## Contents

### Chapter 1. Introduction
- Using the Carlson Software Manual .......................................................... 2
- Product Overview .......................................................................................... 2
- System Requirements ...................................................................................... 4
- Installing Carlson Software ........................................................................... 4
- Authorizing Carlson Software .......................................................................... 10
- Carlson Registration .......................................................................................... 12
- Setting Up a Project .......................................................................................... 13
- Startup Wizard .................................................................................................. 13
- Command Entry ............................................................................................... 16
- Layer and Style Defaults .................................................................................. 16
- What is New ....................................................................................................... 17
- Standard Report Viewer .................................................................................... 20
- Report Formatter ................................................................................................ 22
- Instruction Manual and Program Conventions .................................................. 25
- Carlson File Types ............................................................................................. 26
- Quick Keys ......................................................................................................... 29
- Obtaining Technical Support ............................................................................. 30

### Chapter 2. Tutorials
- Lesson 1: Entering a Deed ............................................................................... 33
- Lesson 2: Making a Plat .................................................................................... 42
- Lesson 3: SurvNET ............................................................................................ 80
- Lesson 4: Field to Finish for Faster Drafting .................................................... 105
- Lesson 5: Intersections and Subdivisions ......................................................... 125
- Lesson 6: Contouring, Break Lines and Stockpiles .......................................... 150

### Chapter 3. AutoCAD Overview
- Issuing Commands ........................................................................................... 165
- General Commands .......................................................................................... 166
- Selection of Items ............................................................................................. 167
- Properties and Layers ....................................................................................... 168
- Properties Toolbar ............................................................................................ 169
Chapter 4. File Menu

New ................................................................. 171
Open ................................................................. 172
Close ................................................................. 172
Save ................................................................. 173
Save As ............................................................. 173
Page Setup ......................................................... 174
Plot Preview ....................................................... 174
Plot ................................................................. 174
Import Xref to Current Drawing ................................ 178
Xref Manager ....................................................... 179
Import/Export LandXML Files ................................... 181
Write Polyline File ............................................... 183
Draw Polyline File ............................................... 184
Clipboard .......................................................... 184
Drawing Cleanup ................................................ 185
Audit ................................................................. 188
Recover ............................................................. 189
Remove Reactors ................................................ 189
Remove Groups .................................................. 189
Purge ............................................................... 190

Chapter 5. Edit Menu

Undo ................................................................. 193
Redo ................................................................. 193
Erase Select ....................................................... 193
Erase by Layer ................................................... 193
Erase by Closed Polyline ....................................... 194
Erase Outside ..................................................... 195
Move ............................................................... 195
Standard Copy ................................................... 196
Copy To Layer .................................................... 196
Copy Polyline Section ........................................... 197
Standard Offset .................................................. 197
Variable Offset .................................................. 197
Standard Explode ............................................... 198
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Explode</td>
<td>199</td>
</tr>
<tr>
<td>Trim</td>
<td>199</td>
</tr>
<tr>
<td>Extend To Edge</td>
<td>200</td>
</tr>
<tr>
<td>Extend to Intersection</td>
<td>200</td>
</tr>
<tr>
<td>Extend Arc</td>
<td>201</td>
</tr>
<tr>
<td>Extend by Distance</td>
<td>201</td>
</tr>
<tr>
<td>Break by Crossing Polyline</td>
<td>203</td>
</tr>
<tr>
<td>Break Polyline at Specified Distances</td>
<td>204</td>
</tr>
<tr>
<td>Break at Intersection</td>
<td>205</td>
</tr>
<tr>
<td>Break, Select Object, 2nd Point</td>
<td>205</td>
</tr>
<tr>
<td>Break, Select Object, Two Points</td>
<td>205</td>
</tr>
<tr>
<td>Break, At Selected Point</td>
<td>205</td>
</tr>
<tr>
<td>Change Properties</td>
<td>206</td>
</tr>
<tr>
<td>Change Elevations</td>
<td>206</td>
</tr>
<tr>
<td>Change Attribute Style</td>
<td>207</td>
</tr>
<tr>
<td>Change Style</td>
<td>208</td>
</tr>
<tr>
<td>Change Block/Inserts Rotate</td>
<td>208</td>
</tr>
<tr>
<td>Change Block/Inserts Substitute</td>
<td>209</td>
</tr>
<tr>
<td>Change Block/Inserts Resize</td>
<td>210</td>
</tr>
<tr>
<td>Pivot Point Rotate by Bearing</td>
<td>210</td>
</tr>
<tr>
<td>Rotate by Pick</td>
<td>211</td>
</tr>
<tr>
<td>Entity Insertion Point Rotate</td>
<td>211</td>
</tr>
<tr>
<td>2D Scale</td>
<td>211</td>
</tr>
<tr>
<td>Scale</td>
<td>212</td>
</tr>
<tr>
<td>Edit Text</td>
<td>212</td>
</tr>
<tr>
<td>Text Enlarge/Reduce</td>
<td>212</td>
</tr>
<tr>
<td>Rotate Text</td>
<td>213</td>
</tr>
<tr>
<td>Change Text Font</td>
<td>213</td>
</tr>
<tr>
<td>Change Text Size</td>
<td>214</td>
</tr>
<tr>
<td>Change Text Width</td>
<td>214</td>
</tr>
<tr>
<td>Change Text Oblique Angle</td>
<td>215</td>
</tr>
<tr>
<td>Flip Text</td>
<td>215</td>
</tr>
<tr>
<td>Split Text into Two Lines</td>
<td>215</td>
</tr>
<tr>
<td>Text Explode To Polylines</td>
<td>216</td>
</tr>
<tr>
<td>Replace Text</td>
<td>216</td>
</tr>
<tr>
<td>2D Align</td>
<td>217</td>
</tr>
</tbody>
</table>
Chapter 6. View Menu

Redraw .................................................. 246
Regen .................................................... 246
Zoom - Window ........................................... 246
Zoom - Dynamic ......................................... 246
Zoom - Previous ......................................... 246
Zoom - Center ........................................... 247
Zoom - Extents .......................................... 247
Zoom IN .................................................. 247
Zoom OUT ................................................ 247
Zoom Selection ......................................... 248
Zoom Points ............................................. 248
Pan ........................................................ 248
3D Viewer Window ..................................... 249
Surface 3D Viewer ..................................... 252
Surface 3D FlyOver ..................................... 252
Viewpoint 3D ............................................ 254
Twist Screen: Standard .................................. 255
Twist Screen: Line Pline or Text ....................... 256
Twist Screen: Surveyor .................................. 256
Restore Due North ....................................... 257
Display Order ............................................ 257
Layer Control ............................................ 257
Set Layer .................................................. 260
Change Layer ............................................ 260
Freeze Layer ............................................. 261
Thaw Layer ............................................... 261
Isolate Layer ............................................. 261
Restore Layer ............................................ 261
<table>
<thead>
<tr>
<th>Chapter 7. Draw Menu</th>
<th>263</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>264</td>
</tr>
<tr>
<td>2D Polyline</td>
<td>264</td>
</tr>
<tr>
<td>3D Polyline</td>
<td>266</td>
</tr>
<tr>
<td>Circle</td>
<td>268</td>
</tr>
<tr>
<td>3 Point</td>
<td>268</td>
</tr>
<tr>
<td>PC, PT, Center</td>
<td>268</td>
</tr>
<tr>
<td>2 Tangents, Radius</td>
<td>269</td>
</tr>
<tr>
<td>PC, Radius, Chord</td>
<td>269</td>
</tr>
<tr>
<td>PC, Radius, Arc Length</td>
<td>269</td>
</tr>
<tr>
<td>2 Tangents, Arc Length</td>
<td>270</td>
</tr>
<tr>
<td>2 Tangents, Chord Length</td>
<td>270</td>
</tr>
<tr>
<td>2 Tangents, Mid-Ordinate</td>
<td>271</td>
</tr>
<tr>
<td>2 Tangents, External</td>
<td>271</td>
</tr>
<tr>
<td>2 Tangents, Tangent Length</td>
<td>272</td>
</tr>
<tr>
<td>2 Tangents, Degree of Curve</td>
<td>272</td>
</tr>
<tr>
<td>Tangent, PC, Radius, Arc Length</td>
<td>272</td>
</tr>
<tr>
<td>Tangent, PC, Radius, Tangent Length</td>
<td>273</td>
</tr>
<tr>
<td>Tang, PC, Radius, Chord Length</td>
<td>273</td>
</tr>
<tr>
<td>Tang, PC, Radius, Delta Angle</td>
<td>274</td>
</tr>
<tr>
<td>Compound or Reverse</td>
<td>274</td>
</tr>
<tr>
<td>3-Radius Curve Series</td>
<td>275</td>
</tr>
<tr>
<td>Best Fit Curve</td>
<td>276</td>
</tr>
<tr>
<td>Curve Calc</td>
<td>276</td>
</tr>
<tr>
<td>Spiral Curve</td>
<td>277</td>
</tr>
<tr>
<td>Insert Symbols</td>
<td>278</td>
</tr>
<tr>
<td>Insert Multi-Point Symbols</td>
<td>280</td>
</tr>
<tr>
<td>Hatch</td>
<td>283</td>
</tr>
<tr>
<td>Raster Image</td>
<td>287</td>
</tr>
<tr>
<td>Place Image by World File</td>
<td>289</td>
</tr>
<tr>
<td>Draw By Example</td>
<td>290</td>
</tr>
<tr>
<td>Sequential Numbers</td>
<td>290</td>
</tr>
<tr>
<td>Arrowhead</td>
<td>292</td>
</tr>
<tr>
<td>Curve - Arrow</td>
<td>292</td>
</tr>
<tr>
<td>Boundary Polyline</td>
<td>293</td>
</tr>
<tr>
<td>Shrink-Wrap Entities</td>
<td>294</td>
</tr>
</tbody>
</table>
Chapter 8. Inquiry Menu

Polyline by Nearest Found ........................................... 295
Drawing Block .................................................................. 296
Write Block .................................................................... 298
Insert ............................................................................ 299

Chapter 9. Settings Menu

Drawing Setup .................................................................. 311
Set Project/Data Folders .................................................. 313
Drawing Explorer .......................................................... 316
Project Explorer ............................................................ 319
Store Project Archive ...................................................... 321
Extract Project Archive ................................................... 322
Preferences ................................................................... 323
Configure ....................................................................... 332
Mouse Click Settings ....................................................... 343
Toolbars .......................................................................... 344
Edit Symbol Library ....................................................... 344
Title Block .................................................................... 345
Mortgage Block .............................................................. 348
Rescale Drawing ............................................................ 348
Trim by Point Symbol .................................................. 418
Change Point LayerColor .................................................. 418
Renumber Points ........................................................... 419
Explode Carlson Points ................................................... 420
Convert Surveyor1 to CRD ................................................. 421
Convert CRD to TDS CR5/Convert TDS CR5 to CRD ......................... 421
Convert CRD to Land Desktop MDB ..................................... 421
Convert Land Desktop MDB to Carlson Points ................................ 421
Convert Civil 3D to Carlson Points ........................................ 422
Convert Carlson Points to Land Desktop .................................... 423
Convert Softdesk to Carlson Points ........................................ 423
Convert Carlson Points to C&G ............................................ 423
Convert C&G to Carlson Points ............................................. 424
Convert Carlson Points to Simplicity ........................................ 424
Convert Simplicity to Carlson Points ...................................... 425
Convert Leica to Carlson Points ............................................ 426
Convert Geodimeter to Carlson Points .................................... 426
Convert Carlson Points to Ashtech GIS .................................... 426
Convert Carlson Points to Softdesk ......................................... 426
Convert PacSoft CRD to Carlson CRD ..................................... 426
Convert Carlson Points to Eagle Point ..................................... 427
Convert Eagle Point to Carlson Points ..................................... 427

Chapter 11. Survey Menu .................................................. 429
Data Collectors ................................................................ 430
Edit-Process Raw Data File .................................................. 454
Edit-Process Level Data ..................................................... 502
SurvNET ........................................................................ 506
Draw Field to Finish ......................................................... 593
Field to Finish Inspector ..................................................... 616
Enter Deed Description ....................................................... 618
Deed Reader ..................................................................... 621
Process Deed File ............................................................ 624
Deed Linework ID ............................................................ 626
Deed Correlation .............................................................. 626
Legal Description Writer ...................................................... 630

Contents ix
Contents

Chapter 12. COGO Menu

Draw-Locate Points .............................................. 656
Inverse ............................................................ 656
Occupy Point ..................................................... 657
Traverse ............................................................ 658
Side Shots .......................................................... 659
Enter-Assign Point .............................................. 660
Raw File On/Off ................................................... 661
Line On/Off ........................................................ 661
Visual COGO ....................................................... 662
Locate by Line-Bearing ........................................... 666
Locate by Turned Angle .......................................... 667
Locate by Azimuth ................................................ 667
Locate by Bearing ............................................... 668
Pick Intersection Points ........................................ 668
Linework Intersection Points .................................... 669
Bearing-Bearing Intersect ....................................... 670
Bearing-Distance Intersect ...................................... 671
Distance-Distance Intersect ..................................... 672
2 Point - 2 Point Intersect ...................................... 673
Create Points from Entities ..................................... 674
Resection ........................................................... 676
Benchmark .......................................................... 678
Numeric Pad COGO ............................................... 679
Point on Arc ........................................................ 680
Divide Between Points .......................................... 680
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Divide Along Entity</td>
<td>681</td>
</tr>
<tr>
<td>Interval Along Entity</td>
<td>682</td>
</tr>
<tr>
<td>Create Points from Entities</td>
<td>683</td>
</tr>
<tr>
<td>Line by Angle-Distance</td>
<td>685</td>
</tr>
<tr>
<td>Tangent Line from Circles</td>
<td>686</td>
</tr>
<tr>
<td>Building Offset Extensions</td>
<td>686</td>
</tr>
<tr>
<td>Radial Stakeout</td>
<td>688</td>
</tr>
<tr>
<td>Section Subdivision</td>
<td>689</td>
</tr>
<tr>
<td>GLO Corner Proportioning</td>
<td>690</td>
</tr>
<tr>
<td>One Way Control</td>
<td>690</td>
</tr>
<tr>
<td>Two Way Control</td>
<td>691</td>
</tr>
<tr>
<td>Three Way Control</td>
<td>692</td>
</tr>
<tr>
<td>Four Way Control</td>
<td>693</td>
</tr>
<tr>
<td>Solar Observations</td>
<td>694</td>
</tr>
<tr>
<td>Best Fit Circle</td>
<td>696</td>
</tr>
<tr>
<td>Best Fit Line by Average</td>
<td>697</td>
</tr>
<tr>
<td>Best Fit Line by Least Squares</td>
<td>698</td>
</tr>
</tbody>
</table>

**Chapter 13. Centerline Menu**  

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Centerline</td>
<td>701</td>
</tr>
<tr>
<td>Input-Edit Centerline File</td>
<td>703</td>
</tr>
<tr>
<td>Polyline to Centerline File</td>
<td>710</td>
</tr>
<tr>
<td>Draw Centerline File</td>
<td>710</td>
</tr>
<tr>
<td>Centerline Report</td>
<td>711</td>
</tr>
<tr>
<td>Centerline ID</td>
<td>712</td>
</tr>
<tr>
<td>Station Polyline/Centerline</td>
<td>712</td>
</tr>
<tr>
<td>Label Station-Offset</td>
<td>719</td>
</tr>
<tr>
<td>Offset Point Entry</td>
<td>722</td>
</tr>
<tr>
<td>Calculate Offsets</td>
<td>724</td>
</tr>
<tr>
<td>Centerline Conversions</td>
<td>726</td>
</tr>
</tbody>
</table>

**Chapter 14. Area/Layout Menu**  

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area Defaults</td>
<td>728</td>
</tr>
<tr>
<td>Inverse with Area</td>
<td>730</td>
</tr>
<tr>
<td>Area by Lines &amp; Arcs</td>
<td>731</td>
</tr>
<tr>
<td>Area by Interior Point</td>
<td>732</td>
</tr>
</tbody>
</table>
Chapter 15. Annotate Menu

Annotation Defaults .................................................. 769
Auto Annotate .............................................................. 771
Custom Label Formatter AD ............................................ 777
Draw End Point Leaders .................................................. 778
Dynamic Annotation Note ............................................... 779
Switch Bearing/Azimuth Quadrant .................................... 780
Mirror Selected Labels .................................................. 780
Mirror and Flip Selected Labels ....................................... 781
Flip Last Label .............................................................. 781
Flip Selected Labels ......................................................... 782
Flip On/Off ................................................................. 782
Bearing with Leader ....................................................... 782
Distance with Leader ....................................................... 783
Bearing-Distance with Leader .......................................... 784
Azimuth-Distance with Leader ......................................... 784
Fix Label Overlaps ......................................................... 785
Global Reannotate .......................................................... 787
Survey Text Defaults ...................................................... 788
Offset Dimensions .......................................................... 789
Building Dimensions ....................................................... 790
Adjoiner Text .............................................................. 791
Draw Grid ................................................................. 791
Draw Legend ............................................................... 793
Draw North Arrow ......................................................... 796
Draw Barscale ............................................................ 797
Create Point Table .......................................................... 798
Update Point Table ........................................................... 799
Table Defaults ............................................................. 799
Table Header .............................................. 803
Set Table Position ........................................... 804
Curve Table .................................................. 804
Line Table ................................................... 805
Railroad Curve Table ........................................ 805
Delete Table Elements ....................................... 805
Label Arc .................................................... 805
Stack Label Arc ............................................... 807
Custom Label Formatter ...................................... 809
Draw Text On Arc ............................................. 810
Draw Text on Tangent ......................................... 813
Edit Text on Arc or Tangent .................................. 813
Fit Text Inside Arc ........................................... 814
Fit Text Outside Arc .......................................... 814
Change Polyline Linetype ................................... 814
Polyline to Special Line ..................................... 816
Polyline to Tree Line ........................................ 817
Add Zig to Polyline .......................................... 818
Add Culvert to Polyline ..................................... 818
Sketch Tree Line ............................................. 819
Special Line/Entity .......................................... 819
Guard Rail .................................................... 820
Label Angle ................................................... 820
Label Coordinates/Elevation ................................. 821
Label Lat/Long ............................................... 823
Label Curb/Flow Elevations ................................. 824
Replot Descriptions .......................................... 824
Leader With Text ............................................. 825
Special Leader ............................................... 826
TextBox ....................................................... 827
Label Offset Distances ....................................... 827
Label Elevations Along Polyline ............................ 828
Introduction
Using the Carlson Software Manual

This manual is designed as a reference guide. It contains a complete description of all commands in the Carlson Software product. The chapters are organized by program menus, and are arranged in the order that the menus appear in Carlson Software.

Product Overview

Carlson Software offers a full suite of commands for downloading, entering, and processing field survey data and for generating final plats and drawings. Carlson Software can function as a total and complete software solution for the land surveying firm, or as an affordable downloading, calculation, and preparatory solution used in conjunction with the more full-featured Carlson Software. Built around the Autodesk 2007 OEM graphics engine, Carlson Software reads and writes standard AutoCAD drawings and assures familiarity to AutoCAD trained staff.

Data Collection

The power of Carlson Survey begins with data collection. Carlson Survey downloads all major collectors ranging from Geodimeter and TDS to Leica, Nikon, Sokkia, and SMI. The raw data is stored in "RW5" format and can be viewed, edited and processed. The processing, or calculation of coordinates, recognizes "direct and reverse" and other forms of multiple measurement, and processes sets of field measurements. Surveys can be balanced and closed by selective use of angle balance, compass, transit, Crandall, and least squares methods or simply by direct calculation with no adjustment. Commands exist for finding bad angles and for plotting the traverse and sideshot legs of the survey in distinct colors as a means of searching for "busts" or errors. In addition to downloading of data from electronic data collectors, the program accepts manual entry of field notes directly into a spreadsheet format, permitting review, storage, and editing. Alternatively, field notes can be entered for immediate calculation and screen plotting of points, with the "raw notes" stored simultaneously, permitting re-processing and re-calculation as needed. For data that was not field-surveyed, but was provided in the form of an ASCII or binary point file, Carlson Software offers the "Import Text/ASCII File" command, unrivaled in its flexibility to read foreign data sources.

Field to Finish

The survey world is recognizing the power of coding field shots with descriptions that lead to automatic layering, linework, and symbol work. Office drafting time can be reduced by 50% or more with intelligent use of descriptions, leading to "field to finish" plotting. For example, breaklines, which act as barriers to triangulation, should be placed on streams, ridges, toe-of-slopes and top-of-banks for more accurate contouring. With the field to finish command, breaklines can be created by field coding, with descriptions such as DL, for creating 3D polyline ditch lines, or TB for creating top-of-bank polylines, etc. and this coordinate data can be simply plotted to the screen as undifferentiated points. However, with the field to finish command, the data can be plotted in one step, creating 3D polyline break lines, building lines, light poles, manholes, edge-of-pavements, that are all distinctly layered and fully annotated. The field to finish command within Carlson Survey is extremely robust, so much so that it can adapt to a coding system made up on-the-fly, or a coding system that has been received from an outsourced survey. Field crew coding and office processing using the field to finish command can save valuable hours of drafting and eliminate misinterpretations, paving the way for quick plat generation or supporting supplemental engineering work.

Deed Work

Carlson Survey allows you to enter old deeds and plot the linework, then add bearing and distance annotation optionally. Distances can be entered in meters and feet, and even in the old measurement forms of chains, poles, links, and varas. Both tangent and non-tangent arcs can be entered. Closures, distances traversed, and areas are
automatically reported. Working in reverse, the command Legal Description creates a property description suitable for deed recording directly from a closed polyline on the screen. If that polyline has point numbers with descriptions at any of the property corners, these descriptions will appear in the deed report, as in "...thence N 45 degrees, 25 minutes, 10 seconds E to a fence post...". Deed files can be saved, re-loaded, edited, re-drawn and printed or plotted to the screen in a report form.

**Drafting and Design**

Carlson Software offers approximately 150 different symbols and north arrows, broken down by categories (for example, points, trees, map symbols). You can create new categories or supplement or change the available point symbols within any category. The program is designed to receive entire sets of new, customized point symbols in a single command. Attributes of points, such as elevation and point number, can be selectively "frozen," allowing the creation of final plats with symbols and optional descriptions remaining on points, as desired. Linework, typically in the form of polylines, can be drawn by any combination of point number and "snap" selection, to create property lines, street lines, easements and right-of-ways, building lines and borders. In addition to Carlson Software's standard line types, dozens of special line types are available, including tree lines, fence lines, all manner of utility lines, stonewalls, and customizable line types. Design features include automatic street intersections and cul-de-sacs, and automatic lot layout. For lots, you can pick your right-of-way and back property polylines, specify desired acreages and frontage/rear lot parameters, and the lots are automatically calculated and drawn. Hinged Area, Sliding Side Area, and Area Radial from Curve are excellent design tools, with an easy, graphic interface. All design polylines can be converted to point numbers at vertices and radius points for purposes of field stakeout.

**Annotation**

With a full slate of annotation commands, Carlson Survey is all you need to finalize your boundary surveys and plats. There is a wide range of bearing and distance annotation options, including the Auto-Annotate command, which allows you to annotate an entire selection set of polylines in one step. Station and offset annotating, as for right-of-way lines, is provided. Use commands such as Special Leader, Station Polyline, Draw North Arrow, and Draw Bar Scale to dress up the drawing and give it a hand-drafted look. Commands such as Title Block and Draw Legend, as well as sequential lot numbering and the area labeling commands, help you complete the finished drawing quickly.

**Powerful Utilities**

Carlson Software contains many strong utilities, particularly polyline utilities. You can Join Nearest disconnected polylines, turn 2-sided figures into closed, 4-sided figures, offset, trim, and extend 3D polylines, create building "footprints" with left and right entries using Extend by Distance, even reverse polyline directions. There are over 20 significant polyline utilities available, including Reduce Vertices, which weeds out duplicate or unnecessary vertices and cuts down on drawing size. Boundary Polyline is a simplified version of the AutoCAD command Boundary, and its opposite, Shrinkwrap Entity. Other categories of utilities include point attribute editing, scaling, twisting and re-sizing, text editing, font alteration and re-sizing, and advanced layer manipulation. Raster images such as aerial photos and scanned images can be placed on drawings.

**Contouring and Terrain Modeling**

There are many higher order features in Carlson Survey. Full contouring is provided, with options for smoothing and labeling contours, highlighting index contours and clipping contours to selected perimeters. Carlson Survey can be used to create both grid files and TIN files (.flt format). Volumes can be computed between grid files, inside any selected polyline perimeter. Profiles can be extracted from contour maps or hand-entered, as generic "point-to-point" profiles or as road profiles with vertical curves. The Design Pad Template command carves in building pads, pits, parking lots, roads, and other 3D features into any existing terrain. Land forms created by contouring and Design
Pad Template can be viewed in 3D and rotated in real time, using the 3D Viewer Window command. In addition to all the commands needed to create final drawings, Carlson Survey also contains commands to perform many engineering tasks typically encountered by survey firms.

Carlson Software is the ideal stand-alone solution for the survey and drafting organization, but it is also the perfect go-between product for the large civil engineering firm with in-house or outsourced survey operations. It complements Carlson Roads. Carlson Survey enables Carlson Software to serve the full spectrum of the surveying and civil engineering design world.

**System Requirements**

Carlson's system requirements are no greater than that of the AutoCAD version you are running. See your AutoCAD installation guide for minimum system configuration. It is always recommended that you use the highest performance PC possible.

Note: Carlson does require a minimum screen resolution of 800x600.

Carlson 2008 will operate with the following versions of AutoCAD:


64 bit version of AutoCAD 2008 is not currently supported.

**Installing Carlson Software**

If you're installing Carlson Software on Microsoft® Windows NT® 4.0 or Windows 2000, you must have permission to write to the necessary system registry sections. To do this, make sure that you have administrative permissions on the computer on which you're installing. Before you install Carlson Software, close all running applications. Make sure you disable any virus-checking software. Please refer to your virus software documentation for instructions.

Note: If you are upgrading from an older version of Carlson Software, you must uninstall the older version before installing Carlson Software. This is required for successful software installation and to meet the guidelines of the EULA (End User License Agreement).

1 Insert the CD into the CD-ROM drive.

If Autorun is enabled, it begins the setup process when you insert the CD.

To stop Autorun from starting the installation process automatically, hold down the SHIFT key when you insert the CD.

To start the installation process without using Autorun, from the Start menu (Windows), choose Run. Enter the CD-ROM drive letter, and setup. For example, enter d:\setup.

2 The Windows Installer dialog box is displayed briefly, followed by a dialog box for entering in your serial number.
In the Enter Carlson Software 2008 Serial Number dialog box, you must enter the serial number provided with your copy of Carlson Software. Then click OK.

3 The Setup dialog box appears briefly, followed automatically by the Carlson Software 2008 Setup dialog. If this is the initial installation, you will see the dialogs shown below.
After reading this second dialog box, press Next. If this version of Carlson Software has already been installed, you will see a different Add/Remove dialog instead. In this case, it is recommended that you Cancel the current install and go to Windows > Control Panel > Add/Remove Programs and remove Carlson Software 2008. After the old installation is removed, you may start the install process once more to continue.

4 Review the End-user License Agreement, accept it with the correct click choice, and then click Next. You can optionally print it out.

5 On the Select Installation Type dialog box, select the type of installation you want: Typical or Custom. Choose Next.
Typical installs the following features:

- Program files: Executables, menus, toolbars, Help templates, TrueType® fonts, and additional support files
- Internet tools: Support files
- Fonts: SHX fonts
- Samples: Sample drawings
- Help files: Online documentation

Custom installs only the files you select. By default, the Custom installation option installs all Carlson Software features. To install only the features you want, choose a feature, and then select one of the following options from the list:

- Will be installed on local hard drive: Installs a feature or component of a feature on your hard drive.
- Entire feature will be installed on local hard drive: Installs a feature and its components on your hard drive.
- Feature will be installed when required only: Installs a feature on demand.
- Entire feature will be unavailable: Makes the feature unavailable.

6 On the Destination Folder dialog box, do one of the following:
Choose Next to accept the default destination folder/directory.

Choose Browse to specify a different drive and folder where you want Carlson Software to be installed. Choose any directory that is mapped to your computer (including network directories), or enter a new path. Choose OK and then Next.

Setup installs some files required by Carlson Software in your system folder (for example, c:\Windows\System, or c:\Winnt\System32). This folder may be on a different drive than the folder you specify as the installation folder (for example, d:\Program Files\Carlson Software). You may need up to 60 MB of space in your system folder, depending on the components you select to install. Setup alerts you if there is insufficient free space on the drive that contains your system folder.

On the Start Installation page, choose Next to start the installation.
The Updating System dialog box is displayed while Carlson Software is installed.

When the installation is complete, the Setup Complete dialog box is displayed. Choose Finish to exit the installation program.

It is strongly recommended that you restart your computer at this point in order for the new configuration settings to take effect.

Congratulations! You have successfully installed Carlson Software. You are now ready to register your product and
start using the program. To register the product, double-click the Carlson Software icon on your desktop and follow the instructions.

**Authorizing Carlson Software**

The first time you start Carlson Software, the Registration Wizard is displayed.

Carlson Software has installed an automated procedure for registering your software license. Change keys are no longer given over the telephone. Please choose one of the following registration methods.

**Form**: This method allows you to fill out a form that you can print out and fax or mail to Carlson Software for registration.

**Internet**: If your computer is online, you may register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

**Enter change key**: Choose this method after you have received your change key from Carlson Software (if you previously used the Form method above).

**Register Later**: Choose this method if your want to register later. You may run Carlson Software for 30 days before you are required to register.

After you choose the registration method, press Next
Choose the reason for installation. The very first time you install Carlson Software is the only time you will choose the first reason. All subsequent installations require a choice from the remaining options.

**New install or maintenance upgrade of Carlson Software**: If you are installing Carlson Software for the first time, choose this reason.

**Home use. See License Agreement**: Choose this reason if you are installing on your home computer. See your license agreement for more details!

**Re-Installation of Carlson Software**: Choose this reason if you are reinstalling on the same computer with no modifications.

**Windows or AutoCAD upgrade**: Choose this reason if you have reinstalled Carlson Software after installing a new version of Microsoft Windows.

**New Hardware**: Choose this reason if you are installing Carlson Software on a new computer or if your existing computer has had some of its hardware replaced such as the hard disk, network adapter, etc.

After you choose the reason for installation, press Next, and then enter the required information into the dialog.

If you are using the Form method, press the Print Fax Sheet button, to print out the form. You may fax this form to the number printed on the form, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY
If you are using the Internet method, press Next. After a few seconds, your registration will complete. If your registration is successful, you will receive a message such as the one below. If your registration is unsuccessful, please note the reason why and try again. Keep in mind that each serial number may be registered to a single computer only.

![Carlson Registration dialog box]

If you do not have access to the Internet, and do not have a printer, you must write down the information from the User Info tab (shown above) and fax it to 606-564-9525, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY 41056-1003.

**Carlson Registration**

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.

Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.

- **Fax**: This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

- **Internet**: Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

- **Enter pre-authorized change key**: If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.
Register Later: If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo
mode which displays a message each time a Carlson command is run.

After you select the registration method, choose Next and select the type of installation you are performing, choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax method. The registration form is available on the Carlson Software website at http://www.carlsonsw.com/registration.html.

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button.

Setting Up a Project

Over 200 Carlson Software settings can be specified in the Configure command on the Settings menu. These values are used to initialize Carlson Software options when opening a new or existing drawing. Among these settings is the coordinate point number format, object linking options, and settings for the COGO portion of Carlson Software. The template drawing is the default drawing that opens up each time Carlson Software is started. To customize the template drawing, run the OPEN command under the File pulldown menu, change the files of type setting to Drawing Template and choose the template drawing, "survey.dwt". Then make your changes and SAVE the drawing as survey.dwt in the Template folder.

When starting a new drawing, one of the first steps is to run Drawing Setup in the Settings menu. Drawing Setup sets the drawing scale, the units mode as either english or metric, and the text, symbol and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure > General Settings. When a drawing is saved, the Drawing Setup variables are saved with the drawing. Carlson Software will set the text height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the horizontal scale is set to 50 and the text size scaler is 0.1, Carlson Software will draw the text with a height of 5 (50 * 0.1). Then, when the drawing is plotted at 1"=50', the text will be 0.1 inches.

Every drawing remembers the data files that are being used for the drawing. When the drawing (.DWG) file is saved with the SAVE or SAVEAS command, Carlson Software writes a settings file that contains all the active data file names. Then, when the drawing is reopened, the data files default to their previous settings. For example, you won't have to choose which coordinate file to use unless you want to change it. The settings file is stored in the same folder as the drawing file, and has the same name as the drawing, with an .INI extension. For example, a drawing called survey.dwg would have a settings file called survey.ini.

The Drawing Explorer command, in the Settings menu within the Project command, tracks and stores project files associated with each saved drawing. You may use this command to generate a report of all files used in a particular drawing. Project Explorer takes this concept one level further and allows you to group drawing files and their associated project files. Reports can also be generated using this tool.

Startup Wizard

For creating a new drawing in Carlson Software, the Startup Wizard can guide you through starting and setting up the drawing. This wizard is optional, and it can be turned on or off in the Settings menu by clicking Configure, then General Settings. You can also exit out of the Startup Wizard at any time. When the Startup Wizard is turned on and the New drawing command is executed, you will see the Select template dialog box.
Typically, you want to choose the drawing template SURVEY.DWT when you are using Carlson Survey, and then click Open. Remember that for Carlson Roads you will use ROADS.DWT. For Carlson Field you will use ROADS.DWT. The drawing template will set some of the basic drawing parameters, such as the default layer names. The Startup Drawing Wizard dialog appears.

![Select template](image1)

Here, you need to set the new drawing name and scale. Set the drawing (.dwg) name by picking the Set button. The Drawing to Create dialog box opens. Change to the directory/folder ("Save in" field) where you want to store the drawing. You can either select an existing folder or create a new folder. Type in the drawing name in the File name field and click the Save button.

![Startup Drawing Wizard](image2)

Chapter 1. Introduction 14
Then you can set the drawing horizontal scale, symbol size, text size and unit mode (English or Metric). Clicking the Next button brings up the Startup Wizard Data Files dialog box. This is for setting the Data Path and CRD File. The Set button for the Data Path is for setting the folder where Carlson Software will store the data files, such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to select an existing folder or create a new folder. See the Set Data Directory command for more information.

The Coordinate (.CRD) File is the coordinate file for storing the point data. There is an option to create a new or existing coordinate file. The New option will erase any point data that is found in the specified CRD file. The Existing option will retain any point data in the specified coordinate (.CRD) file. If the specified coordinate (.CRD) file does not exist, the wizard will create a new file.

The next wizard step depends on the Import Points option. The Data Collector option will start the data collection routines to download data from a collector. The Text/ASCII option will import point data from a text/ASCII file. See the Data Collection and Import Text/ASCII File commands for more information on running these routines. If the None option is set, then the Startup Wizard is finished.
Once point data has been imported from the data collector or text/ASCII file, the wizard guides you through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None. If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the Draw All button. The Field To Finish command will import the points into the drawing using different layers and symbols depending on the point descriptions that refer to the code table defined in Field to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish commands for more information on running these routines. After drawing the points, the wizard will zoom the display around the points. Then the wizard is finished.

**Command Entry**

Commands may be issued by selecting a pulldown menu, screen menu, digitizer tablet item, or by typing a command at the AutoCAD command prompt. Pressing Enter at the command prompt repeats that last command. Pulldown menus have a row of header names across the top of the screen. Selecting one of these header names displays the possible commands under that name. Screen menu items are shown in the screen menu (typically on the right side of the screen). The screen menu can be toggled off and on inside of the AutoCAD Preferences dialog. The Pulldown menus are the primary method for Carlson command selection. Each section of this manual shows the pulldown menu which contains the commands that are explained in that section. Pulldown menus are sometimes also referred to as dropdown menus.

Command availability depends on which menu is loaded. Carlson menus have a mixture of both Carlson and AutoCAD commands. This allows you to execute the commonly used AutoCAD commands from the menus while running Carlson.

Quick Keys are user-defined short cut names that can be typed in to start commands. To review the current set of Quick Keys, run the Quick Keys command in the Settings pulldown menu. Quick Keys are explained in more detail in the next section.

**Layer and Style Defaults**

Many Carlson Software commands have default layers such as AREATXT for area labels and BRGTX for bearing and distance annotations. These layers can be specified in dialogs for the corresponding commands, and several can be set in the Configure command under the Settings menu. Sometimes you may want to use the current layer, and it can be an extra step to have to open the dialog to set the layer. In this case, instead of using the default layer that is set in the dialog, the default layer can be set as "CLAYER", which will use the current layer.

For example, if the annotation layer is set to CLAYER, then annotation will be drawn in the current layer instead of BRGTX or whatever the annotation layer used to be. This same concept applies for text styles. Several commands have specific text styles and if you want to use the current style instead of the command style, use the name "CSTYLE" for the style name.
What is New

General Commands

- **New Toolbars** - Added 25+ more default toolbar icons for common commands.
- **Reports** - Added option to output reports directly to Microsoft Word.
- **Report Formatter** - Added output options to create a table in the drawing for the selected fields and to create an html format report. Added ability to save report with all the settings, data and user defined attributes.
- **Perpendicular From Osnap** - Added ability to snap perpendicular from linework within the ‘CL transparent command.
- **Drawing Inspector** - Added option to show curve data. Added setting for high precision data display.
- **New Scale 2D** - New command to scale entities in x,y coordinates without effecting their elevation.
- **Join Nearest** - When layers or elevations don't match, add option to prompt for which one to use. Added option to stop at intersections with more that two connections.
- **Highlight Crossing Polylines** - Added tolerance settings for intersection points to merge by average.
- **3D Viewer Window** - Added tolerance settings for intersection points to merge by average.
- **Insert Symbol** - Added option to align symbols by centerline or polyline.
- **New Draw Arc (PC,PT,Radius len)** - New command to draw an arc with these inputs.
- **New Draw Polyline Start/End** - New command draw different symbols for the start and end points of selected polylines.
- **Layer Inspector** - Added ability to select multiple layers to highlight.

Survey Commands

- **Edit-Process Raw File** - Added support for all grid projections for the Calculate Grid Scale Factor option. Added option to apply a geoid for the Calculate Grid Scale Factor option. Added function to convert point records into notes. Added function to create new raw file within editor. New processing method to calculate coordinates from angle only measurements. Added processing option to not store point numbers from the
control coordinate file into the active coordinate file. Added Data On/Off records to comment out sections of the raw file from processing. Added Elevation 2D/3D notes to control whether to process elevations. Added support for angles in GONS units in spreadsheet and reports. Added report function for a summary report of the traverse, sideshot and store points in the rw5 file. Added settings for min/max ranges of valid instrument and rod heights that are checked during processing.

- **Edit-Process Level Data** - Added import of Leica level data.
- **SurvNET** - Added import of GPS vectors from LandXML and Trimble .DC formats. Added import of Leica level data. Added functions to save/load standard error settings into the project settings. Added support for more projections including UTM, New Brunswick and user-defined. Several improvements to the formatting of ALTA reports. Improved processing speed by 30%.
- **Field-to-Finish** - Added option to draw attributes as text instead of blocks with control of text style, position, prefix, suffix, layers and precision. Added option for values to assign for custom attribute symbols. Added functions to import Eagle Point and C&G code tables. Added option by code to truncate high digits of elevation labels. For JOG special code, added ability to extend a line. For curves with more than 3 points, added option to draw the best-fit curve. Added code option to align points by their associated linework.
- **Field-to-Finish Inspector** - Added ability to select multiple codes to review at a time.
- **Import Text/ASCII File** - Added option to create point group for new points.
- **Draw/Locate Points** - Improved speed of using Field-to-Finish code table and added support for more coding methods. Added option to truncate high digits from elevation labels.
- **New Coordinate System** - Added optional coordinate system data in Drawing Setup to define drawing coordinates as either grid projection or local coordinates. For local coordinates, Define Localization uses control points to define transformation between local and grid systems. The coordinate system setup is used in routines like List Points and Label Lat/Lon to label local, grid and lat/lon coordinates.
- **New Distance Scale Factor** - Added distance scale factor to Drawing Setup to report and label distances in a second system besides the drawing units such as feet-meters or ground-grid.
- **Inverse** - Added option to report in feet and inches.
- **Enter Deed Description** - Now auto-saves during command to enable resuming in case of cancel.
- **Legal Description Writer** - Added option to spell out numbers and option to report interior angles. For curves, added option to identify compound, reverse, tangential and non-tangential.
- **Trim By Point Symbols** - Improved routine to work more reliably for more types of symbols.
- **Coordinate File Utilities** - For Copy/Merge function, added prompt for range of points to use and description filter and made several improvements to the merge dialog. Added function to unlink drawing points with coordinate file. For Coordinate Transformation, added convergence angle to report.
- **New Freeze/Thaw Points** - New functions to hide/show point entities in the drawing. Points can be selected by range, group or screen selection.
- **Cut Sheet** - Added runway clearance surface method.
- **Tangent Line From Circle** - Added option to draw across circles from left to right or from right to left.
- **Building Offset Extensions** - Added option to create points at diagonals and for edges projected across building. Added controls to set layer and elevation for points.
- **New Triangle Solutions** - New triangle calculator command.
- **Draw Legend** - Added option to use description from Field-to-Finish code table as legend default.
- **Line/Curve Tables** - Added option for header line on line/curve tables.
- **Angle/Distance Annotation** - Added auto erase of old labels when relabeling the same linework.
- **Create Point Table** - Added setting for text style.
- **Bearing Leaders** - Added options to position bearing leaders above or below bearing label.
- **Draw Endpoint Leaders** - Added support for curves.
- **Station Polyline/Centerline** - Labels linked to centerline to update labels if centerline is changed. Added options to label deflection angles, to label northing/easting of start, to draw symbols at curve PC/PT stations, and to label curve radius on PC lines. Added setting for text style for labels. Added functions to save/load settings by settings file.
• **Input-Edit Centerline** - Add function to reverse centerline. For assign point number, added option to include CL type in description.

• **Centerline Report** - Added support for railroad curves.

• **Hot New Lot Network** - 25 new commands for subdividing a site into lot and ROW areas. Dynamically updates areas for any changes to boundaries. Includes ability to label linework and areas and to draw setback boundaries.

• **Lot File By Interior Point** - Added option to prompt for point of beginning and setting for clockwise or not.

• **New Draw Lot Setback** - New command to draw frontage, side and back lot setback offsets.

• **New Fit Structure** - New command to draw a building outline within a lot at setback offsets.

**Surface Commands**

• **Triangulate & Contour** - Added controls for generating smoother contours by applying an outlier reduction filter and by reducing contour vertices before Bezier smoothing. Added contour collision check to prevent crossing contours otherwise caused by smoothing adjustments. Added separate elevation range settings: one for source data and one for contour output. Added option to draw flow arrows. Added option to draw depression contours. Added function to save/load settings to style file. The Data Error Manager is changed to a dock-dialog to allow editing in the drawing while using the manager to zoom to the data problems.

• **Volume Calculations** - Improved speed of triangulation volumes by 50%.

• **Draw Triangular Mesh** - Added option to use inclusion/exclusion perimeters.

• **Draw Grid File** - Added option to reduce 3D faces resolution in areas that are fairly coplanar.

• **Offset 3D Polyline** - New method to offset polyline at slope to intersection with a surface model.

• **Make Grid File** - Added method to read source data from a coordinate file or from a text/ascii file.

• **Surface Manager** - Added ability to add points outside current surface.

• **Triangulation File Utilities** - Added function to apply subdivisonal surfaces to the triangulation.

• **Design Pad Template** - Added method to define slope as projected in slope direction instead of perpendicular to pad polyline. Added setting to control side line interval at corners.

• **New Slope Zone Analysis** - New command to report and color slope zones of a surface.

• **Profile From Surface Entities** - Add support for railroad stationing.

• **Profile From Grid or Triangulation Surface** - Add support for railroad stationing.

• **Profile From Points On Centerline** - Added option to record point offsets to centerline into profile descriptions.

• **Draw Profile** - Added support for drawing a user-specified number of profiles at a time. Added draw grid option to use grid ticks and dots. Added setting to control width of profile polylines. For horizontal label box, added option for user-defined rows and option to draw above profile grid. For vertical curves, added option to auto-place labels above highest vertical curve, added option to label high/low points, added more PVI-V linework styles, added control of the curve symbols, added option whether to label the grades on the profile polyline and added prefix/suffix settings for all the curve labels. For profile grid, added setting for vertical grid adder to top and bottom. For profile crossings, added settings to control each label prefix, suffix, style, size, decimals and rotation. For plan-profile sheets, added options to draw sheet layout border in plan view, to draw a north arrow in plan view and to draw plan-view only sheets. For sewer/pipe profiles, added options to draw flow direction arrows on the pipes and to close pipe connections at the structures. For pipe crossings, added method to calculate and draw crossing on-the-fly and new method to specify swath width for drawing any parallel pipes. For drawing additional profiles onto an existing grid, added a button to pick the existing grid to get the grid dimensions. For station and elevation grid text, added settings for offset amount from grid lines. Added separate settings for road, sewer, pipe and crossing labels for label size, color, style and layer. New option to label profile name at start of profile polylines. Added Draw Grid options for grid ticks with checks and whether to label elevations on the left side only.

• **Input-Edit Profile** - For road profiles, added ability to set vertical curve to make a sag/crest at the specified through point. Added report function within editor. Added graphic display option to show slopes.
GIS Commands

- **GIS Query/Report** - Added method to query across multiple tables in a relational database.
- **New Place Camera Symbol/Image** - New command to draw a camera symbol with an attached image.

Data Conversions

- **Belgium** - Added support for hBG03 geoid.
- **Canada** - Added support for GSD95 geoid.
- **Finland** - Added support for Finland 2000 geoid.
- **France RAF98 Geoid** - Added support for this geoid.
- **Geoid 03** - Added support Alaska, Hawaii and Puerto Rico.
- **LandXML** - Added support for sewer network data. Added import of parcel data and parcel groups from Civil 3D.
- **MOSS** - Improved import of Genio files to support curves and layers.
- **Northern Ireland Geoid** - Added support for this geoid.
- **Republic of Ireland Geoid** - Added support for this geoid.

Standard Report Viewer

Many Carlson routines display output in the Standard Report Viewer as shown below. The report can be edited directly in the report viewer. Report Viewer commands are described below.

**Open:** This allows you to open an ASCII file and display the contents in the report viewer.

**Save:** Save the contents of the report viewer to a text file.

**SaveAs:** This allows you to save the contents of the report viewer to a file.

**Append To:** This allows you to append the contents of the report viewer to another file.

**Print:** Print the contents of the report viewer. This will open the standard windows Print dialog where you can choose the printer and modify any of the printer settings before you actually print.

**Screen:** Draws the report in the current drawing. The program will prompt you for a starting point, text height, rotation, layer and whether you want it inserted as Mtext or Text.

**Undo:** Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose the Undo command to restore it. The key combination Ctrl+Z also performs this action.
Chapter 1. Introduction
Select All: Selects all the text in the report viewer.

Cut: Deletes the selected text and places it on the Windows® clipboard.

Copy: Copies the selected text to the Windows® clipboard.

Paste: Inserts ASCII text from the Windows® Clipboard into the report viewer at the cursor.

Search: Opens the Find Text dialog. Allows you to search for text in the report viewer.

Replace: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.

Options: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings, such as lines per page and margins. You can also specify the font used in the report viewer. This font is used for both the display and for printing.

Hide: This button allows you to minimize the report viewer window and give focus back to the Carlson CAD screen. This allows you to return to working on the Carlson CAD screen without closing the report. You can re-activate the report by picking on the minimized report viewer icon.

Report Formatter

A number of Carlson routines use a dialog box called Report Formatter Options to allow you to specify how and which results of calculations should be presented in the report. This report routine lets you select a set of data to report and the format of the selected data. The report can be displayed in either the standard report viewer as described in the previous section, Microsoft® Excel or Microsoft® Access.

The data set in the Report Formatter may be thought of as a spreadsheet, where columns are various fields related to a single item such as time period, drillhole, area and etc. Each new row represents a new item. Descriptions of these field names are displayed in the Available list of the Report Formatter. To include a data field in the report, highlight the field name in the Available list on the left and pick the Add button. This moves the field name to the Used list on the right. The order of items in the right list defines the order in which they will be displayed. In addition, the items may be sorted as specified by the user in the right column. Items are first sorted by the first column, then items with the same value in the first column are sorted as specified for the second column, and so on.
These subsequent sortings do not modify sortings of previous columns. If you specify no sorting for some column (even the first one) then no sorting will happen in subsequent columns either. For example, you may want to sort production by mining panel name but not by month.

To generate the report after selecting columns and other preferences, click on Display button. It will bring up a standard report viewer showing the report data. Upon exiting the viewer, you come back into the Report Formatter for further data manipulation if needed. The other data output and destination options include saving the specified data into a comma-delimited text or CSV file, creating a spreadsheet preview whereby the data may be exported using several methods, and direct export to Microsoft® Excel. Due to the popularity of the Excel output choice, you can also customize certain Excel options, including setting mirror output, just prior to export. Data can also be merged to combine current and old reports, and it be exported to XML format files. There is an option for output to other database formats as well.

You may define new columns as equations based on existing columns. Click on the Edit User Attributes button to add a new field name. A list of the existing attributes is available for reference.

User attributes may have one of the several summation options just like program-generated ones (except that for
them these options are set by program). The summation level is defined by the "Total" pop-up list in the middle of the dialog. By default only grand total will be displayed at the bottom of the list. By picking the next item in that box, you will get subtotals added each time the value in first column is changed. It makes most sense to use this kind to summation if the corresponding column is sorted. For example if the first column is "Area Name" and it is sorted, and "Total" is set to "Grand, Area Name" the report will have a sub-total for each distinct Area Name. This feature makes the Report Formatter a very flexible tool for results exploration, even before or without using a spreadsheet.

Various forms of reports may be saved and recalled using controls in the top line of the dialog.

To save a new version of the format, type in a new name (or use default to overwrite old one) and click on the Save button. The next time that you come to the Report Formatter from the same Carlson routine it will recall this last format. To pick another format just pull down on list of formats in the left top corner and pick which format to use.

To Delete an unwanted format, pick it from the list first and then click on Delete button.

There are several Microsoft® Excel export options provided. You may specify a spreadsheet file to load before export, as well as a left upper cell to start with and sheet number to use. Totals which are reported when using built-in viewer may be skipped when using Microsoft® Excel export.
For commands that process reports using perimeter polylines, the Report Formatter has an option to create GIS links between the polylines and the database records when the Export to MS Access function is used. When the polyline data is available for the GIS Links, there will be a report field called Handle. This Handle field is the AutoCAD entity name for the polyline and serves as the hook for the GIS link. The Handle field does not need to be put into the report Used list in order to create the links. When the Export function is called with the MS Access method, there is a pop-up window prompt for whether to create the GIS links. When these links are created, you can then use the GIS menu commands to manage and report the data.

![Image of Report Formatter Options](image)

**Instruction Manual and Program Conventions**

*Westwood*

Italic text represent responses by the user that should be typed in and followed by the Enter key.

**Number/<Pick point>:**

Bold text represents prompts or questions that the computer program will ask the user.

<90.0000>

Values enclosed in corner brackets represent default values obtained by pressing Enter with a blank response to AutoCAD or Carlson commands.

[end on]

Lower case text enclosed in brackets in Command prompts denotes an **OSNAP** mode that is turned on by the command.
Carlson File Types

.AAN Auto-Annotation Settings
.ADF Annotation Default Settings
.ARX AutoCAD Runtime Extension For Carlson Program
.ATR Strata attribute definitions
.AVG Mining Composite Quality Analysis
.BLK Mining Block Model
.CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDF Geology Channel Sample File Format
.CDS MDL Laser Raw Data
.CDT Mining custom date table
.CFG Configure Configuration Settings
.CFZ Cut/Fill Color Map Zones
.CG C&G Coordinate File
.CGR C&G Raw Data
.CH Corehole definition
.CL Centerline file
.CLT Culvert Settings
.CN Hydrology CN Factors
.COG Cadadvantage Coordinate Data
.COT Multiple Outlet Design Data
.CQT Mining custom quantity table
.CRB Template Curb Definition
.CRD Coordinate file (point#, northing, easting, elevation, description) in binary form
.CTL SDMS Format Raw Data
.CTR Auto-Run Strata Isopach Maps
.CUI Customized User Interface AutoCAD Menu
.CUT SMI Format Cutsheet
.CV T SEDCAD Format Hydro Network
.DAT GPS Localization Definition
.DCF Deed Correlation File
.DCL Carlson dialogs
.DEM Digital Elevation Model
.DEQ Drillhole equations
.DHF Drillhole Text File
.DHT Dragline History
.DIL StrataCalc Convert As-Determined Qualities
.DLL Carlson programs files
.DTF Drillhole Data Format
.DTS Drillhole Text Settings
.DWG AutoCAD drawings
.DXF Drawing Exchange Format
.DZR Dozer Push Settings
.EQO Mining equipment options
.EQU Mining equipment definitions
.ERD Erodible Channel Settings
.EW Earthwork Section End Areas
.EXE Carlson programs
.PFS Draw Profile Settings
.PHN Modem Settings For Carlson Field
.PIT Mining Pit Parameter File
.PLN Plan view polyline file for Dozer 2000
.PNA Mining panel attributes
.PPQ Polygon Processor Query
.PRE Pre-calculated grids for strata model
.PRF Point Range File
.PRJ Project settings file
.PRO Profile (station, elevation, descriptions)
.PSZ Pipe Size Definitions
.PTA Mining pit attributes
.PVF System Variable Settings
.PVL Sewer Network Plan View Label Settings
.PVS Mining Projection and Ventilation Settings
.RCF Drainage Runoff Library
.RCL Runoff Coefficient Layer Definitions
.RDF Road Design File
.RDN Road Network File
.RDS Roadside Ditch File
.REC Seismic Record Output
.REP Hec-Ras Report File
.RES Mining Auto-Run Residuals Settings
.RME Reame Slope Stability Settings
.RMP RiverMorph Project
.RNF Road Network Stakeout for SurvCE
.ROW Right-of-Way offsets for Lot Network
.RPT Report Formatter Data
.RSV Mining Reserve Description
.RUN Auto-Run Strata Grids definition file
.RW5 Raw file of traverse data
.SC Coal Section Configuration
.SC5 SurvCE Raw Data Archive
.SCR COGO script file
.SCT Cross section data (station, offset, elevation, descriptions)
.SDF Strata Definitions
.SDT SB-Slope Stability File
.SEQ Dragline sequence file
.SEW Sewer network file for hydrology
.SGD Slope Group Definition for Design Pad Template
.SIF Surface Inspector File
.SLB Slide library
.SLD Slide image
.SLI Symbol Library
.SST Draw Section Sheet Settings
.STG Stage-discharge data for hydrology
.STR Sewer Structure Library
.SUP Superelevation file
.TAB Hydrology Peak Flow Data
.TCF Digitizer Tablet Configuration File

Chapter 1. Introduction
Quick Keys

“Quick Keys” allows you to enter in the coding shown here on the left, and by doing so run the commands shown on the right.

2DP = 2D Polyline  
3DP = 3D Polyline  
A = Arc  
AL = Align  
B = Block  
BB = Bearing-Bearing Intersect  
BD = Bearing-Distance Intersect  
BH = Boundary Hatch  
C = Circle  
CH = Change Properties  
CO = Color  
CP = Copy  
DD = Distance-Distance Intersect  
DI = Distance  
DT = Draw Text  
E = Erase  
EA = Enter-Assign Point  
EX = Extend  
F = Fillet
Obtaining Technical Support
via Discussion Groups

- Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
- You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.
via Electronic Mail

- The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

- Phone: (606) 564-5028
- Fax: (606) 564-6422

via Web Site

Check the Carlson Software web site at http://www.carlsonsw.com for:

- Knowledge Base, discussion groups, technical support documents and newsletters
- Carlson Software manuals (PDF) and training movies
- Training and seminar schedules
- Step by step procedures on popular called-in topics
- Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training

- Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.
Tutorials

This section contains tutorials designed to assist you in learning this Carlson Software product. It is recommended that you try some of these out when you are first starting to learn the software, or when you need some pointers later on.

You will see how to enter a deed, make a plat and use Field to Finish for faster drafting. There are also lessons on intersections and subdivisions, SurvNET, contouring, DTM and design. Using break lines and surfaces are also covered.

Some of the tutorials will ask you to open drawing and data files that are provided to you at purchase. Good luck!
Lesson 1: Entering a Deed

In this short lesson you will create a simple drawing. You will enter a 6-sided deed, add a title block, bar scale, and north arrow, add a title and certification text, and plot the deed area.

Note that the Esc key will cancel most commands, so if you choose the wrong command or enter something incorrectly and want to start over, just press Esc.

1 Click the icon for Carlson. You may be presented with a "Startup Wizard" dialog box. If so, click Exit.

2 Under the Settings menu, click Drawing Setup. Set the unit setting to English and the Horizontal Scale to 50. Click OK.

3 Choose Point Defaults from the Points menu, and, in the dialog box, click Elevations off to eliminate the Elevation prompt. Click Descriptions on and also set the point symbol name to symbol 4 (SPT4), which is the round, open circle. Click Automatic Point Numbering on. Click OK.

4 Under the Survey menu, select Enter Deed Description. Use the default settings as shown in this dialog box image.
Set the To Table Scaler option to 0.00. This places all of the deed calls in the drawing. The To Table Scaler determines which deed calls appear in the drawing and which deed calls appear in a table. Deed calls less than the To Table Scaler value multiplied by the Drawing Scale will be placed in a table of calls. Set the dialog box options to match those shown above. Click OK.

The command line is the area below the graphics and to the left. When prompted to "Pick point or point number" at the command line, pick a point in the lower left quadrant of your screen to start the deed plotting. If you are prompted for elevation, you failed to turn off the elevation prompt in Point Defaults. Press Esc and return to the Point Defaults command.

The following dialog box will appear so you can specify where to store the coordinates:
Select the New tab. Then, for the File Name, type in Deed. This creates a file called Deed.crd. All Carlson points are stored in files with the "crd" extension, which stands for "coordinates." Click Open. Now respond to the command line prompts exactly as shown here:

When you are prompted for a description, enter "Fence Post".

**Exit/Curve/<Bearing (Qdd.mmss)>**: 125.3500
The quadrant (Q) is 1 for Northeast (2 is Southeast, 3 is Southwest and 4 is Northwest). The bearing is 25 degrees, 35 minutes, and 00 seconds. If all digits for the minutes and seconds are entered as shown above, then the deed call will be fully plotted, including the seconds. If only the degrees and minutes were entered, as in 125.35, then the plot would appear as "N 25° 35' E".

**Varas/Meters/Poles/Chains/<Distance(ft)>**: 200.51 Note that you can enter old deeds in the forms of Poles and Links, Chains and Links and even Varas (a unit of measurement formerly used in the southwestern states of the U.S.).

**Enter Point Description <Fence Post>:** Iron Pin

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 189.4321

**Varas/Meters/Poles/Chains/<Distance>:** 225.00

**Enter Point Description <Iron Pin>:** press Enter
Pressing Enter selects the default, which is Iron Pin.

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: C

**Radius**: 75

**Curve direction [Left/<Right>]?** press Enter for right

**Non-tangent/Reverse-tangent/Bearing/Chord/DeltaAng/Tangent/<Arc Len>:** 118.17
If you don't know the arc length, but you know the tangent, you would choose "T" for tangent.

**Enter Point Description <Iron Pin>:** press Enter

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 200.0000 (due south)
If you were to enter just 2 (no degrees, minutes, or seconds), then the deed call would be plotted "S 000 E".

Chapter 2. Tutorials
Varas/Meters/Poles/Chains/<Distance>: 178.00
Enter Point Description <Iron Pin>: Concrete Monument
Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 488.2300
This entry specifies Northwest 88 degrees, 23 minutes.
Varas/Meters/Poles/Chains/<Distance>: 300.34
Enter Point Description <Concrete Monument>: Fence Post
Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 454.1109
Varas/Meters/Poles/Chains/<Distance>: 106.93
Enter Point Description <Fence Post>: press Spacebar, then press Enter
Simply pressing Enter uses the default text (Fence Post) again. To avoid drawing the text "Fence Post" twice on the end point, press the spacebar, skip a blank character, and press Enter.
You have now completed the 6-sided figure (including one curve).
Undo/Exit/Curve/<Bearing (Qdd.mmss)>: E

The following results are reported:

SQ. FEET: 83921.8  SQ. YARDS: 9324.6  SQ. MILES: 0.0
ACRES: 1.93
Closure error distance> 0.01708540  Error Bearing> S 52d5'26'' E
Closure Precision> 1 in 66076.89  Total Distance Traversed> 1128.95
SQ. FEET: 82302.9  SQ. YARDS: 9144.8  SQ. MILES: 0.0
ACRES: 1.89

The resulting deed, has a closure of 1:66077. In the initial prozmpmt "Undo/Exit/Curve...", U for Undo would allow you to reenter the previous deed call.

Use the Extents command on the View menu to see the entire area. Then choose Zoom Out under the View menu giving you adequate room for the next step.

5 Under the Settings menu, select Title Block. The first dialog you will see is shown here:
Select Paper Size B2 (11 x 17), and enter the layer name of BORDER, then choose OK. You will be prompted for the border location, pick a point in the lower left of the survey.

The following dialog appears, allowing you to enter the attributes for the Title Block. After you have completed the title block entries, as shown below, select OK.

Note that the title line is plotted in large text on the title block. Its length, therefore, should not exceed 15 characters.

Your drawing should look like the example below at this point.
Use the Extents command, found in the View menu, to see the entire working area. If you want to move the border, use the Move command on the Edit menu. Pick the border lines and the title block objects (up to 3 picks total), press Enter (to end object selection), then pick two points representing the vector of the move.

If you want to see a margin around the working area after you use the Extents command, use the Zoom Out command on the View menu. Then use the Window command on the View menu to capture the view and margin you prefer.

If you make a mistake, enter U for undo, or select the back arrow icon that appears at the top of the screen.

6 On the Annotate menu, select Draw North Arrow.

Accept the default north arrow that is shown at the right side of the dialog, click OK, and place it in the upper right of your drawing. Choose Move on the Edit menu (or Enter M for move at the command line) and move it.

7 On the Annotate menu, select Draw Bar Scale. Accept the defaults, and then pick an insertion point below the north arrow and directly above the "a" in Farmer, and approximately the same distance from both. You can move the bar scale using the Move command on the Edit menu, if you need to.

8 On the Draw menu, select Dynamic within the Text command. Respond to the prompts as shown below:

Specify start point of text or [Justify/Style]: J
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: C for center justified
Specify center point of text: Choose a point near the top-center of the drawing.
Specify height <4.00>: 10 Entering 10 make the title text bigger than the default.
Specify rotation angle of text <E>: E
Text: Farmer Survey
Text: Ashland, KY
Text: press Enter

To enter a certification in the lower-right of the drawing, again select Text > Dynamic from the Draw menu, or type "dtext" at the command line. If you haven't done anything else, such as Zoom or Pan, you can simply press Enter to repeat the last command. If pressing Enter does not repeat the Text command, press Esc to cancel. Enter Dtext at the command prompt, and respond to the resulting prompts as shown below.

Pick a point above and to the left of the title block for the certification. You don't have to enter L for left-justification. The Dtext command defaults to left-justification every time.

Height <10.00>: 4
Rotation angle <E>: press Enter
Text: Surveyor's Certification
Text: Press spacebar, then press Enter
Text: I do hereby certify that the survey shown hereon
Text: is a true and correct representation.....
Text: press spacebar, then press Enter
Text: ____________________________
Text: Arnold James, PLS #2534
Text: press Enter twice to end

The following is a closeup of the certification that we just entered:

<table>
<thead>
<tr>
<th>Concrete Monument</th>
</tr>
</thead>
</table>

**Farmer Survey**

<table>
<thead>
<tr>
<th>DRAWN ABC</th>
<th>DATE</th>
<th>William T. Farmer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>04/13/05</td>
<td>102 Plum Avenue</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>APPROVED ABC</th>
<th>DATE</th>
<th>Ashland, KY 40202</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>04/13/05</td>
<td>March 25, 2005</td>
</tr>
</tbody>
</table>

| SCALE 1" = 50' | SHEET 1 of 1 | PROJECT NO. Lesson 1 |

9 Enlarge the two title lines ("Farmer Survey" and "Surveyor's Certification") by a factor of 2.0 using the command Text Enlarge/Reduce on the Edit menu, option Text. When prompted for Scaling Multiplier, enter 2. Select both the Farmer Survey text (at the top of the screen, not in the title block) and the Surveyor's Certification text. When asked
again to Select Objects, press Enter.

When you are selecting objects, if you select something you don't want, you can enter "R" at the next Select Objects prompt, and remove items from the selection set. If you want to add objects after you have removed an object, enter "A" at the next Select Objects prompt.

10 Make the enlarged Farmer Survey text at the top of the screen bold by changing its font to the bold font. Select the Text command from the Edit menu, Text, then select the Change Text Font option.

Select Objects: pick the Farmer Survey Text at the top of the drawing
Select Objects: press Enter for no more selections.
Style Name: Bold

11 Select the Edit Text command (under the Edit menu, Text option) to change
S 00°00'00" E to S 00° E. When you are prompted, "Select Text to Edit:" pick the due South bearing text. A dialog box appears as follows:

![Edit Text dialog box]

The degree symbol is represented as %%%d. (If you had typed N 15%%d25'35" E in the Dtext command, Carlson would draw that entry as N15°25'35"E.) Click in the text to the immediate right of the quotation mark and press the Backspace key until the text reads as shown here.

![Updated Edit Text dialog box]

Click OK. Press Enter to exit the command.

12 In the enlargement in Step 8 showing the title block and also showing point 5, notice how the linework travels into the circle that represents the point. To clip off the linework at the edge of the corner symbols, use the Trim by Point Symbol command on the Points menu. This command requires that all points be in view, so if you cannot see your entire drawing, use the Extents command on the View menu (sometimes referred to as Zoom Extents). Respond to the following prompts:

Select point symbols to trim against. Select objects: ALL
Entering "all" at the command line selects everything on the screen. Only the linework crossing into the corner symbols will be trimmed.
Select objects: press Enter
You can continue to select objects until you press Enter.
The trimming is completed.

13 Prepare for area labeling by selecting the Area Defaults command on the Area menu. The dialog box shown below appears. Change the Other Area Labels and Inverse with Area decimal precision to 4 decimal places. Also,
You are going to compute the area by point number. You could have chosen the *Area by Lines & Arcs* command. In that command, you would pick the lines and arcs that make up the figure. But since the closure was 0.017 off (the distance from point 7 to point 1), you would exceed the default Max gap tolerance. Unless you change that tolerance in this dialog box to something larger than 0.017, you would get no result using the *Area by Lines & Arcs* command. So do not change it for this exercise because you might forget to change it back. Instead, you will compute the area by inversing from 1 through 7 and back to 1. Click OK to exit the *Area Defaults* dialog box.

14 Select *Inverse with Area* on the Area menu. Respond to the prompts as shown below:

**Station/<Pick Starting point or point number>:** 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 2
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 3
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): R
**Radius point number or pick point:** CEN for center "snap"
Now move the cursor, without picking, to the arc and see how the center snap becomes active. When the radius point is found, pick on the arc.
**Curve direction [Left/<Right>]?** press Enter for the Right option
Pick End of Arc or point number (U-Undo, Enter to end): 4
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 5
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 6
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 7
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): press Enter to end

A Standard Report Viewer dialog box showing the Inverse with Area results will appear. Select Exit at the top of the dialog box and respond to the prompts as shown below:
This completes the Lesson 1 tutorial: Entering a Deed.

Lesson 2: Making a Plat

In this lesson you will draw out a plat of a single lot, using Carlson drafting techniques. You will make the plat from an ASCII file of points named Plat.txt.
1 Click the icon for Carlson. You may be presented with a Startup Wizard dialog box, as shown below:

You will use the Wizard in Lesson 3 to quickly perform a series of commands. In this lesson, however, you will enter the commands individually, so that you can see what each one does.

If you see the Startup Wizard dialog box, and you don’t want to see it again, click the Skip Startup Wizard Next Time option in the dialog box above. Make sure the other settings are as shown above and click Exit.

Another way to turn off the Wizard is to click it off within the Configure > General Settings command, found under the Settings menu. You will open this General Settings dialog box now.

2 On the Settings menu, click Configure to display the following menu:

Click General Settings to display the dialog box shown here.
The settings in this dialog box, along with the settings in other Configure sub-options, determine default working conditions for Carlson. Turn on Group Point Entities, which groups point elevations, numbers, and descriptions (all aspects of the points) into a single entity for moving, erasing and other commands.

Choose Numeric Only to store points in numeric form. This produces point numbers such as 1, 2, 3, 10 and 11. If you selected Alphanumeric, then you could have point numbers like 1A, 1B, 1C, HUB5, CTRL, SS10, etc. There is a slight speed advantage to working with purely numeric point numbers. The highest numeric point number allowed is 32000. Regardless of format, point numbers are stored in a file that has a .crd extension. There is no limit to the number of points in an alphanumeric coordinate file. In anticipation of Lesson 3, click on the Use Startup Wizard option. Click OK at the bottom of this dialog box.

Now we want to set the data path. Another of the Configure sub-options is Project/Data Folders. Click this option and you will see this dialog box.

For this lesson, you will keep it simple. Click on Fixed Folder at the top. Notice the Current Data Folder section at the bottom. This specifies where data files, such as .crd files in this case, are to be stored. Set the folder to
3 Select *Drawing Setup* from the Configure main dialog box.

The scale acts as a multiplier on all text annotation. For example, 100 * Text Plot Size (0.08) = 8 (text height of 8 units). The Text Plot Size is the effective height, in inches, that the text will appear when plotted at the Horizontal Scale (here 100).

Bearings and Distances, Legends, Title Blocks, and Point Symbols will size up or down on the basis of the Horizontal Scale set within *Drawing Setup*. Set the Horizontal Scale to 100. Then click OK to exit Drawing Setup. Then click Exit to close the Configure dialog box.

4 Next, you will import the ASCII file called Plat.txt and store the points in a Coordinate file called Plat.crd. However, since you are in a new drawing, you have not yet set a coordinate file to store the points in. You must have a Carlson coordinate file (.crd) open and established as the container for your points.

So, under the Points menu, select the command *Set CoorRDinate File* to display a dialog box. Click the New tab, as shown here. To the right of File name enter Plat and click Open. You have now created the required .crd file.
You are now ready to import the points. This time, under the Points menu, select **Import Text/ASCII File** to display the Text/ASCII File Format dialog box, as shown below. Click the Select Text/ASCII Files button and then choose Plat.txt listed on the right. It is found in the default data folder (C:\Carlson2008\Data). Click Open.
Plat.txt is an ASCII file containing 54 points in the form of Point Number, Northing, Easting, Elevation and Description. The format of the points appears in the Preview Window. The format is: Point (P), Northing (Y), Easting (X), Elevation (Z), Description (D), or, in short, P,Y,X,Z,D. You must match this format in the Coordinate Order. If you don't see P,Y,X,Z,D in the Coordinate Order box, then select that format from the Common Formats option. Or, you can type the list directly into the Coordinate Order box. Make sure that Draw Points is set to Off.

Click OK. The points will be saved and stored in Plat.crd. A confirming dialog appears as follows:

![AutoCAD Message]

Click OK.

5 Choose the List Points command under the Points menu.

![List Points]

The List Points dialog box will typically default to the full range of points, which is 1 through 54 in this exercise. You can control the decimal places for the Northing/Easting and the Elevation of the points in the lower portion of the dialog box. Click OK and the settings shown above result in the report exhibited below in the Standard Report Viewer:
Exit the report by selecting the Exit icon at the top of this report viewer box, or by clicking the X in the upper right of the window.

6 Select the Draw-Locate Points command on the Points menu to draw the points on the screen.
In this figure shown above, the current Symbol Name is showing as SPT10, which stands for Survey Point symbol 10. SPT10 is an X, shown in the symbol display window. You can select a different default symbol using the Point Defaults command on the Points menu.

In this exercise you will change the Symbol Name to null, or symbol 0, listed as SPT0 (in effect, no symbol). Later, you will add official property corner and utility symbols. Although you are working without a default symbol, there will always be a "dot" or a node at the correct insertion point of each point number.

At the top click Select. You will see the following dialog box:

![Select Symbol dialog box](image)

Note that the scroll bar at the right of this Select Symbol dialog box leads to more pages of symbols. Click the blank SPT0 point symbol option.

When you select a symbol, you automatically return to the Draw-Locate Point dialog box. Click Draw All to display the rather busy drawing shown below:
You will now be using the *Scale Point Attributes* command on the Points menu. Notice how the lower-right corner of the drawing is very congested, with many point attributes overlapping. You can specify a window containing these points and scale them down by a factor of 0.4. For Scaling Multiplier, you will enter 0.4. When you are prompted to Select Carlson Software points, you will enter WP for Window Polygon and make a polygon around the congested area. Press Enter when you have surrounded the points with the polygon as shown below. Here is the command line sequence, along with the responses you will enter, after clicking *Scale Point Attributes*:

**Scaling Multiplier**: \( \langle 0.500 \rangle : .4 \)

Scale symbols only, point labels only or both [Symbols/Labels/\(<\text{Both}\)>]? press Enter

Select points from screen, group or by point number [\(<\text{Screen}/\text{Group}/\text{Number}\)>]? press Enter

Select Carlson Software points.

Select objects: wp

First polygon point: start creating your polygon
Once this polygon is complete, you are again prompted to select points. Press Enter. The following shows the scaled points.

8 Next, you will prepare for drawing linework by setting the current layer. You should draft linework and symbol work in designated layers. In this example, you will put linework and symbol work in a layer named Final. (You could put property linework in the Final layer and utility linework in the Utility layer, but, for now, you will put all linework and symbols in the layer Final.) To pick the current working layer, select the Layer Control command from the View menu.
Click Final. Click Current. Click OK.

The 2D Polyline command allows you to enter point numbers to draw a line. First, connect portions of the property line. Select the 2D Polyline command on the Draw menu. A dialog box might appear. If it does, accept the defaults and click OK.

This creates a polyline. Keep this as a separate polyline because later you will turn this back lot line into a fence line.

Now, connect some of the other property lines. Repeat the 2D Polyline command. You can press Enter to
repeat the command, or you can select it from the Draw menu. Connect points 8 through 10, and start an arc, by entering as follows:

[Continue/Extend/Follow/Offset/OOptions/<Pick point or point numbers>]: 8-10

[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: a

[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: 15

[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: 1

[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: press Enter to end the command

This creates the full lot, with the arc coming off point 10 on a tangent. The line from 15 to 1 is not guaranteed to be tangent to the previous arc.

You should have the following linework at this point:

![Diagram of the linework created so far](image)

10 You will now create a fence line on the polyline you drew from points 1 to 8. Go back to Drawing Setup from the Settings menu and set the Horizontal Scale to 50. Click OK to exit Drawing Setup.

Now, choose the Line Types command on the Annotate menu and select the Change Polyline Linetype command. The Line Types command creates polylines that respond as one entity when selected. When the dialog box appears, click Next twice to display the dialog box shown below.
Choose the Fence_S option (the solid fence line).

When prompted to Select Objects, pick the polyline you created from points 1 to 8. Press Enter to end selection. Notice in the dialog box above that the current Line Type Scaler, governing spacing, should be 0.5 (inches) and the Text (height) Scaler is 0.1. If your settings are different, you may want to Undo (by entering U for undo) the fence line and select the Annotate Defaults command on the Annotate menu, and set these items to match the example.

On the View menu, select the Isolate Layers command, pick the property line, and press Enter twice. Here is the result:
Next, you will connect up the edge of pavement. On the View menu, select the *Restore Layers* command to restore your points. Then select the *2D Polyline* command under the Draw menu. Again, a dialog box might appear as shown below. If it does, make sure that the options selected are the same. In the future you can choose not to see this box.

Click OK. Proceed as follows to connect up the edge of pavement:

**[Continue/Extend/Follow/Options/<Pick point or point numbers>]**: 45-47, 49-51

Press Enter at the next prompt to exit the command and create the road. Press Enter one more time. Note how you can separate range entries using a comma.

To smooth the edge of the road, select the *Polyline Utilities* command on the Edit menu, and select *Smooth Polylines*.
Enter the looping factor (1-10) <5>: press Enter
Enter the offset cutoff <0.05>: press Enter
Select objects: pick the edge of road polyline
Select objects: press Enter

13 To offset the smoothed edge-of-road polyline by 24 feet to make the opposite edge of the road, Select the Standard Offset command on the Edit menu.

Specify offset distance or [Through/Erase/Layer] <Through>: 24
Select object to offset or [Exit/Undo] <Exit>: pick the edge-of-road polyline
Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: pick to the right of the polyline
Select object to offset or [Exit/Undo] <Exit>: press Enter to end the command

Now, select the Isolate Layers command again from the View menu, pick on any of your linework, and only the entities on the picked layers are displayed.

Select the Restore Layers command from the View menu to recover your points. Experiment with the "cadence" of Isolate and Restore Layers. Select Isolate Layers, pick the layers to isolate, then press Enter twice. Then select Restore Layers.

14 Next, you will draw the shed. Select the 2D Polyline command on the Draw menu. To draw a two-sided shed, connect points 5 through 7 as follows:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 5-7, press Enter twice

This produces the 2-sided building shown here:

Select the 4 Sided Building command on the Survey menu. Turn the 2-sided shed into a 4-sided shed as follows:

Options/<Pick a line or polyline>: Pick the shed

Now your 2-sided building looks like this:
Focus your attention on the area of tightly spaced points with point numbers ranging from 27 to 44. This is the driveway and paving area. In the case of the driveway, assume that the surveyor who collected the points shot in 3-point arcs. They came up to a PC, shot a point on the arc, and finished up at the PT.

On the View menu, select the Window option, and pick a lower left and upper right point that windows the driveway area. (If you wish to use the View>Previous command to zoom out, then use View>Window to zoom in again.) Select the 2D Polyline command under the Draw menu, and walk the polyline through the two arcs as follows:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 27
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 28
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: S
Use S for 3-pt arcs.
Second point or point number: 29
Endpoint or point number: 30
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: 31
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: S
Second point or point number: 32
Endpoint or point number: 33
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
In the above exercise you started at point 27, went to the PC at point 28 and inserted a 3-point arc through points 29 and 30. You proceeded tangent to point 31, which was another PC, then completed a 3-point arc through points 32 and 33, and ended.

Now, connect up the basketball court area. Select the 2D Polyline command under Draw, or press Enter to repeat the previous command.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 27
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 44
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: 43-39 (you can enter "backwards" ranges)
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A
16 Next you will make a building footprint. Points 18 and 19 are two shot corners of a building. Assume that the surveyors taped the main house, going clockwise from point 18, as follows: 10'L, 20'R, 40'L, 20'R, 20'L, 83'L, 60'L, 23'L, 10'R.

You can easily enter these "jogs" in the building using the Extend by Distance command. If you are zoomed in on the driveway, use View > Zoom > Zoom Out, then View > Pan to focus on the building north of the driveway. Now use the 2D Polyline command on the Draw menu to draw a line from 18 to 19.

**Pick point or point numbers:** 18

**Undo/Arc/Length/**<**Pick point of point numbers**>: 19, then press Enter twice to end

Select the **By Distance** option from the Edit menu, **Extend** command.

**Pick line or pline to extend:** *pick the building line closer to point 18*

This makes the arrow point toward 18 rather than 19. Now you can go clockwise:
Enter or pick distance to Draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):  L10 (lower case 'l' and 'r' work also)

17 Next, you will complete the linework for the sewer line and the electric utility line. Use the View > Extents command so you can see all your points.

The sewer line runs from points 52 to 53 to 54. Select the 2D Polyline command from the Draw menu. To create the sewer line, enter the following:

[Continue/Extend/Follow/Options/ <Pick point or point numbers>]:  52-54, press Enter twice to end

You will next annotate the sewer polyline using the Change Polyline Linetype command, but first you must set the default spacing for the annotation. Select the Annotate Defaults command on the Annotate menu. The following dialog box appears.

![Annotate Defaults dialog box](image)

Change the Line Type Spacing to 1.5. This will label "S" on the sewer line every 1.5" at the current scale (1"=50').

To annotate the sewer line with an S, select the Line Types command on the Annotate menu, then choose Change Polyline Linetype. Within the dialog box, click Next four times, select the Sewer linetype from the list, and then...
select the sewer polyline that runs next to the road. The polyline will be annotated.

Next, create the electric utility line, which runs from point 3 to point 4 to point 17. Select the 2D Polyline command on the Draw menu.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 3
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 4
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: 17
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter twice to end

No points were taken beyond point 17, due to obstructions from the various setups in the field. So you must extend the polyline from point 17 to beyond the property. Under the Edit menu, choose Extend, then By Distance. Pick on the electric utility polyline near point 17. Then pick beyond the property. Press Enter to end.

Before you annotate the electric utility line, you must offset it 25' on both sides, for a 50' total right-of-way. You will do this using Standard Offset. Select the Offset>Standard Offset command under the Edit menu. Enter the offset distance of 25. Pick the electric utility polyline and then pick to one side for the first offset. Repeat for the other side, by first picking the electric utility polyline, then picking the other side for the offset. Press Enter to end.

Now annotate the central electric line with an E by selecting the Line Types command on the Annotate menu, then choose Change Polyline Linetype. Choose the Electric linetype, which appears on the second page of linetypes. Then select the electric utility polyline to annotate it, and press Enter.

Next, make the Property lines bold. Under the Edit menu, select Polyline Utilities, then Edit Polyline and then select Change Polyline Width.

New Width <0.0>: 1.5
Select objects: pick the property polylines while holding down the Shift key. Pick once for the fence line portion and once for the remaining property lines.
Select objects: press Enter to end

To add color and improve layer management, make a layer for your road and driveway. Select the Layer Control command on the View menu.

Click the New Layer button, and enter the name "Road" for the new layer. Choose the color cyan by clicking the color square to the right of the layer name. Click OK.

On the View menu, select the Change Layer command.
Select entities to be changed.
Select objects: with Shift key held down, pick all driveway and road entities and press Enter

This brings up the dialog box shown below. Select ROAD and click OK.
Your linework is now complete and is shown below:

If you have not already saved your drawing, now is a good time to do it. Use the Save command on the File menu, and call the file Lesson2.dwg.

20 You will add symbols for trees, property corners, manholes and a light pole.

Start with the trees. Points 11, 12, and 20 are oak trees of different sizes, and point 14 is a pine tree. Use symbol 61 for the deciduous oak trees and symbol 53 for the pine tree. On the Draw menu select Symbols. Then select the Insert Symbols command. The following dialog box appears.
Click the Select button, and within the Select Symbol dialog box, use the down arrow at the right to scroll forward to the tree symbols, which are several pages deep. Choose symbol SPT61. You can also choose Trees under the Symbol category field in this dialog. You are returned to the Insert Symbols dialog box.

Click the Select Layer button, and type in TREES in the Layer Name field. This creates a Trees layer if one does not exist. Click OK. For the Symbol Size use 18. A symbol size equal to the diameter of the tree is often effective. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 11
Options/Select entities/Enter Coords/<Pick point or point numbers>: 20
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 61 on the larger point 12 at size 24. Press Enter to repeat the last command, or once again select the Insert Symbols command from the Draw menu. Symbol 61 will now be the default. Change the Symbol Size to 24 and click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 12
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 53 on the larger point 14 at size 8. To do this, press Enter to repeat the last command, or select Insert Symbols from the Draw menu. Select symbol 53 and a Symbol Size of 8. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 14
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 5 (representing an iron pin) on points 8-10 and point 15. Repeat Insert Symbols by pressing Enter to repeat the last command, or again select the Insert Symbols command from the Draw menu. Select symbol 5 (first page) and leave the Symbol Size of 8. Change the layer to FINAL. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 8-10,15
Wildcard match of point description <*>: press Enter
This puts symbols on points 8 through 10, as well as point 15.
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter
Place a concrete monument (symbol 13) on point 13 on layer FINAL. Keep the Symbol Size of 8. Press Enter to repeat the last command, or select the Insert Symbols command from the Draw menu. Select symbol 13.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 13
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place a manhole (symbol 34) on the vertices (endpoints) of the sewer line, at points 52 through 54. You could use the above method, but you can also use S for Select entities, and place the symbol automatically at the vertices of the selected entity.

Select the Insert Symbols command from the Draw menu. Select symbol 34 from the list. Keep with layer FINAL and Symbol Size 8. Click OK.

Options/Select entities/Enter Coords/<Pick point of point numbers>: S
The following dialog box appears. Click OK.

Select arcs, circles, faces, points, text, lines and polylines.
Select objects: pick the sewer polyline

The symbols are inserted at the three polyline endpoints.

21 You can reduce clutter by selecting the Freeze Layer command under the View menu, and picking a point number. The points freeze, leaving only linework and symbols. To bring the points back, use the Thaw Layer command under the View menu. The Freeze Layer and Thaw Layer commands go together, just like the Isolate and Restore Layers commands.

22 Next, you will create (in reduced size) your building dimensions. You can set the building dimension text size for the current work session using the Survey Text Defaults option of the Survey Text command on the Annotate menu. However, you can set the text size permanently using the Configure command on the Settings menu, then selecting the Configure command. Use this last method. This dialog box appears:
Select Survey Settings and the following dialog box appears:

Choose Survey Text Defaults. The following dialog box appears:

The changes you will make are in the upper-left section "Building Dimensions." Change the Text Size Scaler to
0.04, change Offset From Line to 0.02, and select Drop Trailing Zeros.

The Drop Trailing Zeros option will label 17.0' as 17'. To save more space, you could blank the Characters to Append box, but not this time. Enter the name of a new layer for the building text called BTXT, so that building dimensions can be frozen to reduce the clutter even more. It is generally a good strategy to use layers for selective freezing and thawing.

Click OK on the above dialog box, then click Exit until you return to the command prompt. On the Annotate menu, choose the Survey Text command, Building Dimensions option. Click on the middle of the bottom segment of the building and then drag the alignment to the right, along the same bottom segment being dimensioned. The resulting label is shown below.

[Diagram of building with dimensions labeled]

If you had dragged the cursor to the left rather than to the right, with the same near-parallel angle to the line, the 83' would be drawn below the building rather than above.

Another example is shown below. Select Annotate > Survey Text > Building Dimensions, and click on the left-most segment of the building. Then click roughly perpendicular to the left. This creates a perpendicular, rather than parallel, label as shown below.
Label the rest of the building. Notice that the sides of the building that you are dimensioning are measured in even feet. Because you had selected the Drop Trailing Zeros option when you set your Survey Text Defaults, and you set the Decimal Places default at 0.0, the ".0" is not reflected in the labels.

If you choose the wrong direction while you are labeling, you can exit the command, or you can erase the incorrect dimension by typing E for erase at the command line, or you can enter U for undo to back out your last work. Once the labels are in place, you can type M for the Move command, and move the text to the desired position.

Next, you will label the offset dimension from property lines to two building corners, the SE corner as offset from the south property line, and the SW corner as offset from the west property line. Because of the options you set in the Survey Text Defaults dialog box above, Offset Dimensions will be created on layer DTXT, and they will be horizontal, with arrowheads.

On the Annotate menu select Survey Text, Survey Text Defaults. The dialog previously shown will reappear. Change the Text Size and Arrow Size Scalers to 0.040. Then select Dual Arrows Line and click OK. On the Annotate menu, select Survey Text, Offset Dimensions option.

**Pick Bldg/Object Corner:** pick on the SE building corner

**Perp** Pick Line To Offset From: pick on the South property line (before the arc, near the end of the driveway)

The setback is labeled 43.5 ft. Why "ft" and not " ' " for distance? If you review the Survey Text Defaults dialog box again, you will see that you set the Characters to Append option to "ft".
On the Annotate menu, select Survey Text > Survey Text Defaults. Under Offset Dimension Text, change the characters to Append to an apostrophe, ".". Also, change the Text Alignment to Parallel instead of Horizontal. Click OK. Select Annotate > Survey Text > Offset Dimensions.

[end on] Pick Bldg/Object Corner: pick on the SW building corner  
[perp] Pick Line To Offset From: pick on the West property line (avoid the electric right-of-way line)

Use the Move command to move the 20' text label to the right, so that it is not overwritten by the offset dimension. The result is shown below:

Notice the display, within the above prompts, of the [end on] and [perp] snaps. When Carlson sets a snap for temporary use, it displays the snap within the brackets as shown. A building corner is always an endpoint, so the end snap always applies to the first pick. The offset is the perpendicular distance to the property lines, so the [perp] snap always applies to the second pick. The per, or perpendicular, snap applies to offsets from arcs as well. In the case of arcs, the per snap finds the shortest, radial distance to the arc.

When you enter a snap at the keyboard in response to a "Pick object" request, type only the first 3 letters of the snap, such as "per" or "end". You could use the Offset Dimension command to label the Electric utility right-of-way distance of 50' total by entering "nea" (for nearest snap) for the first pick, then entering the default "per" snap for the second pick on the other side of the right-of-way.

24 Next, you will add adjoiner ownership text to the property lines. Select the Survey Text Defaults command, under the Annotate menu, and set the Adjoiner Text Justification option to C for centered, and the Text Size Scaler to 0.06. Click OK and then select the Adjoiner Text option on the Annotate > Survey Text command.

Pick Line Or Polyline: pick the west property line  
Pick Starting Point: pick a centering point west of the property for the adjoiner text  
Text: Brian W. and Mary T. Jones  
Text: D.B. 101, P. 37  
Text: press Enter twice

This produces parallel, center-justified text on the west side of the property. Repeat the command for the north side. Press Enter to repeat the Adjoiner Text command or select it from the menus.

Pick Line Or Polyline: pick the north property line
**Pick Starting Point:** pick a centering point north of the north property line

**Text:** Stan W. Bosworth

**Text:** D.B. 94, P. 272

**Text:** press Enter twice

The results are shown here:

25 Next, you will add bearing annotation. Select the Annotate menu, choose Angle/Distance, select the BearingDistance option to place Bearing and Distance above the line.

**Define bearing by, Points/<select line or polyline>:** *pick the northern property line to the east, or right side* The bearing direction will be labeled towards the picked end, which is northeast.

**Define bearing by, Points/<select line or polyline>:** *pick the eastern property line* Pick closest to the southern endpoint of the line

To label the western property line on the lower (western) side of the line, select the _BearingDistance option of the Angle/Distance command.

**Define bearing by, Points/<select line or polyline>:** *pick the western property line on the northern portion of the line*

To label the southern line segment with a leader, on the Annotate menu select the Annotate w/Leader command, Brg-Dist w/Leader option.

**Options/Points/<Select line or polyline>:** *pick the southern property line segment* on the southwest side

**Pick point to start leader:** *pick a point* to start and locate the pointed end of the arrowhead

**Pick next leader point:** *pick a point* Pick a point off to the right for the left-justified bearing and distance

**Pick next leader point (Enter to end):** *press Enter*

**Options/Points/<Select line or polyline>:** *press Enter* to end

26 Next, you will want to annotate the arc in the drawing. The label will consist of four entries: arc length, radius, chord bearing (angle) and chord distance.
Select the *Annotate Arc* command, on the Annotate menu, and choose the *Stack Label Arc* option. The Stack Label Arc dialog box appears.

![Stack Label Arc dialog box](image)

Set the sequence column to 1, 2, 3 and 4 as shown. Remember that changes to this box apply only to this work session. To set these options permanently, go to the Settings menu, choose *Configure > Survey Settings* and choose the *Stack Label Arc* command. When you are done with the dialog box, click OK.

**Define arc by, Points/<select arc or polyline>:** pick the arc

**Pick point for labels:** pick a point to the right to place the label

As the cursor moves, the text "ghosts", allowing you to make the best possible placement decision

**Pick point to start leader at ([Enter] for none):** pick a point on or near the arc for the arrowhead

**Define arc by, Points/<select arc or polyline>:** press Enter to end

Sometimes Carlson displays an arc as a series of chords. Type Regen at the command prompt to "regenerate" the arc. Even if an arc shows up on the screen as a group of jagged chords, it will plot as a smooth arc to a printer or plotter.

27 Next, you will label the trees, the shed, and the building using a special leader, for a hand-drafted appearance. Under the Annotate menu, select the *Special Leader* command.

**Options/Pick Arrow Location:** pick near the southern most corner of the shed

**Text location:** pick slightly down and to the right

**Text:** Shed

**Text:** press Enter twice to end

Repeat the process for all the special leader text items shown in the drawing below. In the case of the 18" Oak trees, create just one leader with text, and on the second oak tree, create only the leader, and then press Enter when asked for Text. For the best appearance, enter 18"Oak and 24"Oak with no spaces between the characters.

Your drawing should be similar to this one:
28 You can add a North Arrow and Bar Scale by selecting these options under the Annotate menu. When you place the North Arrow, pick your North Arrow symbol, maybe change the scale, and click OK. Then pick an insertion point. You place the Bar Scale by answering the prompts and picking a location. Both the North Arrow and the Bar Scale can be moved to desired locations with the Move command on the Edit menu.

29 Next, you will insert a title block with a border. Select the Title Block command from the Settings menu.
Choose paper size A1 (portrait view, 8-1/2 by 11). Click OK. Pick a point below and to the left of the survey in order to locate the lower-left corner of the border outer line. Remember that the title block will be at the bottom, so leave extra room at the bottom.

The following dialog appears, prompting you for the attributes of the title block. Be sure to also click Next in order to enter in more attributes.

![Image of Enter Attributes dialog]

Your drawing should resemble the one shown below.

![Image of completed drawing]
Next, you will add a legend. On the Annotate menu, select the *Draw Legend* command. Choose the New tab, then Open the default legend name. When the dialog box appears, select Add from Drawing. You will make one pick for each symbol you want to appear in the legend. So, with the Shift key held down, select one of the sewer manholes, one of the iron pins, the concrete monument, one oak tree and the pine tree. Press enter. You will then see the symbols that you picked listed.

If you want to change the order of the items in the list, use the Move Up and Move Down buttons, after first selecting and highlighting the item to be moved. After the list is ordered correctly, highlight one item on the list and click the Edit button to edit the symbol definition.

Edit each symbol definition individually, typing the following descriptions in the description box:

SPT5 = "Iron Pin"
SPT34 = "Manhole"
SPT13 = "Concrete Monument"
SPT 61 = "Oak Tree"
SPT53 = "Pine Tree"

Below is the symbol definition, with Description, for SPT13.

After you have entered the descriptions for the symbols, choose the Add option from the Legend Definition dialog box, and add the Fence Line type to the list by picking the Select Linetype command, as shown below:
Save the completed legend, which is shown below.

Select the Draw option from the Legend Definitions dialog box. Set the defaults as shown below.
Click OK. Pick a point for the legend, at roughly 5260,4380. Then click Exit.

You may need to move the fence line portion of the legend to fit in the tight space. You also may need to move the previously drawn bar scale. Use the *Move* command to do this. The following shows the drawing to this point:

If you wish to reset the spacing of the sewer and electric utility annotation, use the LTSCALE box in the Drawing Setup dialog box, under the Settings menu, to set it. (The setting is 50, in this example).

31 Next, you will use Dtext to label the road and Mtext to create a certification block. Zoom in on the area shown below. At the command line, type Dtext.

Specify start point of text or [Justify/Style]: R (for right-justified)
Specify right endpoint of text baseline: *pick a point* shown below, just to the left of the leader annotation
Specify height <8.00>: 10
Specify rotation angle of text <E>: *pick a point* as shown below by the location of the crosshair

Text: Meadow Lane
Now you will enter a certification using Mtext. The Mtext command stretches an entire block of text. This command breaks up the lines in the block of text, depending on how you edit and adjust the Mtext window. First, use the View > Extents command to view the entire drawing. Then, at the command line, type in Mtext.

**Specify first corner:** *pick a point* in the 5660,4980 range  
**Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]:** *pick a point* below and to the right of the first, but inside the inside border line.

You now see a dialog box that displays all the text heights that you have used in the drawing. Choose the text height of 8. Then type the following into the dialog box:

```
Surveyor’s Certification

I do hereby certify that the survey shown hereon was performed under my direction by method of random traverse, and that the error of closure was 1:52544

----------------------------------------------
B Brad Smith     PLS No 11952
```

The command adds carriage returns to the text when it runs out of space in the Mtext window. Click OK at the upper right to place this text into the drawing.

After the Mtext is plotted, you can click on the text to activate the grips. All 4 corners highlight as grips. Pick on a grip, and then you can expand or change the shape of the Mtext rectangle. When you do this, the text adjusts automatically, adding more lines and carriage returns, or condensing many lines into fewer, but longer, lines of text. You can also move the entire text block to a new location.

**32** Next, you will define a text style, then add text using that style. On the Draw Menu, under Text, choose select the *Set Style* option. The Text Style dialog box appears. Click New, enter Bold in the New Text Style dialog, and click OK.
Create a Bold Style consisting of the Arial Black font tilted at a 10 degree oblique angle, by entering the settings as show below.

![Text Style dialog box](image)

Then click Apply and Close. Now, run the Dtext command by typing Dtext at the command line, and place the text at the top of the drawing as follows:

**Specify start point of text or [Justify/Style]:** pick a point near the northwest corner of the drawing  
**Specify height <10.00>:** 20  
**Specify rotation angle of text <N 54d40'16'' E>:** E for due East  
**Text:** William T. Farmer  
**Text:** press Enter twice

33 Next, you will create an area label for the drawing. Select the Area Defaults command, under the Area/Layout menu, and change the Precision for Other Area Labels to 2 decimal places.

Select the **Areas by Lines & Arcs** command, under the Area menu. When prompted to Select objects, pick the 2 polylines that, taken together, completely enclose the property.

Pick an area labeling centering point for the area label under the William T. Farmer title at the top of the drawing.

34 Next, bring the points back and draw a contour map. To draw the points, use the **Thaw Layer** command under the View menu. If you did not complete this lesson in one sitting, then Carlson won't "remember" what layer to thaw. In that case, select the **Layer Control** command on the View menu, and thaw the PNTS layer by turning the snowflake to a sun symbol.

Go to the Surface menu and select the **Triangulate & Contour** command. Click the Contour tab.
In this Contour tab section, change the contour interval to 1.0. Now click on the Triangulate tab, then click on Use Inclusion/Exclusion Areas. Press OK and then answer as follows:

**Select the Inclusion perimeter polylines or ENTER for none.**

**Select objects:** press Enter

We have no "inclusion" perimeter.

**Select the Exclusion perimeter polylines or ENTER for none.**

**Select objects:** select the building and the shed while holding down the Shift key, then press Enter

Since the building and shed are closed polygons acting as exclusion perimeters, the contours will not pass through them when they are created.

**Select the points and barrier lines to Triangulate:** select a window around the points by picking from the lower left to the upper right

The contour map is created. Freeze the points again by using View > Freeze Layer and picking one of the points.

Next, label the contours. Select the Contour Elevation Label command from the Surface menu > Contour Labels. Select OK after matching the settings in the dialog box shown here:
Now pick two points that cross through one or more contours. The contours are automatically labeled using the current text style. You can use the Change Text Font command, part of the Text command in the Edit menu, to change the font to Romans, or to another font, if you wish to.

The Completed Plat is shown here:

If you have not saved your drawing for awhile, now is a good time to do it. Use the Save command on the File menu. Now we are ready to plot the drawing.
Before plotting it's a good idea to do a **Zoom Extents**, then a **Zoom Out** (both on the View Menu) before executing the plot command.

To get started, choose Plot from the File menu. There are many variables that can affect how the dialog box will look, such as what version of AutoCAD you are using. Here is a common Plot dialog box:

![Plot Dialog Box](image)

With this layout, you have two tabs on the dialog labeled "Plot Device" and "Plot settings". We will start with "Plot device". The first thing to select is your plotting device (see arrow #1). Here DWF6 ePlot.pc3 is already selected, and that is what we want to use. Next, arrow #2 points to the "What to Plot" section. In this version of AutoCAD, you are either working in the model tab or one of the layout tabs. Our example is drawn in the model tab, so the option labeled "Current Tab" should be selected. If you want more than one copy of your plot, this is where you would change that number. Arrow #3 points to the plot settings tab. Click on here next. Now the dialog should look like this:
Now we are on the "Plot settings" tab. Arrow #4 points to where you can change the paper size and units. Here we chose 8.5 X 11 for our size and inches for our units. The next thing to select is the drawing orientation, arrow #5 shows you where this is. We will choose portrait.

Now looking at arrow #6, we want to choose the window button in order to select the area we want to plot. After you select this button, the dialog will disappear and you can select the upper left and the lower right corners of the drawing border. When you finish, the dialog will reappear.

The next thing to do (arrow #7) is choose the correct plotting scale, our drawing is 1"=100' or 1:100. Choose this from the dropdown list. Now we are ready to preview the plot. Press the Full Preview button in the lower left corner of the main dialog. Press ESC to return to the main dialog. One new feature starting in AutoCAD 2000 is the ability to save all the information you have just entered in a "Page Setup". In the upper part of the dialog, check on the box labeled "Save changes to layout", then to the right of that, click the button labeled "Add". A new dialog will appear, at the top of this dialog, enter a name to save your page setup as and click OK. I chose 8.5 X 11 STD. You can see this in the dialog shown above. If your plot preview looked OK, choose OK from the bottom of the dialog and your plot is on its way. The advantage to saving the page setup is that you can open this drawing tomorrow or 3 weeks later and choose 8.5 X 11 STD as your page setup, and then choose OK to plot the drawing exactly like you did today, without having to remember all the settings yourself.

This completes the Lesson 2 tutorial: Making a Plat.

**Lesson 3: SurvNET**

This tutorial is divided into two lessons covering the process of reducing and adjusting raw survey data into final adjusted coordinates, using the SurvNET program. The tutorial will describe the reviewing and editing of the raw data prior to the processing of the raw data. Next, the least squares project settings will be described, and then the
The final report generated from the least squares processing will be reviewed. This tutorial will review both a total station only project, and a project that combines both total station and GPS vectors.

The raw data files associated with this tutorial are located in the Carlson2008\Data folder, under the installation folder on your computer (example: \Carlson2008\DATA).

**Lesson One - Processing an Assumed Coordinate System 2D Total Station Network**

1. The easiest way to start the program is to select *SurvNET* from the Survey menu. This opens the SurvNET window and program.

2. The first step is to open an existing project or create a new project. We will open an existing project. Choose *Open Project* from the File menu. Navigate to the \Carlson2008\DATA\ folder and open the SurvNetTut01 project.
Learning the meaning and implications of the different project settings is the most critical initial step in learning how to use SurvNET. Let's review the different project screens. Choose Project from the Settings menu.

Least Squares Settings

The Network Least-Squares Settings dialog box is displayed. In this dialog, the different settings required for the Least Squares reduction are available in the different tabbed dialog boxes. When all of the settings are set as desired, press OK to save the changes to the project settings, or press Cancel to return to the raw data editor without saving any project settings. For the purpose of this tutorial, the Coordinate System settings tab should look as follows before proceeding to the next step. To use an assumed coordinate system, the 'Local' Coord. System.
needs to be checked, and the 2D,1D Adjustment Model must be chosen. When using a local coordinate system, the distance units are not important other than for display purposes in the report. Computing elevation factors and performing geoid modeling is not applicable to assumed datums. Notice that in this example we are not performing a vertical adjustment.

For more information on the content of this dialog box section, please review the SurvNET chapter of this manual.

Choose the 'Input Files' tab. This is the section of the Settings dialog box where you define the data files that make up the project. You can have multiple raw files in a single project. The ability for multiple raw files allows flexibility in collecting the data and processing large projects. It is typically easier in a large project to analyze and edit subsets of the total project, before combining all the data for a final adjustment. Notice that since we are working in a local coordinate system and using the 2D,1D Adjustment Model, GPS vectors cannot be incorporated into this project.

Note: The sample tutorial project has the input raw file in the default data folder of C: \Carlson2008\DATA. If you have a different data directory, then set the correct data file by highlighting the default file, pick Delete and then pick Add and select SurvNetTut01.rw5 from your data folder.
Choose the Preprocessing tab to review the least squares preprocessing settings. For the purpose of this tutorial, the Preprocessing settings should look as follows before proceeding to the next step. Preprocessing consists of reducing and averaging all the multiple measurements, applying curvature and refraction correction, reducing the measurements to grid if appropriate, and computing unadjusted traverse closures if appropriate. Much of the data validation is performed during the preprocessing step.
For more information on the content of this dialog box section, please review the SurvNET chapter of this manual.

7 Choose the Standard Errors tab to review the standard error settings. The standard error settings should look as follows before proceeding to the next step. Standard errors are an estimate of the different errors you would expect to obtain based on the type equipment and field procedures you used to collect the raw data. For example, if you are using a 5 second theodolite, you could expect the angles to be measured within +/- 5 seconds (Reading error).

8 Choose the Adjustment tab to review the Adjustment settings. The Adjustment settings should look as follows before proceeding to the next step. The Adjustment settings affect how the actual least squares portion of the processing is performed. Additionally, from the screen the user can set whether ALTA reporting is performed.
Choose the Output Options tab to review the output settings. For the purpose of this tutorial, the Output Options settings should look as follows before proceeding to the next step. These settings apply only to the output of data to the report files. These settings do not affect computational precision. Press OK to return to the main SurvNET screen.
General Rules For Collecting Data for Use in Least Squares Adjustments

Least squares is very flexible in terms of how the survey data needs to be collected. Generally speaking, any combination of angles and distances, combined with a minimal amount of control points and azimuths, are needed. This data can be collected in any order. But there needs to be at least some redundancy in the measurements.

Redundant measurements are measurements that are in excess of the minimum number needed to determine the unknown coordinates. Redundancy can be created by including multiple GPS, and other control points, within a network or traverse. Measuring angles and distances to points in the network that have already been located create redundancy. Running additional cut-off traverses, or additional traverses to existing control points, creates redundancy. Following are some general rules and tips in collecting data for least squares reduction.

- Backsights should be to point numbers. Some data collectors allow the user to backsight an azimuth not associated with a point number. SurvNET requires that all backsights be associated with a point number.
- There has to be at least a minimum amount of control. There has to be at least one control point. Additionally, there needs to be either one additional control point or a reference azimuth. Control points can be entered in either the raw data file, or there can be a supplemental control point file containing the control point. Reference azimuths are entered in the raw data file. The control points and azimuths do not need to be for the first points in the raw file. The control points and azimuths can be associated with any point in the network or traverse. The control does not need to be adjacent to each other. It is permissible to have one control point on one side of the project, and a reference azimuth on the other side of the project.
- At least one of the control points needs to be occupied. There may be situations where no control point is ever occupied in the network, but only backsighted. In these situations, a preliminary value for one of the occupied points needs to be computed and entered as a floating point control point.
- Some data collectors do not allow the surveyor to shoot the same point twice using the same point number. SurvNET requires that all measurements to the same point use a single point number. The raw data may need to be edited after it has been downloaded to the office computer to insure that points are numbered correctly.
- The majority of all problems in processing raw data are related to point number problems. Using the same point number twice to different points, not using the same point number when shooting the same point, misnumbering backsights or foresights, and misnumbering control points are all common problems.
- It is always best to explicitly define the control for the project. A good method is to put all the control for a project into a separate raw file. A big source of problems with new users is a misunderstanding in defining their control for a project.
- Some data collectors may have preliminary unadjusted coordinates included with the raw data. These coordinate records should be removed from the raw file. The only coordinate values that should be in the raw file are the control points.
- When a large project is not processing correctly, it is often useful to divide the project into several raw data files and debug and process each file separately as it is easier to debug small projects. Once the smaller projects are processing separately, they can be combined for a final combined adjustment.

Reviewing and Editing the Raw data
To review or edit the raw data, choose the *Edit Raw Files* command from the Tools menu.

If there are problems with the raw data, such as point numbering problems or incorrect rod heights, the raw data can be edited from this dialog. See the section on the raw data editor in the Carlson documentation to learn the details of the editor. Review the following Standard Errors and Control Points section before exiting the raw data editor.

### Standard Errors and Control Points

The default standard errors for points are defined in the Standard Errors sheet of the Settings dialog box. There are times when the default values may need to be overridden. For example, the control may be from GPS and the user has differing standard errors for his various GPS points. Or maybe some of the control points were collected with...
RTK methods, and other GPS points collected with more accurate static GPS methods. Standard error for individual points can be inserted into the raw data file. The following is the menu option used to insert standard errors into the raw file. Notice in the above raw data file that points TR1 and TR100 are the control points for this project. Also, notice there is a standard error record, CSE, preceding the control points.

The CSE record has the character '!' in the N,E,& Z field. The character '!' designates that all following control points will be fixed. Points that are fixed will not be adjusted during the adjustment. Placing a very small standard error on a control point is almost equivalent to fixing the point. Points can also be designated to be floating points by using the '#' character. The only practical use of creating a floating point is if SurvNET cannot compute preliminary coordinates because no control point is occupied. The surveyor can compute a preliminary value for one of the occupied points, and insert that point as a floating point. The floating point will be adjusted, and no weight will be given to the floating coordinate values.

Standard error records affect all the records that follow the standard error record. To revert the standard errors back to the default values, a CSE record can be inserted containing the '*' character. In the following example, point TR1 has been designated as a fixed point. TR100 has a north standard error of .02 and an east standard error of .01. Following the TR100 point record there is a CSE record containing the '*' character. So, if there were any control points further down in the raw data file they would use the default standard errors as set in the project settings dialog box.
There may be times when non-control standard errors need to be overridden for certain measurements. For example, if fixed tripods were used for backsights and foresights for part of the traverse, and hand-held rods were used for another portion of the traverse, it would be appropriate to have differing 'Rod Ctr' standard errors for the different sections of the raw data.

Standard errors for angles and distances can also be inserted into the raw data file using the Add menu options Setup Standard Error and Measurement Standard Error. The standard errors set by these inserted records override the default standard errors. In the following example, a setup standard record, SSE record, has been inserted in record 12. The SSE record effects all setup data that follow until another SSE record is inserted. In the following example, the foresight rod centering error is set to .005, the total station centering error is set to .005, the total station measure-up error is set to .005 and the foresight measure-up error is set to .005.
The following is another example where it would be appropriate to insert a measurement standard error record, MSE, into the raw data. If two different total stations with different accuracy specifications were used to collect the data, it would be appropriate to have different standard errors for the different sections of the raw file, depending on which total station was used to collect the data. In the following example, a MSE record has been inserted for record 27. The horizontal pointing and reading error has been changed to 5 seconds, and the vertical pointing and reading error has been changed to 10 seconds. The inserted MSE record will effect all following raw data until another MSE is inserted.
After exiting the raw data editor, we are ready to perform the least squares adjustment. From the Process menu, choose the *Network Adjustment* option.

The least squares adjustment is performed, and the results from the adjustment are displayed. If the solution converged correctly, the report should look similar to the following window. If there were errors or the solution did not converge, an error message dialog will be generated.

If there are errors, you will need to return to the raw data editor to review and edit the raw data. Since the tutorial example should have converged, we will next review the reports generated by the least squares adjustment. There are four windows created by the least squares program during processing. These files include the .err file, which contains any errors or warnings that were generated during processing. The .rpt file is the primary least squares report file summarizing the data and the results from the adjustment. An .out file is created containing a listing of the final coordinates. There is also a Graphics window that is displayed. The graphic window is temporary and useful only for seeing the results of the survey. To bring up the Graphics window, choose under the Window menu the *Graphics* command, or click the View Graphics icon on the toolbar.

**Relative Error Ellipses**

Relative error ellipses are a statistical measure of the expected error between two points. Regular error ellipses are a measure of the absolute error of a single point. Some survey accuracy standards such as the ALTA standards state the maximum allowable error between any two points in a survey. Relative error ellipses can give you...
this information. There is a more detailed ALTA reporting feature in SurvNET. See the manual for additional information on creating an ALTA report.

13 Press the Relative Error Ellipse toolbar icon button, or choose, off of the Tools menu, Relative Error Ellipse. Enter TR3 and TR7 in the From Pt. and To Pt. fields. Press OK to calculate. The dialog box should look as follows.

At the 95% confidence level there should only be around .02 feet of error between points TR3 and TR7. If you need to compute relative error ellipses for sideshots make sure the "Enable sideshots for error ellipse" toggle is set in the Adjustment tab of the Settings/Project dialog box.

Review of the Least Squares Report

14 In this section, the different sections of the least squares report are explained. If the Least Squares Report is not already showing, choose the Window menu and select the Least Square Report item. The report viewer has tabs to quickly access different sections of the report.

Preprocessing and Header Information

The following excerpt from the report shows the header information and the preprocessing results. The header information consists of the date and time, the input and output file names, the coordinate system, the curvature/refraction setting, maximum iterations, and distance units.

During the preprocessing process, multiple angles are reduced to a single angle and multiple slope distances, vertical angles, HI's, and rod heights are reduced to a single horizontal distance and vertical difference. During this process the horizontal angle, horizontal distance, and vertical difference spreads are computed. If the spreads exceed the tolerance settings from the Settings dialog box, then a warning message is displayed showing the high and low measurement and the difference between the high and low measurement.
Unadjusted Measurements

The following excerpt from the report shows the unadjusted measurements. Measurements consist of some combination of control X, and Y, horizontal distances, horizontal angles, and azimuth measurements. These measurements consist of a single averaged measurement. For example, if multiple distances were collected between two points during data collection, only the single averaged measurement is used in the least squares adjustment.

Also, standard errors for the measurements are displayed in this section of the report. The standard errors are computed from the standard error setting in the Settings dialog box using error propagation formulas. The standard error of an angle that was measured several times would typically be lower than an angle that was measured only once.

If the data had been adjusted into NAD 83 coordinates both the ground distances and the grid distances would be displayed. The grid, elevation, and combined factor would also be displayed in this section of the report.
The next section of the report shows the final adjusted coordinates. Additionally, the computed standard errors of the coordinates are displayed. If this project was reduced to NAD 83, the final latitude and longitudes are also displayed. Error ellipses computed to the 95 percent confidence interval are also displayed.

### Adjusted Coordinates

The following section from the report shows the final adjusted measurements. This section is one of the most important sections to review when analyzing the results of the adjustment. In addition to the adjusted measurement, the residual is displayed. The residual is the amount of adjustment applied to the measurement. The residual is computed by subtracting the unadjusted measurement from the adjusted measurement.

<table>
<thead>
<tr>
<th>Adjusted Measurements</th>
</tr>
</thead>
</table>

### Adjusted Measurements

The following section from the report shows the final adjusted measurements. This section is one of the most important sections to review when analyzing the results of the adjustment. In addition to the adjusted measurement, the residual is displayed. The residual is the amount of adjustment applied to the measurement. The residual is computed by subtracting the unadjusted measurement from the adjusted measurement.

The standard deviation of the measurement is also displayed. Ideally, the computed standard deviation and residual and the standard error displayed in the unadjusted measurement would all be of similar magnitude. The standard residual is a measure of the similarity of the residual to the a-priori standard error. The standard residual is the
measurements residual divided by the standard error displayed in the unadjusted measurement section. A standard residual greater than 2 is marked with an "*". A high standard residual may be an indication of a blunder. If there are consistently a lot of high standard residuals it may indicate that the original standard errors set in the Settings dialog box were not realistic.

Statistics

The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network.

The standard error of unit weight relates to the overall adjustment and not to an individual measurement. A value of one indicates that the results of the adjustment are consistent with the a priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a-priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether the results of the adjusted measurements are consistent with the a priori standard errors. Notice that if you change the project standard errors and then reprocess the survey the results of the chi-square test change, even though the measurements themselves did not change.

In our example the chi-square test failed at the 95% significant level. Our example failed the chi-square test on the low end, 52.6 is less than 60.5. Failing on the low end indicates that our data is actually better than expected compared to our a-priori standard errors. If we were to decrease the pointing and reading standard error in the Settings screen by 5-10 seconds we would probably pass the chi-square. Also notice that if you change the standard errors by only 5-10 seconds and reprocess the data the final coordinates will not change significantly.
Sideshots

If the "Enable sideshots for relative error ellipses" is not set in in the Adjustment screen of the project settings screen, sideshots are computed separately after the adjustment is completed.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Bearing</th>
<th>Dist.</th>
<th>N</th>
<th>E</th>
<th>StdDev. N</th>
<th>StdDev. E</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR1</td>
<td>100</td>
<td>S 72' 22' 23''E</td>
<td>20.86</td>
<td>4993.7449</td>
<td>5019.6883</td>
<td>0.0025</td>
<td>0.0028</td>
</tr>
<tr>
<td>TR2</td>
<td>101</td>
<td>S 74' 35' 42''E</td>
<td>23.26</td>
<td>4963.7993</td>
<td>5022.4125</td>
<td>0.0033</td>
<td>0.0034</td>
</tr>
<tr>
<td>TR2</td>
<td>102</td>
<td>N 04' 55' 59''E</td>
<td>134.11</td>
<td>5123.6541</td>
<td>5010.6725</td>
<td>0.0088</td>
<td>0.0088</td>
</tr>
<tr>
<td>TR2</td>
<td>103</td>
<td>N 09' 19' 36''E</td>
<td>94.50</td>
<td>5083.7459</td>
<td>5010.4699</td>
<td>0.0085</td>
<td>0.0084</td>
</tr>
<tr>
<td>TR2</td>
<td>104</td>
<td>N 57' 42' 43''E</td>
<td>116.78</td>
<td>5063.4450</td>
<td>5006.4090</td>
<td>0.0047</td>
<td>0.0074</td>
</tr>
<tr>
<td>TR2</td>
<td>105</td>
<td>N 63' 39' 22''W</td>
<td>132.17</td>
<td>5061.9176</td>
<td>4862.0216</td>
<td>0.0029</td>
<td>0.0082</td>
</tr>
<tr>
<td>TR2</td>
<td>106</td>
<td>N 69' 32' 48''W</td>
<td>160.16</td>
<td>5061.8699</td>
<td>4842.5590</td>
<td>0.0051</td>
<td>0.0084</td>
</tr>
</tbody>
</table>

If the project had valid elevation benchmarks and measured HI's and rod heights the project could have been defined to adjust elevations. When using the 2D/1D least squares model the horizontal and the vertical adjustments are separate least squares adjustment processes. As long as there are redundant vertical measurements the vertical component of the network can also be reduced and adjusted using least squares. In the vertical adjustment, benchmarks are held fixed.

This is the final step in the adjustment. The final adjusted coordinates are now stored in the current project point database and can now be used for mapping and design.

Lesson Two - Processing a 3D Network With Both Total Station Data and GPS Vectors

In this lesson we will process a project that contains both GPS vectors and total station measurements.

1. Following is the opening SurvNET window. The first step is to open the project for lesson two. Choose the File/Open Project.. option. Navigate to the `\Carlson2008\Data\` subdirectory and open the SurvNetTut02 project.
2 Let's review the project settings. Go to Settings/Project.

In order process GPS vectors, the coordinate system must be set to 'SPC 1983' with the appropriate state plane zone. The 'Coordinate System Adjustment Model' must be set to the 3D Model. With the 3D model, horizontal units and vertical units must be the same in regards to output and total station raw data. Geoid modeling may or may not be important depending on the extent of the project and the accuracies required. The most accurate results are typically obtained by using a 'Geoid File' set to GEOID03.
The project raw data is defined from the 'Input Files' settings screen. Notice that the units need to be specified for both the GPS vector data and the total station raw data. Typically, but not always, GPS vectors are in meters while the total station and the final output may need to be in feet. Also make sure that the correct GPS vector format is correct. Some GPS formats are binary and cannot be edited easily. Sometimes it is needed to edit the GPS vectors usually in terms of point numbers.

Note: The sample tutorial project has the input raw file in the default data folder of C:\Carlson2008\Data. If you have a different data directory, then set the correct data file by highlighting the default file, pick Delete and then pick Add and select GPSAndTS.crg (C&G format raw file) from your data folder. Do the same for the GPS Vector files of GPSAndTS1.gps and GPSAndTS2.gps.
Though this tutorial does not cover the topic, it is from this screen that you would define the traverse file needed to compute either GPS loop closures or totals station traverse closure. See the manual for further details.

Notice the standard error settings related to GPS. The GPS instrument centering error can be defined. The vector
standard error is a factor that can be used to increase the standard errors as defined in the GPS vector files.

None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Adjustment' dialog box.
None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Output' dialog box. Press the OK to return to the main SurvNET dialog box.

3 Following is the main SurvNET window. To process the data chose the Process/Network Adjustment option.

The project should process and converge and the following windows should be displayed.
Let's review sections of the report that are unique to the processing of GPS vectors and the 3D model.

unadjusted Observations

<p>| control coordinates: 1 observed points, 0 fixed points, 0 approx. points |
|------------------------|------------------------|------------------------|------------------------|------------------------|</p>
<table>
<thead>
<tr>
<th>sta.</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Z (Ellip.)</th>
<th>StErr N</th>
<th>StErr E</th>
<th>StErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>209</td>
<td>40°19'58.99054&quot;N 76°12'53.03901&quot;W</td>
<td>898.21</td>
<td>0.0030</td>
<td>0.0030</td>
<td>0.0043</td>
<td></td>
</tr>
</tbody>
</table>

Grid XYZ

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N:</th>
<th>E:</th>
<th>Z (Geoid):</th>
<th>StErr N</th>
<th>StErr E</th>
<th>StErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>209</td>
<td>350768.1500</td>
<td>239658.1700</td>
<td>898.21</td>
<td>0.0030</td>
<td>0.0030</td>
<td>0.0043</td>
</tr>
</tbody>
</table>

Geocentric XYZ

<table>
<thead>
<tr>
<th>Sta.</th>
<th>X:</th>
<th>Y:</th>
<th>Z:</th>
<th>StErr X:</th>
<th>StErr Y:</th>
<th>StErr Z:</th>
</tr>
</thead>
<tbody>
<tr>
<td>209</td>
<td>1160304.9395</td>
<td>-479065.2290</td>
<td>416424.27</td>
<td>0.0009</td>
<td>0.0009</td>
<td>0.0023</td>
</tr>
</tbody>
</table>

Notice that now that we are working with a specific datum instead of an assumed coordinate system that latitude/longitude, state plane coordinates and geocentric coordinates are all displayed.
In the above unadjusted observations section of the report, notice that distances have been converted to mark to mark distances. Note that vertical angles are now treated as measurements in the 3D model. And lastly, notice that the GPS vectors are also displayed. The GPS vectors are displayed as delta X,Y,Z in the geocentric coordinate system.

<table>
<thead>
<tr>
<th><strong>Mark to Mark Slope Distances:</strong> 192 Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Sta.</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Mark to Mark Vertical Angles:</strong> 191 Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Sta.</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Horizontal Angles:</strong> 191 Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>BS Sta.</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>201</td>
</tr>
<tr>
<td>201</td>
</tr>
<tr>
<td>201</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>GPS Vectors:</strong> 17 Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Sta.</td>
</tr>
<tr>
<td>200</td>
</tr>
<tr>
<td>302</td>
</tr>
<tr>
<td>301</td>
</tr>
<tr>
<td>300</td>
</tr>
<tr>
<td>303</td>
</tr>
<tr>
<td>340.433</td>
</tr>
</tbody>
</table>

In the above adjusted coordinate section of the report, notice that the grid, elevation, and combined factor are displayed with the adjusted geographic coordinates.
In the above adjusted measurements section the adjusted measurements are shown along with their residuals, standard residuals and standard deviation.

This completes the Lesson 3 tutorial title SurvNET.

**Lesson 4: Field to Finish for Faster Drafting**

In this lesson, you will make a plat using field to finish techniques, with the help of the Startup Drawing Wizard.

1. Launch Carlson, or, if you are already in the program, select the File menu, and select New to start a new drawing. Save your existing drawing first, if you'd prefer. If you are asked to use a template, choose carlsonxx.dwt, where xx is the last two digits of the AutoCAD release that you are working with. For example, for AutoCAD 2006, you will select carlson06.dwt.

The first of several Startup Wizard dialog boxes appears. If the Startup Wizard does not appear, then go to the Settings menu, choose Configure and then select General Settings. In the General Settings dialog, click Use Startup Wizard in the upper-left and click OK. Then open a new drawing again.
Once in the Startup Drawing Wizard, click Set at the top of the dialog box, and enter in a new Drawing Name. Since this is Lesson 3, call the new drawing Plat3.

Verify that the other settings match the settings shown above, and click Next. You will see the Startup Wizard Data Files dialog. This dialog box is used to specify where to store data, and the existing point information source. Set Plat3.crd as the new CRD file name.

Our source is the same file as in Lesson 2, Plat.txt. This is an ASCII file, so click Next, and in the new dialog box click the option to Select Text/ASCII Files. In the next dialog box, titled Text File to Read, choose plat.txt from the \DATA folder, and then click Open.
The Text/ASCII File Format dialog appears again, and the format of the points appears in the Preview Window, for verification, as shown below. Be sure that to the right of Draw Point, that Draw-Locate Pts is selected. Set the other options as shown. Click OK.

The points are then copied into the file Plat3.crd. If you repeat this exercise, and again use the file name Plat3.crd,
you will be asked:

[O]verwrite w/new coordinates, overwrite [A]ll, or use number <55>: A (for all)

In either case, when you correctly complete the process, the following dialog box appears:

![AutoCAD Message]

Then this Drawing Import Wizard dialog box appears:

![Data Import Wizard]

Choose the Field to Finish option, and click Next. If you receive a file selection dialog titled Specify Field Code Definition File, choose the file called "Carlson.fld". A dialog box now appears with a warning that some codes have two descriptions.

![Possible Multiple Codes Found]

The command is asking whether these codes are to be treated as two separate descriptions, or as one description that has a space in it. Choose the default (Split all multiple codes), to tell the command that codes with spaces are really two separate descriptions, and click OK.

The Draw Field to Finish dialog box appears. Choose the options as shown here. Then click Additional Draw Options.
This displays a dialog box that provide many additional options, as shown below.

You want to draw all 1 through 54. Make sure the other options are set as shown above. Click OK twice.

*Draw Field to Finish* now draws the points and linework. Got to View, and then *Extents* to show the points, as well as the linework and point symbols. *Draw Field to Finish* saves you many manual steps. Your plat is shown below:
2 To understand how the above drawing was created, select *Draw Field to Finish* again from the Survey menu, and then select the Edit Codes/Points button from the dialog box. This takes you to the Field to Finish dialog box.

The display window shows a list of point codes, such as IP for iron pin and FL for fence line, that are converted to...
special symbols and linetypes by *Draw Field to Finish*. For an example of how the codes are used, look at the sewer line running from point 52 to 53 to 54 (the southernmost point), which is based on a field code of MH. Select MH for Manhole, as shown above, and then click Edit. The following dialog box is displayed.

MH has several attributes that are used by *Draw Field to Finish*, based on the settings shown above. *Draw Field to Finish* draws a manhole using the symbol SPT34. It draws a sewer line with the letter S for sewer. It places the manhole on layer SEWER, and plots a text description of "MANHOLE" underneath the symbol. (Descriptions can be upper or lower case.) When you are done looking at the MH field code definition dialog, click OK.

Other codes have fewer attributes. LP is set only to draw a symbol and text (Light Pole), but not to draw linework. FL, for fence line, is set to draw linework but not corner symbols or points descriptions. A code's attributes depend on the entries in the Set Linetype, Set Symbol, Description and Entity Type options.

The "Carlson.fld" Field to Finish code table is provided with the Carlson software. This table shows one possible system, but with far too many codes for a field crew to remember. You can make your own table by choosing the Code Table Settings option from the Field to Finish dialog box, then choose the Set button at the top right. Then select the New or the Existing tab from the top of the Specify the Code Definition File dialog box, in order to create or select a different code table (.FLD) file.

3 Use the Layer ID command, located under Inquiry, to verify the layers of the various plotted entities. Select Layer ID. Pick on the fence line, the road and the utility line, and notice the different layers (FENCE, EOP, UTILITY). You should study the layers in a drawing before deciding what to freeze and thaw. To reduce clutter on the screen, select the Layer Control command from the View menu. (The appearance of this dialog box might differ from what you see. It varies, depending upon what AutoCAD version is in use.)
Freeze the PNTS layer, the SPOT layer, and the PNTELEV layer by turning the sun into a snowflake. Then click OK.

4 Now you will do some drawing cleanup. Note that a single property line is drawn from point 8 to 9 to 10 and to 15. The chord from point 10 to 15 should be an arc. You will erase the segment from 9 to 10 and from 10 to 15, so that you can re-draw it, establish the tangent, then draw the arc and finish back at point 1.

To eliminate part of a polyline, select the Edit menu, then select the Polyline Utilities command, then Remove Polyline, and then click Remove Polyline Segment.

**Break polyline at removal or keep continuous [ <Break >/Continuous ] :** press Enter for Break

**Select polyline segment to remove:** Pick the segment from 9 to 10, then the segment from 10 to 15, then press Enter to end

To draw the correct polyline, use the 2D Polyline command under the Draw menu. If you prefer to type in the command, enter 2dp, which stands for 2D Polyline.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 9
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 10
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: 15
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: 1
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter

Now erase the plotted traverse line that makes a "V" near the left side of the drawing. Then use the 4-Sided Building command you learned in Lesson 2 to create the other two sides of the shed, located in the upper middle of the screen, near point 17. The end result, except the house, is shown below:
5 Much of the text in the above drawing, such as tree sizes and types, the manhole text, and the light pole text, can be used in the final drawing. But some of the text, such as the text plotted for iron pins and poles, can be fully described in the Legend without the redundancy of plotting to the screen. If you use the Erase command to remove the iron pin and pole text, the entire point will be erased because the attributes are grouped with the point. Instead, use the Erase Point Attributes command under the Points menu.

Select Point No., Elev, or Desc to Erase: Pick the 3 poles and the 4 iron pins

6 Next, you will use Extend by Distance command to create a building. The building will be less complex than the building you created in Lesson 2, but you will learn the "t" and "c" options, in addition to "l" for left and "r" for right. Under Edit, choose the Extend command. Select the By Distance option. Pick the western side of the small line segment west of the 12" pine and north of the driveway. Follow the prompts:

Pick line or polyline to extend:
"T" or "t" means "total" distance or "to" the distance - so extend "to" 50 feet total.

The Extend by Distance "T" option for total distance solves the dilemma of making an existing line, of unknown length, extend to an exact known length.

7 Use the Twist Screen command to position the plat on the sheet. Not every drawing can be plotted "due North." Sometimes North needs to be rotated so that property lines and important features run nearly left-to-right or top-to-bottom on the plotted page, for a better fit. In this drawing, you want the western line from point 8 to point 9 to run left-to-right on a sheet that will be plotted in landscape style (longer left-to-right than top-to-bottom). Under
the View menu, select *Twist Screen*, then *Line, Polyline or Text*.

**Pick a line, polyline or text to make horizontal:** *Pick the western line* from point 8 to point 9, closer to point 9

Now the drawing appears as shown below:

Notice that the north indicator (referred to as the USCICON), at the lower left, displays the rotation.

8 Now select *Twist Point Attributes*, under the Points menu, to twist the point descriptions and point numbers back to a left-to-right rotation.

**Twist by [Twist screen>/Azimuth/Entity segment/Follow polyline]? press Enter**

**Enter angle relative to current twist screen <0.0>: press Enter**

**Select points from screen, group or by point number [Screen>/Group/Number]? press Enter**

**Select Carlson Software points.**

**Select objects: ALL press Enter**

The points then twist back orthogonal to the screen, reading once again left-to-right.

9 The remaining descriptions associated with the points can be used in the final drawing, but they should be moved slightly for a better appearance. For example, the tree descriptions would look better if they were not inside the tree canopies.

Under the Points menu, select *Move Point Attributes - Single*. The steps of the command are: pick text, pick the new text position, press Enter, press Enter. Then the command repeats. Notice how the text "ghosts" as it moves, which helps you place it in the best position. Try to duplicate this result:
10 Because of the earlier *Twist Screen* command, the E’s in the electric utility polyline are upside down. Choose the *Text* command, from the Edit menu, and select the *Flip Text* option. Select the text to flip.

**Select objects:** *pick the upside down E’s* individually while holding down the Shift key

11 To label the dimensions of the building automatically, you must first activate the *Auto Label Closed Polyline Exterior* function. To make this a permanent setting, under the Settings menu, select *Configure*, then *Survey Settings*, and then *Survey Text Defaults*. Change the dialog box as shown below:

![Auto Label Closed Pline](image)

Click OK, and Exit back out. Select *Building Dimensions* from the Annotate menu, which is under the *Survey Text* command. Pick on the house. If the text overwrites the inside corner of the house, use the *Move* command (under the Edit menu, or type M for Move at the command prompt) and move the 30’ dimension beneath the line.

12 To automatically annotate bearings and distance, as well as arcs, select the *Auto Annotate* command from the Annotate menu. When the dialog box appears, under the *Lines* tab, select the options you would like to use so that the bearings and distance labels appear as you would like. Then pick the three polylines that fully define the perimeter: the fence line, the polyline containing the arc, and the lower polyline, which is still the western polyline although you have twisted the screen so that it runs along the lower portion of the drawing. Use the *Move* command to move the bearing and distance labels to avoid overwriting other features.

When you move the lower distance label, 404.90' to the left, you want to move perfectly level to the screen, since this was the line you used to twist the screen, and it runs perfectly left-to-right. To do this, press the function key F8 to activate Ortho. Then pick 404.90' and move it to the left, picking its final position. Repeat this for the S 17°05’38” E bearing. After you move these items, press F8 again to turn off Ortho. Sometimes you will load a drawing from another client or source, and the Ortho setting has been left on. This may initially confuse you during the *Move* commands. Press F8 to deactivate Ortho. Notice that F8 works even with Twist Screen active.

13 *Auto Annotate* typically centers the arc annotation above and below the arc, which causes the arc data to overwrite...
the surveyed edge-of-pavement (EOP) polyline. You want to erase both the arc annotations, and use the Label Arc option of the Annotate Arc command to force both the arc length and radius to be drawn beneath the arc.

At the command line, enter E for Erase.

**Select objects:** enter WP, then pick as shown below

*Press Enter* when the selection set is complete. There is no "close" option for window polygon and crossing polygon selections.

For the new annotation, under the Annotate menu, select the Annotate Arc command, then the Label Arc option. Then select the arc from the screen. The Label Arc Settings dialog box appears:
You want to locate the arc text inside the arc, on positions 1 and 2. Position (Row) 1 is just under the arc, and 2 is under 1. Be sure they are both Inside. Fill out the dialog box as shown above, and click OK.

The new arc text might overwrite the 8'' Pine, so, if it does, use the command Move Point Attributes - Single, in the Points menu, to relocate the 8'' Pine description.

With the annotations placed in new positions, your drawing should be similar to the one shown below. Move your annotations to match this drawing.
14 To label the area of the lot, first select the Area Defaults command from the Area/Layout menu. Set the Square Units (s.f.) to the nearest whole unit (no decimals) and the Other Area Labels to 2 decimal places. Then click OK to exit the dialog box. Select the Area by Lines & Arcs command from the Area/Layout menu, and pick the three polylines individually, while holding down the Shift key, that define the property perimeter. Press enter, and locate the text to the left of the 12' Pine.

15 Before completing the final formatting of your drawing, you need to do some minor cleanup, using procedures you learned in Lesson 2.

You don't want point 16, the PL point, to show in the final drawing. Use the Layer ID command, under the Inquiry menu, to verify the layer of point 16, which should be MISC. Freeze MISC using the Freeze Layer command on the View menu, and pick point 16. Freeze the point numbers using the Layer Control command on the View menu, and freeze the layer PNTNO.

16 To insert an A1, 8-1/2 x 11 border and title block, with the orientation landscape (not portrait), select the Title Block command from the Settings menu. You will see this dialog box.

![Create Title Block dialog box](image)

Be sure these above selections match your own. Click OK. For the insertion point, select a point at the very lower-left of the screen, so that your drawing plan entities fit inside the border and somewhat nearer to the top. Pick your screen location. You will then be prompted for the attributes of the title block. Fill them in and click OK.
If you prefer, you can use the *Move* command, pick the title block and two border perimeters, and move them. Never move the drawing, because you will change the coordinates if you do. Move the drawing only if changing the coordinate locations does not matter.

17 Select the *Draw Legend* command, under the Annotate menu, select the Existing tab, choose the .lgd file that you saved in Lesson 2, and click Open. Then select Draw and OK, to close out the dialog boxes that follow, and then click Exit.

Pick an upper-left location point in the available space to the lower-left of the plat. If you did not save a legend in Lesson 2 (or you skipped Lesson 2), follow the steps in that lesson. Use the *Scale Point Attributes* command, under the Points menu, and scale up the oak tree symbol in the Legend by a factor of 1.5.

Select the *Survey Text* command from the Annotate menu, then select *Survey Text Defaults*. Change the Offset Dimension Text alignment to Horizontal. (It may have been set to Parallel in Lesson 2.) Click OK. Now select the *Offset Dimensions* command from the Annotate menu, under the *Survey Text* command, and pick the lower right corner of the building, then the lower-most property line (in the current twist screen position). This labels the offset dimension horizontal to the current twist screen.

Pick the *Draw North Arrow* command, under the Annotate menu, and select and find the north arrow symbol that is shown in the figure below. Change the Symbol Size Scaler, if necessary, and click Specify Rotation On-Screen. Click OK. Then pick an appropriate location and press Enter. Note how the arrow draws due north, respecting the twist screen.

Choose the *Draw Barscale* command, under the Annotate menu, and pick a location near the lower-left portion of the drawing.

Your drawing should now look similar to this:
18 Select the Hatch command from the Draw menu.

Select the SOLID pattern from the pulldown list, then click the Select Objects button. Pick the house and the shed, and press Enter twice.

19 To offset the EOP Polyline, first try using the Standard Offset command under the Edit menu, and try offsetting the edge-of-pavement polyline that runs roughly parallel to the sewer line. You will see an error message because that object is a 3D Polyline, created by the Draw Field to Finish command.
To offset a 3D Polyline, you must use a command specifically designed to offset 3D Polylines. Under the Edit menu, select 3D Polyline Utilities, and slide over to Offset 3D Polyline.

Enter the offset method [<Interval>/Constant/Variable]: press Enter
Vertical/<Horizontal offset amount>: 30
Percent/Ratio/Vertical offset amount <0>: press Enter
Select a polyline to offset (Enter for none): pick the EOP polyline
Select side to offset: pick out and away from parcel, for the other side of the road

Before you add a title to the drawing, create a text style for the title. Choose Set Style in the Draw menu, found under Text.

Click New, and name the style Title. Choose the font named romant.shx, and then change the oblique angle to 10 degrees as shown. Click Apply, then click Close. Now, to create the title, type Dtext at the command line. Make sure that TITLE is the current text style.

Specify start point of text or [Justify/Style]: C
Specify center point of text: pick a point near the top-right of the screen
Specify height <8.00>: 20
Specify rotation angle of text <E>: pick a point to right of first point with <Ortho on>, dynamically stretch right
Text: Farmer Survey
Text: August 15, 2006
Text: press Enter

Select the Text Enlarge/Reduce option of the Text command under the Edit menu. Enter a Scaling Multiplier of .8 and pick the date you just entered.

Verify your drawing scale using the Drawing Setup command under Settings. Your drawing should have a
scale of 100 with a Text Plot Size of 0.08. Change the Text Plot Size to 0.06 to shrink the building dimensions. Then label the house "2-Story", "Farm House" (2 lines of labeling), select the Leader with Text command under the Annotate menu.

**Options/Pick Arrow Location:** pick near or on the left side of the house

**To point:** pick off to the left

**Next point (Enter to end):** press Enter

**Text:** 2-Story

**Text:** Farm House

**Text:** press Enter

Pick anywhere on the leader. You see two grip squares (usually yellow), one on the left side and one of the right side. Pick on the right grip nearest the house. Move your cursor. Note how the arrow moves. Pick again for the new location, and note how the arrowhead and leader are now located and angled to your specifications.

22 Select the Triangulate & Contour command from the Surface menu. The Contour tab of dialog box should be filled out as shown below:

![Triangulate and Contour dialog box](image)

Click on the Selection tab and fill out to match the following:
Chapter 2. Tutorials

Click on the Labels tab and match the following dialog:

Click OK.

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: Pick the house and the shed. Since these objects have now been filled, the selection may be a little more tricky. We could (actually should) have placed the solids on their own layer and froze the layer before beginning the contour command. But we can use the fact that Carlson is filtering the objects to get around the problem. When prompted to select the objects, issue the C (for crossing) option, then pick a box that crosses the edge of the filled polylines. Carlson will accept the polyline but reject the fill.

Select the points and breaklines to Triangulate. Select a right-to-left window of the property. A right-to-left selection behaves as a crossing, which means that any object that is touched by the window or included inside the window is selected. (A left-to-right selection is a window selection, which means that only objects that are fully enclosed by the window are selected.)

Select objects: pick Window location
Other corner: pick other location
Select objects: press Enter to end
Pick the coordinate file that contains the points, plat3.crd, and click Open.

Reading points ...
Range of Point Numbers to use [<All>/Group]: press Enter
Wildcard match of point description <*>: press Enter

If the triangulation lines and faces were drawn, freeze them now. Next, pick the lower-left elevation "502" contour near the end. The grips are displayed. The grips near the contour end can be used for stretching. Straighten out the end of this contour line.

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: pick a grib and pick a point

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: pick another grib and pick a point

Press Enter. Clicking the right button on your mouse is the equivalent to pressing enter.

The final drawing will look similar to this:

This completes this Lesson 4 tutorial titled Field to Finish for Faster Drafting.
Lesson 5: Intersections and Subdivisions

1 Click the icon for Carlson and start up Carlson Software from Windows. Once in the program, exit the Startup Wizard if it appears.

2 Once in Carlson, click Open under the File pulldown menu. Look for the file Plat4.dwg and click on it. When it lights up blue, as shown below, it will appear in the Preview Window at right. It should look like the open-sided property shown here. Plat4.dwg is found within the WORK folder of Carlson. You search for the file as you typically would in Windows, clicking the yellow "Up one level" button to go to the parent folder of the current folder, or by clicking the adjacent down arrow to find the desired path in the full tree of folder locations.

Now click Open to select and open the file Plat4.dwg.

3 Enter & Assign a Starting point for the Street Centerline. Select Draw-Locate Points, found under the Points pulldown, and obtain the dialog shown below:
Click off the prompting and labeling for Descriptions, Elevations and Locate on Real Z Axis (make them blank as shown). Up top, change the symbol to SPT10 by picking Select at the very top of the dialog, and choosing symbol SPT10 from the dialog of symbol choices (not shown here). Also, verify that Automatic Point Numbering is clicked on, that the Starting Point Number is 1, that the layer is PNTS. Match these entries (which are mostly the default conditions) and click Enter and Assign at the lower left.

Prompting will appear at the bottom of the screen. We will enter the starting point as follows:

**Enter North (y):** 4809.17  
**Enter East (x):** 4391.28

The program will recognize that you have not yet started a coordinate file, so click the New tab and enter the File Name as Plat4.crd (which should be the default). If you enter Plat4, you do not need to enter the extension .crd. The program will add extensions automatically. You will see this:
Click Open. You will be prompted again:

**Enter North(y)**: press Enter (for no more points; we are done)

4 Traverse from PI to PI (to the two endpoints of our centerline). Select Traverse under the COGO menu, or alternately just enter T at the command line. (T is a hot key. Other hot keys are I for Inverse and SS for Sideshot).

Reply to the prompts as follows:

```plaintext
Traverse, Line OFF, RA W FILE OFF
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <7>: 1
Enter Bearing Angle (dd.mmss) <90.0000>: 58.1848
Points/<Distance>: 736.73
N: 5196.15 E: 5018.19 Z: 0.00
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>: E (to exit)
```

You could keep on traversing, but we will stop here to review. You have created point 2, traversing NE from point 1. To review, code 1 is for NE, 2 for SE, 3 for SW, 4 for NW, 5 for Azimuth, 6 for Angle Left, 7 for Angle Right, 8 for Deflection Left and 9 for Deflection Right. This is the standard way that traverses and sideshots are entered in Carlson with a code entry (followed by Enter), then the angle or bearing entry (followed by Enter). Lesson 1, the Entering a Deed lesson, presented another method, where the angle and bearing are together in the form of 158.1848. That is a rare form, designed to save keystrokes, and used primarily only in Enter Deed Description. Now you have been exposed to both!

5 Line On/Off. Click Line On/Off, under the COGO menu, to turn on simultaneous linework with traversing. This command toggles on and off each time you click it, with the On status indicated by a check mark. Now repeat the Traverse command. Try T for Traverse this time, entered at the command line.

```plaintext
Traverse, Line ON, RAW FILE OFF
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>: 2
```
Enter Bearing Angle (dd.mmss) <58.1848>: 75.0627
Points/<Distance>: 553.69
N: 5053.85 E: 5553.28 Z: 0.00
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>: E (to exit)

6 Draw a Polyline from Point 1 to Point 2, and connect the segments with Join Nearest. We could have turned linework with traverse on before we got started, but now we will do it after-the-fact. So choose 2D Polyline under Draw. Some users like to simply type in 2DP at the command line that starts the Polyline command, also.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 1
[Arc/Closedistance/Follow/Undo/<Pick point or point numbers>]: 2
[Arc/Closedistance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter (to end)

Now we have two line objects. The first, from point 2 to point 3 is a pure Line. The second, from point 1 to point 2, is a true Polyline (even though it is only one segment long). It is officially a LWPOLYLINE, a lightweight polyline. This can be verified by picking it using the List command under Inquiry. Polylines are linked combinations of one or more line segments that behave as one unit. We encourage use of polylines versus lines because they offset as a unit, will take on a thickness or width, are easier to select and have superior editing capabilities. A line can be turned into a polyline by picking Polyedit under Edit, picking the line, and answering Y to the question "Do you want to turn it into one? <Y>". To join the polyline and line objects into a single polyline, choose the very useful command Join Nearest, found under Edit.

7 Design a Curve with a 500’ Radius. Under Draw, pick Arc and slide over to 2 Tangents, Radius.

Radius of Arc <0.00>: 500
[nea] Pick Point on 1st Tangent Line: Pick on the 1st polyline segment closer to point 2
[nea] Pick Point on 2nd Tangent Line: Pick on the 2nd polyline segment close to point 2

The arc draws in, and the centerline remains a polyline, now with 3 segments.

8 I for Inverse. Entering I for Inverse, at the command line, is a handy way to get on a point to begin another traverse. Practice inversing. Enter I. Inverse from point 1, then to point 2, then to point 3 then back to 1. But you can also
inverse (go to) a snapped position on a line or polyline, such as the midpoint of an arc. Let's do that, because we want to traverse south from the midpoint of the arc. Enter I, for Inverse.

Calculate Bearing & Distance from starting point?
Traverse/SideShot/Options/Arc/Pick point or point number: MID (for midpoint snap) of Select the arc
Traverse/SideShot/Options/Arc/Pick point or point number: T (for traverse)
Traverse, Line ON, RAW FILE OFF
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>: press Enter
Enter Bearing Angle (dd.mmss) <75.0627>: 10.11
Calculated Bearing (Qdd.mmss): 210.1100
Points/<Distance>: 400
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>: E (to exit traverse)

Notice that you can transition from inverse, to traverse, to sideshot, etc. with these COGO options. We were in inverse, but we did T for traverse, and could have done I for inverse to return to inverse. This cuts down on keystrokes, and adds to the sense of fluidity of the software.

9 Turn a Line into a Polyline with Polyedit. The command Offsets & Intersections requires pure polylines, not lines, to execute. So, since we had Line On with the last traverse, we have created a line. To use this in street design, we need to convert it into a polyline. Select Polyedit under the Edit pulldown menu.

Select polyline or [Multiple]: Pick the side road line
Object selected is not a polyline
Do you want to turn it into one? <Y> press Enter
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo]: press Enter

10 Offsets & Intersections. Under the Area/Layout menu, select Offsets & Intersections.

Select all PRIMARY road polylines.
Select objects: Enter (we will consider both these subdivision streets secondary)
Select all SECONDARY road polylines.
Select objects: Hold down the Shift key and pick the main centerline
Select objects: With shift key still down, pick the side road
Select objects: Enter (for no more)
The street intersections are presented in a dynamic dialog as shown above. Try experimenting with different radii under the Secondary Roads column, then clicking Calculate. The streets will re-draw in the upper graphical area. But after experimenting, change the four values under Secondary Roads to those shown (ignore Primary Roads – those don't apply here), and click Calculate. Then click Finish 2D. Note the drawn-out street intersection.

Now select Layer ID under the Inquiry menu. Pick on the outside polyline (it is layer ROW). Pick on the next polyline in from the outside (it is layer EOP). For example, if you had clicked off EOP under the Draw column in the above dialog, the edge-of-pavement polyline would not have drawn.

11

Standard Cul-de-Sac. Under Area/Layout, select Cul-de-Sacs. You may want to zoom into the area of the bottom center, near point 4. When finished with the procedure below, zoom back out.

Prompting:

Select all offset polylines to end with cul-de-sac.

Select objects: Do a crossing selection from right to left across the lower side road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)

Select objects: press Enter (for no more)

Pick cul-de-sac center projection onto centerline: END (type end for endpoint snap)

Pick near the endpoint of the centerline of the lower side road near point 4. However make sure the pick is on the centerline polyline, or the routine will say the centerline not found.

This brings up the following dialog:
Again, you can change the Fillet Radius and the Outside Radius on the EOP or ROW, hit Calculate, and check out its effect. (Don't make the Outside radii too small or it will fail Calculate if there is no workable solution). Set values as shown above. Then click on Finish 2D.

12 Teardrop Cul-de-Sac. Now select the *Cul-de-Sacs* routine again, under Area/Layout.

**Select all offset polylines to end with cul-de-sac.**

**Select objects:** *Do a crossing selection* pick from right to left across the right main road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)

**Select objects:** *Enter*(for no more)

**Pick cul-de-sac center projection onto centerline:** END for endpoint snap *Pick endpoint of the centerline* of the lower side road near point 3

For a teardrop cul-de-sac, fill out the dialog as follows, then click on Calculate and Finish 2D.
Teardrop cul-de-sacs allow moving vans and other large vehicles more turning room, and have been popular in the Cincinnati area, for instance. Our drawing now appears as shown below, with the exception of the filled reference dots.

13 Let's make a layer called LOTS using Layer Control found under View. It's a good idea to create a layer and set it current before beginning the design process. Select Layer Control and obtain the following dialog:
Click on for New layer. When Layer1 highlights, as shown at bottom of list, type over it with LOTS, then click under the Color column and change the color to Magenta. Then click the (Set) Current button up top to make this layer current. Then click OK to exit the dialog.

Next, we will use **Break at Selected Point**, found in the Edit menu.

The **Lot Layout** routine under Area/Layout works nicely with reasonable polylines that run roughly parallel. Our goal is to make 1-acre lots. Lots of zigs, zags, and jogs in the polylines cause the perpendicular offset logic to fail to find a solution (lots will radiate perpendicular from the front polyline in Lot Layout). Not only should the front and back lines run opposite each other, but they should end at some point before the calculation runs into difficulty with impossible math.

The outer R-O-W polyline currently runs left-to-right, goes around both cul-de-sacs and returns right-to-left in one, connected polyline. We need to break it near where the filled dot is pointing. It should be easy to lay out lots along the upper portion of the subdivision, as long as we stop to break the R-O-W polyline before it turns and runs back through the lower, more complex frontage and back property portions.

Under Edit, select **Break**, and slide over to **At Selected Point**. You will select using the filled dots, shown on the plan above, as references.

Select Line, Arc, or Polyline at break point: Pick near the filled dot on the outer boundary polyline. Repeat the command for the ROW polyline.

Select Line, Arc, or Polyline at break point: Pick the far right end of the Teardrop cul-de-sac R-O-W polyline.

To prove you have broken the polylines in two, click on the R-O-W polyline on the south side (only the south portion should highlight), then click on the north R-O-W polyline (which we will use as our frontage polyline in the command Lot Layout). Then press the ESC key twice, which gets rid of the grips, as does zooming or panning.
Fill out as shown. In particular, click off Apply Remainder Equally to All Lots (if it is on) so that we force 1.000 acres lots and don’t just get equal lots of some size such as 1.0017 (because the remainder lot that would not fit was added onto all lots).

Making Closed Polylines means that our side lines will be doubled up, each lot sharing a side line. Click OK.

Select front polyline: Pick north R-O-W
Select back polyline: Pick northernmost polyline the back property line.

The 1.00 acres lots are laid out as far as is possible. You may get a small lot at the end of the row, which you would erase.

15 Applications of Reverse Polyline. We can get one more lots from Lot Layout, by doing the lower R-O-W at the left side of the drawing, and picking the southern back polyline. Let’s try. Select Lot Layout under Area/Layout. Use same dialog entries. Select the front polyline as the southern edge of the road R-O-W, near the left side of the drawing. Select the back polyline as the southern property line.Oops! Nothing drew. It was unable to calculate. It turns out that the direction of the polyline is important. The southern R-O-W polyline starts way off to the right, so the program was not even considering where we were looking! We need to reverse the direction of the southern R-O-W polyline so it starts on the left side. Select Reverse Polyline, found under the Edit pulldown, sliding over from Polyline Utilities. It prompts: Select polyline or line to reverse: Pick the southern R-O-W polyline.

The polyline now reverses direction, goes left-to-right, and shows phantom direction lines (which are automatically removed when the command ends). Now repeat the Lot Layout command as outlined in the beginning of Step 15, and we get one new lot out of the exercise, as shown below. If you get a second wedge shaped lot, erase it.
16 Break at Intersection. The lower back property line is still continuous. We can work with it in small pieces rather than as one big polyline. Say we want to break it as the inside corner identified by the arrow above. To do this, select Edit pulldown, Break, sliding over to At Intersection. Prompting:

Select Line, Arc, or Polyline to Break: Pick the south property line
Pick Intersection to break at: Move the cursor to the intersection point indicated above, look for the INT snap to appear as you approach the exact corner (which is an intersect), then click there.

17 Draw a Polyline from the corner indicated by the filled dot to the beginning of the R-O-W arc, also indicated by a filled dot in the previous graphic. Select 2D Polyline under Draw.

Pick point or point numbers: End (type in end for the endpoint snap)
of . Pick the inner back property corner
Undo/Arc/Length/<Pick point or point numbers>: End (type in end for the endpoint snap) of . Pick the beginning of the Arc (it will show endpt when you get close to the true start of arc)
Undo+/−/Arc/Close/Length/<Pick point or point numbers>: Enter (to end)

18 Area by Interior Point. We have just created a new lot, but the lot is not defined by one, single, closed polyline. If we want to verify its area, however, we can still use the command Area by Interior Point. Select Area by Interior Point under Area.

Pick point inside area perimeter: Pick inside our new lot

SQ. FEET: 40997.2 SQ. YARDS: 4555.2 SQ. MILES: 0.0
ACRES: 0.9412 PERIMETER: 830.5026

Pick area label centering point: Press Enter here to avoid labeling.

The lot is less than one acres. We will set as a goal to extend its lower boundary to the right to obtain one acre. That is accomplished by using the command Hinged Area. But Hinged Area works best if we have a nice, closed polyline for the new lot. We can get one using the command Boundary Polyline.

19 Boundary Polyline. At the command line, type in BPOLY (or BOUNDARY). When the dialog appears, pick
Then pick all the polylines that surround our new lot. Then after you hit Enter to Select objects, this same dialog returns. Then you select Pick Points and pick inside the lot. This creates a new closed polyline, in the current, LOTS layer (magenta).

20 Select *Hinged Area* under the Area/Layout pulldown.

**Define area by points or closed polyline [Points/<Linework>]?** *press Enter* (for linework)
**Select polyline segment to adjust:** *Pick on the right-side line*
**Select hinge point [endp]:** *Pick on the upper right hinge point (see arrow)*
**Keep existing polyline [Yes/<No>]?:** N
**Area:** 40997.20 S.F, 0.9412 Acres
**Remainder/Acres/<Enter target area (s.f.)>:** A (for acres)
**Remainder/SF/<Enter target area (acres)>:** 1.0

The new lot draws, as shown below:
21 Next, use the Erase command to remove the segment that is pointed to above with the text Click on This Side.

22 Make 2 More Lots with Polyline command. Instead of using Draw, 2D Polyline, we will use the straight AutoCAD polyline command. At the command line, enter PL.

Specify start point: END (type in the endpoint snap)
of Pick the endpoint (which is the lower right corner of the new lot).

Current line-width is 0.00

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: PER (type in the perpendicular snap) to Pick on the R-O-W polyline to the right.

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: press Enter (to end)

Now for the second lot. Referring to the drawing below, repeat the PL command, and answer as follows:

Specify start point: NEA (enter the nearest snap) of Pick on the property line anywhere near the circled point 1 (no need to be exact)

Current line-width is 0.00

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: PER (type in the perpendicular snap, which when intersecting arcs means radial to the arc) to Pick on the R-O-W polyline near circled point 2.

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: ENTER (to end)

The drawing appears below:
23 Issue the *Break at Intersect* command, and break the back property polyline and the cul-de-sac R-O-W polyline at the intersections with our newly drawn polyline from step 22. Repeat this command, and break the back property polyline at the filled dot to the right of the "Sliding Side Area" label below.

24 Repeat *Lot Layout* with the same entries as before. The front and back polylines to select are shown below, along with the results. This gives us 2 more usable lots.

Next, use the 2D Polyline command to generate a segment (above the "Sliding Side Area" label below) that runs from the ENDpoint of the corner to a point PERpendicular to the R-O-W line. Then use BPOLY to create a closed boundary inside it.

Erasing the original segment you placed is a little tricky since the newly formed polyline is on top. When two pieces of geometry lie on top of each other, Carlson will take the one created last. Issue the *Erase* command, then hold down the control key while picking the segment above the "Sliding Side Area" label. When the single segment highlights, press enter to erase it, leaving the boundary polyline.
25 Sliding Side Area. Because we have a small closed polyline, we can investigate another area command, the Sliding Side Area. As shown in the graphic above, we want to slide the north side of the last, smaller lot parallel to its current bearing such that the lot will contain 1.00 acres. Select Sliding Side Area under the Area/Layout pulldown.

**Define area by points or closed polyline [Points/<Linework>]?**  
**press ENTER**

**Select polyline segment to adjust:** Pick the north side of the lot above (shown here containing the words Sliding Side Area)

**Keep existing polyline [Yes/<No>]?**  
**press ENTER**

**Area:** 20375.30 S.F, 0.4678 Acres

**Remainder/Acres/<Enter target area (s.f.)>:** A (a for acres)

**Remainder/SF/<Enter target area (acres)>:** 1.0
Complete the remaining Lots. Using the 2D Polyline command, under Draw, use endpoint snaps and perpendicular snaps (end and per) to draw the final 3 polylines, shown below marked 1, 2 and 3 for reference.

It may not be the most aesthetic subdivision, but we applied a lot of tools making it. But we're not done. There's some real automation ahead.

Create Points from Entities. We have designed a subdivision, in effect, without point numbers. This is the beauty of CAD. But we need to make point numbers in order to stakeout the subdivision. To do this, select Create Points from Entities, under COGO. The following dialog appears:

Set the starting point number to 5, verify the dialog as shown, and click OK. A second dialog, covering what entities to capture, appears next. Stick with the default settings and click OK.
When it asks, Select objects, type in All. Press Enter for no more selections, and Enter again. All the point numbers for stakeout are created.

28 Number the lots, clockwise from the upper left, using the command *Sequential Numbers*. Under Draw, select *Sequential Numbers*. This dialog appears:

Choose the circled text and click OK.

Set the text size (height) to **16** and the starting text value to **10**, as shown. Then click OK.

**Pick point at center of label or type Polyline to label:** *Pick near the center of the first upper left lot.*

**Pick point for label alignment:** *Press F8 for <Ortho on> Pick to the right.*

Now pick near the center of all of the lots, going clockwise.

When done, and back to the command line, press F8 again to set Ortho off.

The resulting drawing, with point numbers, is shown below:
Lot File by Interior Text. Official lot files can be created whenever a lot number or name exists within a lot as the sole text (other text may be present but could be frozen). So we will play it safe and first freeze the point number layer. Before we do, take note of the point number assigned to the NW corner of Lot 10. In our case, it is point 64 (it may be different in your case, depending on how you selected the objects in the command Convert Entities to Points).

Under View, select **Freeze Layer** and pick on one of the point numbers. Now go to the Area/Layout pulldown, select **Create Lots** and slide over to select **Lot File by Interior Text**.

A dialog box will appear. Be sure that is says Block Name 1. Click OK.

**Select lot lines, polylines and text.**  
**Select objects:** Pick the lots and the lot numbers

The Lot Files will be created. Before we look at the Lot Files, let's finish up and do area annotation on the upper lots, by the command **Area by Interior Point**.

Note: If we had not made points at all lot corners, using Convert Entities to Points, the Lot File by Interior Text would make point numbers. This is the reason for the prompt: Starting point number. If points are found, no new ones are created. Lot files must have points at all the corners.

Area by Interior Point. Select **Area Defaults**, under Area/Layout, and cancel the square feet plot, leaving only the area plot to 3 decimal places. Set as shown below:
Now choose *Area by Interior Point*, under the Area/Layout pulldown menu, and pick inside Lots 10 through 16, as shown below:

31 Select *Lot Manager*, under Area/Layout, and the following Lot Editor dialog appears:
Pick on Lot 10 and click Report. This will lead to the Lot Report dialog box.

Be sure that your setting are as shown above, and then click Lot Report.
This dialog is typical of the many Carlson Standard Report Viewer dialogs, first introduced in Carlson CES. You can click on 1 or more lines, highlight them and hit the delete key on the keyboard, and these lines will delete. You can edit lines directly in the dialog. You can also save the report to disk with the Save icon shown above. To exit, click the Exit icon.

32 The Edit Current (lot) option within the Lot Editor dialog box can be used to describe a lot by different point numbers, or to assign a lot to a different block. This is explained here and shown below for reference purposes only.

Click Lot Manager under the Area/Layout pulldown menu. You will see the Lot Editor dialog as shown in Step 31. First, make sure that a .lot file is open. If it is not, open one. Then, under Selection, select a lot to edit. Click Edit Current. You will get this dialog. Note the graphic display in the lower half, which map the Points listed above.
33 Re-Drawing Lots after Editing Points. Let's assume you actually changed the point numbers that define Lot 10. That would cause the lot to draw differently. Also, you could simply alter the coordinate values of a point in the current lot file. That would also cause the lot to draw differently. Let's take the latter approach. Remember point 64? It is the NW corner of lot 10 (in our case yours may be different as stated above). So select *Edit Points* under the Points pulldown menu. A spreadsheet appears. Scroll down to point 64 (or whatever point is your NW corner of Lot 10).
Click on the Northing and edit it to 5050. This is for illustration purposes. In reality, you might be fine-tuning your subdivision design points. As long as the same points define the lots, you are, in effect, making a ready-made new drawing. Now select at the top of the dialog File, then *Save and Exit*.

34 Draw the Lot File. Before we draw the lot file, save your drawing by selecting *Save* under the File pulldown menu. Then choose *New*, exit the Startup Wizard (if it appears), and go straight to *Lot Manager*, found under the Area/Layout pulldown menu. *Lot Manager* provides the tools for drawing lot files to the screen.
Click the Existing tab. Select the plat4 lot file and click Open. Now select your existing crd file that you created earlier. In the next dialog, called Lot Editor, shown below, choose all lots by clicking Select All. Then click Draw.
Accept the defaults and click OK to the Draw Lots dialog box. This leads to the Auto-Annotate dialog, shown below. Use the settings shown here. Click OK.

Next comes the Area Defaults dialog, as seen in Step 30. Fill out exactly as shown in Step 30.
Click OK and then Exit. This leads to the plot shown below, created entirely from stored Lot Files, and showing our revision of Lot 10.

This completes this Lesson 5 tutorial titled Intersections and Subdivisions.

**Lesson 6: Contouring, Break Lines and Stockpiles**

1. Click the icon for Carlson and start-up AutoCAD/Carlson from Windows.
2 Once in Carlson, exit out of the Startup Wizard (if it appears) and click Open under the File pulldown menu. Look for the file Mantopo.dwg and click on it.

3 Select Triangulate & Contour from the Surface pulldown menu (within the Survey module). Click the Contour tab. Let's target contours at a 1-unit interval, and contour the area of points. You will see this dialog:

![Triangulate and Contour dialog]

Make all settings as shown (most of them are the default). We want to make sure that the Contour Interval (top right) is set to 1. Also, be sure to set the Index Interval to 5. Click OK.

Select the points and breaklines to Triangulate.

Select objects: Do a bottom right to upper left crossing selection by picking just to the left of the small, stockpile contour map, near the bottom of the screen, and then picking the upper left of the screen (capturing all points).

Select objects: Enter (for no more)

A dialog box appears. Select Mantopo.crd as your crd file. Click Open and the points will be read from the crd file.

Range of Point Numbers to use [<All>/Group]: Enter (to accept All)

Wildcard match of point description <a>: Enter

Contours are drawn, but notice the unacceptable wavy look around the perimeter an area which is meant to be a ditch.
Type in U for Undo and press Enter until the new contours (at left) disappear and you are back at the command prompt.

4 Field-to-Finish: From within the Survey module, under the Survey pulldown menu, select *Draw Field-to-Finish*. You will be prompted for the CRD file to process. Choose the Existing tab, then select MANTOPO.CRD, which resides in Carlson's data folder, and click Open. The Draw Field to Finish dialog appears.

At the lower left of the Draw Field to Finish dialog, click Edit Codes/Points. The Field to Finish dialog appears.
On the left side of the Field to Finish dialog, under the heading Code Table, there is an option called Code Table Settings. Click on it. You will see this dialog:

As you can see at the top of the Code Table Settings dialog, the default Field to Finish code definition (.FLD) file is Carlson.fld. We want to make a new code table because the coordinate file for the field survey includes special coding (17 and 18) for ditch lines and top of banks.

You can react and adjust to whatever a field crew uses by making a new field-to-finish table that can load up the codes right from whatever descriptions were used in the field. To do this, click Set at the upper-right of the Code Table Settings dialog, then choose the New tab (for new file) and you might name it Mantopo, as shown below:
Click Open. You will be taken to the previous dialog.

Notice how `\DATA\Mantopo.fld` is now listed at the top. Click OK. You will return to the main Field to Finish table, completely empty, as shown below:
Now, jump start the table by choosing the option Code Table by CRD (located in the lower left of the dialog). Choose Append.

In this lesson, we only care about code 17 and 18, so highlight all of the others (by holding the CTRL key down and picking them), then choose Cut. Now highlight both 17 and 18 as shown below.
Pick the middle Edit button. Another dialog appears.

Click the Entity button for yet another dialog, shown below. Make all settings as shown in this box. We will turn them both into 3D polylines (which will act as break lines or barrier lines for contouring). Accept the 3D Polyline choice by clicking OK, then hit Exit, which will take you back to the Field to Finish dialog.
The last steps are to first to save the Field-to-Finish (.FLD) file Mantopo by clicking the Save button. Then click Draw (lower right) to draw the 3D polylines. You will see the following dialog which allows you to control the details of what to draw. Make sure lines is the only entity to be drawn, not points or symbols. Take a quick look at Additional Draw Options by clicking that button. Make sure that the Point Label Settings are set so that you can see the points properly. Click OK to both dialog boxes.
The following drawing is created. All the ditch lines and top of bank lines, because they were coded 17 and 18, are drawn in one quick procedure.

Because the field crew did not use start and stop logic (e.g. appending 7 or some agreed upon code to a description could end a polyline and start another), some polylines connect that should not. In particular, the line pointed to near the NW corner is clearly crossing the ditch line. It must be removed. Choose the Edit pulldown, then Polyline Utilities, Remove Polyline, then Remove Polyline Segment.
Break polyline at removal or keep continuous [<Break>/Continuous]? Enter
Select polyline segment to remove: Select the polyline segment to the right of point 127. You will recognize this as a long segment running from point 127 to point 50.
Select polyline segment to remove: Enter (for no more)

6 Return back up to the Surface Menu, pick Triangulate & Contour, and set the standard contour interval to 1 (as before), but specify Draw Index Contours. Set the index interval to 5. Then do a right-to-left crossing selection as before (avoiding the stockpile at the lower right). Select the Mantopo.crd file again.

Now we get excellent contours, with a sharply defined ditch. Under View, do Freeze Layer and pick on a point. The points will freeze.

Here is the improved drawing, helped out by 3D polylines, which, if selected, act as break lines, which were produced by Draw Field-to-Finish.

7 Delete Layer. Let's say that now you don't want the break lines on there. You don't want to even freeze them, you want to fully delete them. There is a command for that under Edit. Pick Erase, sliding over to Erase by Layer. This dialog appears.
If you know the layer names, you can just type them in. If you know where they are but not their names, then click on Select Layers from Screen. If you'd recognize the layer name if you saw it in a list, click Select Layers by Name. Click on Select Layers by Name and pick 17 and 18, then OK twice. Notice the change in the drawing.

**8 Explode.** Inserted Drawings need to be exploded. Do a View pulldown, option Window and window in on the stockpile at the lower right of the drawing. If you type E to Erase, and try to erase any aspect of the stockpile, the whole stockpile will erase all features. That is because the Stockpile was another drawing inserted into this drawing. Sometimes other drawings that are inserted are referred to as Blocks. In any case, this stockpile block, or inserted drawing, needs to be exploded. Explode just breaks it up into its unit objects which then start to behave normally. Select Explode under Edit and slide over to Standard Explode. Then pick the stockpile. It is now a set of normal objects.

It’s also worth noting that while the block has been exploded, it still exists in the drawing as a block definition. This means that now that it’s exploded it is taking up twice the amount of storage space in the drawing. As such, you should purge the drawing of the unused block, or turn on the explode toggle when inserting one drawing into another. As a basic rule, if it’s a symbol, don’t turn on the explode toggle; if it’s a complete dialog, turn it on.

**9 Change Elevations.** Let’s assume our stockpile drawing is too high and should be lowered in elevations by 540 units. To best see the effect of this command, bring back the points by selecting Thaw Layer, under View. Now select the Edit pulldown, then Change, then Elevations.

**Ignore zero elevations [Yes/No]?** Enter

**Type of elevation change [Absolute/Differential]?** D

**Change Layer for changed entities [Yes/No]?** Enter

**Positive number increases, negative number decreases elevation.**

**Scale/Elevation difference <0.00>:** -540

Hit Enter twice.

**Select objects:** Do a lower right pick to upper left pick (automatic crossing) selection.

**Select objects:** Enter (for no more)

Notice in the drawing below how everything has change elevation, including the points, but with the exception of the contour text.
Do the command *List Elevation* under the Inquiry pulldown, pick on an index contour, and notice how the elevation has indeed changed. Repeat step 7 and delete the layer Ctext, so as to remove the 5 index contour elevations, which are no longer accurate.

**10 Volumes by Layer.** One of the signature commands of Carlson, *Volumes by Layer* will produce accurate volumes without making any files. The only prerequisite is that the existing and final surfaces exist on the drawing in separate, distinct layers. It is also very important to have a drawn inclusion perimeter to pick and define where the volumes are being calculated. In our example, the original ground will be the 3D polyline connecting points 1 through 15, and everything else above will be the final ground (including the 3D perimeter itself).

Select *Volumes by Layers*. This command is found under the Grading menu, within *Volumes by Grid Surface*.

**Pick Lower Left limit of surface area:** *Pick below and to the left* of the stockpile, but as close as possible to the stockpile without clipping it in the window. You want to totally include it, but with little wasted margin.

**Pick Upper Right limit of surface area:** *Pick above and to the right* of the stockpile.

A dialog appears:
We will stick with the defaults, as shown. Notice that we are using 50 grid cells within our window, and since our window was not a perfect square, the cell sizes are not whole numbers. (In this example it is 6.88 x 5.77. You may have slightly different sizes). Seeing this, if we wanted 5 x 5 cell size, we could click the Dimensions of a Cell option and set the size to 5 x 5. Hundreds or thousands of cells in both directions will increase calculation time. You can experiment with more cells, or if you prefer, smaller cells (which makes more cells), and see when you get diminishing returns in terms of accuracy changes. After a while, tighter, smaller cell sizes don't add any value to the precision of the calculation. Click OK.

Then pick the layers that define the existing ground (Perimeter) and the layers that define the final ground (Perimeter, Barrier, Ctr, Ctrindex).

![Volumes by Layer](image)

Then click OK. Notice how the Perimeter layer is common to both. If you want to be a master of volumes, remember this as a mantra: The perimeter should be a 3D polyline in a distinct layer, common to both surfaces. A stockpile is just a special case in that sometimes the 3D perimeter is all you know about the base surface.

When asked to Select objects, do a right-to-left (crossing) selection of the entire stockpile area. Lastly, you will be asked for the inclusion perimeter (pick the white perimeter polyline) and the exclusion perimeter (none). This leads to a flexible reporting and output dialog:

![Volume Report Options](image)

Elevation Zone Volumes, for example, would produce volumes in any desired increment from the base of the stockpile going up. If the stockpile consists of coal (80 lbs/c.f.), then Report Tons can be clicked on and a Density value entered.

Click OK, and the basic report is produced, as seen below. We did not include the points in the final layer. Since
there is a high point, for example, the top of the stockpile, the points would lift the volumes up slightly.

Click the Exit icon to return to the command prompt.

11 Stockpile Volumes. Our Stockpile is naturally well-suited for applying the simplest volume command of all Stockpile Volumes. It requires that the 3D perimeter polyline for the stockpile be placed in a layer called Perimeter which ours is. So let's try it.

Select Calculate Stockpile Volume found under the Grading pulldown menu.

Material density lbs/ft\(^3\) (Enter for none): 80

Ignore zero elevations [\(<Yes>/No\)]? Enter

Reading points ...

Select Stockpile perimeter polyline: Crossing select (right-to-left picks) the entire stockpile area.

The grid resolution dialog (note that it is still at 50x50) appears again. Click OK. Done. A report is generated.

This completes the Lesson 6 tutorial: Contouring, Break Lines and Stockpiles.
AutoCAD Overview

This chapter explains the essentials of using AutoCAD including command entry, selection sets and layers. Since Carlson Software is built on the AutoCAD OEM engine, it is helpful to know the AutoCAD basics. Several of the Carlson Software commands are native AutoCAD commands and many others have an AutoCAD style user-interface.
Issuing Commands

Virtually all commands in Carlson Software have three or more ways they can be initiated. The two most common are the menu and the toolbar, but the command line can many times be a very easy method of working through commands. Using the menu and toolbar should be second nature to Windows users, so this section will mainly focus on the command line usage in Carlson Software.

Command Line Prompt-Command:

Carlson Software has a command line prompt where commands are "issued" and the status of a command is reported. When you select a command from the menu or toolbar, that command name is sent to the command line and is executed. Before most commands can begin, all other commands must be terminated. The exceptions are referred to as transparent commands. The easiest way to see if no commands are running is to look at the command line. If it displays Command: no commands are currently in progress.

Enter

When you are required to press the Enter key in Carlson Software, you can use the Enter key on the keyboard or you can press the spacebar or click the right mouse button.

Pressing the Enter key will perform different operations depending on your location within Carlson Software. If you are in the process of running a command, the Enter key will end the command (if there are no available options) or it will select one of the options available (see below). If you are at the command line Command: prompt, pressing the Enter key will repeat the last command.

Right Mouse Button

As mentioned above, the right mouse button can be used as enter. However, you can set the right mouse button to perform different functions. The control for the Right Mouse Button behavior is in the Mouse Click Settings command. When you click the right mouse button, you will get a drop down list of the options and can select the desired one. Move the cursor the desired option and click on it with the left mouse button.

Getting Out of a Command-Esc

For commands that provide no options, the Enter key (or spacebar or right mouse button) will end the command you are using. Also, when a command is issued in Carlson Software, this action will also automatically end the previous command. However, there are exceptions to these two rules.

To avoid any problems with using the above methods to end a command, you can press the Escape (Esc) key. For example, if the command line displays something other than Command: or if a command you want to run does not start because you are using another command, you will want to end the command and return to the command prompt. Using the Escape (Esc) key will accomplish this every time.

Note: Some commands have several optional levels which will require the escape key to be pressed more than once.

If you accidentally select a location on the screen and start a selection window, the command prompt will prompt for another corner. Either select another point on the screen to finish the selection (not advised) or press the Esc key to return to the Command: prompt.

Commands Option
When any command is issued, the command line acts as a status bar that will show the available options and "ask" for input from you.

When there are options for the command you are currently running, these options will be shown on the command line with capital letters in the option name. To use one of the options, type the capital letter(s) at the prompt. For example, if you issue the Zoom command, the command prompt will show All/Center/Dynamic/Extents/...<Realtime>: To select the Dynamic option, type D at the command line, then press the Enter key. If you do not input an option and just hit enter, you will be selecting the option that appears in the <> brackets. For the example shown, that is the Realtime Zoom option.

**Transparent Commands**

Several commands in Carlson Software can be run transparently. This means that they can be performed while another command is running. For example, if you are in a command and are trying to select something in the drawing but it is too small to see, you can use the zoom command transparently. Zoom to the area where the object is, then select the object without ending the initial command. The most commonly used commands are the View commands of Zoom and Pan, and the Properties commands including the Layer dialog box.

To issue a transparent command, type an ' (apostrophe) before the command name. For example, 'Z would be transparent zoom. Note that many commands will automatically be assumed to be transparent if they are issued from the toolbar while another command is running.

When you are in a command that is running transparently, this will be indicated with a >> at the far left of the command line preceding any options or other text. When a transparent command is complete, you will return to the command you were previously running. If you are in a transparent command and want to end the command to get back to the command prompt, you will need to press the Esc key twice.

**Note:** If you select a View command while running another command, the other command will not end. You will be running the View command transparently. This is one of the exceptions to the rules for ending a command. If you do not want to run the View command transparently, you need to complete the other command or end it by pressing the Esc key.

**General Commands**

**Enter**

When you are required to press the Enter key in Carlson Software, you can use the Enter key, the spacebar on the keyboard or click on the right mouse button.

**Repeating Commands**

When you press the Enter key at the command line Command: prompt, you will repeat the last command.

**Cancel**

The Escape key (Esc)key can be used to cancel any command. Some commands may require pressing the Escape key more than once.

**Command Options**
The command line changes as a command is running. When there are options available for the command you are running, they will display at the command line. To select one of the options, type the capital letter(s) in the name of the option and press the Enter key.

**Selection of Items**

Most commands in Carlson Software require the selection of objects. When you need to select objects, the command line will prompt Select objects:. When you are at this prompt, your next step will be to create a selection set. While creating the selection set, the prompt Select Objects: repeats and you can continue to select objects until you press the Enter key, at which time the command you are using will continue and use the objects selected. If you are selecting objects for an Eagle Point Software command, the objects selected will then be used for that command.

**Selection Sets**

There are several ways to create a selection set from the Select objects: prompt. With all selection methods, the number of objects selected will be displayed in the command line along with any objects that were duplicated. Following are the most commonly used methods for creating a selection set:

**Single**

A single selection is made when you move the object selection target to an object on the screen and click on it. The selected object will highlight and the select objects prompt will return. The cursor changes to a small square when the command line displays Select objects:.

**Window**

A Window will select all objects completely inside of the rectangle drawn. Create a window by selecting a point on the view screen and then moving the cursor right. The window will display as a solid rectangle. You can also create a window by typing W at the select objects prompt. In this case you can move the cursor to the left to create the window.

**Crossing**

A crossing will select all objects within the rectangle as well as those touched by the rectangle. If you select a point on the view screen and move the cursor to the left, you are creating a crossing. The crossing will display as a dashed rectangle. You can force a crossing by typing C at the select objects prompt, allowing you to move the cursor to the right and create the crossing.

**Previous**

After you select several objects, they will be temporarily stored as a selection set. Should you want to re-use the same objects that were selected by the last command, you can type P at the Select objects: prompt.

**Remove**
If you select incorrect objects, you can type R to remove objects from the selection set. When you are in Remove mode, the prompt will be Remove objects: Click on the objects that you do not want to include in your selection. To return to select or add mode, type A at the command line.

**Grips**

Objects may also be selected before issuing the command and receiving the *Select objects:* prompt. This selection will turn on Carlson Software "grips." Grips appear as small blue squares in the drawing. All objects with grips will be used when a command is issued. Grips are turned on similar to selecting objects as described in the previous section, but with the command line at the *Command:* prompt, not the *Select Objects:* prompt. You can select single objects by clicking on an object with the standard cursor or you can select multiple objects by clicking in the view where there are no objects, then creating the window (right) or crossing (left). To remove grips, press the Esc key twice.

**Using Grips**

Grips can also be used to edit or change the location of objects in the drawing. Move your cursor to a grip and click. You should notice the cursor "snap" to the grip. The grip will turn from blue to red. The object grip is now attached to the cursor so you can move the object to the desired location and release it by clicking again.

**Properties and Layers**

Properties define how an object in Carlson Software is stored. One of the most common properties is the Layer. Layers can be turned off or frozen so the objects on that layer are hidden from the view of the drawing. Layers that are turned off can still be selected while frozen layers are essentially removed from the working set of the drawing. After layers are turned off or on, a redraw (which is done automatically) will update the view. A redraw of a file is a rather quick process. After a frozen layer is thawed, a regeneration may be required to update the view. Regenerations on large files may take a considerable amount of time depending on your hardware.

**Layer Dialog Box**

The Layer dialog box provides control of the drawing layers. You can turn layers on, off, freeze or thaw them, change the layer color and linetype, set the current layer, add new layers, delete layers, etc. To perform any of these functions, click on the *Layers* button .

In the Layer dialog box, you can highlight several individual layers to perform actions on at once by holding down the Control key and clicking on the desired layers. You can also highlight a continuous range of layers by highlighting one layer, holding down the Shift key, and clicking on another layer. All layers between the two will be selected. To select all of the layers, hold down the CTRL key and press A on the keyboard.

**Layer Drop List**

To turn layers on/off or freeze/thaw, you can also use the drop list on the toolbars. When you click on the symbols in the list, the layer's status will be changed appropriately.

**Setting Current Layer**

The current layer will be the one shown in the Layer drop list box. You can change the current layer by selecting the desired current layer from the drop list. You can also use the Set Current Layer button and select an object on the...
layer. The layer the object is on will become the current layer. Finally, you can highlight a layer in the Layer dialog box and click on the **Current** button to make the highlighted layer current.

You cannot freeze the current layer, but you can turn that layer off (not recommended).

### Changing Properties

To change the properties of an object in the drawing, use the Properties button on the toolbar or the Change command from the command line. This command will allow you to change the layer an object is on, the color or linetype of the object. The color and linetype can be set to bylayer or to a specific setting. Bylayer means that when the property for a layer is changed, so does the property for the object. For example, the specific setting of an object may be the color blue. No matter what color you set for the layer the object is on, that object will be blue.

### Properties Toolbar

![Properties Toolbar Image]

If this toolbar (or any toolbar) is not displayed, you can open it using the Toolbars dialog box. Type `toolbars` at the command line.

### Layer

The Layer dialog box is used to modify layers properties (color or linetype) or status (on/off, freeze/thaw).

**Key-in:** `LA` or `ddlmodes`

**Toolbar:** [Layer Icon]

### Current Layer

The Current Layer is the layer that you are on and will be working with. The Current Layer is the one shown in the Layer drop list. For example, in the above toolbar illustration, the Current Layer is **Water**.

**Toolbar:** [Current Layer Icon]

### Change

The Change command allows you to modify the properties of an object, such as layer and color.

**Key-in:** `CH`

**Toolbar:** [Change Icon]
The Carlson Software programs share some of the same pull-down menus, such as File, Edit, View, Draw, Settings and Points. Within each program, the other pull-down menus, typically, are specific to that program. The common pull-down menus contain general commands that are applicable within all programs. Many of these commands are AutoCAD commands which are described in your AutoCAD Reference manual. The Carlson commands located in the more common pull-down menus are explained in the next sections.

All the options on the File menu not described here are AutoCAD commands, which are discussed in the AutoCAD Reference Manual.
New

This command allows you to create a new drawing file. This routine defines the settings for a new drawing. You can start a new drawing file by selecting New, and then picking a template file. SURV.DWT is the default template file for use in Carlson Survey. After choosing the template, click the Open button at the lower-right. Next, you will either see the New Drawing Wizard dialog box or you will be taken to a blank screen. Should you use the wizard, a new drawing name will need to be chosen in order to get to the next step.

There are two methods that you can use to create a new drawing. One is this New command. The other is Open, also under the File pulldown menu. If you need to open an existing drawing, use the OPEN command, under File, then choose an existing file name.

The opening dialog, Select Template, lists all template files that currently exist in the drawing template file location. Choose a file to use as a starting point for your new drawing. A preview image of the selected file is displayed to the right. If the wizard is in use, the following options will be available to you in the New Drawing Wizard dialog. The New command starts a new drawing using default settings defined in either the surv.dwt or surviso.dwt template, depending on the measurement system you've chosen. You cannot modify the surv.dwt or surviso.dwt templates. To start a new drawing based on a customized template, see Use a Template.
**New**

This option starts a new drawing based on the Imperial measurement system. The drawing is based on the surv.dwt template, and the default drawing boundary (the drawing limits) is 12 × 9 inches.

**Metric**

This option starts a new drawing based on the metric measurement system. The drawing is based on the surviso.dwt template, and the default drawing boundary (the drawing limits) is 429 × 297 millimeters.

The New command creates a new drawing using the settings defined in a template drawing you select. Template drawings store all the settings for a drawing and may also include predefined layers, dimension styles, and views. Template drawings are distinguished from other drawing files by the .DWT file extension. They are normally kept in the template directory. Several template drawings are included with Carlson Survey. You can make additional template drawings by changing the extensions of drawing file names to .DWT.

**Pulldown Menu Location:** File

**Keyboard Command:** new

**Prerequisite:** None

---

**Open**

**Function**

This command allows you to open an existing drawing file. Carlson TakeOff displays the Select File dialog box (a standard file selection dialog box). Select a file and click Open.

**Prerequisite:** None

**Keyboard Command:** OPEN

---

**Close**

**Function**

This command allows you to close the current drawing. Carlson TakeOff closes the current drawing if there have been no changes since the drawing was last saved. If you have modified the drawing, the program prompts you to save or discard the changes. You can close a file that has been opened in Read-only mode if you have made no changes or if you are willing to discard changes. To save changes to a read-only file, you must use the SAVEAS command.

**Prerequisite:** None
Save

Function

If the drawing is named, Carlson TakeOff saves the drawing without requesting a file name. If the drawing is unnamed, the program displays the Save Drawing As dialog box (see SAVEAS) and saves the drawing with the file name you specify. If the drawing is read-only, use the SAVEAS command to save the changed file under a different name. This command allows you to save the drawing under the current file name or a specified name.

Prerequisite: None

Keyboard Command: SAVE or QSAVE

Save As

Function

This command allows you to save an unnamed drawing with a file name or renames the current drawing.

Carlson TakeOff displays the Save Drawing As standard file selection dialog box. Enter a file name and type. You can select any of the following file types:

- Carlson Software 2002/AutoCAD 2000 (*.dwg)
- AutoCAD R14/LT 98/LT 97 Drawing (*.dwg)
- AutoCAD R13/LT 95 Drawing (*.dwg)
- Drawing Template File (*.dwt)
- Carlson Software 2002 DXF (*.dxf)
- AutoCAD R14/LT 98/LT 97 DXF (*.dxf)
- AutoCAD R13/LT 95 DXF (*.dxf)
- AutoCAD R12/LT2 DXF (*.dxf)

Carlson TakeOff saves the file under the specified file name. If the drawing is already named, the program saves the drawing to the new file name. If you save the file as a drawing template, the program displays the Template Description dialog box, where you can provide a description for the template and set the units of measurement.

Saving a drawing in Release 14/LT 98/LT 97 format is subject to the following limitations:

- Hyperlinks are converted to Release 14 attached URLs.
- Database links and freestanding labels are converted to Release 14 links and displayable attributes.
- Database attached labels are converted to MText and leader objects, and their link information is not available. Attached labels are restored if you open the drawing in AutoCAD 2000 or later.
- Lineweight information is not available. Lineweights are restored if you open the drawing in AutoCAD 2000 or later.

Saving a drawing in Release 13/LT 95 format is subject to the following limitations:

- Lightweight polyline and hatch patterns are converted to R13 polylines and hatch patterns.
• Raster objects are displayed as bounding boxes. Raster objects are restored if the drawing is opened in AutoCAD 2000 or later.

• Draw order information is not applied for display or print.

• Xrefs that have been clipped with a boundary box are displayed in full as attached xrefs because Release 13 does not support xref clipping. Clipping is restored if the drawing is opened in AutoCAD 2000 or later.

Saving a drawing in Release 12/LT 2 DXF format is subject to the following limitations:

• Lightweight polylines and hatch patterns are converted to R12 polylines and hatch patterns.

• All solids, bodies, regions, ellipses, leaders, multilines, rays, tolerances, and xlines are converted to lines, arcs, and circles as appropriate.

• Groups, complex linetypes, OLE objects, and preview images are not displayed.

• Many objects are lost if you save a drawing as Release 12 and open it later in AutoCAD 2000 or later.

Prerequisite: None

Keyboard Command: SAVEAS

Page Setup

Function

This command allows you to configure your drawing for plotting. The Page Setup dialog box has the same options as the Plot dialog box. See the PLOT command below for a detailed description of options.

Menu Location: File

Prerequisite: None

Keyboard Command: PAGESETUP

Plot Preview

Function

This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit. This command is the same as the Full Preview option under Plot.

Menu Location: File

Prerequisite: None

Keyboard Command: PREVIEW

Plot

Function

This command allows you to plot a drawing to a plotting device or file.

Carlson TakeOff displays the Plot dialog box. Choose OK to begin plotting with the current settings and display the Plot Progress dialog box.
The Plot dialog box includes the tabs, Plot Device and Plot Settings, and several options to customize the plot.

- **Layout Name:** This option displays the current layout name or displays "Selected layouts" if multiple tabs are selected. If the Model tab is current when you choose Plot, the Layout Name shows "Model."
- **Save Changes to Layout:** This option saves the changes you make in the Plot dialog box in the layout. This option is unavailable if multiple layouts are selected.
- **Page Setup Name:** This option displays a list of any named and saved page setups. You can choose to base the current page setup on a named page setup, or you can add a new named page setup by choosing Add.
- **Add:** This option displays the User Defined Page Setups dialog box. You can create, delete, or rename named page setups.

Under the Plot Device Tab you can specify the plotter to use, a plot style table, the layout or layouts to plot, and information about plotting to a file.

- **Plotter Configuration:** This field displays the currently configured plotting device, the port to which it's connected or its network location, and any additional user-defined comments about the plotter. A list of the available system printers and PC3 file names is displayed in the Name list. An icon is displayed in front of the plotting device name to identify it as a PC3 file name or a system printer.
- **Properties:** The option displays the Plotter Configuration Editor (PC3 Editor), where you can modify or view the current plotter configuration, ports, device, and media settings.
- **Hints:** This option displays information about the specific plotting device.
- **Plot Style Table (Pen Assignments):** This option sets the plot style table, edits the plot style table, or creates a new plot style table.
- **Name:** This option displays the plot style table assigned to the current Model tab or layout tab and a list of the currently available plot style tables. If more than one layout tab is selected and the selected layout tabs have different plot style tables assigned, the list displays "Varies."
• Edit: This option displays the Plot Style Table Editor, where you can edit the selected plot style table.
• New: This option displays the Add-a-Plot-Style-Table wizard, which you can use to create a new plot style table.
• Plot Stamp: This option places a plot stamp on a specified corner of each drawing and/or logs it to a file.
• On: This option turns on plot stamping.
• Settings: This option displays the Plot Stamp dialog box, where you can specify the information you want applied to the plot stamp, such as drawing name, date and time, and plot scale.
• What to Plot: This field defines the tabs to be plotted.
• Current Tab: This option plots the current Model or layout tab. If multiple tabs are selected, the tab that shows its viewing area is plotted.
• Selected Tabs: This option plots multiple preselected Model or layout tabs. To select multiple tabs, hold down CTRL while selecting the tabs. If only one tab is selected, this option is unavailable.
• All Layout Tabs: This option plots all layout tabs, regardless of which tab is selected.
• Number of Copies: This option denotes the number of copies that are plotted. If multiple layouts and copies are selected, any layouts that are set to plot to a file or AutoSpool produce a single plot.
• Plot to File: This option plots output to a file rather than to the plotter.
• File Name: This option specifies the plot file name. The default plot file name is the drawing name and the tab name, separated by a hyphen, with a .plt file extension.
• Location: This option displays the directory location where the plot file is stored. The default location is the directory where the drawing file resides.
• [...]: This option displays a standard Browse for Folder dialog box, where you can choose the directory location to store a plot file.

3 Under the Plot Settings Tab you specify paper size, orientation, plot area and scale, offset, and other options.
• **Paper Size and Paper Units:** This field displays standard paper sizes available for the selected plotting device. Actual paper sizes are indicated by the width (X axis direction) and height (Y axis direction). If no plotter is selected, the full standard paper size list is displayed and available for selection. A default paper size is set for the plotting device when you create a PC3 file with the Add-a-Plotter wizard. The paper size you select is saved with a layout and overrides the PC3 file settings. If you are plotting a raster image, such as a BMP or TIFF file, the size of the plot is specified in pixels, not in inches or millimeters.

• **Plot Device:** This field displays the name of the currently selected plot device.

• **Paper Size:** This field displays a list of the available paper sizes.

• **Printable Area:** This field displays the actual area on the paper that is used for the plot based on the current paper size.

• **Inches:** This option allows you to specify inches for the plotting units.

• **MM:** This option allows you to specify millimeters for the plotting units.

• **Drawing Orientation:** This option specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation. You can change the drawing orientation to achieve a 0-, 90-, 180-, or 270-degree plot rotation by selecting Portrait, Landscape, or Plot Upside-Down. The paper icon represents the media orientation of the selected paper. The letter icon represents the orientation of the drawing on the page.

• **Portrait:** This option orients and plots the drawing so that the short edge of the paper represents the top of the page.

• **Landscape:** This option orients and plots the drawing so that the long edge of the paper represents the top of the page.

• **Plot Upside-Down:** This option orients and plots the drawing upside down.

• **Plot Area:** This option specifies the portion of the drawing to be plotted.

• **Layout:** This option plots everything within the margins of the specified paper size, with the origin calculated from 0,0 in the layout. Available only when a layout is selected. If you choose to turn off the paper image and layout background on the Display tab of the Options dialog box, the Layouts selection becomes Limits.

• **Limits:** This option plots the entire drawing area defined by the drawing limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option. Available only when the Model tab is selected.

• **Extents:** This option plots the portion of the current space of the drawing that contains objects. All geometry in the current space is plotted. TakeOff may regenerate the drawing to recalculate the extents before plotting.

• **Display:** This option plots the view in the current viewport in the selected Model tab or the current paper space view in the layout.

• **View:** This option plots a previously saved view. You can select a named view from the list provided. If there are no saved views in the drawing, this option is unavailable.

• **Window:** This option plots any portion of the drawing you specify. If you select Window, the Window button becomes available. Choose the Window button to use the pointing device to specify the two corners of the area to be plotted or enter coordinate values.

• **Plot Scale:** This option controls the plot area. The default scale setting is 1:1 when plotting a layout. The default setting is Scaled to Fit when plotting a Model tab. When you select a standard scale, the scale is displayed in Custom.

• **Scale:** This option defines the exact scale for the plot. The four most recently used standard scales are displayed at the top of the list.
• Custom: This option creates a custom scale. You can create a custom scale by entering the number of inches or millimeters equal to the number of drawing units.

• Scale Lineweights: This option scales lineweights in proportion to the plot scale. Lineweights normally specify the linewidth of printed objects and are plotted with the linewidth size regardless of the plot scale.

• Plot Offset: This field specifies an offset of the plotting area from the lower-left corner of the paper. In a layout, the lower-left corner of a specified plot area is positioned at the lower-left margin of the paper. You can offset the origin by entering a positive or negative value. The plotter unit values are in inches or millimeters on the paper.

• Center the Plot: This option automatically calculates the X and Y offset values to center the plot on the paper.

• X: This field specifies the plot origin in the X direction.

• Y: This field specifies the plot origin in the Y direction.

• Plot Options: This field specifies options for lineweights, plot styles, and the current plot style table. You can select whether lineweights are plotted. By selecting Plot with Plot Styles, you plot using the object plot styles that are assigned to the geometry, as defined by the plot style table.

• Plot object lineweights: This option plots lineweights.

• Plot with Plot Styles: This option plots using the plot styles applied to objects and defined in the plot style table. All style definitions with different property characteristics are stored in the plot style tables and can be easily attached to the geometry. This setting can replace pen mapping in earlier versions of AutoCAD.

• Plot Paperspace Last: This option plots model space geometry first. Paper space geometry is usually plotted before model space geometry.

• Hide Objects: This option plots layouts with hidden lines removed for objects in the layout environment (paper space). Hidden line removal for model space objects in viewports is controlled by the Viewports Hide property in the Object Property Manager. This is displayed in the plot preview, but not in the layout.

• Full Preview: This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit.

• Partial Preview: This option quickly shows an accurate representation of the effective plot area relative to the paper size and printable area. Partial preview also gives advance notice of any warnings that you might encounter when plotting. The final location of the plot depends on the plotter. Changes that modify the effective plot area include those made to the plot origin, which you define under Plot Offset on the Plot Settings tab. If you offset the origin so much that the effective area extends outside the preview area, the program displays a warning.

Prerequisite: None

Keyboard Command: PLOT

**Import Xref to Current Drawing**

**Function**

This command allows you to import external reference files (Xrefs) into the current drawing. Before Xrefs are imported, the drawing data from the Xrefs can be viewed but not modified. This import routine has a simplier method for importing than the Xref Manager command. A list is shown of the Xrefs that are attached to the current drawing. If the Xref file is not found, you can pick the Set Path button to locate the drawing file. To import an Xref, highlight the file name and Pick Import.
Prerequisite: files to import

Keyboard Command: import_xref

**Xref Manager**

**Function**

Attaches, overlays, lists, binds, detaches, reloads, unloads, renames, and modifies paths to external references (Xrefs) in the current (or host) drawing. Displays the Xrefs in the drawing in a tree view or a list view. You can use the F3 and F4 keys to switch between list view and tree view.
List View: Displays a flat listing of the attached Xrefs and their associated data. You can sort the list of references by name, status, type, file date, file size, or the saved path and file name.

Reference Name: Lists the names of the Xrefs as stored in the definition table for the drawing. Status: Shows whether the Xref is loaded, unloaded, unreferenced, not found, unresolved, orphaned, or marked for unloading or reloading.

- Loaded: Currently attached to the drawing.
- Unloaded: Marked to be unloaded from the drawing once the Xref Manager is closed.
- Unreferenced: Attached to the drawing but erased.
- Not Found: No longer exists in the valid search paths.
- Unresolved: Cannot be read by AutoCAD.
- Orphaned: Attached to another Xref that is unreferenced, unresolved, or not found.

Size: Shows the file size of the corresponding reference drawing. The size is not displayed if the Xref is unloaded, not found, or unresolved.

Type: Indicates whether the Xref is an attachment or an overlay.

Date: Displays the last date the associated drawing was modified. This date is not displayed if the Xref is unloaded, not found, or unresolved.

Saved Path: Shows the saved path of the associated Xref (this is not necessarily where the Xref is found).

Tree View: Displays a hierarchical representation of the Xrefs, displaying the relationships between Xref definitions. Tree view shows the level of nesting relationship of the attached Xrefs, whether they are attached or overlaid, and whether they are loaded, unloaded, marked for reload or unload, or not found, unresolved, or unreferenced.

Attach: Displays the External Reference dialog box if an external reference is selected or displays the Select Reference File dialog box if no external reference is selected.

Detach: Detaches one or more Xrefs from your drawing, erasing all instances of a specified Xref and marking the Xref definition for deletion from the symbol table. Only the Xrefs attached or overlaid directly to the current drawing can be detached; nested Xrefs cannot be detached. Carlson TakeOff cannot detach an Xref referenced by another Xref or block.

Reload: Marks one or more Xrefs for reloading. This option rereads and displays the most recently saved version of the drawing.

Unload: Unloads one or more Xrefs. Unloaded Xrefs can be easily reloaded. Unlike detaching, unloading does not remove the Xref permanently. It merely suppresses the display and regeneration of the Xref definition to improve performance.

Bind: Displays the Bind Xrefs dialog box Xref. The Bind option makes the selected Xref and its dependent symbols (such as blocks, Xref styles, dimension styles, layers, and linetypes) a part of the current drawing.

Found At: Displays the full path of the currently selected Xref. This is where the Xref is actually found and is not necessarily the same as the saved path.

Browse: Displays the Select New Path dialog box (a standard file selection dialog box), in which you can select a different path or file name.

Save Path: Saves the path, as it appears in Xref Found At, to the currently selected Xref.
Prompts

Command: _Xref
Overlay Xref "example1": ..\..\..\..\Program Files\Carlson TakeOff
2004\WORK\example1.dwg
"example1" loaded: G:\oem4\src2\work\example1.dwg

Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Command: Specify opposite corner:
Select objects: Enter

Prerequisite: multiple files

Keyboard Command: Xref

Import/Export LandXML Files

This command performs two functions: Export Carlson files to LandXML and Import LandXML files into Carlson.
This command supports version 1.0 of LandXML and the following Carlson file types: Coordinate (.CRD) files,
Centerline (.CL) files, Profile (.PRO) files, Section (.SCT) files, Grid (.GRD) files, Triangulation (.FLT) files, and
Lot (.LOT) files.

Export to LandXML: Allows you to export a Carlson file to LandXML. Choose a new or existing LandXML file,
then choose an existing Carlson file.
Import to Carlson: Allows you to import a LandXML file into Carlson. First, choose a new or existing Carlson
file, then choose an existing LandXML file.

You first see the Import/Export LandXML dialog. To Export, for example, first click Export to LandXML. Then
click Current Drawing Data Files button. You will then see the Select LandXML File dialog box. Select an existing
.XML file to be exported from the list of files on the right and click Open.
The next dialog appears, showing the new buttons to be used for the Export. Choose the Add, Remove, Change Directory and/or Report buttons, and then Continue.

Choosing the Continue button takes you further into the Export process. The Report button will give you the Report Formatter Options dialog box.

Data protection is turned on by default, meaning that if you are importing/exporting to an existing file, you will be prompted before the program overwrites existing data. There is a Point Protection option that will not allow any points to be overwritten if the same number appears more than once in the XML file being imported. If you decide to Import From LandXML, go back to the opening dialog and choose the existing LandXML file.

**Pulldown Menu Location:** File  
**Keyboard Command:** imp_exp  
**Prerequisite:** Files to convert
Write Polyline File

This command creates a polyline file that contains the point data of the select polylines. The objects supported by this tool include polylines, arcs and lines. If you want to include text, you must use the Text Explode To Polylines command found in the Edit menu to convert the text to polylines before running this command. This polyline file is a text file that has three formats. The Carlson format (.PLN) is used by some Carlson commands and by machine control (Carlson Grade, Dozer 2000, GradeStar) for the plan view. Each polyline begins with a line of "POLYLINE, Color number". Then the points for the polyline are listed on separate lines in X,Y,Z format. Here is a list of the available color numbers:

0 = Black 8 = Dark Gray
1 = Blue 9 = Light Blue
2 = Green 10 = Light Green
3 = Cyan 11 = Light Cyan
4 = Red 12 = Light Red
5 = Magenta 13 = Light Magenta
6 = Brown 14 = Yellow
7 = Light Gray 15 = White

The MicroStation format (.txt) can be imported into MicroStation. This format has the coordinates as space delimited for each polyline point. There is an extra column with a 1 or 0 where 1 specifies the start of a new polyline. The DTM and Idan formats create linework files for the DTM and Idan programs.

Prompts

Polyline file format [Carlson>/DTM/Idan/MicroStation]? press Enter for Carlson format
Specify File to Write dialog create a new file or append to existing
Polyline file for Grid File Utilities macro [Yes/<No>]? press Enter The option will write a polyline file that can be used with Grid File Utilities for inclusion/exclusion perimeters.
Include Z coordinate in polyline file [Yes/<No>]? press Enter This option controls whether the polyline vertices are written in 2D or 3D.
Specify Exclusion/Warning Polylines [Yes/<No>]? press Enter This option applies to machine control for warning areas.
Specify WorkZone Polylines [Yes/<No>]? press Enter This option applies to machine control for working areas.
Reduce Polyline Vertices [<Yes>/No]? press Enter This option applies Reduce Polyline to the polyline vertices before writing the file.
Enter reduce offset cutoff <0.1>: press Enter
Decimal places for coordinates <2>: press Enter
Select polylines, lines and arcs to write.
Select objects: pick the entities to process
Done.

Sample Polyline File:

POLYLINE,15
47639.82,74540.11,0.00
Draw Polyline File

This command draws polylines from the selected polyline file. These polylines are drawn in the current layer. This command supports the following formats: Carlson (.PLN), Idan (.DIS), MicroStation (.TXT), MOSS (.INP, .PRN) and Topcon Pocket 3D (.TXT).

Prompts

Polyline file format [Carlson|DTM|Idan|MicroStation|MOSS|Topcon]? press Enter to accept Carlson
Polyline File to Read Dialog select existing .PLN file

Clipboard

Function

This command allows for different cut, copy, and paste options.

Cut

To cut objects to the Clipboard.

- Select the objects you want to cut.
- From the Clipboard command, choose Cut.

The objects are available to be pasted into other Windows applications.

Copy

To copy objects to the Clipboard.

- Select the objects you want to copy.
• From the Clipboard command, choose Copy.

**Copy with Base Point**

To copy objects to the Clipboard. When the objects are pasted into a drawing, the program places them relative to the specified base point.

- Select the objects you want to copy.
- From the Clipboard command, choose Copy with Base Point.
- Specify the base point.

**Paste**

The objects currently on the Clipboard are pasted into the drawing at the specified insertion point.

- From Clipboard command, choose Paste.

**Paste as Block**

The objects currently on the Clipboard are pasted into the drawing as a block at the specified insertion point.

- From Clipboard command, choose Paste as Block.

**Paste to Original Coordinates**

The objects currently on the Clipboard are pasted into the drawing using the coordinates from the original drawing.

- From Clipboard command, choose Paste to Original Coordinates.

**Drawing Cleanup**

The Drawing Cleanup dialog box allows you to perform many functions that fix common errors, and it removes unnecessary data found in many drawing files. It also converts incompatible data into useful entities. This command offers many filters that audit the drawing file and allows you to select which options and settings you want to use. A report of the cleanup results will be displayed upon completion. Always save your file when the drawing cleanup routine is complete.
Set UCS to World Coordinates
This sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson works exclusively in the world coordinate system and there is no way to change this setting. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, click this on to restore the UCS.

Remove Layers With No Entities
AutoCAD drawings work with a "BYLAYER" concept meaning that layer definitions define the drawing. For example, the layer named EOP might be used to display polylines at the Edge Of Pavement in the drawing. Many times extra layers get defined by a user but not used to display any objects. This function removes any layers defined in the drawing that are not being used.

Remove Unused Blocks, Linetypes and Styles
This function removes this unused information from the drawing.

Remove Zero Length Linework
This function seeks out and removes any linework definition that have zero length. Point nodes are not removed.

Remove Duplicate Linework
This function finds any duplicate linework in the drawing and removes all but one set.

Remove Overlapping Polylines
Polylines that completely overlap themselves are broken into two different polylines.

Join Linework With Same Endpoint
This function finds common endpoints on linework on common layers with common elevations and joins the linework into a continuous polylines. This is very helpful for future selection sets.
Convert Splines, Multilines and Regions Into Polylines
Some CAD applications utilize Spline Object Definitions and Regions, Carlson utilizes basic polyline/polygon definitions. This function finds any Splines and/or Regions defined in the drawing and re-defines them as simple polylines or polygons.

Convert Lines, Arcs, Circles, Ellipses, 3DFaces and Solids Into Polylines
By converting Lines, Arcs, Circles, Ellipses, 3D Faces, and Solids into Polylines, you can use the variety of Polyline commands available in Carlson.

Convert LDD-AEC Contours and Points Into Carlson Format
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re-defines them as simple 2D polylines retaining their elevation values.

Convert Entities With Extrusion To World Coordinates
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re-defines them as simple 2D polylines retaining their elevation values.

Erase Hatch Entities
Carlson offers many hatch display options, however hatch entities have no 3D value. This function removes all hatch entities in the original drawing to help reduce the size and clutter of the drawing file.

Remove Arcs From Polylines - Offset Cutoff
This function replaces arcs in polylines with a series of short chord segments. The purpose is to prepare the polylines for modeling since arcs need to be converted into segments to be part of the triangulation model. The density of chord segments is controlled by the offset cutoff. This cutoff represents how much the polyline can move horizontally. A smaller cutoff will result in more chord segments. The option for 3D Only controls whether only polylines at zero elevation or both zero and elevated polylines get processed. Sometimes you may want to leave the arcs in zero elevation polylines when these polylines represent road alignments and are not part of the surface model.

Reduce Polyline Vertices - Offset Cutoff
This function utilizes a pre determined offset amount and removes unnecessary polyline vertices that fall within the offset amount.
Set Elevations Outside Range to Zero and Elevation Range
This function comes with a "Scan DWG" option that audits the elevation range in the drawing file. Once the minimum and maximum elevation range has been set, manually or by a scan, all objects that fall outside the set range are moved to elevation zero. All objects at zero elevation do not contribute to the 3D model.

Entities To Process...
This allows you to run the command for the entire drawing or for a selected set.

Default
This allows you to return to the Carlson Drawing Cleanup default settings.

Final Report
This example report displays the results of drawing cleanup. Like all reports in Carlson, this report can be saved to a text file, sent directly to your printer, or pasted onto the screen ad text entities.

Pulldown Menu Location: File
Keyboard Command: dwg_cleanup
Prerequisite: None
File Name: \lsp\poly3d.arx

Audit
Function
This command scans your current drawing and looks for any corruption and has the option to fix any errors.

Prerequisite: none
Keyboard Command: audit

Recover

Function

This command opens a drawing file and scans it for errors. Use this command if Carlson TakeOff crashes while using the regular Open command.

Prerequisite: none

Keyboard Command: recover

Remove Reactors

This command removes the reactor links from the selected points, text, polylines and lines. This disables the links for points to the coordinate (.CRD) file, annotation with linework and linework with points. Note that in General Settings there is a section called Object Linking. This is the specific section that contains the options for creating these reactors to the drawing entities. Reactors can be turned off for entities created later by clicking off the four link options in General Settings. To get to this dialog go to Settings > Configure > General Settings.

Prompts

Select entities to remove reactors from:
Select objects: pick the entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: delreact
Prerequisite: Entities with reactors
File Name: \lsp\crdutil.arx

Remove Groups

This command is used to "ungroup" selected entities that, prior to using this command, were part of an AutoCAD group. For our purposes, we might more specifically be referring to Carlson's Point Entity Grouping feature. A group is a named selection set of objects. This routine removes selected entities from groups. It is especially useful when dealing with our Carlson points.

More on Point Entity Grouping: As mentioned in the Points chapter, remember that for each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other AutoCAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD. To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key, and pressing the letter A on the keyboard, activates this two-way toggle, with the current status echoed to the command prompt area.
Prompts

Select entities to remove from groups.
Select objects: select entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: rmgroupe
Prerequisite: Entities in group(s)
File Name: \lsp\poly3d.arx

Purge

Function

Displays a tree view summary of all named objects that can and can't be purged in the current drawing. The View Items You Can Purge and View Items You Cannot Purge options toggle the dialog box display, showing different options and tree view summaries.

Items Not Used in Drawing: Displays a tree view of all named object categories (blocks, layers, and so on) in the current drawing. A plus sign appears next to the object category names that you can purge. Clicking the plus sign or double-clicking an object category expands the tree view, displaying all unused named objects that exist for the category. To purge all unused named objects, select All Items in the tree view, and choose Purge All. To purge a specific named object category, select the category in the tree view, and choose Purge.

Confirm Each Item to Be Purged: Displays the Verify Purge dialog box when you purge an item.
**Purge Nested Items**: Removes all unused named objects from the drawing even if they are contained within or referenced by other unused named objects. The Verify Purge dialog box is displayed, and you can cancel or confirm the items to be purged.

**Prerequisite**: None

**Keyboard Command**: purge
In addition to AutoCAD’s powerful editing commands, the Carlson Edit menu has the additional commands which are explained in this section. Commands that are pure AutoCAD are not detailed here. They can be found in the AutoCAD manual.
Undo

Function
This command allows you to reverse the effect of previously issued commands.

Prerequisite: None

Keyboard Command: U

Redo

Function
This command allows you to reverse the effects of the previous UNDO command.

Prerequisite: None

Keyboard Command: REDO

Erase Select

Function
This command allows you to remove objects from a drawing.

Prerequisite: None

Keyboard Command: ERASE, E

Erase by Layer

This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the Select Layers from Screen button and then select the entities on the layers to be deleted. The Select Layers by Name button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline.
Pulldown Menu Location: Edit > Erase
Keyboard Command: ldel
Prerequisite: Something to erase
File Name: \lsp\dellayr.lsp

Erase by Closed Polyline

This tool is used to clean up drawing geometry at the extents of a polyline boundary. It provides options to erase adjacent geometry as well as trim geometry crossing the fence of the polyline.

First, select the boundary polyline. Only one can be selected. Designate the desired options in the following dialog. The top section of the dialog allows you to toggle which object types should be affected by the operation. Note that some of the objects, such as text and inserts, cannot be trimmed.
In the middle of the dialog is a toggle that determines whether to prompt for objects to process. If you want to isolate the drawings contents to that of the selected polyline, turn this toggle on. Note that all geometry in the drawing is effected, even geometry that is outside of the current viewport. Many users will prefer to turn this toggle off, so that they can be prompted to manipulate the geometry.

The bottom row allows you to choose whether to erase all the entities on the inside or outside of the polyline.

**Pulldown Menu Location:** Edit > Erase  
**Keyboard Command:** erasepline  
**Prerequisite:** Entities and a closed polyline  
**File Name:** \lsp\poly3d.arx

### Erase Outside

This command erases all the entities outside of a user specified window. This can be useful if you somehow place entities way outside your drawing limits and want to easily erase them.

**Prompts**

- **Pick 1st corner of window to erase outside of:** Pick point location  
- **Pick 2nd corner:** Pick second point location  

**Pulldown Menu Location:** Edit > Erase  
**Keyboard Command:** eraseout  
**Prerequisite:** Entities to erase  
**File Name:** \lsp\surv1.lsp

### Move

**Function**

This command allows you to displace objects a specified distance in a specified direction.  
**Prerequisite:** None
Keyboard Command: MOVE, M

**Standard Copy**

**Function**

This command copies all objects you select to the Clipboard. You can paste the contents of the Clipboard into a document or drawing as an OLE object.

You can also use CTRL+C to run this command. If the cursor is in the drawing area, Carlson TakeOff copies the selected objects to the Clipboard. If the cursor is on the command line or in the text window, the program copies the selected text to the Clipboard.

**Prerequisite:** None

**Keyboard Command:** COPY

**Copy To Layer**

This command is used to copy a selected entity or entities and put the copy in a specified layer. Once copied to the chosen layer the entity or entities will take on the characteristics of that layer (color, linetype, etc.).

![Select Layer Dialog](image)

**Prompts**

**Select entities to copy.**

**Select objects:** select entities

**Select Layer dialog** select a layer from list and click OK

**Pulldown Menu Location:** Edit > Copy

**Keyboard Command:** copy2layer

**Prerequisite:** Entities to be copied

**File Name:** \lsp\surv1.lsp
Copy Polyline Section

This command is used to copy a portion of a polyline, at specified points, and put the copied portion onto another layer. The portion of existing polyline that is being copied still remains as part of the original entity (with no break), while the new portion, with its chosen layer designation, is a new polyline.

Prompts

Select polyline to copy: Pick a polyline
Select first break point along polyline: Pick location on the polyline
Select second break point along polyline: Pick the second location on the same polyline
Layer name <CTR>: wall

Pulldown Menu Location: Edit > Copy
Keyboard Command: copy_pl
Prerequisite: Polyline to be copied

Standard Offset

Function

This command creates a new object at a specified distance from an existing object or through a specified point. Offset does not support 3D polylines. Use Offset 3D Polyline to offset these entities.

Prompts

1 Specify offset distance or [Through] <Through>: Press Enter
The Through option allows you to screen pick the location of the offset. You can also enter a value for the interval of the offset.
2 Select object to offset or <exit>: select entity
3 Specify through point: pick point
Menu Location: Edit
Prerequisite: None
Keyboard Command: OFFSET

Variable Offset

This is a command to offset a polyline, with different offset amounts for each polyline segment of the same polyline. The offset distances can be variable, and you choose between a Line or a Point method at the command line.

Prompts

Vary offsets by line segments or at points [<Line>/Point]? press Enter
Select a polyline to offset (Enter for none): pick polyline
Select side to offset: pick a point on the side to offset to
As you go from segment to segment, you can enter in different offset values for each line segment.
Enter the segment horizontal offset <0.000>: 56
Enter the segment horizontal offset <56.000>: 33
Enter the segment horizontal offset <33.000>: 12
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: VOFFSET
Prerequisite: A polyline to offset

Standard Explode

Function

This command allows you to break a compound object into its component objects.

Results differ depending on the type of compound object you're exploding. The following is a list of objects that can be exploded and the results for each.

• **All Explodable Objects**: Produces object geometry that may look the same, but the color, linetype, and lineweight of the object may change.

• **Block**: Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.

When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a "*E" prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded.

Exploding a block that contains attributes deletes the attribute values and redisplay the attribute definitions.

• **2D and Lightweight Polyline**: Discards any associated width or tangent information.

• **Wide Polyline**: Places the resulting lines and arcs along the center of the polyline. TakeOff discards any associated width or tangent information.

• **3D Polyline**: Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.

• **Text Explode to Polylines**: Explodes polylines depending on the font used for various annotations, this can make the resulting polylines more efficient in terms of vertex count.

• **Leaders**: Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), Mtext, or tolerance objects, depending on the leader.

• **Mtext**: Explodes into text entities

• **Multiline**: Explodes into lines and arcs.

• **3D Solid**: Explodes planar surfaces into regions. Nonplanar surfaces explode into bodies.
• **Region**: Explodes into lines, arcs, or splines.
• **Body**: Explodes into a single-surface body (nonplanar surfaces), regions, or curves.
• **Polyface Mesh**: Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.
• **Circle Within a Nonuniformly Scaled Block**: Explodes a circle within a nonuniformly scaled block into ellipses.
• **Arc Within a Nonuniformly Scaled Block**: Explodes an arc within a nonuniformly scaled block into elliptical arcs.

**Prerequisite**: None

**Keyboard Command**: EXPLODE, X

### Block Explode

This command retains the values of attributes when a block is exploded. The standard AutoCAD *Explode* command changes the attribute values back to the attribute type. For example, using *Explode*, a Carlson point block would become PNTNO, PNTELEV, PNTDESC. *Block Explode* would keep the point attribute values, such as 10, 1000.0, EP. The layer names of the exploded block attributes can be either the insert layer of the parent block or the original attribute layers from the block definition.

**Pulldown Menu Location**: Edit
**Keyboard Command**: explode2
**Prerequisite**: A block to be exploded
**File Name**: \lsp\blkattex.lsp

### Trim

**Function**

This command allows you to trim objects at a cutting edge defined by other objects.

**Prompts**

1. Select cutting edges ...
   
   Select objects: **pick entity**

2. Select object to trim or shift-select to extend or [Project/Edge/Undo]: **select entity to be trimmed**
   
   • **Project**: You can project the object to be trimmed in order to trim objects that do not intersect.
   
   • **Edge**: You can project the trimming edge in order to trim objects that do not intersect.
   
   • **Undo**: This option allows you to undo the above projections.

**Prerequisite**: None

**Keyboard Command**: TRIM, TR
Extend To Edge

Function

This command allows you to extend an object to meet another object.

Prompts

1 Select boundary edges ...
Select objects: **pick entity**
2 Select object to extend or shift-select to trim or [Project/Edge/Undo]: **pick entity**
You have the option of trimming or projecting objects and edges.

**Prerequisite:** None
**Keyboard Command:** EXTEND

Extend to Intersection

This command extends the end points of two lines and/or polylines, at the same time, to their intersection point.

Prompts

**Select first line or polyline to extend:** *pick a line or polyline*
**Select second line or polyline to extend:** *pick another line or polyline*

Before Extend to Intersection

After Extend to Intersection

**Pulldown Menu Location:** Edit > Extend
**Keyboard Command:** extint
**Prerequisite:** Two lines or polylines
**File Name:** \lsp\poly3d.arx
Extend Arc

This command extends an arc entity.

Prompts

**Pick arc to extend:** select an arc entity

**Break Arc at Extension [Yes/<No>]?**  
N  Answering Yes will create a new arc starting at the end of the existing arc.

**Enter or pick the distance to extend:** 5 This extends the arc 5 units

**Enter or pick the distance to extend ('U' to Undo):** press Enter to end

Pulldown Menu Location: Edit > Extend

Keyboard Command: extarc

Prerequisite: An arc

File Name: \lsp\scadutil.arx

Extend by Distance

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.

The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

**# - Number:** Distance to draw or extend

**A# - Angle change:** Rotates pointer by specified number of degrees

**A - Align:** Rotates pointer to align with segment

**B - Bearing:** Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)

**C - Close:** Closes the polyline
**D - Draw Mode:** Actions draw or extend the line or polyline
**E - Extend to Edge:** Extends to intersection with a selected line or polyline
**I - Input mode:** Toggles distance input between decimal feet and feet-inches
**L - Left rotate:** Rotates counterclockwise 90 degrees
**M - Move Mode:** Actions only move the pointer
**N - Next:** Moves pointer forward to next point
**O - Open:** Opens the polyline
**P - Previous:** Moves pointer backward to previous point
**R - Right rotate:** Rotates clockwise 90 degrees
**S - Switch:** Reverses pointer direction
**T# - Total distance:** Sets current segment to specified distance
**U - Undo:** Undo the last Extend by Distance command
**Z - Zoom mode:** Toggles auto-zoom between on/off

**? - Info:** Displays lengths of current polyline

**H - Help:** The Help option also displays this Extend by Distance Commands list.

Press **<Enter>:** Ends the routine

### Prompts

**Select line or polyline to extend:** *select line or polyline near the place to extend*

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** 50 The line is extended by 50 units. Use the Pick option to pick a distance.

**Pick/Horizontal Distance to Extend ([Enter] for new line):** *R* Rotate right 90 degrees.

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** 50 The line is extended by 50 units. Use the Pick option to pick a distance.

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** press *Enter*

**Extend another (<Yes>/No)? No**

Note: R50 and L10 can be used to go right 50, left 10, etc.
The result of using the Help (H) option

**Pulldown Menu Location:** Edit > Extend

**Keyboard Command:** extender

**Prerequisite:** An existing line or polyline with at least one segment from which to start.

**File Name:** \lsp\scadutil.arx

---

**Break by Crossing Polyline**

This tool is used to break drawing geometry at the edge of a polyline boundary. It provides options to change the layers of the interior and exterior geometry after it is broken.

First, select the boundary polyline. Only one can be selected. Then select the polylines and lines to be clipped. You will be prompted for options on specifying the layers for the newly broken geometry. Respond with a "Y" if you want to specify a new layer, then enter the new layer name. If the layer name does not exist, it will be created.

**Prompts**

**Select the clip edge polyline:** pick a closed polyline

Select the polylines and lines to be clipped.

**Select Objects:** pick the entities to break

Specify layer names for Inside segments (Yes/No)? Yes

Enter a layer name for the Inside segments <0>: press Enter

Specify layer names for Outside segments (Yes/No)? Yes

Enter a layer name for the Outside segments <0>: Final
Pulldown Menu Location: Edit > Break
Keyboard Command: clipline
Prerequisite: A closed polyline
File Name: \lsp\poly3d.arx

Break Polyline at Specified Distances

This command allows you to pick a polyline and break it at a specified distances along the polyline. Following the prompts below, the beginning of the polyline in the illustration was broken into three 55-foot segments.

Prompts

Select polyline to break: select polyline
Total Distance: 779.429 This is the length of the polyline reported.
Distance Along Polyline For Break: 55.0
Distance Along Polyline For Break (Enter to end): 110
Distance Along Polyline For Break (Enter to end): 165
Distance Along Polyline For Break (Enter to end): press Enter
3 polyline breaks created.
Break at Intersection

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the *Area by Lines & Arcs* command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

**Prompts**

*Select Line, Arc, or Polyline to Break*

**Select object:** select object to break

**[int on] Pick Intersection to break at:** pick intersection point

**Pulldown Menu Location:** Edit > Break

**Keyboard Command:** breakat

**File Name:** \lsp\svr1.lsp

Break, Select Object, 2nd Point

>  

**Function**

This command allows you to break an object by selecting the object, then the second break point. The first break point is the point where you select the object.

**Prompts**

1. Select object: selectentity to break
2. Specify second break point or[First point]: select second break point

Break, Select Object, Two Points

**Function**

This command allows you to break an object by selecting the object, then two points. First select the object, then the program will prompt you to select two points that define where the object will be broken.

**Prompts**

1. Select object: selectentity to break
2. Specify second break point or[First point]: First
3. Specify first break point: pick first point
4. Specify second break point: pick second point

Break, At Selected Point

**Function**
This command allows you to break an object by selecting the object. Only one pick is necessary since TakeOff both selects the object and treats the selection point as the break point.

**Prompts**

1 Select object: select entity to break

Select an object to break

**Prerequisite:** None

**Keyboard Command:** BREAK

**Change Properties**

**Function**

This command allows you to change certain properties of existing objects.

![Change Properties dialog box](image)

1 In the Change Properties dialog box, you must choose the properties to modify.

- **Color:** This option allows you to change the color of the object.
- **Layer:** This option allows you to change the layer of the object.
- **Linetype:** This option allows you to change the linetype of the object.
- **Linetype Scale:** This option specifies the linetype scale factor for the new linetype.
- **Thickness:** This option specifies the distance to extrude the object above or below its elevation.

Note: The Properties command allows you to modify entity specific properties such as the radius of a circle or the height of a text entity.

**Prerequisite:** None

**Keyboard Command:** DDCHPROP

**Change Elevations**

This command will change the elevation of selected entities. It can move the entity to a specified elevation from it's current elevation (absolute) or do a differential change by adding or subtracting a value from it's current elevation. If Carlson points are selected, their attribute text and z axis coordinate are changed.
Prompts

Ignore zero elevations (<Yes>/No)? press Enter If you answer No, then entities with elevation 0 will be changed. [A]bsolute or [D]ifferential Change <A>: A
Elevation to change to: 125 By using the Absolute option all entities selected are changed to the elevation 125.
Select Entities for elevation change.
Select objects: C
First corner: pick a point
Other corner: pick a point
Select objects: press Enter

If Carlson points are selected, the command warns:
This command DOES NOT change the elevations in the Coordinate file!
Use Coordinate File Utilities menu option F to update the file.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgelev
Prerequisite: Something to change
File Name: \lsp\scadutil.arx

Change Attribute Style

This command will globally change the text style of attributes on the drawing. This can be very useful if all the label styles (such as the point symbol attribute labels) on a drawing must be changed to accommodate a different plotting specification. The default STYLE used for the point symbol attributes is PTXT.

Under Existing Style, select the style that is currently applied to the attributes you want to change. If you are unsure of the existing text style, select the Pick Attr button, then pick an existing attribute on the screen. When the dialog returns, the text style applied to that attribute will be selected in the list.

Select the New Style that you want to apply to the attributes.

Enter a New Height for the attributes. An entry of zero (0) will not modify the existing height.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgattr
Prerequisite: You may want to use the LIST command to check the current Text size.

File Name: \lsp\chgattr.lsp

Change Style

This command will globally change the style and height of text on the drawing. This can be very useful if all the text sizes on a drawing must be changed to accommodate a different plotting scale.

Under Existing Style, select the style that is currently applied to the text you want to change. If you are unsure of the existing text style, select the Pick TEXT button, then pick an existing text entity on the screen. When the dialog returns, the text style applied to that text entity will be selected in the list.

Select the New Style that you want to apply to the text.

Enter a New Height for the text. An entry of zero (0) will not modify the existing height.

Pulldown Menu Location: Edit > Change

Keyboard Command: chgstyl

Prerequisite: Text entities

File Name: \lsp\chgstyl.lsp

Change Block/Inserts Rotate

This is a command to set the angle of blocks by various methods. This command optionally can change the rotation of a block by twist screen angle, azimuth, entity segment or by follow polyline. It will work with Carlson point symbol blocks, or any AutoCAD block. For example, you may receive an AutoCAD drawing from another firm, insert it in, and then want to change the rotation.

Prompts

Twist by [Twist screen>/Azimuth/Entity segment/Follow polyline]? press Enter
Enter angle relative to current twist screen <0.0>: 30
Select Symbols to Rotate. pick symbol
Select objects: 1 found

**Pulldown Menu Location:** Edit > Change > Block/Inserts  
**Keyboard Command:** TWISTSYM  
**Prerequisite:** None

## Change Block/Inserts Substitute

This command is used to replace selected block(s) with a different block. The command optionally can change the size and rotation angle. This command will work with Carlson point symbol blocks, or any AutoCAD block. For example, you may receive an AutoCAD drawing from another firm and want to replace certain inserts with inserts of your own specification. In the dialog shown, we are replacing the block named NASTAR with a block named COHNORTH, which will be inserted at 50 scale and zero rotation.

![Change Block/Inserts Substitute dialog](image)

**Existing Block:** Select the block name to be replaced. If the block name is unknown, choose the Select from Screen button, then select the block from the current drawing.  
**Replace With:** Select the block that will replace the existing block. You may choose from the list of defined blocks, select an existing block from the current drawing, choose a point symbol from the standard Carlson point library, or select an AutoCAD drawing file.  
**Retain Size and Rotation:** When checked, the new block will retain the size and rotation values from the old block.  
**New Size:** Available if Retain Size and Rotation is not checked. Enter the size for the new block.  
**New Rotation Angle:** Available if Retain Size and Rotation is not checked. Enter the rotation angle for the new block.

**Pulldown Menu Location:** Edit > Change > Block/Inserts  
**Keyboard Command:** chgblk  
**Prerequisite:** None  
**File Name:** `\sp\chgblk.lsp`
Change Block/Inserts Resize

This command resizes blocks inserts while maintaining their insertion position. When prompted to select objects, choose the inserts to resize. Note that this routine does not rescale attributes that may be associated with the selected inserts.

Prompts

**Scaling Multiplier <0.5>:** Enter the size scale factor.

**Select symbols and blocks to scale.**

**Select objects:** select entities

**Pulldown Menu Location:** Edit > Change > Block/Inserts

**Keyboard Command:** sizeblk

**Prerequisite:** block/inserts in drawing

**File Name:** \lsp\sizeblk.lsp

Pivot Point Rotate by Bearing

This command allows you to rotate the selected entities from the drawing. The rotation angle is defined by the difference between a reference line and an entered bearing or azimuth. The reference line is defined by two points that can be picked on the screen or entered by point number.

Prompts

**Select entities to rotate.**

**Select objects:** select the entities

**Base pivot point ?**

**Pick point or point number:** 2 The program then reads the coordinate value for pt#2 from the current CRD file.

**Reference Bearing point ?**

**Pick point or point number:** pick a point

**Reference Bearing N 44d31'1'' E** The program then displays the reference bearing defined by the two points selected.

**Azimuth/<Bearing (Qdd.mmss)>**: 245.3030 Enter an A to input an Azimuth or enter the bearing. The above response is a bearing of South 45 degrees, 30 minutes, and 30 seconds East. The program then rotates the database to the new bearing.

If Carlson Points are selected the program warns:

**This command DOES NOT change the coordinates in the CooRDinate file!**

Use CooRDinate File Utilities menu, Update CRD from Drawing.

This warning applies if the points entities are not linked to the CRD file. This link option is set in the Configure command.

**Pulldown Menu Location:** Edit > Rotate

**Keyboard Command:** brot

**Prerequisite:** None

**File Name:** \lsp\scrot.lsp

Chapter 5. Edit Menu 210
Rotate by Pick

Function

This command allows you to move objects about a base point using a point as a rotation reference.

Prompts

1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify rotation angle or [Reference]: rotate to desired location

Prerequisite: None

Keyboard Command: ROTATE

Entity Insertion Point Rotate

This command allows you to rotate the selected entities from the drawing where they will follow one of the following alignments: Twist screen, Azimuth, Entity Segment, Follow or Pick.

Prompts

Rotate by [<Twist screen>/Azimuth/Entity segment/Follow/Pick]? F
Select polyline to follow: pick a polyline
Select Entities to Rotate.
Select objects: pick entities to rotate
Flip text for twist screen [Yes/<No>]? Y
Rotating ....

Pulldown Menu Location: Edit > Rotate

Keyboard Command: ss_twist

Prerequisite: None

File Name: \lsp\scrot.lsp

2D Scale

This command will scale the selected entities using specified scale factor and base point. This 2D Scale function is the same as the AutoCAD Scale function except that this 2D Scale function only scales the entities in the x,y coordinates and does not change the elevations of the entities. One application of this routine is to convert a drawing from architectural to decimal units when the architectural units have the drawing x,y coordinates in inches and the elevations in feet. In this case, 2D Scale can be used to apply a 1/12 scale factor (0.08333333) to convert the inches to feet for the x,y coordinates and leave the elevations unchanged.

Prompts

Select entities to scale.
Select objects: pick entities to process
Specify base point: 0,0
Specify scale factor: 0.0833333333

Pulldown Menu Location: Edit > Scale
Keyboard Command: sscsacle
Prerequisite: None
File Name: \lsp\surv1.lsp

Scale

Function

This command allows you to enlarge or reduce selected objects equally in the X, Y, and Z directions.

Prompts

1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify scale factor or [Reference]: scale to desired size

Prerequisite: None
Keyboard Command: SC

Edit Text

Function

This command allows you to edit text and attribute labels.

1 Select Text to Edit: select the text

You can modify text in provided text field.

Prerequisite: Text
Keyboard Command: EDITXT

Text Enlarge/Reduce

This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtenl
File Name: \lsp\surv1.lsp
**Rotate Text**

This command sets the rotation of the selected text to the current twist screen, an entered azimuth, or to align with a line or polyline. The text keeps the same insertion point and justification. The Twist Screen option sets the text rotation to align horizontal with the current twist screen. With the Azimuth option you can enter the angle or pick two points to define the text rotation. The Entity segment aligns the text with a selected line or polyline segment. The Follow option aligns the text with the closest polyline segment.

**Prompts**

Rotate by (<Twist Screen>/Azimuth/Entity segment/Follow/Pick)? press Enter
Enter angle relative to current twist screen <0.0>: 23
Select Text to rotate.
Select objects: select the text

**Pulldown Menu Location:** Edit > Text
**Keyboard Command:** twisttxt
**Prerequisite:** Text
**File Name:** \lsp\twisttxt.lsp

**Change Text Font**

This command can change multiple text entities to a user specified style. The routine prompts for a selection set of TEXT and/or MTEXT objects. Once the selection is made, the Select Style dialog appears. You can then select a text Style Name, such as MONO or ROMANS, that you would like to change to. Click OK. To the right on Style Name, you can enter a style name that does not exist. If you do, it will be created for you using the font with the same name.

![Select Style Dialog](image)

**Pulldown Menu Location:** Edit > Text
**Keyboard Command:** chgtxtstyle
**Prerequisite:** Text entities to be changed
**File Name:** \lsp\chgtxtst.lsp
Change Text Size

This command will change the size of the selected text objects to the user specified size. The Text Enlarge/Reduce command also changes text size. The difference is that this routine sets the text to an absolute size whereas Text Enlarge/Reduce scales, or relatively changes, the text size.

Prompts

Select the text to size.
Select objects: select the text
Enter new text size: enter value

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtsize
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp

Change Text Width

This command changes the width of the selected text entities, after a new width factor is entered. The insertion point of each text entity is maintained as the routine lengthens or shortens the text.

Effect of different width factors on the same text line

Iron Pin

Iron Pin

Iron Pin

Iron Pin

Text width = 1

Text width = 0.75

Text width = 1.5

Prompts

Select the text to change.
Select objects: select text entities
Enter new width factor <1.0>: enter new width factor

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtwidth
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp
Change Text Oblique Angle

This command allows you to change the text oblique angle on existing text in the drawing. The oblique angle for a specific text style is defined during the creation of the style. The default value for the oblique angle for text styles is 0 until defined to another value by the user. When changing the oblique angle, a minus (-) sign in front of the angle indicates a backward slant and a positive value results in a forward slant. Remember that the reference base point for the oblique change is always 0 degree. This means that if an existing text string has an oblique angle of 20, changing the oblique angle to 25 will not add 25 degrees to the existing 20 degree oblique resulting in a text oblique angle of 45 degrees, but rather a 25 degree oblique will be established by referencing 0 oblique as the base, and then slanting the text to 25 degrees. This works the same for slanting text backward as well as forward. Below is an example showing original text created with the default oblique angle of zero, then changed to a backward slant of 20 and a forward slant of 25 degrees.

**Prompts**

Select the text to change.
Select objects: *Select text to change oblique angle on*. Note that one or more text strings can be selected. When all desired text has been selected, press Enter.
**Enter new oblique angle <0.0>:** Enter the desired oblique angle.

<table>
<thead>
<tr>
<th>Oblique Angle</th>
<th>Text String</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Iron Pin</td>
</tr>
<tr>
<td>-20</td>
<td>Iron Pin</td>
</tr>
<tr>
<td>25</td>
<td>Iron Pin</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Edit > Text
**Prerequisite:** Text entities to be changed
**Keyboard Command:** chgtxtoblique
**File Name:** \lsp\surv1.lsp

Flip Text

This command will change the alignment of text entities by 180 degrees.

**Pulldown Menu Location:** Edit > Text
**Keyboard Command:** fliptext
**Prerequisite:** Text entities to be changed
**File Name:** \lsp\surv1.lsp

Split Text into Two Lines

This tool allows you to break a single line of TEXT into two separate lines. First, select the text string you would like to break. The Text Break dialog then appears. Initially, the slider is all the way to the right. Begin dragging it
toward the left until it reaches the point where the split is at the desired position. Then choose OK to complete the break operation.

![Text Break dialog box](image)

**Pulldown Menu Location:** Edit > Text  
**Keyboard Command:** txtbrk  
**Prerequisite:** Text entity to break  
**File Name:** \lsp\txtbrk.lsp

### Text Explode To Polylines

This command converts the selected text into polylines. This function is generally used when preparing a plan view file for machine control, before using the *Write Polyline File* command.

**Prompts**

- **Select text to be EXPLODED.**
- **Select objects:** *select the text*
- **Substitute With Simple Font [<Yes>/No]?** *Y*
- 1 text object(s) have been exploded to lines.  
  The line objects have been placed on layer 0.  
  Reading the selection set ...  
  Joining ...  
  Converting ...

**Pulldown Menu Location:** Edit > Text  
**Keyboard Command:** textexp  
**Prerequisite:** Text  
**File Names:** \lsp\textexp.lsp, \lsp\poly3d.arx

### Replace Text

This command will replace one text string with another. For example, if the text LEGEL is on a drawing, you could use this command to replace it with LEGAL. In AutoCAD 2000 and later, the command *Find and Replace Text* includes more options, including replacing partial strings and searching attributes and MTEXT.

**Pulldown Menu Location:** Edit > Text  
**Keyboard Command:** chgtext
2D Align

This command will align (translate, rotate and scale) the selected objects using two pairs of source and destination control points. The difference between the first source point and first destination point determines the translation amount. The difference between the angle and distance from the first and second source points compared to the angle and distance from the first and second destination points determines the rotation and scale. The scale part of the alignment is optional. This 2D Align function is the same as the AutoCAD Align function except that this 2D Align function does not use elevations so that the alignment is always in 2D. The control points can be screen picked or entered by point numbers.

Prompts

Select entities to align.
Select objects: pick entities to process
First Source Point?
Pick point or point number: pick point 84
First Destination Point?
Pick point or point number: pick point 18
Second Source Point?
Pick point or point number: pick point 85
Second Destination Point?
Pick point or point number: pick point 19
Scale factor: 1.00434258
Scale objects based on alignment points [Yes/No]? Y
This command DOES NOT change the coordinates in the CooRDinate file!
Use Coordinate File Utilities menu, Update CRD File from Drawing.

Pulldown Menu Location: Edit > Align
Keyboard Command: scalign
Prerequisite: None
File Name: \lsp\scalign.lsp

**Standard Align**

**Function**

Aligns objects with other objects in 2D and 3D

You use ALIGN to move, rotate, or scale objects into alignment with other objects. Add source points to the objects you want to align, and add destination points to the objects to which you want the source objects to align. You can add up to three pairs of source and destination points to align an object.

The first set of source and destination points defines the base point for the alignment. The second set of points defines the angle of rotation.

When you select three point pairs, you can move and rotate the selected objects in 3D to align with other objects.

If you use two source and destination points to perform a 3D alignment on nonperpendicular working planes, you get unpredictable results.

After you enter the points, Takeoff prompts you to scale the object. The program uses the distance between the first and second destination points as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.

**Prompts**

1 Specify first source point: pick point
2 Specify first desitination point: pick point
3 Specify second source point: pick point
4 Specify second desitination point: pick point
5 Specify third source point or <continue>: Press Enter
6 Scale objects based on alignment points? [Yes/No] <N>: Press Enter

Prerequisite: None
Keyboard Command: ALIGN

**Fillet**

**Function**

This command allows you to round and fillet the edges of objects. You can enter a radius for rounding (default radius is 0). You can also trim an object that extends beyond the intersection.

![Before and after FILLET](image)

FILLET rounds or fillets the edges of two arcs, circles, elliptical arcs, lines, polylines, rays, splines, or xlines with an arc of a specified radius. FILLET trims the intersecting lines to the endpoints of the fillet arc. If the selected lines do not intersect, Carlson Survey extends or trims them so that they do. FILLET also rounds or fillets the edges of 3D solids.

If both objects you want to fillet are on the same layer, the program creates the fillet line on that layer. Otherwise, the program creates the fillet line on the current layer. The same is true for the fillet color, lineweight, and linetype.

You can fillet line segments of a polyline that are adjacent, nonadjacent, intersecting, or separated by one segment. If they are nonadjacent, the polyline segments are extended to accommodate the fillet. If they are intersecting, the polyline segments are trimmed to accommodate the fillet. To create a fillet, the polyline segments must converge within the drawing limits when limits checking is on.

The result is a single polyline that includes the fillet as an arc segment. All the properties of this new polyline, such as its layer, color, and linetype, are inherited from the first polyline selected.

Filleting an associative hatch whose boundary is defined by lines removes hatch associativity. Carlson Survey maintains associativity when the boundary is a polyline.

**Prompts**

1 Select first object or [Polyline/Radius/Trim]: select entity
2 Select second object: select entity

**Menu Location**: Edit

**Prerequisite**: None

**Keyboard Command**: FILLET

**Mirror**

**Function**

This command allows you to create a mirror image copy of objects. The two specified points become the endpoints of a line about which the selected objects are reflected. In 3D, this line orients a mirroring plane perpendicular to the XY plane of the user coordinate system (UCS) containing the mirror line.
Prompts
1 Select Objects: select objects to be mirrored
2 Specify first point of mirror line: pick point
3 Specify second point of mirror line: pick point
4 Delete source objects? [Yes/No] <No>: Press Enter

Menu Location: Edit
Prerequisite: None
Keyboard Command: MIRROR

Properties Manager

Function
Carlson Survey displays the Properties window. The Properties window is the main method for viewing and modifying properties of AutoCAD objects.

There are some general properties common to all objects. These include Color, Layer, Linetype, Linetype Scale, Plot Style, Plot Style Table, Lineweight, and Thickness. All other object properties are specific to the type of entity. In the example below, a line has been selected. In addition to the properties mentioned above, you may modify the X, Y, and Z coordinate for each endpoint. Notice that you may not directly modify the delta, length or angle. These are read-only properties. Obviously, modifying either end point will cause these values to change.

The Properties window can be docked in the drawing area. Right-click the Properties window and choose Allow Docking or Hide to undock or hide it.

You can enter commands and work in Carlson Survey while the Properties window is open.
When you select an object in the drawing area, the Properties window displays the properties of that object. If you select multiple objects, the Properties window displays all the properties they have in common.

Object properties are displayed either alphabetically or by category, depending on the tab you choose. To modify properties using the Properties window select the object whose properties you want to change and use one of the following methods:

- Enter a new value
- Select a value from a list
- Change the property value in a dialog box
- Use the Pick Point button to change a coordinate value

The Select Objects button in the Properties window provides access to the full complement of selection methods, such as Fence and Crossing Polygon, from the Command prompt. You choose Select Objects, select the desired objects using any selection method, and press ENTER. The properties common to the selected objects are displayed in the Properties window. You can then modify the properties of the selected objects in the Properties window or you can make other changes to the selected objects by entering an editing command.

In the next example, 3 circles have been selected. Each circle has a different radius, color and linetype. Notice that these three fields do not show a default value. Remember, when multiple objects are selected, only their common properties are shown.

This last illustration shows how the properties window can be docked inside the main application window.
Menu Location: None
Prerequisite: None
Keyboard Command: Properties

**Entities to Polylines**

This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids into individual polylines. Use *Join Nearest* to convert adjoining lines and arcs into continuous polylines.

**Prompts**

Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert.
Select objects: *select entities*

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: topline
Prerequisite: lines, arcs or other entities to convert
File Name: \lsp\poly3d.arx

**Reverse Polyline**

This command reverses the order of the line and/or arc segments of a POLYLINE. This can be useful in conjunction with the commands *Station Polyline, MXS by Polyline, Profile from Surface Model* or *CL File from Polyline*, since
the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in one direction do so and then use the Reverse Polyline command to change it's order. Temporary arrows along the polyline are drawn to graphically show the new polyline direction.

**Prompts**

Select the Polyline to Reverse: *pick a point on polyline*

Pulldown Menu Location: Edit > Polyline Utilities

Keyboard Command: revpline

Prerequisite: A polyline

File Names: `\lsp\revpline.lsp`, `\lsp\poly3d.arx`

**Reduce Polyline Vertices**

This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a polyline with three points in a straight line, the middle point can be removed without changing the polyline. This command is explained further in the Triangulate & Contour command.

**Prompts**

Enter the offset cutoff <0.1>: .5

Select polylines to reduce.

Select objects: *pick polylines*

Processed polylines: 1

Total number of vertices: 10

Number of vertices removed: 1

Pulldown Menu Location: Edit > Polyline Utilities

Keyboard Command: reduce

Prerequisite: A polyline

File Name: `\lsp\tri4.arx`

**Densify Polyline Vertices**

This command adds vertices to the selected polylines at the specified interval. These points are interpolated between existing points in the polyline. This command is the opposite of Reduce Polyline Vertices.
Prompts

Select polylines to densify.
Select objects: select polylines
Point interval <10.0>: press Enter
Testing Entity > 1
Added 17 points to 1 polyline.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: densepl
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Smooth Polyline

This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. The looping factor controls smoothing amount. A higher factor gives more looping. This command is explained further in the Surface menu section.

Prompts

Enter the looping factor (1-10) <5>: 7
Enter the offset cutoff <0.05>: press Enter This is the same reducing filter described above.
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: smoothpl
Prerequisite: A polyline
File Name: \lsp\tri4.arx

Draw Polyline Blips

This command will draw temporary markers, "blips", at each polyline vertex. This allows you to identify the actual location of each vertex. The Blips are temporary. Any change to the viewport (pan, zoom, regen) will make the blips disappear. In later versions of AutoCAD, you can also click on the polyline to activate the grips which will remain visible during and after viewport changes.
Prompts

Select polylines to draw blips.
Select objects: select polyline(s)

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plblip
Prerequisite: A polyline
File Name: lsp\poly3d.arx

Add Intersection Points

This command adds points into lines or polylines where there are intersections. This can be useful for other commands such as Auto-Annotate. For example in the drawing shown, Add Intersection Points adds points to the boundary polyline where the lot lines intersect. Then Auto Annotate for the boundary polyline will label the boundary distance along each lot. This routine does not add intersection points on arcs.

Prompts

Select lines and polylines to check.
Select objects: pick lines or polylines
Reading the selection set ...
Adding intersection points ...
Added 3 intersection points.
Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

Prompts

Select polyline to add to: pick a polyline
Pick or enter point to add: pick a point
Select polyline to add to: press Enter to end

Edit Polyline Vertex

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of
the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following
dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows
you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also
determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the
values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal
distances, the coordinates will change.

![Edit Polyline Vertex dialog](image)

**Prompts**

**Select polyline to edit:** *pick a polyline*

**Pick point on polyline to edit:** *pick a point to be modified*

**Edit Polyline Vertex dialog** *click “Pick Position”*

**Pick vertex position:** *pick a new location for the vertex*

**Edit Polyline Vertex dialog** *click OK*

Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and
coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.

**Select polyline to edit (Enter to end):** *press Enter to end*

**Pulldown Menu Location:** Edit > Polyline Utilities

**Keyboard Command:** editpl

**Prerequisite:** A polyline

**File Name:** \sp\poly3d.arx


**Edit Polyline Section**

This command revises a segment of a polyline. Begin by picking a point on the polyline where you want to start editing. Then pick new points for the polyline. When finished picking new points press Enter, and then pick a point on the polyline to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

**Prompts**

- **Select polyline to edit:** *pick the polyline at the place to start editing*
- **Pick intermediate point (Enter to End):** *pick a point*
- **Pick intermediate point ('U' to Undo, Enter to End):** *pick a point*
- **Pick intermediate point ('U' to Undo, Enter to End):** *press Enter*
- **Pick reconnection point on polyline:** *pick the polyline at the place to join*

**Remove Duplicate Polylines**

This command analyzes the selected polylines and erases any duplicate polylines found. They must be exactly the same for one to be deleted.

**Prompts**

---

*Chapter 5. Edit Menu*
Select lines, arcs and polylines to process.
Select objects: select linework to process
Reading the selection set ...
Removed 1 duplicate linework entities.

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmduplwork
Prerequisite: Polylines that have duplicates
File Name: poly3d.arx

Remove Polyline Arcs
This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

Prompts

Select polylines to remove arcs from.
Select objects: pick polylines
Offset cutoff <0.5>: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs
File Name: \lsp\poly3d.arx

Remove Polyline Segment
This command removes the user specified segment from a polyline. A polyline segment is the section between two vertices of the polyline. There are two options for removing the segment. Either the two vertices of the removed segments are averaged together to keep polyline continuous, or the segment is left missing in the polyline, which creates two separate polylines. The keywords Continuous and Break respectively identify these two options. The first image is of the Original Polyline. The second is with the Continuous Removal option. The third is using the Break Removal option.
Prompts

Break polyline at removal or keep continuous (Break/<Continuous>)? press Enter
Select polyline segment to remove: pick point on polyline
Select polyline segment to remove: press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: removepl
Prerequisite: A polyline
File Names: \lsp\removepl.lsp, \lsp\poly3d.arx

Remove Polyline Vertex

This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete, press Enter when you are done.

Prompts

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Create Polyline ID Labels

This command labels the selected polylines with either the AutoCAD "Handle", which can be seen with a list, or with unique text numbers, such as 1, 2, 3, 4, etc.. When using the Text option, the following window appears to choose the text settings.

Prompts

Select Polylines to label.
Select objects: pick polyline
Label polylines by Text or Handles [Handles/<Text>]? press Enter
**Change Polyline Width**

This command sets the width of the selected polylines. In later versions of AutoCAD, the command *EDIT* can also modify the width of multiple polylines.

**Prompts**

- **New width** <1.0>: 2
- **Select Polylines/Contours to change width of:**
  Select objects: *pick polylines*

**Pulldown Menu Location:** Edit > Polyline Utilities > Edit Polyline
**Keyboard Command:** cwidth
**Prerequisite:** A polyline
**File Name:** \lsp\surv1.lsp

**Set Polyline Origin**

This command sets the starting vertex of a closed polyline. Simply pick the polyline and then pick near the point to set as the starting point.

**Prompts**

- **Select Polyline:** *pick a polyline*
- **Pick Near New Origin Point:** *pick a point on the polyline to be the starting point*
- **Processing ...**
  Select Polyline: *press Enter*

**Pulldown Menu Location:** Edit > Polyline Utilities > Edit Polyline
**Keyboard Command:** plchgorg
**Prerequisite:** A closed polyline
**File Name:** \lsp\plchgorg.lsp

**Remove Polyline Arcs**

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as *Break by Closed Polyline* and *Make 3D Grid File*. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

**Prompts**

- **Select polylines to remove arcs from.**
- **Select objects:** *pick polylines*
- **Offset cutoff <0.5>:** *press Enter*
Change Polyline Elevation

Polyline Elevation/Assign:
- Contour
- Elevations
- Single
- Group

Check Elevation Range

This command analyzes a selection set of polylines, and highlights the ones that fall outside of a specified elevation range. There is an option to set the polylines that are outside of the range to zero. Every polyline vertex that is outside of the range will be highlighted with an X.

Prompts

Enter elevation range minimum: 0
Enter elevation range maximum: 4900
Select polylines to check.
Select objects: pick polylines to process
Found 1 polylines outside of elevation range.
Set polylines outside elevation range to zero elevation [Yes/<No>]? N

Chapter 5. Edit Menu
Highlight Crossing Plines

This command highlights selected polylines that are crossing in the drawing and have different elevations at the crossing. Every intersection point where the polylines cross are marked with a temporary X. A report is provided at the end where the X and Y of the intersection points are displayed with the two Z values and the Z difference. The command has the ability to repair crossing polylines by inserting a vertex in each polyline at the intersection and assigning a common elevation at this intersection.

Prompts
Select polylines to check.
Select objects: pick polylines to process
Ignore zero elevations [Yes/No]? press Enter for Yes to filter out polylines at zero elevation
Reading points ... 1677
Finding points on breaklines ...
19 crossing polylines are highlighted.
Use Report Formatter [Yes/No]? press Enter for No. Use the Report Formatter to customize the report layout or export to Excel.
Minimum delta Z to report <0.0>: 2
Add polyline vertices at intersections [Yes/No]? Y
Set 3D polyline to crossing contour elev or average elevs [Set/Average]? press Enter for Average. The Set option applies to crossing polylines where one polyline is a 3D polyline with varying elevations and the other polyline is a contour polyline with a fixed elevation. For this case, the Set method will hold the elevation of the contour polyline and set the 3D polyline elevation to match the contour. The Average method sets the elevation of the intersection point as the average of the crossing polyline elevations at that point.
Maximum delta Z to average <1.0>: press Enter. This option will only add the intersection point with the averaged elevation if the elevation difference is less than this tolerance.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: xing_plines
Prerequisite: Polylines with elevations

Offset 3D Polyline

This command allows you to offset a 3D polyline entity in both the horizontal and vertical directions. There are three offset methods. The Interval method applies one horizontal and one vertical offset to all the vertices of the polyline. The Constant method has a horizontal offset and sets the elevation of the polyline to one constant elevation. The Variable method allows you to specify each horizontal and vertical offset individually either by polyline segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

Prompts

Enter the offset method [Interval/Constant/Variable]: press Enter
Vertical/Horizontal offset amount: 15
Percent/Ratio/Vertical offset amount <0>: 10
Select a polyline to offset (Enter for none): select a 3D poly
Select side to offset: pick a point
Select a point on the graphics screen that is in the direction of the side of line to offset.
Select a polyline to offset (Enter for none): press Enter
**Fillet 3D Polyline**

This command fillets two segments of a 3D polyline with the given radius. AutoCAD's *FILLET* command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.

**Prompts**

- Fillet corner of a polyline or intersection of two polylines [<Corner>/Intersection]? press Enter
- Enter fillet radius <10.00>: press Enter
- Select a corner point on polyline: pick 3D poly line near meeting point of two segments
- Select a corner point on polyline: pick 3D poly line near meeting point of two segments
- Select a corner point on polyline: press Enter (to end command)

**Join 3D Polyline**

This command joins *3DPOLY* entities into a single 3D polyline entity.

**Prompts**

- Select the 3D polyline to join: pick a 3D poly line
- Select the other 3D polyline to join: pick a 3D poly line that has a common endpoint with the first 3 segments added to the polyline.

**Add Points At Elevation**

This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

**Prompts**
Enter Elevation Interval: 50
Select 3D polylines to process. pick 3D polyline(s)
Select objects: 1 found
Select objects:
Processing polylines ...
Added 10 points to polylines.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: addplz
Prerequisite: 3D Polylines
File Name: \lsp\poly3d.arx

3D Polyline by Slope on Surface

This command creates a 3D polyline at a user-specified slope. The user picks the starting point and then the polyline continues along the surface at the slope until it reaches a point where the maximum slope at the point is less than the design slope. The surface is defined by a grid or TIN file which must be created before running this routine. Applications for this command include designing haul roads or ditches.

Prompts

Enter the polyline layer <SLOPE_ROAD>: press Enter
Select the Grid File dialog
Reading row: 51
Extrapolate grid to full grid size (Yes/<No>)? Y
Limiting length for polyline (Enter for none):
Pick origin point of 3D polyline: pick a starting point
Direction of 3D Polyline (<Up>/Down)? press Enter The slope must go either uphill or downhill.
Direction of 3D Polyline facing up slope (<Left>/Right)? R Imagine facing uphill. Do you want the polyline to go to the left or right?
Enter the design slope: 10 This value is in percent slope.
Pulldown Menu Location: 3D Data
Keyboard Command: surfpl
Prerequisite: Existing surface file
File Names: \lsp\slop_rd.lsp, \lsp\cntr_grd.arx

Join Nearest

This command joins lines, arcs and/or polylines together. While AutoCAD's *PEDIT-Join* command requires the endpoints to match, Join Nearest will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.
Max Separation to Join: Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.

Max Deflection Angle (degrees): This option will not join any lines if the angle between them is greater than this angle in degrees.

Connection Method: Determines how to connect the endpoints. See the illustration below.

1. Average Endpoints Together: New vertex will be located at midpoint between two original endpoints (see illustration below on left).
2. Directly Connect Endpoints: Original endpoints are connected with new segment (see the middle illustration below).
3. Fillet with Radius Zero: Same as AutoCAD FILLET command using zero radius (see the illustration on right).

Convert Lines and Arcs Into Polylines: When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.

Join Across Intersections: This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.

Join Only Identical Layers: When checked, only entities on the same layer will be joined.

Join Only Common Elevations: When checked, only endpoints located on the same elevation will be joined.

Different Layer Prompt: When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.

Different Elevation Prompt: When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.

Pulldown Menu Location: Edit
Keyboard Command: nearjoin
Prerequisite: Lines or polylines to be joined
File Names: \\lsp\nearjoin.lsp, \lsp\poly3d.arx

3D Entity to 2D

This command changes a 3D Line, Arc, Circle, Polyline, Insert or Point to 2D, i.e. an entity with the elevations of the endpoints at the same Z coordinate. When the program detects a 3D polyline with all vertices with the same
elevation, there is an option to convert to a 2D polyline with this elevation. Otherwise, the entered elevation here is used.

**Prompts**

*Select/<Enter Elevation <0.00>: press Enter*

Select Lines, Arcs, Circles, Polylines, Inserts and Points for elevation change.

*Select objects: pick a 3D polyline*

3D POLY to 2D POLYLINE

Number of entities changed > 1

**Pulldown Menu Location:** Edit

**Keyboard Command:** 3dto2d

**Prerequisite:** None

**File Name:** \lsp\3dto2d.lsp

**Select by Filter**

This command can be used to build a selection set of objects inside a drawing based on layer and entity type. When the tool is executed it displays the following dialog. Select the layer(s) on the left you wish to select, then turn on the toggle(s) for the entity types to consider. The tool then builds a selection set of those objects that resides on those layers. When you execute your command following this selection building process, when you are prompted to select objects simply enter "P" for previous.

**Pulldown Menu Location:** Edit > Selection Sets

**Keyboard Command:** fsel
Select by Elevation

This command builds a selection set of entities that are greater than, less than or in between a specified elevation that you enter in on the command line. Entities selected, based upon this elevation criteria, go into a selection set. With the Window selection method, the entities must be entirely inside of the inclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select by greater, less or between elevations [<Greater>/Less/Between]? press Enter
Enter elevation for greater than: 19
Ignore zero elevations [<Yes>/No]? press Enter
Select objects to build selection set. pick objects
Processing selection set ...
Built selection of 120 objects for elev more than 19.00.
To use type 'P' at Select objects: prompt.

Select by Area

This command builds a selection set using inclusion and/or exclusion closed polylines. Entities within the inclusion polylines are selected and entities within the exclusion polylines are not selected. With the Window selection method, the entity must be entirely inside the inclusion area and entirely outside the exclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick the closed polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Type of selection (Window/<Crossing>)? press Enter
Select objects to build selection set.
Select objects: All These selected objects are checked with the inclusion/exclusion polylines.
Select objects: press Enter
Built selection set with 43 objects.
Command: Erase
Select objects: P To use previous selection set created by Select by Area.
43 found
Select objects: press Enter

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: ssgetarea
Prerequisite: Closed perimeter polylines
File Name: \sp\volcalc.arx

Image Frame

Function

This command controls whether TakeOff displays the image frame or hides it from view. Because you select an image by clicking its frame, setting the image frame to off prevents you from selecting an image.

Prompts

1 Enter image frame setting [ON/OFF] <current>: enter an option or Press Enter
   • On: Displays image frames so you can select images.
   • Off: Hides image frames so you cannot select images.

Prerequisite: None
Keyboard Command: IMAGEFRAME

Image Clip

Function

This command allows you to create new clipping boundaries for an image object.

Prompts

1 Select image to clip: select the edge of an image
2 Enter image clipping option [ON/OFF/Delete/New boundary] <New>: enter an option or Press Enter

The boundary you specify must be in a plane parallel to the image object.
   • On: Turns on clipping and displays the image clipped to the previously defined boundary.
   • Off: Turns off clipping and displays the entire image and frame. If you recclip the image while clipping is turned off, the program automatically turns clipping back on. The program prompts you to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.
   • Delete: Removes a predefined clipping boundary and redisplays the full original image.
   • New Boundary: Specifies a new clipping boundary. The boundary can be rectangular or polygonal, and consists only of straight line segments. When defining a clipping boundary, specify vertices within the image boundary. Self-intersecting vertices are valid. Rectangular is the default option. If you use the pointing device to specify a point at the Enter Clipping Type prompt, the program interprets the point as the first corner of a rectangle.
3 Enter clipping type [Polygonal/Rectangular] <Rectangular>: enter P or Press Enter

- **Polygonal**: Uses specified points to define a polygonal boundary.
  
  Specify first point: Specify a point
  Specify next point or [Undo]: specify a point or enter u
  Specify next point or [Undo]: specify a point or enter u
  Specify next point or [Close/Undo]: specify a point, or enter c or u
  You must specify at least three points to define a polygon.

  If the image already has a clipping boundary defined, TakeOff displays the following prompt:
  Delete old boundary? [No/Yes] <Yes>: enter N or Press Enter
  If you choose Yes, the program redraws the entire image and the command continues; if you choose No, the command ends.

- **Rectangular**: Specifies a rectangular boundary by its opposite corners. TakeOff always draws the rectangle parallel to the edges of the image.

  Specify first corner point: specify a point
  Specify opposite corner point: specify a point

  **Prerequisite**: None
  **Keyboard Command**: IMAGECLIP

**Image Adjust**

**Function**

This command controls the display of the brightness, contrast, and fade values of images.

![Image Adjust Dialog Box](image)

The Image Adjust dialog box controls how the image is displayed by adjusting the brightness, contrast, and fade settings of the selected image. Adjusting these values changes the display of the image but does not change the image file itself.
• **Brightness**: Controls the brightness, and indirectly the contrast, of the image. Values range from 0 through 100. The greater the value, the brighter the image and the more pixels that become white when you increase contrast. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

• **Contrast**: Controls the contrast, and indirectly the fading effect, of the image. Values range from 0 through 100. The greater the value, the more each pixel is forced to its primary or secondary color. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

• **Fade**: Controls the fading effect of the image. Values range from 0 through 100. The greater the value, the more the image blends with the current background color. A value of 100 blends the image completely into the background. Changing the screen background color causes the image to fade to the new color. In plotting, the background color for fade is white. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

• **Image Preview**: Displays a preview of the selected image. The preview image updates dynamically to reflect changes to the brightness, contrast, and fade settings.

• **Reset**: Resets values for brightness, contrast, and fade to default settings (50, 50, and 0, respectively).

**Prerequisite**: None

**Keyboard Command**: IMAGEADJUST
In addition to AutoCAD's powerful display and view commands, the Carlson View menu has some additional commands. The commands in the top section effect the screen display size and location, and the bottom section commands change layers.
Redraw

Function

This command refreshes the display in the current viewport.

Prerequisite: None

Keyboard Command: R

Regen

Function

This command regenerates the drawing and refreshes the current viewport.

Prerequisite: None

Keyboard Command: REGEN

Zoom - Window

Function

This command zooms to display an area you specify by two opposite corners of a rectangular window.

Prerequisite: None

Keyboard Command: ZOOM, W

Zoom - Dynamic

Function

This command zooms to display the generated portion of the drawing using a view box. The view box represents your viewport, which you can shrink or enlarge and move around the drawing. Positioning and sizing the view box pans or zooms the viewport, filling it with the image inside the view box.

Prerequisite: None

Keyboard Command: ZOOM, D

Zoom - Previous

Function

This command zooms to display a previous view. You can restore up to 10 previous views.

Prerequisite: None

Keyboard Command: ZOOM, P
Zoom - Center

Function

This command zooms to display a window you define by picking a center point and a magnification value or height. A smaller value for the height increases the magnification. A larger value decreases the magnification.

Prompts

1 Specify center point: pick a point
2 Enter magnification or height <226.66>: enter a value

Prerequisite: None
Keyboard Command: ZOOM, C

Zoom - Extents

Function

This command zooms to display the drawing extents. You can use Zoom Extents transparently, but it always regenerates the drawing.

Prerequisite: None
Keyboard Command: ZOOM, E

Zoom IN

Function

This command increases the zoom factor of the current viewport by a factor of 2.0.

Prerequisite: None
Keyboard Command: ZOOM, 2.0x

Zoom OUT

Function

This command decreases the zoom factor of the current viewport by a factor of 0.5.

Prerequisite: None
Keyboard Command: ZOOM, 0.5x
**Zoom Selection**

This command zooms the display to fit the selected entities. For example, if you run Viewpoint 3D and your viewport only shows two small dots of entities that are far apart, then you can use *Zoom Selection* to select the entities of one of these dots and quickly zoom the display to these entities.

**Prompts**

*Select objects to zoom onto:*
*Select objects: select entities*

**Pulldown Menu Location:** View
**Keyboard Command:** zoom_on
**Prerequisite:** Entities
**File Name:** \lsp\mineutil.arx

**Zoom Points**

This command centers the screen to a user-specified point. The point can be specified by either the point number or description. The command searches the current coordinate (.CRD) file. Besides centering the screen, the magnification can also be changed. The default value is the current magnification. To zoom in, enter a smaller value and to zoom out, enter a greater value.

**Prompts**

*Find by point number or description [Number]/Desc]? N*
*Point number or range of point numbers to find <1>: 2079*
*We want to find point number 2079*
*Magnification or Height <179.50>: press Enter*

Accept the default zoom magnification

**Pulldown Menu Location:** View
**Keyboard Command:** zoompnt
**Prerequisite:** A .CRD file
**File Names:** \lsp\fpoint.lsp, \lsp\crdutil.arx

**Pan**

**Function**

This command moves the drawing display in the current viewport. The cursor changes to a hand cursor. By holding down the pick button on the pointing device, you lock the cursor to its current location relative to the viewport coordinate system. The drawing display is moved in the same direction as the cursor.

When you reach a logical extent (the edge of the drawing space), a bar is displayed on the hand cursor on the side where the extent has been reached. Depending on whether the logical extent is at the top, bottom, or side of the drawing, the bar is either horizontal (top or bottom) or vertical (left or right side).
When you release the pick button, panning stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again to pan the display from that location.

To stop panning at any time, press Enter or ESC.

**Prerequisite:** None

**Keyboard Command:** P

## 3D Viewer Window

This command views in 3D, the selected 3D faces, polylines, lines and points. This routine uses the OpenGL graphics library for rendering, which gives it superior performance. Some of it's features include the ability to zoom in and out, pan, rotate around the X,Y,Z axis and shade in user-positioned lighting.

![3D Viewer Window](image)

### View Control

- **Ignore Zero Elevations:** When checked, the 3D viewer ignore entities at zero elevation.
- **Color By Elevation:** This will color the contours or 3D faces by elevation. The elevation scale legend is displayed on the left of the window.
- **Vert. scale:** Sets the vertical scale factor for the 3D viewer. Flat surfaces can be exaggerated by increasing the vertical scale.
This control represents position of the sun in the sky if looked from above. Therefore, the position of the sun in the center means that the sun is in a zenith, and position near the edge of the circle means that the sun is near the horizon. To move the sun, simply drag it to a new location, or click on the new location. The slide bars on the sides are the intensity and brightness of the display.

- **Zooms IN.**
- **Zooms OUT.**
- **Switch to Dynamic Zoom mode.**
- **Switch to Pan mode. Click and drag to pan.**
- **Switch to Rotation mode.**
- **Switch to initial view.**
- **Toggles shading on and off.**
- **This is an inquire tool. Point the arrow to any entity to display entity data including the layer, type, elevation and length.**
- **Resets the 3D view to plan.**
- **Exit the 3D viewer window.**

- **Clip Plane:** This slider will clip the image based on the location of the slider. When the slider is all the way to the left, the entire image is displayed. Moving the slider to the right will clip the image, going deeper as the slider is moved to the right. This is useful to view items that are hidden behind something else.
- **Scroll Bars:** Use X,Y,Z scrollbars near the bottom to rotate the view. The range of these scrollbars is -180 to +180 degrees with middle being 0 which is the default position when the viewer starts. When the cursor is near the middle of the window, the XY icon will allow for rotating the image with the mouse, while holding the left mouse button. Move the cursor to the edge, and the icon switches to Z. This allows for rotating around the Z axis with the mouse, while holding the left mouse button.
Advanced Tab

- **Block Model Objects:** This option has three choices when loading block model entities. 1. To leave as points. 2. To Render and 3. To prompt each time. If render is selected, it will apply to all face objects such as a TIN or GRD.

- **Block Model layers:** This will display the block color scheme. Colors of the blocks can be turned on or off to view blocks in the middle.

- **Shading Mode:** There are 3 shading modes to render 3D faces. They are 1. Shade Front, 2. Shade Both, and 3. Shade Back. This will render the top and bottom of the faces if desired.

- **Display Axis Icon:** This controls whether to show the X/Y/Z axis icon in the lower left of the graphic window.

- **Display Bounding Box:** This controls whether to display a 3D box around the limits of the data.

- **Display Vertical Scale:** This controls whether to display the current vertical scale in the graphic window.

This function exports the graphic display to an image file. Several different image file formats are supported including bmp, png, jpg, xpm and gif. There is a Export Image Selections dialog to choose the image resolution and color depth.

Sets the AutoCAD view to match the view shown in the 3D viewer window.

- **Saved Views:** This option allows for naming and saving a 3D view. These can be selected from the pulldown. They can be deleted from the list.

**Pulldown Menu Location:** View

**Keyboard Command:** cube
**Surface 3D Viewer**

This command is identical to the 3D Viewer Window, except that this one loads a Carlson Grid GRD, TIN or FLT file. After the file is selected, the same viewer documented in *3D Viewer Window* appears.

**Pulldown Menu Location:** View  
**Keyboard Command:** cube  
**Prerequisite:** Entities to display  
**File Name:** \lsp\cube.arx

**Surface 3D FlyOver**

This command allows you to view a self guided animation of following a path through a 3D surface model. There are two variations to this command. When the command is started, you must specify whether you want to use a surface model from file or screen entities.

**Surface model from file:** Using this method, you can select either a triangulation (.TIN) file or a grid (.GRD) file, then you have the option of following a polyline or following a "free" path. If you choose the polyline method, then the animation is limited to following the polyline. If you choose the "free" path method, you first specify two points to obtain a starting direction, the while inside the viewer you can point the animation in any direction.

**Screen entities:** Using this method, you must select a 3D polyline to follow. The animation is limited to following the polyline.
After making the above selections, the 3D graphics window is opened. The main window is for the animation, the smaller upper right window shows you the overall plan view, and the smaller window located at middle right shows you the current elevation, slope and azimuth. While following a "free" path, you will have a 3rd small window located at lower right which shows you the amount of roll at your current position.

This button raises the elevation of your viewing position.

This button lowers the elevation of your viewing position.

This button turns your viewing position to the left.

This button turns your viewing position to the right.
This button allows you to zoom in and out.

This button allows you to rotate the main animation window in any X, Y or Z direction.

This button allows you to pan.

This button toggles shading on and off.

This button starts the animation in the main window.

This button stops the animation.

This button exits the 3D Surface FlyOver command

Control for position of the light source, viewed from above.

**Prerequisite:** Surface Model and optionally a 3D Polyline  
**Keyboard Command:** flyby

**Viewpoint 3D**

**Function**

This command allows you to define 3D view settings.
1 Under Set Viewing Angles, you must set the direction of the view relative to either the world coordinate system (WCS) or a user coordinate system (UCS).

- **Absolute to WCS**: This option sets the view direction relative to the WCS.
- **Relative to UCS**: This option sets the view direction relative to the current UCS.

2 You must specify the viewing angles.

- **X Axis**: This field specifies the angle from the X axis.
- **XY Plane**: This field specifies the angle from the XY plane. You can also use the sample image to specify viewing angles. The black arm indicates the new angle. The red arm indicates the current angle. Specify an angle by selecting the inner region of the circle or half-circle. Selecting the bounded outer regions rounds off the angle to the value displayed in that region.
- **Set to Plan View**: This option sets the viewing angles to display the plan view relative to the selected coordinate system.

**Prerequisite**: None.

**Keyboard Command**: DDVPOINT

### Twist Screen: Standard

This command will twist the screen orientation to where something other than the north direction is toward the top of the screen/drawing. It does not do a coordinate rotation, the drawing coordinates remain unchanged. Use commands on the *Points* menu, such as *Rotate Points* and *Translate Points*, if you want to do a coordinate rotation or translation.

#### Prompts

This routine prompts for the twist angle then adjusts the screen and cross-hairs to that angle. This is a modification of AutoCAD's *DVIEW* command. The twist angle is always measured counterclockwise with 0 degrees being to the east/right.
Twist Screen: Line Pline or Text

This is a variation of the previous command that allows you to select a line, polyline, or text in your drawing that you want to be aligned parallel to the east-west direction of the graphics screen. Think of the entity you select as a pointer or arrow that will point in the east direction of the screen after you select it. Select the line, polyline, or text closest to the end point which you want to be the horizontal or east direction of the screen.

Prompts

Pick a line, polyline or text to make horizontal: pick a line or polyline

Twist Screen: Surveyor

This is another variation of twisting the screen that allows you to input an angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen.

Prompts

Angle to set to horizontal: 0 This would align due north with respect to real world coordinates to the east or horizontal direction of the graphics screen.
**Restore Due North**

This command twists the screen to make due north vertical.

**Pulldown Menu Location:** View > Twist Screen

**Prerequisite:** None

**Keyboard Command:** twist3

**File Name:** \lsp\scadutil.arx

**Display Order**

**Function**

This command allows you to change the display order of objects by repositioning an entity from either the background to the forefront of the drawing view or from the forefront to the background of the drawing view.

**Prerequisite:** None

**Keyboard Command:** draworder

**Layer Control**

**Function**

This command allows you to manage layers and layer properties.
This Layer Properties Manager dialog box makes a layer current, adds new layers to the layer name list, and renames an existing layer. You can assign properties to layers, turn layers on and off, freeze and thaw layers globally or by viewport, lock and unlock layers, set plot styles for layers, and turn plotting on and off for layers. You can filter the layer names displayed in the Layer Properties Manager, and you can save and restore layer states and properties settings.

1 Under Named Layer Filters, you determine which layers to display in the list of layers. You can filter layers based on whether they’re xref-dependent, or whether they contain objects. You can also filter layers based on name, visibility, color, linetype, lineweight, plot style name, whether they are plotted, or whether they are frozen in the current viewport or in new viewports.

- **Invert Filter**: This button displays the Named Layer Filters dialog box.

- **Invert Filter**: This option displays layers based on the opposites of the criteria you select when you are using a named layer filter. Layers that fit the inverse criteria are displayed in the layer name list.

- **Apply to Object Properties Toolbar**: This option displays in the Object Properties toolbar only layers that match the current filter. The layer list tooltip on the Object Properties toolbar displays the filter status of layers in the drawing. (To display the layer list tooltip, position the pointing device over the layer list on the Object Properties toolbar.)

- **New**: This option creates a new layer. After you choose New, the list displays a layer named LAYER1. You can edit this layer immediately. To create multiple layers quickly, you can select a layer name for editing and enter multiple layer names separated by commas. If you create a new layer, the new layer inherits the properties of the currently selected layer in the layer list (such as Color, and On/Off state). To create layers with default settings, make sure that there are no selected layers in the list or that you select a layer with default settings before beginning layer creation.

- **Current**: This option sets the selected layer as the current layer. The CLAYER system variable stores the layer name.

- **Delete**: This option deletes selected layers from the drawing file definition. You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers containing objects (including objects in block
definitions), the current layer, and xref-dependent layers. Layers that don't contain objects (including objects in block definitions), are not current, and are not xref-dependent can be deleted by using the PURGE command. Be careful about deleting layers if you are working on a drawing in a shared project or one based on a set of layering standards.

• **Show/Hide Details**: This option controls whether the Details section is displayed in the Layer Properties Manager.

• **Save State**: This option displays the Save Layer States dialog box, in which you save layer state and layer properties settings of all layers in a drawing. You can choose which layer states and properties you want to preserve. You save a layer state by assigning it a name.

• **Restore State**: This option displays the Layer States Manager, in which you can manage named layer states.

The Layer Properties Manager dialog box displays all layers and their properties. To modify a property, click its icon. To quickly select all layers, right-click your pointing device and use the shortcut menu. The following are the layer properties you can modify:

• **Name**: This field displays the names of the layers. You can select a name, and then click and enter a new name.

• **On/Off**: This field turns layers on and off. When a layer is on, it is visible and available for plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.

• **Freeze/Thaw in All Viewports**: This field freezes and thaws layers in all floating viewports. A frozen layer is invisible and excluded from regeneration, hiding objects, rendering, and plotting. A thawed layer is visible and available for regeneration, hiding objects, rendering, and plotting.

You can freeze layers to speed up ZOOM, PAN, and many other operations, improve object selection performance, and reduce regeneration time for complex drawings. TakeOff does not display, plot, or regenerate objects on frozen layers. Objects on frozen layers do not hide objects and are not rendered.

You can freeze layers in all viewports, in the current viewport, or in new viewports.

Freeze layers that you want to be invisible for long periods. When you thaw a frozen layer, the program regenerates and displays the objects on that layer. If you switch between visible and invisible states frequently, use the On/Off setting.

• **Lock/Unlock**: This field locks and unlocks the layers. You cannot select or edit objects on a locked layer. Locking a layer is useful if you want to view information on a layer for reference but do not want to edit objects on that layer.

• **Color**: This field changes the color associated with the selected layers. Clicking the color name displays the Select Color dialog box.

• **Linetype**: This field changes the linetype associated with the selected layers. Clicking any linetype name displays the Select Linetype dialog box.

• **Lineweight**: This field changes the lineweight associated with the selected layers. Clicking any lineweight name displays the Lineweight dialog box.

• **Plot Style**: This field changes the plot style associated with the selected layers. If you are working with color-dependent plot styles (the PSTYLEPOLICY system variable is set to 1), you cannot change the plot style associated with a layer. Clicking any plot style displays the Select Plot Style dialog box.

• **Plot/Don't Plot**: This field controls whether the selected layers are plotted. If you turn off plotting for a layer, the objects on that layer are still displayed. Turning off plotting for a layer affects only visible layers in the drawing (layers that are on and thawed). If a layer is set to plot, but is currently frozen or off in the drawing, TakeOff does not plot the layer. Turning off plotting for layers containing reference information such as construction lines can be useful.
Prerequisite: None

Keyboard Command: LAYER

Set Layer
This command allows the user to change the current layer to a different layer by picking an entity on that layer.

Pulldown Menu Location: View
Keyboard Command: lset
Prerequisite: None
File Name: \lsp\picklayr.lsp

Change Layer
This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed in or read from an existing entity by picking an entity that is on the layer that you want to change the group to.

Prompts
Select entities to be changed.
Select objects: pick entities
The Select Layer dialog appears select a layer from the list, or select Screen Pick
If Screen Pick is chosen,
Pick entity with layer to change to: pick another entity This assigns the selected entities to the layer of this entity.
or
Enter new layer name or pick entity with layer (Enter/\Pick>)? E
Enter new layer name: FINAL This assigns the selected entities to the FINAL layer.

Pulldown Menu Location: View
Keyboard Command: lc change
Prerequisite: None
File Name: \lsp\chglayr.lsp
**Freeze Layer**

This command will freeze layers by picking entities on that layer.

**Pull-down Menu Location:** View  
**Keyboard Command:** loff  
**Prerequisite:** None  
**File Name:** \lsp\loff.lsp

**Thaw Layer**

This command thaws the layers frozen by the Freeze Layer command.

**Pull-down Menu Location:** View  
**Keyboard Command:** lon  
**Prerequisite:** None  
**File Name:** \lsp\lon.lsp

**Isolate Layer**

This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

**Prompts**

- **Select objects on layers to isolate.**  
  - **Select objects:** pick entities  
  - **Retain POINT layers [Yes/No]?** Press Enter

- Isolate the wall layer by picking one wall line

**Pull-down Menu Location:** View  
**Keyboard Command:** isolate  
**Prerequisite:** None  
**File Name:** \lsp\isolate.lsp

**Restore Layer**

This command thaws the layers that were frozen by the Isolate Layer command.
Pulldown Menu Location: View
Keyboard Command: restore
Prerequisite: None
File Name: \lsp\restore.lsp
Most of the Draw Menu commands are AutoCAD commands for creating entities in your drawing. Carlson commands that are part of the Draw menu are documented here. Any items not appearing in the Carlson manual are AutoCAD commands that can be referenced in the AutoCAD manual.
**Line**

**Function**

This command allows you to draw a line entity by picking points on the screen or by supplying the coordinate values using the point number and associated coordinates stored in the current coordinate file. The Line command links the line with the points when the line is drawn using point numbers if the Link Linework with Points option is turned on. This option is set under General Settings in the Configure command in the Settings menu. With links active, changing a point with a command like Move Points automatically updates the line. This command always draws 2D lines with a zero elevation.

**Prompts**

1 Pick point or point numbers: 1-3

You may enter a single point number or a range of point numbers

2 Undo/Distance/<Pick point or point numbers>: 16

3 Undo/+/-/Close/Distance/<Pick point or point numbers>: 35

4 Undo/+/-/Close/Distance/<Pick point or point numbers>: +

The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.

5 Perpendicular Distance Right: 80

6 Undo/+/-/Close/Distance/<Pick point or point numbers>: -

The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.

7 Perpendicular Distance Left: 105.12

8 Undo/+/-/Close/Distance/<Pick point or point numbers>: D

The distance option allows you to input a distance for the next line segment. The position of the cursor determines the angle.

9 Enter distance: 174.32

10 Undo/+/-/Close/Distance/<Pick point or point numbers>: C

The close option draws a line segment back to the original starting point

**Prerequisite:** None

**Keyboard Command:** 2DLINE

**2D Polyline**

A polyline is a series of line and/or arc segments joined together in one entity or object. In addition to the regular AutoCAD Draw Polyline command (PL), there is this Carlson command that has several key features and options. This command allows you to draw a polyline entity in a variety of ways, including: Continue, Extend, Follow, Arc, Direction, Close, Pick point or point numbers. This dialog shown below automatically appears when you run the command.
The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If you do not want it to come up, then toggle it off. In this dialog you can set the elevation of the polyline, as well as the layer it will appear on.

**Offset from centerline** allows you to make another choice. First, a unique command line appears.

[Continue/Extend/Follow/Offset/Options/\(<\text{Pick point or point numbers}>\)]:

**Auto-Zoom mode** regenerates the screen as you draw your polyline, to give you the best view as you are working. **Always** means it will always regenerate the screen. **Proximity** regenerates the screen according to the **Proximity Zoom Level %** value. **Never** toggles off this feature. The **Elevation** of the polyline can be set here. The default is 0. If it is off, then the last settings will apply. To get the box back, choose **O** for Options on the command line.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer. If the current layer is not used, the **Layer** option allows you to **Select** from a list or **Pick** from the screen.

There are three options under **Auto-Zoom Mode**. **Never** will not zoom to the last point picked. **Proximity** will zoom to the percent proximity set below. **Always** will always zoom center on every point.

If the **Proximity** Auto-Zoom mode is checked, the percent of the proximity is set in the box on the right.
Annotate closed pads, when checked, will make available the Settings button on the right side. When Settings is chosen, the Annotate pad dialog appears. Here is where you can enter in values that will result in annotation for the closed polyline.

With regards the options available on the command line, they are explained as follows:

**Continue** allows you to run Arc, Direction, Close, Extend, or Follow for an existing polyline.

**Extend** allows you to extend an existing polyline by picking or entering in a distance.

**Follow** allows you to match the path of your polyline with an existing polyline. You are prompted to select the point in which your polyline first intersects with the existing polyline and the point in which it exits. If the existing polyline is a closed polyline than you will be prompted to approve the direction in which your polyline follows the existing closed polyline.

**Options** brings up the Polyline 2D Options dialog that appears when you first run the command, unless Offset from centerline is checked, in which case the letter indicates this feature, and a centerline will be requested.

**Pick point** allows you to pick a point on the screen to start your polyline.

**Point numbers** allows you to enter in coordinates to start your polyline.

**Arc** allows you to draw an arc by Arc length/Chord/Radius/Second point in your polyline. The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line. This is useful for plotting buildings.

**Distance** for an angle code, a backsight point, an angle (dd.mmss), and a distance to draw your polyline.

**Close** will connect the ends of your polyline making it a closed polyline.

**Prompts**

```
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point
Segment length: 0.00, Total length: 0.00
[Arc/Close/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 3.83, Total length: 3.83
[Arc/Close/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 2.94, Total length: 6.77 press Enter to end
```

**3D Polyline**

In addition to the regular AutoCAD Draw 3D Polyline command, there is this Carlson command that has several options.
The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If it is off, then the last settings will apply. To get the box back, choose O for Options.

**Prompt for Elevation/Slope** controls whether the elevation of each picked point will be entered in, or hit S for slope to draw a slope line.

**Use Surface Model from File** will use a grid or triangulation file as a surface model. Wherever the points are picked on the surface, the elevation of the surface will be assigned to the polyline.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer.

If the current layer is not used, the **Layer** option allows you to Select from a list or Pick from the screen.

There are 3 options under **Auto-Zoom Mode**. **Never** will not zoom to the last point picked. **Proximity** will zoom to the percent proximity set below. **Always** will always zoom center on every point.

If the **Proximity** Auto-Zoom mode is checked, the percent of the proximity is set in the **Proximity Zoom Level %** box.

**Prompts**

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point

Elevation <0.00>: 435

Z: 435.00, Hz dist: 0.00, Slope dist: 0.00, Slope: 0.0% Ratio: 0.0:1

[Arc/Direction/Close/Follow/Undo/<Pick point or point numbers>]: pick a point

Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>: 444

Z: 444.00, Hz dist: 3.67, Slope dist: 9.72, Slope: 245.3% Ratio: 0.4:1

[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: pick a point

Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>: 399

Z: 399.00, Hz dist: 3.16, Slope dist: 45.11, Slope: -1425.2% Ratio: -0.1:1

[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: press Enter to end

**Pulldown Menu Location:** Draw

**Keyboard Command:** 3DP

**Prerequisite:** None
Circle

Function

This command allows you to draw a circle.

Prompts

1 Pick center point or point number or [3P/2P/TTR]: pick point or specify option
   • 3P: This option draws a circle based on three points on the circumference.
   • 2P: This option draws a circle based on two endpoints of the diameter.
   • TTR-Tangent, Tangent, Radius: This option draws a circle with a specified radius tangent to two objects.
2 Specify radius of circle or [Diameter]: enter a value

Sometimes more than one circle matches the criteria specified in the command. The circle whose tangent points are closest to the selected points is drawn.

Prerequisite: None

Keyboard Command: SCIRCLE

3 Point

This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the PT. The points can either by picked on-screen or specified by point number.

Prompts

Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3PA
Prerequisite: None
File Name: \lsp\3ptarc.lsp

PC, PT, Center

This command draws an arc between the PC point, radius point and PT point. The points can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct? No/<Yes>: N

Pulldown Menu Location: Draw > Arc
Keyboard Command: pca
Prerequisite: None

2 Tangents, Radius

This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then prompts to pick points on the two tangent lines.

Prompts

Radius of Arc <300.000>: press Enter
[nea] Pick Point on 1st Tangent Line: pick a point
[nea] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlin
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlin.lsp

PC, Radius, Chord

This command draws an arc, given the PC point, radius length, chord length and chord bearing. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Radius of Arc <40.00>: 500
PC Start Point ?
Pick point or point number: pick a point
Chord bearing or chord endpoint (<Bearing>/Point)? Press Enter
Enter Bearing (Qdd.mmss) <90.0000>: 145.1041 (for NE 45d10'41'"
Chord Length <200.46>: 200
Is this arc in the correct direction (<Yes>/No)? Press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: srcb
Prerequisite: None

PC, Radius, Arc Length

This command draws an arc given the PC point, radius length, and arc length. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.
Prompts

Pick PC Point or point number: pick a point
Pick Radius point or point number: pick a point
Arc length <5.00): 150
Is this arc in the correct direction (<Yes>/No)? press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: pra
Prerequisite: None
File Name: \lsp\cenarc.lsp

2 Tangents, Arc Length

This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick the P.I. (intersection of tangent lines) and points on the two tangent lines.

Prompts

Arc Length <100.00>: press Enter or enter distance
[int on] Pick P.I. of curve: pick intersection of tangent lines
[nea on] Pick pnt on 1st Tangent Line: pick a point
[nea on] Pick pnt on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlal
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlal.lsp

2 Tangents, Chord Length

This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

Prompts

Chord Length <100.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlcl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlcl.lsp
2 Tangents, Mid-Ordinate

This command fits a curve between two tangent lines and a known middle ordinate. It prompts for the middle ordinate length, the Point of Intersection and points on the two tangent lines.

Prompts

Middle Ordinate <50.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlmo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlmo.lsp

2 Tangents, External

This command fits a curve between two tangent lines and a known external secant distance. It prompts for the P.I. and points on the two tangent lines then the external distance.

Prompts

[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point
External Distance <50.00>: press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlex
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlex.lsp
2 Tangents, Tangent Length

This command fits a curve between two tangent lines and a known curve tangent length. It prompts for the tangent length, P.I. and points on the two tangent lines.

Prompts

Tangent Length <50.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanltl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanltl.lsp

2 Tangents, Degree of Curve

This command fits a curve between two tangent lines by entering a known degree of curve. It prompts for the degree of curve and then prompts to pick points on the two tangent lines.

Prompts

Degree of Curve (ddd.mmss) <5.0000>: press Enter
Define by [C]hord or [A]rc length <A>: press Enter
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanldo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanldo.lsp

Tangent, PC, Radius, Arc Length

This command draws a curve from a perpendicular tangent line with a known radius and arc length. It prompts for the radius, the arc length and then to pick the P.C. start point of the curve (endpoint of previously drawn tangent line) and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <15.00>: 55
Arc Length <25.00>: 30
PC Start Point ?
Pick point/ <point Number>: 14
PtNo. North(y) East(x) Elev(z) Desc
14 4869.06 4390.3 10.00

Chapter 7. Draw Menu 272
Tangent, PC, Radius, Tangent Length

This command draws a curve from a perpendicular tangent line with a known radius and tangent length. It prompts for the radius, the tangent length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <300.0000>: press Enter
Tangent Length <236.0000>: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5270.39 4840.36 0.0)
Radius Point Coordinates: (5251.37 4534.71 0.0)

Tang, PC, Radius, Chord Length

This command draws a curve from a perpendicular tangent line with a known radius and chord length. It prompts for the radius, the chord length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts
Precede radius with - sign for curve to the right.
Radius of Arc <300.0000>: press Enter
Chord Length <25.0000>: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5142.38 4911.57 0.0)
Radius Point Coordinates: (5221.51 5209.63 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: SRCL
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srcl.lsp

**Tang, PC, Radius, Delta Angle**

This command draws a curve from a perpendicular tangent line with a known radius and delta angle. It prompts for the radius, the delta angle and then to pick the P.C. start point of the curve and a point along the tangent line.

**Prompts**

Precede radius with - sign for curve to the right.
Radius of Arc <300.00>: press Enter
Enter Delta Angle <90.00>: press Enter
PC Start Point ?
Number/<Pick point>: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: srda
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srda.lsp

**Compound or Reverse**

**Function**

This command draws a compound or reverse off an existing curve. It prompts whether the curve is reverse or compound, for the P.C. start point (endpoint of an existing arc) and the known radius. Then the user selects the other known from the choices of tangent length, arc length, chord length or delta angle and enters that value. This command can be confused and malfunction if there is another entity such as a point symbol at the P.C. (If this happens, freeze the PNTMARK layer or temporarily erase the point symbol.)
Prompts

[end on] Select ARC at PC Start point of the curve: pick a point
Type of curve [<Compound>/Reverse]: press Enter
Enter the Radius: 300
Define arc method [Tangent/Chord/Delta/<Length>]: press Enter
Enter the arc length: 236

Pull-down Menu Location: Draw > Arc
Keyboard Command: srcr
Prerequisite: Tangent arc should be drawn before execution
File Name: \lsp\srcr.lsp

3-Radius Curve Series

This command is used to best fit a series of three curves with different radii between 2 tangents. The "Offsets from the Tangents" is the distance perpendicular to the tangent from both ends of the second curve.
Prompts

Please pick two tangents...
Pick first tangent: pick a point
Pick second tangent: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3curves
Prerequisite: Two tangents

Best Fit Curve

This command draws an arc between to endpoints with a radius that is derived from sampling points and averaging the radius of an arc that passes though these points.

Prompts

Starting Point ?
Pick point or point number: pick a point
Ending point ?
Pick point or point number: pick a point
Select points from screen or by point number [Screen]/Number: press Enter
Select Points to sample.
Select objects: W Use window to select a group of points. After selecting all the points to sample, end selection by pressing Enter.

Pulldown Menu Location: Draw > Arc
Keyboard Command: bfitcrv
Prerequisite: Points for sampling should be drawn before execution.
File Name: \lsp\bfitcrv.lsp

Curve Calc

This Curve Calculator command displays a dialog box with a series of edit boxes that are filled in with the values of a curve. You can input two known values and the program calculates the other values. One of the known values must be the radius or the delta angle. The 3 Points option allows you to simply select three on-screen point locations. All of the fields will immediately be filled in after the picking of the third point. Optionally, you can also input point numbers from a coordinate file.
Roadway or Railroad: Allows you to choose which type of curve you would like information on. Toggling between the two, after data is entered, will reveal different values.

Select: Allows you to select an arc from the drawing. The information for the selected arc is displayed in the dialog box.

3 Points: Allows you to specify three points on the screen to define an arc. The information for this defined arc is displayed in the dialog box.

Plot: Allows you to plot the currently defined arc in the drawing.

Clear: Clears all edit boxes in the dialog.

Prompts

Curve Calculator dialog *Enter at least two values, as described above*
The dialog box first pops up without any data in the fields. The above dialog graphic is a result of entering in the radius and the arc length values of a known curve, then the Enter or Tab key.

Pulldown Menu Location: Draw > Arc

Keyboard Command: curvcalc

Prerequisite: None

File Names: \lsp\curvcalc.lsp, \lsp\scadcfu.dcl

Spiral Curve

This command plots a spiral curve. The user must provide the P.I. (point of intersection), the length of spiral and the radius length of the simple curve. The command will plot a symmetrical spiral or a spiral in or spiral out (choose the S option for the first prompt if you only want to plot a spiral out). If you have an unsymmetrical spiral then plot a spiral in using the T or P option then use the S option to plot the spiral out. The command plots a polyline to represent the spiral as line segments at the resolution specified by the user. You can use the Calculate Offsets, Station Polyline/Centerline or Offset Point Entry commands, found in the Centerline menu, to calculate points and/or stations and offsets from the spiral.
Prompts

Spiral method [TS/ST/<PI>] press Enter
PI Point ?
Pick point or point number: pick intersection of tangent lines
TS Direction point (tangent in) ?
Pick point or point number: pick point along tangent in line
ST Direction point (tangent out) ?
Pick point or point number: pick point along tangent out line
Tangent in direction= N 56d24’9’’ E Azimuth= 56d24’9’’
Tangent out direction= S 65d9’1’’ E Azimuth= 114d50’59’’
Overall Delta= 58d26’50’’
Point calculating distance resolution <10.0>: press Enter
Length of Spiral <350.0>: press Enter
Radius of simple curve (precede with - sign if curve to left) <954.93>: 954.93
Degree of curve: 60d0’0’’
Theta of Spiral= 0.18325951 (radians) 10d30’0’’ (dd.mmss)
Distance along tangent line from TS to SC= 348.82
Distance offset from tangent line to SC= 21.33
(k) Shift along tangent line of PC= 174.80
(p) Shift offset from tangent line of PC= 5.34
Distance from PI to TS= 712.00
North(Y) of TS= 4583.08 East(X) of TS= 4244.46
North(Y) of SC= 4758.34 East(X) of SC= 4546.82
North(Y) of Offset PC= 4675.36 East(X) of Offset PC= 4393.02
[P]lot spiral or
[I]ntermediate distances for staking (deflection angle calc) <P>: press Enter
Point calculating distance resolution <10.0>: 5 Enter the resolution at which you would like the line segments of the representative polyline plotted.
North(Y) of Radius Pt= 3879.96 East(X) of Radius Pt= 4921.44
<press [Enter] for symmetrical spiral out>/[D]elta of simple curve: press Enter If you want a spiral in only enter D then input the delta angle of the curve.
Simple Curve Delta= 37d26’50’’ Length of Arc= 624.12
North(Y) of CS= 4805.10 East(X) of CS= 5158.11
Pulldown Menu Location: Draw > Arc
Keyboard Command: spiral
Prerequisite: For a symmetrical spiral, draw the tangent in and tangent out lines. For spiral in or out only, draw the tangent line in or out.
File Name: \lsp\spiral.lsp

Insert Symbols

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the Edit Symbol Library command.

In the Insert Symbols options dialog, choose a symbol by entering the Symbol Name or by picking the Select button which brings up the Select Symbol dialog. The default Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols. The Prompt For Rotation option will add a prompt for each symbol rotation.
The Rotate By Centerline option will prompt to select linework and then rotate the symbols to make them parallel to the nearest linework. The Symbol Rotation Angle is applied relative to horizontal of the current twist screen or to the nearest linework angle when Rotate By Centerline is active. The Erase Existing Symbols options apply if you specify a symbol location that already has a symbol on it. There are also settings for the symbol layer name and size.

After the options dialog, the program prompts at the Command line for the symbol locations. The locations can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Selecting the Enter coords option allows you to insert the symbol by entering a easting, northing and elevation in x,y,z order.
Prompts

Insert Symbols dialog Choose parameters and click OK

Options/Select entities/Enter coords/<Pick point or point numbers>: pick a point

Options/Select entities/Enter coords/<Pick point or point numbers>: 5-10 Inserts symbols at points 5-10 from the current coordinate file.

Options/Select entities/Enter coords/<Pick point or point numbers>: S

Insert Symbols dialog

Select arcs, faces, points, text, lines and polylines. select objects

Options/Select entities/Enter coords/<Pick point or point numbers>: press Enter to end

Pulldown Menu Location: Draw > Symbols

Keyboard Command: ptsym

Prerequisite: None

File Name: \sp\lptsym.lsp

Insert Multi-Point Symbols

This command allows you to locate symbols using multiple insertion points. Up to three insertion points can be defined for an individual symbol. When defining only two insertion points for a particular symbol, the symbol will be scaled and rotated. With three insertion points defined, the symbol is rotated and scaled in both the X and Y directions. The two point insertion definition will aid in the drawing of tree symbols with a specific drip line width. For instance, a surveyor could locate the tree and then locate the drip line, two shots for each tree, and allow the program to size the tree symbol accordingly so that the map will have various tree symbol sizes that reflect the actual field conditions.

The multiple insertion points are defined in the Field to Finish codes. The Insert Multi-Point Symbols command reads the Field to Finish code table and finds all of the codes with multi-point symbol definitions. Then you can select from these codes for the symbol to draw. Both the two and three point insertion definitions can aid with the insertion of concretes and buildings symbols during final drawing preparations and design phases of a project.

Here are the various steps to define two point and three point insertion point symbols. First, you must decide on the symbol to use for the desired code, as well as the specific placement points for the symbol. Once a symbol has been chosen, open the desired symbol drawing. To do this, identify the symbol name and then locate the symbol by its drawing name under the SUP sub-directory found under the Carlson installation directory. Next, determine the placement points for the symbol. As shown below, the placement points for the BLD code symbol, which will be explored later in this section, were determined by identifying X and Y values of the desired placement points by using the id command and specifying the end points of the lines.
Next, the symbol insertion points must be defined in the Field to Finish code table (.FLD) file. To do this, open your FLD file by choosing Draw Field to Finish under the Survey pulldown. Then select a particular code from the list of codes displayed in the Field to Finish dialog box. Edit it by highlighting the code and picking the Edit button, or define a new code with the Add button. Either choice will display the Edit Field Code Definition dialog. In the Edit Code Definition dialog, choose the desired symbol for the code by pressing the Set Symbol button and selecting the desired symbol. Next, select the Symbol Pts button. This brings up a dialog called Define Symbol Placement Points. Here is where you define the symbol by three points. You do this by entering an X and Y coordinate and a description for the symbol. Enter the X and Y values for each placement point into the appropriate fields. The description fields are used as the prompts when placing the symbol in the drawing. A two insertion point symbol is defined in the same way. An example is the Symbol Pnts definition for the code TREE. The placement points for the Tree code symbol were determined by opening the symbol drawing and finding the X and Y values at the insertion points. The center of the large circle was chosen for Point 1 and the East Quadrant was chosen for point 2. In both cases osnaps were used in picking the points.

Now that we have the codes defined, let's go through the Insert Multi-Point Symbol command and see the results. The command starts with a dialog that lists all the codes with Multi-Point Symbols defined. At this point you can select the symbol to draw. The symbol size applies only to using one point to place the symbol. When two or more points are used, the symbol is scaled to fit the points. Let's look at the BLD code three point insertion definition. Shown below are three points that represent a building pad. We want the building to be exactly the same dimensions defined by the point locations.

The tree with drip line examples follow. We start by specifying the building pad codes.

**Prompts**

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this example, the Pad symbol is a 3 point multi-symbol.

Specify LT FNT PAD point.
Pick Point or Point Number (Enter to End): 15
Specify LT REAR PAD point.
Pick Point or Point Number (Enter to End): 16
Specify RT REAR PAD point.
Pick Point or Point Number (Enter to End): 17
Insert another BLD symbol [<Yes>/No]? N

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this next example, the Tree symbol is a 2 point multi-symbol. Now specify the location of the trunk and the drip line by point number.

Specify Trunk Location point.
Pick Point or Point Number (Enter to End): 1
Specify Drip Line Point.
Pick Point or Point Number (Enter to End): 13
Insert another TREE symbol [<Yes>/No]? N
From the Field to Finish routine
Two points symbol placement for TREE

Three points for building PAD

Two point tree with drip line

**Pulldown Menu Location:** Draw > Symbols

**Keyboard Command:** multisym

**Prerequisite:** Field to Finish file (.FLD) with codes defined with Multi-Point Symbols

**File Name:** \lsp\finish.arx

---

**Hatch**

**Function**

This command allows you to fill an enclosed area or selected objects with a hatch pattern.

The Hatch command first defines the boundaries of the area you want to hatch, either by computing a region or polyline boundary from a specified point within an enclosed area, or by using selected objects as boundaries. It then fills the boundaries with a hatch pattern or a solid color. You can create an associative hatch, which updates when its boundaries are modified, or a nonassociative hatch, which is independent of its boundaries. You can preview any hatch and adjust the definition.

Due to the large number of combinations of geometry that you can hatch, editing hatched geometry can produce unexpected results. In this event, delete the hatch object and rehatch.
The Boundary Hatch dialog box defines the boundary, pattern type, pattern properties, and attributes for hatch objects. Use the Quick Tab to work with hatch patterns and quickly create a hatch. Use the Advanced Tab to customize how TakeOff creates and hatches boundaries.

1 Under the Quick Tab you define the appearance of the hatch pattern to be applied.

- **Type:** This field sets the pattern type.
- **Pattern:** This field lists the available predefined patterns. The six most recently used predefined patterns appear at the top of the list. The Pattern option is available only if you set Type to Predefined.
- **[...]:** This button displays the Hatch Pattern Palette dialog box, in which you can view preview images for all predefined patterns at once to help you make a selection.
- **Swatch:** This field displays a preview of the selected pattern. You can click the swatch to display the Hatch Pattern Palette dialog box.
- **Custom Pattern:** This field lists the available custom patterns. The six most-recently used custom patterns appear at the top of the list. The Custom Pattern option is available only if you set Type to Custom.
- **Angle:** This field specifies an angle for the hatch pattern relative to the X axis of the current UCS.
- **Scale:** This option expands or contracts a predefined or custom pattern. This option is available only if you set Type to Predefined or Custom.
- **Relative to Paper Space:** This option scales the hatch pattern relative to paper space units. Using this option, you can easily display hatch patterns at a scale that is appropriate for your layout. This option is available only from a layout.
- **Spacing:** This option specifies the spacing of lines in a user-defined pattern. This option is available only if you set Type to User Defined.
- **ISO Pen Width:** This option scales an ISO predefined pattern based on the pen width you choose. This option is available only if you set Type to Predefined and set Pattern to one of the available ISO patterns.

2 Under the Advanced Tab you define how TakeOff creates and hatches boundaries.
• Island Detection Style: This option allows you to specify the method for hatching objects within the outermost hatch boundary. If no internal boundaries exist, specifying an Island Detection style has no effect. Because you can define a precise set of boundaries, it's often best to use the Normal style.

The illustrations that accompany each style show how the program hatches a group of three nested boundary objects in each case.

Normal

Hatches inward from the outer boundary. If the program encounters an internal intersection, it turns off hatching until it encounters another intersection. Thus, areas separated from the outside of the hatched area by an odd number of intersections are hatched, and areas separated by an even number of intersections are not.

Outer

Hatches inward from the outer boundary. The program turns hatching off if it encounters an internal intersection. Because this process starts from both ends of each hatch line, the program hatches only the outermost level of the structure and leaves the internal structure blank.

Ignore

Ignores all internal objects and hatches through them.

Hatching concave curves with the Outer and Ignore styles can cause hatching discrepancies.
The Normal, Outer, and Ignore options are also available from a shortcut menu by right-clicking in the drawing area while you specify points or select objects to define your boundaries.

- **Object Type**: This option allows you to specify whether to retain boundaries as objects, and specifies the object type TakeOff applies to those boundary objects. Object Type controls the type of the new boundary object. TakeOff creates the boundary as a region or a polyline. This option is available only if you select Retain Boundaries.

- **Retain Boundaries**: This option adds the temporary boundary objects to the drawing.

- **Boundary Set**: This field defines the set of objects TakeOff analyzes when defining a boundary from a specified point. The selected boundary set has no effect when you use Select Objects to define a boundary. By default, when you use Pick Points to define a boundary, the program analyzes all objects visible in the current viewport. By redefining the boundary set, you can disregard certain objects when defining boundaries without having to hide or remove those objects. For large drawings, redefining the boundary set can also produce the boundary faster because the program examines fewer objects.

- **New**: This option prompts you to select the objects that define the boundary set. When you choose this option, the dialog box temporarily closes, prompting you to select objects. TakeOff includes only the hatchable objects you select when it constructs the new boundary set. TakeOff discards any existing boundary set, replacing it with the new boundary set defined by the objects you select. If you don't select any hatchable objects, the program retains any current set. Until you exit the Hatch command or create a new boundary set, TakeOff ignores objects that do not exist in the boundary set when you define your boundaries using Pick Points.

- **Island Detection Method**: This option allows you to specify whether to include objects within the outermost boundary as boundary objects. These internal objects are known as islands.

- **Flood**: This option includes islands as boundary objects.

- **Ray Casting**: This option runs a line from the point you specify to the nearest object and then traces the boundary in a counterclockwise direction, thus excluding islands as boundary objects.

3 In the Boundary Hatch dialog box, you set the options the define the selection set.

- **Pick Points**: This option determines a boundary from existing objects that form an enclosed area. How TakeOff detects objects using this option depends on the selected Island Detection Method on the Advanced tab. For example, if the Island Detection Method is Flood, the program detects objects within the outermost boundary as islands and includes them in the boundary definition. The Island Detection Style (which you also set on the Advanced tab) then determines how to hatch the detected islands. When you choose Pick Points, the dialog box closes temporarily, and the program prompts for point specification.

- **Select Objects**: This option allows you to select specific objects for hatching. The dialog box closes temporarily, and the program prompts you for object selection. When you define your boundaries using Select Objects, the program does not detect interior objects automatically. You must select the objects within the selected boundary to hatch those objects according to the current Island Detection Style (which you set on the Advanced tab). Each time you choose Select Objects, the program clears the previous selection set. While selecting objects, you can right-click at any time in the drawing area to display a shortcut menu. You can undo the last or all selections, change the selection method, change the island detection style, or preview the hatch.

- **Remove Islands**: This option removes from the boundary definition any of the objects that the program detects as islands when you use Pick Points. You cannot remove the outer boundary.

- **View Selections**: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the hatch settings that you last previewed. This option is unavailable when you have not yet specified points or selected objects.

- **Inherit Properties**: This option hatches specified boundaries using the hatch properties of one object. After selecting the associative hatch object whose properties you want the hatch to inherit, you can right-click in the
drawing area and use the shortcut menu to toggle between the Select Objects and Pick Internal Point options to create boundaries.

- Double: For user-defined patterns, this option draws a second set of lines positioned at 90 degrees to the original lines, creating a crosshatch. This option is available only if you set Type to User Defined on the Quick tab.
- Associative: This option creates an associative hatch, meaning that the hatch is updated when you modify its boundaries.
- Nonassociative: This option creates a nonassociative hatch, meaning that it is independent of its boundaries.
- Preview: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the current hatch settings. This option is not available when you have not yet specified points or selected objects to define your boundaries.

Prerequisite: None

Keyboard Command: BHATCH

 equivalents

Raster Image

Function

This command allows you to manage raster images.

The Image Manager dialog box lists all the image files attached to the current drawing. You can view the parameters and details for selected images. You can attach new image files and detach, locate, reload, and unload existing images.

- List View: This button lists the image definitions attached to the drawing. Each image name appears only once regardless of how many times you attach (insert) the image. You can sort the list of images by name, status (loaded, unloaded, or not found), size, type (TIFF, for example), date, or the saved path and file name. By default, TakeOff displays the list alphabetically by image name.

To select multiple images, hold down SHIFT or CTRL while selecting items.

To sort the list alphabetically or numerically by a specific column, click that column's heading.
To change the width of the column, drag the line between the column headings to the right or left. The program saves and restores the settings when you reopen the dialog box.

To change an image name, select it and then click it again, or select it and then press F2. You cannot edit names of images that reside in external references (xrefs). Image names can include up to 255 characters and can contain letters, digits, spaces, and any special characters not used by Microsoft® Windows® or TakeOff. The image name can be identical to the file name, but changing the image name does not change the file name.

- Tree View: This button displays all the image definitions and the levels of nesting of images within xrefs. The top level of the tree view shows images that you attached directly to the drawing, images nested in block references, and the names of externally referenced drawings containing images. The names of the images attached to the externally referenced drawings appear nested within the drawing at the next tree level. To insert a copy of an already attached image, select it, and then choose Attach.

Tree view lists the image names only (not file names) and lists the image name just once, regardless of how many times you attach (insert) the image.

You can edit an image name by selecting it and then clicking it again, or by selecting it and then pressing F2. However, you cannot select more than one image at a time.

- Attach: This option displays the Select Image File dialog box. When you unload and then reload an image, the program draws that image on top. Images remain loaded or unloaded from one drawing session to the next.
- Detach: This option removes the selected image definitions from the drawing database and erases all the associated image objects from the drawing and from the display.
- Reload: This option loads the most recent version of an image or reloads an image that was previously unloaded. Reloading does not control whether the image is displayed, but it ensures display of the most current image.
- Unload: This option unloads image data from working memory without erasing the image objects from the drawing. It is recommended that you unload images no longer needed for editing to improve performance. An unloaded image cannot be displayed or plotted. You can selectively load and unload individual images from a working list of images associated with the drawing file.
- Details: This option opens the Image File Details dialog box, which displays the image name, saved path, active path, file creation date and time, file size and type, color system, color depth, width and height in pixels, resolution, default size in units, and a preview image.
- Image Found At: This field shows the path of the selected image. If you select multiple images, this field remains blank. The path shown is the actual path where the image resides.
- Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). The path you select appears under Image Found At.
- Save Path: This option stores the new path information. Press ESC while editing the path to restore the old path. If the program cannot find the referenced image in the new path, the image's status changes to Not Found. If you do not choose Save Path after editing the path, the program uses the original image path the next time you load the drawing.

2 Under the Image dialog box, you can attach an image.
3 In the Image dialog box, you must first identify the image and the path.

- **Name:** This field identifies the image you have selected to attach, either from the Select Image File dialog box (an unattached image) or from the list of previously attached images. To add another instance of an image file that is already attached, select the image name from the list and choose OK.

- **Browse:** This option opens the Select Image File dialog box (a standard file selection dialog box). If Show Preview is selected, the program displays a preview of the selected file.

- **Retain Path:** This option saves the path of the image file with the image definition. If Retain Path is not selected, only the image name is saved and TakeOff searches the Support File Search Path.

4 Under Insertion Point, you must specify the insertion point for the selected image. Specify On-Screen is the default. The default insertion point is 0,0.

- **Specify On-Screen:** This option directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and Z.

- **X:** This field sets the X coordinate value.

- **Y:** This field sets the Y coordinate value.

- **Z:** This field sets the Z coordinate value.

5 Under Scale, you must specify the scale factor of the selected image. Specify On-Screen directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor. The default scale factor is 1.

6 Under Rotation, you must specify the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value on the command line. If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

**Prerequisite:** Raster image

**Keyboard Command:** IMAGE

**Place Image by World File**

**Function**
This function allows you to insert Geo-Referenced TIF files into AutoCAD drawings. This process requires the presence of an accompanying TFW file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

**Prompts**

**Select World File:** choose existing .TFW or .JGW file  
**Keyboard Command:** geotiff  
**Prerequisite:** None

---

**Draw By Example**

This command prompts you to pick an entity and then starts the appropriate draw command to begin creating another one of the selected type of entity. The properties such as layer and color of the original entity are used for creating the new one. For example, if you pick a polyline, this command will start the **Pline** command. Likewise if you pick text, this command will begin the **Text** command using the layer and style of the selected text.

**Prompts**

**Pick Object for Command:** pick an entity  
The remaining prompts depend on the type of the selected entity.

**Pulldown Menu Location:** Draw  
**Keyboard Command:** drawbyex  
**Prerequisite:** Entities  
**File Name:** \lsp\drawbyex.lsp

---

**Sequential Numbers**

This command draws a text label and then increments to the next value for additional labels. The label and optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size. First, pick one of the seven formats.
Specify the **Text Size** (height). Defaults to size set in *Drawing Setup.*

Specify the **Text** label.
Specify an optional text **Prefix**.
Specify an optional text **Suffix**.
When **Auto Increment Labels** is checked, the value entered in the Text field will be incremented by the value in the Increment field.
When **Prompt for Alignment Every Time** is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels.
If Auto Increment Labels is checked, Text value is incremented by the **Increment** value.

The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.

**Prompts**

**Select Symbol for Numbers dialog** select your symbol  
**Sequential Numbering Options dialog** make your choices  
**Pick point at beginning of label**: pick a point  
**Pick point for label alignment**: pick a point to the right of the first point  
**Pick point at beginning of label**: press Enter to end the routine  

**Pulldown Menu Location**: Draw  
**Keyboard Command**: numbers  
**Prerequisite**: None  
**File Name**: \lsp\cir_num.lsp

**Arrowhead**

This command draws an arrowhead at the end of the selected line or polyline.

**Prompts**

**Enter the arrow size <5.00>:** press Enter  
**Pick a line or pline to add arrow**: pick a line or polyline  
**Pick a line or pline to add arrow (Enter to End)**: press Enter

**Pulldown Menu Location**: Draw  
**Keyboard Command**: arrowhd  
**Prerequisite**: None  
**File Name**: \lsp\scadutil.arx

**Curve - Arrow**

Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point.
The arrowhead size is determined by the AutoCAD system variable "DIMASZ". In order to change this size, type DIMASZ at the AutoCAD command prompt. This routine also has a Zorro option which creates a Z leader curve.

**Prompts**

Create a Zorro (Yes/<No>?)? N  
Include an arrow (Yes/<No>?)? Y  
Enter the arrow head size <4.00>: press Enter This defaults to the DIMASZ system variable.  
Pick a starting point: pick a point  
Pick an ending point: pick a point  
Pick an intermediate point (U to Undo): pick a point  
Pick an intermediate point (U to Undo): press Enter

Examples of Curve - Arrow

Pulldown Menu Location: Draw  
Keyboard Command: carrow  
Prerequisite: None  
File Names: \lsp\cir_num.lsp, \lsp\scadutil.arx

**Boundary Polyline**

This is a streamlined analog of the AutoCAD command *Boundary*. The Carlson version is faster and works in many cases where *Boundary* fails. *Boundary Polyline* supports a snap tolerance, which means that you may specify a maximum gap to close when creating a closed polyline.

To create closed polylines from any existing linework, simply select all entities you would like to use and specify desired snap tolerance. Then click inside openings you would like to trace and the routine will generate corresponding closed polylines. The duplicate polylines are detected and not created, so that clicking more than once in the same area does not change anything. These new polylines are always created in the current layer. Layers of the original linework do not matter.

**Prompts**

Select polylines: pick an entities to be used  
Enter snap tolerance or press Enter for none:  
Pick an internal point: pick the points to enclose
These three polylines are created from original linework by clicking at shown locations

**Pulldown Menu Location:** Draw  
**Keyboard Command:** boundpl  
**Prerequisite:** Entities  
**File Names:** \lsp\scbpoly.arx

### Shrink-Wrap Entities

This command creates a closed polyline which encloses a given set of entities. The resulting polyline is created in the current layer. The program works on either point entities or polylines. For points, the program creates a closed polyline through the points around the perimeter of the area defined by the points. For polylines, the shrink-wrap polyline follows the outside border of the selected polylines. The polylines that are processed have to be connected to be shrink-wrapped. The snap tolerance is the maximum gap that will be joined to make the closed polyline. For open polylines, as in the bottom figure, the Gap method works better, as it jumps across the gaps and connects the end points.
Prompts

Shrink-wrap across gaps or bounded linework only [<Gap>/Bound]? G
Shrink-wrap layer <FINAL>:
Select points and linework to shrink-wrap.
Select objects: select entities to process
Reading points... 46
Inserted 46 points.
Inserted 23 breakline segments
Perimeter reduction level 0-3 (0-None, 3-Most) <2>: 2
Reduce Perimeter Pass: 1 Removed: 5
Reduce Perimeter Pass: 2 Removed: 3
Reduce Perimeter Pass: 3 Removed: 4
Reduce Perimeter Pass: 4 Removed: 2
Reduce Perimeter Pass: 5 Removed: 1
Reduce Perimeter Pass: 6 Removed: 0
Create 2D or 3D Polyline [<2D>/3D]? 2D

Pulldown Menu Location: Draw
Keyboard Command: swplines
Prerequisite: Entities
File Name: \lsp\scbpoly.arx

Polyline by Nearest Found

This command draws a polyline by connecting points using a nearest found method. The points to connect can be specified either by entering point numbers or picking POINT entities on the screen. The nearest found method
draws a polyline by starting at one of the points and then connecting to the closest of the remaining points. Then a remaining point that is closest to one of the polyline end points is added until all points are part of the polyline.

**Prompts**

Create 2D polyline at zero elevation or 3D polyline [<2d>/3d]? press Enter
Select point from screen or by point number (<Screen>/Number)? press Enter
Select points.
Select objects: pick points

**Drawing Block**

**Function**

This command allows you to create a block definition from objects you select.
1 In the Block Definition dialog box, you must first name the block. The Name field, names the block. The name can have up to 255 characters and can include letters, numbers, blank spaces, and any special character not used by Microsoft® Windows® and Carlson Survey for other purposes. The block name and definition are saved in the current drawing. You cannot use DIRECT, LIGHT, AVE_RENDER, RM_SDB, SH.SPOT, and OVERHEAD as valid block names.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.
   • X: This field specifies the X coordinate value.
   • Y: This field specifies the Y coordinate value.
   • Z: This field specifies the Z coordinate value.
   • Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.
   • Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
   • Convert to Block: This option converts the selected objects to a block instance in the drawing after you create the block.
   • Delete: This option deletes the selected objects from the drawing after you create the block.
   • Select Objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
   • Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
   • Objects Selected: This option displays the number of selected objects.

4 Under Preview Icon, you determine whether to save a preview icon with the block definition and specify the source of the icon.
   • Do Not Include an Icon: This option specifies that no icon is created.
• **Create Icon from Block Geometry**: This option creates a preview icon to be saved with the block definition from the geometry of the objects in the block.

5 In the Block Definition dialog box, you must describe and link the block.

• **Insert Units**: This field specifies the units to which the block is scaled when it is inserted.

• **Description**: This field specifies the text description associated with the block definition.

• **Hyperlink**: This button opens the Insert Hyperlink dialog box, which you can use to associate a hyperlink with the block definition.

**Menu Location**: Draw  
**Prerequisite**: Drawing entities.  
**Keyboard Command**: BLOCK

## Write Block

### Function

This command allows you to write objects or a block to a new drawing file.

![Write Block dialog box](image)

The Write Block dialog box displays different default settings depending on whether nothing is selected, a single block is selected, or objects other than blocks are selected. For example, if you have a single block selected when you open the Write Block dialog box, the Source radio button is set to Block.

1 Under **Source**, you write selected blocks and objects out as a file, and specify insertion points.

• **Block**: This option specifies an existing block to save as a file. Select a name from the list.

• **Entire Drawing**: This option selects the current drawing as a block.
• Objects: This option specifies objects to be saved as a file.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.
• X: This field specifies the X coordinate value.
• Y: This field specifies the Y coordinate value.
• Z: This field specifies the Z coordinate value.
• Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.
• Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
• Convert to block: This option converts the selected objects to a block instance in the drawing after you create the block.
• Delete from drawing: This option deletes the selected objects from the drawing after you create the block.
• Select objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
• Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
• Objects Selected: This option displays the number of selected objects.

4 Under Destination, specify the name, location, and unit value used for the objects in the file.
• File Name: This field specifies a file name that the block or objects will be saved to.
• Location: This field specifies the drive and directory path for the file.
• Insert Units: This field specifies the unit value to be used when the new file is inserted as a block. Enter 0 (zero) if you do not want to scale the drawing to a specific value as you insert it.

Prerequisite: Drawing entities

Keyboard Command: WBLOCK

Insert

Function

This command allows you to place a named block or drawing into the current drawing.
1 In the Insert dialog box, you specify the block to insert and define the position for the inserted block. The last block you insert during the current editing session becomes the default block for subsequent uses of this command.

- Name: This field specifies the name of a block to insert or the name of a file to insert as a block.
- Browse: This button opens the Select Drawing File dialog box (a standard file selection dialog box) where you can select a block or a file to insert.

2 Under Insertion Point, you specify the insertion point for the block.

- Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
- X: This field sets the X coordinate value.
- Y: This field sets the Y coordinate value.
- Z: This field sets the Z coordinate value.

3 Under Scale, you specify the scale for the inserted block. Specifying negative values for the X, Y, and Z scale factors inserts a mirror image of a block.

- Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
- X: This field sets the X coordinate value.
- Y: This field sets the Y coordinate value.
- Z: This field sets the Z coordinate value.
- Uniform Scale: This option specifies a single scale value for X, Y, and Z coordinates. A value specified for X is also reflected in the Y and Z values.

4 Under Rotation, you specify the rotation angle for the inserted block.

- Specify On-Screen: This option specifies the rotation angle of the block using the pointing device.
- Angle: This field sets a rotation angle for the inserted block.

5 You can explode the block and inserts to the individual parts of the block. When you select Explode, you specify only an X scale factor.

**Prerequisite:** None

**Keyboard Command:** DDINSERT
Inquiry Menu

Shown here is the Carlson Inquiry menu. The top section contains detailed inquiry commands. The lower section of the menu includes report and file editing commands.
**List**

**Function**

This command lists the object type, object layer, and \(X, Y, Z\) position relative to the current user coordinate system (UCS) and whether the object is in model space or paper space.

The List command reports color, linetype, and linewidth information if these items are not set to BYLAYER. The thickness of an object is displayed if it is nonzero. \(Z\) coordinate information defines the elevation. If the extrusion direction of the entry differs from the \(Z\) axis \((0,0,1)\) of the current UCS, the List command also reports the extrusion direction in UCS coordinates. The List reports additional information related to the specific object selected.

**Prompts**

Command:
LIST
Select objects: 3 found, 1 group

Select objects:

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F3D
Group = *A1
"SPT4"
at point, \(X=6135023.7190\) \(Y=2190074.2098\) \(Z= 800.0000\)
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F4D
Group = *A1
"SRVPO1"
at point, \(X=6135023.7190\) \(Y=2190074.2098\) \(Z= 800.0000\)
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

ATTRIBUTE Layer: "PNTNO"
Space: Model space
Handle = 1F4E
Style = "PTXT"
Font file = TXT
center point, \(X=6135023.7190\) \(Y=2190077.9598\) \(Z= 800.0000\)
height 5.0000

*Chapter 8. Inquiry Menu* 302
Prerequisite: an entity

Keyboard Command: LIST

Point ID
This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

Prompts

Pick point or point number: 255

PointNo. Northing(Y) Easting(X) Elev(Z) Description
255 4379.83 4265.48 19.01 GROUND/SHOT
N: 4379.83 E: 4265.48 Z: 19.01
PT#: 255 CRD File: c:\Carlson2008\data\mantopo.crd

Pulldown Menu Location: Inquiry
Keyboard Command: PT_ID
Prerequisite: None
File Name: \lsp\pt_id.lsp

Layer ID
This command reports the layer name of the selected entity.

Prompts
Layer Report

This command generates a report containing each layer name, the number of entities on each layer, the color and the linetype applied to each layer.

![Layer Report Image]

Layer Inspector

This command is used to inspect and work with layers in the drawing. This command is ideal when you are working on a very dense and complex drawing which has many layers and you want to review the entities on different layers. In some cases, there will be layers that you would want to erase. Another scenario might be that you’d like to highlight a layer that is hard to find and see.

The Layer Inspector command has a dialog that docks to the bottom of the drawing window which keeps the drawing window visible while running the command. On the left of the dialog is a list of all the layers in the drawing. To inspect a layer, highlight the layer name from this list. You can inspect multiple layers at a time by selecting multiple layers in the list using the Shift and Ctrl keys while picking in the list. When a layer is selected, the Entity Count reports how many entities in the drawing are set to that layer. The Zoom toggle will...
zoom the drawing window to the extents of the entities on the layer. The Isolate toggle will freeze all other layers. The Highlight toggle will highlight all the entities on the layer. The Restore View On Exit will set the drawing window to the original position when Layer Inspector was started. The magnify and arrow buttons are used to zoom in/out and pan the drawing window. The Rename button allows you to rename the layer. The Erase Entities button will erase all the entities on the layer. The Purge button will purge the layer from the drawing which is only available when there are no entities on the layer. The Current button sets the layer as the current layer for the drawing.

Pulldown Menu Location: Inquiry
Keyboard Command: layer_inspect
Prerequisite: None
File Name: \lsp\contour4.arx

Drawing Inspector

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by picking Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.

<table>
<thead>
<tr>
<th>Keyboard Enter</th>
<th>Exit Menu</th>
<th>Turn Off Drawing Inspector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Layer Name</td>
<td>Display Elevation</td>
<td>Display Azimuth-Distance</td>
</tr>
<tr>
<td>Display Azimuth-Distance</td>
<td>Display Bearing-Distance</td>
<td>Display Point Data</td>
</tr>
<tr>
<td>Display Text Data</td>
<td>Display Curve Data</td>
<td>Display Polyline Data</td>
</tr>
<tr>
<td>Display Polyline Blips</td>
<td>Enable Highlighting</td>
<td>Enable Tag Display</td>
</tr>
<tr>
<td>Show Data On Status Bar</td>
<td>Use Default Cursor</td>
<td>Report In High Precision</td>
</tr>
</tbody>
</table>

In the Drawing Inspector menu, you can choose one or more properties to display.

**Display Layer Name:** Allows you to display the layer name of the entity.
**Display Elevation:** Allows you to display the elevation of the entity.
**Display Azimuth-Distance:** Allows you to display the azimuth and distance of a line.
**Display Bearing-Distance:** Allows you to display the bearing and distance of a line.
**Display Point Data:** Allows you to display the coordinate data of a point.

**Display Text Data:** Allows you to display the attributes of text.

**Display Curve Data:** Allows you to display the radius, arc length, chord length, and delta angle of a curve.

**Display 3D Face Data:** Allows you to display the Z elevations at the face corners.

**Display Polyline Data:** Allows you to display the end point elevations, horizontal distance, slope distance, and slope ratios.

**Display Polyline Blips:** Allows you to display temporary blip plus marks at the vertex locations of polylines.

In the *Drawing Inspector* menu, you can also choose how the property information is reported.

**Enable Highlighting:** Allows you to highlight the object that the *Drawing Inspector* is reporting.

**Enable Tag Display:** Enables you to view the information next to the cursor on the screen.

**Show Data On Status Bar:** Enables you to view the information on the status bar, in the lower corner of the screen.

**Use Default Cursor:** When enabled, only the AutoCAD cursor shows. When disabled, the mouse pointer is also shown.

**Report In High Precision:** When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.

---

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** inspector

**Prerequisite:** None

**File Name:** lsp\autotag.arx

---

**List Elevation**

**Function**

This command displays the elevation of a polyline or line. With a 3D polyline, the elevation of the 3D polyline at the pick point is reported along with the elevation of each vertex. See also, the *Drawing Inspector* command on the *Inq-Set* menu.

**Prerequisite:** an entity

**Keyboard Command:** LSTELEV
Bearing & 3D Distance

This command reports the slope distance, slope ratio, bearing, azimuth and vertical angle between two 3D points. Pick or enter the coordinates of two points or select a line or polyline segment to calculate between the segment endpoints.

Prompts

Specify bearing-distance from (Line/PLinel/<Points>)? press Enter
Pick point or enter point number: pick a point
Pick second point or enter point number: pick a point
Horiz Dist: 233.4 Slope Dist: 233.4 Elev Diff: 0.0 Vert Ang: 0d0'0"
Slope: 0.0% 0.0:1 Bearing: S 71d15'37'' W Azimuth: 198d44'23''

Pulldown Menu Location: Inquiry
Keyboard Command: 3DIST
Prerequisite: None
File Name: \lsp\3dist.lsp

Find Point

This command can be used to find a point in the current CRD file with a certain point number or description. For example, if you entered RAD* the command would plot a preview arrow at all the points that have the letters RAD as part of the description. i.e. RADPT1, RADPT2, RADPT3, etc. This command is not case sensitive (test is considered the same as TEST). Matching points are highlighted on the graphics screen with the preview arrow and listed on the text screen.

Prompts

Find by point [N]umber or [D]escription <N>: press Enter
Point number or range of point numbers to find <1>: 8*10
8 4856.75 4747.20 0.00
9 4909.25 4648.37 0.00
10 4223.30 4545.46 0.00 RADPT

If you respond with D for the first prompt the program prompts:

Conforms to AutoCAD's wild card matching.
Point Description(s) text to search for < >: rad*
Searching file C:\Carlson\DATA\LOT.CRD for point descriptions matching RAD* ...
7 4817.02 4662.73 0.00 RADPT
10 4223.30 4545.46 0.00 RADPT
Point(s) found 2

Pulldown Menu Location: Inquiry
Keyboard Command: fpnt
Prerequisite: None
File Name: \lsp\fpint.lsp
Curve Info

This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts

Define arc by, Points/<select arc or polyline>: select the arc entities
Endpoint: (4923.81 5193.15 0.0)
Other Endpoint: (5168.27 5274.03 0.0)
Radius Point Coords: (5126.6 4990.09 0.0)
Chord Bearing: N 71d41'33'' E
Chord Azimuth: 71d41'33''
Delta angle in radians: 0.9304628295
RoadWay Degree of Curve: 19d57'56''
RailRoad Degree of Curve: 20d4'4'' Chord Crv Length: 265.66 Excess: 1.36
External: 34.13 Mid Ord: 30.50 Tangent: 144.06
Delta: 53d18'42''
Chord: 257.49
Length: 267.02
Radius: 286.97
Display curve data in report viewer [Yes/<No>?] Y

Pulldown Menu Location: Inquiry
Prerequisite: None
Keyboard Command: cinfo
File Name: \lsp\curvinfo.lsp

Chapter 8. Inquiry Menu
Polyline Info

This command reports the length and elevation of the selected polyline or line.

Prompts

**Pick Polyline or Line:** *pick a polyline or line*

Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** polylen

**Prerequisite:** None

**File Name:** \lsp\polylen.lsp

Display-Edit File

This command allows you to edit or review an ASCII/text file. Files are displayed in the *Standard Report Viewer* section of this manual.

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** scedit

**Prerequisite:** A file to edit

**File Names:** \lsp\scedit.lsp, \lsp\scadutil.arx, \lsp\scedit.dcl

Display Last Report

This brings up the last report generated by any Carlson command that uses the standard report viewer.

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** report

**Prerequisite:** A previously viewed report

**File Name:** \lsp\quickkey.lsp

Load Saved Report

This brings up the Report Formatter for the report data file saved previously by the Report Formatter.

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** load_report

**Prerequisite:** A saved report

**File Name:** \lsp\scadutil.arx
Settings Menu

Shown here is the Carlson Software Settings menu. The top section contains the commands most important for setting up the drawing. You should run Drawing Setup prior to beginning your drawing. Additional setup and settings features are found in the middle section. The last section of the menu includes AutoCAD settings commands, including the System Variable Editor.
Drawing Setup

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.

- Specify **English 1in=?ft** or **Metric 1m=?m** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.
- Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1" = 50' is your drawing scale.
- The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Text Plot Size is not entered in Drawing Units. The **Drawing Units** field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.
- **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)
- **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)
- **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)
- **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD **UNITS** command.
• **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the section on Localization under the Coordinate File Utilities command for more information.

• **Distance Scale Factor for Labels and Reports** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be entered directly into the edit box or calculated using the Calculate button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor.

• The **Set Paper** button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.

![Set Paper Dialog](image)

- The **Layout** option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.
- The **Paper Size** option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.
Prompts (for Set Paper)

Pick or Type lower left corner point for border <(5000.00 5000.00 0.0)>: pick a point
Erase existing Set Paper boundary [<Yes>/<No]>? Y This prompt only appears if there is an existing paper boundary in this drawing.
Set Limits [Yes/<No>]? Y If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in LIMITS on the command line and set to Off.
Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.

Pulldown Menu Location: Settings
Keyboard Command: setup
Prerequisite: None
File Names: \lsp\survset.lsp, \lsp\scadenvr.dcl

Set Project/Data Folders

This command sets both the project work folder and the data folder to use as the default folders for your Carlson drawing and data files. The \PROJECT folder typically contain the .DWG and .BAK files, while the \DATA folder typically contains files such as coordinate (.CRD), Field to Finish code definition (.FLD), profile (.PRO) and centerline (.CL) files. This routine also shows you the tree structure of existing folders available on your computer. The first dialog provides you with a choice of three for the Data Folder Setup. The three options are Project Folder, Drawing Folder or Fixed Folder. You will choose one.

Project Folder: This option will make available the two buttons (rectangular boxes) in the middle of this dialog box. These large option buttons are labeled Project Sub-Folders Setup and Data Type Sub-Folders, respectively. Clicking the left-side Project Sub-Folders Setup button will produce a dialog called Project Folders.

In the Project Folders dialog you are able to Add, Rename and Delete folders and sub-folders for your project.
Clicking the Data Type Sub-Folders button on the right-side will produce a dialog that has a spreadsheet look and function. Here you have the ability to define the Data Folders and Sub-Folders by matching them up with the Data Types and Descriptions. Be sure to scroll down, using the scroll tool on the right, to review the dozens of rows of Data Types in the list. You can also edit the sub-folder structure (note the dropdown arrows in the Sub-Folder column) as described above.
Drawing Folder: When this option is clicked, all of the options below become grayed out. The drawings will automatically be stored in the Current Project Folder, and the data files will automatically go into the same folder as the drawing.

Fixed Folder: With the Fixed Folder option, you will "Set" a folder for all of your data to be stored in. The \DATA folder is the default folder, but you can also create and set any folder you would like.
To create a new data folder, for example, first note the Current Data Folder section at the bottom of the dialog box, and notice the Set button to the right. Click Set. A new dialog appears that will allow you to select the data folder of your choice. Here, you can create or remove any folder.

If you choose Create Directory, the program will prompt you for the new directory name. The Remove Directory button allows you to delete directories that have no files inside. After you have made your choices, click OK.

**Pulldown Menu Location:** Settings > Project  
**Keyboard Command:** settmpdir  
**Prerequisite:** None

### Drawing Explorer

The Drawing Explorer command presents a list of all Carlson data files that are made in association with a drawing. The knowledge of these files is contained in the .INI file that shares the drawing name (e.g. Estates.dwg, Estates.ini). If a drawing was not made in Carlson or does not have a companion .INI file, then Drawing Explorer will display "No Files". In *Configure > General Settings*, if Save Drawing INI Files is clicked off, then Drawing Explorer will again display "No Files". Drawing Explorer will also not show any data files where the drawing name starts with the seven letters "Drawing". Using any other file name, once data files are created such as a coordinate (.CRD) file, then Drawing Explorer will track these files in the order that they are created. Drawing Explorer helps manage drawing-related data.

**Example 1**

If we are working in a drawing called Estates.dwg and create a coordinate file Estates.crd, then later create a second coordinate file called Estates-GPS.crd, Drawing Explorer would display the following:

The coordinate file created or modified last appears at the top of the list. All data files are displayed in the order of most recent to oldest. If the Estates.crd file is set as current by the command *Set Coordinate File*, then added to or
revised, Estates.crd will move to the top of the list. Thus old, relatively unused files will gravitate to the bottom of the list.

Files are displayed by category. So far, we have only the Coordinate Files category. There are also Raw Field Note files (.RW5), profiles (.PRO), section files (.SCT) - in fact dozens of file type categories that will display once these files are actually created.

If a data file is selected and highlighted, the Up and Down keys will become enabled, and the user can move files up to the top of the list or otherwise alter their position. The position of files affects only the reporting of the files using the Report option in the lower left of the dialog. When highlighted, a file can be removed from the list (but it won't be deleted from the hard drive!). The Add option will add other older or non-referenced data files to the list of files associated with the drawing.

Example 2

As we do more work in the file Estates.dwg, data files will begin to proliferate and will appear in Drawing Explorer. Shown below is a more comprehensive list of files, with occasional examples of multiple files within the same category. Categories themselves float to the top of the list if any of their data files have been used more recently than data files in other categories.

Note that there is even a Miscellaneous Files category, that includes ASCII point files created by the command Export Text/ASCII File.

When many data files are involved, the Report option becomes very useful. Here you can use the Report Formatter to display, in any order, the File Name, File Type, Date last modified, Time last modified, Size in bytes, and whether it is Found (e.g. exists) in the specified directory. For example, if a file was created in a certain directory but moved using Windows Explorer to another directory without being further altered in Carlson, it would show up here as not found. (“No” would appear in the Found column).

Shown here is a summary of our data files by size, with reporting of the found status. In this case, the Estates.Lot
file has been moved or deleted.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g. File type first, File name second, etc.). Click the Display button (not shown above) that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.

A deleted or missing file such as Estates.Lot will appear in Drawing Explorer with a special red [no entry] symbol as shown here.
Pulldown Menu Location: Settings > Project
Keyboard Command: dwgxplore
Prerequisite: None
File Name: \lsp\gisutil.arx

**Project Explorer**

This tool is used for management of a complete project. A project can contain numerous drawings, and each drawing within that project can contain numerous related files.

Think of the *Project Explorer* as the trunk of the hierarchical tree structure that develops into a project. While within each drawing, Carlson keeps track of the files that you create (such as grids and coordinates). These are related to the drawing and you can use *Drawing Explorer* to manage them. When management reaches the top level, the *Project Explorer* is used to tie these together.

**Prompts**

When you initiate the *Project Explorer*, you will be prompted to select an existing or create a new Project File. Project files end in the PRJ extension. Once a project file is open, the following dialog will appear.
Add: When you choose the Add button, you are prompted to select a drawing file to add to the project. The selected drawing file is added to the project tree along with any files related to the drawing.

Remove: When any branch of the tree structure (except the top root) is selected, it is removed. Keep in mind that removing any node of a tree structure removes all nodes under it.

Up/Down: When you select a branch of the tree structure that can be moved, the Up and Down buttons become available. This allows you to rearrange the items vertically.

Report: This option displays the Report Formatting Options for formatting the report of the Drawing Explorer (see Drawing Explorer).

When you choose the Add button you will be presented with a dialog to select a drawing to add to the project. Once a drawing is selected, it will be added to the project tree along with any files related to the drawing.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g. File type first, File name second, etc.). Click the Display button that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.
Pulldown Menu Location: Settings > Project
Keyboard Command: prjxplore
Prerequisite: None
File Name: \lsp\gisutil.arx

Store Project Archive

This command will zip and archive an entire project. The archive contains the drawing file (.dwg) and all the associated data file such as the surfaces. The data files associated with the current project can be reviewed with the Drawing Explorer command. The format of the archive file is a standard .zip file which can be used by WinZip. This file can be sent to someone who can unzip it and use all the same files. If the drawing hasn't been saved recently, the following window appears first.
Pulldown Menu Location: Settings > Project
Keyboard Command: zip_project
Prerequisite: A project file
File Name: \lsp\contour4.arx

Extract Project Archive

This command will unzip an archive file that has been previously created with the command Store Project Archive. It prompts for the directory to unzip to. If any of the files already exist in the folder it is extracting to, there is a window prompting to overwrite the files.
Pulldown Menu Location: Settings > Project
Keyboard Command: unzip_project
Prerequisite: A project file that has been zipped (ZIP)

Preferences

Function

This command opens the Options dialog box where you can customize the settings in CSI related to the CAD engine. Some settings are available in this command that are not applicable to CSI, these settings are not documented below.

Files Tab

Under the Files Tab, you specify the directories in which the program searches for support, driver, menu, and other files. Generally, you will never need to modify any of the settings found here. Advanced users may want to view/modify the following:
• Automatic Save File Location: This is the location that CSI will save drawings when it performs an automatic save.

• Temporary Drawing File Location: This is the location that CSI writes and stores any temporary drawings during the current drawing session.

**Display Tab**

Under the Display Tab, you specify settings related to the graphics and text display.

1 **Window Elements**
   - **Display scroll bars in drawing window**: Specify whether or not to show the scrollbars in the drawing window.

2 **Display resolution**
   - **Arc and circle smoothness**: Controls the smoothness of circles, arcs, and ellipses. A higher number produces smoother objects, but CSI requires more time to regenerate, pan, and zoom the objects. The default setting is 100, and the maximum setting is 20000
   - **Segments in a polyline curve**: Sets the number of line segments to be generated for each polyline curve. The default setting is 8.

3 **Display performance**
   - **Apply solid fill**: Specify whether or not to show fill for hatches and wide polylines.
   - **Show text boundary frame only**: Displays the frames for text objects instead of displaying the text objects

4 **Crosshair size**: Specify the crosshair size in percentage of screen size.

5 **Layout elements**: These options are not applicable to CSI
Open and Save Tab

1 File Save

- **Save as**: Specify the file formats used when saving a file with SAVE and SAVEAS.
- **Save a thumbnail preview image**: Specifies whether an image of the drawing should be displayed in the Preview area of the Select File dialog box.
- **Incremental save percentage**: Sets the percentage of potential wasted space in a drawing file. When the specified percentage is reached, CSI performs a full save instead of an incremental save. Full saves eliminate wasted space. If you set Incremental Save Percentage to 0, every save is a full save.

2 File Open

- **Number of recently used files to list**: Controls the number of recently used files that are listed in the File menu for quick access. Valid values are 0 to 9.
- **Display full path in title**: Displays the full path of the active drawing in the drawing’s title bar, or in the CSI title bar if the drawing is maximized.

3 File Safety Precautions

- **Automatic save**: Saves a copy of your drawing automatically at the interval you specify. See Automatic File Save Location above to specify where the drawing should be saved.
- **Minutes between saves**: Specifies how often the drawing is saved when using Automatic Save
- **Create backup copy with each save**: Specifies whether a backup copy of a drawing is created when you save the drawing. The backup copy is created in the same location as the drawing
- **Maintain a log file**: Specifies whether the contents of the text window are written to a log file. To specify the location and name of the log file, use the Files tab in the Options dialog box
• File extension for temporary files: Specifies a unique extension for the current user to identify temporary files in a network environment. The default extension is .ac$.

4 External References: (These options apply to external referenced drawings, you cannot create external references with CSI, but you can open drawings that have external references).

• Demand Load Xrefs: Controls demand loading of xrefs.
• Retain changes to Xref layers: Saves changes to layer properties and states for xref-dependent layers.

---

**Plotting Tab**

1 Under Default Plot Settings For New Drawings, you control default plotting settings for new drawings.

• **Use As Default Output Device**: Sets the default output device for new drawings. The list displays any plotter configuration files (PC3) found in the plotter configuration search path and any system printers that are configured in the system.

• **Use Last Successful Plot Settings**: Sets the plotting settings according to the settings of the last successful plot.

• **Add or Configure Plotters**: Displays the Autodesk Plotter Manager (a Windows system window). You can add or configure a plotter with the Autodesk Plotter Manager.

2 Under General Plot Options, you control options that relate to the general plotting environment.

• **Keep the Layout Paper Size If Possible**: Uses the paper size specified on the Layout Settings tab in the Page Setup dialog box under the File menu as long as the selected output device can plot to this paper size. If the selected output device cannot plot to this paper size, the program displays a warning message and uses the paper size specified either in the plotter configuration file (PC3) or in the default system settings if the output device is a system printer.

• **Use the Plot Device Paper Size**: Uses the paper size specified either in the plotter configuration file (PC3) or in the default system settings if the output device is a system printer.
• **OLE Plot Quality**: Determines the quality of plotted OLE objects. The values are Line Art, Text, Graphics, Photograph, and High Quality Photograph.

• **Use OLE Application When Plotting OLE Objects**: Launches the application used to create the OLE object when plotting a drawing with OLE objects. You can use this option if you want to optimize the quality of plotted OLE objects. This setting is saved in the drawing. You can also control this option by using the OLESTARTUP system variable.

• **Hide System Printer**: Controls whether Windows system printers are displayed in the Plot and Page Setup dialog boxes under the File menu. This option hides standard Windows system printers only. You can control the size of the list of devices in the Plot and Page Setup dialog boxes by moving a device's PC3 file out of the Plotters directory and its subdirectories.

3 Under Default Plot Style Behavior, you control options related to plot style behavior in all drawings. Changing the default plot style behavior using the Options dialog box does not affect the current drawing.

• **Use Color Dependent Plot Styles**: Uses color-dependent plot styles in both new drawings and drawings created in earlier versions of Autodesk products. Color-dependent plot styles use the numbers from the color index to create a plot style table with a .ctb file extension. Each color is defined by a name or number ranging from 1 to 255. You can assign each color number to a different pen on a pen plotter to achieve different property settings in the plotted drawing. If this option is selected, a plot style is created for each color setting. If you want to change the default plot style behavior for a drawing, select this option or Use Named Plot Styles before opening or creating a drawing. Changing the default plot style behavior using the Options dialog box affects only new drawings or drawings created in an earlier release of an Autodesk product that have never been saved in CSI 2000 format. This setting is saved with the drawing. Once a drawing is saved with either setting, it cannot be changed.

• **Use Named Plot Styles**: Uses named plot styles in both new drawings and drawings created in earlier versions of Autodesk products. CSI plots the drawing according to the property settings you specify in the plot style definition. The plot style is defined in the plot style table attached to the layout or viewport. Named plot style tables are files with the file extension .stb.

• **Default Plot Style Table**: Specifies the default plot style table to attach to new drawings. A plot style table is a file with a .ctb or an .stb extension that includes and defines plot styles. If you are using color-dependent plot styles, this option lists all color dependent plot style tables found in the search path as well as the value of None. If you are using named plot styles, this option lists all named plot styles tables.

• **Default Plot Style for Layer 0**: Sets the default plot style for Layer 0 for new drawings. The list displays the default value Normal and alphabetically displays any plot styles defined in the currently loaded plot style table.

• **Default Plot Style for Objects**: Sets the default plot style that is assigned when you create new objects. The list displays a BYLAYER, BYBLOCK, and Normal style, and it alphabetically displays any plot styles defined in the currently loaded plot style table.

• **Add or Edit Plot Style Tables**: Displays the Autodesk Plot Style Table Manager (a Windows Explorer window). You can create or edit plot style tables with the Autodesk Plot Style Table Manager.
System Tab

1. Current Pointing Device can only be set to Current System Pointing Device. Do not change this setting.

2. General Options include the following:

   - **Single-drawing compatibility mode**: Allows CSI to work with one drawing at a time. Leave this checked.
   - **Display OLE properties dialog**: Controls the display of the OLE Properties dialog box when inserting OLE objects.
   - **Beep on error in user input**: Specifies whether CSI should sound an alarm beep when it detects an invalid entry.
   - **Allow long symbol names**: If this is checked, symbol names such as layers can be 255 characters long.
User Preferences Tab

1 Windows Standard Behavior
   • Windows standard accelerator keys:
   • Shortcuts menus in drawing area:
   • Right-click Customization:

2 Priority for Coordinate Data Entry
   • Running object snap: Specifies that running object snaps override coordinate entry at all times. Not Recommended
   • Keyboard entry: Specifies that coordinate entry overrides running object snaps at all times.
   • Keyboard entry except scripts: Specifies that coordinate entry overrides running object snaps, except in scripts.

3 Object Sorting Methods determines the sort order of objects. Generally speaking, objects are displayed in the order they were created. This means that newer objects will display on top of older objects. Use the Display Order commands on the View menu to change the display order.
Drafting

1 AutoSnap Settings

- **Marker**: Controls the display of the AutoSnap™ marker. The marker is a geometric symbol that displays the object snap location when the crosshairs move over a snap point on an object.

- **Magnet**: Sets the AutoSnap magnet on or off. The magnet is an automatic movement of the crosshairs that locks the crosshairs onto the nearest snap point.

- **Display AutoSnap tooltip**: Controls the display of the AutoSnap tooltip. The tooltip is a text flag that describes which part of the object you are snapping to.

- **Display AutoSnap aperture box**: Controls the display of the AutoSnap aperture box. The aperture box is a box that appears inside the crosshairs when you snap to an object.

2 Tracking Settings

- **Display polar tracking vector**: Sets polar tracking behavior on or off. With polar tracking, you can draw lines along angles relative to a drawing command From or To point.

- **Display Tracking tooltip**: Controls the display of the AutoTrack tooltip. The tooltip is a text flag that displays the tracking coordinates.

3 AutoSnap Marker Size allows you to set the display size for the AutoSnap marker. Values range from 1 to 20 pixels.

4 Aperture Size allows you to set the aperture size. The size of the aperture determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. The smaller the aperture, the closer you must be to the snap point to activate the magnet.
Selection Tab

1 Selection Modes

- **Noun/verb selection**: Allows you to select an object before starting a command.
- **Use Shift to add to selection**: Adds or removes an object to the selection set when you press SHIFT and select an object.
- **Press and drag**: Draws a selection window by selecting a point and dragging the pointing device to a second point.
- **Implied windowing**: Initiates the drawing of a selection window when you select a point outside an object.
- **Object grouping**: Selects all objects in a group when you select one object in that group. Control-A also toggles this setting.
- **Associative Hatch**: Determines which objects are selected when you select an associative hatch. If this option is selected, boundary objects are also selected when you select an associative hatch.

2 Grips

- **Enable Grips**: Controls whether grips are displayed on an object after you select it.
- **Enable Grips within blocks**: Controls how grips are displayed on a block after you select it.
- **Unselected grip color**: Determines the color of an unselected grip.
- **Selected grip color**: Determines the color of a selected grip.

3 Pickbox Size controls the display size of the pickbox. The pickbox is the object selection tool that appears in editing commands. The default size is set to 3 pixels; values range from 0 to 20.

4 Grip size controls the display size of grips. The default size is set to 3 pixels; values range from 1 to 20.
Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing. These settings are stored in files called Carlson.INI, COGO.INI, SCTPRO.INI, DTM.INI, HYDRO.INI, and MINE.INI in the Carlson USER directory. Configure will restore the current drawing settings to these default settings. These global settings can be saved and loaded on a new computer, or for a new installation of Carlson.

The settings for the modules apply to the commands within those modules. Refer to the associated manual chapters for additional descriptions of these settings. Under General Settings there are options that apply to all modules. Many of these options are only accessed in Configure, and will be described here.
Use Startup Wizard: The Use Startup Wizard controls whether this wizard appears when creating a new drawing.

Generate Report Log: When the Generate Report Log option is on, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Misc menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on and off, you can type REPORT at the command prompt. This function toggles the report log on/off.

Save Drawing INI Files: Save Drawing INI Files will create an .INI with the same name as the .dwg file to store the project data files for the drawing.

Auto Zoom Center for New Points: This option zooms the display to center the new, located point. If it is off, the screen does not center the new point.

Ignore Zero Elevs: This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

Use South Azimuth: Turning on this option will use a South Azimuth instead of a North Azimuth, which is the default.

Use Dview Twist Angle: This will use the screen Twist Angle defined with the AutoCAD command DVIEW. This is similar to Twist Screen.

Set Dimscale to Drawing Scale: This will set the dimension scale to match the drawing scale. By default, it is set to 40.0.

Set PDSIZE to Symbol Size: This will set the PDSIZE scale to match the symbol size defined in Drawing Setup. By default, it is set to 4.0.

Set INSUNITS to Unitless: This will set the INSUNITS (Insertion Units) AutoCAD system variable to Unitless when the drawing is opened.

Point Layer: This is the default layer to draw any new points.

Coordinate Report Order: You can choose the traditional north-east format, or reverse these in reports with east-north.

Date Format: You can control the display of dates in Carlson reports with this dropdown menu. The default is 'Windows Setting' which allows you to control it with Windows Control Panel. Several other common formats are available.

Report Viewer: This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

AutoCAD Menu: This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings->Carlson Menus pull-down menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

Object Linking: The Object Linking section contains options for creating reactors to the drawing entities. The Link Points with CRD File option will attach a reactor to the Carlson point entities so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file. The Link Linework with Points option will attach reactors to line and polyline entities that are drawn by point number so that moving the points will automatically move the linework. The Link Labels with Linework applies to bearing/distance annotation. This link with update
the annotation when the linework is modified. The Group Point Entities option joins the three entities of a Carlson point (attribute block, symbol, node). For each point, selecting any one of these entities selects all three entities for the point. See the Points Menu Commands and Dynamic Annotation sections of the manual for more information about linking.

**Database Format:** The Database Format chooses between Microsoft® Access 97 or 2000 (and higher) format. This database format applies to creating new database (.MDB) files in the GIS module, the drillhole database and the Export to Microsoft® Access option in the Report Formatter.

**CRD File Pt# Format:** Carlson can run live on any of these coordinate file formats. The CRD File Pt# Format option sets point number format for coordinate files as one of the following. Here are the options:

- **Carlson Numeric:** This is the default format upon installation. Point numbers cannot contain letters and must be in the range from 1 to 32767.
- **Carlson Alphanumeric:** This native Carlson format allows letters in the point numbers, and the point name can be up to 10 characters. Any combination of letters and numbers is acceptable.
- **C&G Numeric:** This format of the C&G division supports up to 5 digits, with a 65000 point limit.
- **C&G Alphanumeric:** This format of the C&G division supports up to 10 characters, with no limit to the number of points.
- **Simplicity ZAK:** This is the Simplicity Systems coordinate file format.
- **LDT Points.mdb:** This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is found in a projects \COGO directory. The number limitation is established by the database structure, but is frequently numeric and allows unlimited point numbers.

**Digitizer Puck Layout & View:** There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.

![Digitizer Puck Layouts](image)

**Use Mouse:** This option allows you to use the mouse instead of the digitizer puck for the digitize commands.

**Auto Tablet On for Digitize Commands:** This option will activate the auto tablet when using the digitize commands.

**Drawing Setup:**

The settings under *Drawing Setup* are very similar to the AutoCAD Drawing Setup, which is also shown below for comparison. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings and Vertical Angle Mode.
There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation. This dialog is accessed from the Configure menu choice, using the Localization Settings button.

**Survey Settings:**
There are five different areas for default Survey Settings. These all appear elsewhere in Survey, but if you set them there, they will just apply for that drawing. If you make changes here, it will apply to the current and/or future drawings. Since each is defined elsewhere in the Survey chapter, each is not detailed here, just the dialog for viewing.
Chapter 9. Settings Menu
DTM-Contour Settings:

Most of the DTM-Contour commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

Inverse Distance/LeastSquares Modeling Parameters: The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

Specify Grid Resolution As: There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of
cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

**Grid Precision:** This is the number of decimals that are stored in the grid file.

**Section-Profile Settings:**
This configuration box is used mainly for text and drafting settings. Items such as text size scalers and station types are set here and will apply to the current and/or future drawings. These are very self explanatory and are up to the user to set if something other than the defaults is desired.

![Section-Profile Settings](image)

**Hydrology Settings:**
This section contains only three configuration settings. The first is the format of the stage-storage capacity file. The second is the location of the HEC program files. The third is the SEDCAD directory location, if it is installed on the computer.

![Hydrology Settings](image)
Mine Note Options:
These options are settings for prompting when entering the mine notes. They are simply turned on or off for customized mine note entry.

![Mine Note Entry Options](image)

Mine Settings:
This is the configuration screen for default settings used with the Mining Modules. Each item is detailed below.

![Mining Settings](image)

**Inverse Distance/Least Squares Search Radius, Samples and Quadrants:** The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes in that they use the same settings. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

**SDPS Directory:** This is the directory that the SDPS program (Subsidence Deformation Prediction System) is installed in, if it is on the computer.

**Fill in Missing Strata Above/Below Existing Strata (Seam Stacking/Conformance):** This important setting is used for gridding and modeling from drillholes. It does two things. The first item it controls is to fill in missing
strata. For example, if a drillhole does not go deep enough to penetrate a deep seam, or a drillhole is drilled down in a valley or low spot, it will either fill in (carry the seam through the hole) or pinch it out at the hole. None will not fill it in, meaning it will pinch the seam out at the shallow or partial hole. All will not pinch the seams out at the shallow or partial hole. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The marker bed is the "main" seam and other seams will conform to it. There can be more than one marker seam. There is also a hierarchy for conformance, so if the main marker seam is not present, then the next marker seam in line will prevail.

**Calculate Strata Pinchout and slide bar:** This setting determines if the thickness of a seam is pinchout when it does not occur in a drillhole. Turn it on to activate pinchout. If a seam is not present, it will pinch it out using that drillhole. If it is off, it will carry the seam through the hole where the seam is not encountered. The slide bar determines the distance between the drillholes for pinchout. Near zero will pinch the seam closer to the hole where it does not appear. Non-zero will pinch the seam closer to the drillhole where it does appear. Most of the time, the best "guess" is to leave it in the middle, where it will pinch the seam half way between the holes. It is also recommended to have the pinchout turn on when making thickness grids. This will model the thickness properly. But, when modeling the bottom elevation of a seam, turn OFF pinchout. If it is on, many times it will bring the elevation of the seam up to the next seam to pinch it out. Turning the off for elevation grids will keep them down where they belong. Then just add the thickness and the bottom elevation to obtain the roof elevation grid.

**Process Only Strata with Beds:** This setting is used mostly when duplicate strata appear in a drillhole. It will only model with strata that have a bed name, ignoring those that don't. This useful in a situation where only the KEY strata have a bed name. It will ignore all the NONKEY strata, and just model the KEY strata. This can be used when modeling geology such as lignite or bentonite, where thin seams have bed names and the overburden, partings and interburdens do not.

**Prompt for Advancement Pline for Quantities:** When running the quantity routines in the standard mining module, turning this on will prompt for the Advancement pline for quantities.

**Composite Bed Qualities by Density:** When modeling the quality attributes from drillholes, and they are sampled at multiple intervals, by default, they are averaged by thickness and that one value will be used for gridding. This option will weight the quality attribute by a Density value instead of thickness. The Density attribute needs to be in each drillhole and the name is entered in the box to the right. It is usually DENSITY, and is in pounds per cu. ft or kg/cu m.

**Use Strata Limit Lines:** When using Strata Limit Polylines for modeling, this needs to be turned on or the program will not use them, even if they are on screen. If just this one is on, then you will be prompted to select them for all commands.

**Auto Select All Strata Limit Lines:** Turning this on will automatically select all the Strata Limit Polylines for all commands that use them. They will not have to be selected each time.

**Use 0 Values for Blank Entries in Coal Sections:** When using the Coal Sections in the standard mining module, if a value is blank, this option will assign a 0 value instead of a blank or Null value.

**Report Format for Quantities by Avg/Grid Methods:** This setting determines the report format from the quantity commands in the standard mining module. Standard is the regular text editor. Column puts them in columns in the editor and Formatter will use the powerful Report Formatter.

**Key Material Name:** This is the name of the KEY material you are mining. Enter in COAL or LIMESTONE or GOLD, or whatever ore you are mining.

**Include Strata Name in Bed Composite:** This will add the strata name to the bed name when running the bed composite commands, such as Split Bed by Parameters.
**Startup Options:**
These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.

**Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.

**Carlson 2008 Folder:** This is the folder where Carlson is installed. The Browse button allows for selecting a new file.

**Carlson 2008 Launch Folder:** This is the folder where Carlson will initially look for, and save a drawing file. The Browse button allows for selecting a new file.

**Profile Name:** This is the AutoCAD Profile that will be used when working in Carlson and AutoCAD.

**AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the start up procedure.

**AutoCAD product to run:** This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.

**Localization Options:**
There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

<table>
<thead>
<tr>
<th>Annotate Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area Defaults</td>
</tr>
<tr>
<td>Cogo Design</td>
</tr>
<tr>
<td>Drawing Setup</td>
</tr>
<tr>
<td>DTM and Contour</td>
</tr>
<tr>
<td>General</td>
</tr>
<tr>
<td>Lin/Curve Table</td>
</tr>
<tr>
<td>Minimal Length To Label</td>
</tr>
<tr>
<td>Section Profile</td>
</tr>
<tr>
<td>Stack Label Arc</td>
</tr>
<tr>
<td>Survey Text Defaults</td>
</tr>
</tbody>
</table>

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.
Pulldown Menu Location: Settings
Keyboard Command: config_scad
Prerequisite: None
File Names: \lsp\survini.lsp, \lsp\cogoini.lsp, \lsp\dtmini.lsp, \lsp\mineini.lsp, \lsp\hydroini.lsp \lsp\sctini.lsp, \lsp\cfg_scad.lsp, \lsp\cfg_scad.dcl

Mouse Click Settings

This command can be used to make custom mouse click preferences. It allows you to set the preferred functionality of your mouse wheel and mouse buttons.

The Middle Button Click options apply to a 2-button wheel mouse (with the wheel acting as the middle button) or a 3-button mouse. Choose between using the middle mouse wheel for real-time pan, or to show an Object Snap pop-up menu. The mouse wheel can also be clicked and depressed for panning, and it can be used for zooming in and out by scrolling with the wheel.

In the lower section of the dialog, you can determine how the right mouse button will operate. For the right button, there are different levels of pop-up menus that can be activated. With all these menus off, the right button will be used like Enter on the keyboard.

Pulldown Menu Location: Settings
Keyboard Command: clickset
Prerequisite: None

Toolbars

This command allows you to display and hide toolbars. Click on a toolbar name and press the Show or Hide button.

![Toolbars Image]

- **Show**: Turns on the selected toolbar. If the toolbar is already visible, then this does nothing.
- **Hide**: Turns off the selected toolbar. If the toolbar is already hidden, then this does nothing. If the toolbar is floating, you can also turn it off by clicking the x in the upper right corner.
- **Exit**: Exits this command

Pulldown Menu Location: Settings
Keyboard Command: TBARCFG
Prerequisite: None

Edit Symbol Library

Function

This command allows you to customize the symbol library.

Categories are a way for grouping symbols by type for your own convenience in symbol selection. A new category is added by clicking on the "Add Category" button. An edit field then appears in the tree view on the left and waits for you to enter the category name. The input is finished by pressing the Enter key.

The category may be populated by creating a new symbol from selected entities in the drawing, by specifying drawing (.DWG) files, or by moving existing symbols from one category to another.

To create a new symbol, open a drawing which has the entities to be used in the symbol. The symbol should be drawn at unit size (scale 1:1) because Carlson will scale the symbol by the current drawing scale when the symbol is used. Highlight the category for the symbol and click on the "Create Symbol" button. A dialog appears for entering the new symbol name. Next, specify the file name for the symbol. The file name has a .DWG extension and would usually reside in the Carlson SUP directory, but you may use another path. Then the program will prompt you to select the entities from the drawing for the symbol. An insertion point for the symbol must also be picked.
The "Import Symbols" button brings up a file selection dialog which allows you to select multiple files to be added to the current category (to select multiple files use Shift or Control keys along with the mouse). If the files you select are not in the Carlson SUP directory, the program will offer an option of copying them there. There are also Import Library and Export Library buttons.

By default, the symbol description is the same as file name. The description for the symbol or category name may be changed by highlighting that name and clicking on "Rename" button, the name being edited is then placed into edit mode. To move a symbol into a different category, select the symbol to be moved on the tree and click an "Up" or "Down" button as many times a needed to reach the desired category. The symbols are sorted alphabetically within each category, while categories are remaining in the order placed to allow the more frequently accessed categories be on top.

Note: The symbol library is stored in an ASCII file named symbols.dta in the Carlson \USER directory.

**Pulldown Menu Location:** Settings

**Keyboard Command:** editptsym

**Prerequisite:** None

**File Names:** \lsp\scadutil.arx, \user\symbols.dta

## Title Block

### Function

This command draws a border and title block for the selected sheet size. At the top of the dialog, choose your horizontal scale and sheet size. The *other* choice at the bottom of each list will allow you to add your own scale or size if yours is not listed. Anything added to these lists will be retained for future use. Next, choose either "landscape" or "portrait" format. A blue rectangle next to this choice shows you the difference. Below this, you can choose what layer to draw the border and title block on. The margins to use are specified next at the bottom of the
dialog. On the right hand side of the dialog, you can choose from several title blocks. As you choose each one, a preview will be shown below this list. This routine looks for all drawings named "tblock" in the \SUP directory. If you want to add your own title block, simply create a new drawing (or copy an existing one) in the \SUP directory and give it a name that starts with tblock. Example: tblock22.dwg and tblock-Jones.dwg are both valid names for this routine, but "MyTitleblk.dwg" is not. After you have made all your decisions in the dialog box, press OK. Depending on your current zoom level, your drawing may be zoomed out to allow you to see the entire area that will be covered by the drawing border. At this point, you have the border attached to your cursor and it is waiting for you to pick a point for insertion. As soon as you do this, a secondary dialog will appear for you to fill out the attributes associated with the particular title block you selected.
**Pulldown Menu Location:** Settings

**Keyboard Command:** tblock

**Prerequisite:** Set horizontal scale in Drawing Setup

---

**Chapter 9. Settings Menu**
Mortgage Block

This command draws a personalized title block for a mortgage survey. You may select an 8½" x 11" sheet, an 8½" x 14" sheet, or define your own sheet size. The dialog box allows the user to edit all block information and input unique data for every layout. The mortgage block drawing is called from the mortgage.dwg file located in the \sup directory and can be easily opened and edited within AutoCAD, allowing for the user to alter the size, text, or any other aspect of the drawing to fit the user's particular needs. However, this is usually unnecessary since the original .dwg file places this block for a standard 8 ½ x 11 ratio drawing. In addition to the block, the user can include the inputs and prescribed text for a Flood Note, which is placed in the bottom left hand corner of the drawing. You may also select a custom drawing file for your flood note. All inputs are saved and recalled from a mortgage.ini file located in the \User directory.

The LIMITS of the drawing can be set to the lower left and upper right corners of the border. After the title block is drawn, the contents can be edited using the Attribute Edit command under the Edit menu.

Pulldown Menu Location: Settings  
Keyboard Command: mortgage 
Prerequisite: Set horizontal scale in Drawing Setup 
File Names: \lsp\mortgage.lsp, \sup\mortgage.dwg

Rescale Drawing

This command globally resizes selected text, symbol and block entities within the drawing by comparing the existing drawing scale factor to a new scale factor. Entities are scaled from their individual insertion points. Lines and polylines are not scaled.

Chapter 9. Settings Menu 348
Prompts

Old Horizontal Scale: 20
New Horizontal Scale: 30
Select text, symbols, dimensions and blocks to scale.
Select objects: select objects by window, crossing or by typing "all" at the command prompt, and press Enter
41 found
Select objects: press Enter
Number of symbols and blocks changed > 7
Testing Entity > 41
Number of text entities changed > 20

Pulldown Menu Location: Settings
Keyboard Command: scaledwg
Prerequisite: Drawing entities to be scaled

Set/Reset X-Hairs

Set X-Hairs sets the crosshairs either to align with the selected line or polyline or to a user-specified slope. Reset X-Hairs restores the crosshairs alignment to horizontal.

Pulldown Menu Location: Settings > Crosshairs
Keyboard Commands: setxhairs, resetxhairs
Prerequisite: Line entity
File Names: \lsp\xh.lsp, \lsp\rh.lsp

Tablet Calibrate

This command executes the routine to perform calibration of the digitizer tablet to the drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.
Before proceeding, please refer to the Settings menu, then go to Configure and General Settings. Then look at the Digitizer Puck Layout section for the selection of the correct puck layout.

**Tablet Calibration**

**Known Reference Points** uses two known coordinates for reference points on the drawing. When this option is selected, the fields for coordinate info activate. Enter the known northing and easting values for the reference points from the info on the drawings in the appropriate fields and pick the Pick button. Pick the points from the drawing on the tablet. Furthermore, Carlson saves the coordinates of the two reference points for future calibrations and displays them on the Tablet Calibration Dialog the next time it is accessed, so if you are working in the same drawing, you can use the Known Reference Points method with the saved coordinates to digitize back to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer together.

![Tablet Calibration Dialog](image)

**Drawing Scale with New Reference Points** is very convenient when you don't know the precise coordinates of the entities on your drawing. The user must specify the drawing scale from the plan. This method establishes a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). You then pick the Pick button and pick the point on the drawing to assign the specified coordinate to. The program will compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display in the Tablet Calibration Dialog as Known Reference Points the next time you calibrate the tablet, so you can digitize back to the previous coordinates if you are working on the same drawing, even though you may have moved or rotated your drawing on the digitize board.
Prompts

Tablet Calibration Dialog
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

Pick first reference point: pick a point
Pick second reference point: pick another point

Pull-down Menu Locations: Settings > Tablet Calibration
Keyboard Command: digsetup
Prerequisite: Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Select the puck layout in Configure.

File Name: \lsp\digsetup.lsp

Save/Load Tablet Calibration

A common problem with calibrating maps on a large format digitizer is that if you leave the current drawing session, AutoCAD forgets the tablet calibration. Tablet save can be used to save the calibration when a drawing is taped down properly. This calibration file can be restored at any time later and be accurate so long as the drawing did not move on the tablet.

Save Configuration Procedure:
1) Command: TABSAVE
2) Designate filename (*.TCF) to save configuration into.

Restore Configuration Procedure:
1) Command: TABREST
2) Select filename (*.TCF) to restore configuration from.

Pull-down Menu Location: Settings > Tablet Calibration
Keyboard Commands: tablet1, tablet2
Set UCS to World

Function

This command sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson TakeOff works exclusively in the world coordinate system and there is no way to change this setting. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, use this command to restore the UCS.

**Prerequisite:** None

**Keyboard Command:** UCS_WORLD

Units Control

Function

The Drawing Units dialog box controls coordinate and angle display formats and determines precision.

1 Under Length, you specify the current unit of measurement and the precision for the current units.
   
   - **Type:** This field sets the current format for units of measure. The values include Architectural, Decimal, Engineering, Fractional, and Scientific. The Engineering and Architectural formats produce feet-and-inches displays and assume that each drawing unit represents one inch. The other formats can represent any real-world unit.
   
   - **Precision:** This field sets the number of decimal places for the current units display.

2 Under Angle you specify the current angle format and the precision for the current angle display.
   
   - **Type:** This field sets the current angle format.
   
   - **Precision:** This field sets the precision for the current angle display.
TakeOff uses the following conventions for the various angle measures: decimal degrees appear as decimal numbers, grads appear with a lowercase g suffix, and radians appear with a lowercase r suffix. The degrees/minutes/seconds format uses d for degrees, ' for minutes, and " for seconds, for example:

123d45'56.7"

Surveyor's units show angles as bearings, using N or S for north or south, degrees/minutes/seconds for how far east or west the angle is from direct north or south, and E or W for east or west, for example:

N 45d0'0" E

The angle is always less than 90 degrees and is displayed in the degrees/minutes/seconds format. If the angle is precisely north, south, east, or west, only the single letter representing the compass point is displayed.

- **Clockwise**: This option calculates positive angles in the clockwise direction. The default direction for positive angles is counterclockwise.

When the program prompts for an angle, you can point in the desired direction or enter an angle regardless of the setting specified for Clockwise.

3 Under Drawing Units for TakeOff DesignCenter blocks, you can control the unit of measurement used for block insertions. A block created in units that differ from the units specified in this option is scaled and inserted in the specified units. Select Unitless to insert the block as is and not scale the block to match the specified units. Source content units and Target drawing units settings in the User Preferences tab of the Options dialog box under the Settings menu are used when Insert Units are not defined.

4 Sample Output displays an example of the current settings for units and angles.

Direction displays the Direction Control dialog box described below.

A The Base Angle determines where 0 degrees is located when the program calculates angles. The base angle sets the direction of the base angle. These options affect the entry of angles, object rotation angles, the display format, and the entry of polar, cylindrical, and spherical coordinates. Choose East, North, West, or South, or choose Other to indicate an alternative direction. The default direction for the zero angle is East. In TakeOff, the base angle is relative to the orientation of the user coordinate system.

- **East**: Sets the base angle to east (default is zero degrees).
- **North**: Sets the base angle to 90 degrees north.
- **West**: Sets the base angle to 180 degrees west.
- **South**: Sets the base angle to 270 degrees south.
- **Other**: Sets a direction different from the points of the compass.
- **Angle**: Sets the angle. Available only when Other is selected.
- **Pick an Angle**: Uses the pointing device to define the angle based on the angle of an imaginary line connecting any two points you specify. Available only when Other is selected.

**Prerequisite**: None

**Keyboard Command**: UNITS

### Point Object Snap

When this toggle is turned on, you can move your cursor near a Carlson point and snap to the actual coordinates of the point without having to use the AutoCAD `NODE` snap. Point Object Snap can be used alone to display the point information or it can be turned on and used during other commands. In the example illustration, the 2DP command (2D polyline) has been started and the first point picked was point number 2074. As the cursor nears point number 2067, the point snap marker appears and the point information is displayed, click the mouse and the next polyline vertex will snap to the coordinates of point 2067.

**Pulldown Menu Location**: Settings

**Keyboard Command**: `pointsnap`

**Prerequisite**: None

**File Name**: `\lsp\scadutil.arx`

### Aperture Object Snap

**Function**

The Drafting Settings dialog box sets object snap modes.
1 Under Object Snap, you set object snaps.

- **Object Snap On**: This option turns running object snaps on and off. The object snaps selected under Object Snap Modes are active while object snap is on. This setting is also controlled by the OSMODE system variable.

- **Object Snap Tracking On**: This option turns object snap tracking on and off. With object snap tracking the cursor can track along alignment paths based on other object snap points when specifying points in a command. To use object snap tracking, you must turn on one or more object snaps.

2 Under Object Snap Modes, you turn on running object snaps.

- **Endpoint**: Snaps to the closest endpoint of an arc, elliptical arc, line, multilinie, polyline segment, spline, region, or ray or to the closest corner of a trace, solid, or 3D face.

- **Midpoint**: Snaps to the midpoint of an arc, ellipse, elliptical arc, line, multilinie, polyline segment, solid, spline, or xline.

- **Center**: Snaps to the center of an arc, circle, ellipse, or elliptical arc.

- **Node**: Snaps to a point object.

- **Quadrant**: Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.
• **Intersection**: Snaps to the intersection of an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline. Intersection snaps to the edges of regions and curves, but does not snap to the edges or corners of 3D solids.

Extended Intersection snaps to the imaginary intersection of two objects that would intersect if the objects were extended along their natural paths. Carlson Survey automatically turns on Extended Intersection when you select the Intersection object snap mode. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Intersection and Extended Intersection work with edges of regions and curves, but not with edges or corners of 3D solids.

• **Extension**: Causes a temporary extension line to display when you pass the cursor over the endpoint of objects, so you can draw objects to and from points on the extension line.

• **Insertion**: Snaps to the insertion point of an attribute, a block, a shape, or text.

• **Perpendicular**: Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, solid, spline, or xline. Carlson Survey automatically turns on Deferred Perpendicular snap mode when the object you are drawing requires you to complete more than one perpendicular snap. You can use a line, arc, circle, polyline, ray, xline, multiline, or 3D solid edge as an object from which to draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular lines between such objects. When the aperture box passes over a Deferred Perpendicular snap point, the program displays a Snaptip and marker.

• **Tangent**: Snaps to the tangent of an arc, circle, ellipse, or elliptical arc. Carlson Survey automatically turns on Deferred Tangent snap mode when the object you are drawing requires you to complete more than one tangent snap. For example, you can use Deferred Tangent to draw a line that is tangent to two arcs, polyline arcs, or circles. When the aperture box passes over a Deferred Tangent snap point, the program displays a marker and Snaptip. If you use the From option in conjunction with the Tangent snap mode to draw objects other than lines from arcs or circles, the first point drawn is tangent to the arc or circle in relation to the last point selected in the drawing area.

• **Nearest**: Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, multiline, point, polyline, spline, or xline.

• **Apparent Intersection**: Apparent Intersection includes two separate snap modes: Apparent Intersection and Extended Apparent Intersection. You can also locate Intersection and Extended Intersection snap points while running Apparent Intersection object snap mode is on. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline) that do not intersect in 3D space but may appear to intersect in the drawing display. Extended Apparent Intersection snaps to the imaginary intersection of two objects that would appear to intersect if the objects were extended along their natural paths. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Apparent and Extended Apparent Intersection work with edges of regions and curves but not with...
• Parallel: Draws a vector parallel to another object whenever Carlson Survey prompts you for the second point of a vector. After specifying the first point of a vector, if you move the cursor over a straight line segment of another object, the program acquires the point. When the path of the object you create is parallel to the line segment, the program displays an alignment path, which you can use to create the parallel object.

• Clear All: This option turns off all object snap modes.

• Select All: This option turns on all object snap modes.

Menu Location: Settings
Keyboard Command: OSNAP
Prerequisite: None

System Variable Editor

The AutoCAD engine stores the values for its operating environment and some of its commands in system variables. Each system variable has an associated type: integer, real, point, switch, or text string. This command allows you to list or change the values of system variables.

- List Box: Contains a list of the variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

- Edit Field: When an item on the list box is picked, its current setting is displayed in the edit field. If you intend to make changes in an item, use standard editing procedures including the use of arrow keys and/or pointer movements.
to make changes. Once changes have been made, you must use the CHANGE options explained below to effect changes. Pressing enter at the edit field will have no effect on the item in the list. If the item selected is a read-only variable, the edit field will be grayed-out and will not allow input.

- **Description**: When an item on the list box is picked, its definition is referenced and displayed in this field. This can be a benefit in learning the uses of the assorted system variables. This is a display only field, so you can't change the description given.

Under Type Group, the type of variable will be displayed indicated by one of the radio buttons. Each of these types are explained below for your benefit. For additional information on variable types used by AutoCAD, obtain and consult a source of AutoCAD documentation.

- **Integer**: Defined as a whole number in the range from -32767 to +32768, no decimal value accepted.
- **Real**: Defined as a real number in the range from -1.797E+308 to +1.797E+308, with extreme decimal accuracy maintained. Some real variables have a smaller range than previously stated.
- **String**: Defined as a sequential array of characters in the range from 0 to 65535 characters, with a range of ASCII (0-255). Numbers can be included in strings, even though they have no mathematical significance.
- **2D Point**: Defined as a list of two real numbers in the range from -1.797E+308 to +1.797E+308 separated by a comma, having extreme decimal accuracy maintained. Always maintain the X,Y format, one (and only one) comma must be used, separating the X and Y.
- **3D Point**: Defined as a list of three real numbers in the range from -1.797E+308 to +1.797E+308 separated by commas. While editing a 3D point, you must always maintain the X,Y,Z format, two (no less or no more), commas must used, separating the X and Y and Z values.

Under Range Group, the variable displayed will usually have a range displayed. The FROM value indicating the minimum, and the TO value being the maximum value accepted.

Under the Store Group, depending on the type of variable, AutoCAD may store the value in the drawing or the configuration file, or it may not be stored. Each of these types are explained below for your benefit.

- **Not Stored**: Some variables, such as PLATFORM and CDATE, are not stored because they are system interdependent.
- **In Drawing**: Most variables are stored in the drawing, making the drawing format more personal than just a database of objects. This allows you to open a drawing and have it behave just as though you had never left it.
- **In Config**: These are variables that remain the same regardless of the drawing opened. APERTURE and PICK-BOX are just two examples of variables stored in the configuration file.

Under Access Group, depending on the type of variable, AutoCAD may not allow you to make changes to it. Each of these types are explained below.

- **Read Only**: Some variables, such as PLATFORM and CDATE, are read-only and therefore cannot be changed. Read-Only variables are marked and the edit field will be grayed indicating that you can't change the variable.
- **Read/Write**: Most variables are read/write and can be changed. These variables are marked and the edit field will be active so you can change the variable.

Under Binary Group, depending on the type of variable, the value may be off or on, yes or no. If the variable type is not binary, this group will be grayed out entirely.

- **Off (0)**: Indicate an off condition. Some variables, such as ATTREQ, are simply on or off toggles. You may change a binary item by clicking in this group to change the variable, or changing the value in the edit field.
- **On (1)**: Indicate an on condition. Binary variables are simply on or off toggles. Their range is from 0 to 1. You may change a binary item by clicking to change the variable, or changing the value in the edit field.
Control Buttons - These buttons are the main controls in the use of the Variable Editor. Each button's purpose is explained below.

- **OK**: Used to accept the changes made during the variable editing process, returning you to the command prompt with changes in effect.

- **Cancel**: Used to cancel the changes made during the variable editing process, returning you to the command prompt without the changes in effect.

- **Load**: Used to load a saved set of system variables. This allows you to create a drawing, save the system variables, open a second drawing, and load those variables into that drawing. Read-only variables are skipped.

- **Save**: Used to save the current system variables to a disk file. All system variables are stored to the file, even those that are marked as read-only.

- **Print**: Used to print the current system variables. After choosing this option, you will be prompted for an output filename, then the program will proceed to write the system variables to the file. This file can be loaded into any editor or word processor, edited, and printed.

Variable Buttons - These buttons are used to control the changes in variables, while using the Variable Editor. Each button's purpose is explained below.

- **Change**: Used to execute the changes typed into the edit field. You must use this button, simply pressing enter will not make the change.

- **Restore**: Used to cancel the changes typed into the edit field. If you make a mistake or change your mind while making changes in the edit field, press this button to restore the edit field to the value before editing.

- **Status**: Used to determine if the program will echo the status of changes being made to the command area. If this toggle is on, any changes made from the dialog will echo the change. Also if a stream of change commands is being read from a file, and the toggle is on, the changes taking place will be displayed.

Note: This command displays many more system variables than are found in the Systems Variable Chapter, which contains a list of supported system variables. Modification of any system variable other than the supported ones found in the Systems Variable Chapter is done at your own risk, and may result in program errors requiring a re-installation of Carlson.

**Pulldown Menu Location**: Settings  
**Keyboard Command**: VAREDIT  
**Prerequisite**: None
Points Menu

All of the routines in this menu operate on points in a Carlson coordinate (.CRD) file. Coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. All routines in this menu will read from, and write to, these types of point data files. At any given time, there can only be one (1) coordinate (.CRD) file set current. If a command is initiated that requires a coordinate (.CRD) file, and there is not one set, Carlson will prompt for a coordinate (.CRD) file name. From that point on, this is the current coordinate (.CRD) file. Another coordinate file can be used by choosing Set Coordinate File, or Open CRD File in Coordinate File Utilities.

Whenever asked for point numbers you can enter any combination with commas and dashes or All to use all points. For example 1,3,7,20-23 would use 1,2,3,7,20,21,22,23. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point# 7A). The type of point number format is set when the coordinate file is created. This setting is found under General Settings in Configure. This setting only affects new coordinate files.

Each point is drawn by three entities: point block, point node and symbol. The point block is an AutoCAD INSERT entity with PNTNO, PNTELEV and PNTDESC attributes. These attributes represent the point number, elevation and description respectively. The point node is an AutoCAD POINT entity and is used for picking the point with the NODE snap. The point node is also used as the X, Y, Z coordinate in surface modeling in the Civil Design module.
The symbol can be any symbol defined in the Symbol Library. (Use SPT0 for no symbol). Since points use Carlson point symbols, the AutoCAD system variables PDMODE and PDSIZE should usually be set to 0.

**Point Links**

The points in the drawing can be linked to their coordinates in the coordinate file. The link updates the coordinate file when a point is modified in the drawing. For example, when points are moved with the AutoCAD *Rotate* command, their coordinates will be automatically updated in the coordinate file. To update the coordinate file without this automatic link, you can run the command *Update CRD File from Drawing* in *Coordinate File Utilities*. This option is called *Link Points with Coordinate File* and can be set in *Configure* under General Settings. This setting does not affect points currently in your drawing, only points drawn after you change this setting.

**Point Notes**

Each point in the coordinate file has room for a 32 character description. To have a longer description, an associated point note file can be used. The note file has the same file name as the coordinate file with a .NOT extension and is stored in the same directory. For example, survey.not would be the note file for survey.crd. The note file is a text file that stores a point number together with the additional description for the point. There is no limit to the length of the note. Notes can be added to points using the command *Input-Edit Point* found in *Coordinate File Utilities*. The *List Points* command can be used to print out the notes.

**Point Entity Grouping**

For each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other AutoCAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD.

To disable this system altogether, go to *Configure*, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key and pressing the letter A on the keyboard activates this two way toggle, with the current status echoed to the command prompt area.

**Extended Point Information**

Carlson points include additional information on each element that makes up the point collection (attribute block, node and symbol). This information allows Carlson to know such things as which coordinate (.CRD) the point came from. Commands like *Drawing Inspector* can then display the point information for the point entities. This also makes it easier for Carlson to identify which AutoCAD objects belong to a point, making commands like *Edit Point Attributes* a single pick instead of a selection set.
Point Defaults

This command sets Carlson point options.

**Descriptions:** Specify whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.

**Elevations:** Specify whether you are prompted for a point elevations when creating points and whether the point elevations are labeled in the point block.

**Locate on Real Z Axis:** When checked, points are located at their actual elevation, otherwise points will be located zero elevation.

**Attribute Layout ID:** Controls the location of the point number, elevation and description. These attribute layouts are defined in AutoCAD drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Symbol Name:** Enter the default symbol name to use. You may also pick the Select Symbol button to select a symbol from the symbol library.

**Prompt for Symbol Names:** When checked, you will be prompted for each symbol name instead of using the default symbol.

**Point Numbers:** When this toggle is OFF, no point number will be created and no points will be stored in the coordinate (.CRD) file.

**Automatic Point Numbers:** When this toggle is OFF, commands that locate a point will prompt for a point number. Otherwise, point numbers are numbered sequentially. If the Start Point Number field is set to 0, no point will be plotted. An exception to this is when you use the Draw-Locate Points command and use the Range option, then a point entity is plotted.
The following table illustrates the effects of elevation settings:

<table>
<thead>
<tr>
<th>Elevations</th>
<th>Real Z</th>
<th>Picked Point</th>
<th>Point Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>Labels point, Prompts for elevation, uses 0 for z coordinate</td>
<td>Labels point, No Prompt, uses 0 for z coordinate</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Labels point, Prompts for elevation for z coordinate</td>
<td>Labels point, No Prompt, uses z coordinate from file</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>No Label, No Prompt, uses 0 for z coordinate</td>
<td>No Label, No Prompt, uses 0 for z coordinate</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Labels point, No Prompt, uses z coordinate of picked point</td>
<td>Labels point, No Prompt, uses z coordinate from file</td>
</tr>
</tbody>
</table>

**Start Point Number:** Specify the next point number to use.

**Vertical Angle Mode:** Specify how Carlson should prompt you for vertical angles. None means no prompt. Applies to creating points with commands such as Traverse. The vertical angle is used to calculate the point elevation.

**Separate Layers:** Specify settings for point attribute layers.

- **None:** The point symbol, point number, elevation and description use the layer names PNTMARK, PNTNO, PNTELEV and PNTDESC.
- **Points:** The point number, elevation and description layers are composed by concatenating the point layer and the string NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the attribute layers will be UTILNO, UTILELEV and UTILDESC.
- **Symbols:** The point symbol layer is composed by concatenating the point layer and the string MARK. For example, if the point layer is UTIL then the symbol layer will be UTILMARK.
- **Both:** The point symbol, point number, elevation and description layers are composed by concatenating the point layer and the string MARK, NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the symbol/attribute layers will be UTILMARK, UTILNO, UTILELEV and UTILDESC.

**Layer for Points:** Specify the layer name for Carlson points.

**Auto Zoom:** When checked, AutoCAD will perform a Zoom—Center around new points to keep the display centered around current working area. This only applies during commands such as Traverse. This setting is also available in Configure under General Settings where it is called Auto Zoom Center for New Points.

**Use Field to Finish For:** Allows you to use the code definitions from Field to Finish for the Point Symbols, Layers, Descriptions, Attribute Layout IDs and whether to locate the point on the "Real Z" and whether to Separate Attribute Layers when creating new points. For example, when creating a point with description "EP", Carlson would look up "EP" in the Field to Finish table and will use the field code definitions to establish the point instead of the definitions defined in Point Defaults.

**GIS File:** This option lets you specify a GIS file to be used when creating new points. The GIS file contains a list of fields to prompt for. For each point that is created, the program will prompt for these fields and store the results.
Draw-Locate Points

The Draw-Locate Points dialog box allows you to insert either new or existing points into the drawing. You can create new points either by picking points on the screen, or by entering northing and easting coordinates. You can also place existing points by entering point numbers which reference the current coordinate file. You are prompted to choose a coordinate file if no coordinate file is current.

The name of the symbol file is displayed in Symbol Name. You can choose a different symbol by clicking Select. The selected point symbol is displayed on the right.

Symbol Rotation Azimuth is the rotation angle that is used for the point symbols. This angle is used in a counterclockwise direction relative to the current twist screen.

Layer by Desc inserts the points in the layer named by the point description. Using Layer by Desc organizes the points by description and allows for layer management. For example, you can use the Isolate Layers command to show only points on a certain layer. If you include an invalid layer character in the description, the layer name stops at the bad character. A point description of "UP / 105" would use layer "UP", for example. The Layer Prefix is added to the beginning of the layer name. For example, a Layer Prefix of "PT_" and a point with the description "EP" would use the layer "PT_EP". Layer Prefix is optional. It allows all the point layers to be grouped.
Draw Nodes Only inserts only a point entity (the node) and not the point block and symbol. This option is most useful when you have a lot of points to insert, because inserting only the nodes is faster than inserting nodes with the point block and symbol. Commands such as Triangulate & Contour and Make 3D Grid File can use these points, and do not need the point block and symbol.

Selecting Elev Text Only draws text of the point elevation without the point block, symbol, or node. The decimal place of elevation text is placed at the northing and easting point location.

Locate within Polyline inserts only the points that are inside a closed polyline. The command prompts you to select a closed polyline. All the points in the current coordinate file are checked. Any points that are located within the closed polyline are drawn.

Locate within Distance inserts only the points that are within a specified distance from a reference point. The command asks you for the reference point and the search distance. All the points in the current coordinate file are checked. Any points that are located within the search distance of the reference point are drawn.

Locate within Window/Coord Range inserts only the points that are within the specified window or range of northing, easting, and elevation. The command prompts for the minimum and maximum northing, easting, and elevations. These values default to the actual minimum and maximum in the coordinate file. Then the command prompts for the point number range of points to check. The points that fall in both the point number range and the coordinate range are drawn.

Under Point Prompt-Label Settings, you determine attributes for which you will be prompted.

Descriptions determines whether you are prompted for descriptions for each point when creating new points. When you are placing both new and existing points, Descriptions determine whether this attribute is labeled with the point inserts.

Notes works with the note file (.not) associated with the current coordinate file. The note file contains unlimited point descriptions in addition to the fixed 32-character point descriptions in the coordinate file. When you create points with Notes on, the command will prompt for point notes to be stored with the point. When you draw existing points with Notes on, any notes for the points are drawn as text entities below the point description.

Elevations determines whether you are prompted for elevations for each point when creating new points. When you are placing both new and existing points, Elevations determine whether this attribute is labeled with the point inserts.

Use '+' labels the positive elevations with a leading '+'. For example, "+159.43".

Use '-' labels the negative elevations with a leading '-'.

Locate on Real Z Axis determines if the points are placed at their elevations or at zero elevation.

Label Zeros will label points with zero elevation when the Elevations option is on. Otherwise only points with nonzero elevation will be labeled.

Elevation Prefix/Suffix set the prefix and suffix labels to apply for the elevation labels.

Elevation Integers controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

Elevation Decimals sets the number of decimals to the right of the decimal places for the elevation labels.

Under Point Number Settings, you determine how points will be numbered.
**Point Numbers** determines whether the complete point block is drawn or just the symbol and node. When you create new points with Point Numbers off, no points are stored in the current coordinate file, and only the point symbol and node are drawn. When you draw existing points with Point Numbers off, the point attribute block is not drawn and only the point symbol and node are drawn.

**Automatic Point Numbering** applies to creating new points. With this option active, the command will use the **Starting Point Number** for the first new point. The next point number is automatically incremented. Before storing the point, the command checks whether the point number is used. If the point number is used and point protect is on (set in the Coordinate File Utilities command), then the command will prompt for another point number or to overwrite the point. With Automatic Point Numbering off, the command will prompt for the point numbers.

Determine how the points are to be displayed and in what layer.

With **Wildcard match of pt description**, you can display only points with specific descriptions. This can be thought of as a filter. For example, entering IP would display only points that are labeled with the description IP, or Iron Pin. The default is the asterisk (*). This will display all points regardless of description.

**Layer Name** allows you to designate a layer for the points to be displayed. You can enter a new name or choose an existing layer by clicking **Select Layer**. A Carlson Survey point consists of a block insert with attributes, a point symbol, and a point entity. The point entity is used for picking the point by OSNAP Node in other commands. The block insert includes a point number, elevation, and description. These attributes are in the PNTMARK, PNTNO, PNTELEV, and PNTDESC layers. The points are also in an overall layer as specified in this dialog box. This layer setup allows you to freeze a group of points by the main layer name or freeze point attributes for all the points in the drawing. For example, freezing layer "PNTS" would freeze all the points in this layer. Freezing layer "PNTELEV" would freeze the point elevation attribute for all the points.

The **Erase Duplicates** option will erase existing point entities that match the point numbers currently being drawn.

**Fix Overlapping Point Attributes** will detect point number, elevation and description attributes that overlap with other points. Rules can be applied to rearrange the point attributes to avoid the overlaps. A point overlap manager then steps through each overlap for review or manually moving the attributes.

**Draw Range** will draw existing points from the current coordinate file. The Draw Range button will prompt for the point numbers to draw.

**Draw All** will draw all the points in the coordinate file, and then zoom the extents of the display to show the points.

**Draw Point Group** will draw a point group with settings that are established in the Point Group Manager.

**Enter and Assign** can be used to create new points using the point northing and easting.

**Screen Pick** allows you to create points by picking the point coordinate on the screen. For example, you could set the Object Snap to EndPoint and pick the end point of a building polyline to create a point at the building corner.

**Prompts**

To create a new point:

**Draw-Locate dialog** choose **Screen Pick**

**Pick point to create:** pick a point

Select/<Enter Point Elevation <0.00>: Enter elevation Press S to select text to set elevation.

Enter Point Description <>: Enter

N: 5106.57 E: 4901.96 Z: 0.00

Enter/<Select text of elevation>: Select text entity that defines elevation of point.
To locate a point in the coordinate file (point number 3 in this example):

**Draw-Locate Point dialog** choose *Draw Range*

**Point numbers to draw:** 3
**Points Drawn** > 1
Locates point 3.

**Point numbers to draw:** 1-2
**Points Drawn** > 2
Locates a range of points. From 1 to 2.

**Point numbers to draw:** Enter

**Keyboard Commands:** lpoint

**Prerequisite:** A CRD file and you may want to execute *Drawing Setup* (see the Setting menu) to set the scale and size.

**File Names:** \lsp\lp.lsp, \lsp\crdutil.arx

### List Points

This command generates a report of point numbers, northing, easting, elevation and descriptions.

**Selection Method-Range** allows you to specify the points to list by point number range.

**Selection Method-Area** allows you to select a closed polyline to list all of the points inside of that polyline.

**Selection Method-Selection Set** allows you to specify the points to list by selecting them from the drawing.

**Range of Points:** If you are using the Range method, specify the range of points to list here. To quickly specify all points, click the **All** button.
**Point Group** allows for the selection of a specified group or multiple groups for listing. Standard windows selection tools, ctrl and shift keys, can be utilized for selecting groups.

![Select Point Group(s) window](image)

**Description Match:** Can be used to filter the point list. For example, entering "EP" for the Description Match would only list those points with a description of "EP". An asterisk (*) is the default setting, it matches any character sequence, meaning no filtering occurs.

**Report Coordinate Range:** When checked, the point list will include the minimum and maximum northing, easting and elevation.

**List Point Notes:** When checked, any additional point notes assigned to the points will be included in the point list. Point notes can be entered using the *Input-Edit Point* command found in *Coordinate File Utilities*.

**Use Report Formatter:** When checked, you may customize the fields and layout of the point report using the Report Formatter. The Report Formatter can also be used to export the point report to Excel or Access.

**Double Space Between Points:** When checked, the report will be double spaced.

The point list report is displayed in the Standard Report Viewer which can print, draw and save the report file. This report viewer cannot be used to edit the coordinate file. Instead use the *Edit Points* command in the Points menu.

**Example of List Points Report:**

```
List Points Report
File> C:\Carlson2008\DATA\POINTS.CRD
Job Description>
Job Number> 0.000 Job Date> 06/01/2002
PointNo. Northing(Y) Easting(X) Elev(Z) Description
  1   5355.240   5000.000   91.8   CP2
  2   5000.000   5000.000   90.0   CP2
 1000 5355.236   5000.000   91.8   CK
 1001 4941.911   4622.029   91.4   FPC
 1002 4952.629   4642.818   90.6   FH
 1003 4959.931   4634.440   89.8   TOE1
```
**Pulldown Menu Location:** Points  
**Keyboard Command:** listpt  
**Prerequisite:** Points in a coordinate file or on the screen  
**File Name:** `\lsp\crdutil.arx`

### Import Text/ASCII File

This command converts point data from an ASCII text file into the current Carlson coordinate (.CRD) file. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter. Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters. For example:

For a text file with northing, easting, elevation and comma delimiters:

- 5100.0,5150.5,485.1
- 5127.1,5190.3,487.3

The Coordinate Order would be:

Y X Z

For a text file with point number, easting, northing, elevation, description and space delimiters:

- 1 5000.0 5000.0 490.3 TRAV
- 2 5030.4 4930.5 495.5 TRAV

The Coordinate Order would be:

P X Y Z D

Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file. The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File.

Multiple files can be imported at once. To do this toggle on the Enable Process Multiple Files option. After selecting the Text/ASCII Files button, you can select multiple files by using the Shift or Ctrl keys while picking files. You can also run Select Text/ASCII Files multiple times allowing for selection of files located in different locations. The files to import are listed in the top scroll display window. The point data from all the import files can be stored to the current CRD file or to separate files for each import file. The separate file option will name the resulting CRD files with the same name as the import file with a .CRD file extension. For example, the import file job125.txt would create job125.crd. The CRD file will be created in the same location as that of the selected text file to import.

The special formats of Leica .gsi files, TDS .cr5 files, Geodimeter .obs/.raw files, Laser Atlanta .txt files, Trimble .pos files, Zeiss .txt files, Traverse PC .trv files, Maptech, Benchmark .dat files and Cadvantage .cog files can be directly imported by choosing that File Format at the top of the dialog.
Pulldown Menu Location: Points
Keyboard Command: readpt
Prerequisite: A text file to read
File Name: \lsp\crdutil.arx

Export Text/ASCII File

This command outputs point data from the current Carlson coordinate file to an ASCII text file. Specify the type of file to write with the Coordinate Order radio buttons. There are several variations on point number, northing, easting, elevation and descriptions as well as specific formats for Leica, Geodimeter, Zeiss, Maptech, D45, Cдвantage, Multiplane and SDMS CTL formats. In addition there is an option, User-Defined Format, to define the order of
the fields output. When using the User-Defined format, after selecting OK, the User-Define Export Format dialog will appear. On this dialog, specify the order of the fields by defining a number sequence in each field. You can skip fields and omit data in the output file by leaving None in the sequence field for this data.

Specify the Delimiter of the export file as either Comma or Space in the Delimiter field. There are three Selection Methods provided for the data to export. Specify either Range, Screen Points or Screen Entities in the Selection Field. A Range selection is a user specified range such as 1-10, 30-50. A Screen Points selection is made by selecting points from the screen area. The Screen Entities option allows for selection of polylines, lines, arcs, points, faces, inserts and text to export point data from. When the Screen Entities option is selected, the following dialog box will display allowing for the specification of the type of entity to export data from.
A description filter is also available for exporting only points from the range or selection set with certain descriptions. After selecting the OK button, another dialog appears that allows you to specify a new text?ASCII file or to append data into an existing file. The standard file selection dialog allows you to specify the export file name.

**Pulldown Menu Location:** Points  
**Keyboard Command:** writept  
**Prerequisite:** A Coordinate File (.CRD)  
**File Name:** \lsp\crdutil.arx

### Set Coordinate File

This command allows the user to set the name of the active coordinate file. This file is used by different commands that compute, store and recall point coordinates. Carlson coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. These files are stored by default in the configured data subdirectory. When prompted for the name, if you type in a path name the file will be stored in the specified path. If you don't specify a path then the default path that is configured in the Configure command, found under Settings, will be used.

When executed, the command defaults to the Existing tab for selection of an existing file. You may select a file from the list of Recent Folders, or choose the Browse button to go to a specific location on your computer. To create a new file, select the New tab and enter the name of the file in the file name field provided. Use the Browse button to specify the desired location to save the file.
Pulldown Menu Location: Points

Keyboard Command: setcrd

Prerequisite: None

File Names: \lsp\pcrdfile.lsp, \lsp\scadfile.dcl

CooRDinate File Utilities

This command allows you to manipulate the coordinates stored in a coordinate (.CRD) file. One of the most important commands is the Update CRD File from Drawing which allows you to update the file after editing the drawing with commands such as Erase, Move, Rotate or Change Elevations. Another handy option is the Draw Entities by Point Number which allows the user to input point number ranges and plot Lines, Arcs, Polylines or 3D polylines. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point number 7A). The type of point number format is displayed at the top title bar of the main dialog.
Open CRD File: Allows the user to switch to another file. When you exit Coordinate File Utilities this will be the current file that you work with in Carlson.

Copy/Merge CRD File: This command allows for the copying of entire CRD files, or parts of CRD files, to a new or existing files. This can be used to make a backup of your coordinate file, and it can also be very valuable in coordinate file manipulation. For example, if a certain range of points from one CRD file was also required in the active CRD file, this command would be used to simply copy the required range into the active CRD file. There are two options when first executing the command. These options are whether to import points from another file to the current (active) CRD file, or to export the current (active) coordinate file to another file.

Once this option has been decided, a prompt for the file to copy From or TO, will be displayed. Here simply specify the correct file.
Next there's a dialog to specify the range of points to transfer and some options. Here specify the points to copy. Point numbers and ranges can be entered together, for example, 1-3,10,15 would result in points 1 through 3 and points 10 and 15 being copied. The Description Match can be used to filter the points to transfer only the points with matching description. The default of * will transfer all the points in the range. The Store Non-Conflicting Point Automatically will set the transfer action as Store for all transfer points that don't have a point protect conflict. The Skip Merge Dialog If No Conflicts will skip the next dialog when there are no point protect conflicts.

Next there's the Merge Points Manager dialog that shows the Source Coordinate File on the left (where the point data is being copied from) and the Target Coordinate File on the right (where the point data is being written to). Conflict cases are when the same point number exists in both files with different coordinates. The action choices for conflicts are to Overwrite, Skip or Renumber. For renumber, you can either renumber with the next available point number in the target file or to the highest point number in the target file plus one. Non-conflict cases are when the source point number does not exist in the target file. The action choices for non-conflicts are to Store or Skip. You can assign actions by picking on the Action field in the spreadsheet or by entering in a Point Range to apply and picking an action button. The Show Matching Points toggle will show points with matching point data in both files. Otherwise only point with differences are shown. The Next Conflict button will highlight the spreadsheet and set the Point Range to the next point that needs an action assigned. Similarly, the Previous Conflict sets focus to a lower point number that needs an action. The History button shows the point history for the selected point. The
Report button creates a list points report. The Current Merge Status reports the number of unresolved and resolved points. When all the unresolved points are resolved by assigning actions, you can pick OK.

**Convert CRD File Format:** This allows you to convert the current CRD file from numeric format to alphanumeric format or visa versa. This routine will also change crd files to and from different software formats. These formats include C&G, AutoDesk Land Desktop, and Simplicity. The current format of the active coordinate file will be displayed as well as the options for the new file format. This command only changes the format of the active coordinate file.

![Convert Coordinate File Format](image)

**Map Points from 2nd File:** This routine adds point to the current CRD file from points stored in a second CRD file. The points to copy are specified by numbers one at a time. Prompts for the destination point number (number to create in current crd file) and source point number (point number to be copied from second crd file) will be displayed.

**Import Text/ASCII File:** This routine converts point data from a text file into the current coordinate (.CRD) file. See the Import Text/ASCII File command in this chapter for more information.

**Export Text/ASCII Text File:** This routine outputs point data from the current coordinate (.CRD) file to a ASCII Text file. See the Export Text/ASCII File command in this chapter for more information.

**Edit Header:** Enter or edit the job information associated with the coordinate file. The fields include Job Description, Job Number and Job Date. This information will appear on the List Point report. Non-digit characters are not allowed in the Job Number field.

![Edit Job Header Info](image)

**Compress CRD File:** Removes unused point numbers by renumbering high point numbers into the unused spaces. For example, for an original file with points 1,2,105,107,108,109 would be compressed to 1,2,3,4,5,6.
Coordinate Transformation: Transforms coordinates between local, state plane 27, state plane 83, latitude/longitude, and Universal Transverse Mercator (UTM). Works on individually entered coordinates, by range of point numbers and with on-screen entities. For converting between state plane 27 and 83, Carlson calls upon NADCON from the National Geodetic Survey to apply the latitude/longitude adjustment. The NADCON program, ndcon210.exe, is stored in the Carlson EXEC directory.

The Transformation Type is used to define the Source Coordinate and Destination Coordinate formats. Settings for Lat/Long Datum, Lat/Long formats (dd.mmss or dd.dddd), Projections, State Plane Zones and coordinate units are defined in the Transformation Type dialog. The format of this dialog will change depending upon the type of transformation requested.
For all Transformation types, there are three options for inputting the data to be transformed. Data can be selected from the screen by using the **Screen Entities**. If a range of points or a particular point is desired, the **Point Numbers** option would be used. Manual entry of coordinates to transform one at a time is accomplished with the **Enter Coordinates** option. The coordinates can be typed in or use the Input Point Number option. Output Point Number is an option to store the results in the coordinate file.

![Enter Transform Coordinates](image)

For all transformations there are two output options when using point numbers as the input data. **Overwrite Existing Coords** replaces the original coordinate values with the new coordinate values after transformation. **New Point Numbers** will retain the original coordinate data and point numbers and create new point numbers with the revised coordinate data after transformation.

When transforming a **Local Coordinate System**, there are two options for defining the transformation as shown in the next dialog.

![Local Coordinate Transformation Options](image)

The **Align by Two Pairs of Points** option uses two pairs of source and destination coordinates. The first pair defines the translation as the difference between the source and destination northing and easting.
This destination point is also the pivot point for rotation. Rotation can be entered directly or defined by a second pair of points where the bearing between the first and second source points is rotated to align with the bearing from the first and second destination points. There is an option to also apply scaling. The scaling holds the angle between points and adjusts the distances by the scale factor. The scale factor is calculated for each point as the elevation factor at the first source point times the grid factor at the first destination point averaged with the elevation factor at the transform point times the grid factor at the transform point.

The **Least-Squares Best-Fit** option is used when there are more than two pairs for translation points. Since two pairs of points are sufficient to define the translation and rotation, more than two pairs of points provides more than enough information.
Over Determination by Plane Similarity is used to find the least squares best fit transformation for all the given source and destination points. Besides doing a translation and rotation, this option will also scales the points during the transformation. The Rigid Body Transformation also does a best fit least squares transformation, but applies only translation and rotation with no scale. The Helmert 7-Parameter method can also be used for local transformations. The 7-Parameter Values can be calculated from control points or entered by the user.

The Add button is used to define the source and destination coordinates for the points that define the transformation. Pressing this button brings up the following dialog box.

The Edit button is used to edit existing data.

The Delete button removes the source and destination pairing from the transformation setup.
The Process On/Off button allows source and destination pairings to be turned on and off. This is useful when wanting to inspect different results using different pairings.

The Optimize option chooses which point pairings would yield the best transformation results by turning off the processing of pairings with higher residuals. This minimizes the average residual for the control points.

The Report option displays a report of the transformation point pairings, their residuals, processing status, transformation scale and avg. residual.

The Load and Save options allow for saving and recalling local coordinate transformation pairings and settings.

Draw Entities by Point ID: Draw Lines, Arcs, 3DLines, Polylines or 3DPolys by defining a range of point numbers.

Prompts

Plot Entities by Point Number
Type of entity, Arc/Polyline/3dpoly/2dline/Exit/<Line>: P This response causes the program to plot polylines. Example: ‘1*4-7-10*12-5-8’ would draw lines from point number’s 1 through 4 then to 7, to 10 through 12, then to 5 to 8. (limit 132 characters)
Undo/<Enter point numbers or ranges>: 1*10-20*30
The program draws a polyline from point number 1 through 10 to point number 20 through 30.

New Last Point Number: This option sets the highest point number in the CRD file. All points above this number are erased.

Swap Northing-Easting: This option allows you to swap northing and easting coordinates for any selected range of points. What was the northing of an existing coordinate point, or range of points, becomes the easting. And the easting(s) becomes the northing(s).

Point Entry CRD File Links Manager: When points are created in the drawing, the program records the source coordinate file for the points. The coordinate file names assigned to the point entities links the point entities back to the coordinate file. These links are used by routines that process the point entities and then need to reference the coordinate file such as Move Point which selects a point entity and updates the coordinate file. This routine checks all the point entities in the drawing and lists all the linked coordinate files. You can use the Assign button to set the
coordinate file assigned to point entities which is useful when the coordinate file has been moved after the points were drawn. Use the Unlink button to remove the link.

**Update Drawing from CRD File**: This function updates the position of Carlson points in the drawing to match the position stored in the coordinate file. This command also has options to erase and draw points. For the erase option, points are erased from the drawing if the point number does not exist in the coordinate file. For the draw option, if a point number in the CRD file does not exist in the drawing, then this point is drawn using the settings from the dialog. The number of points modified, erased and drawn is reported at the end of the command.

**Update CRD File from Drawing**: This function allows you to select all or some of the points in the drawing and add or update them to the .CRD file. The points can be filtered with AutoCAD’s Select Objects: selection mechanism and/or wild card matching of the point descriptions. The Update Point Descriptions option determines whether the point descriptions from the drawing will be stored to the CRD file. Use this command to update the file after a global edit such as Move, Rotate, Renumber Points, Change Elevations, Erase, etc. This routine directly reads Leica...
(Wildsoft), Softdesk, Geodimeter, InRoads, Land Development Desktop, and Eagle Point point blocks.

**List Points:** List the points stored in the .CRD file. See the *List Points* command in this chapter for more information.

**Delete Points:** Deletes points in the coordinate (crd) file by point number or description.

**Screen Pick Point:** Pick a point on the graphics screen and it's coordinate values are added to the coordinate (crd) file. Prompts for point number, elevation and description will be displayed. This command does not plot a point, point attributes or point symbol. Use the command *Draw-Locate Points* command to do this.

**Scale Points:** This option multiplies the point northing, easting, and elevation by the scale conversion factor. You can use this routine for metric-English conversion. See the *Scale Points* command in this chapter for more information.

**Translate Points:** This option translates a range of points based on entered delta x and delta y, entered coordinates or translation point numbers. See the *Translate Points* command in this chapter for more information.

**Rotate Points:** This option rotates a range of points based on entered degrees or rotation, entered azimuths, entered bearings or rotation point numbers. See the *Rotate Points* command in this chapter for more information.

**Align Points:** This option does a translate based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. See the *Align Points* command in this chapter for more information.

**Description for Points:** This option sets the point description field with the user-specified text for a range of point numbers.

**Elevation for Points:** This option sets the elevation of a specified point or range of points.
Point Number Report: This routine lists the used and the unused point numbers in the CRD file.

Duplicate Points: This function searches the CRD file for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set in the dialog separately for northing/easting and elevation. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance. The duplicate points can be erased or only reported. For the erase option, the first point number is kept and any higher point numbers with duplicate coordinates are erased from the CRD file.

Compare Points: This function compares the coordinates in the .CRD file with either the coordinates for the matching point numbers in the drawing file, with matching point numbers from another CRD file or with different point numbers from the same CRD file. A report is created for any differences that shows the point numbers and the differences. The difference can be reported as a bearing and distance between the two points, as distance North/South and East/West or as the delta-X and delta-Y. There is an option whether to include the point coordinates in the report.
Example Bearing-Distance format Compare Points Report

**Renumber Points:** This option renumbers points in the user-specified range starting from a new point number. The old point numbers are erased. The condense points will renumber such that there are no unused point numbers in the renumbered range. Otherwise the spaces between the points is maintained. In the example shown, renumbering 1-25 with points 1,2,24,25 to starting point number 101 will result in points 101,102,103,104 if condense is on or 101,102,124,125 if condense is off.

**Input-Edit Point:** Enter or edit the coordinate values or the description of a point. The Notes section is for adding optional point notes which are additional point descriptions. The standard description field is limited to 32 characters. Under notes, any number of lines of text can be assigned to the point. A list box shows the lines of notes. To add a note line, pick a blank line in the list box and then type in the note in the edit box belong the list box and press Enter. To edit a note, highlight the line in the list box and edit the text in the edit box.
**Point History:** All changes to the coordinate file will record the commands performed on this coordinate file and the status of the points themselves. This makes up the coordinate file history. The history can then be reported by point number or by command. All of the changes can be rolled back. It is important to note that if maintaining such a history file is your objective, in the Settings > Configure > General Settings dialog you must make sure that Maintain CRD History File is checked.
The Disable History Feature button at the top of the dialog shown above is a toggle device. It should be clicked if you prefer not to build the point history file. Clicking it a second time changes it back to saying Enable History Feature. You can also choose Delete History File to delete the file altogether. By clicking any point from the list, as shown in the Points tab example above, and then selecting History, you will be given the history for that specific point. Double-clicking on any command shows the details. Clicking on Details also shows the selected command's details. Undo thru Selected will undo the effect of all of the commands up through and including the selected command. The changes from the undo command are themselves then added to the command list and can be undone in the future.

Point Protect Toggle: This option, located at the bottom-left of the main Coordinate File Utilities dialog, toggles point protection on and off. With this option on, when attempting to store a point with a point identifier (point number) that already exists in the current coordinate file, the following dialog will be displayed.
**Overwrite with new coordinates** will update the existing point number with the new location of the point.

The **Use Another Number** field displays the point number that will be used if the Use Another Number option is selected. This number will depend upon the option chosen from the **Another Number From** settings. If **Next Available** is chosen, the next available number will be displayed in the Use Another Number Field. If there are number gaps in the coordinate file this number will not be the next highest number in the file. For example if points 1-10 and 20-30 exist in the crd file leaving a gap from 11-19, the Next Available number would be 11. If the desired point number, in this example, is 31, then the option of **End of File** would be selected.

The **Overwrite All** and **Renumber All** options apply when more than one point with the same number exists in the coordinate file. These options are helpful when importing points into existing CRD files.

**Pull-down Menu Location:** Points  
**Keyboard Command:** cfu  
**Prerequisite:** None  
**File Names:** \lsp\crdutil.lsp, \lsp\crdutil.arx, \lsp\scadcfu.dcl, \lsp\scadfile.dcl

**Point Group Manager**

This command is used to create point groups based on inclusion and exclusion filters. The manager can perform various functions on these point groups. Also point groups can be referenced by group name in other commands such as Field to Finish and Data Collection.

![Point Group Manager](image)

**Groups Pulldown**

Create Point Group: This option creates point groups. When selected, the New Point Group dialog box is displayed.
Group Name is the name of Point Group to create.

Description is the description of Point Group to create.

Use the Include Tab to define the filters to be applied when creating the point group. Inclusion rules are applied before the exclusion rules.

When Include All is toggled on, all points in the coordinate file will be included in the selection.

When Point List is toggled on, an option of defining the point list must be selected.

**DWG: Select** allows for manual selection of the points to include from the drawing. The points must be drawn on the screen prior to using this option. All standard AutoCAD selection tools, are available for selection of the points.

**DWG: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. Points must be drawn to the screen prior to using this option.

**DWG: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. Points must be drawn to the screen prior to using this option.

**CRD: Select** allows for manual selection of the points to include from a point list. Standard window selection tools are available for selecting the points to include.
CRD: Add Within Circle allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. The points do NOT have to be drawn to the screen prior to selection.

CRD: Add Within Polyline allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. The points do NOT have to be drawn to the screen prior to selection.

Elevation Range allows for the selection of points within a specified elevation range to be included in the group. The minimum and maximum elevations can be entered manually in their respective data fields. The minimum and maximum values can also be specified by the Set By Selection and Set From List options.

Set By Selection allows for selection of points to include in the group from the drawing. The points must be drawn to the screen prior to using this selection method. Standard AutoCAD selection methods are available.

Set From List allows for selection of points to include in the group from a point list. Standard Windows selection tools are available with this option.
The **Description** option allows for a selection of points to include based upon the description of the point. The description to filter for can be entered in the data field or by using the Set By Selection and/or the Set From List options described above.
The **Exclude Tab** allows for defining rules that pertain to the points to be excluded from the Inclusion selection. After defining the inclusion rules for the group, the options on the Exclude tab can be used to filter for points to exclude from the group. For example, if the inclusion rules call for all points within the elevation range of 8 to 12, an exclusion rule can be set to exclude the points on elevation 9 or with the description tree. The options on this tab work exactly like the options on the Include tab. Please refer to the Include tab definitions for further instruction.

**Save Changes** saves the point group to the group name specified based upon the Inclusion and Exclusion rules specified.

**Cancel Changes** discards specified rules and changes and goes back to the Point Group Manager dialog.

**Edit Point Group** allows for editing of existing point groups. From the list of available groups, highlight the group or groups to edit. When complete with the first group, if more than one is selected, selecting the Save Changes option will save the changes to the active group and switch to the next group in the selection set.

![Point Group Manager Dialog Box](image)

From the Groups pulldown, select Edit Groups, the Edit Group dialog box will now appear.

---

*Chapter 10. Points Menu*  
392
See Create Point Groups for further definitions of the available options.

**Delete Point Groups** deletes specified groups for the existing group list. One or more groups can be deleted at one time.

**Import Point Groups** allows for importing filters from point group manager settings of other coordinate files. This is a useful option when coordinate files are going to contain same point group names with the same filters. This option only brings in the filters into the point group manager, it does not import actual points into the coordinate file by group name. Existing points in the active coordinate file that meet the filter definitions of the imported point groups will automatically be added to the corresponding group.
Points Pulldown

The **Insert into Drawing** option draws the points in the group in the drawing. Individual points or point ranges can be selected from the group to be erased from the drawing. For example, points 264-275 and point 298 contained in group Wet Lands are tagged to be erased from the drawing in the following figure.

The symbol to be used and the attribute layout are determined by the Point Default Settings. The symbol size and the point attribute size are determined by the settings in the Drawing Setup routine.

**Erase from Drawing** erases specified point group/groups or specified points from within the group from the drawing.

**Erase from Coordinate File and Drawing** erases the points in the specified group/groups or specified points from within the group from the drawing and will also permanently delete the points from the CRD file. You will be prompted with a warning as follows:
Selecting **Yes** will complete the command and erase the points from the screen and also the coordinate file. Selecting **No** will cancel the command leaving the drawing and the coordinate file unchanged.

The **Report** option will generate a point list of the points contained in the selected group/groups or specified points from within the group.

The **Highlight** option highlights the specified objects in the drawing. This makes them distinguishable from the other points on the screen.

The **Draw 2D Line** option draws a 2d polyline between the points contained in the group/groups or between specified points in a group.

The **Export** command exports the selected group/groups or the specified point(s) or range of points from within the group to various formats. The available formats are ASCII/Text, Carlson Software CRD and C&G CRD files.

When **ASCII/Text** is selected, the Export Text/ASCII File dialog box will be displayed. Please refer to the Export Text/ASCII File section of the manual for more information.
The **CRD-Carlson software** command writes the selected group/groups or the specified point(s) or range of points within the group to a new Carlson formatted CRD file.

Specify the file name of the CRD file to create and press save.

**CRD-C&G** writes the selected group/groups or the specified point(s) or range of points within the group to a new C&G formatted CRD file.

Specify the file name of the CRD file to create and press save.
Edit Points

This command edits point data in the current coordinate file or within a point range. The current coordinate file can be set with the Set Coordinate File command. Edit Points shows all the points in the coordinate file. New points can be added and points can be deleted by using the Insert and Delete keys.

This tool also lets you edit notes associated with each point. While the standard point description is limited to 32 characters, the drawing notes are not. When you click on a given point, you can add numerous lines of notes about that point in the bottom of the dialog. Keep in mind that these notes are stored in a separate file with the extension ".not" having the same name as the CRD and residing in the same folder.
Erase Points

This command erases Carlson points inserts from the drawing. The points to erase can either be selected from the screen or specified by point number, point number range or by point group. Erasing a Carlson point will erase the point symbol, point attributes, and point node. The points may optionally be erased from the coordinate file. As long as the points are not deleted from the coordinate file, they can be redrawn with Draw-Locate Points.

Prompts

Select points from screen, group or by point number [Screen/Group/Number]? press Enter
Point numbers to erase: 1-5
Delete points from coordinate file (Yes/No)? press Enter
Erasing Carlson Points ...
Number of points erased > 5

Pulldown Menu Location: Points
Keyboard Command: DELPT
Prerequisite: Carlson points to be erased
File Name: \lsp\delpt.lsp

Freeze Points

This command freezes Carlson points to hide them from view without erasing them. Use the Thaw Points command to show the points again. This command works similar on points as Freeze Layers works on layers. The points to freeze can be selected by point number range, point group, inclusion/exclusion perimeter polyline areas, or screen selection. There is a dialog to choose the method and specify a description match filter.

Pulldown Menu Location: Points
Keyboard Command: freezept
Prerequisite: Carlson points to freeze
File Name: \lsp\crdutil.arx
Thaw Points

This command thaws Carlson points that were frozen with the Freeze Points command to show the points in the
drawing again. This command works similar on points as Thaw Layers works on layers.

Pulldown Menu Location: Points
Keyboard Command: thawpt
Prerequisite: Frozen Carlson points
File Name: \lsp\crdutil.arx

Translate Points

This command translates points in a coordinate file from one coordinate position to another. The delta X, Y, and
Z can be entered directly or calculated from original and destination coordinates. The original and destination
coordinates can be entered directly, specified by point number, selecting the point number from a point list by
selecting the list icon, or selected from the screen by selecting the pick icon. Once these points have been specified,
the Delta X,Y,Z, if Process Elevations is checked ON, fields will be filled in with their calculated values. Any points
in the drawing will be updated automatically in addition to updating the coordinate file.

Define Translation By Angle/Distance requires a specified direction, Northeast (NE), Southeast (SE), Southwest
(SW), Northwest (NW) or Azimuth (AZ) along with a specified distance in order to perform a translation. Once the
direction and distance are entered, the Delta X,Y,Z will be calculated. This is a useful command when you know that the job needs to shift, for example, to the Northeast 25 degrees for a distance of 100 feet. Here you would simply type in 25 in the Angle (dd.mmss) field, choose NE in the Type field and then enter the distance of 100 in the Distance field.

With **Process Elevations** checked, all elevations will be translated by the specified or calculated Delta Z value. This option is very useful in correcting point elevations after performing a survey with assumed elevations and then later surveying into a benchmark with known true elevation. In this case only the Delta Z value, use (-) to indicate a lower correction, and the range of points to translate would be required for a translation. For example if the entire job needed to be lowered by 5', the Delta Z would be defined as -5 and the Range of Points defined as ALL.

**Ignore Zero Elevations** is only available when Process Elevations has been chosen. With this option checked ON, all points with an elevation of 0 will be ignored resulting in no translation taking place on these points.

With **Translate Screen Entities** checked ON, after specifying the point range or group to translate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also translate and press enter. The translation of the points and screen entities will be completed.

Various **Output Options** for the translated points are available.

**Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original co-ordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

**New CRD File** will place the translated coordinates in a new crd file. After selecting OK to the range of points to translate dialog, the Coordinate File to Create dialog will appear. On this dialog enter the name of the new crd file and select save. The original crd file will remain unchanged and the new file will contain the points with the translated coordinates.

Specifying the points to be translated is accomplished either by specifying a **Range of Points** (1-20,33,36-40...) or by **Point Groups**. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only translates points with the description(s) specified in this field.

**Undo Last Translation** restores the points to their previous location before translation. It is important to note that if Translate Screen Entities has been checked to restore the translated objects to their previous location will require the use of the undo command located in the Edit pulldown.

The AutoCAD command **MOVE** can be used to translate points on the screen but this does not update the coordinate file unless you have the option Link Points with CRD File turned ON in **Configure**. (Note: This toggle must have been turned ON prior to locating the points). If you do use the **MOVE** command and the CRD file needs updating, run the command **Update CRD file From Drawing** found in Coordinate File Utilities.
Rotate Points

This command rotates points in a coordinate file. The degrees of rotation can be entered directly or calculated from original and destination bearings or azimuths.

The **Rotation Point** will remain unchanged while the points specified for rotation rotate around it. This point can be specified by using the **List** button to pick from a list of points contained in the coordinate file, or from the screen by using the **Pick** button. The rotation point can also be defined by a coordinate value by manually entering in the X and Y values of the point. This point must be defined before the rotation will take place.

The **Original Bearings/Azimuths** and **Destination Bearings/Azimuths** can be entered directly or specified by point numbers. If using a pair of points to define the original bearing and then specifying the destination bearing by entering in the desired Bearing/Azimuth, the From and To Pt# fields should be left blank in the destination bearing/azimuth settings. Use the From and To Pt# fields in the Destination Bearing/Azimuth when you want to make a direction or Bearing/Azimuth between two existing points match the Bearing/Azimuth between two other existing points within the file. For example, to make the bearing between points 10-12 match the bearing between points 25-26, the Original Bearing/Azimuth could be defined as From Pt#10 To Pt#12 with the Destination Bearing/Azimuth defined as From Pt#25 To Pt#26.

With **Rotate Screen Entities** checked ON, after specifying the point range or group to rotate and selecting OK on the dialog box the following command line prompt is displayed:

```
Select objects to rotate (points excluded):.
```

At this prompt select the objects on the screen, polylines, lines, arc, etc., to also rotate and press enter. The rotation
of the points and screen entities will be completed.

Various **Output** options for the rotated points are available. **Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file. **New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

![Select Point Group(s) dialog box](image)

Specifying the points to be rotated is accomplished either by specifying a Range of Points (1-20,33,36-40,...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only rotates points with the description(s) specified in this field.

The points that have been specified for rotation that are present in the drawing will be graphically updated to their new location in addition to an automatic update of the coordinate file.

**Undo Last Rotate** restores the points to their previous location before rotation. It is important to note that if Rotate Screen Entities has been checked to restore the rotated objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points
**Keyboard Command:** rotatept
**Prerequisite:** points in a coordinate file
**File Name:** \sp\crdutil.arx
**Align Points**

This command translates a specified Range of Points or Points Group(s) based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. The command basically combines the Translate and Rotate Point commands. To specify a Range of Points to align, enter the range to align or select a point group(s) by selecting the Point Group button. Each of the Translation and Rotation points, both Source and Destination points, can be entered manually or picked from the point list by selecting the List button.

When **Align Screen Entities** is checked, after specifying the point range or group to align and selecting **OK** on the dialog box the following command line prompt is displayed:

**Select objects to rotate (points excluded):** At this prompt select the objects on the screen, polylines, lines, arc etc., to also align and press Enter. The alignment of the points and screen entities will be completed.

When **Ignore Zero Elevations** is checked, all points with an elevation of 0 will be ignored in the alignment.

**Undo Last Align** restores the points to their previous location before alignment. It is important to note that if Align Screen Entities has been checked to restore the aligned objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points
**Keyboard Command:** alignpt
**Prerequisite:** Points in a coordinate file
**File Name:** \lsplcrdutil.arx
Scale Points

This command scales points in a coordinate file. The northing, easting and optionally the elevation are multiplied by the specified scale factor. You can use this routine for Metric-English conversion or a specific conversion by choosing the Use Customized Scale Factor option and specifying the desired Scale Factor in the edit box.

Specify the **Range of Points** to scale by entering in a range or group to scale. You can access the group dialog box by typing “group” in the range of points field.

The **Description Match** option only scales points with the description(s) specified in this field.

The **Scale Factor** is to be entered in manually when using a customized scale factor. If converting from standard measurement units, feet to meters, meters to feet, US Feet to International Feet, etc., the scale factor will be calculated and entered automatically. If a combined scale factor is required for converting from ground to grid and grid to ground coordinates, this value can be calculated by using the **Calculate Combined Factor** option. This calculation process begins with the Calculate Scale Factor dialog shown below.
The Projection Type must be specified as either State Plane 83 or State Plane 27 as well as what state plane Zone is required.

The available Coordinate Units are Metric, US Feet and International (Intl) Feet. The correct unit must be specified before calculating the combined scale factor.

The Range of Numbers to Process should be used to select the points to be used in order to calculate the combined scale factor. This does not specify what points are going to be scaled by the resulting scale factor. These points can be selected from a list by selecting the List button.

Scale Direction determines which way the scale factor will be calculated. A scale for Ground to Grid or Grid to Ground can be calculated and applied.

Pressing the Calculate button will calculate and then display the combined scale factor on the dialog box. To accept this value as the customized scale factor to use to scale the points in the coordinate file, press the OK button.

The Report option displays a report showing specified information. This information is specified by using the report formatter found throughout the program. Simply choose the information you wish to display and the order to be displayed. For further instruction and information on the Report Formatter please refer to the Report Formatter section of this manual.
With **Align Scale Entities** checked ON, after specifying the point range or group to scale and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to scale (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also scale and press enter. The points and screen entities will be now be scaled and updated graphically and in the active coordinate file.

With **Use Customized Scale Factor** Off, various conversions can be performed by specifying the Source Coordinate units and the Destination Coordinate units. This is a quick and easy way to perform Metric/English conversions.

**Pulldown Menu Location:** Points
**Keyboard Command:** scalept
**Prerequisite:** points in a coordinate file
**File Name:** \lsp\crdutil.arx

### Move Points

This command allows you to move Carlson points, one at a time by selecting any part of the point. Each Carlson point is made of three entities: an AutoCAD POINT entity, a symbol, and a point block with the point number, elevation and description. All these parts of the point are moved together with this routine. Any point moved using this command will result with the original source coordinate file (which is not necessarily the current coordinate file) updated with the new position of the point.

**Pulldown Menu Location:** Points
**Keyboard Command:** mpnt
**Edit Point Attributes**

This command will edit the attributes of a Carlson point, such as the symbol type, point number, elevation and description. When this command is invoked, the command line will prompt the user: **Select point to edit (Enter to end).** At this point, you can select any part of the point including the symbol, elevation, point number or the description. Next, a dialog will appear as shown.

![Edit Point Dialog](image)

To change the symbol, either type in a new symbol name in the edit box, or choose the "Select Symbol" button where you can choose from a list of symbols. To change any of the other properties of the point, simply change or replace the contents of the edit box with the new information. Both Drawing Description and CRD File Descriptions are displayed. When a change to the Drawing description is made, this change will not be reflected in the coordinate file. This allows the change of a description that is defined in the Field to Finish (fld) table for a particular code. If a change is made in the CRD File description, it will be reflected in the coordinate file. Take note that if the CRD file description is changed, running Field to Finish will change the definitions for the point(s) changed. If you change the point number to a number that already exists in the current CRD file, and point protect is ON, you will be prompted **[O]verwrite w/new coordinates, overwrite [A]ll, or use number <1000>:**. You can choose to use the next available point number in the CRD file (this is the default), or overwrite the point number. The properties that you modify, with the exception of Drawing Description, will update the current CRD file. All modifications will update screen entities. Selecting the History button will bring up another dialog box that displays the point history of the point chosen. A history of the point will be listed, but only if, under General Setting, the Maintain CRD History File had been set to ON (selected) for the coordinate file that you are working with. With the CRD History feature of Carlson, all point changes can be rolled back.
You may also choose to use the AutoCAD `DDATTE` command to change the attributes of a point. If you do this, then the CRD file will not be updated and if you change the elevation attribute, the point will not change its current Z location.

**Pulldown Menu Location:** Points  
**Keyboard Command:** `editpnt`  
**Prerequisite:** Carlson points  
**File Name:** `\lsp\editpnt.lsp`

## Edit Multiple Pt Attributes

This function allows you to modify the properties of multiple point attributes at the same time. This command gives you complete control over the Carlson point attributes that are present in the drawing. Changes can be made to each attribute – the point number, elevation, description or symbol – all in one motion. For example, you could rotate the elevation text of some points to 45 degrees, change the height of the description text for all the points in the drawing, or change the layer for a particular attribute. Once this command is chosen, the entry Edit Multiple Points dialog, a smaller box, appears. Here you can determine your point selection method. There is also an option for description matching.

![Edit Multiple Points dialog](image)

After the selection of the points to change, click OK, and the subsequent, larger Edit Multiple Points dialog boxes will appear. The number of points selected will be shown at the top of the dialog boxes.

**Edit Multiple Points dialog**

For each attribute, you can change any number of the properties, including the layer, height and rotation. These dialogs will reflect the current status of each attributes properties. If, for example, you select 10 points, and 5 of them have the elevation rotation set at 45 degrees, and the other 5 are set at 0 (zero) degrees, then the rotation edit field will say *varies* to let you know that the properties of the points you selected are not the same. Here is an example of the dialog box.
The **X location** refers to the distance in the X direction from the center (or insertion point) of the point symbol. The **Y location** refers to the distance in the Y direction from the center (or insertion point) of the point symbol.

The **Layer** refers to the layer of the individual attribute, not the entire attribute block. To change the layer of the entire attribute block, use the **Attribute Block Layer** option. The **Height** is expressed in real units (generally feet or meters), not plotted size. The **Rotation angle** is expressed in absolute decimal degrees. The **Point Entity Layer** refers to the layer that the node of the point resides. The required layers can either be typed in manually, or the Select button can be used to pick from the existing layers in the drawing. If a new layer is desired, simply type in the name of the new layer and it will be created automatically. Use the layer property manager to edit the properties of this new layer, if required.

To change a point symbol, check on the **Symbol** option and use the select button to choose the desired symbol. The **Attribute Layout ID** refers to the attribute layout style defined in Point Defaults or Field to Finish code definitions. This option allows you to change the particular layout with one of the other available styles or to a customized style if defined. The Pick buttons allow you to pick two points to define a distance (or angle in the case of Rotation). If you want to select a line to define a distance or angle, select two points on the line with the appropriate OSNAP.

Each change to an attribute is defined separately. Select the attribute to edit, make the necessary changes to this attribute and then move on to the next attribute if required. Changes made to the attributes are remember individually, which allows for switching back and forth though the attributes until the command is completed. After completion the new settings for the point attributes will be retained until changed or redrawn on the screen.

**Edit Multiple Points dialog**

Again, the number of points selected will be shown in the dialog title. Let's now define the changes for each attribute individually. In the following example, suppose we want to rotate the elevation text to a 45 degree angle, move the description to the right and change the symbol. First, click on the Elevation for the Attribute to Edit. Now, select the Rotation option and type in 45. The dialog box should be as below.
Now, select the Description option for the Attribute to Edit. Select the X location from the Items to Change. Enter 1.50 in the box. This value makes the description line up better with the rotated elevation. The dialog should be as below:

Now, for the final change, select the Symbol for the Attribute to Edit. We want to actually change the point symbol. To do this, toggle on the option to change the symbol by clicking in the box beside the word Symbol. Next, press the Select button and select symbol SPT5. The dialog should be as below:
At this point we are ready to select the OK button to perform the changes. The following image shows the points before and after the changes.

Before and After Changes

**Pulldown Menu Location:** Points

**Keyboard Command:** modpnts

**Prerequisite:** Points drawn on the screen

**File Name:** \lsp\crdutil.arx

---

**Move Point Attributes Single**

This command allows the user to move Carlson point attributes (including the point number, elevation or description) one at a time.

**Prompts**
Select Point Number, Elevation, or Description to Move: *select point attribute*

Pick new location: *pick point*

Pick new angle: *pick new angle or press Enter*

Pulldown Menu Location: Points

Keyboard Command: movepnt

Prerequisite: Carlson points

File Name: `\lsp\surv1.lsp`

**Move Point Attributes with Leader**

This command allows the user to move Carlson point attribute (including the point number, elevation or description) and to draw a dynamic leader to the point node. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts.

**Prompts**

Select Point Label to Move (O for Options): *select point attribute*

Pick label position: *pick point*

Select another Point Label to Move (O for Options, Enter to End): *O*

**Minimum Leader Length Scaler:** Specifies the minimum length, in terms of multiples of the attribute block's height, that the leader must be.

**Draw Arrowhead:** Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

**Minimum Leader for Arrow Scaler:** Specifies the minimum length of the leader, in terms of multiples of the attribute block's height, that the leader must be before an arrowhead is placed on it.

Pulldown Menu Location: Points

Keyboard Command: movepntleader

Prerequisite: Carlson points

File Name: `\lsp\`

**Scale Point Attributes**

This command will scale point attribute text (number, elevation and descriptions) and point symbols up or down in size. The routine prompts for a scale multiplier and a selection set of objects. If you want to enlarge, enter a value
greater than one. If you want to reduce, enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. This command has the added benefit that it will adjust the point attributes and symbols to a new screen twist angle.

Prompts

Scaling Multiplier <0.500>: 2.5 This response would enlarge the point attributes and symbols by 250 percent.
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software points. pick a point
Select objects: Specify opposite corner: pick a point
Scaling Carlson Software Point Attributes ....
Number of entities changed> 174

Pulldown Menu Location: Points
Keyboard Command: pntenl
Prerequisite: Carlson points
File Name: \lsp\ptenl.lsp

Erase Point Attributes

This command allows you to erase point attributes like the number, elevation or description individually by picking on the attribute to erase.

Prompts

Select Point No., Elev, or Desc to Erase: select point attribute

Pulldown Menu Location: Points
Keyboard Command: erasepnt
Prerequisite: Carlson points
File Name: \lsp\surv1.lsp

Twist Point Attributes

This command will rotate the orientation of the text of Carlson point attributes (point #, elevation, description) and point symbols. The Twist Screen option aligns the point attributes to appear horizontal in the current twist screen. The Azimuth option allows you to enter an azimuth or pick two points to align the point attributes. The Entity Segment option aligns the point attributes by the selected line or polyline segment in the direction the entity is drawn. The Follow Polyline option aligns the point attributes by the polyline segment that is closest to the point.

Prompts

Twist by [<Twist screen>/Azimuth/Entity segment/Follow polyline]? F
Select reference polylines to follow. pick a polyline
Select objects: 1 found
Select objects:
Select points from screen, group or by point number [<Screen>/Group/Number]? select Enter
Select Carlson Software points.
Select objects: *pick the Carlson point inserts*

Point attributes aligned by Follow Polyline option of Twist Point

**Pulldown Menu Location:** Points  
**Keyboard Command:** twistpts  
**Prerequisite:** None  
**File Name:** \lsp\twist.pt.lsp

**Resize Point Attributes**

This command sets the size of the selected point attributes (point number, elevation, description) and point symbols. This command is similar to Scale Point Attributes, but instead of scaling the size by a factor, all the select points are set to the same specified size. Points can also be chosen based upon Point Groups.

**Prompts**

Enter point attribute and symbol size <4.0>: press Enter  
Scale symbols only, point labels only or both [Symbols/Labels/Both]? press Enter  
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter  
Select Carlson Software points.  
Select objects: *pick the point entities*
Finding Carlson Software Point Attributes ....  
Number of entities changed> 10

**Fix Point Attribute Overlaps**

This command is to be used to adjust point attribute labels to avoid overlapping labels. It applies adjustment methods based upon user-specified ordering and tolerances. The command steps you through any remaining overlaps in an Overlap Manager, which includes the capability to manually move labels. This point overlap feature is also available within the Draw-Locate Point and Field To Finish commands.
Methods: There are different methods of automatically solving a point attribute overlap. The methods will be applied in order from top to bottom on the Used Methods list. Unused methods appear on the Available Methods list. The methods are:

Alternate Layout ID 0-9
These methods will simply apply the specified attribute layout ID and then check to see if the attributes of the point in question still overlap. The different attribute layout IDs can be seen in the Point Defaults command on the Points menu.

Flip Individual Attributes
This method tests each attribute (point #, description, and elevation) by flipping it or mirroring it the other side of the point. The mirror is the vertical axis of the text that goes through the point entity. This method is not applied to points that have a leader.

Slide Individual Attributes
This method tests each attribute (point #, description, and elevation) by sliding it back and forth. The maximum distance the attribute will be moved is the horizontal length of the text. This method is not applied to points that have a leader.

Rotate (If Only One Attribute)
This method is applied if there is only one point attribute, either point #, description, or elevation. The one attribute is rotated around the point entity to see if the point overlap can be fixed.

Offset Attribute Block
This method is arguably the most powerful method and can solve any overlap by moving the attribute block far enough. See Offset Options below for a description of the options that can be used with this method.
Offset Options: These are the options that apply to the Offset Attribute Block method of automatically solving point attribute overlaps.

Maximum Offset Scaler: This specifies the maximum distance, in terms of multiples of the whole attribute block's height, that the attribute block may be offset from the point entity.

Use Leader: Specifies whether or not a leader should be drawn when offsetting the attribute block.

Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the height of an attribute's text, that the leader must be.

Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the height of an attribute's text, that the leader must be before an arrowhead is placed on it.

Use Selection Set for Points: Check this checkbox to be given the option of selecting which points in drawing to fix overlaps with. If not checked, then all the points in the drawing are used.

Avoid Linework Conflicts: Check this checkbox to prevent point attributes from overlapping linework in addition to other point attributes.

Review Remaining Overlaps: Check this checkbox to have the Overlap Reviewer dockable dialog come up after the automated process finishes. The Overlap Reviewer allows for reviewing the automated fixes as well as tools for manually fixing any remaining overlaps. See Overlap Reviewer below for more information.

Skip Resolved Overlaps: Check this checkbox to skip overlaps that were automatically resolved and to only review unresolved overlaps. If not checked, then both resolved overlaps and unresolved overlaps will be available for review. This option only applies if Review Remaining Overlaps is on.

Overlap Reviewer

The Overlap Reviewer will come up after automatic overlap fixing if the Review Remaining Overlaps checkbox was checked. This tool displays how many points were found, how many overlaps were fixed, which overlap is currently being viewed, how many overlaps there were total, and the point # of the current overlap. Use the First, Last, Back, and Next buttons to navigate forwards and backwards through the list of overlaps. Use the Move Block and Move Attrs buttons to manually move either the entire attribute block or individual attributes.
**Pan and Zoom Controls:** Use the buttons on the top to help zoom in and out and pan the drawing around. You can also use the standard mouse controls for panning and zooming.

**First, Last, Back, and Next:** These buttons allow you to step through each overlap or to jump to the first or the last.

**Status:** This drop-down list indicates the status of the current overlap. *open* means that the overlap has not been fixed yet. *resolved* means that the overlap has been fixed. *ignore* can be chosen by you to remove the overlap from the list.

**Restore:** Restores the attributes of the current point to their original location and rotation from before the Fix Point Attribute Overlaps command was run.

**Move Block:** Allows you to move one or more attribute blocks in the drawing. See the documentation for *Move Point Attributes with Leader* command in the Points menu.

**Move Attrs:** Allows you to move and rotate one or more individual attributes in the drawing. See the documentation for *Move Point Attributes* command in the Points menu.

**Auto-Zoom:** Check this checkbox to automatically zoom and pan the view as each overlap is viewed.

**Prompts**

The following prompt will be displayed if the Use Selection Set for Points checkbox is on and OK is pressed. **Select the points to fix overlaps with:** *pick the Carlson point inserts*
**Trim by Point Symbol**

This command will trim lines and polylines that pass through the selected point symbols such that the lines do not appear within the symbol. This should be a last step because this routine explodes the points and modifies the lines and polylines by trimming which makes these entities unusable by some of the other COGO routines.

**Prompts**

*Select Carlson Software point symbols to trim against.*
*Select objects: select the point symbols*

![Diagram before trim](image1)

Before Trim by Point Symbol

![Diagram after trim](image2)

After Trim by Point Symbol

**Change Point LayerColor**

This command changes the layer and optionally the color of Carlson points. The points are initially put in the layer set in Point Defaults. The symbol, point number, elevation and description are in the layers PNTMARK, PNTNO, PNTELEV, and PNTDESC. To change the point attribute colors, this routine creates new attribute layers based on the new layer name. For example if the new layer name was TRAV, then the resulting layers would be TRAVMARK,
TRA VNO, TRAVELEV and TRAVDESC. These new layers can be given different colors. To select an attribute color, pick on the color button. To permanently change attribute colors, edit the drawing SRVPOLO1.DWG in the Carlson SUP directory. To permanently change a symbol color, edit the symbol drawing itself.

The selection of the points to change can be accomplished in three ways. A number range selection would require the input of the range of points to change. An example would be 1-20,25,30, 32-36. Points groups can also be used as a selection method. Simply specify the point group name to change, when prompted, and all the points included in that group will be changed. The final selection method is that of Pick Points. Using this method a prompt to select objects is displayed. When prompted select the points to change from the screen.

Pulldown Menu Location: Points
Keyboard Command: pntchg
Prerequisite: Carlson points displayed in the graphic drawing window
File Name: \lsp\pntchg.lsp

Renumber Points

This command will edit the point number attributes of a group of Carlson points. The command prompts for the user to enter the point number difference. Enter the positive or negative amount you would like to have added/subtracted from the current value. After selecting the point to change, a prompt to delete the old point number is displayed. If yes is chosen the old point number is deleted from the CRD file, if no is selected the old and new point numbers are retained in the file. This results in one coordinate position represented by two point numbers.

The following illustrates number changes from point 4, 5 and 6 to 104, 105 and 106. This prompt sequence retains both numbers in the CRD file. If the intent is to renumber and delete the original points 4, 5 and 6, then Yes would be selected when prompted to Delete old point numbers.

Prompts

Positive number increases, negative number decreases Point number.
Point Number difference \[<1>: 100\] This response would add 100 to the current point number value.
Select Carlson Software Points for Point Number change.

Select objects: select a point number or a group of points by window or crossing

Delete old point numbers from file [<Yes>/No]? Choose correct response. In this example the response was N, leading to the following.

PT#: 6 changed to PT#: 106..
PT#: 5 changed to PT#: 105..
PT#: 4 changed to PT#: 104..
Number of entities changed: 3

Pulldown Menu Location: Points
Keyboard Command: renumpt
Prerequisite: Carlson points
File Name: \sp\renumpnt.lsp

**Explode Carlson Points**

This command can be useful if you need to send your drawing to another firm who does not have AutoCAD/Carlson. Drawing transfer problems occur when the recipient does not have the same block/inserts defined or available. This command explodes all blocks and replaces the Carlson point attributes with TEXT entities of the same value. After the points have been selected, a prompt for the layer name for each point attribute will be displayed. Point Numbers, Point Elevations and Point Descriptions can be put on user specified layers, or the default for each prompt can be selected. **Caution:** After using this command, the link between the points and the coordinate file are destroyed and you can no longer extract the attributes from the drawing. If you want to use this command but retain your point information, follow these steps:

1. Save your drawing
2. Run this command to explode the points
3. Execute the SAVEAS command and save the drawing as a different name (you can also choose DXF format if you wish).
4. Exit the drawing **without** saving.

**Prompts**

This command will explode selected Carlson Software point blocks and replot the attributes as Text entities! The resulting points will **NOT** be useable by most Carlson Software commands!!!!

Select Carlson Software Points to Explode, select points
Layer Name for Point Numbers <PNTNO>: press Enter
Layer Name for Point Elevations <PNTELEV>: press Enter
Layer Name for Point Descriptions <PNTDESC>: press Enter
Number of entities changed> 345

Pulldown Menu Location: Points
Keyboard Command: explode,scad
Prerequisite: Carlson points
File Name: \sp\scexp.lsp
Convert Surveyor1 to CRD

This command will convert a Surveyor1 coordinate file to the current Carlson format.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** SURVEYOR2CRD  
**Prerequisite:** A Surveyor1 coordinate file

Convert CRD to TDS CR5/Convert TDS CR5 to CRD

These commands convert coordinate file formats between a Carlson CRD file and a TDS CR5 file. Both of these file formats are binary which require these special routines. These commands will prompt for the file names to process.

**Pulldown Menu Location:** Points  
**Keyboard Commands:** crd_cr5, cr5_crd  
**Prerequisite:** A CRD or CR5 file  
**File Name:** \lsp\cogoutil.arx

Convert CRD to Land Desktop MDB

This command converts a Carlson CRD file into an Autodesk Land Development Desktop (LDD) point database file in Access MDB format. The LDD point database always has the file name of POINTS.MDB. So, to specify the LDD file to create, you only need to specify the directory/path and not the file name. This path corresponds to the LDD project directory. The conversion program has point protect, so that if a point number from the CRD file already exists in the LDD file, you then will be prompted to skip or replace the point. Once the command is executed, the following dialog is displayed. On this dialog, specify the Carlson CRD file to convert as well as the LDD (MDB) file to append, if existing, or create if creating a new LDD (MDB) file.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd_ldd  
**Prerequisite:** A .CRD file  
**File Name:** \lsp\gisutil.arx

Convert Land Desktop MDB to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD, also referred to as LDT) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in
the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog, specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** LDD crd  
**Prerequisite:** An LDD point database file  
**File Name:** \lsp\gisutil.arx

## Convert Civil 3D to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.
**Convert Carlson Points to Land Desktop**

**Function**

This command converts a Carlson CRD file into a Land Desktop point file. To do this, you must specify the existing Carlson CRD points to convert. You have the option of selecting all points, or selecting on-screen the specific points you'd like to convert.

**Prompts**

- Convert all or selected points [All/<Selected>]? press Enter
- Select Carlson Software Points to convert:
  - Select objects: pick first point for window selection method
  - Select objects: pick second point
  - Processing Carlson Software point...

**Convert Softdesk to Carlson Points**

This command converts Softdesk point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Softdesk points can also be read into the current CRD file by using the command *Update CRD File from Drawing* in *Coordinate File Utilities*, this updates the CRD file without modifying the screen entities.

**Convert Carlson Points to C&G**

This command converts a Carlson CRD file into a C&G Point file.
Specify the existing Carlson CRD to convert by selecting the Open Carlson CRD File button. Specify the existing C&G CRD file to write to, or the new C&G CRD file to create, by selecting either Open C&G CRD file or Create C&G CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd2cg  
**Prerequisite:** A Carlson CRD file

### Convert C&G to Carlson Points

This command converts C&G Points into a Carlson CRD file.

Specify the existing C&G File to convert by selecting the Open C&G CRD File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open Carlson CRD file or Create Carlson CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** cg2crd  
**Prerequisite:** A C&G point file

### Convert Carlson Points to Simplicity

**Function**
This command will convert Carlson points to Simplicity.

Select Carlson CRD file to convert by selecting the Open CRD file button.
Specify the existing Simplicity file to write to, or the new Simplicity file to create, by selecting either Open Simplicity File or Create Simplicity File. Press Export and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd_zak  
**Prerequisite:** A Simplicity point file

### Convert Simplicity to Carlson Points

This command converts Simplicity Points into a Carlson CRD file.

Specify the existing Simplicity File to convert by selecting the Open Simplicity File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open CRD File or Create CRD File. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** zak_crd  
**Prerequisite:** A Simplicity point file
Convert Leica to Carlson Points

This command converts LisCad or Leica point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Leica points can also be read into the current CRD file by using the command *Update CRD File from Drawing* in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** `2surv3`  
**Prerequisite:** Leica points

Convert Geodimeter to Carlson Points

This command converts Geodimeter point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Geodimeter points can also be read into the current CRD file by using the command *Update CRD File from Drawing* in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** `2surv4`  
**Prerequisite:** Geodimeter points

Convert Carlson Points to Ashtech GIS

This command converts Carlson point blocks in the drawing to Ashtech GIS point blocks. After executing the command, you will be prompted to select the points to convert. When using this command, the setting "Group Point Entities", found under General Settings of the Configure command (Settings menu) should be unchecked (turned off).

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** `2ashtech`  
**Prerequisite:** Carlson Points

Convert Carlson Points to Softdesk

This command converts Carlson point blocks in the drawing to Softdesk point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** `2soft`  
**Prerequisite:** Carlson points  
**File Name:** `\lsp\2soft.lsp`

Convert PacSoft CRD to Carlson CRD

This command converts a PacSoft CRD file to a Carlson CRD file. PacSoft stores the point descriptions to a separate coordinate descriptor file having an extension of PTD. This file should be present in the same directory as the CRD file to convert. Prompts for the PacSoft CRD file to convert, and the Carlson CRD file to create, will be
displayed. Once both files have been specified, the following dialog box will be displayed.

![PacSoft Conversion Type dialog box](image)

The **No Coordinate Conversion** option converts the file format while leaving the coordinate values unchanged. **Convert From Meters to Feet** will assume the coordinates in the selected PacSoft crd file are metric, and will convert the coordinate values to US Feet.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** pacsoft2crd  
**Prerequisite:** PacSoft crd file

## Convert Carlson Points to Eagle Point

This command converts Carlson point blocks in the drawing to Eagle Point point blocks. A prompt for the Eagle Point version to convert to will be displayed.

![Convert to what version dialog box](image)

Specify the appropriate version and then select the OK button. You will then be prompted to select the Carlson points to convert. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2eds  
**Prerequisite:** Carlson points

## Convert Eagle Point to Carlson Points

This command converts Eagle Point point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Eagle Point points can also be read
into the current CRD file by using the command Update CRD File from Drawing, found in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** 2surv2

**Prerequisite:** Eagle Point points

**File Name:** \lsp\2surv2.lsp
This chapter provides information on using the commands from the Survey pulldown menu, in order to download data from data collectors, process raw data and prepare plats. The first sections of the pulldown provide information on working with data collectors, editing and processing raw data and drawing Field to Finish. Carlson SurvNET is Carlson’s Network Least Squares Reduction (NLSA) program. Below that there are complex deed creation and linework commands. The bottom portion of this menu provides features for creating cut sheets, polyline data and other survey important requirements.
Data Collectors

This command does two main functions for a variety of popular data collectors. First, this command transfers (uploads and downloads) data between the data collector and Carlson. Second, this command converts data formats between the data collector format and the Carlson format. So, if you already have the data file on the computer, you can skip the transfer function and just perform the conversion function.

The transfer function does the conversion at the same time. In most cases, the download from the data collector produces a raw (.RW5) file (field notes) and/or a coordinate (.CRD) file (coordinate points). Several of the download programs have an option to automatically run the Edit-Process Raw Data File command after downloading raw data. You can also send, or upload, a coordinate (.CRD) file. The dialog shown here appears when the menu command is selected.

Carlson SurvCE: For Carlson Software data collection programs SurvCE and SurvStar. This button produces the SurvCOM dialog and program.
CG Field: For CG Field programs.
Surveyors Assistant: For data collectors running Surveyors Assistant software (Corvallis MC2, MC5 and Pentax SC5).
Sokkia SDR: For SDR2 through SDR 33 and other collectors that have a SDR format like the Trimble.
Sokkia G2: Specifically for the SDR2.
TDS: For data collectors that use TDS software (Ranger, HP48, HP95, Husky FS-2 & FS-3, Corvallis MC-V and TOPCON FS2, FC95 and FC48).
SMI: For SMI data collectors on the HP48.
Leica: For Leica GIF-10 module and Leica instruments.
Nikon: For Nikon DTM and DR-48 total stations.
Geodimeter: For the Geodimeter Geodat collector.
Topcon 210/310/220/GPT2000: Supports these Topcon models.
MDL Laser: For MDL Laser instruments.
General Kermit Transfer: For general transferring using Kermit.

Carlson SurvCE
Connect the serial cable. Select Data Transfer from the on the handheld. Choose Carlson/Carlson Survey Download. This leads to a File Transfer screen on SurvCE, which says "Awaiting Connection". All the action is on the PC side. There is no time delay in this handshake. It will wait for the PC program to catch up. When you connect the cable from SurvCE to the PC, Microsoft ActiveSync may interfere and say "Connect to PC?" If you get this question, say No or otherwise terminate the Microsoft ActiveSync linkage. Start the Carlson portion of this link by choosing Survey, Data Collectors, then the SurvCE option. If connection is automatically established, SurvCE will display, "Connected to PC".

If only the left side of the screen displays data, then you do not yet have a connection. Press the Connect button located at the bottom left of the file transfer dialog. The transfer program will respond with Retrieving File List. Once the file list has been retrieved, the left side of the dialog box will show files located in the specified path on the PC and the right side of the dialog displays the files located in the designated path on the remote. You can change directories by scrolling to the top of the file list and choosing the Up One Level (just like in Windows).

To transfer one or more files, simply select or highlight the desired files and select the transfer button. More than one file can be transferred from the remote to the PC or from the PC to the remote during the transfer process. Standard Windows selection options apply. For example, selecting one file and then while pressing the shift key on the PC, selecting another file deeper on the list will select all the files in between the first and last selected. You can also select the first file to transfer and press and hold down the shift key and use the down arrow to specify the range of files to transfer. Pressing and holding the control key on the keyboard allows for the selection of multiple files in any selection order, by picking the files with the left mouse button.

After the files have been selected, press the transfer button. When the transfer is complete, the program will return a "Transfer Complete" message, and will then proceed to update the file lists on the PC and the Remote.
**Connect:** After selecting Data Transfer in SurvCE, press this button to start the connection. Once connection is made, the status line on the file transfer utility dialog box will show Connected to the remote machine.

**Transfer:** Pressing this button transfers selected files from either the Remote to the PC, or the PC to the Remote.

**Set Path:** This option allows for the specification of the desired source and destination drives and folders for both the PC and the Remote device. For example, if you were downloading, or copying files from the Remote device to the PC, to specify a source path on the remote device, select the Remote Machine toggle and then type in the desired path in the path field. To specify a destination path on the PC, select the Local PC toggle and type in the desired path the path field. When a change to either path is made, the transfer utility will retrieve a new file list from the specified paths.

**Make dir:** This option allows for creation of directories on both the PC and the Remote device. Specify the hardware on which to create the directory and then enter the directory name.

**Delete:** This option allows you to delete the tagged files. To delete a file, select the file to delete by clicking on the file, press the delete button at the bottom of the dialog. Confirm deletion by selecting the appropriate response on the Delete File dialog.
Rename: To rename a file, click on the file to rename and select the rename button at the button of the dialog. On the dialog that displays type in the new name and press the OK button.

Options: This command allows you to set various options for data transfer. The dialog shown below will appear.

Com Port: You must select which com port on the PC to use.

If you are transferring data via a USB port, set the com port to ActiveSync, see the Options section below for procedures to change com ports. To transfer data using an USB port a connection between the Remote and PC using ActiveSync is required. In ActiveSync verify that the "Connect Settings" have been set to "Allow serial cable or infrared connection to this Com port" and Allow USB connection with this desktop computer. This will allow for connection using an USB port or a COM port connection. Both will use ActiveSync to transfer data between devices.
**File Mask:** You must select a file filtering syntax. This filter allows for the setting of specific file types to display. For example if you only wanted to see CRD files the filter would be *.CRD.

**Directory Sort:** You must select how to sort the list of files.

**Display Special Files:** Toggle whether or not you should see special files.

**Confirm Overwrite:** Check this to confirm before overwriting files.

**Baud Rate:** You must choose the baud rate for transferring data.

**Protect Remote Files:** Check this to protect files on the mobile device.

**Archive RW5 Files:** With this option set to YES, when downloading rw5 files, a second copy of the file will be made with a .SC5 extension to serve as an archive of the original rw5 file.

**Geoid:** This command will carve out a portion of the Geoid 99, EGM96, Canadian CGC2000, Canadian HT2.0, Canadian HT 1.01, Australian GDA94, Great Britain OSG-MO2 and Geoid 2003 grid files, and send it to SurvCE. Since these geoid grids are very large, this carves out a precise portion of it and avoids overloading the memory on the remote device running SurvCE. You will be prompted for the directory on the PC of the source Geoid grid file.
the approximate latitude and longitude of the job, and the size of the area desired in miles, kilometers or degrees of latitude and longitude. To define a Geoid area, make sure that this criteria is met:

1. Specify the location of the geoid grid files.
2. Specify the geoid type.
3. Enter the latitude and longitude near the center of the job area.
4. Specify the Grid size either in miles, km (kilometers), or deg (degrees).
5. Name the grid file.

The file will be transferred to the data collector and place in the appropriate place for use.

**F2F conv:** This converts the more thorough and detailed Carlson field code file (for field-to-finish work, *.FLD) to the more simplified Feature Code List that runs in SurvCE (*.FCL). The Feature Code List in SurvCE (not SurvStar or Field) handles Linework (on or off), Line Type (2D or 3D), Layer (= Code) and Full Text (Description). Select the Carlson field code (*.FLD) to convert, the conversion takes place and the file is transferred and located in the correct location for use in the data collector.
**Send Pnts**: This option allows for the uploading of a user specified point number range out of the selected crd file to unload. Use the Select button to specify the crd file to upload. The Remote File Name will default to the name of the crd file selected to upload. You can change this name if needed. Specify the Point Range to Send and select the OK button.

![Send Range of Points dialog box]

**Exit**: This command will exit the File Transfer Utility.

The following information describes the buttons on the Data Collection Programs dialog box that come after the Carlson SurvCE button, moving from left to right and then from top to bottom. The command/button name is on the far left margin, in bold:

**CG Field**

To transfer data to and from data collectors using CGField software, first make sure that the Baud Rate is set to 9600 and the Parity is set to NONE then follow the steps outlined below.

**Receiving a Coordinate File from CGField**

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 4, “Send Coords”
3) Select the Coordinate file to send.
Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the “Download Coordinates” button to ready Carlson to receive the file.
Stop here in Carlson and go back to CGField to complete the transfer process.

CGField:
Select the points to send.
1) For All points
2) To select Blocks of points.
3) From .PTS file (the set of points in a Batch Point File).

The coordinates will be transferred. After the transfer is complete, you will be asked for the CRD file name. The C&G CRD file will automatically be converted to a Carlson CRD file. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Receiving a Raw Data File from CGField

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 2, "Send Raw Data". Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download Raw" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

CGField:
Select the raw data file to be sent. The transfer will begin.
The C&G .RAW file will be transferred and saved in the data folder. After the transfer is complete, you will be asked for the RW5 file name. The RAW file will be automatically converted to a Carlson RW5 file.

Receiving an ASCII file from CGField

This will allow you to transfer a C&G report file (RPT) or an ASCII NEZ file to Carlson.
CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 6, "Send ASCII". Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download ASCII" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

CGField:
Select the ASCII file to send.
After the transfer is complete, you will see the file in the Carlson editor. You can then select FILE and SAVE (or SAVEAS) to save the ASCII file.

Sending a Coordinate File to CGField
CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 3, "Receive Coords" to ready the data collector. Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
1) Press the "Upload (Send Carlson File)" button.
2) Select the Coordinate file.
3) Select the points to send.
4) Press the "Start Transfer" button.

CGField:
Carlson will send the file name to CGField and a coordinate file with the same name will be automatically created or opened in CGField.
If the file exists you will be asked how you want to handle duplicate points:
1) Overwrite
2) Don't Overwrite
3) Ask for each Point
The point transfer will begin.

Convert CG .RAW to Carlson .RW5
This utility allows you to convert a C&G raw data file to a Carlson raw data file. Select the C&G .RAW file to convert. Then enter the file name of the destination Carlson RW5 file.

Thales/FastSurvey You will be taken directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

Surveyor's Assistant
Download
From the Surveyor's Assistant data collector, go to the Transfer routine from the main menu. Fill out the transfer screen as follows:
Direction: OUTPUT
Format: LIETZ
Data: Coordinate or All Data
Port: COM1 or COM2 Ckh Hold: NO
Protocol: NONE

You should also check the settings under the PORT menu. Typical port settings are baud=9600, parity=none, data=8, stop=1 and handshake=XON/XOFF. Now in Carlson, run Data Collection in the Survey menu and choose Surveyor's Assistant. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to Surveyor's Assistant and press GO. The file transfer should now go. If the All Data option is used, then the Leitz format will contain both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the Surveyor's Assistant. First go to the Transfer routine on the main menu. Fill out the screen as follows:
Direction: INPUT
Format: LEITZ
Port: COM1 or COM2
Protocol: NONE

Go back to Carlson and choose Surveyor's Assistant from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to the Surveyor's Assistant and hit the GO function key. The Surveyor's Assistant is now waiting to receive so return to Carlson and click OK on the range of point dialog. The file transfer should now go.
Sokkia SDR

This routine applies to the Sokkia SDR-20, SDR-22, SDR-31 and SDR-33 as well as other collectors that have SDR format transfer such as the Trimble and C & G.

Download

From the SDR data collector, go to the Communications routine from the main menu. Choose Data Format SDR. Next hit the Send function key. Then choose Select Jobs. From the list of jobs, highlight the job to transfer and set it to Yes with the arrow keys. Now in Carlson, run Data Collection in the Survey menu and choose Sokkia/SDR. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SDR and press OK. The file transfer should now go. The SDR format contains both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. The original SDR transfer file is stored on the computer as a RAW file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

The SDR-33 has different modes for storing and transferring data. In coordinate mode, the download will create points in the coordinate (.CRD) file and the raw data (.RW5) file will only contain some basic header lines. In the raw data mode, the download will create all the measurement data in the raw file and no points will be created in the coordinate (.CRD) file. For this raw data mode, you will need to run Edit-Process Raw Data File in the Survey menu to calculate the points from the raw data. The third mode in the SDR-33 creates both raw data in the raw data (.RW5) file and points in the coordinate (.CRD) file. The Include Time Stamps in Notes option sets whether all the date-time records for each point are put in the raw data (.RW5) file as description records. The Include Point Attributes in Notes option will store SDR code 13(AT) codes to the point note (.NOT) for the coordinate (.CRD) file.

Chapter 11. Survey Menu
Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the SDR. First go to the Communications routine on the SDR main menu. Choose Data Format SDR. Go back to Carlson and choose Sokkia/SDR from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. Then a Sokkia Options dialog appears for setting the job parameters for the file to be created on the collector. Be sure to choose the Distance Unit that matches your coordinate (.CRD) file (meters, US feet or international feet). Click OK and the next dialog now allows you to specify the range of point numbers to upload. Before clicking the Start Transfer button for range of points, go to the SDR and hit the Receive function key. The SDR is now waiting to receive so return to Carlson and click Start Transfer on the range of point dialog. The file transfer should now go.

Communication Settings
Besides matching the baud rate between Carlson and the collector, make sure that the collector is set to word length of 8 and 1 stop bit under the communication settings.

Print File
The Receive Sokkia Print File downloads a print report from the SDR33 data collector. This file is only used for printing report purposes in Carlson. This file is not used by Carlson to generate coordinate (.CRD) files or raw files. The first step is to choose Data format=Printed in the Communications menu of the SDR33. Next pick the Receive Print File button in Carlson. Then on the SDR33 choose the Send function and select a job to send. At this point the file is transferred. After downloading, the job report is displayed in the Carlson standard report viewer.

Example of Sokkia Printed Format:

```
SDR33 V04-04.25 (C) Copyright 1998 Sokkia May-29-80 23:39 01/29/1999
Angle Degrees  Dist Feet
```
Sokkia G2 This routine takes you directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**TDS**

**Download [HP-48 and Husky]**
In the TDS program, go to the File Transfer routine. Choose the type of data to transfer (CRD or RAW). Next pick the Send function key. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Download [Ranger and Windows CE]**
In the TDS program, go to the Transfer routine and pick the Send File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. In the Type field of the file selection dialog, choose Coordinate Files or Raw Files. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS and pick OK in the TDS dialog. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.
Upload [HP-48 and Husky]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the File Transfer routine. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

Upload [Ranger and Windows CE]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the Transfer routine and pick the Receive File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) file edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

SMI

Download
To send point data from the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TOPC] [COMM]. In SMI version 6 or later, type [Job][KERM][SEND]. Also in version 6, make sure that the first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. The [NE] stands for North-East coordinate order which is the format that Carlson expects. Also in the
[Job][KERM] screen, make sure that the second function key reads [COMM] and not [SPACE]. The [COMM] stands for comma separators. Then enter the first point to send followed by the last point to send but before pressing Enter for the last point go to Carlson. Run Data Collection in the Survey menu and choose SMI. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SMI and press Enter for the last point to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. To send raw data, use the [Print][Raw] routine in SMI along with the same Carlson procedure used for point data.

**Upload**

From the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TO48] [COMM]. In SMI version 6 or later, type [Job][KERM][RECV]. Also in version 6, make sure that first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. Then enter the first point to send followed by the last point to send. Next enter the job name but before pressing Enter go to Carlson and run SMI under Data Collection in the Survey menu. In the Carlson dialog, specify the same job name as entered in SMI. Next pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the same range of points as entered on the SMI. Go back to SMI and hit Enter for job name followed by clicking the OK button for range of points in Carlson. The file transfer should now go.

![SMI HP-48 Data Collection](image.png)

**Leica**

There are two types of Leica transfers: GIF-10 and GeoCom for all other Leica instruments. The type is set in the Equipment Type field on the main dialog. For transferring with the Leica instruments, the GeoCom program shows a dialog of the available COM ports on your computer. On the first time that you transfer to an instrument, you will
need to pick the Instruments button and register the instrument from the list. Pick the Port Settings button to make sure that the communication settings match the instrument.

To download a file with GeoCom, make sure that the instrument is ON and connected to the computer by serial cable. The instrument also needs to be in GeoCom mode. Then pick the Download in the Carlson dialog. In the GeoCom program, open the computer COM port that the instrument is connected to by picking the ‘+’. Then open the Memory Card and GSI folders. Next select the file to transfer and click the OK button. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

To upload a file with GeoCom, specify the file name to be created on the instrument in the Leica File field and pick the Upload button in the Carlson dialog. Then the program will prompt for the range of points to transfer. Fill out the range and pick the Start Transfer button. Then the GeoCom program will start. Open the computer COM port by picking the ‘+’. Then open the Memory Card folder and highlight the GSI folder and click OK.

The upload and download file transfer works with the GIF-10 data collector. The GIF-10 communication settings should be the following:

- Baud: 9600
- Parity: NONE
- Protocol: NONE
- Stop Bit: 1
- End Mark: CR/LF
- Connected As: Some computers use DCE and others use DTE
Download
From the GIF-10, go to the file transfer routine. Then go to Carlson and run Data Collection in the Survey menu and choose Leica. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to GIF-10 and select the file to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Upload
From the GIF-10 data collector, go to the file transfer routine. Then go to Carlson and run Leica under Data Collection in the Survey menu. In the Carlson dialog, specify the job name in the Leica File field. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to GIF-10 and start the receive by highlighting Receive and pressing the Run button. The GIF-10 now shows the available job numbers. Choose a job to receive the transfer using the arrow buttons and then press the Run button.

Converting
Carlson supports raw and coordinate data collected using three different Leica Operation Codes: Wildsoft and 10-20-30-40 as well as the newer LISCAD. Moreover, data could be in the GSI8 format or the newer GSI16 format. Some example files are shown here.

GS18 format data file using LISCAD Operation codes:
WILD GIF-12
410149+00000001 42....+00005003 43....+00005.42 44....+00005.25 45....+00005000
110150+00005000 21.324+35959480 22.324+09238590 31..01+00228271
Leica raw files usually have a .RAW or .GSI extension. The primary difference in the GSI8 and GSI16 formats is that information is contained in data blocks of 16 characters in the GSI16 format, while it is contained in blocks of 8 characters in the GSI8 format. Leica instruments make it possible to have both the GSI8 as well as GSI16 data formats in the same raw file. However, lines with the GSI16 format data will always start with an asterisk (*) character, to distinguish them from the GSI8 format. There is no distinction between Leica raw files collected in the Wildsoft and LISCAD operation codes.

**Supported Wildsoft codes:**

1: Start Job  
11: Assign Coords  
12: Coord Offset  
13: Target Height  
14: Add to Tgt Ht  
15: Add to Meas Dist  
2: Occupy Point
21: Occupy Saved Point
3: FS to Trav Pt
31: FS to Single Pt
32: Radial Sideshots
33: Sets of Angles
4: Closing Pt
41: Closing Angle
50: BS to Benchmark
51: FS to Turn Pt
52: BS to Turn Pt
53: FS to Benchmark
60: Save Point
61: Recall Point
62: Compare Point
63: Remark

Supported LISCAD codes:
1: New instrument setup
2: New target height
3: Sets of directions
4: Fixed azimuth
5: Feature code
6: Measured offset
8: Line creation for sub-codes 1 (straight string), 2 (curved string) and 6 (arc by 3 points)
9: Fixed coordinates
11: Close string
14: Additional description
20: Start of job
27: Feature code
90: Split feature code
100+: Descriptions

The Convert button can be used to convert any Leica format file into a Carlson format file. For example, if you have a Leica PCMCIA card then there is no serial cable transfer to do. Instead use the Convert routine to make the Carlson raw data (.RW5) and coordinate (.CRD) files. Since there is no distinction between Wildsoft and LISCAD files, the user must know in advance which format has been used in the file. Then, select that particular option (Wildsoft, 10-20-30-40 or LISCAD) under the "Coding System" option at the bottom of the dialog box, as shown in the previous page. Another option that the user needs to choose is the order in which foresight-backsight readings have been recorded in the raw file, BFFB or BFBF, as explained in the dialog box. Then, the user can simply pick the "Convert" button and the program prompts for the input" Wild/Leica File" (raw file), and the output" Carlson RW5 file" and "Carlson CRD file", if they are not already filled.

Nikon

Download
First choose the equipment and data type under the Transfer Type list. Also check that the communication and data format settings match your collector. Then click the Download button and follow the on-screen directions. When the transfer is complete, the program will ask you for the Carlson coordinate file (.CRD) and raw file (.RW5) to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the
coordinate file for existing point data before downloading the point from the data collector. The original data from the collector is stored in a file name with the same name as the coordinate file except with a .TRN extension. For example, job5.crd would have job5.trn.

**Upload**

Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Set the points and then click the Start Transfer button. The file transfer should now go.

---

**Convert Nikon to Carlson**

The Convert button will translate the Nikon raw file format (.TRN or .RAW) into Carlson coordinate (.CRD) and raw (.RW5) files.

**Portion of typical Nikon file format:**

MP,1,.5000.0000,5000.0000,0.0000,T/1
ST,1,.0000,.0000,.0000,0.0000
SS,3,.0000,152.1510,359.59590,90.44100,11:43:38,T/2
SS,4,.0000,127.5560,.06040,90.40110,11:44:45,CON
SS,5,.0000,.97.1820,2.1980,90.52460,11:45:43,CON

**Geodimeter**

**Download**

From the Geodimeter data collector, go to the file transfer routine by pressing the PRG (Program) key and entering
program 54. Then choose Imem (option 1) as the source. Next choose the file type to send as either Job (measurement data) or Area (point data). The Geodimeter will then prompt for the job name. Next enter Serial (option 3) as the destination. A confirmation screen appears showing the serial port settings. Here are some typical settings:

COM=1,8,0,9600

Before pressing enter (ENT key), go to Carlson and run Data Collection in the Survey menu and choose Geodimeter. Then click the Download button and within 15 seconds, go back to the Geodimeter and press Enter. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate file and raw file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Upload**

In Carlson, run Geodimeter under Data Collection in the Survey menu. Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the points to send but before clicking OK, go to the Geodimeter data collector. Start the file transfer routine by pressing the PRG key and entering program 54. Then choose Serial (option 3) as the source. The Geodimeter will display the serial port settings. Check these values and press enter. Next choose Area (option 2) as the destination. Then enter the job name. The Geodimeter is now listening for data. Quickly go back to Carlson and click OK on the points to send dialog. The file transfer should now go.

**Convert**

The Convert button will translate the Geodimeter raw file format (.OBS) into Carlson coordinate (.CRD) and raw (.RW5) files.

**Communication Settings**

If the Geodimeter is not communicating with Carlson, run function 79 on the Geodimeter and make sure that it is
set to 4. This setting is for the transfer message end of sequence format.

**Supported Geodimeter Codes**
The following Geodimeter codes are processed when converting the Geodimeter raw file. All other codes are recorded as descriptions in the Carlson rw5 file.

0=Info
1=Data
2=Station No
3=Instrument Height
4=Point Code
5=Point Number
6=Signal Height
7=Horizontal Angle
8=Vertical Angle
9=Slope Distance
11=Horizontal Distance
17=Horizontal Angle
18=Vertical Angle
21=Horizontal Reference Angle
30=Atmospheric Correction
37=Northing
38=Easting
39=Elevation
40=Delta North
41=Delta East
42=Delta Elevation
45=Correction To Bearing
46=Standard Deviation
50=Job Number
51=Date
52=Time
53=Operator
54=Project Id
55=Instrument Id
56=Temperature
60=Shot Id
61=Activity Code
62=Reference Object
70=Entered Radial Offset
71=Entered Angle Offset
72=Calculated Radial Offset
73=Calculated Angle Offset
74=Air Pressure

**Portion of typical Geodimeter file format**

5=108
4=13POC
6=5.000
7=238.0708

---

*Chapter 11. Survey Menu*
8 = 89.2236
9 = 440.39
37 = 767.42
38 = 4626.07
39 = 699.795

**Topcon 210/310/220/GPT2000**

This command supports these above Topcon models.

**MDL Laser**

The MDL Laser outputs a raw file of angles, distances and codes as one long string of data which can be converted into a Carlson raw data (.RW5) file. There is no coordinate data in the MDL raw file. So you need to run *Edit-Process Raw File* to calculate coordinates from the raw data. The Download button will transfer the MDL raw data from a BDI logger.
Kermit

Kermit can be also used for transferring files with accuracy. The dialog looks like this:

**Pulldown Menu Location:** Survey
**Keyboard Command:** datacolt
**Prerequisite:** None
**File Name:** \lsplsp\cogoutil.arx
Edit-Process Raw Data File

This program reads or creates a raw data (.RW5) file that contains various lines of data (records) that could be likened to a surveyor's field book. You can specify point coordinates, job information, notes, and the angles and distances that make up traverse or sideshots records. Once the raw data is created or read it can be processed/reduced to coordinates that are stored in the current coordinate (.crd; .cgc; .mdb; .zak) file.

The raw file can also be created or appended using the Locate Point, Traverse, Sideshot, and Inverse commands on the COGO menu. To store the data inputs from these commands into a raw file, first toggle on the Raw File ON/OFF command on the COGO menu. It is possible to always have the raw data file open to store data inputs. To enable this option, choose Configure from the Settings menu, then choose Survey Module, then choose General Settings. Turn on the Automatic Raw File toggle in this dialog.

The raw files created by TDS data collector programs are also compatible without conversion. The command Data Collectors on the Tools menu has options for reading other data collectors native file formats and converting them to raw data (.RW5) format. Within the raw data editor, the File menu includes an import menu for converting raw data from other formats.

When you select the Edit-Process Raw Data File command you are prompted to specify the name of the raw data (.RW5) file. The current coordinate file is used automatically. To change the current coordinate file, use the Set Coordinate File command in the Points menu before starting this command. If no coordinate file is current, the program will prompt you to set the current coordinate (.CRD) file.

Edit-Process Raw Data File uses a spreadsheet for editing the raw data as shown. Each row of the spreadsheet is represented by a number located at the far left side of the editor. Various messages and reports often reference possible problems with the data by this row number. Each row of the spreadsheet represents one record of data. There are 14 types of data records. The type of data record is shown in the first column. Different record types use different numbers of columns. Whenever the data record type changes between rows, a record header is added to the spreadsheet that describes each column of data in the following row. To edit the raw data, simply highlight the cell and type in the new value. To change the type of record, pick on the down arrow in the first column and choose a new data type from the list. To delete a row, highlight any cell in the row and hit the Delete key or choose Delete Row from the Edit menu. Records can be added pressing the Insert key, pressing the down arrow key from the last line in the spreadsheet, or by choosing one of the add records from the Add menu.
The different record types are described below.

**TR (Traverse)**
The traverse record contains the occupied point number, foresight point number, angle mode, horizontal angle, distance, vertical angle and description. When processed, this record will calculate and store the coordinates for the foresight point. Traversing also moves the setup by making the traverse foresight point the next occupied point and the traverse occupied point becomes the next backsight point. The different angle codes are NE for northeast bearing, SE for southeast, SW for southwest, NW for northwest, AZ for azimuth, AL for angle left, AR for angle right, DL for deflection angle left and DR for deflection angle right. To set the angle code, pick on the Code down arrow and choose from the list. The horizontal and vertical angles should be entered as dd.mmss. For example, 45.2305 is 45 degrees, 23 minutes and 5 seconds. The vertical angle can be shown as vertical angle (0 degrees level), zenith angle (90 degrees level) or elevation difference. The vertical angle mode is set in the Display menu. The distance mode is also set in the Display menu as either slope or horizontal distance. The description field is used as the foresight point description.

**SS (SideShot)**
The sideshot record is the same as the traverse record except that sideshot does not move the setup.

**HI (Instrument and Rod Height)**
This record sets the instrument and rod heights used in elevation calculations. This record should precede any traverse and sideshot records that you want the heights applied to.

**BK (BackSight)**
The backsight record contains the occupied point number, backsight point number, backsight azimuth and the set azimuth. This record should precede any traverse and sideshot records that use this setup. If no backsight point is entered, the program uses the backsight azimuth to turn angles from. The Set Azimuth is the circle reading of the instrument when sighting the backsight. A Set Azimuth of zero is the default.

**PT (Store Point)**
The store point record consists of a point number, northing, easting, elevation and description. When processing,
this data will be stored as a point in the coordinate file. If the first Occupied point and/or the initial Backsight point are not defined in the coordinate file set for processing to, both points will need to be added to the rw5 file as PT (Store Point) records.

**DS (Description)**

The description record is an additional note that appears in the spreadsheet editor and printouts. This record can contain various information that is recorded in data collectors during field operations. This data can vary from user, temperature and general data to each line of data associated with "Set Collection". When "Sets" of data collected using various brands of data collection software is converted/imported into the raw editor, the actual measurements made during the spinning of the angles and distances are recorded as DS records and the mean value of the angle and distance is recorded as a SS record. DS records are not used in processing.

**CL (Closing Shot)**

The closing shot record is the traverse record where the foresight point is the closing point for the traverse. This record is used by the adjustment commands in the Process menu. There should be only one CL record in each Traverse loop (Name Record) in the raw file. If there is no CL record, the process adjustment routines will prompt for which shot is the closing shot. The closing shot can also be define in the field by using special codes defined in the Open Settings found under the File pulldown within the editor. Please refer to the "Open Settings" documentation below for more information on these codes.

**AB (Angle Balance)**

The Angle Balance record is the measurement data observed that closes the angles of the traverse. Typically this record is the measurement data recorded from the closing shot to the initial backsight point. The backsight could be either external or internal to the traverse. Angle Balance routine in the Process menu uses this record and compares the angle between the occupied point and foresight point of this record with a user-specified reference angle. There should be only one AB record in the raw file. If there is no AB record, then the Angle Balance routine will prompt for which shot to use as the angle balance.

**CL + AB (Closing Shot and Angle Balance)**

This record is used as both the closing shot and angle balance records.

**FD (Foresight Direct)**

The foresight direct is a traverse record used in a direct and reverse set. When the program finds one the of direct-reverse measurement records, it will look for the other three records to complete the set.

**FR (Foresight Reverse)**

The foresight reverse is a traverse record used in a direct and reverse set.

**BD (Backsight Direct)**

The backsight direct is a traverse record used in a direct and reverse set.

**BR (Backsight Reverse)**

The backsight reverse is a traverse record used in a direct and reverse set.

**EL (Elevation Only)**

This record sets the elevation in the CRD file for the specified point number. Often used when an existing point with good vertical control is being traversed through. Using this record type for the point would keep the elevation from changing on the existing point regardless of the measurement data.

**AZ (Azimuth Only)**

Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**CSE (Control Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**SSE (Set-up Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**MSE (Measurement Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**NAME (Traverse Name)**
This record acts as an identifier for the group of records that make up a traverse. All the records after the NAME record belong to that traverse up to the next NAME record or the end of the file. This record allows you to have multiple traverses in one raw file. When running one of the Process commands, the program will bring up a list of all the traverse names. Simply choose which traverse to process. If you have only one traverse in the raw file, then you don't need the NAME record.

**GPS**
This record contains the Latitude and Longitude of a point as measured by GPS surveying equipment using Carlson SurvCE data collection software. This record has additional information tied to it such as localization files, geoid files, coordinate projection systems etc. This record has its own processing routine in the Process pulldown within the editor. Processing procedures are discussed in the Process (Compute Pts) pulldown documentation.

**Raw Data Editor Pulldown Menus**

**File Menu**

*Open RW5 File*
This command prompts for a rw5 file to load into the editor.

*New RW5 File*
This command clears the editor spreadsheet.
**Save RW5 File**
This saves the rw5 file. If the file hasn't been named you will be prompted for the file name and the location to save the file. After you perform the first save, this command acts as a quick save and saves the file to the name and location specified during the initial saving of the file.

**Save RW5 As**
This command saves the raw editor data in the spreadsheet to a rw5 file and always prompts for file name and location to save.

**Open CRD File**
This command prompts for an existing coordinate file to set as the active coordinate file for the raw editor.

**New CRD File**
This command prompts for a new coordinate file to set as the active coordinate file for the raw editor. The coordinate data will be initialized as empty.

**Save CRD File**
This command saves the current coordinate data in the raw editor to the current coordinate file.

**Save CRD As**
This command saves the current coordinate data to a specified coordinate file name.

**Report/Print**
There are three types of reports: Raw Data, Coordinates and Summary. A sample of the raw data report is shown below. This report shows the data from the raw editor spreadsheet. The Coordinates report lists the point data (point number, northing, easting, elevation, description) from the current coordinate file. The summary report groups the traverse, sideshot and store point numbers along with a list of the setups and the shots from each setup.

```
Raw File> c:\data\survey.rw5
CRD File> c:\data\survey.crd
Note
Survey Example
PntNo Northing Easting Elevation Desc
1   5000   5000   100   START
OcPt BsPt SetAzi
   1
InstHgt RodHgt
5.32   6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 1 2 AR 268.5330  711.420  89.4050   P2
InstHgt RodHgt
5.43   6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 2 3 AR 262.5448  457.760  89.3236   P3
InstHgt RodHgt
5.4   6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 3 4 AR 208.5710  201.310  89.1803   P4
TR 4 5 AR 247.1657  497.120  88.5235   P5
TR 5 6 AR 277.4835  223.980  90.2926   P6
TR 6 7 AR 92.4113   233.880  90.2746   P7
InstHgt RodHgt
5.42   6.0
OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR 7 8 AR 261.2756  387.250  91.4405   CLOSE
```
**Report/Print Settings**

This dialog has settings for the report functions.

![Print Settings Dialog](image)

**Import**

These routines convert raw data from other formats into the current Carlson RW5 format. The converted raw data will be added to the end of any existing data in the editor. In many cases, the raw data file to import can be downloaded directly from the data collector or instrument using the *Data Collectors* command. The following supported formats (along with their standard file extension) are listed here. Some Sample File Formats are listed at the end of this section.

- **C&G (.CGR;.RAW;.TXT;*)**
- **CalTrans (.DMP)**
- **Carlson (.RW5)**
- **Fieldbook (.FBK):** From Softdesk, Land Development Desktop or Civil 3D.
- **Geodimeter (.OBS; .RAW; job;*)**
- **LandXML (.XML)**
- **Leica (.GSI; .RAW; GRE):** This reads the Leica raw file in Wildsoft, Liscad, 10-20-30-40, C&G, or GeoComp format. There are options to specify direct-reverse shot order if any and to convert from International Feet to Leica US Feet.
Maptech (.FLD)
MDL Laser (.CDS)
Nikon (.TRN; .RAW)
PC Cogo (.BAT)
SDMS (.prj;*)
SMI (.RAW)
Sokkia SDR (.SDR; .RAW;*)
SurvCOGO (.RAW or .TXT)
SurvCE Archive (.SC5) When downloading a .rw5 file from SurvCE using SurvCOM, there's an option to copy the .rw5 file to a .sc5 file as a read-only backup.
Survis (.RAW)
TDS (.RW5; RAW)
Topcon (raw;*)
Trimble (.dc)
3TA5 (.TXT)
Zeiss (.DAT)

Export
These routines convert the Carlson raw data (.RW5) file to other formats. The following file formats are supported.

CalTrans (DMP)
Fieldbook (.FBK): This export routine provides an option to "Setup Fieldbook Codes". This allows the user to substitute the raw description contained in the .rw5 file with the fieldbook code used in AutoDesk Land Desktop or Civil 3D.
### FL DOT (.OBS)
- GPS Data (.TXT;*)
- Land XML (.XML)
- MOSS (.MOS)
- RMGeo (.txt)

**SDMS (.PRJ)** This export routine provides an option to "Setup SDMS Codes". This allows the user to substitute the raw description contained in the rw5 file with the SDMS codes used in SDMS program.

### Sokkia (.SDR)
- TDS (RW5;RAW)
- VA Dot (TOP)

**Open/Save Settings**
This option allows for defining codes that represent the closing shot and angle balance shot of a traverse. These codes can be entered in the description of a point while in the field. When the rw5 is opened in the raw file
editor, the measurement data containing the closing shot code will be set to a CL record and the measurement data containing the angle balance code will be set to an AB record. This allows for quick processing of the survey data and saves the time spent setting up the file for processing.

Exit
Exits the raw file editor.

Edit Menu

Undo: This command undoes the last data entry or the last copy, cut or delete command performed on keyboard entered data only. This will not undo a change to the Type or Code columns, nor a cut or copy command to a row.

Cut: Standard windows cut command. Removes data from editor and places it in the windows clipboard.

Copy: Standard windows copy command. Copies selected data to windows clipboard.

Delete: Deletes selected data or row of data. Will not delete headers if data is present below the header.
**Find:** Tool to search and find a particular word, letter, numeric value or a combination of all. Provides options to Match whole word only and/or case. Allows for a up or down directional search from the active cell in the editor.

![Find Dialog Box](image)

**Replace:** Tool to search and replace a particular word, letter, numeric value of a combination of all. Options to Match whole word only and/or case is provided for the search criteria. Provides further options to Replace individual items one at a time or to Replace All.

![Replace Dialog Box](image)

**Go To:** Tool to advance the focus of the active cell to a specified line number.

![Go To Dialog Box](image)

**Delete Row:** This command deletes the row containing the active cursor or cell. You can delete a row by placing the cursor in any of the cells in the row that you wish to delete, or by picking on the row number at the far left of the editor.

**Modify Measurements:** This option allows for a change in distance, horizontal angle or vertical angle by a specified
amount for the entire file or for a specified point number or line number range. To modify a measurement, choose which field to modify, enter the change in either distance or angle in dd.mmss format. Next choose how to apply the modification. If all is selected, the change will be applied to all records in the specified field. If By Point Number is chosen, enter the point number or range of numbers in the Range of Points field. If by Line Number is chosen, then define the area for the change by specifying the Starting and Ending line.

Convert Points To Notes Records: This function converts point (PT) records to note (DS) records. This leaves the information of the point coordinates in the rw5 file as display only and without having the point coordinates stored to the coordinate file when the file is processed. The point data in the DS records can be converted back to PT records by picking the Code field in the spreadsheet and switching DS to PT.

Edit Coordinate File: This option allows for editing and/or listing of the coordinate data in the active coordinate file. The active coordinate file is displayed in the Header of the raw data editor. This routine brings up the edit point dialog and allows editing of the points one at a time.
Display Menu

Angles: This option chooses the angle format between degrees/minutes/seconds (dd.mmss) and Gons-400 decimal degree circle (dd.dddd). This setting applies to the angles in the spreadsheet editor as well as the angle format for reports.

Vertical: The options contained in this menu allow for specifying the type of vertical measurement information you will input or is contained in the rw5 file. The Vertical Angle selection assumes the barrel or scope of the instrument is level when reading 0 (zero). With this setting, the vertical component of a measurement record will have a header of VertAng. The Zenith Angle selection, most commonly used, assumes the barrel/scope to be level when reading 90. Using this setting results in a header of ZenithAng. Elevation difference displays the elevation difference between the occupied and foresight points. If the Distance option is specified as Slope, this elevation difference will be used.
to calculate the horizontal distance of the measurement. The header for this record is ElevDiff. The None selection assumes all distances are horizontal distances and removes the vertical component for a measurement from the editor. Switching modes can be performed at any time.

Distance: This option controls the display of either Slope or Horizontal Distances. Changing the display results in the distance data adjusting to reflect the correct value for the selection made. The Vertical data, VertAng, ZenithAng or VertDiff, is used to convert the distance value when changing this display option.

Graphics: The Raw Data Editor uses an optional graphics window to display the points and traverse lines in real time. As data is entered or edited, the graphics window will be updated to show the configuration or new configuration of the traverse. The option of whether to show sideshots is also available. When a cell is selected, the traverse or sideshot line in the display window will change to the color yellow for a graphical reference. The graphics window is toggled on or off from the Display — Graphics Window menu inside the raw file editor.

Graphics>On: Turns the graphics window on.
Graphics>Off: Turns the graphics window off.
Graphics>Show Sideshots: Controls the display of the sideshot data in the graphics window. Figure 1 shows the graphics window with sideshots on. Figure 1A shows the graphics window with sideshots off.
**Graphics>Zoom Mode:** Within the graphics window, real time zoom is available. To zoom in press and hold the left mouse button and drag in the direction of the + symbol. To zoom out, press and hold the left button and drag in the direction of the - symbol.
**Graphics > Pan Mode:** Real time pan is available within the graphics window. To pan, set the graphics window to pan mode, then press and hold the left mouse button and then drag to desired position.

**Graphics > Resize Text:** With this option on the text becomes smaller/larger in the view when you zoom in/out.

**Graphics > Fixed Text Size:** With this option on, the text stays a fixed size while zooming in and out.

**Spreadsheet Colors:** This option allows for the assignment of colors to record types. To change/define the color for a particular record, select Spreadsheet Colors from the Display pulldown within the raw editor. From the Color Settings dialog select the record to edit by clicking on the select button next to the desired record.

The color slide beside the select button shows the current setting for the record. After selecting the record, the Select Color dialog box will be display. Select the Set button next to the desired color for the record.
**Display > Hide Row:** This option allows for hiding single or multiple rows. This could be used to prevent crucial information from being accidentally altered during editing of data or data entry. Hiding a record does not exclude it from processing. To hide a record click on the row number at the far left of the editor. The entire row of data will highlight, now select the Hide Row option. Multiple rows or data can be selected by selecting the first row of data to hide then while holding down the shift key on the keyboard, select the last row to hide. All rows in between these two selections will be highlighted, now select Hide Row. When a row or rows of data are hidden, the row numbers will reflect the hidden rows. For example, Figure 2 below shows a multiple selection of rows 10-17 to hide. Figure 2A shows the editor with the rows hidden. Notice that the row numbers indicate hidden rows by showing a gap from rows 9-18.

![Figure 2](image-url)
Show Row: This option shows rows that have been hidden. To show hidden rows, the row above the first hidden row and the row below the last hidden row must be selected by using the shift key selection method described in Hide Row above. After selecting the appropriate rows, select the Show Row option. Figure 2B shows the selection of rows 9 & 18 in order to show the hidden rows 10-17. Figure 2C shows the editor after the Show Row option has been selected.
**Hide Description Records:** This option controls the visibility of the Description records contained in a rw5 file. The description record is an additional note used to store useful information in addition to typical point data. Sometimes these records clutter the raw file and make it hard to review actual survey data. The ability to control the description record visibility is a useful tool when reviewing survey data.

**Show Description Records:** This option shows (unhides) description records contained in the rw5 file.

**Hide Record Headers:** This option hides the in-line headers such as the PntNo, OcPt, FsPt, etc. The editor contains "Smart Headers" that changes with the type of data that is in the active row. These headers are not in-line and are always displayed at the top of the editor. Figure 2D shows the editor with the record headers hidden and the Smart Header active. Row #21 contains the active cell, the automatic header at the top of the editor shows traverse (TR) record headers.
Add Menu

- **Traverse**: Adds a traverse record (TR) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

- **SideShot**: Adds a sideshot record (SS) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

- **Backsight**: Adds a backsight (BK) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.
the current row.

**Instrument Height:** Adds an instrument height (HI) record to the editor. This record contains both the instrument and rod height setting.

**Point:** Adds a point (PT) record to the editor. Provides options to either add a Blank Point Record or Import From Coordinate File.

Inserting a blank record allows for manual input to define the coordinates for the point. Import From Coordinate File imports the coordinate values from an existing point or range of points contained in the coordinate file. Enter the point number or range of points and select OK. The points will be read into the rw5 file at the top of the file.

![Add Point From Coordinate File](image)

**COGO Command:** Adds COGO Command (CC) record with a field to specify the command (Translate, Rotate, Scale or Align) and a field for entering the parameters. The COGO commands are executed in sequence as the rw5 file is processed from top to bottom by any of the process methods in the Process menu. The COGO commands are all transformation commands that are applied to the points in the current coordinate file. The following list is the syntax of the COGO commands:

- **Translate:** Range Dx Dy Dz Process_Zero_Z
- **Rotate:** Range Angle Base_Y Base_X
- **Scale:** Range Scale Base_Y Base_X Use_Z
- **Align:** Range From1 To1 From2 To2

All the parameters are entered into one spreadsheet cell next to the COGO function. The parameters use space separators. The following list is the parameter definitions:

- **Range:** point numbers
- **Dx:** delta easting (X)
- **Dy:** delta northing (Y)
- **Dz:** delta elevation (Z)
- **Process_Zero_Z:** toggle for whether to process points with elevation of zero (0=No, 1=Yes)
- **Angle:** rotation angle in dd.mmss format
- **Base_Y:** base point northing
- **Base_X:** base point easting
- **Scale:** scale factor
- **Use_Z:** toggle for whether to scale the elevations (0=No, 1=Yes)
- **From1:** point number of first source point
To1: point number of first destination point
From2: point number of second source point
To2: point number of second destination point

For example, to translate points 1-10 by a delta Z of 6.0 while filtering out zero elevation points, set the parameters for the COGO Translate record as "1-10 0 0 6.0 0".

**Elevation:** Adds an elevation (EL) record to the editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Note:** Adds a note (DS) record to the editor. Note records are for information display and do not effect processing except for two special notes which are:
- Elevation: 2D
- Elevation: 3D

These special notes set the elevation mode for processing for the records that follow the note. The raw editor starts in 3D mode. The "Elevation: 2D" note will switch processing to 2D mode and the "Elevation: 3D" note will switch the mode back to 3D. In 2D mode, the processing will not set the elevations in the coordinate file.

**Data On/Off:** Adds a data on/off (DO) record to the editor. This record toggles the raw data between processing on and off modes. The raw data starts in processing on mode. Working from top to down, when a DO record is reached, the processing mode is turned off. Then next DO record will turn processing back on, and so on. Data records that are in processing off mode and skipped when running the routines in the Process menu.

**Traverse Name:** Adds a traverse name (Name) to the editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**GPS:** Adds a GPS record to the editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Reference Azimuth:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Control Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Setup Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Measurement Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Process (Compute Pts) Menu**
This menu contains tools to process raw data by various methods. The calculated coordinates, and notes if specified, are stored to the active specified coordinate file. The coordinate file can be specified using Set Coordinate File, under the Points pulldown within the drawing screen, or from the Tools menu of the editor, discussed later in this section. The options for processing are specified within either the Process Options dialog box or the Closure Options dialog box, depending upon. This dialog box is displayed before processing data, using any of the available methods, with the exception being the Least Squares method.
Multiple Measurements To Same Point: This option sets the method of how to handle multiple measurements to the same point. There are three available options, Use Last, Average or Use First. Use Last uses the last measurement to calculate the position of the point. Average uses the average of all the measurements for the position calculation and Use Last takes the last measurement to the point as the data to use.

Use Backsight Reciprocals: The Backsight Reciprocal options treat reciprocal measurements "special". A foresight to point 15 from a setup on 14, followed by a backsight from 15 to 14, makes a pair of "reciprocal" measurements. The backsight "reciprocal" measurement can be ignored for its impact on recalculating the occupied point (None Option), or the elevation of component of the reciprocal measurements can be averaged (Average Elevation option), or both the elevation and distance can be averaged (Average Elev & Dist) to recalculate the setup (occupied point) coordinates.

Calculate Elevations: This option determines whether the elevations of the points will be calculated and written to the coordinate file. Options of whether to calculate All elevations or just the Sideshots Only are provided.
Direct-Reverse Vertical Angles: Specify whether to balance all or process the direct-reverse shots and use only the foresight direct shot.

Report Angle Format: Specifies the angle format for the report. The By File option makes the report use the angle format in the raw data (.RW5) file.

Calculate Elevations: This option controls which point elevations will be calculated. For example, if the traverse point elevations have already been adjusted and you need to recalculate the sideshot elevations, then use the SideShots Only option.

Report SideShots: Specify whether to include the sideshot data in the process results report.

Point Protect: This option will check the coordinate (.CRD) file for existing point data before processing. If the foresight point number for any traverse or sideshot record already is a stored coordinate in the coordinate (.CRD) file, then the program shows a list of conflicting point numbers. You can either continue processing and overwrite the coordinate (.CRD) file coordinates with the calculated raw file coordinates or cancel the processing to go back to the editor to change foresight numbers.

A report of the conflicting point numbers can be generated to the standard report viewer in Carlson by selecting the Report option on the Point Protect dialog box. From the report viewer, the report can then be printed, sent to the screen or saved to a file.
Create Point Notes: This option will generate a note (.NOT) file named after the coordinate file. The note file contains additional descriptions for points. With this option active, the text from all note records (DS records) will be stored to the note file for the foresight point number preceding the note records.

Calculate Grid Scale Factor at Each Setup: This option will calculate a scale factor for each TR and SS record. This scale factor is calculated as the average of the scale factors at the occupied and foresights points. At these points the scale factor is calculated as the projection grid factor multiplied by the elevation factor which is the earth radius divided by the elevation plus the earth radius \[ SF = \text{Grid Factor} \times \left( \frac{\text{Earth Radius}}{\text{Elevation} + \text{Earth Radius}} \right) \]. In order to calculate these projection grid factors, the traverse coordinates must be in grid coordinates. When this option is selected, the program will prompt for the projection and zone to use. The elevation for the scale factor can be adjusted by the geoid height using the geoid specified in the Geoid To Apply list. The geoid height is added to the point elevation to adjust the elevation value used in the scale factor equation. The geoid surface files are not installed by default due to the large size of these files. To install the geoids to use with this option, go to the Carlson Software webpage and download the Geoid Grid Files from the Support->Downloads section.

Report Each State Plane Scale: This option becomes available if the Calculate State Plane Factor at Each Setup has been selected. With this option on, the scale factor at each point will be shown in the process results report.

Scale Factor: This value is multiplied by the slope distance for the traverse and sideshot records.

Correct for Earth Curvature: This option adjusts the calculated points for the effect of the Earth's curvature. Typically this adjustment is small and adjusts the elevation more than the horizontal.

Report Angle Format: This option controls the angle format displayed on the process result report. The option of By Raw File will display the angles in the format that is contained in the raw file. The Bearing option will display the angle in a bearing format. The Azimuth option will display the azimuth of the measurement and the Angle Right option will display the angle right measurement of the observation.

Decimal Places for Report: This option controls the number of decimal places for the reported data.
**Report Closure:** This option determines whether the closure report will be displayed after processing. If processing a topo survey where the traverse has not been closed, then turn this toggle off for quick processing.

**Report Sideshots:** Controls whether the sideshot data is shown on the process report.

**Reference Closing Point:** This is an optional field for entering the coordinates to compare the ending traverse point with. This reference closing point is used to calculate the closure. Without using this option the program will by default use the starting coordinate as the reference closing point.

**Report Output:** There are three report output options contained in the raw editor, the *Standard Report Viewer*, the *Custom Report Formatter* and the *Tabular Report Viewer*. Each is documented below.

The *Standard Report Viewer* is the default report viewer throughout the program. Any routine that generates a report has this option and the data contained in the report depends upon the routine executed. The report viewer is also a text editor. It allows for addition and deletion of text in order to customize the report for printing or for saving to a particular format for a file. Options to print, send to the screen in the drawing window as text or save to a file are available.

The *Custom Report Formatter* allows for customization of the process results by selecting the fields and the layout of the fields to display. The settings can be saved to a format name and recalled when needed. Options to Delete, Export and Import saved Formats are also available.
To create a report, select data from the Available list and then select the Add button. This will populate the Used field with the selected data. Standard window selection methods can be used when selecting the data to report. Holding the ctrl key while selecting data allows for making random selections. Holding the shift key while selecting data will select the first item picked, last item picked and all items between.

The **Tabular Report Viewer** displays a report viewer consisting of tabs. Each tab organizes and displays different data depending upon the process option chosen. The process results using the No Adjust method results in three tabs the Report Header, Unadjusted Data and the Store Points tabs. Each of these tabs display different information which corresponds to the tab title. Using an adjustment method results in five tabs. In addition to the three listed above, an Angle Balance and Compass Closure tab is added. From the Tabular Report Viewer, the Standard Report Viewer can be switched to by pressing the Report option at the bottom of the dialog. This is useful when wanting to combine all tabs into one report for printing or saving to a file. An example of a Tabular Report for a compass rule adjustment is shown below.
Processing Methods

No Adjust: No Adjust means that no angle balance or traverse adjustment will be applied. Options are specified in the Process Options dialog. After picking OK for the process options dialog, a Traverse Points dialog appears for entering the starting and ending point numbers.

The program reads the raw file to set the defaults for these point numbers which are used to calculate the closure. The difference between the ending point and the reference closing point is the closure error and the sum of the traverse distances from the starting to the ending point is used as the total distance traversed. After picking OK for the second dialog, the program starts processing the raw file from the top record down. The result is displayed in the Standard Report Viewer which can save, print or draw the report.

Angle Balance: This process method applies an angle balance to the traverse lines when calculating the coordinates.
The angle balance takes the angular error divided by the number of traverse lines and adjusts the angle of each traverse line by this amount. The angular error is the difference between the angle balance shot and a reference angle. The angle balance shot is specified as a type AB or CL+AB record in the raw file. If no AB record is found in the raw file, then the program will prompt for which traverse shot to use as the angle balance shot. The angle from the angle balance shot is calculated as the angle from the occupied point to the foresight point. The reference angle can be specified as a bearing, azimuth or by two point numbers in the dialog shown.

The angle balance report shows the unadjusted points, the unadjusted closure, the angular error, the adjusted points and then the adjusted closure. Typically but not always, applying the angle balance correction will improve the traverse closure.

**Compass, Crandall, Transit:** These process methods apply the selected rule to the traverse lines when calculating the coordinates. After adjusting the traverse, the sideshots are also recalculated. The closure error is calculated as the difference between the closing shot and a reference point. The closing shot is specified as a type CL or CL+AB record in the raw file. If no CL record is found in the raw file, then the program will prompt for which traverse shot to use as the closing shot. The foresight point is used as the closing coordinate. The reference point can be specified by point number or by entering the northing, easting and elevation. The process results report shows the unadjusted points, closure error, adjustments to each traverse point and adjusted point.

**Prepare Least Squares Data:** From the raw file data, this routine makes initial calculations for the coordinate points in the traverse.
This data, along with the control point coordinates and the angle and distance measurements, is stored to a data file with the same name as the current RW5 file except with a .LSQ extension (ie: survey.lsq goes with survey.rw5). The constraints of the routine are:

**All angle readings must be in angle right mode.**

**The coordinates of the starting and the ending points must be known.**

The routine begins with a dialog for specifying the reference closing coordinates and any scale factors to apply to the distance measurements. The Reference Closing Point is the last point in the traverse, whose coordinates must be known. If an angle balance shot is used in the traverse, the Reference Angle Balance Angle must also be specified, either as a value or as the angle between known points.

Since angles and distances have errors of different magnitudes, they are normalized using weights, based on the accuracy and confidence with which these quantities have been measured. There is a dialog for specifying the estimated measurement errors. The Reading Error is the horizontal angular error in the instrument. For example, for a "5-second" instrument this error would be 5. The Pointing Error accounts for several factors in the horizontal angle reading including accuracy lining up the crosshairs on the target, the target size and the optical quality of the instrument. The Target and Instrument Centering Errors are the distance off the point due to faulty centering. The EDM Constant Error is the accuracy of the instrument distance measurements. The EDM Scaler Error is entered in parts per million for the increased error in longer measurements. These settings can be saved and loaded as a way to store settings for different equipment.
The program will calculate the weights for each distance and angle measurement using these measurement errors. The control points, points to adjust, distance and angle measurements with weights are reported. You can edit these measurements and weights using the Edit Least-Squares Data routine or go directly to the Process Least-Squares Data routine.

**Edit Least Squares Data:** This routine edits the points, measurements and weights stored in the .LSQ file associated with the current RW5 file. The editor works through the dialog shown. You can edit, add or remove the control points, adjust points, angle measurements or distance measurements. The program does not check that the editing is valid. So you need to make sure that your changes keep a good set of least-squares data (i.e. don’t delete a needed control point). The Distance Error button allows you to set the distance standard error weights for all the distance measurements to the same value. Likewise the Angle Error button sets the standard error weights for all the angle measurements.

**Least-Squares Input Data:**

**Control Points**

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5000.0000</td>
<td>5000.0000</td>
</tr>
<tr>
<td>8</td>
<td>5000.0000</td>
<td>5000.0000</td>
</tr>
</tbody>
</table>

**Distance Observations**

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Distance</th>
<th>Std-Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>711.409</td>
<td>0.018</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>457.745</td>
<td>0.017</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>201.295</td>
<td>0.017</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>497.024</td>
<td>0.018</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>223.972</td>
<td>0.017</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>233.872</td>
<td>0.017</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>387.073</td>
<td>0.017</td>
</tr>
</tbody>
</table>

**Angle Observations**

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Angle</th>
<th>Std-Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>268.533</td>
<td>15.10408</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>262.5448</td>
<td>13.68258</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>208.5710</td>
<td>30.36335</td>
</tr>
</tbody>
</table>

Chapter 11. Survey Menu
BSight Occupy PSight Angle StdErr

7 1 2 268d53'30'' 7.617''
1 2 3 262d54'48'' 6.869''
2 3 4 208d57'10'' 15.194''
3 4 5 247d16'57'' 14.222''
4 5 6 277d48'35'' 12.262''
5 6 7 92d41'13'' 15.818''
6 7 8 261d27'56'' 12.991''
7 1 8 01d59'18'' E 0.001''

Process Least Squares Data
This routine applies a least-squares adjustment to the data stored in the .LSQ associated with the current raw data (.RW5) file. The closing errors are distributed among the other points, using the "Method of Least Squares" (Ref: Wolf, P.R. and Ghilani, C.D., 1996, "Adjustment Computations", John Wiley and Sons, NY, Third Edition). After the adjustment, the rest of the raw file is processed to recalculate the sideshots. There is an option to draw standard error ellipses around the adjusted points. The ellipse axes are multiplied by Ellipse Scale Factor to make the ellipse larger for easier viewing.

The least-squares process report shows the input data and the results. For each point, the amount adjusted and the standard error in X and Y are reported. The Reference Standard Deviation is based on the sum of the residuals and the initial estimated standard errors. The Chi-Squares test is a goodness-of-fit test that checks the reference standard deviation with the least-squares model. If this test fails, there may be a blunder in the measurement data or the initial estimated standard errors were too low or too high.

Stadia Processing Method: Provides functionality to process Stadia surveying notes. Stadia sighting depends on two horizontal cross-hairs, known as stadia hairs, within the telescope. These hairs are parallel to the horizontal cross-hair and are equally spaced above and below it. The distance between the two stadia hairs is known as the intercept. The distance from the instrument to the rod is 100 times the intercept. For example, an intercept of 3.10 would represent a distance of 310 (3.10 X 100). For entering in stadia notes, you would enter the horizontal angle, the distance (entered as the intercept X 100) and the vertical angle.

GPS: The process GPS routine allows for reduction of GPS records that reside in a raw (*.RW5) file from latitude, longitude and WGS84 Ellipsoid Height to State Plane or local coordinates. When selected, the GPS Settings dialog will appear as shown below.
GPS > Projection Type:
Defines the datum coordinate system to be used for converting the latitude, longitude and WGS84 Ellipsoid height collected from the GPS receiver into Cartesian coordinates. The supported projection types are State Plane 83, State Plane 27, UTM, Lat/Long, Great Britain-OSGB36, Australia, New Zealand-NZGD2000, New Zealand-NZGD49, and France NTF-GR3DF97A. A User-Defined option is also available for defining a user projection.

The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and SGM02 (Britain). GeoUser-Defined projections are supported. To define a new projection select the Define Projection option. This will bring up the following dialog.
Enter a name for your system (e.g. PRVI for Puerto Rico/Virgin Islands), then select a Projection type and enter the appropriate parameters. Note that all latitude and longitude values are in Degrees Minutes and Seconds (dd.mmss) and False Northing and False Eastings are always presented in meters. Define a Datum shift by selecting the Select Datum radial button. You may select a predefined Ellipsoid or set your own parameters by typing in a new ellipsoid name in the Ellipsoid field and entering values for a and 1/f. When you enter in a new Ellipsoid name, the Datum name field will be blank. The values for Dx, Dy, Dz, Rx, Ry, and Rz and scale are "to WGS84". If the values you have are "from WGS84", simply reverse the sign of each value (positive becomes negative and vice versa).

You may save your system to a "udp" file. To Load a user defined coordinate system from a file, select the Load radial button. A list of user defined systems will be displayed. Select the desired system and press OK.

**GPS>Zone:** for State Plane projections, you must select the correct state zone that you are working in. For UTM, the Automatic Zone option will have the program automatically use the correct UTM zone for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual option applies to working on the border between zones and you want to force the program to always use one of those zones.

**GPS>Use Alignment File For Localization:** With this option toggle on, a prompt for the Alignment File to Process will be displayed. This file is typically created by SurvCE (Carlson's Data Collection System) using the Localization routine or by Carlson Field Using the Align to Local Coordinates routine. This file (*.DAT) contains the parameters to transform the derived State Plane coordinates to the defined local coordinates.

At the end of the process, the coordinates will be written to the current coordinate (*.crd) file and a report will be presented in the Carlson editor for saving or printing purposes.

**GPS>Transformation:** The transformation in the align Local Coordinates command can either be by plane similarity or rigid body methods. The difference is that the rigid body method does a transformation with a translation and rotation and without a scale The plane similarity does a rotation, translation and scale. This option only applies when two or more points are used in Align Local Coordinates or the Localization routine in SurvCE.

**GPS>One Point Alignment Azimuth:** This option applies to the rotation when using one point in Align Local Coordinates or the Localization routine in SurvCE. For this alignment method, the state plane coordinate is translated to the local coordinate. Then the rotation can use either the state plane grid or the geodetic as north. No scale is applied in this transformation. The state plane and geodetic true north diverge slightly in the east and west edges of the state plane zone. This option allows you to choose which north to use.

**GPS>Two Point Alignment Method:** There are two option when using this method, Fit & Rotate and Rotate Only. Fit & Rotate will use the second point in the localization file for direction and scaling. The Rotate Only option allows you to use the second point in the localization file for direction but not for scaling. When using the Rotate Only option, any scale factor entered in the Project Scale Factor will be used.

**GPS>Project Scale Factor:** For most applications, the Scale Factor should be set to 1.0. The scale factor represents the "combined" grid/elevation factor that reduces ground distances to grid. After converting the LAT/LONG from the GPS records to state plane coordinates and applying the coordinate alignment (Localization) file, the Project Scale Factor is applied as the final adjustment to the coordinates. This adjustment is used on the X, Y, and not the Z. The Project Scale Factor is applied by dividing the distance between the coordinate and a
base point by the Project Scale Factor. The coordinate is then set by starting from the base point and moving in the direction to the coordinate for the adjusted distance. The base point is the first point in the alignment (Localization) file. If there are no points specified in the alignment file, then 0,0 is used as the base point. If using an alignment file (Localization File) this value will be automatically calculated and displayed. Manual entry of a scale factor is also permitted and is often used with the Two Point Alignment Method when a scale factor is known.

**GPS>Geoid to Apply:** The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and SGM02 (Britain).

This option will account for the geoid undulation in determining the orthometric elevation of the measurement. The definition of the geoid model as currently adopted by the national Geodetic survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares sense, global mean sea level. Orthometric elevation measurements are used in survey calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric elevations (E0), you must provide for a correction between the GPS-measured ellipsoid (reference ellipsoid) and a constant level gravitational surface, the geoid. This corrections is the geoid undulation (Ug). The formula is He=E0 + Ug.

Carlson applies the Geoid model by subtracting the Geoid undulation from the GPS elevation. The resulting elevation is then used and displayed. In practice, the Geoid model is most applicable to two types of alignment scenarios. One of these types is when setting up the base over a know point and having no alignment control points. The other is when there is one alignment control point. When using multiple alignment control points, the Geoid model is not as important because Carlson can model the elevation difference which can generally pick up the local Geoid undulation.

**GPS>Units:** Coordinates can be reduced into one of three available units, Metric, US Feet or International Feet.

**Process>Process Settings:** This option allows for the setting of user preferences and tolerances to be used during processing and generation of reports.
Multiple Measurement Settings: These options provide control for managing how multiple measurements to the same point are handled and reported.

Distance Tolerance Horizontal and Vertical: Allows for user input of desired tolerance values for multiple measurements. Exceeded tolerances will be displayed on the process results report. With the Report Residuals option ON, the residual values of the measurements will be shown on the process results report. The data to be averaged can be either the Distance Measurements or the Coordinates.

Check Point Settings: These options provide user controls for survey check points. With Report Check Points ON, any point coded as a check point in the raw data file, will be reported. When selected the Check Point Code and Distance Tolerance fields become active and allow for editing. The Check Point Code is a user specified code entered in during the survey that tells the program to check the coordinates of a particular point with the coordinates of another point. This code is configurable by the user. An example of a point description coded as a Check Point would be as such, "trav =8". This description tells the program that the description of the point is "trav" and to check the coordinates of the this point with that of point #8. The Distance Tolerance Horizontal and Vertical are user specified tolerances for the check point. If either of these tolerances is exceeded it will be reported on the process results report.

Instrument/Rod Height Ranges: These settings are used to check the instrument and rod heights when the raw file is processed. The program will report warnings if there are any heights that exceed the specified min/max ranges.

Angle Only Measurements: The Combine Elevations Method applies to points calculated from Angle Only measurements. Angle Only points are calculated as part of the processing for the No Adjust, Compass, Crandall, Transit and Angle Balance process methods. To calculate points from Angle Only measurements, there needs to be multiple SS records with horizontal and vertical angles and no distance with the same target foresight point number from setups at different occupy points. The elevations can be set as the average from the multiple measurements, using the highest measured elevation, or using the lowest measured elevation. For example, to survey the top of a tree, you could have a SS to foresight point 99 from occupy point 1 with a horizontal and vertical angle and another SS to foresight point 99 from occupy point 2 with a horizontal and vertical angle. Then point 99 can be calculated by angle-angle intersect which determines the horizontal distances from 99 back to occupy points 1 and 2. These distances are then used with the vertical angles and occupy point elevation to calculate the elevation at point 99.

Store Point Records: These options control how any store point (PT) record is handled during processing of the raw data file. There are three options for storing Store Point (PT) records, Never, Always, and When CRD Empty. Never prevents any Store Point (PT) Record Report in the raw file from being written to the crd file. With this option on no existing point in the crd file would be overwritten. Always will write to the coordinate file and will overwrite any existing point with the same number of the Store Point (PT) records. The When CRD Empty option will only write Store Point (PT) records to the coordinate file when it is empty. Report Store Points displays all store points in the process results report. The Hold Store Points option will hold the coordinate values for the store point record when measurements are taken to the store points. This will prevent the coordinates of the point from changing if measurements to the point dictate a change in coordinate position.

Direct-Reverse Settings:

Direct-Reverse Vertical Angles: This option determines how to handle direct-reverse vertical angle measurements when processing. Balance Direct-Reverse will take the mean of the direct-reverse measurements and
use this value when processing the file. **Direct Only** will only use the direct measurement to the point for processing.

**Foresight-Backsight Measurements:** Balance Foresight-Backsight allows for averaging in the Foresight and backsight measurements when using direct-reverse sets. The Foresight Only option will average the foresight measurements only of a direct-reverse set.

**Horizontal Angle Tolerance (Seconds):** This is the tolerance that the angle measured by the direct measurements and the angle measured by the reverse measurements in a direct-reverse set must fall within.

**Flip Angle Tolerance (Seconds):** User specified value for the acceptable difference in measured horizontal angles determined from the direct (BD-FD) and reverse (BR-FR) observations.

**Distance Tolerance:** User specified tolerance for the difference in distance measurements to the same points. When this value is exceeded on a measurement, it will be displayed on the process results report.

**Measurements To Control Points:** The **Store To Current Coordinate File** option applies when a control coordinate file is used in addition to the active coordinate file. When processing the raw file, measurements to point numbers that are in the control coordinate file will not be stored into the active coordinate file when this option is on.

**Drawing Points and Linework:** This option controls the drawing of points and linework using Field to Finish. It differs from the draw traverse and sideshot lines under the Tools Menu of the Raw Editor by using a field to finish code table (*.fld) to define how the points and linework are to be drawn and layerized. There are three settings for this option, Manual, Auto and Prompt. Manual means that the file will not be processed using the field to finish codes and no points or linework with be drawn upon existing the raw editor. The Auto option will use the current or last used field to finish file (*.fld) to draw the points and lines on the drawing screen when the raw editor is existed. The option of Prompt will give the option to draw the points and lines to the screen. With this setting specified, the following prompt will be displayed when existing the editor.

![Field To Finish](image)

**Tools Menu**
**Direct-Reverse Report:** This routine creates a report of direct and reverse shots along with the resulting averaged shots. Any tolerance specified in the Process Settings > Direct-Reverse Settings section, that is exceeded will be displayed in this report. The residuals are the difference between the measurement and the final average.

**Reduce Direct-Reverse:** This routine processes the direct and reverse shots and simplifies the raw file by replacing the sets of direct and reverse shots with the resulting average traverse record.

**Update Raw from Points:** This routine is used to update the raw data based upon the coordinates of the points contained in the coordinate (*.crd) file. For example, if the raw data has been processed using the compass rule adjustment method, the points in the crd file are now adjusted. However, the raw data remains unchanged. If a record of the rw5 file reflecting the angles and distances between the points after an adjustment has been run is desired, this routine can be run thus updating the raw data to reflect the adjusted angles and distances. Another application for this routine is that of building a rw5 file for future processing and adjustment. For example, if a point file or text file has been received from another engineering firm or fellow surveyor and you would like to build a rw5 file for future reference and processing, this option can also be used to accomplish this. The rw5 file would be set up with the occupied points, foresight points and the desired angle type to use specified for the traverse. This would be all the manual entry of the data necessary. After creating the "shell" of the traverse, then run the update raw from points routine and the raw data, as contained in the coordinate file, will be imported into the rw5 file thus filling out the horizontal angle, distance and vertical components specified.

**Find Bad Angle:** This routine prompts for another raw data (.RW5) file which is read and the data added to the end of the existing raw data (.RW5) file. For example, if you are editing the raw file from the first days work and have a separate raw file with a second days work, you can use this routine to add the second raw data to the first raw file.

**Draw Traverse-Sideshot Lines:** This routine draws lines for all the traverse and sideshot records. Sideshot Traverses are traverses that do not lead to the closing or ending point. There are different layers so that the lines can be drawn with different colors. This command does not process the raw file. Instead, it reads the raw file and for each traverse and sideshot record, the program looks up the coordinates for the occupied and foresight points in the CRD file. So it may be necessary to run Process > No Adjust before running this routine. With the Erase Previous Traverse-Sideshot Lines toggled on, any previous linework drawn using this method will be erased from the drawing screen before drawing the lines again.
**Renumber Points**: This routine renumbers points in the raw file. This applies to all point numbers including: TR, SS, and PT records.

**Range of Points to Renumber**: Enter in the range of points to change, ie 1-4.

**Line Number to Begin Renumbering**: This corresponds to the line number located at the far left or the raw data editor. Enter the line number to begin the renumbering.

**Line Number To End Renumbering**: This also corresponds to the line number located at the far left on the raw data editor. Enter the line number to end the renumbering. If the range of numbers specified does not occur between the beginning line number and the ending line number, no changes will be made.

**Numbers to Add to Point Numbers**: Enter in the value to add. This number will be added to the existing point number to create the new point number. For example, if the number to add is 10 and the existing point numbers 1 and 6, the new renumber points will be 11 and 16.

**Point Groups**: This option can be used to organize the survey data into point groups. There are three options for the creation of point groups, Create All Point Group, Create Traverse Point Group and Create Sideshot Point Group. The Create All Point Group option, creates a Traverse Point Group containing all of the points defined in the rw5 file. The Create Traverse Point Group creates a user specified group containing only the points defined in the traverse records (TR) of the rw5 file. The Create Sideshot Point Group creates a user specified group that contains only the points defined in the sideshot records (SS) of the rw5 file.

**Format of the raw data (.RW5) file**

The Carlson raw data format is a comma delimited ASCII file containing record types, headers, recorded data and comments. The format is based on the RW5 raw data specification, with the exception of angle sets. Angle sets are recorded as BD, BR, FD and FR records to allow reduction of all possible combinations. Essentially, these records are identical to a sideshot record.
Backsight Record
Record type: BK
Field headers:
OP Occupy Point
BP Back Point
BS Backsight
BC Back Circle
Sample(s):
BK,OP1,BP2,BS315.0000,BC0.0044

Line of Sight Record
Record type: LS
Field headers:
HI Height of Instrument
HR Height of Rod*
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
LS,HI5.000000,HR6.000000
LS,HR4.000000

Occupy Record
Record type: OC
Field headers:
OP Point Name
N Northing (the header is N space)
E Easting (the header is E space)
EL Elevation
– Note
Sample(s):
OC,OP1,N 5000.00000,E 5000.00000,EL100.000,–CP

Store Point Record
Record type: SP
Field headers:
PN Point Name
N Northing
E Easting
EL Elevation
– Note
Sample(s):
SP,PN100,N 5002.0000,E 5000.0000,EL100.0000,–PP

Traverse / Sideshot Record / Backsight Direct / Backsight Reverse / Foresight Direct / Foresight Reverse
Record type: TR / SS / BD / BR / FD / FR
Field headers:
OP Occupy Point
FP Foresight Point
(one of the following)
AZ Azimuth
BR Bearing
AR Angle-Right
AL Angle-Left
DR Deflection-Right
DL Deflection-Left
(one of the following)
ZE Zenith
VA Vertical angle
CE Change Elevation
(one of the following)
SD Slope Distance
HD Horizontal Distance
– Note
Sample(s):
TR,OP1,FP4,AR90.3333,ZE90.3333,SD25.550000,–CP
SS,OP1,FP2,AR0.0044,ZE86.0133,SD10.313750,–CP
BD,OP1,FP2,AR0.0055,ZE86.0126,SD10.320000,–CP
BR,OP1,FP2,AR180.0037,ZE273.5826,SD10.315000,–CP
FD,OP1,FP3,AR57.1630,ZE89.4305,SD7.393000,–CP
FR,OP1,FP3,AR237.1612,ZE270.1548,SD7.395000,–CP

GPS
Record type: GPS
Field headers:
PN Point Name
LA Latitude (WGS84)
LN Longitude (WGS84, negative for West)
EL Ellipsoid elevation in meters*
– Note
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
GPS,PN701,LA42.214630920,LN-71.081409184,EL-21.8459,–C
P /Brass Disk
Alphabetical listing of Record Types
BD Backsight Direct
BK Backsight
BR Backsight Reverse
FD Foresight Direct
FR Foresight Reverse
GPS GPS Position in Lat (dd.mmss) Lon (dd.mmss - Negative for West) and WGS84 Ellipsoid Elevation in meters

Alphabetical listing of Field Headers
AD Azimuth Direction ( 0 for North, 1 for South)
AL Angle-Left
AR Angle-Right
AZ Azimuth
BC Back Circle
BP Back Point
BR Bearing (this field will be recorded as N123.4500W)
BS Backsight (when back point is not defined)
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Change Elevation</td>
</tr>
<tr>
<td>DL</td>
<td>Deflection-Left</td>
</tr>
<tr>
<td>DR</td>
<td>Deflection-Right</td>
</tr>
<tr>
<td>DT</td>
<td>Local Date (MM-DD-YYYY)</td>
</tr>
<tr>
<td>E</td>
<td>Easting (the header is E space)</td>
</tr>
<tr>
<td>EC</td>
<td>Earth Curvature (0 for off, 1 for on)</td>
</tr>
<tr>
<td>EL</td>
<td>Elevation (GPS value is ellipsoid elevation in meters)</td>
</tr>
<tr>
<td>EO</td>
<td>EDM Offset</td>
</tr>
<tr>
<td>FE</td>
<td>Foresight Elevation</td>
</tr>
<tr>
<td>FP</td>
<td>Foresight Point</td>
</tr>
<tr>
<td>HD</td>
<td>Horizontal Distance</td>
</tr>
<tr>
<td>HI</td>
<td>Height of Instrument</td>
</tr>
<tr>
<td>HR</td>
<td>Height of Rod</td>
</tr>
<tr>
<td>LA</td>
<td>Latitude</td>
</tr>
<tr>
<td>LN</td>
<td>Longitude</td>
</tr>
<tr>
<td>N</td>
<td>Northing (the header is N space)</td>
</tr>
<tr>
<td>OC</td>
<td>Occupy Point Coordinates</td>
</tr>
<tr>
<td>OP</td>
<td>Occupy Point</td>
</tr>
<tr>
<td>PN</td>
<td>Point Name</td>
</tr>
<tr>
<td>SD</td>
<td>Slope Distance</td>
</tr>
<tr>
<td>SF</td>
<td>Scale Factor</td>
</tr>
<tr>
<td>TM</td>
<td>Local Time (HH:MM:SS)</td>
</tr>
<tr>
<td>UN</td>
<td>Distance Unit (0 for feet, 1 for meter, 2 for US feet)</td>
</tr>
<tr>
<td>VA</td>
<td>Vertical Angle</td>
</tr>
<tr>
<td>ZE</td>
<td>Zenith</td>
</tr>
</tbody>
</table>

**Traverse Examples**
This first example is a closed traverse with an internal backsight of azimuth 178d0'42"

Use the functions under the Add menu to create and fill out the raw file as shown here.

Notice that the record from point 7 to 8 is set as a CL+AB record. This tells the program that point 8 is the closing point and that the angle from 7 to 8 is the closing angle. For traverse adjustment, the closing reference point is 1 and the closure error is the difference between point 1 and point 8. For angle balance, the reference closing angle is

Chapter 11. Survey Menu
358d0'42" (178d0'42" + 180). The angle balance error is the difference between this reference angle and the angle from points 7 to 8.

Now let's process using Compass adjustment with Angle Balance. Choose Compass under the Process menu and fill out the dialogs as shown.

First half of process report:

Process Results 05/23/2002 10:06
Raw file> c:/scadxml/data/example.rw5
CRD file> C:/scadxml/DATA/example.crd

Scale Factor: 1.00000000
Correct for Earth Curvature: OFF
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Angle</th>
<th>Angle</th>
<th>Dist</th>
<th>HT</th>
<th>HT</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5330</td>
<td>89.4050</td>
<td>711.32</td>
<td>5.32</td>
<td>6.00</td>
<td>5038.43</td>
</tr>
<tr>
<td></td>
<td>P2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>AR262.5448</td>
<td>89.3236</td>
<td>457.76</td>
<td>5.43</td>
<td>6.00</td>
<td>4587.89</td>
</tr>
<tr>
<td></td>
<td>P3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>AR208.5710</td>
<td>89.1803</td>
<td>201.31</td>
<td>5.40</td>
<td>6.00</td>
<td>4397.30</td>
</tr>
</tbody>
</table>

Chapter 11. Survey Menu
Closure Results (Before Angle Balance)

Starting Point 1: N 5000.00 E 5000.00 Z 100.00

Closing Reference Point 1: N 5000.00 E 5000.00 Z 100.00
Ending Point 8: N 5000.09 E 4999.97 Z 100.06
Azimuth Error : 341°38'22''
North Error : 0.09061
East Error : -0.03007
Vertical Error: 0.05953
Hz Dist Error : 0.09547
Sl Dist Error : 0.11251
Traverse Lines> 7
SideShots> 1
Horiz Dist Traversed: 2712.29
Slope Dist Traversed: 2712.62
Closure Precision: 1 in 28409

Remaining of process report:

Compass Closure
Adjusted Point Comparison

<table>
<thead>
<tr>
<th>Point#</th>
<th>Original Northing</th>
<th>Original Easting</th>
<th>Adjusted Northing</th>
<th>Adjusted Easting</th>
<th>Dist</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5038.445</td>
<td>5710.269</td>
<td>5038.440</td>
<td>5710.294</td>
<td>0.025</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>3</td>
<td>4587.914</td>
<td>5791.222</td>
<td>4587.907</td>
<td>5791.263</td>
<td>0.042</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>4</td>
<td>4397.319</td>
<td>5726.469</td>
<td>4397.310</td>
<td>5726.517</td>
<td>0.049</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>5</td>
<td>4363.044</td>
<td>5230.628</td>
<td>4363.032</td>
<td>5230.693</td>
<td>0.067</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>6</td>
<td>4586.509</td>
<td>5245.681</td>
<td>4586.496</td>
<td>5245.755</td>
<td>0.075</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>7</td>
<td>4613.178</td>
<td>5013.335</td>
<td>4613.163</td>
<td>5013.416</td>
<td>0.083</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>8</td>
<td>5000.017</td>
<td>4999.905</td>
<td>5000.000</td>
<td>5000.000</td>
<td>0.097</td>
<td>S 79°46'08'' E</td>
</tr>
</tbody>
</table>

Max adjustment: 0.097
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

Point Horizontal Zenith Slope Inst Rod Northing Easting Elev
No.  Angle   Angle Dist HT HT Description

<table>
<thead>
<tr>
<th>No.</th>
<th>Original</th>
<th>Adjusted</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5326</td>
<td>89.4050</td>
</tr>
<tr>
<td>3</td>
<td>AR262.5434</td>
<td>89.3236</td>
</tr>
</tbody>
</table>
Shown above is the resulting process report. The angle balance had an error of 39 seconds which was divided among the 7 traverse sides. The Compass Closure shows how each traverse point was adjusted and then the resulting adjusted angles and distances.

Here is another layout of the last example that shows an external backsight setup. In this case there are two known points. Point 1 is the starting point and point 21 is the initial backsight. The setup could also use a backsight azimuth (ie north azimuth for example) instead of a backsight point number.
The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Example of an open traverse

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.
The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Here is an example of an open traverse.

**Compass Report from Open Traverse example:**

<table>
<thead>
<tr>
<th>Process Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw file &gt; d:/scdev/data/tsurvey.rw5</td>
</tr>
<tr>
<td>CRD file &gt; d:/scdev/data/tsurvey.crd</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjusted Point Comparison</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original</td>
</tr>
<tr>
<td>Point# Northing Easting Northing Easting Distance Bearing</td>
</tr>
<tr>
<td>2  5013.76 5711.18 5013.78 5711.13 0.047 N 63d21'19'' W</td>
</tr>
<tr>
<td>3  4560.69 5776.42 4560.72 5776.35 0.078 N 63d21'19'' W</td>
</tr>
<tr>
<td>4  4372.46 5705.08 4372.50 5705.00 0.091 N 63d21'19'' W</td>
</tr>
</tbody>
</table>

| Point Horizontal Vertical Slope Inst Rod Northing Easting Elev |
| No. Angle Angle Dist HT HT |
| 2  AR133.5324 89.4050 711.27 5.32 6.00 5013.78 5711.13 103.29 |
| 3  AR262.5506 89.3236 457.74 5.43 6.00 4560.72 5776.35 106.36 |
| 4  AR208.5712 89.1803 201.30 5.40 6.00 4372.50 5705.00 108.22 |

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.
Portion of typical Sokkia/SDR raw data file:
00NMSDR20 V03-05 Jan-22-98 19:14 122211
10NMTW970709A
13CPSea level crn: N
02TP00015000.000005000.0000085.63500005.22000000PK-FD
08K10003500.000005192.920081.74500000MN-SET
07TP0001000390.00000000.00000000PK-FD
09F100010003193.1000092.40416660.00000000MN-SET
09F100010003193.0000091.31388880.00000000SN-REC

Portion of typical Wild/Leica raw data file:
410001+00000000 42.124+00000000 43.104+00000000 44.123+00000000 45.101+00000000 110002+00000000
21.124+35959590 22.104+08748240 31...1+00000000 51..0.+0012+000 110003+00000000
21.124+00000000 22.104+08748240 31...1+00267075 51..0.+0012+000 110004+00000000
21.124+0420390 22.104+08702570 31...1+00168234 51..0.+0012+000 110005+00000005
21.124+2629130 22.104+09311370 31...1+00206133 51..0.+0012+000 110006+00000005
43....+00000000 44....+00000000 45....+00000000 110007+00000000 110008+00000000 110009+00000000
21.124+25827090 22.104+09504550 31...1+00106228 51..0.+0012+000 110010+00000000
21.124+27151500 22.104+09312240 31...1+00106066 51..0.+0012+000

Portion of typical SMI raw data file:
CM Definitions: SS: Side Shot; TR: Traverse; OC: Occupied Coordinates;
PC: Point Coordinates; CM: Comment; OS: Occupied Station;
TS = time stamp; e = electronic; m = manual; CM TS TUE 04/09/91 09:41:25P
PC 1 5000.00000 5000.00000 0.00000
SS e HI:4.000 HR:5.000 PIPE/F
0 1 2 BAZ:0.00000 AR:0.00040 ZA:91.24330 SD:92.020
SS e HI:0.000 HR:0.000 BC/BR FRAME 1ST
0 1 3 BAZ:0.00000 AR:28.47220 ZA:91.20250 SD:65.240

Portion of typical PC COGO raw data file:
* NEW SET UP INST. AT 1 359 59 59 ON 4
L ANG 1000 4 1 77 18 52.444 +1000 WALL# 283.22
L ANG 1001 4 1 55 44 28 9.8 * 1001 WALL# 283.28
L ANG 1002 4 1 38 37 8 15.89 * 1002 WALL# 283.48
L ANG 1008 4 1 27 18 34 123.82 * 1008 WALL# 287.75

Portion of typical Nikon raw data file:
MP,NOR,,5000.0000,5000.0000,100.0000,1
ST,NOR,,1,,5.0000,0.0000,0.0000
SS,1,5.0000,131.0605,91.3744,88.4935,10:36:15,CL1
SS,2,5.0000,137.6770,90.2923,88.5236,10:36:50,CL1

Portion of typical MDL/Laser raw data file:
D052097F04P52I494P01P02
H32473V-0639R016202P03
H06687V-0706R014936P91
H03840V-0483R017380

Portion of typical Geodimeter raw data file:

Chapter 11. Survey Menu 501
Edit-Process Level Data

This command is for entering and calculating level data. It has a spreadsheet editor for entering the level measurements, and the level calculations are updated as the data is entered. There is also a processing and reporting feature. The level data is stored in a file with a .LEV extension. If you are creating a new .LEV file, you must choose either single-wire or three-wire for your level format data entry preference.
Three Wire leveling, or precise leveling, is a process of direct leveling wherein three cross hairs, or threads, are read and recorded rather than the single horizontal cross hair. Note below, in the sample three-wire editor graphic, the additional columns representing top and bottom readings.

The commands starts by asking you, with a dialog box, to select an existing level file (.LEV) to process or to select a name for a new level file. The below examples are using existing files. Once this choice is made the small, Level Format dialog appears.

Regardless of whether you choose Single or Three Wire, the Level Editor appears in its own window. Below we see the editor displaying the contents of two existing files of level information. One is single wire and the other is three wire. The pulldown menus are the same for both, as described below in detail.

In the spreadsheet, the background color of the cells indicate the data type. White cells are for user-specified values. Blue cells are program calculated values. Black cells are data fields that aren't used by the level record for that row.
File: Standard File routines - Open, Save, Save As, Settings, Print and Exit. Settings brings up a dialog where you can adjust the 3-wire tolerance and distance values. Open will allow you to open up another existing .LEV file.

File->Import->Leica: This routine imports Leica level data in GSI format into the level editor.
**Edit:** Cut, Copy, Paste and Go To. Go To will take you to the row of your choosing.  
**Add:** These options provide the standard level run routines. Details on each and a graphic of the pulldown follow.  
**Tools:** This pulldown is for adjusting and storing elevations.

The Add and Tools pulldowns at the top of the editor provide the following features:

![Add pulldown menu](image)

**Level Editor - Add pulldown menu**

**Level Start (SR):** Starts the level run, usually with a known starting elevation or benchmark.  
**Level Turning Point (TP):** Turning point procedure for leveling.  
**Level Side Shot (LV):** For entering leveling side shots.  
**Level End (ER):** Enter your value.  

**Note:** You can add a note, or comments, into the editor as you move through the level run.

![Tools pulldown menu](image)

**Level Editor - Tools pulldown menu**

**Adjust Elevations:** Gives you the updated data in the Adjust Elevation report.  
**Store Elevations to Coordinate File:** Coordinates can be saved and used outside of this editor.
Selecting Print (editor File menu) provided this Level File Report sample

**Editor Columns:**

**Type:** These are small pulldown menus with two-letter level procedure choices. The two letters are abbreviations as indicated in the next dialog. These steps may be made with the Add pulldown or with this method. The options are SR, TP, ER, LV and DS. DS stands for description shot.

**Code:** The code is used by SurvNet for network least-squares processing of networked level loops. The code can be either EL or FE where EL is for calculated elevations and FE is for fixed elevations. FE should only be assigned to a START or END record (where you can enter the value for the adjusted elevation). If FE is assigned to an intermediate record it is ignored. Here is how the FE records are used. Say you run from one benchmark to another (point 1 to point 10). Point 1 and point 10 are the START and END records of the first loop and both are FE records. Then you start another loop at point 5 (halfway between 1 and 10). This is not a benchmark and can be adjusted so it should be assigned an EL code. Point 5 is the START record for the second loop. You run from point 5 to point 20 which is a benchmark. Point 20 is the END record and is assigned an FE code. When SurvNET processes the file, it will hold points 1, 10 and 20, allowing all others to be adjusted, including point 5 (even though it is a START record).

**Pulldown Menu Location:** Survey

**Keyboard Command:** diglevel

**Prerequisite:** .LEV (level) file to process

**File Name:** \lsp\rawedit.arx

**SurvNET**

SurvNet is Carlson's network least squares adjustment program. This program performs a least squares adjustment and statistical analysis on a network of raw survey field data, including both total station measurements and GPS vectors. SurvNet simultaneously adjusts a network of interconnected traverses with any amount of redundancy. The raw data can contain any combination of traverse (angle and distance), triangulation (angle only) and trilateration (distance only) measurements, as well as GPS vectors. The raw data does not need to be in any specified order, and individual traverses do not have to be defined using any special codes. All measurements are used in the adjustment.
Carlson Entry Point:

Entry into the SurvNet program is easy. It can be accessed in two different ways. The easiest way to start the program is to select SurvNet from the Survey menu. The other method is to start SurvNet from within the Raw Data File editor. You get to this editor by selecting Edit-Process Raw Data File from the Survey menu. When in the editor, selecting the Process (Compute Pts) menu and click SurvNet.

C&G Entry Point:

Entry into the SurvNet program is easy. It can be accessed in two different ways. You can select SurvNet from the
The Opening SurvNet Window

Following is the SurvNet start-up dialog box. This dialog box is displayed when SurvNet is first started. SurvNet
is a project based program. Before performing a least squares adjustment an existing project must be opened or a new project needs to be created. This opening dialog box allows the user to open or create a project on start-up. You also can create or open a project from the 'Files' menu. Since all project management functions can be performed from the 'Files' menu this start-up dialog box is a convenience. So, the 'Show this dialog box on start-up' can be unchecked and the start-up dialog box will not be displayed when SurvNet is started.

Following is a view of the SurvNet main window with an existing project opened.

- SurvNet reduces survey field measurements to grid coordinates in assumed, UTM, SPC83 SPC27, and a variety of other coordinate systems. In the 2D/1D model, a grid factor is computed for each individual line during the reduction. The elevation factor is computed for each individual line if there is sufficient elevation data. If the raw data has only 2D data, the user has the option of defining a project elevation to be used to
compute the elevation factor.

- SurvNet supports a variety of map projections and coordinate systems including the New Brunswick Survey Control coordinate system, UTM, and user defined systems consisting of either a predefined ellipsoid or a user defined ellipsoid and one of the following projections, Transverse Mercator, 1 Standard Parallel Lambert Conformal, 2 Standard Parallel Lambert Conformal, Oblique Mercator, and the Double Stereographic projection.

- A full statistical report containing the results of the least squares adjustment is produced and written to the report (.RPT) file. An error report (.ERR) file is created and contains any error messages that are generated during the adjustment.

- Coordinates can be stored in a Carlson (.CRD) file, C&G (.CRD) file, Simplicity file or an LDD file. An ASCII coordinate (.NEZ) file is always created that can be imported into most any mapping/surveying/GIS program. The user has the option to compute unadjusted preliminary coordinates.

- There is an option to compute traverse closures during the preprocessing of the raw data. Closures can be computed for both GPS loops and total station traverses. Closure for multiple traverse loops in the same raw file can be computed.

- SurvNet can combine GPS vectors and total station data in a single adjustment. GPS Vector files from Leica, Thales, Topcon and Trimble can be input, as can GPS files in the StarNet format.

- SurvNet includes a variety of blunder detection routines. One blunder detection method is effective in detecting if the same point number has been used for two different points. Additionally this blunder detection method is effective in detecting if two different point numbers have been used for the same physical position. This method also flags other raw data problems. Another blunder detection method included in SurvNet is effective in isolating a single blunder, distance or angle in a network. This method does not require that there be a lot of redundancy, but is effective if there is only one blunder in the data set. Additionally, SurvNet includes a blunder detection method that can isolate multiple blunders, distances or angles in a network. This method does require that there be a lot of redundancy in the network to effectively isolate the multiple blunders.

- Other key features include: Differential and Trig level networks and loops can be adjusted using the network least squares program. Geoid modeling is used in SurvNet, allowing the users to choose between the Geoid99 and the Geoid03 model. The user can alternately enter the project geoid separation. There are description codes to identify duplicate points with different point numbers. The user can specify the confidence interval from 50 to 99 percent.

SurvNet performs a least squares adjustment and statistical analysis of a network of raw survey field data, including both total station measurements, differential level data and GPS vectors. SurvNet simultaneously adjusts a network of interconnected traverses with any amount of redundancy. The raw data can contain any combination of angle and distance measurements, and GPS vectors. SurvNet can adjust any combination of trilaterations, traverses, triangulations, networks and resections. The raw data does not need to be in a linear format, and individual traverses do not have to be defined using any special codes. All measurements are used in the adjustment.

**General Rules for Collecting Data for Use in Least Squares Adjustments**

Least squares is very flexible in terms of how the survey data needs to be collected. Generally speaking, any combination of angles, and distances combined with a minimal amount of control points and azimuths are needed. This data can be collected in any order. There needs to be at least some redundancy in the measurements. Redundant measurements are measurements that are in excess of the minimum number of measurements needed to determine the unknown coordinates. Redundancy can be created by including multiple GPS and other control points within a network or traverse. Measuring angles and distances to points in the network that have been located from another point in the survey creates redundancy. Running additional cut-off traverses or additional traverses to existing control
points creates redundancy. Following are some general rules and tips in collecting data for least squares reduction.

- Backsights should be to point numbers. Some data collectors allow the user to backsight an azimuth not associated with a point number. SurvNet requires that all backsights be associated with a point number.
- There has to be at least a minimum amount of control. There has to be at least one control point. Additionally there needs to be either one additional control point or a reference azimuth. Control points can be entered in either the raw data file or there can be a supplemental control point file containing the control point. Reference azimuths are entered in the raw data file. The control points and reference azimuths do not need to be for the first points in the raw file. The control points and azimuths can be associated with any point in the network or traverse. The control does not need to be adjacent to each other. It is permissible, though unusual, to have one control point on one side of the project and a reference azimuth on the other side of the project.
- Some data collectors do not allow the surveyor to shoot the same point twice using the same point number. SurvNet requires that all measurements to the same point use a single point number. The raw data may need to be edited after it has been downloaded to the office computer to insure that points are numbered correctly. An alternative to renumbering the points in the raw data file is to use the 'Pt Number substitution string' feature in the project 'Settings' screen. See the 'Redundant Measurement' section for more details on this feature.
- The majority of all problems in processing raw data are related to point numbering problems. Using the same point number twice to different points, not using the same point number when shooting the same point, misnumbering backsights or foresights, and misnumbering control points are all common problems.
- It is always best to explicitly define the control for the project. A good method is to put all the control for a project into a separate raw file. A big source of problems with new users is a misunderstanding in defining their control for a project.
- Some data collectors may have preliminary unadjusted coordinates included with the raw data. These coordinate records should be removed from the raw file. The only coordinate values that should be in the raw file are the control points. Since there is no concept of 'starting coordinates' in least squares there is no way for SurvNet to determine which points are considered control and which points are preliminary unadjusted points. So all coordinates found in a raw data file will be considered control points.
- When a large project is not processing correctly, it is often useful to divide the project into several raw data files and debug and process each file separately as it is easier to debug small projects. Once the smaller projects are processing separately they can be combined for a final combined adjustment.

SurvNet gives the user the option to choose one of two mathematical model options when adjusting raw data, the 3D model and the 2D/1D model.

In the process of developing SurvNet numerous projects have be adjusted using both the 2D/1D model and the 3D model. There are slight differences in final adjusted coordinates when comparing the results from the same network using the two models. But in all cases the differences in the results are typically less than the accuracy of measurements used in the project. The main difference in terms of collecting raw data for the two different models is that the 3D model requires that rod heights and instrument heights need to be measured, and there needs to be sufficient elevation control to compute elevations for all points in the survey. When collecting data for the 2D/1D model the field crews do not need to collect rod heights and instrument heights.

In the 2D/1D model raw distance measurements are first reduced to horizontal distances and then optionally to grid distances. Then a two dimensional horizontal least squares adjustment is performed on these reduced horizontal distance measurements and horizontal angles. After the horizontal adjustment is performed an optional one-dimensional vertical least squares adjustment is performed in order to adjust the elevations if there is sufficient data to compute elevations. The 2D/1D model is the model that has been traditionally been used in the past by non-geodetic surveyors in the reduction of field data. There are several advantages of SurvNet's implementation of the 2D/1D model. One advantage is that an assumed coordinate system can be used. It is not necessary to know geodetic positions for control points. Another advantage is that 3D raw data is not required. It is not necessary to record rod heights and heights of instruments. Elevations are not required for the control points. The primary disadvantage of
SurvNet's implementation of the 2D/1D model is that GPS vector data cannot be used in 2D/1D projects. Another limitation of the 2D/1D model is that all elevation control is considered FIXED in the vertical adjustment using the 2D/1D model.

In the 3D model raw data is not reduced to a horizontal plane prior to the least squares adjustment. The 3 dimensional data is adjusted in a single least squares process. In SurvNet's implementation of the 3D model XYZ geodetic positions are required for control. The raw data must contain full 3D data including rod heights and measured heights of instrument. The user must designate a supported geodetic coordinate system. The main advantage of using the 3D model is that GPS vectors can be incorporated into the adjustment. Another advantage of the 3D model is the ability to compute and adjust 3D points that only have horizontal and vertical angles measured to the point. This feature can be used in the collection of points where a prism cannot be used, such as a power line survey. Unlike the 2D/1D model, you can assign standard errors to elevation control points.

When using the 2D/1D model if you have 'Vertical Adjustment turned' ON in the project settings, elevations will be calculated and adjusted only if there is enough information in the raw data file to do so. Least squares adjustment is used for elevation adjustment as well as the horizontal adjustment. To compute an elevation for the point the instrument record must have a HI, and the foresight record must have a rod height, slope distance and vertical angle. If working with .CGR raw data a 0.0 (zero) HI or rod height is valid. It is only when the field is blank that the record will be considered a 2D measurement. Carlson SurvCE 2.0 or higher allows you to mix 2D and 3D data by inserting a 2D or 3D comment record into the .RW5 file. A 3D traverse must also have adequate elevation control in order to process the elevations. Elevation control can be obtained from the supplemental control file, coordinate records in the raw data file, or elevation records in the raw data file.

SurvNet can also automatically reduce field measurements to state plane coordinates in either the NAD 83 or NAD 27 coordinate systems. In the 2D/1D model a grid factor is computed for each individual line during the reduction. The elevation factor is computed for each individual line if there is sufficient elevation data. If the raw data has only 2D data, the user has the option of defining a project elevation to be used to compute the elevation factor.

A full statistical report containing the results of the least squares adjustment is produced and written to the report (.RPT) file. An error report (.ERR) file is created and contains any error messages that are generated during the adjustment. Coordinates can be stored in the following formats:

- C&G numeric (*.crd)
- C&G alphanumeric (*.cgc)
- Carlson numeric (*.crd)
- Carlson alphanumeric (*.crd)
- Autodesk Land Desktop (*.mdb)
- Simplicity (*.zak)
- ASCII P.N,E,Z,D,C (*.nez)

A file with the extension .OUT is always created and contains an ASCII formatted coordinate list of the final adjusted coordinates formatted suitable for printing. Additionally an ASCII file with an extension of .NEZ containing the final adjusted coordinates in a format suitable for input into 3rd party software that is capable of inputting an ASCII coordinate file.

SurvNet produces a wealth of statistical information that allows an effective way to evaluate the quality of survey measurements. In addition to the least squares statistical information there is an option to compute traverse closures during the preprocessing of the raw data. Traverse closures can be computed for both GPS loops and total station traverses. This option has no effect on the computation of final least squares adjusted coordinates. This option is useful for surveyors who due to statutory requirements are still required to compute traverse closures and for those surveyors who still like to view traverse closures prior to the least squares adjustment.

Chapter 11. Survey Menu 512
SurvNet works equally well for both Carlson users and C&G users. The primary difference between the two users is that a Carlson user will typically be using an .RW5 file for his raw data and a C&G user will typically be using a .CGR as the source of his raw data.

SurvNet is capable of processing either C&G (.CGR) raw data files or Carlson (.RW5) raw data files. Measurement, coordinate, elevation and direction (Brg/Az) records are all recognized. Scale factor records in the .CGR file are not processed since SurvNet calculates the state plane scale factors automatically. The menu option ‘Global Settings’ displays the following dialog box. If the ‘Use Carlson Utilites’ is chosen then the .RW5 editor will be the default raw editor and Carlson SurvCom will be the default data collection transfer program. If the ‘Use C&G Utilities’ is chosen then the C&G .CGR editor will be the default raw editor and C&G’s data collection transfer program will be the default data collection transfer program.

Standard errors are estimated errors that are assigned to measurements or coordinates. A standard error is an estimate of the standard deviation of a sample. A higher standard error indicates a less accurate measurement. The higher the standard error of a measurement, the less weight it will have in the adjustment process.

Although you can set default standard errors for the various types of measurements in the project settings of SurvNet, standard errors can also be placed directly into the raw data file. A standard error record inserted into a raw data file controls all the measurements following the SE record. The standard error does not change until another SE record is inserted that either changes the specific standard error, or sets the standard errors back to the project defaults. The advantage of entering standard errors into the raw file is that you can have different standard errors for the same type measurement in the same job. For example, if you used a one second total station with fixed backsights and foresights for a portion of a traverse and a 10 second total station with backsights and foresights to hand held prisms on the other portion of the traverse, you would want to assign different standard errors to reflect the different methods used to collect the data.

Make sure the SE record is placed before the measurements for which it applies.

If you do not have standard errors defined in the raw data file, the default standard errors in the project settings will be applied to the entire file.

** Carlson Raw Data Editor:**
The raw data editor can be accessed from the tool bar icon. Following is an image of the .RW5 editor. Refer to the Carlson raw editor documentation for guidance in the basic operation of the editor. The following documentation only deals with topics that are specific to the .RW5 editor and SurvNet.

You can insert or Add Standard Error records into the raw data file. Use the INSERT or ADD menu option and select Standard Errors, or pick the SE buttons on the tool bar. Use the ‘Add’ menu option to insert standard error records into the raw files.

**SEc - Control Standard Errors**

You can set standard errors for Northing, Easting, Elevation, and Azimuth using the ‘Control Standard Error’ menu option. Azimuth standard errors are entered in seconds. The North, East and Elevation standard errors affect the PT (coordinate) and EL (elevation) records.

You can hold or fix the North, East and Elevation fixed by entering a "!" symbol. You can allow the North, East and
Elevation to FLOAT by entering a "#" symbol. You can also assign the North, East and Elevation actual values (In the 2D/1D model elevation control is ALWAYS fixed). If you use an "*" symbol, the current standard error value will return to the project default values.

North East Elevation Azim
! ! ! (Fix all values)
# # # 30.0 (Allow the N., E. & Elevation to Float)
0.01 0.01 0.03 5.0 (assign values)
* * * * (return the standard errors back to project defaults)

When you fix a measurement, the original value does not change during the adjustment and all other measurements will be adjusted to fit the fixed measurements. If you allow a value to float, it will not be used in the actual adjustment, it will just be used to help calculate the initial coordinate values required for the adjustment process. Placing a very high or low standard error on a measurement accomplishes almost the same thing as setting a standard error as float or fixed. The primary purpose of using a float point is if SurvNet cannot compute preliminary values, a preliminary float value can be computed and entered for the point.

Direction records cannot be FIXED or FLOAT. You can assign a low standard error (or zero to fix) if you want to weight it heavily, or a high standard error to allow it to float.

Example:
North East Elev Azim

CSE ! ! !
PT 103 1123233.23491 238477.28654 923.456
PT 204 1124789.84638 239234.56946 859.275
PT 306 1122934.25974 237258.65248 904.957

North East Elev Azim
CSE * * *
PT 478 1122784.26874 237300.75248 945.840

The first SEc record containing the '!' character and sets points 103, 204, and 306 to be fixed. The last SEc record contains the '*' character. It sets the standard errors for point 478 and any other points that follow to the project settings. The Azimuth standard error was left blank.

**MSE - Measurement Standard Errors**

You can set the standard errors for distances, horizontal angle pointing, horizontal angle reading, vertical angle pointing, vertical angle reading, and distance constant and PPM.

"Distance" - distance constant and measurement error, can be obtained from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"PPM" - Parts per Million, obtain from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"Pointing" - total station horizontal angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves. Or you may set it higher for total stations running in Robotic Mode because they cannot point as well as a manual sighted total station.

"Reading" - total station horizontal angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.
"V.Pointing" - total station vertical angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves.

"V.Reading" - total station vertical angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

Example:
Distance Point Read V.Point V.Read PPM
MSE 0.01 3 3 3 5

You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.

If you use an "*" symbol, the standard error for that measurement type will return to the project default values.

**SSE - Setup Standard Errors**

These standard errors are a measure of how accurately the instrument and target can be setup over the points.

"Rod Ctr" is the Target Centering error. This value reflects how accurately the target prism can be set up over the point.

"Inst Ctr" is the Instrument Centering error. This value reflects how accurately the instrument can be set up over the point.

"Ints Hgt" is the Instrument Height error. This value reflects how accurately the height of the instrument above the mark can be measured.

"Rod Hgt" is the Target Height error. This value reflects how accurately the height of the prism above the mark can be measured.

Example:
TargCtr InstCtr HI TargHgt
SSE 0.005 0.005 0.01 0.01

You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.

If you use an "*" symbol, it will return the standard error to the project default values.

**C&G Raw Data Editor:**

You can set standard errors for control, measurements and instrument setup using the Insert->Standard Error menu option:
This will open a Standard Error dialog box:
This dialog allows you to create three types of standard error records: Control, Measurement, and Setup. You need only enter the values for the standard errors you wish to set. If a field is left blank no standard error for that value will be inserted into the raw data file.

You can hold the North, East and Elevation fixed by entering a "!" symbol (as shown above). You can allow the North, East and Elevation to FLOAT by entering a "#" symbol. You can also assign the North, East and Elevation actual values (In the 2D/1D model elevation control is ALWAYS fixed). If you use an "*" symbol (or press the "Set Project Defaults" button), the current standard error value will return to the project default values.

In the above example, a Control Standard Error record (SEc) will be created:

<table>
<thead>
<tr>
<th>TYPE</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Azim (sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEc</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>43</td>
<td>400952.01400</td>
<td>2241684.70100</td>
<td>948.17100</td>
</tr>
<tr>
<td>G</td>
<td>104</td>
<td>401717.10000</td>
<td>2244262.31000</td>
<td>976.97000</td>
</tr>
<tr>
<td>IP</td>
<td>104</td>
<td>5.140</td>
<td>103</td>
<td>6.000</td>
</tr>
</tbody>
</table>

Below are some sample values for control standard errors:

North East Elevation Azim
! ! ! (Fix all values)
# # # 30.0 (Allow the N., E. & Elevation to Float)
0.01 0.01 0.03 5.0 (assign values)
* * * * (return the standard errors back to project defaults)

When you fix a measurement, the original value does not change during the adjustment and all other measurements will be adjusted to fit the fixed measurements. If you allow a value to float, it will not be used in the actual adjustment, it will just be used to help calculate the initial coordinate values required for the adjustment process. Placing a very high or low standard error on a measurement accomplishes almost the same thing as setting a standard error as float or fixed. The primary purpose of using a float point is if SurvNet cannot compute preliminary values, a preliminary float value can be computed and entered for the point.

Direction records cannot be FIXED or FLOAT. You can assign a low standard error (or zero to fix) if you want to weight it heavily, or a high standard error to allow it to float.

**MSE - Measurement Standard Errors**

You can set the standard errors for distances, horizontal angle pointing, horizontal angle reading, vertical angle pointing, vertical angle reading, and distance constant and PPM.
"Distance" - distance constant and measurement error, can be obtained from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"PPM" - Parts per Million, obtain from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"Pointing" - total station horizontal angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves. Or you may set it higher for total stations running in Robotic Mode because they cannot point as well as a manual sighted total station.

"Reading" - total station horizontal angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

"V.Pointing" - total station vertical angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves.

"V.Reading" - total station vertical angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

Example:

You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank. If you use an "*" symbol, the standard error for that measurement type will return to the project default values.

The following SEm record will be created:
SSE - Setup Standard Errors

These standard errors are a measure of how accurately the instrument and target can be setup over the points.

"Targ Ctr" is the Target Centering error. This value reflects how accurately the target prism can be set up over the point.

"Inst Ctr" is the Instrument Centering error. This value reflects how accurately the instrument can be set up over the point.

"HI" is the Instrument Height error. This value reflects how accurately the height of the instrument above the mark can be measured.

"Targ Hgt" is the Target Height error. This value reflects how accurately the height of the prism above the mark can be measured.

Example:
You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.
If you use an "*" symbol, it will return the standard error to the project default values.

The following SEs record will be created:
There are several other features available in both the Carlson and C&G editors that are useful to SurvNet.

- Insert Coordinate records from file - when inputing control into a raw data file, it is more convenient to read the control point directly from a coordinate file than it is to manually key them in. The "Insert Coordinates" function allows you to select points in a variety of manner making it easy to select just control points. For example, you can select points by description, code, point blocks, point number, etc.
• Data ON/OFF records - when trying track down problems, sometimes it is convenient to remove certain sections of raw data prior to processing. The editors have a special record (DO record) that will turn OFF or ON certain areas of data. For example, when you insert a DO record all data following that record will be turned OFF (it will be shown in a different color). When you insert another DO record further down, the data following it will be turn back ON. It is simply a toggle. In the example below, the instrument setup at point 106 backsighting 105 was turned OFF.
One of the benefits of SurvNet is the ability to process redundant measurements. In terms of total station data redundant measurement is defined as measuring angles and/or distances to the same point from two or more different setups.

It is required that the same point number be used when locating a point that was previously recorded. However, since some data collectors will not allow you to use the same point number if the point already exists, we use the following convention for collecting redundant points while collecting the data in the field. If you begin the point description with a user defined string, for example a "=" (equal sign) followed by the original point number, we will treat that measurement as a redundant measurement to the point defined in the description field. The user defined character or string is set in the project settings dialog. For example, if point number 56 has the description "=12", we will treat point number 56 as a shot to point number 12, not point 56. Make sure the Preprocessing Settings dialog box has the Pt. Number Substitution String set to the appropriate value.

Alternately, the point numbers can be edited after the raw data has been downloaded from the data collector.

Supplemental Control Files
In order to process a raw data file, you must have as a minimum a control point and a control azimuth, or two control points. Control points can be inserted into the raw data file or alternately control points can be read from coordinate files. Control points can be read from a variety of coordinate file types:

- C&G or Carlson numeric (.CRD) files
- C&G Alphanumeric coordinate files (*.cgc)
- Carlson Alphanumeric coordinate files (*.crd)
- Autodesk Land Desktop (*.mdb)
- Simplicity coordinate files (*.zak)
- ASCII (.NEZ) file
- ASCII latitude and longitude (3D model only)

The standard errors for the control points from a supplemental control file will be assigned from the NORTH, and EAST standard errors from the project settings dialog box.

In the ASCII .NEZ file, the coordinate records need to be in the following format:

Pt. No., Northing, Easting, Elevation, Description

```
103, 123233.23491, 238477.28654, 923.456, Mon 56-7B
```

Each line is terminated with carriage-return <cr> and line-feed <lf> characters.

In the ASCII latitude and longitude file, the records need to be in the following format:

Pt. No., Latitude (NDDD.mmssssss), Longitude (WDDD.mmssssss), Elevation (Orthometric), Description

```
FRKN,N35.113068642,W083.234174724,649.27
```

Each line is terminated with carriage-return <CR> and line-feed <LF> characters.

The major advantage of putting coordinate control points in the actual raw data file is that specific standard errors can be assigned to each control point (as described in the RAW DATA section above). If you do not include an SE record the standard error will be assigned from the NORTH, EAST, and ELEVATION standard errors from the project settings dialog box. The supplemental control file and the final output file should never be the same. Since least squares considers all points to be control points only control points should be in a supplemental control file.

The following graphic shows the main network least squares window. Most least squares operations are initiated from this window.
File

Selecting the FILE menu option opens the following menu:

A Project (.PRJ) file is created in order to store all the settings and files necessary to reprocess the data making up the project. You can create a NEW project, or OPEN an existing project. It is necessary to have a project open in order to process the data.

The "Save Project As Default" can be used to create default project settings to be used when creating a new project. The current project settings are saved and will be used as the default settings when any new project is created.

The project settings are set by selecting Settings > Project from the menu, or pressing the SE icon on the tool bar. The project settings dialog box has six tabbed windows, Coordinate System, Input Files, Preprocessing, Adjustment,
Standard Errors, and Output Options. Following is an explanation of the different project settings tabbed windows.

Coordinate System

The Coordinate System tab contains settings that relate to the project coordinate system, the adjustment model and other geodetic settings.

You can select either the 3D model or the 2D/1D mathematical model. If you choose 2D/1D mathematical model you can choose to only perform a horizontal adjustment, a vertical adjustment or both. In the 3D model both horizontal and vertical are adjusted simultaneously. The 3D model requires that you choose a geodetic coordinate system. Local, assumed coordinate systems cannot be used with the 3D model. GPS vectors can only be used when using the 3D model.

If using the 2D/1D mathematical model you can select Local (assumed coordinate system), or a geodetic coordinate system such State Plane NAD83, State Plane NAD27, UTM, or a user-defined coordinate system as the coordinate system. When using the 3D model you cannot use a local system.

Select the 'Horizontal Units for' output of coordinate values (Meters, US Feet, or International Feet). In the 3D model both horizontal and vertical units are assumed to be the same. In the 2D/1D model horizontal and vertical units can differ. The 'Horizontal unit' setting in this screen refers to the output units. It is permissible to have input units in feet and output units in meters. Input units are set in the 'Input Files' tabbed screen.

If you choose SPC 1983, SPC 1927, or UTM, the appropriate zone will need to be chosen. The grid scale factor is computed for each measured line using the method described in section 4.2 of NPAA Manual NOS NGS 5, "State Plane Coordinate System of 1983", by James E. Stem.

If using the 2D/1D model and you select a geodetic coordinate system, you have a choice as to how the elevation factor is computed. You can choose to either enter a project elevation or you can choose to have elevations factors computed for each distance based on computed elevations. In order to use the 'Compute Elevation from Raw Data'
all HI's and foresight rod heights must be collected for all points.

If you choose a geodetic coordinate system and are using the 2D/1D model you will want to select "Project Elevation" if any of your raw data measurements are missing any rod heights or instrument heights. There must be enough information to compute elevations for all points in order to compute elevation factors. For most survey projects it is sufficient to use an approximate elevation, such as can be obtained from a Quad Sheet for the project elevation.

**Geoid Modeling**

If you are using either the 3D or the 2D/1D adjustment model using SPC 1983 or UTM reduction you must choose a geoid modeling method. A project geoid separation can be entered or the GEOID99 or GEOID03 grid models can be used. The project must fall within the geographic range of the geoid grid files in order to use GEOID99 or GEOID03 models.

Geoid modeling is used as follows. Entering a 0.0 value for the separation is the method to use if you wish to ignore the geoid separation. In the 2D, 1D model it is assumed that elevations entered as control are entered as orthometric heights. Since grid reduction requires the data be reduced to the ellipsoid, the geoid separation is used to compute ellipsoid elevations. The difference between using geoid modeling and not using geoid modeling or using a project geoid separation is insignificant for most surveys of limited extents. In the 3D model it is also assumed that elevations entered as control are orthometric heights. Since the adjustment is performed on the ellipsoid, the geoid separation is used to compute ellipsoid elevations prior to adjustment. After the adjustment is completed the adjusted orthometric elevations will be computed from the adjusted ellipsoid elevations and the computed geoid separation for each point.

If you choose the GEOID99 or GEOID03 modeling option, geoid separations are computed by interpolation with data points retrieved from geoid separation files. The geoid separation files should be found in the primary installation directory. Grid files have an extension of .grd. These files should have been installed during the installation of SurvNet. These files can be downloaded from the Carlson/C&G website, carlsonsw.com, if needed.

If you choose to enter a project geoid separation the best way to determine a project geoid separation is by using the GEOID03 option of the NGS on-line Geodetic Toolkit. Enter a latitude and longitude of the project midpoint and the program will output a project separation.

**Working With User-defined Coordinate Systems**

SurvNet allows the creation of user-defined geodetic coordinate systems (UDP). The ability to create user-defined coordinate system allows the user to create geodetic coordinate systems based on the supported projections that are not explicitly supported by SurvNet. A SurvNet user-defined coordinate system consists of an ellipsoid, and a map projection. The ellipsoid can be one of the explicitly supported ellipsoids or a user-defined ellipsoid. The supported map projections are Transverse Mercator, Lambert Conformal Conic with 1 standard parallel, Lambert Conformal Conic with 2 standard parallels, Oblique Mercator, and Double Stereographic projection. User-defined coordinate systems are created, edited, and attached to a project from the Project Settings ‘Coordinate System’ dialog box. To attach an existing UDP file, *.udp, to a project use the 'Select' button. To edit an existing UDP file or create a new UDP file use the 'Edit' button.
The following dialog box is used to create the user-defined coordinate system. The ellipsoid needs to be defined and the appropriate map projection and projection parameters need to be entered. The appropriate parameter fields will be displayed depending on the projection type chosen.

Test - Use the 'Test' button to enter a known latitude and longitude position to check that the UDP is computing correct grid coordinates. Following is the test UDP dialog box. Enter the known lat/long in the top portion of the dialog box then press 'Calculate' and the computed grid coordinates will be displayed in the 'Results' list box.
Load - Use the 'Load' to load the coordinate system parameters from an existing UDP.

Save - Use the 'Save' button to save the displayed UDP. The 'Save' button prompts the user to enter the UDP file name.

OK - Use the 'OK' button to save the UDP using the existing file name and return to the 'Coordinate System' dialog box.

Cancel - Use the 'Cancel' button to return to the 'Coordinate System' dialog box without saving any changes to the UDP file.

If you need to define an ellipsoid chose the 'User-Defined' ellipsoid option. With the user-defined ellipsoid you will then have the option to enter two of the ellipsoid parameter.
Input Files

**Raw Data Files:** Use the 'Add' button to insert raw total station files into the list. Use the 'Delete' button to remove raw files from the list. All the files in this list are included in the least squares adjustments. Having the ability to choose multiple files allows one to keep control in one file and measurements in another file. Or different files collected at different times can be processed all at one time. If you have multiple crews working on the same project using different equipment, you can have "crew-specific" raw data files with standard error settings for their particular equipment. Having separate data files is also a convenient method of working with large projects. It is often easier to debug and process individual raw files. Once the individual files are processing correctly all the files can be included for a final adjustment. You can either enter C&G (.CGR) raw files or Carlson (.RW5) files into the list for processing. You cannot have both .CGR and .RW5 files in the same project to be processed at the same time. Notice that you have the ability to highlight multiple files when deleting files.

**Level Raw Files:** Differential and Trig level files can be entered and processed. Differential level raw files have a .LVL extension and are created using the Carlson/C&G level editor. Carlson SurvCE 2.0 or higher allows you to store differential or trig levels in a .TLV file which can also be processed by SurvNet.

**GPS Vector Files:** GPS vector files can be entered and processed. Both GPS vector files and total station raw files can be combined and processed together. You must have chosen the 3D mathematical model in the Coordinate System tab in order to include GPS vectors in the adjustment.

Currently, the following GPS vector file formats are supported.

- Thales: Thales files typically have .obn extensions and are binary files.
- Leica: Leica files are ASCII files.
- StarNet ASCII GPS: See below for more information on StarNet format. These files typically have .GPS extensions.
- Topcon (.tvf): Topcon .tvf files are ASCII files.
Topcon (.xml): Topcon also can output their GPS vectors in XML format which is in ASCII format.
Trimble Data Exchange Format (.asc): These files are in ASCII format
Trimble data collection (.dc): These files are ASCII.
LandXML, (*.xml)

The following is a typical vector record in the StarNet ASCII format. GPS vectors typically consist of the 'from' and 'to' point number, the delta X, delta Y, delta Z values from the 'from' and 'to' point, with the XYZ deltas being in the geocentric coordinate system. Additionally the variance/covariance values of the delta XYZ's are included in the vector file.

G0 'V3 00:34 00130015.SSF
G1 400-401 4725.684625 -1175.976652 1127.564218
G2 1.02174748583350E-007 2.19210810829205E-007 1.23924502584092E-007
G3 6.06552466633441E-008 -5.58807795027874E-008 -9.11050726758263E-008

The GO record is a comment. The G1 record includes the 'from' and 'to' point and the delta X, delta Y, and delta Z in the geocentric coordinate system. The G2 record is the variance of X, Y, and Z. The G3 record contains the covariance of XY, the covariance ZX, and the covariance ZY. Most all GPS vector files contain the same data fields in different formats.

Use the 'Add' button to insert GPS vector files into the list. Use the 'Delete' button to remove GPS vector files from the list. All the files in this list will be used in the least squares adjustments. All the GPS files in the list must be in the same format. If the GPS file format is ASCII you have the option to edit the GPS vector files. The Edit option allows the editing of any of the ASCII GPS files using Notepad. Typically, only point numbers would be the fields in a GPS vector file that a user would have need to edit. The variance/covariance values are used to determine the weights that the GPS vectors will receive during the adjustment and are not typically edited.

**Supplemental Control File:** The supplemental control file option allows the user to designate an additional coordinate file to be used as control. The supplemental control files can be from a variety of different file types.

C&G numeric (*.crd)
C&G alphanumeric (*.cgc)
Carlson numeric(*.crd)
Carlson alphanumeric(*.crd)
Autodesk Land Desktop (*.mdb)
Simplicity (*.zak)
ASCII P,N,E,Z,D,C (*.nez)
ASCII P,Lat,Long,Ortho,D,C (*.txt)

**Note:** You should never use the same file for supplemental control points and for final output. Least squares considers all points to be measurements. If the output file is also used as a supplemental control file then after the project has been processed all the points in the project would now be in the control file and all the points in the file would now be considered control points if the project was processed again. The simplest and most straight-forward method to define control for a project is to include the control coordinates in a raw data file.

**Preprocessing**

The Preprocessing tab contains settings that are used in the preprocessing of the raw data.
Apply Curvature and Refraction Corrections: Set this toggle if you wish to have the curvature refraction correction applied in the 2D/1D model when reducing the slope distance/vertical angle to horizontal distance and vertical distance. Curvature/refraction primarily impacts vertical distances.

Tolerances: When sets of angles and/or distances are measured to a point, a single averaged value is calculated for use in the least squares adjustment. You may set the tolerances so that a warning is generated if any differences between the angle sets or distances exceed these tolerances. Tolerance warnings will be shown in the report (.RPT) and the (.ERR) file after processing the data.

Horiz./Slope Dist Tolerance: This value sets the tolerance threshold for the display of warnings if the difference between highest and lowest horizontal distance exceeds this value. In the 2D model it is the horizontal distances that are being compared. In the 3D model it is the slope distances that are being compared.

Vert. Dist Tolerance: This value sets the tolerance threshold for the display of a warning if the difference between highest and lowest vertical distance component exceeds this value (used in 2D model only).

Horiz. Angle Tolerance: This value sets the tolerance threshold for the display of a warning if the difference between the highest and lowest horizontal angle exceeds this value.

Vert. Angle Tolerance: This value sets the tolerance threshold for the display of a warning if the difference between the highest and lowest vertical angle exceeds this value (used in 3D model only).

Compute Traverse Closures: Traditional traverse closures can be computed for both GPS loops and total station traverses. This option has no effect on the computation of final least squares adjusted coordinates. This option is useful for surveyors who due to statutory requirements are still required to compute traditional traverse closures and
for those surveyors who still like to view traverse closures prior to the least squares adjustment. This option is used to specify a previously created closure file.

To use this option the user has to first create a traverse closure file. The file contains a .cls extension. The traverse closure file is a file containing an ordered list of the point numbers comprising the traverse. Since the raw data for SurvNet is not expected to be in any particular order it is required that the user must specify the points and the correct order of the points in the traverse loop. Both GPS loops and angle/distance traverses can be defined in a single traverse closure file. More details on creating the traverse closure files follow in a later section of this manual.

**Pt. Number Substitution String:** This option is used to automatically renumber point names based on this string. Some data collectors do not allow the user to use the same point number twice during data collection. In least squares it is common to collect measurements to the same point from different locations. If the data collector does not allow the collection of data from different points using the same point number this option can be used to automatically renumber these points during processing. For example you could enter the string '=' in the Pt. Number Substitution String. Then if you shot point 1 but had to call it something else such as 101 you could enter ‘=1’ in the description field and during preprocessing point 101 would be renumbered as point '1'.

**Adjustment**

![Adjustment settings](image)

**Maximum Iterations:** Non-linear least squares is an iterative process. The user must define the maximum number of iterations to make before the program quits trying to find a converging solution. Typically if there are no blunders in the data the solution will converge in less than 5 iterations.

**Convergence Threshold:** During each iteration corrections are computed. When the corrections are less than the threshold value the solution has converged. This value should be somewhat less than the accuracy of the measure-
ments. For example, if you can only measure distances to the nearest .01' then a reasonable convergence threshold value would be .005'.

**Confidence Interval:** This setting is used when calculating the size of error ellipses, and in the chi-square testing. For example, a 95% confidence interval means that there is a 95% chance that the error is within the tolerances shown.

**Enable sideshots for relative error ellipses:** Check this box if you want to see the error ellipses and relative error ellipses of sideshots. This checkbox must be set if you want to use the "relative error ellipse inverse" function with sideshots. When turned off this toggle filters out sideshots during the least squares processing. Since the sideshots are excluded form the least squares processing error ellipses cannot be computed for these points. When this toggle is off, the sideshots are computed after the network has been adjusted. The final coordinate values of the sideshots will be the same regardless of this setting.

Large numbers of sideshots slow down least squares processing. It is best to uncheck this box while debugging your project to avoid having to wait for the computer to finish processing. After the project processes correctly you may turn on the option for the final processing.

**Relative Err. Points File:** The new ALTA standards require that surveyors certify to the relative positional error between points. Relative error ellipses are an accepted method of determining the relative positional error required by the ALTA standards. The points that are to be included in the relative error checking are specified by the user. These points are defined in an ASCII file with an extension of .alt. To select an .alt file for relative error checking use the 'Select' button and then browse to the file's location.

There is a section later in the manual that describes how to create and edit the .alt file.

**Include ALTA tolerance report:** Turn this toggle on if you wish to include the ALTA tolerance section of the report.

Allowable Tolerance, PPM: These fields allow the user to set the allowable error for computations. Typically the user would enter the current ALTA error standards, i.e. 0.07' & 50 PPM.

See the later section in this manual for more detailed information on creating and interpreting the ALTA section of the report.

**Standard Errors**
Standard errors are the expected measurement errors based on the type equipment and field procedures being used. For example, if you are using a 5 second total station, you would expect the angles to be measured within +/- 5 seconds (Reading error).

The Distance Constant, PPM settings, and Angle Reading should be based on the equipment and field procedures being used. These values can be obtained from the published specifications for the total station. Or the distance PPM and constant can be computed for a specific EDM by performing an EDM calibration using an EDM calibration baseline.

Survey methods should also be taken into account when setting standard errors. For example, you might set the target centering standard error higher when you are sighting a held prism pole than you would if you were sighting a prism set on a tripod.

The settings from this dialog box will be used for the project default settings. These default standard errors can be overridden for specific measurements by placing SE records directly into the Raw Data File (see the above section on raw data files).

If the report generated when you process the data shows that generally you have consistently high standard residuals for a particular measurement value (angles, distances, etc.), then there is the chance that you have selected standard errors that are better than your instrument and methods can obtain. (See explanation of report file). Failing the chi-square test consistently is also an indication that the selected standard errors are not consistent with the field measurements.

You can set the standard errors for the following:

**Distance and Angle Standard Errors**

**Distance Constant:** Constant portion of the distance error. This value can be obtained from published EDM specifications, or from an EDM calibration.

**Distance PPM:** Parts per million component of the distance error. This value can be obtained from published EDM specifications, or from an EDM calibration.

**Angle Reading:** This value can be obtained from published EDM specifications, or from an EDM calibration.
specification, or from an EDM calibration.

**Horizontal Angle Pointing:** The horizontal angle pointing error is influenced by atmospheric conditions, optics, experience and care taken by instrument operator.

**Horizontal Angle Reading:** Precision of horizontal angle measurements, obtain from theodolite specs.

**Vertical Angle Pointing:** The vertical angle pointing error is influenced by atmospheric conditions, optics, experience and care taken by instrument operator.

**Vertical Angle Reading:** Precision of vertical angle measurements, obtain from theodolite specs.

### Instrument and Target Standard Errors

**Target Centering:** This value is the expected amount of error in setting the target or prism over the point.

**Instrument Centering:** The expected amount of error in setting the total station over the point.

**Target Height:** The expected amount of error in measuring the height of the target.

**Instrument Height:** The expected amount of error in measuring the height of the total station.

### Control Standard Errors

**Direction (Bearing / Azimuth):** The estimated amount of error in the bearing / azimuth (direction) found in the azimuth records of the raw data.

**North, East, Elev:** The estimated amount of error in the control north, east and elev. You may want to have different coordinate standard errors for different methods of obtaining control. Control derived from RTK GPS would be higher than control derived from GPS static measurements.

### GPS Standard Errors

**Instrument Centering:** This option is used to specify the error associated with centering a GPS receiver over a point.

**Vector Standard Error Factor:** This option is used as a factor to increase GPS vector standard errors as found in the input GPS vector file. Some people think that the GPS vector variances/covariances as found in GPS vector files tend do be overly optimistic. This factor allows the user to globally increase the GPS vector standard errors without having to edit the GPS vector file. A factor of 0 should be the default value and results in no change to the GPS vector standard errors as found in the GPS vector file.

### Differential Leveling Standard Errors

These setting only effect level data and are not used when processing total station or GPS vector files.

**Avg, Dist. To BS/FS:** This option is used to define the average distance to the backsight and foresight during leveling.

**Rod Reading Error per 100 ft./m:** This option is used to define the expected level reading error.

**Collimation Error:** This is the expected differential leveling collimation error in seconds.

### Standard Error Definition Files

The Standard error settings can be saved and then later reloaded into an existing or new project. Creating libraries of standard errors for different types of survey equipment or survey procedures is convenient method of creating standards within a survey department that uses a variety of equipment and performs different types of surveys. Standard error library files, *.sef files, can be created two ways. From the 'Settings/Standard Errors' dialog box the 'Load' button can be used to import an existing .sef file into the current project. A .sef file can also be created from the existing project standard errors by using the 'Save As.' button.
Standard error files, .sef files, can also be managed from the main 'Files' menu. Use the 'Edit Standard Error File' menu option to edit an existing standard error file. Use the 'New Standard Error File' option to create a new standard error file.

After choosing one of the menu options and choosing the file to edit or create, the following dialog box will be shown. Set the desired standard errors and press the 'OK' button to save the standard error file.
These settings apply to the output of data to the report and coordinate files.

**Display Precision**

These settings determine the number of decimal places to display in the reports for the following types of data. The display precision has no effect on any computations, only the display of the reports.

Coordinates (North, East, Elevation) - Chose 0-4 decimal places.
Distances - Chose 0-4 decimal places
Directions (Azimuths or Bearings) - nearest second, tenth of second, or hundredth of second.

**Format**

These settings determine the format for the following types of data.

**Direction** - Choose either bearings or azimuth for direction display. If the angle units are degrees, bearings are entered as QDD.MMSSss and azimuths are entered as DDD.MMSSss. If the angle units are grads, bearings are input as QGGG.ggggg and azimuths are input as GGG.ggggg.

**Coordinate Display** - Choose the order of coordinate display, either north-east or east-north.

**Null Elevation** - Choose the value for null elevations in the output ASCII coordinate NEZ file. The Null Elevation field defaults to SurvNet's value for NO ELEVATION,

**Angle Display** - Choose the units you are working in, degrees or gradians.

**Coordinate File Output**

These settings determine the type and format of the output NEZ file. An ASCII .NEZ and .OUT files are always created after processing the raw data. The .OUT file will be a nicely formatted version of the .NEZ file. The .NEZ file will be an ASCII file suitable to be input into other programs. There are a variety of options for the format of the .NEZ file. Following are the different ASCII file output options.

P,N,E,Z,CD,DESC (fixed columns); - Point,north,east,elev.,code,desc in fixed columns separated by commas.

P,N,E,Z,CD,DESC; Point,north,east,elev.,code,desc separated by commas.

P N E Z CD DESC (fixed columns); Point,north,east,elev.,code,desc in fixed columns with no commas.

P N E Z CD DESC; Point,north,east,elev.,code,desc in fixed columns with no commas.

P,N,E,Z,DESC (fixed columns); Point,north,east,elev., desc in fixed columns separated by commas.

P,N,E,Z,DESC; Point,north,east,elev., desc separated by commas.

P,E,N,Z,CD,DESC (fixed columns); - Point,east,north,elev.,code,desc in fixed columns separated by commas.

P,E,N,Z,CD,DESC; Point,east,north,elev.,code,desc separated by commas.

P E N Z CD DESC (fixed columns); Point,east,north,elev.,code,desc in fixed columns with no commas.

P E N Z CD DESC; Point,east,north,elev.,code,desc in fixed columns with no commas.

P,E,N,Z,DESC (fixed columns); Point,east,north,elev., desc in fixed columns separated by commas.

P,E,N,Z,DESC; Point,east,north,elev., desc separated by commas.

P,E,N,Z DESC (fixed columns); Point,east,,northelev., desc in fixed columns with no commas.

P,E,N,Z DESC; Point,east,north,elev.,code,desc separated by spaces.

You can also set the output precision of the coordinates for the ASCII output file. This setting only applies to ASCII files, not to the C&G or Carlson binary coordinate files which are stored to full double precision.

* N/E Precision: number of places after the decimal to use for North and East values (0 -> 8) in the output NEZ ASCII file.
* Elevation Precision: number of places after the decimal to use for Elevation values (0 - 8) in the output NEZ ASCII file.

If you want to write the calculated coordinates directly to a C&G or Carlson coordinate file, check the "Write to Carlson/C&G .CRD file" box and select the file. You can choose the type of Carlson/C&G file to be created when you 'select' the file to be created. You may wish to leave this box unchecked until you are satisfied with the adjustment. Following are the different available coordinate output file options.

* NOTE: If coordinate points already exist in the CRD file, before a point is written, you will be shown the NEW value, the OLD value, and given the following option:

**Cancel:** Cancel the present operation. No more points will be written to the Carson/C&G file.

**Overwrite:** Overwrite the existing point. Notice that if you check the 'Do Not Ask Again' box all further duplicate points will be overwritten without prompting.

**Do not Overwrite:** The existing point will not be overwritten. Notice that if you check the 'Do Not Ask Again' box all further duplicate points will automatically not be overwritten - only new points will be written.
When you select Process > Network Adjustment from the menu, or select the NETWORK ICON on the tool bar, the raw data will be processed and adjusted using least squares based on the project settings. If there is a problem with the reduction, you will be shown error messages that will help you track down the problem. Additionally an .err file is created that will log and display error and warning messages.

The data is first preprocessed to calculate averaged angles and distances for sets of angles and multiple distances. For a given setup, all multiple angles and distances to a point will be averaged prior to the adjustment. The standard error as set in the Project Settings dialog box is the standard error for a single measurement. Since the average of multiple measurements is more precise than a single measurement the standard error for the averaged measurement is computed using the standard deviation of the mean formula.

Non-linear network least squares solutions require that initial approximations of all the coordinates be known before the least squares processing can be performed. So, during the preprocessing approximate coordinate values for each point are calculated using basic coordinate geometry functions. If there is inadequate control or an odd geometric situations SurvNet may generate a message indicating that the initial coordinate approximations could not be computed. The most common cause of this problem is that control has not been adequately defined or there are point number problems.

Side Shots are separated from the raw data and computed after the adjustment (unless the "Enable sideshots for relative error ellipses" toggle is checked in the adjustment dialog box). If side shots are filtered out of the least squares process and processed after the network is adjusted, processing is greatly speeded up, especially for a large project with a lot of side shots.

If the raw data processes completely, a report file, .RPT, a .NEZ file, an .OUT file, and an .ERR file will be created in the project directory. The file names will consist of the project name plus the above file extensions. These different files are shown in separate windows after processing. Additionally a graphic window of the network is displayed.

.RPT file: This is an ASCII file that contains the statistical and computational results of the least squares processing.

.NEZ file: This file is an ASCII file containing the final adjusted coordinates. This file can be imported into any program that can read ASCII coordinate files. The format of the file is determined by the setting in the project settings dialog box.

.OUT file: The .OUT file is a formatted ASCII file of the final adjusted coordinates suitable for display or printing

.ERR file: The .ERR file contains any warning or error messages that were generated during processing. Though some warning messages may be innocuous it is always prudent to review and understand the meaning of the messages.

The following is a graphic of the different windows displayed after processing. Notice that with the report file you can navigate to different sections of the report using the Tabs at the top of the window.
If you have "Write to Carlson/C&G.CRD" checked in the output options dialog, the coordinates will also be written to a .CRD file.

**Inverse Buttons** - The 'Inverse' button is found on the main window (the button with the icon that shows a line with points at each end). You can also select the Tools->Inverse menu option. This feature is only active after a network has been processed successfully. This option can be used to obtain the bearing and distance between any two points in the network. Additionally, the standard deviation of the bearing and distance between the two points is displayed.

The **Relative Error Ellipse Inverse** button is found on the main window (the button with the icon that shows a line with an ellipse in the middle). You can also select the Tools > Relative Error Ellipse menu option. This feature is only active after a network has been processed successfully. This option can be used to obtain the relative error ellipse between two points. It shows the semi-major and semi-minor axis and the azimuth of the error ellipse, computed to a user-define confidence interval. This information can also be used to determine the relative precision between any two points in the network. It is the relative error ellipse calculation that is the basis for the ALTA tolerance reporting. If the 'Enable sideshots for relative error ellipses' toggle is checked then all points in the project can be used to compute relative error ellipses. The trade-off is that with large projects processing time will be increased.
If you need to certify as to the "Positional Tolerances" of your monuments, as per the ALTA Standards, use the Relative Error Ellipse inverse routine to determine these values, or use the specific ALTA tolerance reporting function as explained later in the manual.

For example, if you must certify that all monuments have a positional tolerance of no more than 0.07 feet with 50 PPM at a 95 percent confidence interval. First set the confidence interval to 95 percent in the Settings/Adjustment screen. Then process the raw data. Then you may inverse between points in as many combinations as you deem necessary and make note of the semi-major axis error values. If none of them are larger than 0.07 feet + (50PPM×distance), you have met the standards. It is however more convenient to create a Relative Error Points File containing the points you wish to check and include the ALTA tolerance report. This report takes into account the PPM and directly tells you if the positional tolerance between the selected points meets the ALTA standards.

**Convert GPS File to ASCII**

The purpose of this option is to convert GPS vector files that are typically in the manufacturers' binary or ASCII format into the StarNet ASCII file format. The advantage of creating an ASCII file is that the ASCII file can be edited using a standard text editor. Being able to edit the vector file may be necessary in order to edit point numbers so that the point numbers in the GPS file match the point numbers in the total station file. The following dialog box is displayed after choosing this option.
First choose the file format of the GPS vector file to be converted. Next use the 'Select' button to navigate to the vector file to be converted. If you are converting a Thales file you have the option to remove the leading 0's from Thales point numbers. Next, use the second 'Select' button to select the name of the new ASCII GPS vector file to be created. Choose the 'Convert' button to initiate the file conversion. Press the 'Cancel' button when you have completed the conversions. The file created will have an extension of .GPS. Following are the different GPS formats that can be converted to ASCII.

**Thales:** The Thales GPS vector file is a binary file and is sometimes referred to as an 'O' file. Notice that you have the option to remove the leading 0's from Thales point numbers, by checking the "Remove leading 0's from Thales point numbers" check box.

**Leica:** The Leica vector file is an ASCII format typically created with the Leica SKI software. This format is created by Leica when baseline vectors are required for input into 3rd party adjustment software such as SurvNet. The SKI ASCII Baseline Vector format is an extension of the SKI ASCII Point Coordinate format.

**Topcon (.TVF):** The Topcon Vector File is in ASCII format and typically has an extension of .TVF

**Topcon (.XML):** The Topcon XML file is an ASCII file. It contains the GPS vectors in an XML format. This format is not equivalent to LandXML format.

**Trimble Data Exchange Format (.ASC):** The Trimble TDEF format is an ASCII file. It is typically output by Trimble's office software as a means to output GPS vectors for use by 3rd party software.

**Trimble Data Collection (.dc):** The Trimble .dc format is an ASCII file. It is typically output by Trimble's data collector. It contains a variety of measurements including GPS vectors. This option only converts GPS vectors found in the .DC file.

**LandXML (.XML):** The landXML format is an industry standard format. Currently SurvNet will only import LandXML survey point records. The conversion will not import LandXML vectors.

**Convert Level Files**

The purpose of this option is to convert differential level files into C&G/Carlson differential level file format. At present the only level file format that can be converted are the level files downloaded from the Topcon digital levels.
Toolbars

Many of the most commonly used functions can be accessed using the toolbar. Following is an explanation of the buttons found in the toolbar.

- **Create New Project** - New project Icon.
- **Open an Existing Project** - Open file Icon.
- **Save the Current Project** - Disk Icon.
- **Print One of the Reports** - Printer Icon.
- **Inverse** - Icon has a line with points on each end.
- **Relative Error Ellipses** - Icon has a line with points on each end and an ellipse in the middle.
- **Process Network** - Icon that looks like a traverse network.
- **Graphics** - Icon that looks like an eye. This icon is active once a project has been opened.
**Settings** - Icon has the letters SE. This takes you to the SETTINGS->STANDARD ERRORS tab.

**Edit Raw Data** - This icon can be used to start either the .RW5 raw data editor or the .CGR raw data editor. If your project has multiple raw data files, you will be shown a list and asked to select the file you wish to edit. The appropriate editor will be called depending on what type raw files are defined in the project settings. If no raw file or project has been specified the default raw editor as defined in the Settings menu will be executed. Any changes you make in the editor need to be saved before returning to SurvNet for processing.

Data Collector Transfer Program - This icon will run either the C&G Data Collector Transfer/Conversion program or the Carlson SurvCom program. The C&G program allows you to transfer data from the data collector, or convert the data collector file to a .CGR file format. It supports all major data collectors. The Carlson program connects specifically to the Carlson SurvCE data collector.

**Report File:** A report file consisting of the project name with an .RPT extension is generated after successfully processing the raw data. The report file will be shown in a text window so you can analyze the data. You can pick the "Printer" icon if you want a hardcopy. Following is an example of the results from a relatively simple network adjustment using a local coordinate system.

Sample 2D/1D, Local Coordinate System Report File

```
LEAST SQUARES ADJUSTMENT REPORT

Mon May 08 10:16:16 2006
2D Geodetic Model.
Input Raw Files: C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON
Maximum iterations: 10 , Convergence Limit: 0.002000
Local Coordinate System, Scale Factor: 1.000000
Horizontal Units: US Feet
Confidence Interval: 95.00
Default Standard Errors:
  Distance: Constant 0.010 ,PPM: 5.000
  Horiz. Angle: Pointing 3.0'' ,Reading: 3.0''
  Vert. Angle: Pointing 3.0'' ,Reading: 3.0''
  Total Station: Centering 0.005 ,Height: 0.010
  Target: Centering 0.005 ,Height: 0.010
Azimuth: 5''
  Coordinate Control: N:0.010, E:0.010, Z:0.030,

Horizontal Angle spread exceeds tolerance:
  IP: 1, BS: 5, FS: 2
  Low: 109-19'10.0'' , High: 109-19'17.0'' , Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2, BS: 1, FS: 6
  Low: 190-32'02.0'' , High: 190-32'10.0'' , Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2, BS: 1, FS: 3
  Low: 096-03'48.0'' , High: 096-03'56.0'' , Diff: 000-00'08.0''
```
Horizontal Angle spread exceeds tolerance:
  IP: 3, BS: 2, FS: 4
  Low: 124-03'50.0'' , High: 124-03'56.0'' , Diff: 000-00'06.0''

Horizontal Angle spread exceeds tolerance:
  IP: 5, BS: 4, FS: 10
  Low: 039-26'35.0'' , High: 039-26'45.0'' , Diff: 000-00'10.0''

Horizontal Angle spread exceeds tolerance:
  IP: 10, BS: 5, FS: 11
  Low: 241-56'23.0'' , High: 241-56'35.0'' , Diff: 000-00'12.0''

Horizontal Angle spread exceeds tolerance:
  IP: 11, BS: 10, FS: 12
  Low: 114-56'20.0'' , High: 114-56'34.0'' , Diff: 000-00'14.0''

Horizontal Angle spread exceeds tolerance:
  IP: 12, BS: 11, FS: 3
  Low: 140-39'18.0'' , High: 140-39'31.0'' , Diff: 000-00'13.0''

Horizontal Angle spread exceeds tolerance:
  IP: 5, BS: 4, FS: 1
  Low: 117-30'35.0'' , High: 117-30'50.0'' , Diff: 000-00'15.0''

Horizontal Distance from 2 to 3 exceeds tolerance:
  Low: 324.15, High: 324.20, Diff: 0.04

Vertical Distance from 2 to 3 exceeds tolerance:
  Low: 6.62, High: 8.36, Diff: 1.74

Vertical Distance from 3 to 4 exceeds tolerance:
  Low: 11.46, High: 11.51, Diff: 0.05

Horizontal Distance from 12 to 3 exceeds tolerance:
  Low: 144.64, High: 144.66, Diff: 0.02

HORIZONTAL ADJUSTMENT REPORT
================================

Unadjusted Observations
=========================

Control Coordinates: 1 Observed Points, 0 Fixed Points, 0 Approx. Points

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N:</th>
<th>E:</th>
<th>StErr N</th>
<th>StErr E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>658428.26</td>
<td>2150182.70</td>
<td>0.01</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Distances: 14 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Dist.</th>
<th>StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>290.45</td>
<td>0.01</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.21</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>52.39</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.19</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>275.60</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>134.66</td>
<td>0.01</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>116.07</td>
<td>0.01</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
<td>50.12</td>
<td>0.01</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>309.65</td>
<td>0.01</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>129.99</td>
<td>0.01</td>
</tr>
</tbody>
</table>
### Angles: 15 Observations

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>StErr (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>109-19'13.5''</td>
<td>7.7</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>6</td>
<td>190-32'06.0''</td>
<td>26.2</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>096-03'52.0''</td>
<td>7.3</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>124-03'53.0''</td>
<td>7.8</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>20</td>
<td>185-23'56.0''</td>
<td>12.8</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>180-15'26.0''</td>
<td>17.6</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>22</td>
<td>183-26'45.0''</td>
<td>31.2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>093-02'11.5''</td>
<td>7.5</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>10</td>
<td>039-26'40.0''</td>
<td>10.4</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>11</td>
<td>241-56'29.0''</td>
<td>15.6</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>056-23'10.0''</td>
<td>125.0</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>12</td>
<td>114-56'27.0''</td>
<td>15.5</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>3</td>
<td>140-39'24.5''</td>
<td>15.3</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>2</td>
<td>325-54'30.0''</td>
<td>9.5</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>117-30'42.5''</td>
<td>7.7</td>
</tr>
</tbody>
</table>

### Azimuths: 1 Observations

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>StErr (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>N 45-00'00.0''E</td>
<td>5.0</td>
</tr>
</tbody>
</table>

### Adjusted Coordinates

#### Adjusted Local Coordinates

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N:</th>
<th>E:</th>
<th>StErr N:</th>
<th>StErr E:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>658428.26</td>
<td>2150182.70</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>2</td>
<td>658634.88</td>
<td>2150389.32</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>5</td>
<td>658554.12</td>
<td>2149920.92</td>
<td>0.03</td>
<td>0.02</td>
</tr>
<tr>
<td>3</td>
<td>658887.03</td>
<td>2150185.59</td>
<td>0.02</td>
<td>0.03</td>
</tr>
<tr>
<td>4</td>
<td>658863.61</td>
<td>2149910.99</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>20</td>
<td>658999.28</td>
<td>2150111.19</td>
<td>0.03</td>
<td>0.04</td>
</tr>
<tr>
<td>21</td>
<td>659096.31</td>
<td>2150047.49</td>
<td>0.04</td>
<td>0.05</td>
</tr>
<tr>
<td>10</td>
<td>658657.11</td>
<td>2150000.25</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>11</td>
<td>658636.21</td>
<td>2150124.52</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>12</td>
<td>658742.89</td>
<td>2150197.81</td>
<td>0.03</td>
<td>0.03</td>
</tr>
</tbody>
</table>

### Adjusted Coordinates Error Ellipses, 95% CI

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.05</td>
<td>0.05</td>
<td>S 29-26'39.4''E</td>
</tr>
<tr>
<td>2</td>
<td>0.07</td>
<td>0.07</td>
<td>N 45-00'00.0''E</td>
</tr>
<tr>
<td>5</td>
<td>0.08</td>
<td>0.07</td>
<td>N 10-58'28.2''E</td>
</tr>
<tr>
<td>3</td>
<td>0.10</td>
<td>0.07</td>
<td>N 84-37'31.0''E</td>
</tr>
<tr>
<td>4</td>
<td>0.11</td>
<td>0.07</td>
<td>N 51-23'12.0''E</td>
</tr>
<tr>
<td>20</td>
<td>0.13</td>
<td>0.10</td>
<td>N 84-24'17.5''E</td>
</tr>
<tr>
<td>21</td>
<td>0.17</td>
<td>0.12</td>
<td>N 72-01'17.5''E</td>
</tr>
<tr>
<td>10</td>
<td>0.09</td>
<td>0.07</td>
<td>N 43-35'54.5''E</td>
</tr>
<tr>
<td>11</td>
<td>0.09</td>
<td>0.08</td>
<td>N 54-43'51.1''E</td>
</tr>
<tr>
<td>12</td>
<td>0.08</td>
<td>0.08</td>
<td>N 79-48'07.2''E</td>
</tr>
</tbody>
</table>

### Adjusted Observations
### Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>290.46</td>
<td>0.01</td>
<td>1.42</td>
<td>0.01</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.21</td>
<td>-0.00</td>
<td>0.40</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.17</td>
<td>-0.01</td>
<td>1.62</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>275.59</td>
<td>-0.01</td>
<td>1.11</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>134.66</td>
<td>-0.00</td>
<td>0.00</td>
<td>0.02</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>116.07</td>
<td>-0.00</td>
<td>0.00</td>
<td>0.02</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>309.65</td>
<td>0.01</td>
<td>0.64</td>
<td>0.01</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>130.00</td>
<td>0.01</td>
<td>0.97</td>
<td>0.01</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>126.01</td>
<td>0.00</td>
<td>0.16</td>
<td>0.01</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>129.44</td>
<td>0.01</td>
<td>0.98</td>
<td>0.02</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>144.66</td>
<td>0.01</td>
<td>0.94</td>
<td>0.02</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS): 0.01

### Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>109-19'19.2''</td>
<td>5.7</td>
<td>0.7</td>
<td>9.9</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>096-03'43.4''</td>
<td>-8.6</td>
<td>1.2</td>
<td>9.2</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>124-03'48.1''</td>
<td>-4.9</td>
<td>0.6</td>
<td>10.1</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>185-23'56.0''</td>
<td>-0.0</td>
<td>0.0</td>
<td>21.5</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>093-02'12.8''</td>
<td>1.3</td>
<td>0.2</td>
<td>9.3</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>10</td>
<td>039-26'37.1''</td>
<td>-2.9</td>
<td>0.3</td>
<td>14.4</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>11</td>
<td>241-56'27.5''</td>
<td>-1.5</td>
<td>0.1</td>
<td>21.2</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>12</td>
<td>114-56'39.8''</td>
<td>12.8</td>
<td>0.8</td>
<td>21.8</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>3</td>
<td>140-39'40.8''</td>
<td>16.3</td>
<td>1.1</td>
<td>20.3</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>2</td>
<td>325-54'33.8''</td>
<td>3.8</td>
<td>0.4</td>
<td>13.2</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>117-30'56.6''</td>
<td>14.1</td>
<td>1.8</td>
<td>9.9</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS): 8.1

### Adjusted Azimuths

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>N 45-00'00.0''E</td>
<td>0.0</td>
<td>0.0</td>
<td>8.4</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS): 0.0

### Statistics

Solution converged in 2 iterations
Degrees of freedom: 6
Reference variance: 2.84
Standard error unit Weight: +/- 1.68
Failed the Chi-Square test at the 95.00 significance level
1.237 <= 17.023 <= 14.449

### Sidestrons

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Bearing</th>
<th>Dist.</th>
<th>N</th>
<th>E</th>
<th>StDev. N</th>
<th>StDev. E</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>6</td>
<td>N 55-32'06.0''E</td>
<td>52.39</td>
<td>658664.53</td>
<td>2150432.52</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
<td>N 29-50'09.6''W</td>
<td>50.12</td>
<td>659139.78</td>
<td>2150022.56</td>
<td>0.04</td>
<td>0.05</td>
</tr>
<tr>
<td>10</td>
<td>15</td>
<td>N 86-00'28.6''W</td>
<td>10.00</td>
<td>658657.80</td>
<td>2149990.27</td>
<td>0.03</td>
<td>0.03</td>
</tr>
</tbody>
</table>

Chapter 11. Survey Menu
LEAST SQUARES VERTICAL ADJUSTMENT REPORT

Mon May 08 10:16:16 2006
2D Geodetic Model.
Input Raw Files:
C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON

FIXED VERTICAL BENCHMARKS

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>569.8500</td>
</tr>
</tbody>
</table>

POINTS TO BE ADJUSTED

<table>
<thead>
<tr>
<th>Station</th>
</tr>
</thead>
<tbody>
<tr>
<td>2,5,3,4,10,11,12</td>
</tr>
</tbody>
</table>

MEASUREMENT SUMMARY

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Elev. Diff. (unadjusted)</th>
<th>StdErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>7.5040</td>
<td>0.0145</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>7.5659</td>
<td>0.0145</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>6.9843</td>
<td>0.0145</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>-11.4907</td>
<td>0.0146</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>4.3557</td>
<td>0.0145</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>2.2639</td>
<td>0.0143</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>1.0931</td>
<td>0.0143</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>0.3828</td>
<td>0.0143</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>3.3590</td>
<td>0.0144</td>
</tr>
</tbody>
</table>

ADJUSTED ELEVATIONS

<table>
<thead>
<tr>
<th>Station</th>
<th>Adjusted Elev</th>
<th>Standard Dev.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>569.8500</td>
<td>0.00000</td>
</tr>
<tr>
<td>2</td>
<td>577.4336</td>
<td>0.02465</td>
</tr>
<tr>
<td>5</td>
<td>577.3363</td>
<td>0.02465</td>
</tr>
<tr>
<td>3</td>
<td>584.4355</td>
<td>0.02915</td>
</tr>
<tr>
<td>4</td>
<td>572.9628</td>
<td>0.03070</td>
</tr>
<tr>
<td>10</td>
<td>579.6003</td>
<td>0.03341</td>
</tr>
<tr>
<td>11</td>
<td>580.6935</td>
<td>0.03641</td>
</tr>
<tr>
<td>12</td>
<td>581.0764</td>
<td>0.03519</td>
</tr>
</tbody>
</table>

ADJUSTED MEASUREMENT SUMMARY

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Elev. Diff. (adjusted)</th>
<th>Residuals</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>7.4863</td>
<td>-0.0177</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>7.5836</td>
<td>0.0177</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>7.0019</td>
<td>0.0177</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>-11.4728</td>
<td>0.0179</td>
</tr>
</tbody>
</table>
Vertical Sideshots
Station Elevation

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>571.77</td>
</tr>
<tr>
<td>21</td>
<td>581.25</td>
</tr>
<tr>
<td>22</td>
<td>580.14</td>
</tr>
<tr>
<td>15</td>
<td>579.60</td>
</tr>
</tbody>
</table>

Project Settings

The first section of the report displays the project settings at the time the project was processed.

Tolerances

The second section of the report displays warning and error messages generated during the preprocessing of the raw data. The primary messages displayed will be warnings when multiple angles, horizontal distances, and vertical differences exceed the tolerance settings as set in the project settings. The low and high measurement and the difference are displayed. It is prudent to pay attention to any messages generated in this section of the report.

Unadjusted Observations

The next four sections list the reduced and averaged, but unadjusted measurements that make up the network. Multiple measurements of the same angle or distance are averaged to a single measurement. The standard error of multiple averaged measurements is less than the standard error of a single measurement. When multiple measurements are used, the standard error for the averaged measurement will be computed using the average of the mean formula.

The first of the four sections is a list of the control coordinates used in the network adjustment. These coordinates could have been read from the .CGR raw data file, or from the .CRD or .NEZ supplemental coordinate file. Notice that the standard errors for the control points are displayed.

The second of the four measurement sections shows the distances and distance standard errors used in the adjustment. These distances are horizontal distances computed from all slope distance and vertical angles for that distance, including all foresight and backsight distances. The standard error settings used to calculate the final distance standard error include the distance standard error, the PPM standard error, the target centering standard error and the instrument centering standard errors. The techniques and formulas used to calculate the final distance standard error are found in section 6.12 of the textbook "Adjustment Computations, Statistics and Least Squares in Surveying and GIS", by Paul Wolf and Charles Ghilani.

The third of the four measurement sections shows the angles and angle standard errors used in the adjustment. These angles are the averaged angle value for all the multiple angles collected. The standard error settings used to calculate the final angle standard error include the pointing standard error, the reading standard error, the target centering standard error and the instrument centering standard errors. The techniques and formulas used to calculate the final angle standard error are found in section 6.2 of the textbook "Adjustment Computations, Statistics and Least Squares in Surveying and GIS", by Paul Wolf and Charles Ghilani.

The fourth of the four measurement sections shows the azimuths and azimuth standard errors used in the adjustment.
Azimuths can only be defined as a direction record in the .CGR raw data file.

Adjusted Coordinates

If the adjustment of the network converges the next section displays a list of the final adjusted coordinates and the computed standard X, Y standard error. An interpretation of the meaning of the X, Y standard error, is that there is a 68% probability that the adjusted X, Y is within plus or minus the standard error of the X, Y of its true value.

The next section displays the error ellipses for the adjusted coordinates. The error ellipse is a truer representation of the error of the point than the X, Y standard error. The error ellipses are calculated to the confidence interval as defined in the settings screen. In this report the error ellipse axis is larger than the X, Y standard errors since the error ellipses in this report are calculated at a 95% probability level as set in the Settings screens. The maximum error axis direction is along the axis of the semi-major axis. The direction of the minimum error axis direction is along the semi-minor axis and is perpendicular to the semi-major axis. If a point is located from a variety of stations, you will most likely see that the error ellipse will approach a circle, which is the strongest geometric shape.

Adjusted Observations

The next three sections list the adjusted horizontal distance, horizontal angle, and azimuth measurements. In addition to the adjusted measurement the, residual, the standard residual and the standard deviation of the adjusted measurement is displayed.

The residual is defined as the difference between the unadjusted measurement and the adjusted measurement. The residual is one of the most useful and intuitive measures displayed in the report. Large residuals in relation to the standards of the survey are indications of problems with the data.

The standard residual is the a priori standard error divided by the residual of a measurement. The a priori standard errors are the standard errors of the measurements as displayed in the unadjusted measurement section. A standard residual of 1 indicates that the adjusted measurement is consistent with the adjustment being made to the measurement. One or a few measurements having high standard residuals, in relation to the rest of the standard residuals, may be an indication of a blunder in the survey. When all standard residuals are consistently large there is likely an inconsistency in the a priori standard errors and the adjustments being made to the measurements. In other words the standard errors defined for the project are too small, in relation to the survey methods used.

The standard deviation of the measurement means that there is a 68% probability that the adjusted measurement is within plus or minus the standard deviation of the measurement's true value.

Additionally, the root mean square of each measurement type is displayed. The root mean square is defined as the square root of the average of the squares of a set of numbers. Loosely defined, it can be described as an average residual for that measurement type.

Statistics

The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network.

The standard error of unit weight relates to the overall adjustment and not an individual measurement. A value of one indicates that the results of the adjustment are consistent with a priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data (.CGR) file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether
the results of the adjusted measurements are consistent with the a priori standard errors. Notice that if you change
the project standard errors and then reprocess the survey the results of the chi-square test change, even though the
final adjusted coordinates may change very little.

**Sideshots**

The next section displays the computed sideshots of the network. Sideshots are filtered out of the network adjustment
as part of the preprocessing process if the 'Enable Sideshots for Error Ellipses' toggle is off. Least squares adjustment
requires a lot of computer resources. Sideshots are filtered out to minimize the computer resources needed in a large
network adjustment. The sideshots are computed from the final adjusted network points. The results of the side shot
computations are the same whether they are reduced as part of the least squares adjustment or from the final adjusted
coordinates.

**LEAST SQUARES VERTICAL ADJUSTMENT REPORT**

The next part of the report displays the results of the vertical adjustment. In the 2D/1D model the horizontal and
the vertical adjustments are separate least squares adjustment processes. As long as there are redundant vertical
measurements the vertical component of the network will also be reduced and adjusted using least squares.

The first section displays the fixed vertical benchmarks used in the vertical adjustment. These points are fixed and
will not be adjusted vertically. Next, is listed the points that will be adjusted as part of the vertical adjustment.
The following section displays the measurements used in the adjustment. The measurements consist of the vertical
elevation difference between points in vertical adjustment. The lengths between these points are used to determine
the weights in the vertical adjustment. Longer length lines are weighted less in the vertical adjustment than shorter
length lines.

The next section displays the adjusted elevations and the computed standard deviations of the computed elevations.
Following the adjusted elevation section is a section displaying the final adjusted elevation difference measurements
and their residuals. Finally, the computed side shot elevations are displayed.

**State Plane Reduction Report file:**

When reducing to a state plane coordinate system, there is additional information displayed in the report file.

First, notice the heading of the report. The heading indicates that the project is being reduced into the North Carolina
zone of the 1983 State Plane Coordinate System. The heading shows that the elevation factor is computed based on
a project elevation of 250 feet:

**Sample 2D/1D, State Plane Coordinate System Report File**

```plaintext
===========================================
LEAST SQUARES ADJUSTMENT REPORT
===========================================
Tue Mar 21 17:37:27 2006
2D Geodetic Model.
Input Raw Files:
    C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON
Maximum iterations: 10 , Convergence Limit: 0.002000
1983 State Plane Coordinates, zone:3200 North Carolina
Elevation factor computed from project elevation,250.000000.
Elevation Units: US Feet
Horizontal Units: US Feet
Confidence Interval: 95.00
Project Geoid Height: 0.00
Default Standard Errors:
```

*Chapter 11. Survey Menu*
Distance: Constant 0.010 , PPM: 5.000
Horiz. Angle: Pointing 3.0'', Reading: 3.0''
Vert. Angle: Pointing 3.0'', Reading: 3.0''
Total Station: Centering 0.005 , Height: 0.010
Target: Centering 0.005 , Height: 0.010
Azimuth: 5''
Coordinate Control: N:0.010, E:0.010, Z:0.030,

Horizontal Angle spread exceeds tolerance:
  IP: 1, BS: 5, FS: 2
  Low: 109-19'10.0'', High: 109-19'17.0'', Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2, BS: 1, FS: 6
  Low: 190-32'02.0'', High: 190-32'10.0'', Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2, BS: 1, FS: 3
  Low: 096-03'48.0'', High: 096-03'56.0'', Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
  IP: 3, BS: 2, FS: 4
  Low: 124-03'50.0'', High: 124-03'56.0'', Diff: 000-00'06.0''

Horizontal Angle spread exceeds tolerance:
  IP: 5, BS: 4, FS: 10
  Low: 039-26'35.0'', High: 039-26'45.0'', Diff: 000-00'10.0''

Horizontal Angle spread exceeds tolerance:
  IP: 10, BS: 5, FS: 11
  Low: 241-56'23.0'', High: 241-56'35.0'', Diff: 000-00'12.0''

Horizontal Angle spread exceeds tolerance:
  IP: 11, BS: 10, FS: 12
  Low: 114-56'20.0'', High: 114-56'34.0'', Diff: 000-00'14.0''

Horizontal Angle spread exceeds tolerance:
  IP: 12, BS: 11, FS: 3
  Low: 140-39'18.0'', High: 140-39'31.0'', Diff: 000-00'13.0''

Horizontal Angle spread exceeds tolerance:
  IP: 5, BS: 4, FS: 1
  Low: 117-30'35.0'', High: 117-30'50.0'', Diff: 000-00'15.0''

Horizontal Distance from 2 to 3 exceeds tolerance:
  Low: 324.15, High: 324.20, Diff: 0.04

Vertical Distance from 2 to 3 exceeds tolerance:
  Low: 6.62, High: 8.36, Diff: 1.74

Vertical Distance from 3 to 4 exceeds tolerance:
  Low: 11.46, High: 11.51, Diff: 0.05

Horizontal Distance from 12 to 3 exceeds tolerance:
  Low: 144.64, High: 144.66, Diff: 0.02

HORIZONTAL ADJUSTMENT REPORT
================================

Chapter 11. Survey Menu 555
### Unadjusted Observations

Control Coordinates: 1 Observed Points, 0 Fixed Points, 0 Approx. Points

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N</th>
<th>E</th>
<th>StErr N</th>
<th>StErr E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>658428.26</td>
<td>2150182.70</td>
<td>0.01</td>
<td>0.01</td>
</tr>
</tbody>
</table>

The first distance listing in the Unadjusted Observation section of the report shows the unadjusted ground distances:

#### Distances: 14 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Ground Dist.</th>
<th>StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>290.45</td>
<td>0.01</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.21</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>52.39</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.19</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>275.60</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>134.66</td>
<td>0.01</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>116.07</td>
<td>0.01</td>
</tr>
<tr>
<td>21</td>
<td>22</td>
<td>50.12</td>
<td>0.01</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>309.65</td>
<td>0.01</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>129.99</td>
<td>0.01</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>126.01</td>
<td>0.01</td>
</tr>
<tr>
<td>10</td>
<td>15</td>
<td>10.00</td>
<td>0.01</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>129.43</td>
<td>0.01</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>144.65</td>
<td>0.01</td>
</tr>
</tbody>
</table>

#### Angles: 15 Observations

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>StErr r (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>109-19'13.5''</td>
<td>7.7</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>6</td>
<td>190-32'06.0''</td>
<td>26.2</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>096-03'52.0''</td>
<td>7.3</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>124-03'53.0''</td>
<td>7.8</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>20</td>
<td>185-23'56.0''</td>
<td>12.8</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>180-15'26.0''</td>
<td>17.6</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>22</td>
<td>183-26'45.0''</td>
<td>31.2</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>093-02'11.5''</td>
<td>7.5</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>10</td>
<td>039-26'40.0''</td>
<td>10.4</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>11</td>
<td>241-56'29.0''</td>
<td>15.6</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>056-23'10.0''</td>
<td>125.0</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>12</td>
<td>114-56'27.0''</td>
<td>15.5</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>3</td>
<td>140-39'24.5''</td>
<td>15.3</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>2</td>
<td>325-54'30.0''</td>
<td>9.5</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>117-30'42.5''</td>
<td>7.7</td>
</tr>
</tbody>
</table>

#### Grid Azimuths: 1 Observations

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>StErr (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>N 45-00'00.0''E</td>
<td>5.0</td>
</tr>
</tbody>
</table>

There is a new section displaying the reduced unadjusted grid distances. The grid factor, the elevation factor, and the combined factor used to reduce the ground distance to a grid distance are included in the listing:

#### Grid Distances: 14 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Grid Dist.</th>
<th>Grid Factor</th>
<th>Z Factor</th>
<th>Combined Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>290.41</td>
<td>0.99988685</td>
<td>0.99988804</td>
<td>0.99987490</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.18</td>
<td>0.99988686</td>
<td>0.99988804</td>
<td>0.99987491</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>52.38</td>
<td>0.99988689</td>
<td>0.99988804</td>
<td>0.99987494</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.15</td>
<td>0.99988692</td>
<td>0.99988804</td>
<td>0.99987497</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>275.57</td>
<td>0.99988695</td>
<td>0.99988804</td>
<td>0.99987500</td>
</tr>
</tbody>
</table>
There is a new section displaying the reduced unadjusted horizontal angles with the t-T correction applied. The t-T correction is generally a small correction. For most surveys of limited size the correction is negligible. The t-T correction is displayed in seconds.

### Grid Horizontal Angles: 15 Observations

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>StErr (Sec.)</th>
<th>t-T</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>109-19'13.5''</td>
<td>7.7</td>
<td>0.0</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>6</td>
<td>190-32'06.0''</td>
<td>26.2</td>
<td>0.0</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>096-03'52.0''</td>
<td>7.3</td>
<td>0.0</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>124-03'53.0''</td>
<td>7.8</td>
<td>-0.0</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>20</td>
<td>185-23'56.0''</td>
<td>12.8</td>
<td>-0.0</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>180-15'26.0''</td>
<td>17.6</td>
<td>-0.0</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>22</td>
<td>183-26'45.0''</td>
<td>31.2</td>
<td>-0.0</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>093-02'11.5''</td>
<td>7.5</td>
<td>-0.0</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>10</td>
<td>039-26'40.0''</td>
<td>10.4</td>
<td>0.0</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>11</td>
<td>241-56'29.0''</td>
<td>15.6</td>
<td>0.0</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>15</td>
<td>056-23'10.0''</td>
<td>125.0</td>
<td>0.0</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>12</td>
<td>114-56'27.0''</td>
<td>15.5</td>
<td>0.0</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>3</td>
<td>140-39'24.5''</td>
<td>15.3</td>
<td>0.0</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>2</td>
<td>325-54'30.0''</td>
<td>9.5</td>
<td>0.0</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>117-30'42.5''</td>
<td>7.7</td>
<td>0.0</td>
</tr>
</tbody>
</table>

### Adjusted Coordinates

**Adjusted Grid Coordinates**

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N: 658428.26</th>
<th>E: 2150182.70</th>
<th>StErr N: 0.02</th>
<th>StErr E: 0.02</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>658634.86</td>
<td>2150389.30</td>
<td>0.02</td>
<td>0.02</td>
</tr>
<tr>
<td>5</td>
<td>658854.11</td>
<td>2149920.95</td>
<td>0.03</td>
<td>0.02</td>
</tr>
<tr>
<td>3</td>
<td>658886.98</td>
<td>2150185.59</td>
<td>0.02</td>
<td>0.03</td>
</tr>
<tr>
<td>4</td>
<td>658863.56</td>
<td>2149911.03</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>20</td>
<td>658999.20</td>
<td>2150111.20</td>
<td>0.03</td>
<td>0.04</td>
</tr>
<tr>
<td>21</td>
<td>659096.23</td>
<td>2150047.51</td>
<td>0.04</td>
<td>0.05</td>
</tr>
<tr>
<td>10</td>
<td>658657.08</td>
<td>2150000.27</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>11</td>
<td>658636.18</td>
<td>2150124.52</td>
<td>0.03</td>
<td>0.03</td>
</tr>
<tr>
<td>12</td>
<td>658742.85</td>
<td>2150197.81</td>
<td>0.03</td>
<td>0.03</td>
</tr>
</tbody>
</table>

In the Adjusted Coordinates section of the report there is a new section displaying the latitude and longitude of the final adjusted points. Additionally the convergence angle, the grid factor, the elevation factor, and the combined factor are displayed for each point:

**Adjusted Geographic Coordinates**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>35-33'29.13143''N</td>
<td>78-29'42.16576''E</td>
<td>0.000-17'29.2''</td>
<td>0.99988686</td>
<td>0.99998804</td>
<td>0.99987501</td>
</tr>
<tr>
<td>2</td>
<td>35-33'31.16445''N</td>
<td>78-29'36.65237''E</td>
<td>0.000-17'30.7''</td>
<td>0.99988689</td>
<td>0.99998804</td>
<td>0.99987488</td>
</tr>
<tr>
<td>5</td>
<td>35-33'30.38930''N</td>
<td>78-29'45.12617''E</td>
<td>0.000-17'27.4''</td>
<td>0.99988687</td>
<td>0.99998804</td>
<td>0.99987493</td>
</tr>
<tr>
<td>3</td>
<td>35-33'33.66835''N</td>
<td>78-29'42.10255''E</td>
<td>0.000-17'29.2''</td>
<td>0.99988695</td>
<td>0.99998804</td>
<td>0.99987500</td>
</tr>
</tbody>
</table>
### Adjusted Coordinates Error Ellipses, 95% CI

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.05</td>
<td>0.05</td>
<td>N 17-17'30.9''E</td>
</tr>
<tr>
<td>2</td>
<td>0.07</td>
<td>0.07</td>
<td>N 45-00'00.0''E</td>
</tr>
<tr>
<td>5</td>
<td>0.08</td>
<td>0.07</td>
<td>N 10-58'14.5''E</td>
</tr>
<tr>
<td>3</td>
<td>0.10</td>
<td>0.07</td>
<td>N 84-37'33.3''E</td>
</tr>
<tr>
<td>4</td>
<td>0.11</td>
<td>0.07</td>
<td>N 51-23'11.9''E</td>
</tr>
<tr>
<td>20</td>
<td>0.13</td>
<td>0.10</td>
<td>N 84-'24'34.6''E</td>
</tr>
<tr>
<td>21</td>
<td>0.17</td>
<td>0.12</td>
<td>N 72-01'28.4''E</td>
</tr>
<tr>
<td>10</td>
<td>0.09</td>
<td>0.07</td>
<td>N 43-35'55.4''E</td>
</tr>
<tr>
<td>11</td>
<td>0.09</td>
<td>0.08</td>
<td>N 54-43'48.7''E</td>
</tr>
<tr>
<td>12</td>
<td>0.08</td>
<td>0.08</td>
<td>N 79-47'56.6''E</td>
</tr>
</tbody>
</table>

### Adjusted Observations

#### Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>290.43</td>
<td>0.01</td>
<td>1.42</td>
<td>0.01</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>292.17</td>
<td>-0.00</td>
<td>0.40</td>
<td>0.01</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>324.13</td>
<td>-0.01</td>
<td>1.62</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>275.56</td>
<td>-0.01</td>
<td>1.11</td>
<td>0.01</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>134.65</td>
<td>0.00</td>
<td>0.00</td>
<td>0.02</td>
</tr>
<tr>
<td>20</td>
<td>21</td>
<td>116.06</td>
<td>0.00</td>
<td>0.00</td>
<td>0.02</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>309.61</td>
<td>0.01</td>
<td>0.64</td>
<td>0.01</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>129.98</td>
<td>0.01</td>
<td>0.97</td>
<td>0.01</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>126.00</td>
<td>0.00</td>
<td>0.16</td>
<td>0.01</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>129.42</td>
<td>0.01</td>
<td>0.98</td>
<td>0.02</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>144.64</td>
<td>0.01</td>
<td>0.94</td>
<td>0.02</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.01

#### Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>109-19'19.2''</td>
<td>5.7</td>
<td>0.7</td>
<td>9.9</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>096-03'43.4''</td>
<td>-8.6</td>
<td>1.2</td>
<td>9.2</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>124-03'48.1''</td>
<td>-4.9</td>
<td>0.6</td>
<td>10.1</td>
</tr>
<tr>
<td>3</td>
<td>20</td>
<td>21</td>
<td>180-15'26.0''</td>
<td>-0.0</td>
<td>0.0</td>
<td>21.5</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>093-02'12.8''</td>
<td>1.2</td>
<td>0.2</td>
<td>9.3</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>10</td>
<td>039-26'37.2''</td>
<td>-2.8</td>
<td>0.3</td>
<td>14.4</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>11</td>
<td>241-56'27.5''</td>
<td>-1.5</td>
<td>0.1</td>
<td>21.2</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>12</td>
<td>114-56'39.8''</td>
<td>12.9</td>
<td>0.8</td>
<td>21.8</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>3</td>
<td>140-39'40.8''</td>
<td>16.3</td>
<td>1.1</td>
<td>20.3</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>2</td>
<td>325-54'33.8''</td>
<td>3.8</td>
<td>0.4</td>
<td>13.2</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>1</td>
<td>117-30'56.6''</td>
<td>14.1</td>
<td>1.8</td>
<td>9.9</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 8.1

#### Adjusted Azimuths

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>N 45-00'00.0''E</td>
<td>-0.0</td>
<td>0.0</td>
<td>8.4</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.0
Statistics
==========

Solution converged in 2 iterations
Degrees of freedom: 6
Reference variance: 2.84
Standard error unit Weight: +/- 1.69
Failed the Chi-Square test at the 95.00 significance level
1.237 <= 17.037 <= 14.449

Sideshots
==========

From | To  | Bearing   | Dist.  | N  | E       | StdDev. N | StdDev. E
-----|-----|-----------|--------|----|---------|-----------|-----------
 2   |  6  | N 55-32'06.0''E | 52.38 | 658664.50 | 2150432.48 | 0.02 | 0.02
21  | 22  | N 29-50'09.6''W | 50.11 | 659139.69 | 2150022.58 | 0.04 | 0.05
10  | 15  | N 86-00'28.6''W | 10.00 | 658657.77 | 2149990.30 | 0.03 | 0.03

LEAST SQUARES VERTICAL ADJUSTMENT REPORT

Tue Mar 21 17:37:27 2006
2D Geodetic Model.
Input Raw Files:
C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON

FIXED VERTICAL BENCHMARKS

Station | Elevation
---------|---------
 1       | 569.8500

POINTS TO BE ADJUSTED

Station
2, 5, 3, 4, 10, 11, 12

MEASUREMENT SUMMARY

From | To  | Elev. Diff. (unadjusted) | StdErr
-----|-----|--------------------------|-------
 1   |  5  | 7.5040                   | 0.0145
 1   |  2  | 7.5659                   | 0.0145
 2   |  3  | 6.9843                   | 0.0145
 3   |  4  | -11.4907                 | 0.0146
 4   |  5  | 4.3557                   | 0.0145
 5   | 10  | 2.2639                   | 0.0143
10  | 11  | 1.0931                   | 0.0143
11  | 12  | 0.3828                   | 0.0143
ADJUSTED ELEVATIONS

<table>
<thead>
<tr>
<th>Station</th>
<th>Adjusted Elev</th>
<th>Standard Dev.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>569.8500</td>
<td>0.00000</td>
</tr>
<tr>
<td>2</td>
<td>577.4336</td>
<td>0.02465</td>
</tr>
<tr>
<td>5</td>
<td>577.3363</td>
<td>0.02465</td>
</tr>
<tr>
<td>3</td>
<td>584.4355</td>
<td>0.02915</td>
</tr>
<tr>
<td>4</td>
<td>572.9628</td>
<td>0.03070</td>
</tr>
<tr>
<td>10</td>
<td>579.6003</td>
<td>0.03341</td>
</tr>
<tr>
<td>11</td>
<td>580.6935</td>
<td>0.03641</td>
</tr>
<tr>
<td>12</td>
<td>581.0764</td>
<td>0.03519</td>
</tr>
</tbody>
</table>

ADJUSTED MEASUREMENT SUMMARY

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Elev. Diff. (adjusted)</th>
<th>Residuals</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5</td>
<td>7.4863</td>
<td>-0.0177</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>7.5836</td>
<td>0.0177</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>7.0019</td>
<td>0.0177</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>-11.4728</td>
<td>0.0179</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>4.3735</td>
<td>0.0178</td>
</tr>
<tr>
<td>5</td>
<td>10</td>
<td>2.2641</td>
<td>0.0001</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>1.0932</td>
<td>0.0001</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>0.3829</td>
<td>0.0001</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>3.3591</td>
<td>0.0001</td>
</tr>
</tbody>
</table>

Vertical Sideshots

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>571.77</td>
</tr>
<tr>
<td>21</td>
<td>581.25</td>
</tr>
<tr>
<td>22</td>
<td>580.14</td>
</tr>
<tr>
<td>15</td>
<td>579.60</td>
</tr>
</tbody>
</table>

The 'Preprocess, compute unadjusted coordinates' option allows the computation of unadjusted coordinates. If there are redundant measurements in the raw data, the first angle and distance found in the raw data is used to compute the coordinates. If a state plane grid system has been designated the measurements are reduced to grid prior to the computation of the unadjusted coordinates. If the point is located from two different points the initial computation of the point will be the value stored.
A variety of blunder detection tools are available that gives the user additional tools in analyzing his survey data, and detecting blunders. The standard least squares adjustment processing and its resulting report can often be used to determine blunders. No blunder detection method can be guaranteed to find all blunders. So much depends on the nature of the network geometry, the nature of the measurements, and the intuition of the analyst. Generally, the more redundancy there is in a network the easier it is to detect blunders.

There are three different methods that can be used to track down blunders in a network or traverse.

**Option 1) Preprocess the raw data:**

![Preprocess the raw data interface](image)

The 'Preprocess the raw data' option validates the raw data. It displays angle and distance spreads as well as checks the validity of the raw data. Traverse closures are computed if specified. It also performs a "K-Matrix" analysis. The "K-Matrix" analysis compares the unadjusted, averaged measurements with the computed preliminary measurements (measurements calculated from the preliminary computed coordinates). This method will catch blunders such as using the same point number twice for two different points. The report will be sent to the ERR file. The ERR file will contain the tolerance checks, closures and the K-Matrix analysis. Following is an example of the report created using the 'Preprocess the raw data' option. Notice that the first section of the report shows the angle and distance spreads from the multiple angle and distance measurements. The second part of the report shows the 'K-matrix' analysis.

Additionally there is a 'Point Proximity Report' section that reports pairs of different points that are in close proximity to each other which may indicate where the same point was collected multiple times using different point numbers.

The 'Preprocess the raw data' option is one of the simplest and effective tools in finding blunders. Time spent learning how this function works will be well spent. If the project is not converging due to an unknown blunder in the raw data this tool is one of the most effective tools in finding the blunder. Many blunders are due to point numbering errors during data collections, and the 'K-matrix' analysis and 'Point Proximity' search are great tools for finding this type blunders.
Tue Mar 21 16:04:32 2006
Input Raw Files: 
C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT

Checking raw data syntax and angle & distance spreads.

Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.00 180.00050 4
Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.00 180.00070 5
Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.00 180.00100 10
Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.00 180.00020 11
Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.01 325.54320 2 H&T
Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.01 145.54300 2 H&T
Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.01 180.00020 12

Horizontal Angle spread exceeds tolerance:
  IP: 1, BS: 5, FS: 2
  Low: 109-19'10.0'' , High: 109-19'17.0'' , Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2, BS: 1, FS: 6
  Low: 190-32'02.0'' , High: 190-32'10.0'' , Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
  IP: 2, BS: 1, FS: 3
  Low: 096-03'48.0'' , High: 096-03'56.0'' , Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
  IP: 3, BS: 2, FS: 4
  Low: 124-03'50.0'' , High: 124-03'56.0'' , Diff: 000-00'06.0''

Horizontal Angle spread exceeds tolerance:
  IP: 5, BS: 4, FS: 10
  Low: 039-26'35.0'' , High: 039-26'45.0'' , Diff: 000-00'10.0''

Horizontal Angle spread exceeds tolerance:
  IP: 10, BS: 5, FS: 11
  Low: 241-56'23.0'' , High: 241-56'35.0'' , Diff: 000-00'12.0''

Horizontal Angle spread exceeds tolerance:
  IP: 11, BS: 10, FS: 12
  Low: 114-56'20.0'' , High: 114-56'34.0'' , Diff: 000-00'14.0''

Horizontal Angle spread exceeds tolerance:
  IP: 12, BS: 11, FS: 3
  Low: 140-39'18.0'' , High: 140-39'31.0'' , Diff: 000-00'13.0''

Horizontal Angle spread exceeds tolerance:
IP: 5, BS: 4, FS: 1
Low: 117-30'35.0'', High: 117-30'50.0'', Diff: 000-00'15.0''

Horizontal Distance from 2 to 3 exceeds tolerance:
Low: 324.15, High: 324.20, Diff: 0.04

Vertical Distance from 2 to 3 exceeds tolerance:
Low: 6.62, High: 8.36, Diff: 1.74

Vertical Distance from 3 to 4 exceeds tolerance:
Low: 11.46, High: 11.51, Diff: 0.05

Horizontal Distance from 12 to 3 exceeds tolerance:
Low: 144.64, High: 144.66, Diff: 0.02

K-Matrix Analysis.

Distance: From pt.: 4 To pt.: 5
Measured distance: 309.61 Initial computed distance: 309.65
Difference: -0.04

Distance: From pt.: 12 To pt.: 3
Measured distance: 144.63 Initial computed distance: 144.66
Difference: -0.03

Distance: From pt.: 5 To pt.: 6
Measured distance: 348.51 Initial computed distance: 523.29
Difference: -174.79

Angle: IP: 4 BS: 3 FS: 5
Measured angle: 093-02'11.5''
Initial computed angle: 093-01'45.1''
Difference: 000-00'26.4''

Angle: IP: 12 BS: 11 FS: 3
Measured angle: 140-39'24.5''
Initial computed angle: 140-40'32.6''
Difference: -000-01'08.1''

Angle: IP: 5 BS: 4 FS: 1
Measured angle: 117-30'42.5''
Initial computed angle: 117-31'16.4''
Difference: -000-00'33.9''

Angle: IP: 5 BS: 4 FS: 6
Measured angle: 145-30'34.0''
Initial computed angle: 079-39'46.4''
Difference: 065-50'47.6''

Point Proximity Report:

Points 3 and 30 are within 0.05 of each other.

The problem with the above project was that point 6 was accidentally used twice for two separate side shots. Because of the point numbering problem the project would not converge, using the regular least squares processing. The 'Preprocess the raw data.' option was then used. Notice in the K-matrix section the distance from 5 to 6 shows a difference of 174.79' and the angle 4-5-6 shows a difference of 065-50'47.6''. Then notice that the other listed differences are in the range of .02' for the distances and less than a minute for the angles. This report is clearly pointing out a problem to point 6.
Note the point proximity report section. During data collection point number 30 was used as the point number when the point was previously collected as point 3.

In the first section of the report notice that there are several warnings concerning whether a horizontal angle reading was collected in direct or reverse reading. The preprocessing software uses the vertical angle reading to determine the angle face of the horizontal angle reading. If the vertical angle is missing the program makes its best guess as to whether the angle was collected in direct or reverse face. Since all horizontal angle spreads in the report are reasonable, the preprocessing software must have made the correct determination.

**Option 2) Float one observation:**

This option is useful in finding a single blunder, either an angle or distance, within a network or traverse. If there is more than a single blunder in the network then it is less likely that this method will be able to isolate the blunders. If the standard least squares processing results in a network that will not converge then this blunder detection method will not work. Use the 'Preprocess the raw data' blunder detection method if the solution is not converging. Also this method will only work on small and moderately sized networks. This method performs a least squares adjustment once for every non-trivial measurement in the network. So for large networks this method may take so long to process that it is not feasible to use this method.

With this method an adjustment is computed for each non-trivial individual angle and distance measurement. Consecutively, a single angle or distance is allowed to float during each adjustment. The selected angle or distance does not "constrain" the adjustment in any way. If there is a single bad angle or distance, one of the adjustment possibilities will place most of the error in the "float" measurement, and the other measurements should have small residuals. The potentially bad angle or distance is flagged with a double asterisk (**). Since an adjustment is computed for each measurement this method my take a long time when analyzing large data files.

The adjustments with the lowest reference variances are selected as the most likely adjustments that have isolated the blunder. You have the choice to view the best adjustment, or the top adjustments with a maximum of ten. In the above example we asked to see the top 5 choices for potential blunders. The results are shown in the ERR file. Following is a section of the report generated where an angular blunder was introduced into a small traverse. Notice the '***' characters beside the angle measurements. In this report the two most likely adjustments
were displayed. The blunder was introduced to angle 101-2-3. Angle 101-2-3 was chosen as the 2nd most likely source of the blunder, showing that these blunder detection methods though not perfect, can be a useful tool in the analysis of survey measurements. Notice how much higher the standard residuals are on the suspected blunders than the standard residuals of the other measurements.

Adjusted Observations
================================

Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>2</td>
<td>68.780</td>
<td>-0.006</td>
<td>0.608</td>
<td>0.008</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>22.592</td>
<td>-0.006</td>
<td>0.573</td>
<td>0.008</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>47.694</td>
<td>-0.002</td>
<td>0.213</td>
<td>0.008</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>44.954</td>
<td>-0.001</td>
<td>0.069</td>
<td>0.008</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>62.604</td>
<td>0.005</td>
<td>0.472</td>
<td>0.009</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>35.512</td>
<td>0.006</td>
<td>0.539</td>
<td>0.008</td>
</tr>
<tr>
<td>7</td>
<td>101</td>
<td>61.704</td>
<td>0.003</td>
<td>0.314</td>
<td>0.009</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.005

Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>101</td>
<td>2</td>
<td>048-05'06''</td>
<td>-5</td>
<td>0</td>
<td>21</td>
</tr>
<tr>
<td>101</td>
<td>2</td>
<td>3</td>
<td>172-14'33''</td>
<td>-2</td>
<td>0</td>
<td>27</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>129-27'44''</td>
<td>-222</td>
<td>7</td>
<td>56 **</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>166-09'59''</td>
<td>11</td>
<td>0</td>
<td>25</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
<td>043-12'26''</td>
<td>22</td>
<td>1</td>
<td>21</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>192-11'52''</td>
<td>12</td>
<td>0</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>101</td>
<td>148-38'19''</td>
<td>8</td>
<td>0</td>
<td>25</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 85

Adjusted Azimuths

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>7</td>
<td>N 00-00'00''E</td>
<td>0</td>
<td>0</td>
<td>4</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0

Statistics

Solution converged in 2 iterations
Degrees of freedom:3
Reference variance:0.78
Standard error unit Weight: +/-0.88
Passed the Chi-Square test at the 95.00 significance level
0.216 <= 2.347 <= 9.348

Adjusted Observations
================================

Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>2</td>
<td>68.781</td>
<td>-0.005</td>
<td>0.473</td>
<td>0.009</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>22.592</td>
<td>-0.005</td>
<td>0.512</td>
<td>0.009</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>47.690</td>
<td>-0.006</td>
<td>0.586</td>
<td>0.009</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>44.950</td>
<td>-0.005</td>
<td>0.523</td>
<td>0.009</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>62.605</td>
<td>0.006</td>
<td>0.607</td>
<td>0.009</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>35.512</td>
<td>0.006</td>
<td>0.560</td>
<td>0.009</td>
</tr>
<tr>
<td>7</td>
<td>101</td>
<td>61.708</td>
<td>0.006</td>
<td>0.614</td>
<td>0.009</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.006

Chapter 11. Survey Menu 565
Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>101</td>
<td>2</td>
<td>048-05'22''</td>
<td>11</td>
<td>0</td>
<td>24</td>
</tr>
<tr>
<td>101</td>
<td>2</td>
<td>3</td>
<td>172-11'03''</td>
<td>-213</td>
<td>*</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>129-31'23''</td>
<td>-3</td>
<td>0</td>
<td>29</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>166-09'48''</td>
<td>1</td>
<td>0</td>
<td>26</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
<td>043-12'11''</td>
<td>6</td>
<td>0</td>
<td>21</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>192-11'50''</td>
<td>10</td>
<td>0</td>
<td>27</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>101</td>
<td>148-38'24''</td>
<td>13</td>
<td>0</td>
<td>27</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 81

Adjusted Azimuths

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>7</td>
<td>N-00-00'00''E</td>
<td>-0</td>
<td>0</td>
<td>5</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0

Statistics

Solution converged in 2 iterations

Degrees of freedom: 3

Reference variance: 0.89

Standard error unit Weight: +/- 0.94

Passed the Chi-Square test at the 95.00 significance level

0.216 < 2.675 < 9.348

The blunder is most likely in the measurement containing the largest residual and standard residual. The observation marked with ** is the observation that floated. It is also most likely the measurement containing the blunder.

Option 3) Re-weight by residuals & std err:

This method is capable of detecting multiple blunders but one is more likely to find the blunders if there is a high degree of redundancy (network of interconnected traverses). The higher the degree of freedom the more likely this method will find the blunders. This method will not work if the standard least squares processing will not converge.
Use the 'Preprocess the raw data' blunder detection method if the network is not converging.

First, select the number of adjustments or passes you wish to make. Each time an adjustment is completed, the measurements will be re-weighted based on the residuals and standard errors. Hopefully, after three or four passes, the blunders will become obvious. The results are shown in the ERR file, look for the measurements with the highest standard residuals. These measurements are more likely to contain blunders.

The theory behind this method is that after processing, the measurements with blunders are more likely to have higher residuals and computed standard errors. So, in the next pass the measurements are reweighted based on the computed residuals, with less weight being assigned to the measurements with high residuals. After several passes it is likely that the measurements with the blunders have been reweighed such that they have little effect on the network.

As a rule of thumb three or four passes are usually sufficient. Following is a section of the report showing the results of the 'Reweight by residuals & std. err.' This report was generated using the same data used in the earlier example. Notice that it has flagged the same two angle measurements.

The 'Reweight by residuals & std. err.' method performs a new adjustment for each pass. So, this method will take longer than the standard least squares adjustment, but does not take near as long to complete processing as the 'Float one Observation' method for larger networks.

### Adjusted Observations

#### Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>2</td>
<td>68.778</td>
<td>-0.009</td>
<td>0.827</td>
<td>0.014</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>22.588</td>
<td>-0.010</td>
<td>0.942</td>
<td>0.015</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>47.694</td>
<td>-0.002</td>
<td>0.208</td>
<td>0.009</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>44.954</td>
<td>-0.001</td>
<td>0.077</td>
<td>0.006</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>62.608</td>
<td>0.010</td>
<td>0.919</td>
<td>0.016</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>35.517</td>
<td>0.011</td>
<td>1.040</td>
<td>0.016</td>
</tr>
<tr>
<td>7</td>
<td>101</td>
<td>61.705</td>
<td>0.004</td>
<td>0.398</td>
<td>0.011</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.008

#### Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>101</td>
<td>2</td>
<td>048-05'07''</td>
<td>-4</td>
<td>0</td>
<td>21</td>
</tr>
<tr>
<td>101</td>
<td>2</td>
<td>3</td>
<td>172-13'19''</td>
<td>-77</td>
<td>*</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>129-29'56''</td>
<td>-91</td>
<td>*</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>166-09'44''</td>
<td>-3</td>
<td>0</td>
<td>24</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
<td>043-12'05''</td>
<td>0</td>
<td>0</td>
<td>9</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>192-11'40''</td>
<td>-0</td>
<td>0</td>
<td>19</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>101</td>
<td>148-38'10''</td>
<td>-1</td>
<td>0</td>
<td>20</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 45

#### Adjusted Azimuths

<table>
<thead>
<tr>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Bearing</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>7</td>
<td>N 00-00'00''E</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0

### Statistics

Solution converged in 1 iterations

Degrees of freedom: 3

Reference variance: 1.77

Standard error unit Weight: +/-1.33

Passed the Chi-Square test at the 95.00 significance level
The blunder is most likely in the measurement containing the largest residual and standard residual.

Graphics

SurvNet provides a window that graphically displays the survey network. Additionally the user is able to display error ellipses, and GPS vectors. The user has much control over how the network is displayed. The graphic tool is a useful tool in debugging networks since the raw data can be displayed prior to adjustment. If there are problems with the raw data the graphics often reflect the problem. The actual graphics cannot be output or saved. The graphics can be shown independent of whether the project has been processed.

The following snapshot shows a view of the graphic window. The graphic window can be accessed using the eye icon on the main tool bar. A project must be opened before the graphic window can be displayed. The graphics window will only display error ellipses after the project has been processed.

The tool bar in the graphics window contains buttons that allow the user to pan, zoom in, zoom out, zoom extents, and zoom to a window. Additionally there is a button that allows the user to navigate to points in the .CGR raw data editor. Also, there are buttons that will refresh the graphic, and change the graphic settings.

Pan: Use this button to pan the graphics.

Zoom in: Use this button to zoom in on the graphics.

Zoom out: Use this button to zoom out on the graphics.
Zoom extent: Use this button to zoom to the extents of the graphics.

Zoom to window: Use this button to zoom to the extents of a user picked window.

Pick Point: This button allows the user to navigate within the .CGR raw editor from the graphics window. Currently this button serves no purpose when working with .RW5 data.

Settings: This button is used to change the graphic display settings.

Refresh: This button will refresh the graphic view. Graphics are generated from the saved raw data file. If you make changes to the raw file in the raw editor you must save the file before the changes will be reflected in the refreshed graphic screen.

Following is a description of the options in the graphics setting dialog box, which is accessed using the tool bar button.

**Points Options**

These settings determine how the different type control points are displayed in the graphics window. Different graphic settings can be applied to standard control points, fixed control points and floating control points. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The control point name can be displayed and its size set from this setting dialog box.

The graphic pick radius defines a search radius. This radius is used when navigating the .CGR editor using the graphic window. You can pick a point graphically and the cursor in the editor will go to the next field containing that point number. The radius is defined in terms of the distance units of the raw data file.

**Trav/SS's Options**
These settings determine how the network line work will be displayed for total station raw data. There are settings for traverse data, side shot data, and azimuth control. The program considers any point that has only a single angle and distance to it a side shot. The user can control the color of the traverse lines. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The point name can be displayed and its size set from this setting dialog box.

Error Ellipses Options

These settings determine how the error ellipses will be displayed in the graphic window. Error ellipses will only be displayed if there is a successful least squares adjustment. The display of the error ellipses is relative. The program automatically determines a default relative error ellipse size. The user can modify the visual size of the error ellipses using the track bar in the following dialog box. The user can also control the color of the error ellipse from the following dialog box.

GPS Options
The settings in the following dialog box determine how GPS vectors will be displayed in the graphic window. The user can control the color of the GPS vector lines. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The GPS point names can be displayed and their size set from this setting dialog box.

Some statutes and jurisdictions still require the computation of traditional traverse closures. SurvNet gives the surveyor the ability to compute the closures of multiple traverses within a project as part of the preprocessing of the project raw data. Closures for single or multiple traverses can be computed for a single project. Additionally, GPS closures can be computed for GPS loops. To compute closures you must first create a "Closure" file (.CLS). Closure files define the type of traverse loops that are to be computed and the point numbers that make up the traverse.

There are two options in the FILE menu that are used to create and edit the closure, .cls, files:

Open Traverse Closure File
New Traverse Closure File

After choosing the 'New Traverse Closure File' you will be prompted for a new file name. After choosing a file name
the following dialog box is displayed.

First enter the point sequence which defines the traverse in the bottom left edit box. Check the bottom check boxes to set whether vertical closure and angle closures need to be computed. Then choose what type traverse is being entered. When the bottom fields are correct press the 'Add' button and the traverse will be entered into the upper list box.

If you need to edit one of the traverses in the top list box mouse click the traverse to be edited. The fields will be entered in the lower edit fields. Make the appropriate edits, then click the 'Change' button to save the changes to the upper list box.

Enter the points that define the traverse. Points can be entered in the form:
1,23,30-35,45,23,1

A comma separates the point numbers. You can select a range (30-35) when the points are sequential. You must start with the first backsight point number and end with the last foresight point number. For example, if you have a simple loop traverse with angle closure using points 1, 2, 3 and 4, it will be entered as "4,1,2,3,4,1" where 1 is the first occupied point and 4 is the initial backsight.

You can turn the "Angle Closure" ON or OFF. If the angle closure is ON, you will be shown the total angular error and error per angle point. If the final closing angle was not collected you can turn "Angle Closure" OFF and only the linear closure will be computed.

You can turn the "Vertical Closure" ON or OFF. If the vertical closure is ON, you will be shown the total vertical distance closure.

In order to calculate the traverse closure, you must select the TRAVERSE TYPE. It can be:

**Pt. to Pt. Trav.** - A point to point traverse is a traverse that starts at a set of known coordinates and ends at another known coordinate. This option assumes you start from two control points and tie into two control points if an angle closure is desired and one control point if only a linear closure is desired. The first backsight distance and last foresight distance are not used in computing the linear closure. Following is an example.

100,101,2-5

In the above pt. to pt. list Pt 100 is the starting backsight point, Pt. 101 is the starting instrument point. Pt. 4 is the ending instrument point and the foresight to the angle closure point is point 5. If a closing angle was not collected the list would look as follows '100,101,2-4'.

**Loop Trav., Int. Az. Ref.** - A closed loop traverse that begins by backsighting the last interior point on the traverse.
Following is an example.

7,101,2-7,101
In the above example closed loop with angle balance list, point 7 is the backsight point and point 101 is the first occupied point. If the closing angle 6-7-101 was not collected the list would be entered as follows ‘7,101,2’

Loop Trav., Ext. Az. Ref. - A closed loop traverse that begins by backsighting an exterior point (point not on the traverse).

100,101,2-7,101
In the above example loop with exterior reference and angle balance list, point 100 is the backsight point and point 101 is the first occupied point. If the closing angle 7-101-101 was not collected the list would be entered as follows ‘100,101,2’
GPS Loop Closure: - GPS loop closures can be computed using this option.

A, E, F, A
In the above example GPS loop, closure will be computed from the GPS loop going from A-E-F-A.

After the closure, .CLS, file has been created the preprocessing project settings need to be updated to include the closure file in the project. Following is a view of the settings screen that defines a closure file to be used in preprocessing. Notice that the check box 'Compute Traverse Closure' is checked and a closure file has been entered in the edit box field. Notice that the 'Edit/Create' button can be used to edit an existing closure file or create a new closure file.
When the data is processed, the closure reports will appear in the RPT and ERR files. Following is an example of a closed loop traverse report:

Traverse Closures
=================
Traverse points:
7,101,2-7,101

Loop Traverse; Interior direction reference;
Compute angle closure.
Do not compute vertical closure.

Total angular error: 000-04'16"
Angular error per point: 000-00'37"

Correct Ending Coordinates, North: 249369.069 East: 642232.387
Ending Coordinates, North: 249369.156 East: 642232.360
Error, N: 0.087 E: -0.026 Total: 0.091 Brg: S 16-46'01''E
Distance Traversed: 344.651 Closure: 3776.794

Following is an example of a GPS loop closure report.

Traverse Closures
=================

GPS Loop Points:
A,E,F,A

GPS Loop Closure;

Misclosure, X: -0.0323 Y: -0.0162 Z: -0.0105
Closure error: 0.0376 Perimeter: 20229.3858
Precision: 1:537594

GPS Loop Points:
C,F,D,B,C

GPS Loop Closure;

Misclosure, X: -0.0121 Y: -0.0101 Z: 0.0002
Closure error: 0.0158 Perimeter: 41332.9807
Precision: 1:2622216

GPS Loop Points:
F,D,B,F

GPS Loop Closure;

Misclosure, X: -0.0022 Y: -0.0044 Z: 0.0097
Closure error: 0.0109 Perimeter: 30814.5047
Precision: 1:2833226

Following is a view of the closure file that created the above GPS closure report. The 'Vert. Closure', and 'Angle Closure' toggles serve no purpose with GPS loop closures.
SurvNet provides the ability to generate reports that give the surveyor the information needed to determine if his survey is within ALTA positional tolerances. It is required that the user define which points are to be included in the ALTA testing. The points to be included for ALTA testing are defined in an .Alt file.

There are two options in the FILE menu that are used to create and edit the ALTA, .alt, files:

Open ALTA, Rel. Err. Ellipse File
New ALTA, Rel. Err. Ellipse File

After choosing the ALTA file to be created or edited the following dialog box is displayed.
The above dialog box allows the user to define the points to be included in the ALTA report processing. There are two sections in the .RPT file created through the ALTA reporting. The following report shows the sections of the ALTA report generated by the data in the dialog box. The first section of the report displays only the relative error ellipses between points. The point sequences used in this section come from the list on the right hand side of the above dialog box. The second section of the report performs an ALTA tolerance test and displays only those connections that fall outside of the ALTA tolerances (as set in the ADJUSTMENT tab of the SETTINGS dialog box). The program first checks the specific point sequences defined by the list on the right side of the dialog box. The program then checks all the connections between all the points listed on the left hand side of the dialog box.

There can be many connections to check if the point list on the left hand side of the dialog box has a lot of points. The user can limit the number of sequences to be displayed that fail the ALTA test by entering a number in the "Max. Connections to display" field.

Notice that you can enter points based on descriptions in the left hand list box. If you wished to check connections between all points with TP, EIP, MON descriptions, enter the descriptions in the edit field and press the 'Add' button. If TP, EIP, and MON represented traverse points, existing iron pipes and monuments then ALTA testing would be performed on those point types.

After you have created the .ALT point file you need to set a few project settings. These settings define the ALTA tolerances, specify the .ALT file to be used, and define the type of reporting to be generated. The 'Adjustment' tab sheet within the project 'Settings', has a relative error ellipse section where the ALTA report settings are located.

All the ALTA reporting settings reside within the Relative Error Ellipse box. If there are any side shots that need to be included in the ALTA testing the 'Enable side shots for relative error ellipses' check box must be checked.
The 'Rel. Err. Points File:' check box must be checked, and an .ALT file must be chosen to get an ALTA report. The .ALT file defines which points will be included in the ALTA reporting. See the previous discussion on the creation of the .ALT file if you are unsure of how to create an .ALT file.

Check the 'Include ALTA tolerance report' check box to create the ALTA tolerance checking report section. If an .ALT file has been chosen then the relative error section of the report will always be generated.

Next make sure the appropriate tolerance and PPM has been defined. The ALTA standards define their positional standard as .07 plus 50 PPM. Additionally, the ALTA standards require that the computations be performed to a 95% confidence. The confidence interval is set in the 'Confidence Interval:' edit field.

The following is a sample ALTA report:

```
Relative Error and ALTA Tolerances
==================================
Alta Tolerance Report ,Specific Connections, 95% Confidence Interval
Actual                    Allowable         Ratio
27    500    204.5030  0.0793     0.0802     0.9890          0.0588     S 85-06'
34    36     237.9748  0.0731     0.0819     0.8920          0.0731     N 00-00'
```

```
Alta Tolerance Report ,All Connections, 95% Confidence Interval
Actual                    Allowable         Ratio
506   556    806.5402  1.0818     0.1103     9.8054          0.2586     S 86-37'44
507   556    827.2364  1.0832     0.1114     9.7268          0.2446     S 86-37'44
505   556    818.7994  1.0779     0.1109     9.7158          0.2386     S 86-48'42
```

Chapter 11. Survey Menu 578
If the "Ratio Actual/Allowable" is 1.0 or less, the positional tolerance of the two points have passed the ALTA standards. The first part of the report labeled "Specific Connections" will show all selected connections whether they passed or failed. The second part of the report, labeled "All Connections" will only show the connections that "failed" (we chose to see the worst 25).

GPS vector networks can be adjusted with the current version of SurvNet. This chapter will describe the processing of a simple GPS network. Following is a graphic view of the GPS network that is to be adjusted. Points A and B are control points. The red lines represent measured GPS vectors. Most GPS vendor's software can output GPS vectors to a file as part of the post processing of GPS data.
When processing GPS vectors certain project settings are important. In the following settings dialog box notice that the 3D-model has been chosen, and SPC 1983 with an appropriate zone has been chosen. The 3-D model and a geodetic coordinate are required when processing GPS vectors. Though it is not require for GPS processing it is in most cases appropriate to chose to do geoid modeling.

The following settings dialog box shows the raw files used in processing GPS files. A GPS vector file must be
chosen. GPS vector files from various GPS vendors are currently supported. Following are the formats currently supported.

Coordinate control for the network can be in one of several files. The control can be located in the GPS vector file itself. More typically, the control points can be regular coordinate records in the .RW5 or the .CGR file. The also can be entered as 'Supplemental Control' in one of the available formats. When the control coordinates are in the raw data file or supplemental coordinate file, the coordinates are expected to be grid coordinates. If the control coordinates are found in the GPS vector file, they are assumed to be Earth centered XYZ.

It is not unusual to have different distance units for GPS, total station data, and control data. Often the GPS vector data is in metric units but the total station raw file is in US Feet. So, the distance units must be specified for the different raw data types.

In the Preprocessing Settings dialog box the only important setting is the 'Compute Traverse Closures:' options. If GPS loop closures need to be computed, the loop point numbers need to be entered into a closure file. See the chapter on traverse closures to see how to create closure files.
There are two GPS standard errors fields in the Standard Errors Settings dialog box. The GPS vector XYZ standard
errors and covariances do not need to be defined as project settings since they are typically found in the GPS vector
data files.

The following section shows the report generated by the least squares adjustment of the GPS network. Explanations
of the report are included in the report section and are in bold text.

--------------
LEAST SQUARES ADJUSTMENT REPORT

Chapter 11. Survey Menu 582
3-DIMENSIONAL ADJUSTMENT REPORT

The following section shows the unadjusted measurements that make up the network. The control coordinates are displayed first followed by the GPS vectors. The control coordinates are displayed as latitude/longitude, SPC Grid XYZ, and geocentric XYZ. If geoid modeling is set both ellipsoid and orthometric elevations are displayed, ellipsoid elevation in the latitude/longitude section and orthometric elevation in the SPC section. The GPS vector section shows the unadjusted delta XYZ, variances and covariances of the vectors.

Unadjusted Observations

Control Coordinates: 0 Observed Points, 2 Fixed Points, 0 Approx. Points

Sta. Latitude Longitude Z (Ellip.) StErr N: StErr E: StErr Z:
A 43-15'46.28901''N 89-59'42.16399''W 1382.62 FIXED FIXED FIXED
B 43-23'46.36261''N 89-54'00.75701''W 1235.46 FIXED FIXED FIXED

Grid XYZ

Sta. N: E: Z (Geoid): StErr N: StErr E: StErr Z:
A 140291.2060 600402.2380 1382.62 FIXED FIXED FIXED
B 155110.5390 608083.9250 1235.46 FIXED FIXED FIXED

Geocentric XYZ

Sta. X: Y: Z: StErr X: StErr Y: StErr Z:
A 402.3510 -4652995.3008 4349760.78 FIXED FIXED FIXED
B 8086.0316 -4642712.8473 4360439.08 FIXED FIXED FIXED

GPS Vectors: 13 Observations

From Sta. Delta X Variance Delta X Covariance XY
To Sta. Delta Y Variance Delta Y Covariance XZ
Delta Z Variance Delta Z Covariance YZ
<table>
<thead>
<tr>
<th></th>
<th>X Value</th>
<th>Y Value</th>
<th>Z Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>11644.223</td>
<td>0.001969</td>
<td>-1.916E-005</td>
</tr>
<tr>
<td>C</td>
<td>3601.217</td>
<td>0.001875</td>
<td>1.904E-005</td>
</tr>
<tr>
<td></td>
<td>3399.255</td>
<td>0.001965</td>
<td>-1.904E-005</td>
</tr>
<tr>
<td>A</td>
<td>-5321.716</td>
<td>0.0004316</td>
<td>-4.2E-006</td>
</tr>
<tr>
<td>E</td>
<td>3634.075</td>
<td>0.0003838</td>
<td>4.32E-006</td>
</tr>
<tr>
<td></td>
<td>3173.665</td>
<td>0.000401</td>
<td>-4.2E-006</td>
</tr>
<tr>
<td>B</td>
<td>3960.544</td>
<td>0.000461</td>
<td>-4.46E-006</td>
</tr>
<tr>
<td>C</td>
<td>-6681.247</td>
<td>0.0005092</td>
<td>4.14E-006</td>
</tr>
<tr>
<td></td>
<td>-7279.015</td>
<td>0.0004504</td>
<td>-4.46E-006</td>
</tr>
<tr>
<td>B</td>
<td>-11167.608</td>
<td>0.00054</td>
<td>-5.5E-006</td>
</tr>
<tr>
<td>D</td>
<td>-394.520</td>
<td>0.0005442</td>
<td>5.7E-006</td>
</tr>
<tr>
<td></td>
<td>-907.959</td>
<td>0.000534</td>
<td>-5.44E-006</td>
</tr>
<tr>
<td>D</td>
<td>15128.165</td>
<td>0.002922</td>
<td>-2.86E-006</td>
</tr>
<tr>
<td>C</td>
<td>-6286.705</td>
<td>0.003228</td>
<td>2.68E-006</td>
</tr>
<tr>
<td></td>
<td>-6371.058</td>
<td>0.002616</td>
<td>-2.88E-006</td>
</tr>
<tr>
<td>D</td>
<td>-1837.746</td>
<td>0.002462</td>
<td>-2.38E-006</td>
</tr>
<tr>
<td>E</td>
<td>-6253.853</td>
<td>0.002554</td>
<td>2.44E-006</td>
</tr>
<tr>
<td></td>
<td>-6596.670</td>
<td>0.002566</td>
<td>-2.42E-006</td>
</tr>
<tr>
<td>F</td>
<td>-1116.452</td>
<td>0.001495</td>
<td>-1.58E-006</td>
</tr>
<tr>
<td>A</td>
<td>-4596.161</td>
<td>0.001319</td>
<td>1.76E-006</td>
</tr>
<tr>
<td></td>
<td>-4355.906</td>
<td>0.001523</td>
<td>-1.62E-006</td>
</tr>
<tr>
<td>F</td>
<td>10527.785</td>
<td>0.005134</td>
<td>-4.5E-006</td>
</tr>
<tr>
<td>C</td>
<td>-994.938</td>
<td>0.004326</td>
<td>4.8E-006</td>
</tr>
<tr>
<td></td>
<td>-956.625</td>
<td>0.004794</td>
<td>-4.54E-006</td>
</tr>
<tr>
<td>F</td>
<td>-6438.136</td>
<td>0.001889</td>
<td>-1.84E-006</td>
</tr>
<tr>
<td>E</td>
<td>-962.069</td>
<td>0.001992</td>
<td>2.08E-006</td>
</tr>
<tr>
<td></td>
<td>-1182.230</td>
<td>0.001765</td>
<td>-1.78E-006</td>
</tr>
<tr>
<td>F</td>
<td>-4600.379</td>
<td>0.001866</td>
<td>-1.98E-006</td>
</tr>
<tr>
<td>D</td>
<td>5291.779</td>
<td>0.001975</td>
<td>1.8E-006</td>
</tr>
<tr>
<td></td>
<td>5414.431</td>
<td>0.002408</td>
<td>-1.98E-006</td>
</tr>
<tr>
<td>F</td>
<td>6567.231</td>
<td>0.001329</td>
<td>-1.3E-006</td>
</tr>
<tr>
<td>B</td>
<td>5686.293</td>
<td>0.001493</td>
<td>1.38E-006</td>
</tr>
<tr>
<td></td>
<td>6322.392</td>
<td>0.00121</td>
<td>-1.28E-006</td>
</tr>
<tr>
<td>B</td>
<td>-6567.231</td>
<td>0.001103</td>
<td>-1.26E-006</td>
</tr>
<tr>
<td>F</td>
<td>-5686.303</td>
<td>0.001495</td>
<td>1.22E-006</td>
</tr>
<tr>
<td></td>
<td>-6322.381</td>
<td>0.001326</td>
<td>-1.26E-006</td>
</tr>
<tr>
<td>A</td>
<td>1116.458</td>
<td>0.001324</td>
<td>-1.6E-006</td>
</tr>
<tr>
<td>F</td>
<td>4596.155</td>
<td>0.001622</td>
<td>1.8E-006</td>
</tr>
<tr>
<td></td>
<td>4355.914</td>
<td>0.001875</td>
<td>-1.64E-006</td>
</tr>
</tbody>
</table>

The optional Traverse Closure section shows the GPS loop closures for the GPS loops defined in the closure,.CLS file.

**Traverse Closures**

**GPS Loop Points:**

A, E, F, A
GPS Loop Closure;

Misclosure, X: -0.0323  Y: -0.0162  Z: -0.0105
Closure error:  0.0376  Perimeter: 20229.3858
Precision: 1:537594

GPS Loop Points:
C,F,D,B,C

GPS Loop Closure;

Misclosure, X: -0.0121  Y: -0.0101  Z:  0.0002
Closure error:  0.0158  Perimeter: 41332.9807
Precision: 1:2622216

GPS Loop Points:
F,D,B,F

GPS Loop Closure;

Misclosure, X: -0.0022  Y: -0.0044  Z:  0.0097
Closure error:  0.0109  Perimeter: 30814.5047
Precision: 1:2833226

Following are the final adjusted coordinates. Included in the report are point grid factor, elev. factor and the combined factor. Following the adjusted coordinates are the error ellipses, followed by the adjusted measurements section.

Adjusted Geographic Coordinates

Adjusted Grid Coordinates, (Meters)

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N:</th>
<th>E:</th>
<th>Z (Geoid):</th>
<th>StErr N:</th>
<th>StErr E:</th>
<th>StErr Z:</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>145233.5553</td>
<td>612043.7117</td>
<td>1103.10</td>
<td>0.0062</td>
<td>0.0062</td>
<td>0.0060</td>
</tr>
<tr>
<td>E</td>
<td>145091.9380</td>
<td>595081.6888</td>
<td>914.98</td>
<td>0.0053</td>
<td>0.0053</td>
<td>0.0052</td>
</tr>
<tr>
<td>D</td>
<td>154179.9383</td>
<td>596919.0552</td>
<td>894.01</td>
<td>0.0051</td>
<td>0.0050</td>
<td>0.0052</td>
</tr>
<tr>
<td>F</td>
<td>146611.7860</td>
<td>601518.4564</td>
<td>1024.24</td>
<td>0.0029</td>
<td>0.0027</td>
<td>0.0028</td>
</tr>
</tbody>
</table>

Adjusted Geocentric Coordinates, (Metric)

<table>
<thead>
<tr>
<th>Sta.</th>
<th>X:</th>
<th>Y:</th>
<th>Z:</th>
<th>StErr X:</th>
<th>StErr Y:</th>
<th>StErr Z:</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>12046.5807</td>
<td>-4649394.0824</td>
<td>4353160.06</td>
<td>0.0062</td>
<td>0.0062</td>
<td>0.0060</td>
</tr>
<tr>
<td>E</td>
<td>-4919.3403</td>
<td>-4649361.2195</td>
<td>4352934.45</td>
<td>0.0053</td>
<td>0.0053</td>
<td>0.0052</td>
</tr>
<tr>
<td>D</td>
<td>-3081.5836</td>
<td>-4643107.3693</td>
<td>4359531.12</td>
<td>0.0050</td>
<td>0.0051</td>
<td>0.0052</td>
</tr>
<tr>
<td>F</td>
<td>1518.8008</td>
<td>-4648399.1451</td>
<td>4354116.69</td>
<td>0.0027</td>
<td>0.0029</td>
<td>0.0028</td>
</tr>
</tbody>
</table>

Adjusted XYZ Coordinates Error Ellipses, 95% CI

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0.0161</td>
<td>0.0159</td>
<td>S 25-49'31.6''E</td>
<td>0.0157</td>
</tr>
<tr>
<td>E</td>
<td>0.0138</td>
<td>0.0137</td>
<td>S 29-24'51.2''E</td>
<td>0.0136</td>
</tr>
<tr>
<td>D</td>
<td>0.0133</td>
<td>0.0130</td>
<td>S 11-30'48.4''E</td>
<td>0.0135</td>
</tr>
<tr>
<td>F</td>
<td>0.0074</td>
<td>0.0070</td>
<td>S 05-18'52.7''E</td>
<td>0.0073</td>
</tr>
</tbody>
</table>

Adjusted Observations

Chapter 11. Survey Menu
The final section displays the statistic, followed by sideshots if there are any. Side shots would be a point that
has only a single GPS vector going to or from the point.

Statistics
=========

Solution converged in 2 iterations
Degrees of freedom: 27
Reference variance: 0.26
Standard error unit Weight: +/- 0.51
Failed the Chi-Square test at the 95.00 significance level
14.573 <= 6.927 <= 43.195

Sideshots
=========

Processing a Total Station and a GPS Vector Network

Processing a GPS vector network together with conventional total station data is similar to processing a GPS network by itself. The only difference in regards to project settings is that a raw data file containing the total station data needs to be chosen as well as a GPS vector file. The project must be set up for the 3D model and a geodetic coordinate system needs to be chosen. The total station must contain full 3D data, including all rod heights and instrument heights measured. Following is a view of the Input Files Settings dialog box showing both a GPS vector file and a total station raw data file chosen in a single project. It is not uncommon to have different distance units for GPS data and total station data, so make sure the correct units are set for data types.

Following is a report generated from a project that combined GPS vectors and total station data. Notice that the report is very similar to the GPS vector only project report. Explanations of the report are included in the report and are in bold, normal text.

=================================================
LEAST SQUARES ADJUSTMENT REPORT
=================================================

Mon May 08 15:08:39 2006
3D Geodetic Model.
Input Raw Files:
C:\data\lsdata\3dModel\GPSCombined\rawCombined.cgr
GPS File: C:\data\lsdata\3dModel\GPSCombined\VectorJob.gps

Output File: C:\data\lsdata\3dModel\GPSCombined\gpsCombined2D.RPT
Curvature, refraction correction: OFF
Maximum iterations: 10 , Convergence Limit: 0.000200
1983 State Plane Coordinates, zone:0202 Arizona Central
Horizontal Units: Meters
Confidence Interval: 95.00
Project Geoid Height: -30.000
Default Standard Errors:
  Distance: Constant 0.002 , PPM: 5.000
  Horiz. Angle: Pointing 0.6", Reading: 0.0"
  Vert. Angle: Pointing 2.0", Reading: 3.0"
  Total Station: Centering 0.001 , Height: 0.002
  Target: Centering 0.001 , Height: 0.002
  Azimuth: 5"
  Coordinate Control: N:0.010, E:0.010, Z:0.030,
  GPS: Centering:0.001, Vector Err. Factor:10.0
3-DIMENSIONAL ADJUSTMENT REPORT

Notice that in this example geoid modeling was used. Notice that the ellipsoid elevation is displayed with the latitudes and longitudes. Orthometric elevations are displayed with the SPC83 grid coordinates.

Unadjusted Observations

Control Coordinates: 0 Observed Points, 2 Fixed Points, 0 Approx. Points

Sta. Latitude Longitude Z (Ellip.) StErr N: StErr E: StErr Z:
17 32-58'09.73116''N 112-47'13.55718''W 179.384 FIXED FIXED FIXED
12 33-04'44.24403''N 112-54'36.04569''W 194.299 FIXED FIXED FIXED

Grid XYZ

Sta. N: E: Z (Geoid): StErr N: StErr E: StErr Z:
17 218691.215 131994.035 209.384 FIXED FIXED FIXED
12 230946.179 120618.775 224.299 FIXED FIXED FIXED

Geocentric XYZ

Sta. X: Y: Z: StErr X: StErr Y: StErr Z:
17 -2074605.540 -4938403.868 3451206.784 FIXED FIXED FIXED
12 -2082621.133 -4927852.115 3461405.389 FIXED FIXED FIXED

Notice that in the 3-D model distances are not reduced to horizontal or grid. Slope distances are reduced to mark to mark distances. A Mark to mark distance is the computed slope distance from the monument to monument.

Mark to Mark Slope Distances: 8 Observations

From Sta. To Sta. Dist. StErr
13 51 4013.947 0.022
51 52 2208.268 0.013
52 53 2202.068 0.013
53 18 2714.298 0.016
51 15 1601.219 0.010
52 15 2499.608 0.015
52 16 2639.678 0.015
53 16 2859.648 0.016

Notice that in the 3-D model distances vertical angles are considered as separate measurements. Vertical angles have also been converted to mark to mark vertical angles.

Mark to Mark Vertical Angles: 8 Observations

From Sta. To Sta. Vertical Ang. StErr (Sec.)
13 51 090-04'46.6'' 3.6
51 52 090-14'33.0'' 3.6
52 53 089-43'23.7'' 3.6
53 18 089-58'21.3'' 3.6
51 15 090-27'52.0'' 3.6
52 15 090-05'53.1'' 3.6
52 16 090-07'37.0'' 3.6
53 16 090-20'24.0'' 3.6

Horizontal Angles: 8 Observations

BS Sta. Occ. Sta. FS Sta. Angle StErr (Sec.)
12 13 51 067-58'23.5'' 0.8
13 51 52 160-18'01.7'' 0.9
51 52 53 213-47'22.1'' 0.9
52 53 18 198-52'17.3'' 0.9
13 51 15 240-35'47.0'' 0.9
51 52 15 320-50'46.2'' 0.9

Chapter 11. Survey Menu 588
### GPS Vectors: 8 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>Delta X</th>
<th>Variance</th>
<th>Delta X Covariance</th>
<th>XY</th>
<th>To Sta.</th>
<th>Delta Y</th>
<th>Variance</th>
<th>Delta Y Covariance</th>
<th>XZ</th>
<th>Delta Z</th>
<th>Variance</th>
<th>Delta Z Covariance</th>
<th>YZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>-507.728</td>
<td>6.64E-05</td>
<td>7.231E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>-5749.936</td>
<td>0.0002136</td>
<td>-1.914E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-8484.249</td>
<td>7.969E-005</td>
<td>-6.468E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>5291.644</td>
<td>4.281E-005</td>
<td>4.478E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>-4337.804</td>
<td>0.0001497</td>
<td>-1.252E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-3048.755</td>
<td>5.397E-005</td>
<td>-4.592E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>4725.685</td>
<td>0.0001066</td>
<td>6.211E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>-1175.977</td>
<td>0.0002265</td>
<td>-5.722E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1127.564</td>
<td>0.0001289</td>
<td>-9.329E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>5799.369</td>
<td>5.779E-005</td>
<td>5.987E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>1412.130</td>
<td>0.0001984</td>
<td>-1.63E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5435.492</td>
<td>7.569E-005</td>
<td>-6.123E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>3797.625</td>
<td>0.0001611</td>
<td>0.0001685</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>-3625.824</td>
<td>0.0001025</td>
<td>-8.94E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-2841.898</td>
<td>0.0003411</td>
<td>-0.000365</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>2723.952</td>
<td>6.601E-005</td>
<td>6.098E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>-6213.925</td>
<td>0.0001595</td>
<td>-3.951E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-7149.837</td>
<td>0.0001187</td>
<td>-8.61E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>3983.996</td>
<td>4.166E-005</td>
<td>3.668E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>-2884.461</td>
<td>9.022E-005</td>
<td>-2.464E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-1679.646</td>
<td>6.868E-005</td>
<td>-4.835E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>1260.043</td>
<td>3.331E-005</td>
<td>2.912E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>3329.461</td>
<td>7.695E-005</td>
<td>-1.931E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5470.192</td>
<td>6.021E-005</td>
<td>-4.279E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Adjusted Geographic Coordinates

#### Adjusted Grid Coordinates, (Meters)

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N:</th>
<th>E:</th>
<th>Z (Geoid):</th>
<th>StErr N:</th>
<th>StErr E:</th>
<th>StErr Z:</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>220822.407</td>
<td>122293.821</td>
<td>205.469</td>
<td>0.011</td>
<td>0.006</td>
<td>0.007</td>
</tr>
<tr>
<td>51</td>
<td>222914.991</td>
<td>125719.002</td>
<td>200.982</td>
<td>0.013</td>
<td>0.008</td>
<td>0.028</td>
</tr>
<tr>
<td>52</td>
<td>224634.004</td>
<td>127105.001</td>
<td>191.980</td>
<td>0.011</td>
<td>0.009</td>
<td>0.028</td>
</tr>
<tr>
<td>53</td>
<td>225289.986</td>
<td>129206.984</td>
<td>202.983</td>
<td>0.011</td>
<td>0.008</td>
<td>0.032</td>
</tr>
<tr>
<td>18</td>
<td>225217.062</td>
<td>131920.203</td>
<td>204.850</td>
<td>0.008</td>
<td>0.005</td>
<td>0.007</td>
</tr>
<tr>
<td>15</td>
<td>222134.510</td>
<td>127117.007</td>
<td>188.195</td>
<td>0.013</td>
<td>0.008</td>
<td>0.011</td>
</tr>
<tr>
<td>16</td>
<td>227273.259</td>
<td>127147.034</td>
<td>186.643</td>
<td>0.007</td>
<td>0.004</td>
<td>0.006</td>
</tr>
</tbody>
</table>

#### Adjusted Geocentric Coordinates, (Metric)

<table>
<thead>
<tr>
<th>Sta.</th>
<th>X:</th>
<th>Y:</th>
<th>Z:</th>
<th>StErr X:</th>
<th>StErr Y:</th>
<th>StErr Z:</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>-2083128.851</td>
<td>-4933602.055</td>
<td>3452921.136</td>
<td>0.006</td>
<td>0.011</td>
<td>0.007</td>
</tr>
<tr>
<td>51</td>
<td>-2079539.552</td>
<td>-4933856.880</td>
<td>3454699.821</td>
<td>0.008</td>
<td>0.013</td>
<td>0.028</td>
</tr>
<tr>
<td>52</td>
<td>-2077907.135</td>
<td>-4933512.881</td>
<td>3456146.639</td>
<td>0.009</td>
<td>0.011</td>
<td>0.028</td>
</tr>
<tr>
<td>53</td>
<td>-2075836.064</td>
<td>-4933996.021</td>
<td>3456717.919</td>
<td>0.008</td>
<td>0.011</td>
<td>0.032</td>
</tr>
<tr>
<td>18</td>
<td>-2073345.496</td>
<td>-4935074.401</td>
<td>3456676.978</td>
<td>0.005</td>
<td>0.008</td>
<td>0.007</td>
</tr>
</tbody>
</table>
### Adjusted XYZ Coordinates Error Ellipses, 95% CI

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>0.030</td>
<td>0.013</td>
<td>N 20-10'14.1''E</td>
<td>0.019</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>0.036</td>
<td>0.019</td>
<td>N 21-18'08.4''E</td>
<td>0.071</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>0.029</td>
<td>0.020</td>
<td>N 29-51'55.4''E</td>
<td>0.072</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>0.030</td>
<td>0.021</td>
<td>N 19-08'38.0''E</td>
<td>0.083</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>0.022</td>
<td>0.010</td>
<td>N 26-26'36.4''E</td>
<td>0.018</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>0.034</td>
<td>0.020</td>
<td>N 17-51'28.5''E</td>
<td>0.028</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>0.021</td>
<td>0.009</td>
<td>N 22-55'33.0''E</td>
<td>0.014</td>
<td></td>
</tr>
</tbody>
</table>

### Adjusted Observations

#### Adjusted Mark to Mark Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>51</td>
<td>4013.941</td>
<td>-0.005</td>
<td>0.244</td>
<td>0.013</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>2208.258</td>
<td>-0.011</td>
<td>0.803</td>
<td>0.010</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>2202.072</td>
<td>0.004</td>
<td>0.281</td>
<td>0.011</td>
</tr>
<tr>
<td>53</td>
<td>18</td>
<td>2714.316</td>
<td>0.018</td>
<td>1.146</td>
<td>0.011</td>
</tr>
<tr>
<td>51</td>
<td>15</td>
<td>1601.218</td>
<td>-0.001</td>
<td>0.072</td>
<td>0.008</td>
</tr>
<tr>
<td>52</td>
<td>15</td>
<td>2499.610</td>
<td>0.002</td>
<td>0.145</td>
<td>0.008</td>
</tr>
<tr>
<td>52</td>
<td>16</td>
<td>2639.683</td>
<td>0.005</td>
<td>0.357</td>
<td>0.008</td>
</tr>
<tr>
<td>53</td>
<td>16</td>
<td>2859.656</td>
<td>0.008</td>
<td>0.469</td>
<td>0.008</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.008

### Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>13</td>
<td>51</td>
<td>067-58'22.4''</td>
<td>-1.1</td>
<td>1.3</td>
<td>0.4</td>
</tr>
<tr>
<td>13</td>
<td>51</td>
<td>52</td>
<td>160-18'02.3''</td>
<td>0.6</td>
<td>0.7</td>
<td>0.7</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>53</td>
<td>213-47'22.2''</td>
<td>0.1</td>
<td>0.1</td>
<td>0.7</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>18</td>
<td>198-52'17.5''</td>
<td>0.2</td>
<td>0.2</td>
<td>0.9</td>
</tr>
<tr>
<td>51</td>
<td>15</td>
<td>15</td>
<td>240-35'46.5''</td>
<td>-0.5</td>
<td>0.5</td>
<td>0.9</td>
</tr>
<tr>
<td>52</td>
<td>15</td>
<td>16</td>
<td>320-50'47.2''</td>
<td>1.0</td>
<td>1.2</td>
<td>0.7</td>
</tr>
<tr>
<td>51</td>
<td>16</td>
<td>16</td>
<td>142-02'01.5''</td>
<td>-0.0</td>
<td>0.0</td>
<td>0.8</td>
</tr>
<tr>
<td>52</td>
<td>16</td>
<td>16</td>
<td>061-14'43.4''</td>
<td>-0.3</td>
<td>0.4</td>
<td>0.7</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.6

### Adjusted vertical angles

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Vertical Ang.</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>51</td>
<td>090-04'55.5''</td>
<td>-9.0</td>
<td>*</td>
<td>2.5</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>090-14'36.5''</td>
<td>-3.5</td>
<td>1.0</td>
<td>2.9</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>089-43'25.0''</td>
<td>-1.2</td>
<td>0.3</td>
<td>3.1</td>
</tr>
<tr>
<td>53</td>
<td>18</td>
<td>089-58'22.0''</td>
<td>-0.7</td>
<td>0.2</td>
<td>2.4</td>
</tr>
<tr>
<td>51</td>
<td>15</td>
<td>089-27'53.0''</td>
<td>-1.0</td>
<td>0.3</td>
<td>3.4</td>
</tr>
<tr>
<td>52</td>
<td>15</td>
<td>089-05'52.9''</td>
<td>0.2</td>
<td>0.1</td>
<td>2.3</td>
</tr>
<tr>
<td>52</td>
<td>16</td>
<td>089-07'39.9''</td>
<td>-2.9</td>
<td>0.8</td>
<td>2.1</td>
</tr>
<tr>
<td>53</td>
<td>16</td>
<td>089-20'24.9''</td>
<td>-0.9</td>
<td>0.2</td>
<td>2.3</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 3.6

### GPS Vectors: 8 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>Delta X</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>-507.7297</td>
<td>-0.0022</td>
<td>0.267</td>
<td>0.0061</td>
</tr>
<tr>
<td>13</td>
<td>-5193.9259</td>
<td>0.0102</td>
<td>0.699</td>
<td>0.0109</td>
</tr>
</tbody>
</table>

---

*Chapter 11. Survey Menu* 590
On the installation disk there are a variety of different least squares projects one can use to become familiar with least squares and SurvNet. These projects are located in the C&G/Carlson application folder under the Data\SurvNet subdirectory.

When you open a project for review, you will need to check the project settings, input data files to see if the data files show up. If they do not, you will have to re-select them.

**Simple Traverse with Traverse Closure**

This project is located in Data\SurvNet\2DTraverse. The name of the project is Traverse. This project illustrated
a basic loop traverse with two control points and a known azimuth for control. This project also illustrates how to obtain traditional closure information as part of the least squares report. The program uses the 2D/1D model and uses a local coordinate system.

**Traverse using State Plane Coordinates**

This project is located in \Data\SurvNet\SPCTraverse. The name of the project is TravSPCUSFt. This project illustrated a basic network with three GPS control points for control. This project is computed using the SPC83 NC Grid coordinate system. The project is set up to generate traditional loop closure data. The program uses the 2D/1D model. No elevations are computed or adjusted as there were no HI's or rod readings collected. Notice, that the project uses two raw data files. One file contains the raw angle & distance data. The other raw data file contains the control for the project.

**Network with ALTA Reporting**

The ALTA reporting project is located in \Data\SurvNet\ALTARpt. The name of the project is ALTARpt. This project illustrates how to perform ALTA tolerance testing on points within a network.

**GPS Network with GPS Loop Closures**

The GPS network project is located in \Data\SurvNet\GPSNetwork. The name of the project is GPSOnly. This project is a simple GPS network. In addition to the least squares computation and report, GPS loop closures were generated for various GPS loops for this project.

**Level Network**

The differential leveling project is located in \Data\SurvNet\LevelNetwork. The name of the project is network1. This project is a simple differential leveling network.

**Basic 3D Project**

The basic 3D adjustment project is located in \Data\SurvNet\3DNetwork. The name of the project is pg08. This project is a simple four point example network. Notice in the raw data that all set up records have an HI and all FS readings have valid rod heights. Also note that there are valid vertical angles for every slope distance. Since the 3D model is a true one process 3 dimensional adjustment, you must enter all valid slope distances and vertical angles. Be aware that you cannot just enter a horizontal distance and a vertical angle of 90 from reduced field notes when adjusting using the 3D model.

**3D Project Combining Total Station and GPS Vectors**

The total station raw data combined with GPS vectors example is located in \Data\SurvNet\GPSandTtlSta. The name of the project is GPSandTtlSta. This project illustrates a 3D model adjustment that combines both GPS vectors and data from a total station. Since there is GPS data the 3D model must be used. Notice that the GPS vectors are in meters but the total station data is in US feet and the output coordinates are in US feet. Always make sure your units are correct for each data type especially when using the 3D model.

**Resection**

The total station raw data combined with GPS vectors example is located in \Data\SurvNet\Resection. The name of the project is Resect. This project illustrates an angle and distance resection. There is no real difference in a resection project than any other angle and distance network in terms of how the data is collected or how the project...
Draw Field to Finish

This command turns data collector field notes into a final AutoCAD drawing by matching the descriptions of the field points with user-defined codes. The points are brought into the drawing with attributes defined by the code, including the layer, symbol, size and linetype. Draw Field to Finish also uses an improved coding method.

Example drawing results using the example points and example code definitions

Two files are used in Draw Field to Finish - a coordinate file and a field code definition file. The coordinate file consists of x,y,z points with text description fields. The description fields contain codes for the Draw Field to Finish processing. The coordinate file can be a Carlson coordinate (.CRD) file, C&G CRD file, C&G CGC file, Land Desktop MDB file or Simplicity Systems ZAK file. An ASCII data file can be converted into a coordinate file using the Import Text/ASCII File command. The field code definition file defines the layer, symbol, size and other actions to apply with each code. These file names are displayed at the top line of the Draw Field to Finish dialog box.

Draw Field to Finish can translate the field points into Carlson points (also called coordinate geometry points or cogo points) with a symbol, layer, and size defined by the code. The point settings of whether to label the description, point number, and elevation and whether to locate the point at zero or at the real Z can be found in the Additional Draw Options of the Draw Field to Finish dialog box. The Draw-Locate Points command has these point settings stored separately in the Point Defaults menu. Draw-Locate Points provides a simpler method for drawing points compared with Draw Field to Finish.

There are two different methods for connecting linework. One method creates line work by connecting points with the same code. The linetype is defined by the code as either points only (no line work), lines, 2D polylines, both
2D and 3D polylines, or 3D polylines (breaklines). Distinct lines with the same code are defined by adding a group number to the end of the code name in the data file. With this method, all points with the description CODE1 will be one line while points with CODE2 will be another line. Both CODE1 and CODE2 use the definition for CODE. For example, the code EP could be a code for edge of pavement that is to be connected as 3D polylines. If there are two separate edge of pavement lines on the left and right sides of a road, all the points for the left side could have the description EP1 and the points on the right side could be EP2.

The second method is the PointCAD format. This method also connects points with the same code. The difference is that instead of using a number after the code for distinct lines, you use the same code with an additional code for starting and ending the line. For example, +0 is used to start a line and -0 to end. So the coding for a segment of edge of pavement could be EP+0, EP, EP, EP-0. Another special code that has been added to Field to Finish is +7, -7. This 7 code will use the linetype definition of line, 2D polyline or 3D polyline defined by the Draw Field to Finish code. For example, if EP is defined as a 3D polyline, then the coding EP+7, EP, EP, EP-7 will create a 3D polyline. Otherwise codes like +0, -0, which is defined as start and end line, will draw EP as a line. Other PointCAD special codes are: +4 starts a curved 2D polyline, *4 starts a closed curved 2D polyline, +1 begins a 3-point arc, +5 starts a 3D polyline, *5 starts a closed 3D polyline, +6 starts a 2D polyline, *6 starts a closed 2D polyline, +7 starts a line whose type is specified by the field code definition, -05 starts a curved 3D polyline section, -50 ends that section, +8 starts a 2D and 3D polyline combination, *8 starts a closed 2D and 3D polyline combination, -08 starts a 2D and 3D polyline combination curved section, -80 ends that section. //, followed by a field code, concatenates that field code's description on to the point's description. For example, OAK//04 might become LIVE OAK TREE 4" if the field code OAK translates to LIVE OAK TREE and the field code 04 translates to 4".

The advantage to the PointCAD method is that you don't have to keep track of line numbers. For example, if you are surveying 50 curb lines, the first method would require you to use 50 distinct curb numbers. The advantage to the first method is that you don't have to use the start and end codes. Also the Nearest Found connection option applies to the first method.
Range of Points: Specify the range of points to draw.

Point Group: Specify the point group(s) to process.

Entities To Draw: The Points option draws only the points and point attributes. The Lines option draws only the linework and the Symbols draws only the symbols. Any combination of these options can be processed as well as individual processing of each entity.

Point Label Settings: Specify whether you want Draw Field to Finish to label the Point Numbers, Descriptions, and/or Points Notes which are contained in the note (.NOT) file that is associated with the coordinate (.CRD) file.

Elevation Label Settings: Specify the elevation labeling options. The Label Zeros option will label the elevations of points with z=0. Use Parentheses will place parenthesis around the elevation text. Use '+' and Use '-' will place the appropriate symbol in front of the elevation.

Locate Points on Real Z Axis: Choose between locating all the points at real Z elevation, all at zero elevation or to use the real Z setting as defined in the individual codes.

PC-PT Curve Type: Sets the method for drawing curves with more than 3 points. The Bezier option draws a smooth polyline through all the curve points. The Sequential Arcs method draws multiple arcs with arc end points at each of the curve points. These arcs are tangent to the preceding line segment. The Best Fit method creates a single best-fit curve for all the curve points between the PC and PT.

Layer Prefix: Optional layer prefix added to all entities drawn with Draw Field to Finish.

Erase Existing Draw Field to Finish Entities: When checked, this option will erase from the drawing any old entities created by previous Field-To-Finish runs before drawing the new entities.

In Range: This option only erases and redraws those Draw Field to Finish entities that are within the specified range of points to process.

Creating Point Groups: Point Groups can be created in one or two different ways. Each field code definition can specify a Point Group that all point numbers that use that code will be added to. Multiple field codes can use the same Point Group name. Check the By Code Definition checkbox for that option. The second method is to automatically create Point Groups for each code that is processed. Check the Automatically By Code checkbox for that option. Ignore Code Suffix, if checked, will cause the codes to be considered after removing the numeric suffix.
For example, points with the EP10 and EP11 codes will both be automatically added to the Point Group named EP. No matter how the Point Group is created, the Group Name Prefix can be used to add a prefix to the group name. Note: if the Point Group already exists, it will be erased first before being created again by either of these two methods.

**Pause on Undefined Codes:** When checked, Draw Field to Finish will pause if it encounters a description that is not defined in the code table.

- **Abort without drawing anything:** This stops the command. Run Draw Field to Finish again to correct the code table.
- **Use the default settings for this point:** This option draws a point in the "MISC" layer with no linework. To set your own default, define a code called "SC_DFLT".
- **Use default settings for all undefined codes:** This option will draw all undefined codes in the "MISC" layer by default or a user specified layer as defined in the "SC_DFLT" code. A good way to check the data file for unmatched descriptions is to use the Print Table command and choose the Data Points and Distinct Code options. This command will print the different codes in the data file and identify any undefined codes.

**Draw (continued)**

- **Preview Only:** When checked, this option will temporarily draw the points and linework and allow you to review it with zoom and pan.
- **Auto Zoom Extents:** When checked, this will force a zoom extents after Draw Field to Finish is done.
- **Report Codes/Points:** This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.
**Edit Codes / Points**: The Field to Finish dialog box allows you to load the coordinate and field code definition files, view and edit the code definitions, view and edit the coordinate file, view reports, and then return to the Draw Field to Finish dialog box to process the files. The top section displays the code definitions. The bottom section has three columns of functions each pertaining to controls for different elements of the command. The **Code Table** section provides controls for settings, sorting and reporting of codes. The **Code Definitions** section provides tools for the creation and editing of codes. The **Coordinate File** section provides controls for coordinate files and points. It also contains the Draw controls which starts the processing of the data using Draw Field to Finish.

![Field to Finish Dialog Box]

**Code Table**

**Code Table Settings**: These options provide tools for defining the coding method to be used for processing of the point data. Various import tools allow for the importing of codes from different software packages. Controls for handling multiple codes are located on this dialog. All special codes can be replaced to other characters defined by the user. The special codes are listed and edited on this dialog.

![Code Table Settings Dialog Box]
Set: Choose this button to specify a new code table. The name of the current table is shown in the field to the right of this button.

Process Carlson Coding: When checked, this option interprets and processes coordinate files based upon the Carlson Coding method and data collection method.

Process Eagle Point Coding: When checked, coordinate files are processed based on the Eagle Point Data Collection method. When selected the Eagle Point Codes button becomes available for selection and displays the following dialog. This dialog allows for customization of the eagle point special designators.

Currently the supported designators include, "Field Code", "Point-On-Curve", "Close Line", "Line End", "Insert Description" and "Bearing Close". Also supported is the ability to recognize overwriting of descriptions just as Eagle Point does by using the space separator instead of the "Insert Description" designator. Examples of supported coding are as follows:

.TC Places a node and or line per the field code library.
TC Places a node and or line per the field code library.
-TC Specifies a point on a curve.
TC- Specifies a point on a curve.
.TC Stops the line.
TC! Stops the line.
.TC+ Closes the line back to the starting point.
TC+ Closes the line back to the starting point.
.TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
WV.WI Places a node as specified by the code "WV" in the field code library and then begins a line as specified by code "W" in the field code library.
.TC.EP.FL Results in three lines coming together.
TC1.TC2.TC3 Results in three lines coming together. All three lines are specified by the definition of the single code "TC" in the field code library.
TC.TC1 When used in conjunction with the "Draw Field Codes Without a Suffix as Points Only" toggle, "TC" will be recognized as the node and "TC1" will be recognized as the line so that if the code "TC" in the field code library is defined as a polyline, line or 3D polyline, duplicate lines will not be unintentionally placed when this shot only pertains to a single element. Keep in mind that all line work must have a numeric suffix when using this toggle.
TREE * OAK Result on screen would be: TREE OAK
TREE OAK * Result on screen would be: OAK TREE
TREE OAK Result on screen would be: OAK
TC1.TC2.VLT6# Stops "TC1", continues "TC2" as a point on a curve and closes VLT6 as a rectangle using the "Bearing Close" code.

Note: The use of the "Use Multiple Codes for Linework Only" toggle is recommended when using Eagle Point Coding.
**Process CAiCE Coding:** When checked, coordinate files are processed based on the CAiCE Data Collection method. Examples of supported coding are as follows:

1. **169** is just the code 169.
2. **145C10** is the code 145 and line #10.
3. **169C25C** is the code 169, line #25, and the point is on a curve.
4. **172C12B** is the code 172, line #12, and this point closes the line.

**Split Multiple Codes:**

Multiple codes are defined by including each code in the point description field separated by a space. A single data point can be used in different lines by assigning it multiple codes. For instance, a point might be part of both a curb line and a driveway line with a description of "CURB DRW". Field-to-Finish uses spaces as the delimiter for multiple codes. You should avoid spaces in the descriptions except for where multiple codes are intended or after the "/" character. For example, a code for light post should not be "LGT POST" but instead should be "LGTPOST".

There are three options for the handling of multiple codes when encountered. The **All** option will split all multiple codes and process each code based upon their code definition. When **None** is select both codes will be processed based upon their code definition. If the **Prompt** option is checked on, when Field-to-Finish detects multiple codes on a point the following dialog will be displayed with options for handling the codes.

![Possible Multiple Codes Found](image)

**Import Land Desktop Desc Key:** This option imports and converts a Land Desktop Description Key into a Carlson Draw Field to Finish (fld) code definition file. The Land Desktop Description Key file is a mdb file and is found in the Land Desktop Project file path. It is located in the under the COGO/DescKey directory.

**Import TDS Codes:** This option imports TDS codes into the Carlson Field to Finish (fld) code definition file.

**Import Eagle Point Codes:** This option imports Eagle Point codes into the Carlson Field to Finish (fld) code definition file.

**Import C&G Description Table:** This option imports C&G code tables (tbl) into the Carlson Field to Finish (fld) code definition file.

**Import SurvCE Codes:** This option imports a SurvCE Feature Code List (fcl) into a Carlson Field to Finish (fld) code definition file.

**Draw Field Codes Without a Suffix as Points Only:** This option is useful for when wanting to use a field code sometimes for linework and sometimes for just points but it is preferred to number the lines rather than using start and stop codes. For example, if the field code EP is defined to use the Line Entity type, then EP25 will be drawn as a Line, however if just EP is used, no linework will connect to that COGO point.

**Use Multiple Codes for Linework Only:** When checked, and multiple codes are detected, only linework will be drawn for the secondary codes. Points are only created based on the primary code. If you want symbols for all
multiple codes, then this setting should not be checked.

**Max Delta-Height for Linework:** Use this option to specify the maximum elevation difference that Draw Field to Finish should draw any section of linework. This option is for use with 3d polylines and lines.

**Max Length for Linework:** Specify the maximum length that Draw Field to Finish should draw any section of linework.

**Special Codes:** This section allows you to substitute the existing predefined special codes and characters with your own. Draw Field to Finish recognizes several special codes. A special code is placed before or after the regular code with a space separating the code and special code. Here is a listing of the default special codes and characters.

### Special Characters

The characters (*, -, +, /, and _) can be used and substituted in Draw Field to Finish. The way these characters are used is that when the file is processed the description field is searched for these characters. If the "+" symbol was changed to "-" then the program would look for "-" and change it to "+". This is useful when a particular data collector may not have all the symbols available. With these substitutions you can make a character that is provided on the data collector generate the symbol needed. Multiple characters can also be used. For example "−" can be used to in order to produce a "/" character or any of the characters listed above.

### Special Codes

"/"

Carlson points in the drawing have point attributes including a description. When Field-to-Finish draws the points, the point description from the coordinate file is processed to match a code. The code then defines the description that is drawn with the point. For example, consider a code of "UP" with a description of "POLE" and a data point with the description "UP". The data point description "UP" would be matched with the code "UP" and the point would end up being drawn with the description "POLE". A special character "/" (the forward slash or divide key) can be used for an unprocessed description to append. Everything after the "/" is added directly to the point description and is not considered a code and no further substitution is done on it. For example, a data point with the description "UP / 150" with the same code "UP" definition above would be drawn with the description "POLE 150".
This special code causes text after the "//" to be interpreted as a field code. That field code's description is then appended to the first field code's description. For example, if the field code 02 has the description 2" and the field code OAK has the description oak tree, then 02//OAK will result in the point having the description of 2" oak tree. If the "/" character has been replaced with a different character, for example with a & character, then the "//" code would become "&&".

**PC**

This code begins a three point arc or a curved line when used with the "PT" code (see below). The point with this special code is the first point on the arc. The next point with the code is considered a point on the arc, and third point with the code is the arc endpoint. For example (in point number, X, Y, Z, description format),

10, 500, 500, 0, EP PC - start curve
11, 525, 527, 0, EP - second point on curve
12, 531, 533, 0, EP - end point of curve

**PT**

This is a special code that can be used with "PC" to define a curve with more than three points or a tangent two-point curve. Starting at the point with the "PC", the program will look for a "PT". If the "PT" is found, all the points between the "PC" and "PT" are used for the curve which is drawn as a smoothed polyline that passes through all points and only curves the polyline between points. If no "PT" is found, then the regular three point arc is applied as explained above. If no points are found between the "PC" and "PT", then the point prior to the "PC" and the point after the "PT" are used to create tangents for the resulting curve.

**CLO**

This code forces the lines drawn between a series of points with the same code to close back to the first point with the same code. For example, shots 1-4 all have the BLD description with the exception of point 4. Its description is BLD CLO. This will force the linework drawn for the BLD code to close back to point 1 which is the first point with the description of BLD.

**NE**

This code represents no elevation. A point with this special code is located at zero elevation.

**NOS**

This code indicates that the point should be "non-surface"; that is, that it should be ignored when contouring or creating surfaces. This can also be controlled per-field code by turning on the Non-Surface toggle in the Edit Field Code Definition dialog box.

**OH & OV**

The codes "OH" and "OV" stand for offset horizontal and offset vertical. These offset codes apply to 2D and 3D polylines. A single set of offset codes can be used to offset the polyline a set amount. For example,

10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP
12, 531, 533, 103, EP

This would create a polyline connecting points 10,11 and 12 and an offset polyline with a 2.5 horizontal and -0.5 vertical offset. The direction of the horizontal offset is determined by the direction of the polyline. A positive horizontal offset goes right from the polyline direction and a negative goes left. The horizontal and vertical offset amounts apply starting at the point with the offset codes until a new offset code or the end of the polyline. Only one horizontal and vertical offset can be applied to 2D polylines. For 3D polylines, multiple offset codes can be used to make a variable offset. For example,
This would offset the first point horizontal 2.5 and vertical -0.5, the second point horizontal 5.5 and vertical -0.75 and the third point horizontal 7.5 and vertical -0.75.

**SZ**

This code is used to set a different symbol size. The value of the new symbol size is specified after the SZ (example SZ0.2). This value is a size scaler that is multiplied by the current drawing scale to determine the actual drawn size. For example, a drawing scale of 50 and a symbol size scaler of 0.2 would make the drawn symbol size 10. Two dimensional scales can be accomplished by using an ‘X’ between the horizontal and vertical scales (e.g., "SZ0.2X3.5"). If no number follows the SZ special code, then the next point with the same field code as the current point will be used to determine the scale factor.

**ROT**

This code is used to set the rotation of the point symbol. If a point number follows the ROT code, then angle from the current point to this point number is used for the rotation. For example, "ROT45" would rotate the symbol towards point number 45. If there is no point number after the ROT code, then the rotation point is the next point number with the same code as the current point. ROT can also be used to rotate towards an angle clockwise from north by using ‘+’ or ‘-’ in front of the number. For example ROT+45 rotates the point symbol to the northeast and ROT-90 rotates the point symbol to the west.

**SMO**

This code is used to smooth the polyline.

**AZI & DIST**

The AZI and DIST codes are used together to locate an offset point. The AZI sets the offset azimuth and DIST sets the distance. The values should directly follow the code. For example, AZI25 DIST4.2 would draw the point offset 4.2 at an azimuth of 25 degrees.

**JOG**

The "JOG" special code allows for additional points to be inserted into the line work at perpendicular or straight offsets. Only offsets should follow the JOG code. Positive numbers indicate a jog to the right and negative numbers indicate a jog to the left. Alternatively, "R#" and "L#" can be used where # is the distance to either the right or the left. Finally, "S#" can be used to make an offset straight ahead by using a positive # or behind by using a negative #. For example, "BLDG JOG S10.1 R5 L12.2 L5 L12.2" or equivalently "BLDG JOG S10.1 5 -12.2 -5 -12.2" advances 10.1 units and then draws a closed rectangle on the right hand side of an existing line. The offsets are always done in the X-Y plane. If the current line is vertical, an offset to the right is along the positive X-axis.

**JPN**

The "JPN" (Join to Point Name) special code joins to the point named immediately after the code. For example, "JPN205" causes a line to be drawn from the current point to the point "205".

**RECT**

The "RECT" special code causes a rectangle to be formed on a 2D or 3D polyline using one of two different methods. If a number follows "RECT" (e.g., "RECT10"), a rectangle will be drawn 10 units to the right of the last two points ending on the point with the "RECT" code. Use a negative offset to place the rectangle on the left side (e.g., "RECT-2.5"). For example if locating the left side of a 10’ rectangular concrete pad using the code conc for concrete, the description of the two left points would be (conc) for the first point and (conc rect10) for the second. If no number follows "RECT", then the polyline will be closed by shooting right angles from the first point of the polyline and the
current point and creating a new point where those two lines cross. This method requires three points be established on the pad.

**CIR**

The "CIR" special code stops the linework on the previous point and causes this point to create a circle in one of three different ways. The first way uses just the current point as the center with the CIR special code followed immediately by the radius. For example "CIR5.0" will create a circle centered on this point with radius 5 and at the elevation of the current point. The second method uses two points, the first point specifying the center and the elevation, and the second point specifying the radius. The third method uses 3 points that specify the perimeter of the circle in 2D with the first point specifying the elevation. The "CIR" code can be used with all of the linetypes including "points only". The circles are always parallel to the X-Y plane.

**For Multi-Point 2ND Code**

When used on the first point of a multi-point symbol, the "2ND" code indicates that the second point of the sequence (i.e., the next point after the current one) should be used as the second symbol insertion point for a multi-point symbol. Please refer to Symbol Pts in the Edit Field Code Definition section below.

**For Multi-Point 3RD Code**

When used on the first point of a multi-point symbol, the "3RD" code indicates that the third point of the sequence should be used as the third symbol insertion point. The "3RD" code should be used with the "2ND" code. Please refer to Symbol Pts in the Edit Field Code Definition section below.

**3D Special Codes**

Below are the special codes that can be used for the easy creation of 3D surfaces. The resulting AutoCAD 3D face entities can be viewed in the Carlson 3D viewer by entering "cube" on the command line.

**FACE3D**

Makes a triangle mesh of 3D face entities by triangulating points starting with the current point and contin-
uing until the line ends or another 3D special code is found. The points must be ordered along the perimeter. Although the mesh will be built if the points are clockwise or counterclockwise along the perimeter, the visible side in the Carlson 3D viewer, "cube", is the clockwise side by default. On the Advanced tab, the shading mode may be set to Shade both or Shade back if you would prefer to see both sides or just the counter-clockwise side.

**HOLE3D**

Makes an exclusion area within the triangle mesh identified by the point number following this code (e.g., "HOLE3D101" will start a hole in point # 101). If no point number is given ("HOLE3D"), the exclusion area is applied to the last mesh or if there is a mesh in the process of being constructed by the current sequence of points, it is ended and the hole is applied to it. Note that a hole can only be applied to a mesh that was created by FACE3D (not BLOCK3D or WALL3D). Note also that it can be difficult to predict what the "last mesh" was if it used a different field code since the points of the coordinate file are processed by order of field code first and then point number. There is no limit to how many holes can be applied to a FACE3D mesh. The points of the hole itself are not added to the FACE3D mesh; they are projected on to the best plane that contains the FACE3D mesh and then the hole is cut-out.

Example 1:

2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 VENT1 HOLE3D2500 /applies 2505-2508 as a hole to last mesh that uses point #2500. So any point in the range 2500-2504 would have the same effect.
2506 VENT1
2507 VENT1
2508 VENT1

Example 2:

2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 HOUSE1 HOLE3D /stops the above mesh and applies 2505-2508 as a hole
2506 HOUSE1
2507 HOUSE1
2508 HOUSE1

Example 3:

2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D HOLE3D2503 /applies 2505-2508 as a hole to above mesh 2500-2504 and starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1
Example 4 (same result as Example 3):
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D /starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1 HOLE3D2504 /makes the mesh 2505-2508 also be a hole in the mesh 2500-2504.

**BLOCK3D**

Makes a set of 3D faces to make a 3d block using the height value entered after the code (e.g., "BLOCK3D2.3" with height 2.3). Heights can be positive or negative. With 3 points, makes a parallelogram base that is extruded up (or down if height is negative) to form a 6-sided block, including top and bottom. With 4 or more points, makes a closed polygon for the base that is then extruded by the height. The points can be laid out in clockwise or counterclockwise order around the perimeter. The perimeter or base does not have to be a convex polygon.

**WALL3D**

Makes a set of 3D faces above the polyline using a height value entered after the code (e.g., "WALL3D2.3" with height 2.3). The height can be negative if the points on the top of the wall have been shot. If no parameter exists, then the height is determined by the distance from the current point to the next point. This is a signed distance so the surveyor can shoot either the top of the wall or the bottom of the wall. Both sides of the wall will have triangles and so both sides will always be visible in the Carlson 3D viewer "cube".

Example 5 – 6’ high wall shot along the bottom:
2000 1000.000 1060.000 100.000 WALL1 WALL3D6.0 /wall 6’
2001 1100.000 1060.000 100.000 WALL1
2002 1100.000 1160.000 100.000 WALL1

Example 6 – 6’ high wall, height specified by 1st to 2nd point, shot along the top:
2020 1100.000 1160.000 100.000 WALL2 WALL3D /height by 2nd pt
2021 1100.000 1160.000 106.000 WALL2
2022 1000.000 1160.000 106.000 WALL2

**Code Table (continued)**

**Sort Table** - This sorts the code table by either code name or layer.

**Report Codes/Points** - This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.
**Code Table by CRD** - This command will create code table definitions based on the coordinate file field descriptions. This is useful when creating a code table from scratch.

**Save**: Saves the Draw Field to Finish field code definition (.FLD) file.

**Save As**: Reacts the same as Save but allows for specification of file name and location to save to.

**Code Definitions**

**Edit**: If only one field code is selected, then this command opens the Edit Field Code Definition dialog box. If multiple field codes are selected (by holding down the control key or shift key and clicking on the rows), then the Multiple Set dialog box will open.
Field-to-Finish will layerize the points and linework according to the code definitions. If the layers to use are not already defined, Field-to-Finish will create the necessary layers and assign different colors. To have the same colors for these layers in all your drawings, define the layers in the prototype drawing. The prototype drawing is the default drawing that is loaded whenever a new drawing is created. To define layers in the prototype drawing, save your current drawing and then start a new drawing with the New command. Don't give the new drawing a name, just click OK. Then define the layers as desired with the Layer command. When you are done creating layers, use the Save As command and change to Drawing Template (.DWT) under Save as Type. The default drawing template that is used is named 18SCDRAW.DWT. This template name will correspond to the version of AutoCAD that is being used, for example 16SCDRAW for AutoCAD 2004 users. You can overwrite this default template or make a new drawing template. If you make a new one, you may want to edit the Carlson icon to use the new one. To edit the icon, highlight the icon with one click and then click the right mouse button. Choose Properties and then Shortcut and change the drawing template name.

**Category:** This is an optional field that can be used to help organize your codes. A category is not used for processing and only is useful in viewing and printing.

**Processing ON:** This toggle controls whether this code will be processed.

**Sequence:** This specifies a sequence type code. Sequences are a way to simplify field entry of a sequence of codes. For example, a road cross-section could be SHD1 EP1 CL EP2 SHD2. Instead of entering these different descriptions, one sequence definition can store these descriptions in order. Then just the sequence code (such as RD) is used in the field. The cross-section can be shot in left to right then left right order, right to left then right to left order, or alternating left to right then right then right to left order. The alternating method is known as the Zorro style. The one restriction is that the shots always start from a right or left edge.

To set up a sequence, choose the Sequence toggle in the Edit Code dialog. Then pick the Define Code Sequence button. This brings up a dialog for entering the sequence codes in order. These sequence codes should be defined as normal codes somewhere else in the Draw Field to Finish code table (ie SHD as a 3D polyline). In the field, the one template code is used for all the cross-sections shots (ie RD for all the points). Then Draw Field to Finish will substitute this template code with the sequence codes (ie substitute RD with SHD).
**Resulting points and linework showing Zorro style template**

**Define Code Sequence:** This sets the code names that make up the sequence.

**Companion Codes:** This option allows different codes to connect when defined as line, polyline or 3d polyline. For example, a main line power pole code may be defined as PP while a service utility pole may be defined as UP. When processing Draw Field to Finish, it may be desired to connect all PP and UP codes together. This could be accomplished by defining a companion for UP as PP and a companion code for PP as UP. Each code needs to reference the other as a companion code.
**Code:** This is the key name that identifies the code and is matched with the field data descriptions. It is important to note that the * character, used in this field, is regarded as a wildcard or "match anything" code. For example, a field code definition with the code defined as TREE* will be used for any raw description of TREE. Raw descriptions of TREEA, TREE12, TREE, etc. will match the TREE code definition. This will always be the case unless there is a more specific code is found. For example is there was a code TREEA in the code definition file, then that code would be used instead of the TREE code.

**Full Name:** This is an optional field that describes the code for viewing.

**Layer:** The point and line work for the code will be created in this layer.

**Description:** This value is assigned to the point description attribute when the point is drawn. This description can be different than the field description. An additional description can be added to a point by entering it after a forward slash in the data description field.

**Use Raw Description:** This option turns off the Description field described above. Instead the points will be drawn with their original unprocessed descriptions.

**Dual 3D Polyline Layer:** Displays the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer name can be typed in this field.

**Set 3D Layer:** Sets the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer can be selected from the list or typed in at the bottom of the dialog box.

**Set Linetype:** Line work can be drawn in any of the special linetypes or with the linetype for the layer ("BY-LAYER"). The spacing and size of the special linetypes is determined by the AutoCAD LTSCALE system variable and by the field code settings Line Type Spacing Scaler and Line Type Text Scaler. The special linetype "hedge" is drawn with a user specified width. The special linetype "userdash" is drawn with user specified distances for the length of the dash and the length of the gap between dashes. You will be prompted for this information when you select that linetype.

**Set Symbol:** This is the point symbol for the code. To avoid drawing a symbol, use the Carlson symbol named SPT0.

**Symbol Pts:** For each code definition, the symbol insertion points can be defined with up to three points. To define the symbol insertion points, choose the Symbol Pts button in the Edit Code Definition dialog box. By default, the symbol insertion is defined by one point at the symbol center (0,0). A one point insertion definition can be used to insert a symbol offset from the center. With a two insertion point definitions, the program will rotate and scale the symbol. For example, two insertion points can be used to insert a tree symbol to size the tree, where the first point is for the tree center and the second is for the drip line. With three insertion point definitions, the program will rotate and scale the symbol in both X and Y. For example, three points can be used to insert a car symbol with the first point being the front drivers side, the second point as the back driver side (to rotate and scale the length) and the third as the back passenger side (to scale the width). Besides the insertion point coordinates, you can define a description for each point which is used for the drawn point description and is used for prompting in the Insert Multi-Point Symbol command and in Carlson Field data collection.
Three Point Symbol Drawing

The coordinates for the insertion point definitions are for the symbol at unit size. To figure these coordinates, you will need to open the symbol drawing (.DWG) file. By default, the symbols are located in the Carlson SUP directory. For example to make an insertion point for the tree drip line, open the tree symbol drawing and find the coordinate at the edge of the tree symbol (in this case 0.5,0.0).
Two Point Symbol Drawing

Not all of the symbol insertion points need to be used when drawing the points. If a code definition has a three insertion points, it is possible to use just the first two or first one. There are special codes to associate multiple points to the same symbol. The first code point is used as the first symbol insertion point. The "2ND" code is used to specify the second symbol insertion point. A point number can follow the "2ND" to identify a specific point. Otherwise without the point number, the program will use the next point with the current code. The "3RD" code is used to specify the third symbol insertion point and similar to the "2ND" code, a point number after the "3RD" is optional. The "2ND" and "3RD" codes should be assigned to the first point. For example, consider a code of "CAR" with a three point symbol insertion definition. If point #1 has a description of "CAR 2ND 3RD", then point #1 will be used as the first symbol insertion point and the next two points with the "CAR" description will be used as the second and third symbol insertion points.
Multi Point Symbol Drawing

**Custom Attributes:** This feature allows you to use customized blocks that have customized attributes (the tag/value pairs). This feature works for both point attribute blocks and symbols. For attribute blocks, Field-to-Finish looks for attributes with the tags "PT#", "ELEV2", and "DESC2". The custom attributes feature allows you to define up to an additional 5 attributes in their custom blocks on a per-field code basis. For example, the custom block could have an attribute with the tag "TREE_SPECIES" and there's a separate field code for each species of tree. Each of those field codes can specify the value that should be assigned to the attribute that has the TREE_SPECIES tag. Then when the points are drawn, the tree species is shown. Note that the custom attributes must have their Constant and Preset properties set to "no". The custom attributes settings in F2F should not use those tags that the software already handles (PT#, ELEV2, and DESC2), or the setting will be ignored.

**Set Color:** The line work will be drawn in this color. The default is BYLAYER.

**Text Size Scaler:** This is a scaler value that is multiplied by the horizontal scale to obtain the actual size.
Symbol Size Scaler: This is a scaler value that is multiplied by the horizontal scale to obtain the actual size in AutoCAD. The horizontal scale can be set in Drawing Setup.

Line Width: This controls the width for the linework. Only applies to 2D polylines.

Line Type Spacing Scaler: This is a scaler value that is multiplied by the AutoCAD LTSCALE system variable to give the distance between symbols in the line.

Line Type Text Scaler: This is a scaler value that is multiplied by the AutoCAD LTSCALE system variable to give the size of the text in a line.

Unit Symbol: This option will draw the point symbol at unit (1:1) scale. For example, this option could be used for a symbol that is already drawn to actual dimensions such as a car symbol.

Set Template: For 3D polyline codes, this option allows you to assign a template (.TPL) file to the code. The code points act as the centerline for the template and the program will draw parallel 3D polylines for each break point (grade ID) in the template. The template file is defined in the Civil Design module.

Entity Type: This defines the line entity to be created. Points only does not create any line work. 3D Polyline can be used for breaklines. 3D and 2D entity type selection creates a 3d polyline in the layer specified in the Dual 3d polyline layer setting and a 2d polyline in the layer identified in the Layer setting. Since 3d polylines do not display linetypes, this is useful when needing linework in 3d for design work while also needing to display linetypes for final plotting of the drawing. This provides an easy and quick way to turn off all 2d polylines or all 3d polylines by using the layer control dialog or the appropriate toggles in the Draw Points dialog.

Attribute Format: This chooses the type of point entities to create. The Attribute Block format creates the Carlson point entity which is block with attributes for point#, elevation and description. The Text Attribute format creates text entities for each of the point attributes. When the Text Attribute format is selected, the Set button is available where you can control which attributes to draw as text and the position, decimals, style, prefix, suffix and layer for each attribute.

Separate Attribute Layers: This controls the layers of the point and symbol attributes. With "None" the point layers are the standard layers, "PNTNO", "PNTLEV" and "PNTDESC", and the symbol layer is "PNTMARK". With "Points" or "Both" the point attribute layers begin with the layer for the code followed by the attribute type. For example, the "DWL" code shown in this dialog has a layer name "DRIVEWAY". The point attributes would then be "DRIVEWAYNO", "DRIVEWAYELEV" and "DRIVEWAYDESC". With "Symbols" or "Both" the symbol attribute layer begins with the layer for the code followed by "MARK".
Hard Breakline: This will tag the 3D polylines created with this code as hard breaklines. In *Triangulate & Contour*, contours are not smoothed as they cross hard barriers.

Smooth Polyline: This applies a modified Bezier smoothing to the polyline. The smoothed polyline will pass through all the original points.

Connection Order: The points of a distinct code can be connected in their point number order or by nearest found which makes the line by adding the next closest point.

Tie: When checked the linework drawn with this code will always close. For example if you have points 1, 2, 3, and 4 with the code BLDG and Tie is checked on for the code BLDG, then the linework will be drawn from point 1 to 2 to 3 to 4 and then back to point 1, closing the figure.

Elevation Integers: This controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

Elevation Decimals: This controls the display precision for the elevation label.

Elevation Prefix/Suffix: These set the prefix and suffix for the elevation label per code. In the Draw function under Additional Draw Settings, there is an override to set the elevation prefix/suffix for all the codes.

Attribute Layout ID: Controls the location of the point number, elevation and description. These attribute layouts are defined in AutoCAD drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

Locate Pts on Real Z Axis: This option will draw the points at the actual point elevation. Otherwise the points are drawn at zero elevation. For example, you could turn this option off for the FH for fire hydrant code to drawn them at zero. Then the GND code could have this option on to draw the ground shots at their elevations.

Random Rotate: This option will randomly rotate the symbol. For example, this option could be used for tree symbols to have the trees drawn in various orientations.

Random to Line: This option applies to points that are part of Field-to-Finish linework. This option will align the point attributes and symbol to the associated linework.

Distinct Point Layer: When this toggle is selected, the line work is created in the layer defined in the Layer field and the points are created in the specified distinct point layer. For example, you could have DRIVEWAY for linework and DRIVEWAY_PNT for the points.

Code Definitions (continued)

Select All: This option selects all the codes. This can be used when only wanting to process a couple of codes. For example, use the select all option to select all the codes and then turn them off. Now select the codes for processing and turn them on. Also it can be used to make a global change to all the codes.

Add: The new code definition is inserted in the list in the position after the currently selected one. If none are selected for positioning, the new code is placed at the top. Only one code definition may be highlighted before running this routine.

Copy: This option copies the definition of a selected code. It opens the Edit Field Code Definition dialog and copies the definition of the selected code to the appropriate settings. It does not copy the name of the code. It is a time saving tool to use when creating codes that are similar with only a couple of differences.

Cut: This command will remove the highlighted code definitions from the list and puts them in a buffer for retrieval with Paste.
**Paste:** This command will insert the code definitions put in the buffer by the Cut command. These codes will be inserted after the row of the currently highlighted code or at the top.

**Search:** Allows you to search for a specific code in the list.

**Coordinate File**

**Set CRD File:** This command allows you to specify a coordinate (.CRD,.CGC,.MDB,.ZAK) file to process.

**Edit Points:** This command opens the *Edit Points* spreadsheet editor. See *Edit Points* for more details.

**Draw:** This command returns to the Draw Field to Finish dialog box.

**PointCAD Coding**

Field-to-Finish supports an early Carlson style of linework coding called PointCAD. The PointCAD codes use numbers with +,-,* symbols as follows:

- `+0` Starts a regular 2D line (not a polyline) that is open.
- `*0` Starts a regular 2D line that is closed.
- `+4` Starts a curved 2D polyline that is open.
- `*4` Starts a curved 2D polyline that is closed.
- `+1` Begins a 3-point arc.
- `-0` or `-1` or `-3` or `-4` or `-5` or `-6` or `-7` Ends a line.
- `+5` Starts a 3D polyline that is open.
- `*5` Starts a 3D polyline that is closed.
- `+6` Starts a 2D polyline that is open.
- `*6` Starts a 2D polyline that is closed.
- `+7` starts line whose type (2D line, 2D polyline, 3D polyline) is specified by the point's field code definition. If the field code definition is to use points, then a 2D line is started.
- `+2` Middle point of 3 point arc
- `-05` starts a curved 3D polyline section.
- `-50` ends a curved 3D polyline section.
- `+8` starts a 2D and 3D polyline combination that is open.
- `*8` starts a 2D and 3D polyline combination that is closed.
- `-8` ends a 2D and 3D polyline combination.
- `-08` starts a 2D and 3D polyline combination curve that is open.
- `-80` reverts back to a straight 2D and 3D polyline combination.
PointCAD linework coding examples

**Pulldown Menu Location:** Survey

**Keyboard Command:** fld2fin

**Prerequisite:** A data file of points with descriptions

**File Names:** \lsp\finish.arx, \lsp\field.dcl, \lsp\deffield.lsp

### Field to Finish Inspector

This command reviews entities in the drawing created by Field To Finish. Point descriptions can be edited and the drawing is updated for both the point symbols and linework, using the Field To Finish coding.

Field to Finish Inspector docks a control panel dialog at the bottom of the screen which leaves the drawing view at the top.

**Code:** Lists the field codes that were found in the drawing. Clicking on a code causes the Instance list to show all of the linework and points that use the selected code.

**Instance:** Lists the linework and points of the currently selected code.

**Point:** Lists the points that make up the currently selected linework or point in the Instance list.
Go to Point#: Type in the point # to see in the drawing and then press this button to bring the point # into view. If the point # is not in the drawing, then a message will be printed at the top of the dialog box. If the Zoom toggle is on, then the point # will be brought to the center of the screen even if it was already visible on the screen. Likewise, if Isolate or Highlight are on, then those options will be applied, too.

Zoom: Check this checkbox to make the Field to Finish Inspector automatically zoom and pan the drawing so that the selected items in the above lists are viewable. Zoom is used on the Code and Instance lists. Pan is used for all three lists.

Isolate: Check this checkbox to make the Field to Finish Inspector only display the selected items in the above lists.

Highlight: Check this checkbox to make the Field to Finish Inspector highlight the selected items in the above lists.

Restore View On Exit: Check this checkbox to make the Field to Finish Inspector restore the zoom and pan values when you exit.

Desc: This edit box will display the description field from the coordinate file used on the given point(s). If the points do not all have the same description in the coordinate file, *varies* is displayed instead. If you type in a new description and then click on Apply, the new description will be applied to the coordinate file and Field-to-Finish will be used to process the coordinate file and update the drawing, including linework. Press the Code button to place an existing field code into this Desc edit box.

Code: Press this button to select a field code from the current field code definition (FLD) file. The following dialog box is an example of what you will see. The Categories on the left are the categories that are defined in the current field code definition file. The list on the right is all of the field codes in the selected category. Select (all categories) to see all of the codes in all of the categories. The selected field code will be placed in the Desc edit box.
Apply: Press this button to apply the modified description that is in the Desc edit box to the currently selected points. The below dialog box will come up that lists exactly what will be changed. Optionally, the raw file that was used to create the coordinate file will be updated as well. Press OK to continue. The description will be updated in the coordinate file and then Field-to-Finish will be used to process that coordinate file and finally the drawing will be updated to reflect the changes.

![Update Descriptions dialog box]

Pulldown Menu Location: Survey
Keyboard Command: f2f_inspect
Prerequisite: Entities created by Field-to-Finish
File Name: \lsp\finish.arx

Enter Deed Description

This command lets you enter line and curve data which is drawn and annotated as entered. When entering in data, the bearing quadrant and bearing value is input on the same line. For example, a bearing of N45-10-30E would be entered as 145.1030, where (1) represents the NE quadrant. The numeric codes for the quadrants are 1-4 beginning with NE as (1) and continuing sequentially in a clockwise direction to the NW quadrant (4). Distance data can be entered in Varas, Meters, Poles, Chains or US Feet. Curve data can be entered for Non-Tangent, Reverse-Tangent and Tangent curves. Data used to define curves includes but is not limited to Tangent Out Bearing, Radius data, Chord Bearing, DeltaAng and Tangent Length. Prompting for curve data it determined by what curve definition data is used. When you are finished, the closure and area of the figure is reported. The program has the option to Undo the previous data entry in case you need to re-enter values. Also, the program auto-saves the data entered during the
command so that if the command is canceled and restarted, there's an option to resume entering data. The command starts with the dialog shown here.

**Line and Curve Layer:** Specify the layer name for lines and arcs.

**Annotations Layer:** Specify the layer name for the annotation text.

**Points Layer:** Specify the layer name for the points.

**Traverse by:** Select between entering bearings, azimuth, gons or point numbers. The points option recalls points from the current coordinate (.CRD) file.

**Point Format:** Choose between creating Carlson points in the coordinate (.CRD) file at each point in the figure, drawing descriptions only or having no point labels.

**Line-Curve Annotations:** Specify whether the annotation should be drawn on the lines and arcs or should be added to line and curve tables.

**To Table Scaler:** Used only when the above setting is set to On Lines. If the line or arc length is less than this value multiplied by the horizontal scale, then that annotation will be entered in the line or curve table. For example, if the horizontal scale is 50 and you enter a table scaler of 1.5, then all short curve and line annotation less than 75' (1.5*50) will go to the table.

**Deed Name:** Specify the beginning deed name. Only available when Store to Deed File is checked on.

**Draw Linework:** Specify whether or not to draw linework, if this is disabled then all annotation options are disabled also.

**Prompt for Descriptions:** Specify whether or not the program should prompt you for point descriptions. If this is not checked, then point descriptions are blank.
**Prompt for Elevations:** Specify whether or not the program should prompt you for point elevations. If this is not checked, then point elevations are set to zero.

**Plot Point Symbols:** If the Point Format is set to Descriptions Only or None, this option is available. It will place point symbols without creating points in the coordinate (.CRD) file.

**Create Radius Points:** When checked, radius points will be created for arcs. Radius points are given the description RADPT.

**Store to Raw Data (.RW5) File:** When checked, data entered will also be written to a raw data (.RW5) file that can be opened using the Edit-Process Raw Data File command. The compass rule, crandall rule, transit rule, angle balance adjustment and least square adjustment routines are all available. See Edit-Process Raw Data File for more information.

**Store to Deed File:** When checked, data entered will be written to a deed (.PDD) file. This file can be processed later to correct errors, create deed reports or to redraw the deed. To use this option, set the deed file name by picking the Specify File Name button. Also set the Deed Name field.

**Specify Deed File Name:** Before specifying the deed (.PDD) file name, choose New or Append/Revise from the Deed File Parameters below. Only available when Store to Deed File is checked on.

**Prompts**

**Pick point or point number:** 1

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>North(y)</th>
<th>East(x)</th>
<th>Elev(z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8000.00</td>
<td>12000.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

In this example the coordinate for point number one has already been stored in the current coordinate (.CRD) file with the Draw-Locate Points command.

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>:: 145.3035**

**Varas/Meters/Poles/Chains/<Distance(ft)>:: 210.5** Enter P to input a distance in Pole format or C for Chains format.

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>:: C Enter C to traverse through a curve.**

**Tangent-out/Radius:** R

**Radius:** 1103.5

**Curve direction (Left/<Right>)? press Enter for right**

**Non-tangent/Reverse-tangent/Chord/Delta angle/Tangent/<Arc length>:: N** If the curve is tangent to the previous leg then enter the arc length, enter C for a chord length, D to enter the delta angle or T to enter the tangent distance. In this example we have a non tangent curve so we entered N.

**Curve direction input [<Chord>/Radial]?:: C**

**Chord Bearing (Qdd.mmss): 245.2341**

**Length of Chord:** 201.22

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>:: 345.3218**

**Varas/Meters/Poles/Chains/<Distance(ft)>:: 209.28**

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>:: 445.2348**

**Varas/Meters/Poles/Chains/<Distance(ft)>:: 200.54**

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>:: E Enter E to end the prompting and calculate the closure error.**

**Closure error distance > 1.35251089 Error Bearing > N 70d41'35'' E**

**Closure Precision > 1 in 607.63 Total Distance Traversed > 821.82**
Deed Reader

This command is used to extract deed line and curve data from the text of a deed. It shows the deed data in a spreadsheet and also graphically. The deed data can be saved to a deed file, drawn and reported. A blank Deed Reader dialog box appears as soon as the command is chosen.

The Text section is for entering in ASCII/TXT data for the deed. This can be accomplished by using the Paste button at the bottom of the dialog, or loading a filing using the Load button. You can also type information directly into this screen. Reader Warnings indicates irregularities in the deed text. The Result section is below that. This section will give you a detailed, editable spreadsheet of the deed, which can be saved. At the very bottom of the dialog is a section called Summary. Here is where you will see the mathematical and closure data for this deed displayed.

Paste: This is for pasting in copied information.
Load: This option will load an existing deed text (.TXT) file. Here is an example.
Quick Settings: This option allows you to set up, in a speedy fashion, the detailed criteria for this Deed Reader command.

Settings: A more formal settings feature, which is more methodical and dialog box driven.
Draw: This option will provides you choices as to how the date will be translated to the drawing screen.

It is in the Draw Options dialog that you can make decisions as to how detailed and involved your drawing will be. The Points section is key if you desire to have points created to a new coordinate file, or if you want to append an existing one. In the Annotations section, if Label Lines and Arcs is clicked on, the next dialog that you see, after choosing a point of origin, will be Auto-Annotation. Finally, click OK.

Prompts

Deed Reader dialog: enter in or load the deed text

Pulldown Menu Location: Survey
Keyboard Command: read_legal
Prerequisite: Deed text
File Name:
Process Deed File

This command contains several functions for deed (.PDD) files. A deed file consists of one or more deed descriptions. Each deed description includes a deed name, starting coordinate and line/curve data. This deed data can be created with the Enter Deed Description command. This command begins with the Process Deed File dialog.

Edit opens the Edit Deed dialog where you can view or modify the deed name, starting coordinates, or line/curve data. Within this dialog the following commands are available.

Edit allows you to edit the currently highlighted deed call.
Add allows you to add a new deed call (line or curve).

Remove removes the highlighted deed call.

Add opens the Edit Deed dialog where you can add a new deed.

Remove removes the currently highlighted deed.

Report generates a report for the currently highlighted deed. The report is displayed in the Standard Report Viewer.

Draw draws the currently highlighted deed in the drawing and returns to the main dialog. The actual geometry will not appear in the drawing until you exit Process Deed File. Use the Auto-Annotate command to label the deed.

Save saves the currently loaded deed (.PDD) file.

Save As allows you to save the currently loaded deed (.PDD) file to another file name.

Pulldown Menu Location: Survey

Keyboard Command: deed

Prerequisite: None
Deed Linework ID

This command is used to report the deed name associated with selected linework. Since the Carlson deed commands that draw deeds attach the deed name to the linework, this command will extract that information and list it out. You can choose to select more than one deed linework entity before ending out of the command.

Prompts

Select deed linework to identify: select deed linework
Deed Name: Out Lot3 - Carlson Property
Select deed linework to identify (Enter to end): select Enter

Pulldown Menu Location: Survey
Keyboard Command: deed_id
Prerequisite: A deed name assigned to the entity
File Name: \lsp\scogo1.fas

Deed Correlation

Function

This command takes a set of field and design/deed points and creates an inverse report, such as radial stakeout, for each pair of points. It includes a routine to find the best point to hold and the best point to rotate to. This command provides tools for the correlation of surveyed points with that of deed input points. Different points can be specified as hold points, or rotation points, and provide a report showing the bearing and distance of all sides of the traverse/deed, based upon the hold and rotation points. This allows for the review of different scenarios based upon hold and rotation points. Perhaps two points in the field are in good shape, and seem to meet all the descriptions thereof. You decide to hold these two points as good, but you would like to see what holding these points will do to each side/call of the tract/description. This is what this routine is designed to do. In addition to allowing user specified trials of different hold and rotation points, the routine also provides a Find Minimum Rotation option that will report which points specified as the hold and rotation points will result in the minimum rotation of all sides of the tract/description. All points must be contained in the same coordinate file, and the points to be used in the correlation must be specified as either Survey points or Deed points.
**Edit:** This button allows for editing of the highlighted/selected Survey and Deed point. Once selected the dialog above is displayed allowing for changes to be made.

**Add:** Click this button to specify the points as either Survey or Deed points. Then fill out the Edit Points dialog as desired.

**Remove:** This button will remove the highlighted/selected Survey and Deed points from the correlation setup. This does not delete the points from the coordinate file.

**Inverse Report:** This generates a report showing the inverse data from each point, both survey and deed, to every other point specified in the correlation set up. For example if there were four points in the survey points (1-4) then the report would show inverse data from 1 to 2, 3,4; from 2 to 1,3,4; from 3 to 1,2,4 and from 4 to 1,2,3. This would be the same for the corresponding deed points.

**Compare Before Align:** This option compares the survey information to the deed information.

**Check Align:** This option that allows for user specified hold and rotation points, and then reports the inverse data of each side of the tract/description. The hold point and rotation point must be points from the specified survey point group.

**Find Min Align:** Determines the hold and rotation points that would result in the minimum rotation to each side of the tract/description. When selected the Minimum Deed Rotation Report is displayed.

**Apply Alignment:** This option can be issued after the Min Align criteria is set.

**Save:** Performs a quick save if the file has previously been saved.

**Save As:** This option prompts for a user specified file name and allows for a user specified location to save the file. The file extension for the deed correlation file is dcf. When executing the program you have the option of using an existing file or creating a new file for the deed correlation.

**Exit:** This button end the routine.

**Help:** This button displays the help topics relating to the Deed Correlation routine.

After specifying the hold and rotation points, the deed correlation report will display again, showing the bearing and
distance of each side of the tract/description.
### Check Deed Rotation Report

**Hold Pivot Point**
- **Survey:** 6  **Deed:** 1

**Rotation Point**
- **Survey:** 7  **Deed:** 2

**Translate X:** -2.956  **Y:** -1.310

**Rotation:** 0° 03' 10"

<table>
<thead>
<tr>
<th>Survey Pt</th>
<th>Deed Pt</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>2</td>
<td>S 62°38'22&quot; W</td>
<td>3.009</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>S 78°33'32&quot; W</td>
<td>2.766</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>S 62°16'06&quot; W</td>
<td>2.134</td>
</tr>
<tr>
<td>10</td>
<td>5</td>
<td>S 71°43'06&quot; W</td>
<td>2.658</td>
</tr>
</tbody>
</table>

### Minimum Deed Rotation Report

**Hold Pivot Point**
- **Survey:** 10  **Deed:** 5

**Rotation Point**
- **Survey:** 7  **Deed:** 2

**Translate X:** 0.052  **Y:** -0.214

**Rotation:** 0° 02' 58"

<table>
<thead>
<tr>
<th>Survey Pt</th>
<th>Deed Pt</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>1</td>
<td>N 71°35'09&quot; E</td>
<td>2.693</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
<td>S 10°40'01&quot; W</td>
<td>0.567</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>N 31°02'38&quot; W</td>
<td>0.298</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>S 73°20'09&quot; E</td>
<td>0.675</td>
</tr>
</tbody>
</table>
Legal Description Writer

The Legal Description Writer gives you the ability to create a detailed legal description from an AutoCAD polyline. This description consists of calculated calls, point descriptions from Carlson points, and numerous user defined terms. The programs values for these terms are easily replaced, and are stored as defaults with each use.
Legal Description Writer Dialog
This initial and primary dialog box is shown above, and described below.

Pick Boundary Polyline: This button is used to designate the AutoCAD polyline boundary used. The boundary should be a closed polyline in AutoCAD. Tools are provided in the Edit menu if you need to reverse the polyline or change its origin point.

Pick Reference Lines: Used to select lines that tie into the polyline boundary used for the legal description. These should be LINE objects that have one endpoint exactly the same as the beginning point of the boundary polyline. If a Carlson point exists at the end of the line away from the boundary, the routine will pick up its description, otherwise you will be prompted for the description. You can choose any number of reference lines, simply press enter to conclude the selection of reference lines.

Header File: This button and edit field are used to designate the optional header text file. If a valid file is selected it will be written into the top of the output.

Footer File: This button and edit field are used to designate the optional footer text file. If a file is selected it will be written at the end of the output.

Output Options allows you to select where Legal Description Writer should send the output.

Report Viewer: The output is sent to the report viewer specified under Configure Carlson->General settings: Carlson Standard Report Viewer, Windows Notepad or Microsoft Word.
Text File: The output is sent to an external text file as designated in the output file section described below.

Mtext Object: This creates a mtext object in the current drawing. Upon choosing OK you will be prompted for a starting point (which is the upper left corner) and well as a second point that determines the width and angle. By default ortho is turned on for this second point. Press the F8 key to toggle its status.

Output File: This button and edit field are used to designate the necessary output text file. This file can then be brought into your word processor and finalized. Note that the appearance of the output file can be affected by the status of the 'Use Paragraph Format' toggle in the Legal Description's General settings.

Bearing Specifications
This section is used to establish the appearance of the bearings that are output with the description, and allows detailed control over each aspect.
**Bearing Format**: Designate the character or word used in each bearing direction. Standard values are the letters N, S, E, or W. One possible option is the entire words NORTH, SOUTH, EAST, and WEST. It is important to keep in mind that spaces are literal, meaning that if you don't have a literal space after N/S, and before E/W, a space will not be formatted into the bearing. To use Azimuth, place a check in the Use Azimuth box and the General Prefix will be set to AZ.

**1-Words Quads**: For example bearings that are due NORTH, the default is to generate N 00° 00' 00" E. If the 1-Word Quads toggle is turned on, the program will substitute the single word (which you can change) for the direction, these usually being NORTH, or DUE NORTH.

**Symbols**: This section allows you to designate the precision for bearings, as well as the symbols used. Turn on/off the toggles for degrees, minutes, and seconds to control the precision. For example, if you wish to round to the nearest minute, simply clear the toggle from the second field. For each field (degrees, minutes, seconds), you can supply the character or word to be used. You can quickly fill in these fields with the two buttons to the right.

**Line Segment Specifications**
This section is used to establish the terms used when the course of a call is a line segment, as is often the case. Simply supply the beginning and ending terms for these line calls.

![Line Segment Specs](image)

**Curve Segment Specifications**
This large dialog is used to establish the terms and options used when creating the course of a curve. Basic options include beginning and ending terms, as well as the words for left and right if chosen. In the large table of curve options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. In the example below, the program would output the curve direction, arc length, radius length, chord bearing, and chord length, radius length, chord bearing, and chord length, and in that order. Each field can also have a unique prefix/suffix. There are four different possible phrases for the start of the curve description for whether the curve is tangential, non-tangential, compound or reverse. The Radial In/Out for Non-tangent Only option applies to the Radial In/Out fields and tell the program to only use these fields when the curve is non-tangent. Otherwise, these fields are always used when the Radial In/Out fields are in the sequence.
Distance Specifications

This subdialog is used to establish the terms and precision used when creating a distance for the course of a call. The precision and suffix apply to curves as well. Simply choose the desired distance precision from the popdown, and supply the beginning and ending terms for the line calls.

Note the availability of dual distance reporting. If you would like to report dual distances such as feet/metric, turn on the toggle in the lower left corner of the dialog. Note that the primary units are the units set in the Settings menu, Drawing Setup. If you have English set as your units in Drawing Setup, then the alternate units will be metric. The opposite also applies. If your units in Drawing Setup is set to metric, then the alternate units will be English.
Description Specifications
In the process of following the polyline definition for a boundary, the legal description writer can look for descriptions of the points at the endpoints of the polyline. These can be extracted by setting the data source to the corresponding point from the coordinate (.CRD) file, meaning the points do not have to be plotted on the screen. A second option is point block, in which the program will read the information from the drawing, and not require the presence of a coordinate (.CRD) file.

Prefix: General term applied before the actual description.
Suffix: General term applied after the actual description.
Unknown: The text designated here will be placed in the description if the program does not find a valid description at that coordinate location. The words ‘Unknown Point’ may be used.

General Specifications
This dialog controls general specifications which can affect the entire description. Each group of items are explained in detail below.
**Body of Description**: Enter the beginning and ending terms for the description.

**String Case**: Choose the button corresponding to the string case conversion desired. If you want no changes made, choose none. Choosing upper, lower, or proper case conversion will affect the case of all text throughout the description, except bearing letters.

**Spell Out Numbers**: This option writes numbers as words instead of digits. For example, a distance of 123 would be written as one hundred twenty three.

**Append Lines Output Format**: If this toggle is on, the program will output the description without carriage returns after each line. This approach makes a nice paragraph style when brought into a word processor with word wrap. If the toggle is cleared, the program will place carriage returns at the end of each call.

**Area**

The legal description writer can output several types of areas. Basic options include beginning and ending terms. In the large table of area options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. You can edit the prefix/suffix for each and control decimal precision of each field output.

**Reset**: This option will reset all settings to their original default values.

**Save**: This option saves the legal description settings to a file. The file will be saved with an extension of (LGL).

**Load**: This option loads previously saved legal description (*.LGL) files.

**Pulldown Menu Location**: Survey

**Keyboard Command**: legal

**Prerequisite**: Polyline or line boundary
Closure by Point Numbers

This command allows for traverse entry by point numbers, reports the closure and supports traverse adjustments. Using an existing coordinate file, the traverse is defined by a series of point numbers. The angle and distance for each traverse segment is calculated using the coordinates of the points. The traverse can be processed using all adjustment routines. Refer to the Edit-Process Raw Data File command for more detail on adjustment procedures. After selecting Closure By Point Numbers from the Survey menu, the Closure By Point Numbers dialog will appear.

In this dialog shown above, add the point numbers that make up the traverse. This can be done by entering the point number, a range of points, or a point group into the Point Number(s) field. You can also choose points from a list.
by clicking the List button. Once each point, or group of points, is entered, click the Add button. Continue in this fashion until all of the point numbers are entered in. Clicking the Process button will display the Choose Process Method dialog. Choose the desired process method.

After selecting the process method for any of the adjustment methods, the dialogs and prompts will follow. They all start out with an "options" dialog box. These dialogs are titled either Process Options or Closure Options, depending on which process method you chose. The prompts that follow for any of the methods are subset of, and are very similar to, the prompting found in the *Edit-Process Raw Data File* command. After you have made your selections within these dialog boxes, click OK.

When you choose No Adjust of Angle Balance
When you choose Transit, Compass or Crandall

Each of the process methods will display a report that details the closure before the adjustment, and after the adjustment. Options to save and print this report are available. After a review of the report, pressing Exit will remove the report from the screen. At this point a Process Results dialog, prompting whether to Update points in CRD file with adjusted coordinates, will appear. If you choose Yes, the active coordinate (.CRD) file will be updated with the adjusted coordinates. Choosing No will leave the active coordinate (.CRD) file in its existing state, with the coordinates unchanged. It is important to remember that the starting and ending point in this routine must be a different point number. For example, if the traverse starts at point 1 and ends at point 1, then another point number should be used for the tie in shot to point 1. This logic is different in Edit-Process Raw Data File, where the starting and ending point can be the same point number.

Map Check by Pnts

This command allows you to check the closure of a figure and produce a report. The points used for the map check should already be stored in a coordinate (.CRD) file, by using commands such as Traverse, Locate by Bearing, Curves menu, Locate by Angle – or perhaps a file from an electronic data collector.

Prompts

Table Description: Description
Beginning Point Number: 903
PointNo. Northing(Y) Easting(X) Elev(Z) Description
903 4940.73 2490.40 0.00
eXit/Curve/\(<point number>:\ 904

PointNo. Northing(Y) Easting(X) Elev(Z) Description
904 4850.89 2388.01 0.00
BEARING > S 48d43'58'' W Hz DIST > 136.21
eXit/Curve/\(<point number>:\ 905

PointNo. Northing(Y) Easting(X) Elev(Z) Description
905 4699.39 2423.32 0.00
BEARING > S 13d07'04'' E Hz DIST > 155.56
eXit/Curve/\(<point number>:\ 906

PointNo. Northing(Y) Easting(X) Elev(Z) Description
906 4653.59 2582.19 0.00
BEARING > S 73d55'04'' E Hz DIST > 165.34
eXit/Curve/\(<point number>:\ 910

PointNo. Northing(Y) Easting(X) Elev(Z) Description
910 4941.88 2492.50 0.00
BEARING > N 17d16'54'' W Hz DIST > 301.93
eXit/Curve/\(<point number>:\ X

Closure error distance > 2.39476609 Error Bearing > N 61°10'45'' E
Closure Precision > 1 in 316.96 Total Distance Traversed > 759.04
SQ. METERS: 30403.0 SQ. KILOMETERS: 0.03
HECTARES: 3.04 CUERDAS: 7.74 PERIMETER: 759.04

Pick area label centering point: pick point on screen for label text
Erase Polyline Yes/No <Yes>: N

Typical Map Check Report:

\begin{verbatim}
Map Check Description
04/19/2006 13:14
\end{verbatim}

\begin{verbatim}
COURSE BEARING DISTANCE PT# NORTHING EASTING DESCRIPTION
903-904 S 48°43'58'' W 136.21 904 4850.89 2388.01
904-905 S 13°07'04'' E 155.56 905 4699.39 2423.32
905-906 S 73°55'04'' E 165.34 906 4653.59 2582.19
906-910 N 17°16'54'' W 301.93 910 4941.88 2492.50
\end{verbatim}

Closure error distance > 2.39476609 Error Bearing > N 61°10'45'' E
Closure Precision > 1 in 316.96 Total Distance Traversed > 759.04
327253.1 SQ. FT.
7.51 ACRES
Map Check by Screen Entities

This command allows you to check the closure of a figure, and produce a report from the Distance and Bearing labels in the drawing. The *Deed Reader* command is used here also, for extracting the deed line and curve data from the text of the deed. The deed data can then optionally be saved to deed file.
Prompts

Select linework to process: select the figure
Select sample text: select a label
Cut Sheet

This command creates a report of the elevation difference between points and a design elevation which can be defined by a grid file, triangulation file, 3D polyline, section file, note file, road template file, runway airway clearance or design points. The station and offset of the points can also be reported, if a centerline is specified.

Note the Report Formatter option in the dialog box below. This option can be used to customize the report layout, and to output the report data to Microsoft® Excel or Microsoft® Access. The standard report can be formatted to allow for the Cut/Fill difference to be reported in Feet-Inches, and for user specified decimal place setting for X/Y and Z values. These options are available from the main Cut Sheet Report dialog box shown here.

The **Points** option reports the horizontal distance and cut/fill between two points. The points to compare can be in the same coordinate (.CRD) file or separate files. The Output Options for the cut sheet report include **Bearing-Distance** which reports the bearing and distance difference, if any, between the points selected. The **DeltaX-DeltaY** reports and labels positional difference of the reference and selected points in x, y values. The same can be said of the **North-South-East-West** option. This option will report the positional difference of reference and selected points to compare but will label the differences as either North-South-East-West. With the None option selected only cut/fill values will be reported. If the Report Coordinates option is checked, the coordinate values of the points will be shown on the cut sheet report.
When comparing points in the same file, the Points to Compare dialog appears as shown below. The goal in this dialog is to establish in the upper window all the point pairings that you wish to compare for the cutsheet.

The selection of the points to compare is accomplished in 4 ways:

1) By manually specifying what points are to be compared by picking the survey and design points and then pressing the add button to add them to the selected points field at the top of the dialog. This allows for the assigning of multiple design points to the same survey point if needed. With this method each pair is selected and added individually to the list.

2) By specifying a range of survey and design points to be compared. This is accomplished by entering in the range of points in the Survey Range of Points field and the Design Range of Points field and then pressing add. With this option the points will be compared sequentially for each range. For example, if points 2000-2004 made up the
survey range, and points 2001-2005 made up the design range, point 2000 will be compared with point 2001 and so on.

3) By point group. This option will compare the points of the defined survey group with that of the defined design group. The points will be compared sequentially in the same manner as comparing ranges of points described in item 2 above. Once the groups are specified, press the add button to verify the selection of the groups. If points in the coordinate file have been categorized by groups to define surveyed and design surfaces, this option makes it very quick to calculate cut and fill data.

4) By matching points that are within a distance tolerance from each other, using Match by Tolerance. This option can be a time-saver, particularly when office personnel are not familiar with the pairings to analyze. When comparing points, there is an option to flag points in the report that exceed the specified distance tolerance.

The pairs, ranges or group of points to compare can be saved for later recall and further cut/fill analysis by selecting the Save button. The file to be saved will have a prf extension. To recall a comparison set of points for a cut sheet report press the Load button and specify the desired *.prf file.

For the separate file option, the point numbers are used to match points between the files. If point numbers are missing in the comparison (e.g. points 1 to 3 in the current coordinate (.CRD) file are being compared to points 1 and 3 in the design coordinate (.CRD) file), then there is an option for reporting the missing points, as seen in the Compare Points dialog.
When using a **3D Polyline** for the grade elevation, the program calculates the elevation along the 3D polyline at the position perpendicular from the point selected. This calculated elevation is then compared to the point(s) selected to determine the cut/fill values. For **Grid** and **Triangulation** surface files, the design elevation is determined by the elevation of the surface file at the point selected. With **Section Files**, the grade elevation is interpolated from the offset-elevation data in the section file based on the station-offset of the point along the centerline. When using this method, a centerline file (*.cl) must be specified for station-offset data.

The **Note File** option reads the grade elevation from the note (.NOT) file that is associated with the current coordinate file. For example, if the current coordinate (.CRD) file is job3.crd then the note file name is job3.not. In Carlson Software’s data collection programs (SurvCE and Field), there is an option to store stakeout data to the note file under the Stakeout options. When storing a point in the stakeout routines (using SurvCE or Field), the target point number, coordinates and elevation can be stored to the note file. This results with the as-staked coordinate stored in the coordinate (.CRD) file and the target coordinate stored in the associated note file. The Cut Sheet report can display this stakeout data using the Stakeout Point Comparison report option. The horizontal difference between the staked point and the target point can be reported in Bearing-Distance, Delta X-Y or North-South-East-West format. Also, in SurvCE and Field, the elevation difference routines can record the design grade elevation and station-offset to the note file when a point is stored to the coordinate (.CRD) file. This grade data can be reported using the Grade Elevation Report option. The note file records that the Cut Sheet report uses are TARGET_X, TARGET_Y, TARGET_Z, TARGET_DESC, TARGET_PT, STATION, OFFSET, VOFF1 and VOFF2.

The **Runway Clearance** option defines the target surface as the airway clearance around a runway. This method is for clearance reports for tree and building tops by comparing points to this runway clearance surface. The runway surface is built from a 3D perimeter polyline of the runway along with slopes for the approach lanes and runway sides. The runway sides are offset level from the runway perimeter for the specified distances before starting the slopes. The parameters for the runway are defined in the dialog and illustrated in the graphic shown here. The Write Runway Clearance Surface File creates a triangulation surface file that you can draw or inspect for verification of a correct target surface.
The **Template Design** option defines the grade elevation using road design files. For each point, the program finds the station-offset for the point along the centerline and then applies the road design at that station to determine the grade elevation. **Grade to Process** is used to define the surface to use for the cut sheet comparison. These grades are defined as Top Surface, usually final grade, or subgrades and correspond to the defined grades and subgrades within a template file. The required design files include a centerline (.CL) file, a template (.TPL) file, and a profile (.PRO) file. There are also several optional design files such as Superelevation, Template Point Profile and Template Point Centerline. The design files are created in the Civil Design module. Using the design files in *Cut Sheet* is similar to the *Process Road Design* command.

![Cut Sheet Template](image)

This leads to the following report:

---

**Chapter 11. Survey Menu** 647
If the **Station-Offset** method is selected as an Input Method, then only the final grade elevations are produced in the report. This is useful for writing final grades on the stakes prior to taking field shots. You are first prompted for the desired offset and starting station, as shown in the Station Offset dialog. Specify left offsets with the negative sign (-).

![Station-Offset dialog](image)

After filling out the Station-Offset dialog with the desired information, selecting the OK button will result in the following report showing only the final grade elevations of the specified station-offsets.
Examples of Cut Sheet reports comparing points are shown next.

Example 1: Cut Sheet Report comparing points from the Current Coordinate File and with the Use Feet-Inches For Cut/Fill options on.
Example 2: Cut Sheet Report comparing points from Another Coordinate file, reporting coordinates for the points. Example 3: Steps for Comparing Points in Current Coordinate file and using Report Formatter Option to customize report output to user preference.

2) Specify points to compare by one of the four methods described above for comparing points within the current coordinate file.
3) Select report content by highlighting the desired data from the Available list on the left side of the dialog box and then pressing the Add button to place the selected data in the Used list. Standard window selection methods using the Ctrl and Shift keys can be used to select more than one item at a time. After moving the selected data to the Used window it may be necessary to move data up or down to obtain the desired order of your report. To do this use the up and down arrows located on the left of the Used window.
4) When the desired data has been specified in the Used window press the Display button at the bottom left of the dialog. For more detailed information on using the report formatter see the Report Formatter section of this manual.

Pulldown Menu Location: Survey
Keyboard Command: cutrprt
Prerequisite: A coordinate (.CRD) file
File Name: \lsp\cutrprt.lsp

Set Point Elevations by Surface Model

This command assigns elevations to points by surface model.

Prompts

Choose Grid or Tmesh file to process dialog choose existing GRD, TIN or FLT file
Select points from screen, group or by point number [ <Screen>/Group/Number]? press Enter
Select points to elevate.
Select objects: select points

Keyboard Command: 3dpts_tin
Prerequisite: A surface model
File Name: \lsp\lsp

Set Point Elevations by 3D Polylines

This command assigns elevations to points by referencing 3D polylines.

Prompts
Maximum Offset Tolerance <1.0>: press Enter
Percent slope from reference polyline <0.0>: .2
Vertical Offset <0.0>: 5
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select points to elevate. select point

Keyboard Command: 3dpts_3dp
Prerequisite: 3D polylines
File Name: \lsp\n
Polyline Report
This command generates a report of bearing-distance and curve data for all the point along the selected polyline. The closure is reported between the starting and ending points of the polyline. The polyline area is also reported. After executing the command, by pressing O for options various report options can be selected.

Prompts
Starting station <0.0>: press Enter
Options/Select polyline to report: pick a polyline
Standard Report Viewer Displays the report for the selected polyline.
Options/Select polyline to report (Enter to End): press Enter
Polyline to RW5 File

This command generates a raw data (.RW5) file for the selected polyline. This file can be opened using *Edit Process Raw Data File*, which allows you to process the raw data (.RW5) file to generate coordinate points, calculate closure and perform coordinate adjustments by the compass, crandall, transit and least squares adjustment routines.

**Prompts**

- **RW5 File to Write (Standard Windows File Selection Dialog):** *choose file location and name*
- **Select Polyline To Process:** *select polyline*
- **Done.**

4 Sided Building

Often only two sides of a building are surveyed in the field. This routine completes the building by drawing the other two sides. *4 Sided Building* creates a parallelogram given two connecting lines, or given a polyline with two segments. With two lines, there is an option to make the parallelogram as a polyline or as four lines.

**Prompts**
Options/<Pick a line or polyline>: pick a line
Pick another side (Enter for none): pick a line
Convert the lines into a polyline [<Yes>/No]? press Enter
Options/<Pick a line or polyline>: press Enter
Entering O for options lets you choose whether or not to be prompted to set the new polyline width.

Pulldown Menu Location: Survey
Keyboard Command: 4sided
Prerequisite: A polyline with two segments or two adjoining lines
File Name: \lsp\poly3d.exp
This chapter provides information on using the commands from the COGO menu to perform coordinate geometry operations in your drawing. The top section provides basic COGO routines, with optional quick keys. The bottom section provides numerous survey functions, including the easy-to-use Visual COGO and also Numeric Pad COGO.
**Draw-Locate Points**

This command is described in the Points chapter of this manual. Go there for full details. Within Carlson Software, this important command is located in both the COGO menu and the Points menu, near or at the top.

**Inverse**

This command reports the bearing/azimuth and horizontal distance between two points. The command prompts for a series of points. Use the appropriate object snap mode to select the points from the screen, or use the point numbers to reference coordinates stored in the current coordinate (.CRD) file. The results are then displayed. This command is also used in conjunction with the Traverse and Sideshot commands to occupy and backsight two points. The last two points you Inverse to are the Backsight and the Occupied point for the Traverse and Sideshot commands. An attractive feature of Inverse is that you can enter T or SS within the command and go directly to Traverse or Sideshot. Even a single S will transmit to Sideshot. Hotkeys are not case sensitive. Press [Enter] at the point prompt to end the command.

You can also inverse around an arc by inversing to the PC, and then entering an A for Arc option. The program will ask for the radius point, the curve direction left or right and the PT point. The curve data is then reported. There is an unequal PC-Radius and PT-Radius distance check. The tolerance for this is set in the Area Label Defaults command.

There are several input options for Inverse that are set by entering O for Options on the command line. Sideshot inverse holds the current occupied point and calculates the bearing/distance to each entered point. The Pairs option reports the bearing/distance between pairs of points and not for every entered point. For example, if points 1,2,11,12 were entered, the bearing/distance would be reported for 1,2 and 11,12 but not 2,11. The Auto Increment option uses the next point number by just pressing Enter. To exit the routine with Auto Increment active, End must be entered.

There are also several angle output options that are set at the second prompt in Options. The angle can be reported as either Bearing, Azimuth, Gon or Angle Right. You can also specify to report angles with decimal seconds. There's a setting for the number of decimals for distances and a setting to report distances in feet and inches format. The Report Elevation Difference option will report the delta Z between the pairs of points. The Report Second Scaled Distance option will report a second distance value that is scaled from the first distance value using the scale factor defined in Drawing Setup. When the Second Scaled Distance option is on, there are settings for the suffix to use for both the first and second distance to help identify them separately in the report.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter.

**Prompts**

**Calculate Bearing & Distance from starting point?**

Traverse/SideShot/Options/Arc/Pick point or point number: pick a point

Traverse/SideShot/Options/Arc/Pick point or point number: 9

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>Northing (Y)</th>
<th>Easting (X)</th>
<th>Elev (Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>4909.25</td>
<td>4648.37</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Bearing: N 81d8'54" E Azimuth: 81d8'54"
Horizontal Distance: 261.17407461

Chapter 12. COGO Menu 656
Pulldown Menu Location: COGO
Keyboard Commands: inverse, i
Prerequisite: None
File Name: \lsp\brgdist.lsp

Occupied Point

This command sets the occupied point and backsight angle for other COGO commands such as Traverse. For setting the occupied point, you have the option of picking a point on the screen, entering coordinates at the command line or typing in a point number that will be read from the current coordinate (.CRD) file. Four options are available for determining the backsight direction: Azimuth, Bearing, None and Point. For the default Point option, you may pick a point on the screen, input coordinates, or type a point number that will be read from the current coordinate file. For the Azimuth and Bearing option, you enter the backsight angle in the selected format. The None option sets the backsight to an azimuth of 0 (zero) or North. You can also set the occupied point by using the Inverse command. If you inverse from point 3 to point 1, you have set point 1 as the occupied point and point 3 as the backsight. For more information, see the Inverse command.

The current occupied point and backsight are shown in the lower right hand corner of the AutoCAD status bar just below the command line.

Prompts

Set Occupied Point
Pick point or point number: pick a point (5000 5000 0.0)
Set backsight method [Azimuth/Bearing/None/<Point>]? press Enter
Set Backsight Point
Pick point or point number: pick a point (5184.76 5381.3 0.0)

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: occpoint, op
Prerequisite: None
File Name: \lsp\occupypt.lsp

Traverse

This command allows the user to input any combination of turned angles, azimuths or bearings to define a traverse or figure. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. This command always occupies the last point it calculated and backsights the point before that.

Codes 1 through 4 define the bearing quadrants:
1 = Northeast
2 = Southeast
3 = Southwest
4 = Northwest

The remaining codes define as follows:
5 = a north based azimuth
6 = an angle turned to the left
7 = an angle turned to the right
8 = a deflection angle left
9 = a deflection angle right

For both the Angle-Bearing Code and the Distance prompt, the user can enter point-defined responses: two points separated by an asterisk, as in 2*3 for the bearing (or distance) defined by 2 to 3. You can also add math expressions. For angles, 2*3+90 would deflect 90 degrees right from 2 to 3. For distance, 2*3/2 would mean half the distance of 2 to 3. You do not need to enter N before entering a number-defined distance. Just bring up the number inverse prompt.

The command draws lines between located points (if the Line On/Off in the COGO menu is set to on) and plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. The point settings are defined in the Point Defaults command. If Point Protect is turned on, Traverse checks if the point numbers are already stored in the file. Point Protect is set in the Coordinate File Utilities command.

There are Angle-Bearing code input options for Traverse that are set by entering O for Options. The Angle Right option prompts for the angle right and skips the angle-bearing code prompt. The Azimuth option prompts for the azimuth and skips the angle-bearing code prompt.

Prompts

Occupied Point ?
Pick point or point number: pick a point
You will only be prompted for the occupied point the first time you use the command.
Use the Inverse command to set the occupied and backsight points.
Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <>: o
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? p

**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code** <5>: press Enter Pressing Enter uses the default angle right code.

**Enter Angle (dd.mmss)** <90.0000>: 88.1324 You can also enter L or R to define an angle 90 degrees Left or Right.

**Backsight Point ?**

**Pick point or point number**: pick a point

**Number inverse/</Distance>:** 100

![Diagram of bearings and azimuths]

**Select Coordinate (.CRD) File** This dialog only appears if there is not a current coordinate (.CRD) file.

**Exit/Options/Line/Side Shot/Inverse/Angle-Bearing Code** <7>: 14*9-45.2045 Uses the bearing defined by point numbers 14 & 9 and subtracts the angle 45 degrees, 20 minutes, and 45 seconds. You can use a + or - in this type of entry.

**Number inverse/</Distance>:** N (note: you can enter 14*9/2 here, as well)

**Point number inverse (i.e. 10*20):** 14*9/2 This causes the command to recall the distance from point number 14 to 9 and divide it by 2.

**Exit/Options/Line/Side Shot/Inverse/Angle-Bearing Code** <7>: L

**Select Line or Polyline that defines Bearing**: select line that defines bearing

**Number inverse/</Distance>:** 100

**Exit/Options/Line/Side Shot/Inverse/Angle-Bearing Code** <7>: E Enter E to end the command. Enter S or SS to execute the Side Shots command or I to execute the Inverse command.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

**Pulldown Menu Location**: COGO

**Keyboard Commands**: T, Traverse

**Prerequisite**: None

**File Name**: \lsp\trav.lsp

**Side Shots**

This command allows the user to input any combination of turned angles, azimuths or bearings while remaining on an occupied point. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. Codes 1 through 4 define the bearing quadrants; 1 being North-East, 2 South-East, 3 South-West, and 4 North-West. Code 5 is a north-based azimuth, 6 an angle turned to the left, 7 an angled turned to the right, 8 a deflection angle left and 9 a deflection angle right. The command plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. If Point Protect is turned On, Side Shots checks if the point numbers are already
stored in the file. All points calculated radiate from the occupied point. Use the Traverse, Inverse, or Occupied Point commands explained previously to define the occupied and backsight points. Options allows you to select your angle entry method.

Prompts

Occupied Point ?
Pick point or point number: screen pick a point or enter a point number
Exit/Options/Traverse/Inverse/<Enter Azimuth (ddd.mmmss) <A>: O for options
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P for prompt
Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <7>: 6 Code 6 for angle turned to left.
Pick point or point number: pick a point
Enter Angle (ddd.mmmss) <6>: 22.3524 Angle of 22 degrees, 35 minutes, 24 seconds.
Points/<Distance>: 120.91
Enter Vertical Angle (ddd.mmmss) <0.0000>: 88.2548

These prompts only come up if you have Instrument and Rod height prompting turned on.
Instrument Height <5.000>: 5.12
Rod-Target Height <5.120>: press Enter
Enter Point Description <>: Topo Shot
Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <6> E

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: sideshot, ss
Prerequisite: None
File Name: \lsp\sideshot.lsp

Enter-Assign Point

This command creates a point at the user-entered coordinates. The point is both stored to the current coordinate (.CRD) file and drawn on the screen. The program will prompt for the northing and easting. This routine will prompt for point number, elevation and description, depending on the settings in the Point Defaults command. Point Defaults also allows you to set the point symbol and layer. Point Defaults is found under the Points pulldown.

Prompts

Enter North(y): 5000
Enter East(x): 5000
Select/<Enter Point Elevation <0.00>: Enter 100 for elevation, or press S and enter to select text to set elevation.
Enter Point Description <>: START
N: 5000.00 E: 5000.00 Z: 0.00
Enter North(y): press Enter to end

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.
Raw File On/Off

This menu selection toggles raw file (.RW5) creation. When this option is active, commands such as *Traverse* create entries in the current raw data (.RW5) file. If Raw File is turned on, the pulldown menu option will have a check mark character in the menu. A dialog will appear, allowing you to create a New, Append an existing, or Close the .RW5 file.

To begin this routine, select the COGO pulldown and observe the Raw File (On or Off) toggle for check. Click the command and the dialog appears.

- **New**: Allows you to create a new raw traverse file (.RW5).
- **Append**: Allows you to append an existing raw traverse file.

Pulldown Menu Location: COGO
Keyboard Commands: openraw
Prerequisite: None
File Name: \lsp\openraw.lsp

Line On/Off

This menu selection toggles line plotting on and off for the commands such as *Traverse*, *Locate by Line Bearing*, etc.. If line drawing is turned on, the pulldown menu option will have a check mark character to the left of the command.

- **Command**: set_lonoff
  Line ON
- **Command**: set_lonoff
  Line OFF
Pulldown Menu Location: COGO
Keyboard Command: set_lonoff
Prerequisite: None
File Name: \lsp\surv1.lsp

Visual COGO

Function

This command contains COGO routines for Inverse, Occupy Point, Traverse, Side Shots and Enter-Assign Point. Choosing Visual COGO from the COGO menu provides you with quick access to any one of five main features of the Visual COGO interface.

A dialog for command input docks on the side of the graphic window when any of the five options from the pulldown menu are selected. Points are drawn to the screen as they are created. Linework can also be drawn. AutoCAD and Carlson commands can be activated with the Visual COGO dialog active. This allows for quick switching between Visual COGO commands and any other command.
Prompts

When in Visual COGO, you will have a very different user interface from other areas of Carlson. This user-friendly screen will guide you through various COGO data entry procedures such as Inverse, Occupy Point, Traverse, Side Shots and Enter-Assign Point. You will still be able to follow the command on the command line at the bottom of your Carlson screen. Using Visual COGO is an alternative and easy method to entering in such information. The top half of the COGO pulldown menu offers you the more traditional Carlson data entry method. Your results will be the same.

**IN (Inverse):** This command reports the bearing/azimuth and horizontal distance between two points. The points can be entered manually or by picking from a point list by picking on the list button. The resulting report of bearing/azimuth is dependent upon the Angle Mode setting in the drawing setup options.

**OC (Occupy Point):** Used to specify the point number of the instrument setup point. The point can be specified by manually entering in the point number in the Occupied Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

Backsight Method can be either by Point Number or by Azimuth. If angle right/left or deflection right/left is being used for traverse or sideshot entry, a backsight method must be specified. If using Bearing or Azimuth entry, no backsight method is required. The Backsight Point can be specified by manually entering in the point number in the Backsight Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

**Instrument Height:** Use this field to set the height of the instrument.

**Accept (F2):** Selecting this button or pressing the F2 function key accepts the data entered in the fields above. After accepting the data, until changed, the points specified will remain the occupied and backsight points. If the dialog is exited without Accepting the settings the Occupied and Backsight points will have to be specified when the OC dialog is revisited.

**Exit:** Cancels the command

**TR (Traverse):** This command allows data entry using any combination of turned angles, deflections, azimuths or bearings to define a traverse or figure. This command always occupies, moves up to, the last point it calculated and backsights the point before, or the previous occupied point.

**Point Number:** This is the number of the point to be created.

**Rod Height:** Height of target to be located.

The horizontal angle component can be input in various formats. The format label will change with the option chosen. Choose the format by selecting the down arrow and picking from the list.

- NE=Northeast
- SE=Southeast
- SW=Southwest
- NW=Northwest
- AZ=Azimuth
- AL=Angle Left
- AR=Angle Right
- DL=Deflection Left
- DR=Deflection Right

The vertical angle component can be input in various ways (the format label will change with the option chosen).
Choose the format by selecting the down arrow and picking from the list.

VA=Vertical Angle. Zero (0) degrees is level.
ZE=Zenith Angle. Ninety (90) degrees is level.
DZ=Elevation Difference. The difference in elevation either plus or minus from the instrument setup to the target.

The distance component can be entered as either Slope or Horizontal Distance. Choose the format by selecting the down arrow and picking from the list.

SD=Slope Distance
HD=Horizontal Distance

Distance can be defined by Point Numbers by selecting the calculator button to the far right of Angle Right and Slope Distance.

Additional mathematical calculations of addition, subtraction, multiplication and division can be performed on the input distance by selecting the appropriate button and filling out the function dialog.

For example to add 25 to the Slope distance value on the traverse dialog, select the + button, enter 25 and then select Done. The same steps apply to any of the other mathematical functions.

**Side Shots:** This command works in the same way as the traverse command. All the available options contained in the traverse command are available in this command. The only difference in the commands is that the side shot command does not move the setup point to last shot input. Refer to the traverse command for further details.
Desc: Defines the description for the point to be created.

**Draw Line**: Option to draw line to the traverse point.

**Preview (F2)**: Previews the traverse point location, without storing the point to the coordinate file.

**Store (F2)**: Stores the traverse point based upon the entered data to the coordinate file.

**Undo**: After storing the point, the point can be deleted from the screen and coordinate file by selecting the undo button.

**Exit**: Exits the Visual COGO command and closes the dialog box.

**EA (Enter Assign)**: Use this function to enter and assign coordinate values for new and existing points.
Zooming and panning functions are also available from the Visual COGO dialog box:

**Plus (+) magnifier**: Zooms the display window in. Use to view an area up close.

**Minus (-) magnifier**: Zooms the display window out. This shows more of the drawing.

**Left arrow**: Pans the display window to the left.

**Right arrow**: Pans the display window to the right.

**Up arrow**: Pans the display window up.

**Down arrow**: Pans the display window down.

**Pull-down Menu Location**: COGO

**Keyboard Commands**: vcogo_inverse, vcogo_setup, vcogo_traverse, vcogo_sideshot, vcogo_store

**Prerequisite**: Coordinate file to process

**File Name**: \lsp\cogoutil.arx

### Locate by Line-Bearing

This command calculates and plots a line (if the Line On/Off is set to Line On) and point from an occupied point. The bearing can be defined by picking two points, selecting a line, inputting two point numbers, or typing in a bearing or azimuth. The command always occupies the last point calculated.

**Prompts**

Press [Enter] to use preview point/or select occupied point.

**Pick point or point number**: 14
Pick points that define bearing.
Define Bearing by, Line/Bearing/Numbers/<pick 1st point>: B

At this prompt the default is to pick the first point that defines the bearing. If you pick a point, you are then prompted for a second point. You can input B to type in a bearing or azimuth or L to select a line or polyline that defines the bearing, or N to input two point numbers that define the bearing.

[A]zimuth/<Bearing (Qdd.mmss)>: A
Azimuth (ddd.mmss): 45.2349
Number inverse/<Distance>: 188.27
Enter Vertical Angle (dd.mmss) <0.0000>: press Enter
The horizontal distance is given.
Enter Point Description <stk>: press Enter
The coordinates are given.

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Command: locbrg, lb
Prerequisite: None
File Name: \sc\lsp\locbrg.lsp

Locate by Turned Angle
This command locates a point by turned angle and distance.

Prompts

Define occupied & backsight points by [L]ine or [P]oints <P>: L
Select Line or Polyline near end point that defines occupied point: select line
Occupied point: (4078.44 4610.89 0.0)
Backsight point: (4390.31 4869.06 0.0)
Enter Angle (ddd.mmss) <45.2349>: 22.5632
Pick or Type Distance <188.27>: 40.32
Enter Vertical Angle (dd.mmss) <0.0000>: hit Enter

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Commands: turnang2, ta
Prerequisite: None
File Name: \lsp\turnang2.lsp

Locate by Azimuth
This command locates points by azimuth and distance. The AutoCAD text screen provides the horizontal distance and coordinates.

Prompts

[Enter] to use preview point/ or Select occupied point ?
Pick point/<point Number>: _endp of (pick a point)
Enter Azimuth (ddd.mmss) <22.5632>: 277.1259

Chapter 12. COGO Menu
Enter or pick Distance \(<40.32\>:= 104.39
Enter Vertical Angle (dd.mmss) \(<0.0000\>:= \text{Enter}

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Commands: loczi2, az
Prerequisite: None
File Name: \lsp\loczi2.lsp

**Locate by Bearing**

This command locates points by bearing and distance. Additionally, the AutoCAD text screen provides the horizontal distance and coordinates.

**Prompts**

[Enter] to use preview point or Select occupied point ?
Pick point/<point Number>: 24

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing(Y)</th>
<th>Easting(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>4922.37</td>
<td>4544.81</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Enter Bearing (Qdd.mmss) \(<277.1259\) := 435.2317
Enter or pick Distance \(<104.39\) := 200
Enter Vertical Angle (dd.mmss) \(<0.0000\) := \text{Enter}

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Command: locbrg2, lg
Prerequisite: None
File Name: \lsp\locbrg2.lsp

**Pick Intersection Points**

This command locates points at screen picked intersections. The AutoCAD object snap mode is set to intersection. This routine is similar to the Locate Point command, with an additional check that makes sure there is an intersection at the picked point. If there is not an intersection at the picked point, then no point is created.
Prompts

Pick Intersections Points dialog

**APParent intersection on [<Yes>/No]: Y**

This first prompt is very important. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline) that do not intersect in 3D space, but may appear to intersect in the current view. This allows you to locate a point at the theoretical intersection of two 3D entities. You should answer No to this prompt if you want to ignore theoretical 3D intersections.

**[app on] Pick intersection Point:** *pick a point*

**[app on] Pick intersection Point:** *press Enter to end*

**Pulldown Menu Location:** COGO > Locate at Intersect

**Keyboard Command:** pickint

**Prerequisite:** Intersection of two entities

**File Name:** \lsp\pickint.lsp

Linework Intersection Points

This command is used to create points at all of the intersections between selected linework entities.
Prompts

Select lines and polylines to process.
Select objects: Specify opposite corner: *pick objects*

Pull-down Menu Location: COGO > Locate at Intersect
Keyboard Command: ADDINTPTS
Prerequisite: None
File Name: \lsp\crdutil.arx

**Bearing-Bearing Intersect**

This command locates a point at the intersection of two lines. The lines can be defined by picking two points, selecting a line or typing in a bearing. After the lines are defined a point symbol is located at the point of intersection.

Prompts

[Enter] to use preview point or select 1st Base point ?
Options/<Pick point or point number>: *press Enter*
Define 1st angle by (Line/Points?Right/Azimuth/Bearing) <Bearing>: *L*
Select Line or Polyline that Defines 1st Bearing: *select*
Enter 1st Offset Distance <0.0>: *press Enter*
2nd Base point?
Pick point or point number: *pick a point*
Define 2nd angle by (Line/Points/Right/Azimuth/Bearing) <Line>: *P*
[Enter] to use preview point/or pick 1st point that defines 2nd bearing.
Pick point or Point number: pick point
2nd point that defines 2nd bearing?
Pick point or Point number: pick a point
Enter 2nd Offset Distance <0.0>: press Enter
Enter/<Select text of elevation>: select
The point is then located at the computed point of intersection.

Bearing-Distance Intersect

The Bearing-Distance Intersect command prompts the user for a base point from which the known bearing intersects. It then defines the bearing by one of three methods. The bearing can be defined by picking two points, selecting a line with the same bearing or by typing in the bearing in the form of Qdd.mmss (similar to the Locate by Bearing command). Next the user is prompted for a base point from which the known distance radiates. After entering the known distance a circle is drawn radiating from the selected base point, and a line defined by the bearing is extended to intersect the circle. The user then picks the correct point for the solution desired and a point symbol is located at the selected intersection. The command then erases the temporary circle and line. The Options choice allows you to be prompted for angle method or for offsets, or both.

Prompts

[Enter] to use preview point or select known Bearing base point
Options/Pick point or point number: pick point
Define 1st bearing by (Line/Points/Azimuth/Bearing)<.Bearing>: l
Select Line or Polyline that Defines Bearing: pick entity
Enter 1st Offset Distance <0.0>: press Enter
Known distance base point.
Pick point or point number: pick point
Points/<Enter Distance>: 40.41
Enter 2nd Offset Distance <0.0>: press Enter
[int on] Pick Intersection point ([Enter] to cancel): pick point
Enter Point Number <55>: press Enter This prompt appears only if Automatic Point Numbering is turned off.
See Point Defaults
Enter Point Symbol Number <4>: press Enter This prompt appears only if point symbol prompting is turned on.
Symbol number 4 is located at the computed coordinate and labeled point number 55.

Pick correct solution

When Options (O) is selected

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: bdint
Prerequisite: None
File Name: \lsp\bdint.lsp

Distance-Distance Intersect

This command creates a point at the distance-distance intersection from two base points. The program prompts for two distances and two base points. The two possible intersections (A,B) are shown on the screen. You can either pick near the desired intersection or type in the letter A or B. The A intersection is clockwise from the first point. The Options choice brings up a small dialog that allows you to be prompted for angle method or for offsets, or both.

Prompts
Select 1st base point
Options/<Pick point or point number>: 1
Points/<1st distance>: 46.72
Enter 1st Offset Distance <0.0>
Select 2nd base point
Pick point or point number: 2
Points/<2nd distance>: 38.96
Enter 2nd Offset Distance <0.0>: press Enter
Pick near solution or Enter [A] or [B]: pick a point

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: DD
Prerequisite: None
File Name: \lsp\drint.lsp

2 Point - 2 Point Intersect
This command is similar to Bearing-Bearing Intersect except that in this command bearings are defined by specifying two point numbers. In the example shown below, the first two points specified are 3838 and 3839, the second pair are 3841 and 3840. Point 3842 is located at the intersection.

Prompts

Specify 1st base point.
Pick point or point number: 3838
Specify 2nd point that defines 1st direction.
Pick point or point number: 3839
Specify 2nd base point.
Pick point or point number: 3841
Specify 2nd point that defines 2nd direction.
Pick point or point number: 3840
Select/<Enter Point Elevation>: Enter value

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: bbint2
Prerequisite: None
File Name: \lsp\bbint2.lsp

Create Points from Entities

This command will create Carlson points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the Prompt for Elevations toggle and select the Locate on Real Z Axis toggle. After you have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the Description Settings, Prompt for Description At Each Point will prompt you at the command line for a description for each individual point. Prompt Per Entity will ask you for a description per each highlighted entity. Use Entity Layer for Description will assign the layer name to the description. When Entity Layer for Description is checked, the layer name of the entity will be used as the description for the created point. Same Description For All Points will prompt you for a single description for all points.

The second options dialog has processing settings. When Avoid Duplicates with Existing Pts is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file.
Routine begins with this dialog

Prompts

Create Points From Entities Dialogs Choose settings
Select arcs, circles, faces, points, text, lines and polylines.
Select objects: pick entities
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

**Pull-down Menu Location:** COGO  
**Keyboard Command:** autopnts  
**Prerequisite:** drawing entities  
**File Names:** \lsp\crdutil.arx, \lsp\autopnts.lsp

### Resection

This command calculates point coordinates given the angle and distance from two or three reference points. The Z coordinate can also be calculated in addition to the X,Y. If you only need the 2D solution, then enter the instrument and rod heights as 0.0, the zenith angle as 90 and the distance as the horizontal distance. The reference points are specified by point number. These reference points need to be stored in the current coordinate (.CRD) file before running this command.

After entering the reference point, there is a dialog to enter the horizontal angle, zenith angle and slope distance. The horizontal angle is the horizontal azimuth or angle right from the unknown point to the reference point. In the example, the backsight azimuth is 0 (due north), but this is not a requirement since the backsight can be any angle. The program calculates the coordinate by averaging the distance-distance and angle-angle solutions. Since there is redundant data, the final calculated coordinate will differ slightly from the individual measurements. For example, in a 3-point resection, there are two different distance-distance solutions (between the first-second point and between the second-third points). The program reports the difference between the final coordinate and the individual solutions as the residuals which act as an indicator whether the data is good. High residuals suggest a problem with the input data. In the dialog that displays the final coordinates and residuals, there is a button to store the coordinates to the current coordinate (.CRD) file with a specified point number.

In the first Resection dialog box, you can choose to use two or three reference points.
In the second Resection dialog box, you assign the reference point.

**Point**: You must enter the point number of your reference point. These reference points need to be stored in the current coordinate file before you run this command.

**Inst. Height**: You must enter the instrument height.

**Target Height**: You must enter the target height.

If you need only the 2D solution, then enter the instrument and target heights as 0.0.

In the Manual Read dialog box, you must specify parameters for the calculation.

**Horizontal Angle**: You must enter a horizontal angle from the resection to the reference points. The horizontal angle is the horizontal azimuth, or angle right, from the unknown point to the reference point.

**Zenith Angle**: You must enter a zenith angle. For a 2D solution, set the zenith angle to 90 degrees.

**Slope Distance**: You must enter a slope distance from the reference points to the resection.

You are prompted for additional reference points and parameters.

The Resection Calculation dialog box that displays the final coordinates and residuals. You can select the option to store the coordinates in the current coordinate file with a specified point number.
Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: cressection
Prerequisite: Two or three reference points
File Name: \lsp\cogoutil.arx

Benchmark

This command is similar to the data collector routine, where a measurement with a total station is taken from an unknown elevation to a known elevation foresight. The unknown elevation of the occupied point is then calculated based on the measurement. Either the Occupied Elevation or the Instrument Height can be calculated. Note that a check box is located at the bottom of the dialog box to "Store Elev To Occupied Pt". This will automatically change the elevation of the occupied point.
Prompts

Coordinate File to Process dialog If required, this dialog will appear and you must select a file.

Benchmark dialog Fill in variables, click Calculate

Pulldown Menu Location: COGO
Keyboard Command: benchmark
Prerequisite: None
File Names: \lsp\cogoutil.arx

**Numeric Pad COGO**

Using only the keys on the numeric pad, this command does several COGO commands. The program cycles through six prompts. Only respond to the prompts that apply and the program will perform the correct action. The prompts are: First point? First angle? First distance? Second point? Second angle? Second distance?

To **inverse**, give a first point and second point.

To **traverse**, give a first point, first angle and first distance.

To do **bearing-bearing intersect**, give a first point, first angle, second point and second angle.

To do **bearing-distance intersect**, give a first point, first angle, second point, and second distance. Or give a first point, first distance, second point, and second angle. The point is calculated at the closer intersection.

To do **distance-distance intersect**, give a first point, first distance, second point, and second distance. The point is calculated at the first intersection going clockwise from the first point's distance circle.

Points can be screen picked or entered as point numbers that reference the current coordinate file. The last point is used as a default when you press Enter at the prompt for the first point. Which point is being used is indicated by a ghost arrow pointer.

Angles can be specified by picking two points or entering an angle code which begins with a single digit code followed by the degrees and the minutes and seconds after a decimal point. The digits codes are (1 - Northeast, 2 - Southeast, 3 - Southwest, 4 - Northwest, 5 - Azimuth). For example, Northwest 50d10'2'' would be 450.102.

Distances can be specified by picking two points or entering the distance value.

**Prompts**

Enter coords/Quit/\<Pick 1st point or point number\>: 5
Pick or Type 1st Direction by 2 Points: 145.0135 (Northeast 45d1’35’’)
Pick or Type 1st Distance by 2 Points: 50.0
A point is created from the values for this traverse. The prompts for the second point don't appear because all the information for this action is entered.

Enter coords/Quit/\<Pick 1st point or point number\>: press Enter to use the point created by the traverse.

Pick or Type 1st Direction by 2 Points: 50.0
Enter coords/Quit/\<Pick 1st point or point number\>: 4
Enter/Pick 2nd Direction by 2 Points: press Enter
Enter/Pick 2nd Distance by 2 Points: 75.0
This creates a point by distance-distance intersect.

Enter coords/Quit/<Pick 1st point or point number>: Q

Pulldown Menu Location: COGO
Keyboard Command: ccogo
Prerequisite: None
File Name: \lsp\cc.lsp

Point on Arc

This command locates a point on an arc. You can select an arc entity, an arc polyline segment or enter three points to define an arc. After the arc is defined, the screen preview arrow shows the occupied point and the distance to solve for is entered. The command then displays the curve information and locates/inserts a point symbol at the computed point. When prompted for the distance, use a positive value if the distance is from the 1st endpoint (PC the one highlighted by the screen preview arrow) and a negative value if from the 2nd endpoint (PT).

Prompts

Define arc by, Points/<select arc or polyline>: pick arc or polyline arc segment Pick a point on the arc somewhere near it’s midpoint. The preview arrow points to the 1st endpoint.
Precede distance with minus sign if distance from 2nd endpoint.
Distance along arc from 1st point: 100
The command then plots a point at the computed distance.

Divide Between Points

This command divides the distance between two points and inserts one of the point symbols at the specified distances. It can also interpolate elevations (to interpolate the elevations, the points picked must be at their real Z axis elevation).

Prompts
Interpolate elevations [Yes/<No>]? hit Enter
Point to divide-interpolate from?
Pick point or point number: 1

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing (Y)</th>
<th>Easting (X)</th>
<th>Elev (Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4252.76</td>
<td>4158.32</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Point to divide-interpolate to?
Pick point or point number: pick a point
Number of Segments-Divisions: 3
Enter Point Description <>: hit Enter
The command then locates two points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divlin
Prerequisite: 2 points
File Name: \lsp\divlin.lsp

### Divide Along Entity

This command locates points along an entity such as a line, polyline, spline or arc. You must specify the number of divisions.

**Prompts**

Interpolate Elevations [Yes/<No>]: press Enter
Select Entity to Divide: pick point on entity
Number of Divisions/Segments: 15
The command then locates 14 points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divent
Prerequisite: 2 points if you want to interpolate elevations
File Name: \lsp\divent.lsp

---

Chapter 12. COGO Menu 681
Interval Along Entity

This command creates points at a specified distance along an entity such as a line, arc, spline or polyline. The points are listed out on the text screen, stored in the current coordinate (.CRD) file and drawn on the screen. For example, you might use this command to locate lot corner points along a frontage line. When Break Entity at Points is checked, the selected entity will be broken at every located point. When Create Point at Endpoint is checked, points will also be located at the endpoints of the selected entity. Horizontal Distance Between Points allow you to specify the distance between located points. There is also an option to create points on curved portions of the centerline at a different interval than on tangent portions (to reduce chord lengths, a shorter interval may be suitable for curves).

For improved descriptions on the points, there is an option, in this main dialog, allowing you to determine whether or not to label elevations on the new points. And for the purposes of describing the points, there is an option that allows you to set the same description to all of the points. For more options related to points, see Point Defaults under the Points pulldown.
Prompts

Select entity near endpoint which defines first station.
[nea on] Select Entity to Interpolate Points: select entity
[nea on] Select Entity to Interpolate Points: Locating 13 Points
The command locates points along the selected entity.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: ptint
Prerequisite: An entity
File Name: \sp\ptatint.lsp

Create Points from Entities

This command will create Carlson Survey points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the Prompt for Elevations toggle and select the Locate on Real Z Axis toggle. After you have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the Description Settings, Prompt for Description At Each Point will prompt you at the command line for a description for each individual point. Prompt Per Entity will ask you for a description per each highlighted entity. Use Entity Layer for Description will assign the layer name to the description. Same Description For All Points will prompt you for a single description for all points.

The second options dialog has processing settings. When Entity Layer for Description is checked, the layer name of the entity will be used as the description for the created point. When Avoid Duplicates with Existing Pts is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file.
Prompts

Create Points From Entities Dialogs Choose settings
Select arcs, faces, points, text, lines and polylines.
Select objects: pick entities
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

**Pulldown Menu Location:** COGO  
**Keyboard Command:** autopnts  
**Prerequisite:** drawing entities

## Line by Angle-Distance

### Function

This command draws a line from an occupied point at a given angle and distance, where the angle format supports the standard 1-9 angle-bearing codes. It holds the current occupied point and calculates a line by angle-distance to each entered point. As for the angle formats, the Options choice allows for angle right, azimuth only or prompt entry (Right/Azimuth/Prompt) methods. The Prompt method allows you to enter the 1-9 angle-bearing codes.

### Prompts

- **Occupied Point?**
  - Pick point or point number: pick point
  - Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <90.0000>: 112.3024
  - Points/<Distance>: 290
  - Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <112.3024>: O
  - Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? R
  - Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <112.3024>: 88
  - Points/<Distance>: 300
  - Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <88>: O
  - Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P
  - Exit/Options/Points/Angle-Bearing Code <7>: Enter
Tangent Line from Circles

This command draws a line that is tangent to two circles. The circles are defined by picking the radius point and entering the radius. The tangent line can be drawn to either outside on the left or right side, or across the middle between the circles from left to right or from right to left. The line and the circles are drawn in the current layer.

Prompts

Pick center point of first circle: pick a point
Pick first radius: 25
Pick center point of second circle: pick a point
Pick second radius: 35
Left or Right tangent [<Left>/Right/LtoR/RtoL]? L

Building Offset Extensions

This command is used to calculate building corner offset points that are extensions of the building faces. This command uses building perimeters that are drawn as closed polylines. The point are stored to the current coordinate file and draw on the screen. There is a dialog for setting the parameters. The Offset Amount is the distance that the offsets are extended past the end of the building line. The Starting Point Number is the point number to begin storing
The Point Description and Elevation are assigned to all the new points and the Point Layer is used for all the drawn points. Offset points are always created as extensions of the building lines at the corners. Offset points can optionally be created at the diagonals of corners and across to the other side of the building for inside corners. In the example shown here, points 101, 103, 104, 106, 107, 110, 112, 115, 117, 118 and 120 are corner extension offset points. Points 102, 105, 108, 111, 116 and 119 are diagonal points. Points 113 and 114 are across building points.

**Prompts**

**Building Offset Extensions dialog**
Select building perimeter linework.
Select objects:  *make selection*

**Pulldown Menu Location:** COGO
**Keyboard Command:** bldg_pnts
**Prerequisite:** A polyline perimeter that represents a building
**File Name:** \lsp\poly3d.arx
**Radial Stakeout**

This command creates a radial stakeout report using the current coordinate (.CRD) file. The program calculates the azimuth, angle right, horizontal distance and/or slope distance for a range of points relative to an occupied point and a backsight point.

![Radial Stakeout interface](image)

**Occupied Point Number:** Specify the occupied point number X and Y values will fill in automatically.

**Backsight Point Number:** Specify the backsight point number X and Y values will fill in automatically.

**Maximum Hz Distance:** This is the maximum horizontal distance from the occupied point that the program will include in the report.

**Range of points to Compute:** Enter the range of points to be included in the stakeout report If you check Select Points from Screen, this option is unavailable.

**Select Points from Screen:** This option allows you to select from the screen the points to be included in the stakeout report.

**Number of Decimal Places:** Specify the display precision for the report.

**Report Options:** Specify the direction format that the report should use.

**Report Slope Distance:** When checked, the slope distance is included in the report in addition to the horizontal distance.

**Use Cut Sheet Format:** When checked, adds columns to the report for Description, Hub Elev, and Elevation.
Results from clicking the List (point) button

Sample radial stakeout report:

 Radial Stakeout
Occupied Point
 2  7137.7248  9016.1417  500.000
Backsight Point
 1  7075.7408  8875.7884  500.000
Backsight Azimuth= 246.1021

PtNo.  Azimuth  AngRight  HzDist  North(y)  East(x)  Elev(z)
 3   261.0258   14.5237   74.061  7126.2022  8942.9830  500.000
 4   262.4347   16.3327  113.032  7123.4208  8904.0181  500.000
 5   281.1809   35.0748  137.858  7164.7435  8880.9572  500.000
 6   301.4512   55.3452   82.296  7181.0342  8946.1639  500.000

Pulldown Menu Location: COGO
Keyboard Commands: radstake, rs
Prerequisite: A coordinate file (.CRD file) with points
File Name: \lsp\crdutil.arx

Section Subdivision

This command calculates and stores all 1/16th Section corners. The Section number, Township and Range must be entered first. Specify which Field Corners have been located either Section & Quarter or 1/16th Corners. Enter the appropriate point numbers for the field located corners. Then enter the government changes as prompted. The calculated points will be located on the screen as well as the coordinate file. For each calculated corner, a dialog box will be displayed. On this box, the default point number value can be accepted or changed. The description and elevation can also be changed or accepted.
Pulldown Menu Location: COGO > Section Corners
Keyboard Command: sectionsub
Prerequisite: Coordinate File
File Name: \lsp\cgsc.arx

GLO Corner Proportioning

The GLO Corner Proportioning commands calculate section and 1/4 section corners by one, two, three or four way control. GLO plats are the official plats of the U.S. Government Land Office (GLO) executed after July 1946. The Department of the Interior, Bureau of Land Management (BLM) is the successor agency to the GLO.

One Way Control

This routine calculates section and 1/4 section corners by one way control. First, enter the point number for Point A. This number can be entered in manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Bearing from A to B can be entered manually or by using the Pick radial button to pick from the screen. The distance from A to X can be specified in the same manner as above. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in
the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well.

**Prompts**

**GLO Proportioning One Way Control dialog**

![GLO Proportioning One Way Control dialog](image)

**Pulldown Menu Location:** COGO > Section Corners > GLO Corner Proportioning

**Prerequisite:** A coordinate (CRD) file

**Keyboard Command:** glo oneway

**File Name:** \lsp\cgsc.arx

**Two Way Control**

This routine calculates section and 1/4 section corners by two way control. Enter the point numbers for Point A and B. These numbers can be entered in manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Record Chainages from A to X and from A to B can be entered manually or by using the Pick radial button to pick from the screen. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the...
point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts

GLO Proportioning Two Way Control dialog

Prompts

GLO Proportioning Two Way Control dialog

Three Way Control

This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.
Prompts

GLO Proportioning Three Way Control dialog

Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Keyboard Command: glo.threeway
Prerequisite: A coordinate (CRD) file
File Name: \lsp\cgsc.arx

Four Way Control

This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field with be
Prompts

GLO Proportioning Four Way Control dialog

**Pulldown Menu Location:** COGO > Section Corners > GLO Corner Proportioning  
**Prerequisite:** A coordinate (CRD) file  
**Keyboard Command:** glo_fourway  
**File Name:** \lsp\gcsc.arx

**Solar Observations**

**Function**

This routine calculates true north and/or grid north bearings by solar observation. It uses the Local Hour Angle
method. The routine calculates Ephemeris data, thus alleviating the necessity of obtaining a Solar Ephemeris. The True North option calculates the true north bearing to mark. This option requires no zone/ellipsoid information. The True North & Grid North option calculates both true north and grid north bearings to north. The convergence angle is also shown.

**True North Prompts**

Calculate true north, or true north and grid bearing (<True north>/Grid Bearing: type T, press Enter
Choose field method (Leading edge/Trailing edge/<Center>): choose method, press Enter
If a Roelofs prism is being used, the Center Method should be selected. If not, select one of the other options. The Trailing Edge Method is the more popular of the two remaining methods.
Date of observation as MM/DD/YY or MM-DD-YYYY: For example 04/08/03.
Enter latitude of instrument point as DD.MMSS: For example 36.0545
Enter longitude of instrument point as DD.MMSS:
The following input loop will begin:

**Obs. #1 - Time of observation as HH.MMSS: For example 15.3030**
Enter angle to mark as DD.MMSS: Angle in the instrument when backsighting the mark.
Enter angle to sun as DD.MMSS: Clockwise angle from mark to sun.
The angle to the mark always has a default value of the last entered Angle to Mark. Each observation is numbered and the true bearing to the mark will be calculated. There is not limit as to the number of observations that can be made from a setup. After data entry is complete, press Enter.

The following options appear:

**Edit/<OK>/Quit:** If you choose Edit, you will have the following options:

**ADD/Change/Delete/eXit:**
Add: Allows for addition observation data entry.
Change: Allows editing of existing data. When selected a prompt for Enter observation to change will be displayed.
Choose which observation number to edit. You will then be prompted with the initial input prompts for the observation again. The original input values will be the default values for each prompt. To change the value, simply enter new data.
Once Delete: This will delete the specified observation data. Choose the observation number to delete.
eXit: This exits the change routine.
OK: The bearings from all the observations will be averaged and shown as well as the True Bearing. For example:
No. Time Angle-@-Mark Angle-to-Sun True-Brg-to-Mark.

1 12.3030 0°00'00'' 20°00'00'' N 73°05'43''E
2 12.4456 0°00'00'' 21°00'00'' N 74°17'15''E
Average True Bearing: N 73°41'29''E

**True North & Grid North Prompts**

Calculate true north, or true north and grid bearing (<True north>/Grid Bearing: G
The following dialog will be displayed. Select the state in which the observations were made. All fifty states are available, as well as PR for Puerto Rico and UM for Universal Transverse Mercator. If the state is divided into zones, you will be prompted for the zone you are working in.

**Enter zone (N,S):** Enter the zone. After entering the zone, if applicable, the input loop described for True North calculation as detailed above will begin. After data entry the same options, Edit/<OK>/Quit as detailed above will be displayed. Pressing OK averages and displays the bearings from all the observations taken along with the Average True Bearing, Average Grid Bearing and the Convergence Angle as follows:
No. Time Angle-@-Mark Angle-to-Sun True-Brg-to-Mark
1 12.2222 0°00'00" 20°00'00" N 72°57'31''E
2 12.4444 0°00'00" 22°00'00" N 74°20'51''E
Average True Bearing: N 73°39'11''E
Average Grid Bearing: N 72°15'12''E
Convergency Angle: 1°23'59''

Pulldown Menu Location: COGO
Keyboard Command: solarobs
Prerequisite: None
File Name: \lsp\sideshot.lsp

Best Fit Circle

This command draws a least-squares best-fit circle based on points on the perimeter. The program handles four or more perimeter points. A design point for the circle center can optionally be specified. The report shows the residuals for each point, the residuals standard deviation, the difference between the design point and the circle center, and the circle parameters. The residuals are calculated as the perpendicular distance from the point to the circle. The program generates a report.

Prompts

Select points from screen or by point number [<Screen>/Number]? N
Point numbers: 2-6
Point numbers (Enter to continue): press Enter
Enter design center point# (Enter for None):

Sample Report:

Source Coordinates
Point# Northing Easting Residual
2 5253.198 5070.233 0.126
3 5246.623 5084.077 0.045
4 5232.963 5078.608 -0.131
5 5235.610 5065.105 0.217
6 5247.392 5064.165 -0.264
Residuals Standard Deviation: 0.174

Circle Center: 5242.678,5073.785 Radius: 10.977
Design Center Point#: 1
Design Center: 5242.718,5073.688
Center Distance Difference: 0.105
**Pulldown Menu Location:** COGO  
**Keyboard Command:** bfitcir  
**Prerequisite:** Four or more points  
**File Name:** \lsp\crdutil.arx

### Best Fit Line by Average

This command will fit a line from a starting point by sampling a group of points. The routine averages the coordinates of the sampling group then draws the best-fit line. The program generates a report of the residuals, standard deviation, line bearing and line distance. The perpendicular distance from each point to the line is reported as the residual.
Sample report of Best Fit Line by Average with a different group of points

Prompts

Starting point?
Pick point or point number: pick starting point
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select points.
Select objects: select group of points Select points using Window or Crossing. The line is then drawn to the computed point.

Pulldown Menu Location: COGO
Keyboard Command: bfitlin
Prerequisite: points to sample
File Name: \lsp\bfitlin.lsp

Best Fit Line by Least Squares

This command will sample a group of points by screen selection or point number range, and then compute the best fitting line by least squares. There are options to best fit with nothing held (None), to best fit by holding a point, and to best fit by holding a bearing. All three options are shown below in the graphic. When holding a point, you are prompted to enter the weight for the point. In this example, a weight of 1000 caused the line to pass to within 0.025 of point 111. With a weight of 5000, the line passed to within 0.005 of point 111. Increase the weight accordingly to obtain the desired precision. When holding a bearing such as N45E, you are prompted to enter the bearing in the form QDD.MMSS (e.g. 145.0000 or just 145). The program generates a standard report.
Prompts

Select points from screen, group or by point number [Screen>/Group/Number]? S
Select Carlson Software Points.
Select objects: pick the five points
Point numbers (Enter to continue): press Enter
Parameter to hold [None>/Point/Bearing]: P
Enter point number to hold: 111
Enter weight for point: 5000

Sample Report:

Best Fit Line By Least Squares 05/14/2006 18:15
Holding point 111: (5227.721, 5149.482)

Coordinate File> c:\scad2006\data\interval.crd

Source Coordinates

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
<th>Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
<td>5103.542</td>
<td>5182.098</td>
<td>10.050</td>
</tr>
<tr>
<td>110</td>
<td>5114.634</td>
<td>5191.928</td>
<td>6.921</td>
</tr>
<tr>
<td>111</td>
<td>5149.482</td>
<td>5227.721</td>
<td>0.005</td>
</tr>
<tr>
<td>112</td>
<td>5178.703</td>
<td>5268.237</td>
<td>0.400</td>
</tr>
<tr>
<td>113</td>
<td>5201.666</td>
<td>5312.602</td>
<td>8.129</td>
</tr>
</tbody>
</table>

Residuals Standard Deviation: 6.559

Bearing: N 53°44'07" E
Distance: 163.266

Pulldown Menu Location: COGO
Keyboard Command: bfitlinelq
Prerequisite: Group of points to sample
File Name: \lsp\bfitlr.lsp
Centerline Menu

The Centerline menu provides commands for designing and editing centerlines and centerline files. Tools for stationing, labeling and offsetting centerlines, along with Right of Way features, are also provided in this menu. Additionally, there are many import and export conversion options to select from when you pick Centerline Conversion.
Design Centerline

This command draws a centerline polyline and writes the centerline data in a centerline file. The first step is to specify a centerline (.CL) file name. Next in the Design Centerline dialog you can specify several options. Centerline Layer is the layer name for the polyline. Tangents Layer is the layer name for the tangent lines drawn from the centerline to the curve center. Max superelevation is used for determining the minimum recommended radius. Setting the Prompting mode to Existing skips design questions such as design speed.

After the Design Centerline dialog, the program cycles through curve prompting until End is selected. There are PC and PI modes for curve entry. In PC mode the arc's PC points are entered followed by the curve data. The PC points can be specified by either picking the point, entering a distance or entering a station. In PI mode, the arc's PI points are entered. Once the PI points determine two tangents, the program prompts for curve data for the previous PI. Spirals can only be entered in PI mode. You can switch between arc and PI mode between curves on the polyline. The arc curvature can be specified by degree of curve or radius. The minimum recommend radius is based on AASHTO. The arc length can be specified by PT station, tangent length or arc length.

The Store Points in CRD File will create points in the current coordinate file for each design point on the centerline. This option is also used for creating the SMI chain file within Centerline Utilities, since the SMI chain file requires point numbers. To specify the coordinate file, choose Set Coordinate File in the Points menu.

Prompts

Centerline file to design Enter the .CL file name to create.
Design Centerline Dialog Choose your options and click OK.
Pick Point or Point number: pick a starting point or enter the starting point coordinates
For PC mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pick the PC point
Bearing/PC/PI/End/Undo/<Pick Point or Point number>: PC
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/Right)? press Enter for right
Length to use (Station/Tangent/<Arc>): press Enter for arc
Point/Station/Tangent/<Arc Length>: 200
Reverse/Compound Curve (Yes/No)? press Enter
PI/Distance/Station/<Pick PC or Point number>: D for distance

Chapter 13. Centerline Menu
Point/Enter Distance: 180
Bearing/Line/Undo/End/<Continue PC>: press Enter
Enter Design Speed for curve <40.00>: press Enter
Minimum Recommended Radius = 426.67

Example of PC mode centerline design

View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/<Right>)? press Enter
Point/Station/Tangent/<Arc length>? 300
Reverse/Compound Curve (Yes/<No>)? press Enter
PI/Distance/Station/<Pick point or Point number>: D for distance
Point/Enter Distance: 140
Bearing/Line/Undo/End/<Continue PC>: E to end
For PI mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pi
Pick Point or Point number (PI)<5098.50,3509.11>: pick the first PI point
Type of curve [Spiral/<Circular>]? S for spiral
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Enter Number of Lanes <2>: 500
View/Enter Spiral Length In <204.8000>: 210
View/Enter Spiral Length Out <210.0000>: press Enter
Bearing/Pick next Point or Point number (PI): pick the next PI point
TS: 1+33.280
SC: 3+43.280
CS: 6+39.364
ST: 8+49.364
Bearing/Line/PC/Undo/End/<Continue PI>: press Enter
Type of curve [Spiral/<Circular>]? press Enter for circular
Enter Design Speed for curve <40.00>: press Enter
Example of PI mode centerline design

Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Bearing/Pick next Point or Point number (PI): pick the last PI
PC : 9+35.900
PT : 16+34.283
Reverse/Compound Curve [Yes/<No>?] press Enter
Bearing/Line/PC/Undo/End/<Continue PI>: E to end
EndPoint : 18+37.121

Stations are printed for every PC, PT and end point in the design process.

Pulldown Menu Location: Centerline
Keyboard Command: centerln
Prerequisite: None
File Name: \lsp\eworks.arx

**Input-Edit Centerline File**

This command can be used to input a new centerline or edit an existing centerline (.CL) file. It is a dialog-based alternative to *Design Centerline* and has the advantage of accepting whatever information you have on your centerlines (coordinates, stationing, length of tangents and arcs, etc.). For creating a new centerline, it is ideal for entering data straight from highway design plans. For editing, this command allows you to change any of the geometric properties of any of the elements of the centerline (lines, curves, spiral-only and symmetrical spiral-curve-spiral elements), including the starting coordinates and station.

Starting this command launches the Centerline Input-Edit main dialog box. To edit an existing Centerline, you can either pick the Load button and pick the .CL file, or pick the Screen Pick button and pick the polyline in the drawing that represents the Centerline. The Centerline is then displayed in the graphics window of the dialog box. The highlighted segment in the text window is also highlighted in the graphics window.
Up/Down: Moves elements in the table Up and Down in the list. For example, if this centerline ended with a tangential line from the last curve, then was followed by a non-tangential line at 45 degrees NE, moving the last element up would create a line at 45 degrees after the curve (non-tangential), and the formerly tangential line will remain tangential and therefore continue at NE 45 degrees.

Draw: This button draws the centerline in the drawing on the specified layer.

Drag Action (Zoom and Pan): In the graphics window, hold the left mouse button down and move mouse to Pan, roll the wheel to Zoom.

Load: Loads an existing centerline (.CL) file for review or editing. After loading a centerline, the listbox in the dialog shows a list of all the elements in the centerline, identifying them as either a line, curve, spiral only or full spiral-curve-spiral element and reporting the ending station, northing and easting of the element.

Add: Adds a new element after the highlighted element. Prompts you for the type of the element to be added, Line, Curve, Spiral-Only or Spiral-Curve-Spiral.

Edit: Allows you to edit the highlighted segment.

Remove: Removes the highlighted element from the centerline.

Assign Point Numbers: This will create Carlson points along the elements of the centerline and store them to the current CRD file. The new points will be numbered in sequence beginning with the first available point number in the CRD file.

Reverse: Reverses direction of Centerline.

Save: Saves the currently loaded centerline to a file, or will prompt you for a name if no name has been set.

SaveAs: Prompts you for a file name for the saved file.

Exit: Exits this routine, prompting to save changes if necessary.

Help: Goes to the Help screen for the Input-Edit Centerline command.

Station Equations: At any number of locations on a centerline, you can set the back station and forward station for the re-stationing of the centerline. The station equation dialog appears below:
If the Station Back is lower than the Station Ahead, then a "gap" is inserted in the centerline, where the stations jump forward. If the Station Ahead is less than the Station Back, then an overlap occurs, where the common station range is repeated.

The dialog for every type of element shows the point ID, the northing, easting and station of the start point of the element. It then allows the user to modify or define the parameters specific to the type of element. The following are some of the things to remember about data entry in the centerline editor. These are valid for lines, curves and spirals.

Wherever length of the element is to be entered, entering an expression of the type 123.5 - 93.7 would evaluate the difference of the values. This is particularly convenient where only the stations of the start and end points of the element are known.

When the station is specified, the program takes the length of the element as the difference between the station of the start point of the element and the station specified.

All bearings should be specified by entering the angle between 0 and 90 degree (in dd.mmss format) and selecting the quadrant.

When entering the delta angle of a curve, only the absolute value (between 0 and 360 degree) is to be entered. The direction of the curve is to be explicitly set as right or left, the default being left. All angles are entered in (dd.mmss) format.

Point numbers, when used, access their coordinates in the current .CRD file. If the point number specified has no coordinates stored in the coordinate file, the point number is remembered for that particular location (say the radius point of a curve or the SC point of a spiral). Then, when the .CL file is saved, the program creates points for that location and stores them to the .CRD file with the specified point number.

The dialog for a Line allows the user to specify the line primarily by its length or station and its bearing. The line can also be defined by its end point number or its coordinates. The bearing of a line can be changed if the Tangential to the Previous Element toggle is not checked. By default, any line which follows a curve element is defaulted to be tangential to it. To use a bearing different than that of the previous element, uncheck this toggle and enter the bearing.

The dialog for the Curve allows the user to define the curve primarily by its radius and delta angle or arc length. The other parameters of the curve that can be edited are the bearing of tangent-out and the "Station to", which also defines the arc length. The curve can also be specified by entering the coordinates or point numbers of its end point (PT) and the radius point. Another way to specify the curve would be to enter the chord length or PT point station and chord bearing. If the central PI point and a point on the forward tangent are known, then the curve can be defined by entering both of these points and at least one other property of the curve (like radius, arc length, delta angle). The point on the forward tangent can be any point that defines the tangent out direction including the next PI point. If only the central PI point is known, then the tangent-out can be entered by bearing instead of by forward tangent point. Central PI and forward tangent points are not displayed from the .CL file. They have to be entered by the user and are valid only for that particular edit session; that is, they are not remembered the next time the
file is loaded. Curves are assumed to be tangent to the last element unless the Tangential to the Previous Element checkbox is cleared.

The Curve Edit Mode option defines how the curve is accepted in the centerline. If the Hold PC point is checked on, the radius is taken as fixed and the delta angle of the curve is calculated based on some additional parameter. Hence, the extent of the curve is unlimited. However, if the Hold PI points option is checked on, the bearing of tangent-out of the curve is taken as fixed and the radius is calculated based on some other parameter. In this case, the curve is completely restricted within the central PI point and the bearing of tangent out. Hence, when the Hold PI points option is checked on, the above parameters should also be defined to carry out the calculations.

The dialog for the Spiral-Curve-Spiral element allows the user to define the spiral by entering either the various parameters of the spiral (like the angles and lengths) or the coordinates or point numbers of its defining points: the TS (Tangent-to-Spiral), SC (Spiral-to-Curve), Radius point, CS (Curve-to-Spiral), ST (Spiral-to-Tangent) and end point (optional). While defining the spiral by its geometric properties, the program will accept the data even if the information for the simple curve is given with zero spiral lengths. In this method, however, the central PI point of the spiral MUST be specified (that is, it is always in Hold PI Points mode). The tangent out can be defined by entering bearing or by specifying a point on the forward tangent. This forward tangent point can be the next PI coordinates. The direction of the spiral-in and spiral-out elements would be the same as the direction of the simple curve (left or right).

The spiral can be defined by several different parameters and the order that you enter data into the spiral dialog can be important. There are two main sequences for entering data. The method to use depends on the spiral data that you have. The first method is to enter the radius of the simple curve, the spiral in and out lengths, the tangent bearing out and the PI station. The second method is to make a Line segment coming up to the TS (tangent to spiral) point. This Line segment should be added before creating the Spiral element. Then with the Spiral In point set to the TS point, enter the radius of the simple curve, the spiral in and out lengths, the curve direction (left or right) and the arc length of the simple curve. Then the rest of the spiral points will be calculated.

The Spiral Only element allows for flexible transitions from curve to spiral to curve or line to spiral to curve or between any combination of curve and line elements. The Spiral-Curve-Spiral element, for example, can be entered as Line, Spiral Only, Curve, Spiral Only and Line, producing the same results.

Once all the elements of the centerline are defined, the file can be saved and then plotted using the Draw Centerline File command.

Example

Here is an example of a highway interchange ramp that involves a starting tangent and a spiral curve that goes abruptly into a simple curve and then a final tangent. Here is the starting dialog.

You start by entering a starting Northing and Easting and starting Station. The Start Point# is optional. Then the concept is that you click Add to add each subsequent element (line, curve, spiral-curve-spiral or spiral only).
Line (Tangent) Segment: We want to enter the tangent segment length up to the TS (tangent to spiral). Enter in the length (200.0), bearing (88.0732) and then the bearing quadrant (NW). Since the next spiral-curve-spiral element can be based on a PI station, it is not necessary for this line segment to go up to the TS point. The purpose of this line segment is to establish the tangent-in direction.

When OK is clicked, the routine will add the Line element as the first in the list of complete centerline elements. Next up is Curve-Spiral-Curve. Click Add.
**Spiral Segment:** Though the dialog is complex (for total flexibility), the key on a typical symmetrical spiral curve is to enter four things: (1) the radius of the simple curve, (2) the spiral in and out lengths, (3) the tangent-out bearing and (4) the PI station (1835.67). Everything else will calculate when you press Enter for the PI station.

**Curve Segment:** Add the next element and select curve. The Curve dialog appears. The key is to enter the Radius Length (255), the Arc Length (150) and the Curve Direction. Everything else will calculate.

**Final Line Segment:** All you need to enter in the final dialog for the line (tangent) segment is its length. All other
items will calculate when you press Enter.

The completed centerline will appear as shown in the dialog and each element can be edited. Pick the Save button to store this centerline data to a .CL file.
**Polyline to Centerline File**

This command writes a centerline (.CL) file from a polyline. The northing and easting for each vertex of the polyline is written to the centerline file and each arc in the polyline becomes a circular curve.

**Prompts**

**Centerline file to Write dialog** Enter the .CL file name to create.
**Beginning station <0+00>**: press Enter Or, type in the beginning station then press Enter.
**Select polyline that represents centerline**: pick the polyline that represents your centerline

**Keyboard Command**: clpline
**Prerequisite**: A polyline
**File Name**: \lsp\quikcl.lsp

**Draw Centerline File**

This command reads a centerline (.CL) file and plots it as a 2D polyline in the drawing at the proper coordinates. First you are prompted for the layer name for the polyline to be created. There is also an Options choice that allows you to specify whether to draw PI lines, and specify the length of same.

Next you are prompted for the file name of the centerline to plot.
The .CL file can be made with the following commands on the Design menu: Polyline to CL File, Input-Edit Centerline or Design Centerline. Drawing the centerline file is a way to check the .CL file data graphically for correctness. If a spiral exists in the .CL file, the spiral will be represented by polyline segments.

**Prompts**

**Options/Layer Name for Centerline <CLINE>:** press Enter
Enter the layer name to plot the polyline on.

**Centerline File to Plot file selection dialog:** Select the .CL file name to read and plot.

**Keyboard Command:** cl2pline
**Prerequisite:** a centerline file
**File Name:** \lsp\clpline.lsp

**Centerline Report**

This command reads a centerline file and creates a report in the standard report viewer which can be written to a file, a printer, or to your drawing. If the centerline file contains point numbers, then the report will include these point numbers. If station equations are found, they are noted at the top of the report. Here is an example report:

![Example Centerline Report](image)

**Keyboard Command:** clreport
**Prerequisite:** A centerline (.CL) file
**File Name:** \lsp\eworks.arx
Centerline ID

Centerline ID reports the centerline file name and location that is associated with an alignment polyline. The subject polyline must have been created with either Design Centerline, Input/Edit Centerline, or Polyline to Centerline File. When the routine is initiated and an alignment polyline is selected, the file associated with that polyline is reported at the command line. Additional alignment polylines may be selected without re-entering the command, or Enter may be pressed to exit the command.

Prompts

Select centerline polyline to identify: *pick the polyline*
Centerline Name: D:\SAMPLE.CL
Select centerline polyline to identify (Enter to end): *press Enter*

Pulldown Menu Location: Centerline
Keyboard Command: CL_ID
Prerequisite:A polyline created from a Design Centerline, Input/Edit Centerline, Polyline to Centerline File, or Centerline File to Polyline.
File Name: \lsp\surv1.lsp

Station Polyline/Centerline

This command will station a polyline or centerline file at a given interval distance. The options for this command are set in the dialog shown below. After setting the options, click OK on the dialog and then pick the polyline or select the centerline file. All settings can be saved as (.STA) files and loaded for reuse, and for storing multiple stationing schemes. Polyline/Centerline station labels are also dynamic, and so will update when changes are made in the geometry.
Distance for Stations is the primary interval for stationing.

Distance for Intermediate Stations is the intermediate interval for stationing.

Beginning Station is the beginning station of the centerline for stationing.

Locate Even Stations labels the stations at the distance interval (i.e. 2+00, 3+00, etc.).

Locate Odd Stations labels the non-interval stations at the polyline/centerline end points and PC and PT points.

Locate User-Entered prompts you for individual stations to label.

Without the Increment Station Labels from Beginning Station option, the program increments the station labels from zero. For example, if the station interval is 100 and the polyline starting station is 145, then the program will label 2+00, 3+00, etc. With this option active, the station labels are incremented from the starting station. In this example, the program would then label 2+45, 3+45, etc.

Label Deflection Angles adds this annotation to the stationing. Settings for this are specified in the Label Deflections Setup, accessed by the Deflections Setup button.

When Specify Start/End Stations is checked, only the stations between and including the specified starting and ending stations will be labeled. If locate centerline points and offset points are toggled on, only points within the specified stations will be located.

When Erase Previous Station Labels is checked, previous station labels are erased when new ones are generated.

The Setup PC Lines button accesses the PC Lines Setup dialog, where settings are controlled for lines and/or symbols and/or labels at the starting and ending (PC and PT) stations of an arc of the polyline/centerline.
**Draw PC Lines** controls whether lines are drawn from the PC and PT points.

When **Label PC On Centerline** is checked, the station of the PC and PT will be labeled on the centerline as well as the PC and PT lines. When not checked only the PC and PT lines will be labeled.

**Draw PC Symbols** controls whether symbols are placed at these locations. If checked, the desired symbol is selected by picking on the box to the right.

**Label PC Radius** controls whether this point is labeled.

**Max Length** controls the maximum length for the PC lines to be drawn described above.

**Back in the main Station Polyline/Centerline dialog box:**

**Draw PI Lines** draws a 2 segment polyline in both tangent directions from the PI as a marker for the PI.

When **Label PI Stations** is checked, the PI station is labeled at the PI point.

When **Locate PI Points** is checked a point will be created at the PI of a horizontal curve graphically and written to the active coordinate file.

When **Label Station Text** is checked, this command places station text along the polyline at the angle of the corresponding segment. After toggling this option on, the **Label Setup** button will become available for selection. Select it to configure the label settings as desired. Select the **Marker Setup** options to modify the size of the markers for certain types of stations. See definitions following the dialog box.
Label Setup

- **Text Layer** is the user-specified layer for text labels to be drawn on.
- **Text Style** is the user-specified text style for labels.
- **Decimals** determines the number of decimal places of the stationing labels to be drawn for the odd stations and user entered stations only.
- **Text Size Scaler** determines the size of the station labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the station labels will be 10 units.
- **Text Offset Scaler** works like text size scaler above controlling the distance the text labels will be offset from the centerline.
- If the **Flip Text For Twist Screen** setting is checked and the drawing has been twisted using the twist screen command, the label text will be flipped to read in the proper direction of the stationing.
- **Label Intermediate Stations**: If the intermediate distance is the same as the station distance then no intermediate station ticks or labels will be drawn. For example, with the above entries and 0+00 for the first station the stations will be labeled with descriptions as follows: 0+00 0+50 1+00 1+50, etc.
- **Station + at Tick Mark** labels the station text along the polyline with the '+' of the station text at the station's location on the polyline. See Marker Set up for marker size manipulation settings.
- **Label Northing/Easting of Starting Point** adds this label information, including prefixes and/or suffixes as specified.
- Use **Label Stations** to specify whether to label the stations perpendicular or parallel to the centerline.
- Specify the **Position** of the station labels, either above or below the centerline. This is only available when labeling stations using the parallel option.
- **Align** determines the alignment of the station label, either left or centerline, centered along the centerline or
to the right of the centerline. This option is only available when using the perpendicular option for station labels.

The **Marker Setup** options control the size of markers for different station types as well as the layer the markers will be drawn on.

![Marker Setup dialog box](image)

Specify whether to define the **Centerline By** picking a 2D polyline or 3D polyline in the drawing or selecting a centerline (.CL) file.

- **Using a 2D Polyline** will result in horizontal distance stationing along the polyline.
- **Using a 3D Polyline** will result in the slope distance stationing along the polyline.
- **Using a CL File** will result in horizontal distance stations as with the 2D Polyline option only a prompt for the centerline to use will display.

Use **Station Type** to specify the stationing format to use.

Use **Type of Curves** to specify whether you are labeling a roadway curve (arc definition) or railroad curve (chord definition).

**Locate Centerline Points** will locate points and store them in the current CooRDinate file.

**Locate Radius Points** will locate the radius points of any arc segments.

**Starting Point Number** determines the starting point number for the points to be located.

There are two ways to **Set Elevations** for the centerline points and offset points to be created.

- **The 3D Polyline** option gets the elevation of the point from a specified 3D Polyline within the drawing.
- **The Profile** option will determine the elevation of the point based upon the same station in the profile file. You will be prompted for the profile file to read for the elevation reference.
• With the None option selected, no elevations will be determined for the points.

When Include Station in Description is checked, the station along the centerline will be included in the resulting offset point.

Description Prefix is an optional user-specified prefix to be added to the point description.

Description Suffix is an optional user-specified suffix to be added to the point description.

When Label Sta Equations is checked on any station equation, contained in a centerline (*.cl) file will be labeled. This option is only available when stationing a centerline file (*.cl).

Locate Offset Points will create points at the specified left and right offset distances from the centerline. Options for setting the elevations and descriptions of the points are available from the Offset Setup dialog.

• When Use Slopes is on, it makes available the Percent Slopes fields for defining the slope from centerline both right and left for determining the elevations of the offset points.

• Enter the desired Offsets left and right.
• Enter the desired Percent Slopes from centerline to the left and right offset points.

Prompts

Station Polyline Dialog
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents centerline: select a polyline
Closeup of Station + at Tick Mark option

Labels with Label PC on Centerline checked on

Labels set to perpendicular and Max Length of PC lines set to 75.0
Labels with Draw PI Lines, Label PI Stations and Locate PI Points all checked on

Labels using Centerline By 2D Polyline (Horizontal Station)

Labels using Centerline By 3D Polyline (Slope Station)

Keyboard Command: stapl

Prerequisite: A polyline or CL file

File Name: \lsp\staent.lsp

**Label Station-Offset**

This command will label the station and offset of a point relative to a centerline. A polyline that represents the centerline or a centerline (.CL) file is required before using this command. The points to label can either be picked on screen or specified by point number. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example). This command starts with the Label Station-Offset Settings dialog.
**Label Options:** Specify whether to label the text only or add the label to the existing point description.

**Label Position:** Specify if the program should automatically position the label with a leader, let the user pick the location, or use no leader.

**Label Alignment:** Specify whether the labels should be Horizontal on the screen, Parallel to the Centerline, Perpendicular to the Centerline, or user-specified by Picking.

**Type of Curve:** Specify whether the centerline is for a roadway or railroad.

**Layer Name:** Specify the layer name for the labels.

**Text Size Scaler:** Determines the size of the labels. This value multiplied by the horizontal scale setting in *Drawing Setup* results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the labels will be 10 units.

**Text Offset Scaler:** Determines the text offset. This value works the same way as the Text Size Scaler.

**Beginning Station:** Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

**Max Offset to Calc:** Specify the maximum offset to calculate.

**Station Decimals:** Specify the display precision for the station text.

**Offset Decimals:** Specify the display precision for the offset text.

**Station Prefix:** Specify an optional prefix for the station text.

**Station Suffix:** Specify an optional suffix for the station text.

**Offset Prefix/Suffix:** Specify an optional prefix and/or suffix for each offset.
Station Label: Choose between Full label (1+35.42), Partial label (+35.42) or no station label.

Offset Label: Choose between Fill label (L15.35), partial label (15.35) or no offset label.

Flip Text for Twist Screen: With this option checked, the text will be flipped as necessary to adjust for the use of Twist Screen.

Label Both Station-Offset On Same Line: With this option checked, the station and offset label will be drawn on the same line.

Station Type: Specify the stationing format to use.

Centerline By: Specify whether to define the centerline by picking a polyline in the drawing or selecting a centerline (.CL) file.

Prompts

Label Station-Offset dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline Centerline: pick the polyline centerline
Pick point or point number (SS for Selection Set, G for Group, Enter to End): pick a point
Station on Line> + 2+10.91 Offset> 57.36 Right
Select point number to add station description to: pick point number This prompt will not appear if the L option, label only was selected.
Pick point or point number (Enter to End): press Enter

Top/Left Example: Label Text Only showing Full Labels and the Station/Offset on the same line
Bottom/Right Example: Partial Label

Real time display of station offset as you move the cursor
Keyboard Command: offsta
Prerequisite: A polyline centerline
File Names: \lsp\inqoff.lsp, \lsp\scadcogo.dcl

**Offset Point Entry**

This command creates points along a centerline at specified stations and left and right offsets. The centerline can be defined by a polyline, centerline (.CL) file or two points.

The **Store Points to Coordinate File** option will store any points the current coordinate (.CRD) file. This includes centerline points and offset points.

When **Locate Points on Centerline** is checked, the program will locate points along the centerline, otherwise just the offset points will be created.

When **Label Stations & Offsets** is checked, the program will label the station-offset as the point description attribute.

When **Locate Intersection Points At Line Corners** is checked, the program will locate points along the centerline at the intersection points of selected lines with that of the centerline. This routine is to be used along with Locate Points on Centerline. This is a good option to use when the exact station of where the offset points are to be created
is not known but is referenced by an existing line on the drawing.

**Beginning Station:** Enter the Beginning Station of the Centerline.

Use **Centerline from** to specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

Use **Reference Elevation** to assign elevations to the points created when locating points on the centerline of offset points. When using a 3D Polyline for the elevation reference, points will be created at the station entered and the offsets specified with the elevation of the same station along the 3D polyline. The Profile option will do the same as the 3D Polyline option only it will use a profile file for the elevation reference. You will be prompted for the profile to use for the elevation reference. None simply creates 2d point data on elevation zero. The Reference Elevation option is good for creating points along the centerline for final grade elevation points. **Profile to 3D polyline** can be used to transfer the profile data to the polyline before calculating the final grade points.

**Cross Slope %:** This option is used to alter the elevations of the new points by applying either a Cross Slope calculation or a Delta Z variable.

The Manual Entry option in **Input Station-Offset from** will prompt for the station and offset distances. The Read File option will read the stations and offsets from a text file. The text file format is comma delimited with point number, station, offset and elevation. The station should be just the station number without the ‘+’ (i.e. 250 instead of 2+50). The elevation is optional. The Read File option is a quick routine to convert a station-offset data file into coordinates.

When **Offset Prompt** is set to Both Left-Right, the program will prompt for left and right offsets. If you respond to an offset prompt with zero (0), no offset point is created. The Single Offset option will prompt for one offset per station. Enter a right offset with a positive value and a left offset as a negative value.

Use **Station Type** to specify the stationing format to use.

Use **Type of Curve** to specify whether the curves are for a roadway or railroad.

**Prompts**

**Offset Point Settings Dialog**

Polyline should have been drawn in direction of increasing stations.

Select Polyline near endpoint which defines first station.

[nea on] Select Polyline to Station-Measure: select a polyline

(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63

Distance from beginning station along centerline (Enter to end): 110

Starting Segment Station: 0.0 Ending Segment Station: 228.633

Working Line segment...(5413.4 4879.64 0.0)

Left offset distance <10.0>: 15
Right offset distance <15.0>: 20

Distance from beginning station along centerline (Enter to end): press Enter

**Keyboard Command:** offpts

**Prerequisite:** A centerline (.CL) file, polyline, or two points

**File Name:** \lsp\offpnts.lsp
Calculate Offsets

This command calculates the station and offsets of point coordinates relative to a centerline. The points to calculate can be stored in a coordinate (.CRD) file or picked on the screen. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example).

Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

Maximum Offset to Calc: This is the maximum distance from the Centerline for which offsets are calculated.

Report Offsets Ahead/Behind Centerline: When checked, this option shows offsets for points or picked points located before the beginning station and after the ending station of the centerline.

Label Station and Offsets: When checked, the station offsets will be labeled in the drawing.

Sort Report by Stations: When checked, this option will report the station-offsets in station order no matter what order the points were calculated.

Report Point Coordinates: When checked, this option will include the point northing and easting in the report.
**Report Point Notes:** When checked point notes will be included on the calculate offset report.

**Create Point Notes:** When checked, the station and offset of the offset point will be created as notes and written to a note file (*.not). This note file will have the same name as the crd file.

**Use Report Formatter:** When checked, the output of this command is directed to the Report Formatter which allows you to customize the layout of the report fields and can be used to output the data to Microsoft® Excel or Microsoft® Access. You must check this option on in order to use the Report Grade Elevation From option.

**Round Stations:** When checked, this option will round the stations for the selected points on the report to the Rounding Interval specified. For example if an offset point is located at station 1+01, and the rounding interval is set to 10, then the report will show the offset point at station 1+00.

**Store Station Text to CRD File:** When checked, the station offset text is appended to point numbers that are selected.

**Report Grade Elevation From:** When checked, this option will calculate an elevation for each point from a 3D polyline, grid file (.grd) or triangulation (.flt) file. To Use this option, the Report Formatter must be toggled on. The grade elevation is reported and compared with the point elevation to report the cut/fill. For the 3D polyline option, the grade elevation is calculated by finding the elevation at the point on the 3D polyline that is the nearest perpendicular position from the offset point. The 3D polyline that is used for elevations does not need to be the same polyline that is used as the centerline for the station-offset calculations.

**Define Centerline by:** Specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

**Station Type:** Specify the stationing format to use.

**Decimals:** Specify the display precision for the stations and offsets.

**Type of Curve:** Specify whether the curves are for a roadway or railroad.

**Prompts**

**Calculate Offset Settings Dialog**
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline Centerline: select polyline centerline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
PtNo. North(y) East(x) Elev(z) Description
140 4889.13 5410.25 0.00 1+10.00L10.00 Station on Line
141 4870.15 5416.55 0.00 1+10.00R10.00 Station on Line
+ before station denotes point is ahead of line segment, - denotes beyond.
Pick point or point numbers (Enter to End): 22-28

<table>
<thead>
<tr>
<th>Station</th>
<th>Offset</th>
<th>Description</th>
<th>Elev</th>
<th>Pt#</th>
<th>North</th>
<th>East</th>
</tr>
</thead>
<tbody>
<tr>
<td>4+95.89L</td>
<td>15.48</td>
<td>Catch Basin</td>
<td>0.00</td>
<td>22</td>
<td>4811.00</td>
<td>4454.00</td>
</tr>
<tr>
<td>5+78.43L</td>
<td>58.18</td>
<td>Power Pole</td>
<td>0.00</td>
<td>23</td>
<td>4839.00</td>
<td>4548.00</td>
</tr>
<tr>
<td>6+77.26L</td>
<td>57.28</td>
<td>Power Pole</td>
<td>0.00</td>
<td>24</td>
<td>4868.00</td>
<td>4656.00</td>
</tr>
<tr>
<td>9+01.55R</td>
<td>16.81</td>
<td>Catch Basin</td>
<td>0.00</td>
<td>25</td>
<td>4745.00</td>
<td>4887.00</td>
</tr>
</tbody>
</table>

Chapter 13. Centerline Menu
Centerline Conversions

There are twelve Import options available in Carlson Civil to convert other applications' centerline files to Carlson Civil centerline files (.CL), and five Export options to convert Carlson Civil centerline files (.CL) to other applications' formats. Each Import option prompts for the file to convert and the name of the new .CL file to create, each Export option prompts for .CL file to convert and a file name for the new file.

Pulldown Menu Location: Centerline > Centerline Conversion
Keyboard Commands:
File Names: \lsp\cogoutil.arx
This chapter provides information on using the commands from the Area/Layout menu to calculate and label areas, and also to set and define lots. Commands for designing and drawing more complex configurations, such as cul-de-sacs and intersections, are available here as well.
Area Defaults

This command allows you to specify default settings for area labeling. The top portion of the Area Defaults dialog lists ten area values. For each value, you can specify a value under the Order# column, a Prefix and a Suffix. The area label will include the values in the order specified. If an Order# is left blank, that value is not labeled. Both prefix and suffix controls are included here, although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically. Keep in mind that changes in Area Defaults, if changed in the Area pulldown menu, only apply to that work session. If changed within the Configure command, the changes apply to all new work sessions as well.

Sequence: The top portion of the dialog lists ten area values. For each value, you can specify a value under the Order# column, a Prefix and a Suffix. The area label will include the values in the order specified. If an Order# is left blank, that value is not labeled.

Precision for Square Units Labels: Choose precision level for labeling Square Feet, Square Yards, Square Miles, Square Meters, and Square Kilometers.

Precision for Other Area Labels: Choose precision level for labeling Acres, Cuerdas, and Hectares.

Precision for Inverse with Area: Choose precision level when using Inverse with Area.

Label Area with +/-: This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

Use Commas in Labels: This allows you to use commas in the area labels.

Label Both Feet & Meters for Inverse with Area: When this option is turned ON, both feet and meters will be shown in the Inverse with Area report.

Layer for area text: This allows you to assign a layer for the area text.

Style for area text: This allows you to set a text style for the area labels.

Area text size scaler: This value is multiplied by the horizontal scale to obtain the actual text size.

Max gap to join (Area by Lines and Arcs): You use this option during Area by Lines & Arcs command. When connecting lines and arcs that define the perimeter, the program will join endpoints if the distance between the two points is less than the specified gap. Otherwise the program will report an error and will not report an area.
**Different Radius Tolerance:** You use this option to check the difference between the PC-Radius and PT-Radius on curves. If the difference between these distances is greater than this tolerance, an accurate area calculation cannot occur and the command displays a warning. This setting is used in Inverse, Inverse With Area, Hinged Area and Sliding Side Area.

**Prefix/Suffix:** Although most area labeling uses the suffix as in 1.25 Acres or 3.515 Hectares, those who prefer a prefix as in Ac: 1.25 can create that area labeling style automatically. This control is shown in the dialog below. Keep in mind that changes in Area Defaults, if changed in the Area pulldown menu, only apply to that work session. If changed within the Configure command, the changes apply to all new work sessions as well.

**Load/Save:** These buttons save and recall all the Area Default settings to a .ARS settings file.

---

The **Area Table Settings** button from the main dialog brings up the Table Settings shown above. The area table option puts the area data in a table that is typically drawn outside the area and contains area data for multiple areas. Each row in the table has the data for one area and includes a reference number. The reference number is also labeled inside area.

**Always Use Area Tables** will label all the areas with the table regardless of the area size. The **To Table Area** will only use the area table for areas less than the specified amount. If you don't want to use area tables, set this amount to zero.

**The Area Label Prefix** is used for the reference number.

There are three different methods for setting the reference number: **Next Available** will automatically use the lowest available number. **Specified With Prompt** will prompt you for a number for each area. **Specified with Auto Numbering** will automatically use the lowest available number starting with the specified number.

**Auto Center Table References** will automatically place the reference number in the center of the area. Otherwise you will be prompted to pick each label location.

**Table Size** is a scaler that is multiplied by the current horizontal scale to size the table text size. **Table Layer** is the layer name for the area table entities.

The **Available/Used Fields** allow you to specified which fields to include in the table and their order.
The results of the using prefix with square feet and acres

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** defarea  
**Prerequisite:** None  
**File Name:** \lsp\defarea.lsp, \lsp\scadarea.dcl

### Inverse with Area

This command generates a report of the bearing and horizontal distance between a series of points, and calculates the area of the closed figure defined by the points. Curve data can also be entered and reported. The points can be either picked on the screen, or entered by point number. You can also enter a range of point numbers (i.e. 1-9). The closure is reported using the total distance inversed, and the difference between the starting and ending points, as the closure error. There is an option in Area Label Defaults to report the distances in both feet and meters. The area can be labeled in the drawing using the settings from the *Area Label Defaults* command. If you don't want to label the area, press Enter at the pick label point prompt. This command creates a polyline of the figure which can be erased or kept in the drawing.

### Prompts

- **Station/ <Pick Starting point or point number>:** *pick a point*  
- **Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end):** *pick a point*  
- **Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end):** *R for radius*  
- **Radius point number or pick point:** *pick a point*  
- **Curve direction [Left/<Right>]:** *press Enter*  
- **Pick End of Arc or point number (U-Undo,Enter to end):** *pick a point*  
- **Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end):** *pick a point*
Inverse with Area 05/19/2005 13:07

CRD File> c:\scad2006\data\newplat.crd

<table>
<thead>
<tr>
<th>PNTNO</th>
<th>BEARING</th>
<th>DISTANCE</th>
<th>NORTHING</th>
<th>EASTING</th>
<th>STATION</th>
<th>DESC</th>
</tr>
</thead>
<tbody>
<tr>
<td>903</td>
<td>4940.73</td>
<td>2490.40</td>
<td>0.00</td>
<td>StartPt</td>
<td></td>
<td></td>
</tr>
<tr>
<td>904</td>
<td>S 48°43'58'' W 136.21</td>
<td>4850.89</td>
<td>2388.01</td>
<td>136.21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>905</td>
<td>S 13°07'04'' E 155.56</td>
<td>4699.39</td>
<td>2423.32</td>
<td>291.77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>906</td>
<td>S 73°55'04'' E 165.34</td>
<td>4653.59</td>
<td>2582.19</td>
<td>457.11</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RADIUS: 111.45 CHORD: 204.07 DEGREE: 05°08'28'' DIR: LEFT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>LENGTH: 257.86 DELTA: 123°33'53' TANGENT: 253.67</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CHORD BRG: N 39°47'59'' E RAD-IN: N 16°04'56'' E RAD-OUT: S 63°31'03'' W</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>907</td>
<td>N 4760.67 E 2613.06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>908</td>
<td>4810.37</td>
<td>2712.82</td>
<td>714.97</td>
<td>IP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>909</td>
<td>N 26°28'57'' W 125.87</td>
<td>4923.03</td>
<td>2656.69</td>
<td>840.84</td>
<td></td>
<td></td>
</tr>
<tr>
<td>903</td>
<td>N 83°55'30'' W 167.23</td>
<td>4940.73</td>
<td>2490.40</td>
<td>1008.07 StartPt</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Closure Error Distance> 0.0000
Total Distance Inversed> 1008.07
AREA: 74664.6 SQ METERS

Point number (R-RadiusPt,U-Undo,Enter to end): pick a point
Point number (R-RadiusPt,U-Undo,Enter to end): pick a point
Point number (R-RadiusPt,U-Undo,Enter to end): press Enter
SQ. FEET: 27247.4 SQ. YARDS: 3027.5 SQ. MILES: 0.0
ACRES: 0.63 PERIMETER: 668.35
Pick area label centering point: pick a point
Erase Polyline Yes/No <Yes>: press Enter The command plots a polyline that represents the figure you defined if you want to keep the polyline respond with No.

Pulldown Menu Location: Area/Layout
Keyboard Command: ia
Prerequisite: None
File Name: \lsp\ia.lsp

Area by Lines & Arcs

This command allows you to calculate the area of a perimeter or lot defined by lines, arcs, or polylines. Default settings for this command are set in Area Defaults. One of these settings is Max gap to join. If there is a gap greater than this value, the area is not reported, and the program will show where the gap is with a temporary X symbol. The area data shows up on the text screen. You can then choose to plot the area information to the drawing, or, by...
Prompts

**Select lines & arcs or polylines of perimeter for area calculation.**

Select Objects: *select lines and arcs or polylines*

Lines and arcs are then joined together and the area calculated.

**Pick area label centering point (Enter for none):** *pick a point*

The area is then plotted at the point selected.

---

**Area by Interior Point**

This command calculates and labels the area of the perimeter surrounding a picked interior point. The **Boundary Polyline** command is used to find the perimeter. Generally, this command will only work on closed or overlapping objects. Use **Area by Lines & Arcs** for other applications.

Prompts

**Pick point inside area perimeter:** *pick a point*

**Pick area label centering point (Enter for none):** *pick a point*

The area is then plotted at the point selected.

---

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** joinarea

**Prerequisite:** Lines, arcs, or polylines to define the area

**File Name:** \lsp\joinarea.lsp

---

**Area by Interior Point**

This command calculates and labels the area of the perimeter surrounding a picked interior point. The **Boundary Polyline** command is used to find the perimeter. Generally, this command will only work on closed or overlapping objects. Use **Area by Lines & Arcs** for other applications.

Prompts

**Pick point inside area perimeter:** *pick a point*

**Pick area label centering point (Enter for none):** *pick a point*

The area is then plotted at the point selected.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** ptarea

**Prerequisite:** Set Area Label Defaults

**File Name:** \lsp\ptarea.lsp
Area by Closed Polylines

This command will calculate and report the area of single area and multiple area closed polylines. Area by Closed Polyline will also automatically find special Carlson attributes attached to the polyline, in addition to capturing the area itself. These attributes will appear in the report, which can be the standard report or which can be presented in the Report Formatter, which itself links to Excel and Access. For example, property names and owner names, as applied to a polyline using the Mine modules, will report out automatically using Area by Closed Polyline. The command "Draw Lots from File..." will apply "extended entity data" to the lot polylines, which includes the lot name, and this will also report out when using Area by Closed Polyline. In addition, lot names, or any interior text whatsoever, can be captured and included in the report. The plot of the area on-screen can be canceled if only the report is desired.

Prompts

Select Area Polyline: select the area polyline
SQ. FEET: 64862.9 SQ. YARDS: 7207.0 SQ. MILES: 0.0
ACRES: 1.5 PERIMETER: 1018.7
Pick area label centering point (Enter for none): pick a location

When additional interior text is selected, the standard report will include that text:

Polyline Area 11/17/2004 12:49
Polyline Area: 43560.0 sq ft, 1.00 acres
Polyline Perimeter: 838.35 ft
Text: 16 Sf: 43560.0; Ac: 1.00

In this case, the "16" refers to Lot 16, and appears in the report because the lot number and existing area labeling were selected along with the polyline for the lot.
Digitize Areas

This command allows for digitizing areas. This routine includes an option for drawing perimeter polylines.

Pulldown Menu Location: Area/Layout
Keyboard Command: dig_area
Label Last Area

This command will label the last area calculated with one of the Area commands in the manner defined in the Area Defaults dialog. The command prompts for a point where the label will be centered.

Prompts

SQ. FEET: 50265.3 SQ. YARDS: 5585.0 SQ. MILES: 0.0
ACRES: 1.2 PERIMETER: 889.4
Lot Description <2>: 1

Pick area label centering point (Enter for none): pick a point

Tag Area Descriptions

This command is one of three routines used to assign and report area descriptions. This command adds a tag to the closed area. The existing polyline must be closed.

Prompts

Select polyline for area description: pick a polyline
Area description <AREA1>: 
Identify Area Descriptions

This command is one of three routines used to assign and report area descriptions. This command adds a tag to the closed area. Therefore, the existing polyline must be closed.

Prompts

Select polyline for area description: pick a polyline
Area description <AREA1>:

Untag Area Descriptions

This command is one of three routines used to assign and report area descriptions. This command adds a tag to the closed area. The existing polyline must be closed.

Prompts

Select polyline for area description: pick a polyline
Area description <AREA1>:

Hinged Area

This command can be used to determine the dimensions of a figure when the area is fixed and three or more sides are known. The figure can be defined by a closed polyline or by picking the known points and curves. The command then prompts for the area to be solved for (in square units and acres).

Prompts

Define area by points or closed polyline [Points/Linework]? press Enter
Select polyline segment to adjust: select a polyline segment
Select hinge point [endp]: Move the cursor around to find a hinge point.
Keep existing polyline [Yes/<No>]? N
Area: 47104.31 S.F, 1.0814 Acres
Remainder/Acres/<Enter target area (s.f.)>: 48000

Polyl ine method

Pull down Menu Location: Area/Layout
Keyboard Command: harea
Prerequisite: A closed polyline or at least one known side. Two direction lines should be drawn.
File Names: \lsp\harea.lsp, \lsp\cogoutil.arx

Sliding Side Area

This command adjusts one side of a polyline to meet a specified area. The existing area can be defined by a closed polyline or by picking each point in the perimeter. The desired area can be entered in either square feet or acres. The area to adjust must be represented by a closed polyline. The program moves the selected segment of the polyline in or out. The original direction of the segment is maintained.

Prompts

Define area by points or closed polyline [Points/<Linework>]? press Enter
Select polyline segment to adjust: pick a point on a closed polyline
Keep existing polyline [Yes/<No>]? press Enter
Area: 176044.14 S.F, 4.0414 Acres
Remainder/Acres/<Enter target area (s.f.)>: 17800
Linework Polyline method:
Original perimeter polyline on left, adjusted perimeter on right

Points method

Pulldown Menu Location: Area/Layout
Keyboard Command: ssarea
Prerequisite: A closed perimeter polyline
File Name: \lsp\sarea.lsp

**Area Radial from Curve**

This command swings a line radial from a curve to reach a predetermined area. The existing area can be defined by polylines or by picking each point on the perimeter. For the point method, the curve to radiate from should be the last entity selected when defining the figure. For the polyline method, front and back polylines are used. The computed line goes perpendicular from the front polyline and intersects the back polyline. This line is moved to find the target area. Both ends of the front and back polylines are connected to close the area. The options for the polyline method are set in the dialog shown.

**Prompts**

Define area by points or closed polyline [Points/Linework]? press Enter
Area Radial from Curve dialog Make choices and click OK.
Select curve to radiate from: pick the curve
Select back polyline: pick the back polyline
Lot Area: 9000.00 S.F., 0.2066 Acres
Bearing Area Cutoff

This command is capable of working with a "U" shaped figure, from which you desire to cut out a predetermined area on a specific bearing. The lines where the cut-off bearing line intersects can be either straight lines or arcs.

Prompts

Units for area [<Acres>/Square-feet]: Type in A for acres or S for square feet.
Acres to cut off <0.000000>: This is asking you the number of acres necessary for the desired area to contain.
Enter cut-off bearing <100.0000>: Enter the bearing of the cut-off line through the property.
Area to right or left of bearing [<Right>/Left]: Select whether you want the area to be left or right of the cut-off bearing.
Enter points individually or pick a polyline. [Polyline/<Individual>]: P
Pick a polyline whose vertices correspond to desired property corners:
Select objects: pick a polyline

Lot Layout

This command draws lots based on a front and back polyline. Starting from the front polyline, the program calculates two lot side lines perpendicular from the front polyline that intersect the back polyline and create the specified lot size. Lots are created along the front polyline in the order that the front polyline is drawn. If the front polyline needs to be reversed, use the Reverse Polyline command found on the Edit menu. The direction of the back polyline does not matter. The lots can be drawn as closed polylines or just the lot sides can be drawn. There is also an option to automatically create all the possible lots at the specified area between the front and back polylines or to prompt for each 0.4 acre lot.

In prompt mode, the program reports the remaining area between the front and back polylines and then asks for the lot size. The lot size can be specified either by area or frontage along the front polyline.

The lots are sized to meet the specified area and also meet the minimum frontage and backlot distances. The program starts by checking the lot area at the minimum distances. If this area is greater than the target, then the lot is drawn at the minimum distance and the resulting lot area will be greater than the target area. Otherwise the program will increase the frontage until the lot reaches the exact target area. The Use Frontage Setback Polyline option allows you to use another polyline besides the actual frontage polyline for the minimum frontage indicator. Typically, this Frontage Setback Polyline would be offset a set amount from the actual frontage polyline.
Prompts

Lot Layout dialog
Select front polyline: *pick a polyline*
Select back polyline: *pick a polyline*

With prompt for each lot active:
Area remaining: 160326.88 S.F, 3.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.2269>: 1
Area remaining: 116766.88 S.F, 2.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: F
Enter Frontage <50.00>: 75
Lot Area: 37807.50 S.F., 0.8679 Acres
Area remaining: 78959.38 S.F, 1.8127 Acres
Quit/Area/Enter frontage <50.00>: A
Quit/Frontage/Enter lot area (Acres) <1.0000>: press Enter
Area remaining: 35399.38 S.F, 0.8127 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: Q

Polylines for Lot Layout
The Front Polyline goes from right to left
Offsets & Intersections

This command takes a set of centerline polylines and calculates the series of offset polylines using the user defined offset and fillet radius values. The function recognizes primary and secondary roadways which allows for different offsets and fillet radii to be specified for each. Up to seven sets of offsets and radii can be defined for different features such as edge of pavement, right-of-way, sidewalk, etc. Each set also has a layer name and description. The Pick button lets you set the layer name by picking an entity with that layer in the drawing. The description is for your own information and is not used by the program.

Multiple centerline polylines can be processed together which allows for the creation of an entire set of roadway offset polylines in one step. Intersections are calculated based on the centerlines selected and the fillet radii are applied at the intersections. The Smooth Interior and Exterior Corner options will fillet bends in the offset polylines. Otherwise turns without an arc in the original centerline will become straight corners in the offset polylines. The results of the calculations for the given parameters may be previewed in the dialog. Zoom and pan are available by clicking and dragging mouse on the preview image (zoom or pan mode is selected by a toggle). Once the satisfactory offsets are calculated, they are inserted into the drawing by clicking on Finish2D button. The Finish 3D button opens the Elevate 2D Polylines command, described in this chapter.

If it is preferable to handle intersections manually, you may run the command multiple times on non-intersecting centerlines. Another alternative is to use the Offset command in the Draw menu and the Fillet command in the Edit menu.
Prompts

Select all PRIMARY road polylines.
Select objects: select polylines
Select objects: Enter
Select all SECONDARY road polylines.
Select objects: select polylines
Select objects: Enter
Calculating offsets for layer EOP...
Calculating offsets for layer ROW...

Pulldown Menu Location: Area/Layout
Keyboard Command: wayint
Prerequisite: Centerline polylines
File Names: \lsp\wayint.lsp, \lsp\poly3d.arx

Cul-de-Sacs

This command uses a polyline centerline and the offset polylines to create a cul-de-sac. These offset polylines can be generated by the Offsets & Intersections command, or with the standard Offset command. The layer names of the offset polylines must match the layer names set in the dialog.

To run this command, pick a set of polylines and point on roadway centerline where the cul-de-sac center is. For cul-de-sacs with an offset center, pick a projection of that center onto the centerline and specify an offset distance (positive value is offset to the right, negative - to the left). Like the Offsets and Intersections command, a preview is shown of the cul-de-sac being designed. Any of the cul-de-sac parameters may be modified and reviewed before the cul-de-sac is applied and the drawing is modified with the Finish 2D button. The Finish 3D button opens the Elevate 2D Polylines command described in this chapter.
Bend cul-de-sacs are created by selecting offset entities on one side of the centerline.

**Prompts**

**Select all offset polylines to end with cul-de-sac.**

**Select objects:** *make selections*

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** stdcul

**Prerequisite:** A set of offset polylines and roadway centerlines.

**File Names:** \lsp\stdcul.lsp, \lsp\poly3d.arx

**Elevate 2D Polylines**

This command allows to assign elevations to a selection of polylines based on elevations along supplied 3D centerline and user-defined slopes. This routine calculates a distance from each vertex of 2D polyline to a specified 3D reference polyline and uses that distance and slope to calculate a 3D offset to a corresponding point on 3D polyline.

You can specify either the original centerline to be a reference 3D polyline or use another set of offset polylines. For example, you could specify the edge of pavement elevation to be relative to the curb elevation, while curb elevation is calculated based on the centerline elevation. You can view the resulting road/intersection design in 3D, making changes and updating picture on-the-fly. Local sink points can be reported instantly by evaluating a resulting triangulation to predict low points in the design leading to water retention.
After selecting entities

Another road/intersection design, this time in 3D

**Prompts**

Select all offset polylines for the intersection.
Select objects: *select entities*
Select all 3D profile polylines.
Select objects: *select entities*

**Pulldown Menu Location:** Area/Layout
**Keyboard Command:** 3dintersect
**Prerequisite:** A set of offset polylines and roadway centerlines
Parking

This command draws a series of parking stalls or equilateral lot lines. The command prompts for stall width, stall parking angle, side for stalls and stall depth. Stalls can be located by the number of stalls in a direction, as many as fit between two points, or along a polyline.

Prompts

Parking Settings dialog make selections
Starting point? pick a point
Pick point or point number:
Ending point? Pick point or point number: pick a point
Created 58 stalls.

Set Back Measure-Move

This command can be used to measure the perpendicular distance of 1 or 2 points to 1 or 2 lines. This can be helpful in placing buildings for proper setback from lot lines. After selecting the lot lines and the building, the command allows you to drag the building while a real time display on the side-bar menu shows the perpendicular distances to the lot lines. After experimenting you can press T to type in the values to move to. The second line and point are optional.
Prompts

Select 1st Lot line to measure perpendicular from.
Select object: select line
Select 2nd Lot line to measure perpendicular from ([Enter] for none).
Select object: select line
Select entity to move at 1st point to measure from:
Select object: ENDPOINT of (Pick a point on polyline.)
Pick a 2nd point on entity to measure from ([Enter] for none). END of (Pick a point.) Pick another endpoint of the polyline representing the building.

Drag-Pick new Location or [T]ype in Move distance(s) [C] to Cancel: T Either drag the building to a location and press the pick button on your pointing device or press T to enter the distances.
You may have to use a negative distance to move to the proper side of lot line!
Distance from 1st line: 10
Distance from 2nd line: 20
The building is then moved to your specification.

Pull down Menu Location: Area/Layout
Keyboard Command: setback
Prerequisite: Lot lines and polyline representing the building should be plotted.
File Name: \lsp\bfitlin.lsp

Lot Network Settings

This command displays a dialog for the current Lot Network Settings which specifies the lot network name, road network name, label settings, setback settings and lot area tolerance.

Click Select for the Road Network Name and choose the Road Network file (.RDN).

Then select Edit for Line/Curve Label Settings. The Auto-Annotate dialog appears; accept the defaults and hit OK.
Then select Edit for Area Label Settings. The Area Defaults dialog appears; accept the defaults as they appear in the figure and hit OK.

The routine will also draw property setbacks. To do this select Settings for Draw Setback. Set the Front to 20.0, the Side to 10.0 and the Back to 10.0. Say OK.
The tolerance sets the level at which the area computations will go to be considered "correct".

The files involved in the process are all saved to an .LTN file that can be recalled, modified and re-processed.

Pulldown Menu Location: Area/Layout  
Keyboard Command: lotnet_config  
Prerequisite: None  
File Name: \lsp\eworks.arx

Lot Network Boundary

These are a collection of commands to assign and verify the site boundary for lot network. Sets the site boundary. It must be a closed polyline.

Indicates the boundary to the user by highlighting it.

Indicates the boundary to the user by hatching it.

Erases the hatched boundary for the user.

Deletes the boundary designation from the polyline.

Pulldown Menu Location: Area/Layout  
Keyboard Command: lotnet_limit, lotnet_highlight_limit, lotnet_hatch_limit, lotnet_hatch_erase, lotnet_untag_limit  
Prerequisite: None  
File Name: \lsp\eworks.arx

Input-Edit ROW Offsets

This command defines the ROW offsets for the Road Network for Lot Networks. The ROW offsets are for the frontage polylines to the left and right of the centerlines. Besides the ROW, you can also define additional offset polylines to be drawn. These additional offset polylines do not effect the lot network.
Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_row
Prerequisite: None
File Name: \lsp\eworks.arx

LotNet Road Network

This command develops the linework, geometry and labeling for subdivision, commercial and industrial sites by using the familiar RoadNet interface and pre-defined settings. The program docks a dialog on the left of the screen identifying the geometry settings and all road files and leaves an active CAD screen and command line. You can save drawings and run virtually any standard AutoCAD command while within the docked dialog. Once you identify centerlines for the road network, the program detects intersections and end segments suitable for cul-de-sacs, and through input of design parameters for offset criteria, cul-de-sac dimensions and intersection transitions, the program will process the complete geometry layout, with output options including creating Lot files for later reference and a variety of labeling options for such items as Areas, Distances and Bearings. The road network settings are saved in a .RDN file.
Before running the Road Network, use the following procedure to setup the lot labeling settings and site boundary.

1. Click the Lot Network Settings button. Note that you can use the Area/Layout Menu pulldown to access these commands as well. Select or create a lot network settings file.

2. Next, select the Set Boundary icon. Select a closed polyline for the boundary around your site.

3. Next select the Road Network icon. When prompted, select the .RDN file from the Existing tab. This is where the centerlines involved for the subdivision will be defined and added to the Road Name area of the panel. These centerlines are standard Carlson .CL files. Click a centerline and choose Edit. If a CRD file is requested choose or create a .CRD file. The Edit Road dialog appears. The centerline can be selected here and these centerlines can be edited on the fly if needed. For ROW Offsets, we are using the Row-OFF-a.Row file. Click Edit. The ROW offsets dialog displays. Use the defaults of 45’ left and right and note that additional graphics can be automatically generated by hitting Add and entering additional values, names and layers. Hit Exit.

Note also that Optional Input files can be attached to the process for roadway widenings based on the standard Carlson Road design tools of the same name. This is where a polyline indicating where the roadway template ID's should be tapered or widened is developed into a Centerline file and attached to the roadway template involved. Refer to the Road Design documentation for this information. Hit OK to close the Edit Road dialog. These settings can be set and altered for each road in the network.

Next click on one of the intersections you may have and select Edit Intersection. In the Edit Intersection dialog, the intersection's radii can be set. Click on the Front Left or Front Right to verify this. Hit OK when ready.
The program can also develop cul-de-sacs for the subdivision, although this example doesn’t require one. To see how it works, click Add under Cul-de-sac’s area of the panel. The Select Road for Cul-de-sac dialog appears. Select the road for the Cul-de-sac and the Edit Cul-de-sac dialog opens. Then as shown in the figure, choose whether the cul-de-sac occurs at the beginning or ending of the roadway, provide a cul-de-sac radius and fillet radius and any other criteria to develop the graphics as desired. Since we do not have a cul-de-sac in this example we will skip this step.

Next select Settings at the bottom of the RoadNet panel. Use a radius of 25.0 and turn on the Create Lots toggle and click Settings. Set the values as shown in the Create Lot Settings dialog below. Then hit OK and OK to exit.
In the RoadNet panel click Save or Saveas to save these settings for your own experimentation.

Now Click Process to begin the lot layout. You will notice the ROW's and EOP's being generated, followed by the lot lines. Then areas are labeled and setbacks are created. Finally, the lotlines are labeled with distances, bearings and arc data.
Lot Network Linework

The following commands allow for the Lot Network to be manipulated after the processing. The commands allowing this are:

- **Add a ROW polyline into the model.** By clicking this command, the software asks for the user to select the new ROW polyline. It then reprocesses the site based on this new ROW data and relocates the EOP for this portion of the roadway.

- **Add a lot edge to the model.** The software may request a Lotnet Settings file and if so create or select it. The software prompts with: Select Edge linework to add to model: Select the polyline you drew in the lot representing the new lot edge. The software reprocesses the site based on this new data and redevelops the lot layout accordingly.

- **Take a property line out of the model.** Select the edge in question when prompted.

- **This command allows for adding a new property corner to an existing lotline.** Simply select the lot edge in question and then pick the point to be added using a snap or other means.

- **This command allows for moving a lot corner.**

- **This command allows for eliminating a lot corner.** Simply select the lot edge in question and then the corner to be removed.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** Lotnet_Add_Row, Lotnet_Add_Edge, Lotnet_Remove_Edge, Lotnet_Point/Add, Lotnet_Point/Edit, Lotnet_Point/Remove

**Prerequisite:** None
Lot Network Subdivide Area

This command subdivides an area into smaller parcels. The command starts with the Create Lot Settings dialog. Set the settings and pick OK. Next the command prompts to pick a point within the parcel to subdivide. Then select where on the frontage to begin the lot creation. Note the program highlights the frontage involved. Note also that whether the entire subdivision re-labels itself is based on the Lot Network Settings toggle for Automatic Labels.

Lot Network Sliding Side Area

In this routine a lot side can be altered to reflect a new target area. It will hold its angle and slide along the front and back lot lines until it has achieved the desired area. When running the routine, Select the lot in question when asked to pick inside lot to adjust and then select the lot edge to adjust. Then the prompt asks Acres/<Enter Target Area(sf)>: Type in the desired area you are trying to obtain and the system computes it.

Lot Network Hinged Area

In this routine a lot side can be altered to reflect a new target area. It will hold a lot corner and pivot, or rotate until it achieves the desired area. The procedure is as follows:
Pick inside lot to adjust: Select a point inside the lot to modify.
Select lot edge to adjust: Select the edge that will move. The routine will report the current area to you and then ask for your desired area.
Current Area: 22494.5 SF 0.516 Acres
Acres/<Enter Target Area (sf)>: 10000

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_harea
Prerequisite: None
File Name: \lsp\eworks.arx

Lot Network Labels

These are a collection of commands to draw lot network area, line and arc labels.

Deletes the labels in the model and re-labels the linework based on the LTN file settings.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_update, lotnet_redraw
Prerequisite: None
File Name: \lsp\eworks.arx

Lot Network Report

This command generates a summary report of the areas and number of lots in the lot network model. For a detailed report of the lot data, output the lot network to a .lot file and run the Report function inside Lot File Manager.

Lot Network Report

File: C:\Carlson Projects\Clearwater Oaks.ltn

Total Area: 20.520 acres, 893839.8 sf
Lot Area: 17.600 acres, 766648.4 sf
ROW Area: 2.920 acres, 127191.3 sf
Other Area: 0.000 acres, 0.0 sf
Number of Lots: 50

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_report
Prerequisite: None
File Name: \lsp\eworks.arx

Lot Network Inspector

This command shows a dynamic report of the lots as the cursor passes over them. The program has a small dialog that shows the lot number, area, perimeter and frontage.
Lot Network Renumber Lots

This command allows you to renumber the lot number for selected lots. The program prompts for the Starting Lot Name: where the new value can be types, such as 200 for the new starting number. It then says Pick point inside lot to start renumbering: so you would pick inside the desired lot. The routine then asks for the Next direction point for renumbering: and you must pick into the next lot to continue or cross over several lots in one pick to include all of those lots in the renumbering process.

Lot Network Output To Lot File

This command will develop a .LOT file containing the points to define the lots. The points are stored into the current coordinate file. The .LOT file by the collection of Lot File commands including Lot File Manager.

Set Lot File

This command sets the lot (.LOT) file name that other lot routines will automatically reference. The lot (.LOT) file stores a list of lots with each lot being a list of point numbers which reference coordinates stored in a coordinate (.CRD) file.
Design Lot

This command creates lot definitions that are stored in a lot (.LOT) file. The lots are defined by entering a sequence of point numbers. The point numbers reference coordinates from the current coordinate (.CRD) file. Each lot has a lot name and block name. The lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines. Curves are entered by first specifying the PC point number, then type R for radius and enter the radius point number followed by the PT point number.

Prompts

Lot Name <1>: 105
Block Name <1>: press Enter
Lot Starting Station <0.0>: press Enter
If the figure that you are entering is a centerline, then you could use this as the starting station of the centerline.
Starting point number: 17
Point number (R-RadiusPt,U-Undo,Enter to end): 18
Point number (R-RadiusPt,U-Undo,Enter to end): 19
Point number (R-RadiusPt,U-Undo,Enter to end): R
Radius point number: 20
Use large included angle for curve (Yes/<No>)? press Enter
End of curve point number (R-RadiusPt,U-Undo,Enter to end): 21
Point number (R-RadiusPt,U-Undo,Enter to end): 22
Point number (R-RadiusPt,U-Undo,Enter to end): 17
Point number (R-RadiusPt,U-Undo,Enter to end): press Enter
Enter another lot (<Yes>/No)? N

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: mklot
Prerequisite: Points in a coordinate (.CRD) file
File Name: \lsp\cogoutil.arx

Polyline to Lot File

This command will create lot (.LOT) files from selected polylines. The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found. Each lot has a lot name and block name. Lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines.

Prompts

Polyline To Lot File Options Dialog enter in values
After entering in the Starting Point Number, points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline

Select lot polyline:
Lot Name <LOT 19>:
Created 3 lot points.
Select lot polyline (Enter to end):
Lot Name <LOT 20>:
Created 3 lot points.
Select lot polyline (Enter to end):
Lot Name <LOT 21>:
Created 3 lot points.
Select lot polyline (Enter to end):
Select lot polyline: pick a polyline
Lot Starting Station <0.0>: press Enter
Lot Name <106>: press Enter This defaults to the next available name.
Block Name <1>: press Enter
Lot Starting Station <0.0>: press Enter
Created 7 lot points.
Select lot polyline (Enter to end): press Enter

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: pl2lot
Prerequisite: A polyline
File Name: \lsp\cogoutil.arx

Lot File by Pick Interior
This command is used to create a lot by picking a point, and having the program figure the enclosing linework.

creates lot definitions from the selected polylines and text. For each text entity, the program finds the bounding polyline around the text. The text is used as the lot name. The polylines do not need to be closed themselves but selected together they should define closed areas. Multiple lots can be created at once with this command. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Draw Lot File. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Draw Lot File. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Draw Lot File. If a point number is at the corner of four lots, moving that one point number will cause Draw Lot File to draw differently all four lots.

Prompts
Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Select objects: press Enter
Created 3 lots.

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: txt2lot
Lot File by Interior Text

This command creates lot definitions from the selected polylines and text. For each text entity, the program finds the bounding polyline around the text. The text is used as the lot name. The polylines do not need to be closed themselves but selected together they should define closed areas. Multiple lots can be created at once with this command. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Draw Lot File. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Draw Lot File. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Draw Lot File. If a point number is at the corner of four lots, moving that one point number will cause Draw Lot File to draw differently all four lots.

Prompts

Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Select objects: press Enter
Created 3 lots.

Lot Manager

This command combines Input-Edit Lot capabilities with, Draw Lot and Report Lot into one command. It comes with spreadsheet data entry for lot data, with dynamic graphic preview. There are added functions for changing
the direction of the lots, to change the point of beginning for the lots, and to save and load lot name selections.

![Lot Editor window](image)

**Prompts**

Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lin ......................

Pulldown Menu Location: Area/Layout
Keyboard Command: editlot
Prerequisite: Polylines and text
File Names: \lsp\cogoutil.arx

**Lot Inspector**

This command activates a small pop-up window that when you place your pointer into a lot file area, the details of that lot file will be displayed in the Lot Inspector window.
Prompts

Move pointer inside lots (Pick to edit, Enter to End) hover crosshairs above lot(s)

Pulldown Menu Location: Area/Layout
Keyboard Command: lotinspector
Prerequisite: None
File Name: \lsp\cogoutil.arx

Define Lot Attributes

This command allows the user to define the Lot Type, Lot Attributes and Point attributes. With the use of the opening Lot Attribute Definitions dialog box, shown below, this routine allows you to edit, add, remove or reposition all of these definition types. You can save the selected data to a new Lot Attribute Definition file (LTD). You are also able to load an existing LTD file to work with.

The Lot Types section of the dialog lists out the Lot Type and the layer associated with it.
You can set up different lot types and a layer. When the lots are drawn, the layer name is used per lot type. Also, Lot Types are used in the lot report. There are also Lot Attributes, which are additional fields that you can define for the lots, such as deed number. And there is also Point Attributes.

**Edit/Add:** Both the Edit and the Add buttons bring up the same Lot Type dialog, shown here. You can edit an existing lot or add a new one.

The **Lot Attributes** section asks for the Name and to enter the Data Type.

**Edit/Add:** Edit or add the name of the lot attribute. Choose from one of the four options for Data Type: Real, Integer, String or Document.

Similarly, the **Point Attributes** section also asks for the Name and to enter the Data Type.
Remove: Any of the Remove button will remove a lot type, lot attribute or point attribute from the list above it, depending upon which Remove button you use.

Up/Down (all three): Types and attributes can be repositioned.
Track Original Coordinates: This option will track the original coordinates of the lot so that this record may be kept for your future usage and needs.
Load: A Lot Attribute Definition file (LTD) can be loaded.
SaveAs: A new Lot Attribute Definition file (LTD) can be saved.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotattr
Prerequisite: None
File Name: \lspx\cogoutil.arx

Import Lot File From MDB Database
This command will import a lot file from a Microsoft Access database file (.MDB) format.

Prompts

Database File to Import dialog select existing .MDB file
Lot File to Write dialog select existing or create a new .LOT file

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotimport
Prerequisite: A lot (.LOT) file
File Name: \lspx\cogoutil.arx

Export Lot File to MDB Database
This Lot File Utilities command will export a lot file to a Microsoft Access database file format.

Prompts

Lot File to Export dialog select existing .LOT file
Database File to Write dialog select existing or create a new .MDB file

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotexport
Prerequisite: A lot (.LOT) file
File Name: \lspx\cogoutil.arx
Export Lot File To Old SurvCADD

This Lot File Utilities command will export a Carlson lot file to SurvCADD .LOT file format.

Prompts

Source Lot File to Export dialog select existing .LOT file
Destination Lot File To Write dialog create a new .LOT file

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotexport2
Prerequisite: A lot (.LOT) file
File Name: \lsp\cogoutil.arx

Set CRD File for Lot Files

This command allows you to set the coordinate (.CRD) file that is associated with any number of lot (.LOT) files. This can be useful if the name or location of the coordinate (.CRD) file is changed. In the Set CRD for Multiple Lots dialog, press the Select .LOT files button to select any number of lot (.LOT) files. They are added to the list. Next, press the Select .CRD file button. After you have selected the files, press the Process button.

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotscrd
Prerequisite: Existing lot (.LOT) file(s)
File Name: \lsp\lotscrd.lsp

Lot File to Centerline

This command creates a centerline (.CL) file from a lot (.LOT) file. Since the lot definitions contain a series of points and a starting station, the lot (.LOT) file contains the necessary data to create a centerline. The Select Lot to Convert dialog lists the available lot names in the current lot (.LOT) file. Select a single lot to process, then specify
the centerline (.CL) file name to create.

Prompts

**Centerline File to Write dialog**  enter new centerline (.CL) file name
**Select Lot to Convert dialog**  select a lot from the list

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lot2cl
Prerequisite: None
File Name: \lsp\cogoutil.arx
These menus include commands for labeling lines with bearing/azimuth and distances, special lines, coordinates, curves, curve tables and line tables. The precision of labeled distances and coordinates are set and controlled with the *Annotate Defaults* command.
Annotation Defaults

This command sets the defaults for the annotation menus and controls the way various annotation commands work. Some of these defaults can be changed globally by running *Configure* command, which changes the file COGO.INI so that every time you start Carlson, the new defaults are set. When this menu option is selected the Annotate Defaults dialog appears.

**Horizontal Scale:** This is the horizontal scale for the current drawing. This value can also be set by using the Drawing Setup command on the Settings menu.

**Text Size:** This value is multiplied by the horizontal scale value to set the text size units.

**Annotation Layer:** This specifies the layer to be used for the bearing and distance text.

**Text Style:** This specifies the text style to be used for the bearing and distance text.

**Distance Suffix:** This specifies the suffix that is appended to distance annotations.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line.

**Line Type Spacing:** Specifies the distance between the symbols on special line types.

**Line Type Text Scaler:** This value multiplied by the horizontal scale specifies the size of the symbols of special line types.

**Arc Length Label:** Specifies the prefix label for arc length labels.

**Arc Text Spacing Factor:** This variable controls how close letters will be spaced when labeling arcs. The lower the number, the closer the spacing. The higher, the farther apart. (The suggested range between 0.8 and 1.5)

**Azimuth Label:** Specifies the prefix text for azimuth labels.
**Bearing Annotation Precision**: Specify the display precision for bearing labels.

**Bearing Direction Method**: Choose the orientation of the bearing. This controls how lines selected for bearing or azimuth annotations will be referenced.

**Toward Picked End**: If this option is chosen, the line will be labeled in the direction of the endpoint that is closest to the point where you selected the line.

**Away from Picked End**: This labels the line in the direction away from the closest endpoint.

**North Only**: This option controls whether bearing annotations will always be labeled in the north quadrants (NE or NW) and never in the south quadrants.

**By Linework**: This option labels the line in the direction that the line was drawn.

**Strip Spaces in Bearing Labels**: This option causes the spaces in bearing labels to be removed.

**Add Spaces in Bearing Labels**: This option puts spaces between the degree, minutes, and seconds numbers.

**Label 2nd Scaled Distance**: This option labels distances in both current drawing units and scaled by the scale factor set in Drawing Setup.

**2nd Dist Decimals**: This option applies to the second distance label. The number of decimal places for the first distance label is set by the `Units Control` command in the *Settings* menu. For example, distances in feet could have 2 decimals and distances in meters could have 3 decimals.

**2nd Dist Label**: This option applies to the second distance label. This variable will be assigned as a suffix to the label.

**2nd Dist Use Brackets**: This labels the second scaled distance value inside [brackets].

**Drop Trailing Zeros**: This option allows you to drop trailing zeros on distance labels.

**Draw Bearing Leaders**: This option creates a direction arrow with the bearing annotation as shown below.

Position Leaders To Side: This option draws the bearing leader to the right side of the bearing label. Otherwise the leader is drawn above the label.

**Draw Leaders to Endpoints**: This option creates leader lines (crow’s feet) between the distance annotation and the line segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the distance label.

**Leader Size Scaler**: This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the line segment is too short, the leader is shortened to fit.

**Offset Scaler**: This option controls the distance between the line endpoints and the leader endpoints.

**Leader Style**: This option determines which of the five styles of endpoint leaders to use. The five styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot and Dashed.
Leader Layer: This option determines the layer for drawing the leader.

Load/Save: Choose these options to load an existing annotation defaults file (.ADF) or save a new one, which will contain your current selections.

Pulldown Menu Location: Annotate
Keyboard Command: LDEF
Prerequisite: None
File Name: \sp\ldef.lsp

Auto Annotate

This command allows you to select a group of lines, arcs and/or polylines to be labeled. It allows for any combination of line and distance labeling, and also any combination of arc labeling.

You can position the features of the labels, once in the Auto-Annotate dialog, by using the Row, Side, Order, Orientation and Position Types options, all found under Lines tab. For Arcs, you can select the Arcs tab and determine the type of auto-annotating you would prefer for arc entities. As you select different options, you can see the changes in the preview display of the entry dialog. You will select the Angle Format in terms of Bearing, Azimuths and Gons and there is an important feature that allows you to avoid label overlaps. This is done by applying specific, user-defined settings. When labeling arcs, there are options to set the label prefixes for curve annotation. The Settings button will bring you to the Annotation Defaults dialog, as explained in a previous section. Defaults will restore the prior settings.

Apply Label Settings by Layer brings up another dialog box which allows you to import from file, or load, predetermined configurations. There is an option to have different label settings applied by layer. Apply Label Settings By Layer allows you to set, load, and save your preferred variables.

The Avoid Label Overlap option can bring up a special dialog called the Overlap Manager. This screen, which contains extra tools for, as an example, sliding or stacking the labels that are overlapping and conflicting with drawing entities, gives you the real-time ability to move along the plan and make your corrections. This also will help you to avoid overlapping with other labels, text, symbols and linework – including fence and utility lines. In this Overlap Manager, docked on the left side of the screen, it is recommended that you use the Back and Next button frequently in order to review, adjust and correct your drawing.

Auto-annotate dialog starts with the Lines (tab).
**Angle/Distance:** Allows you to enter the what row the Angle label is on, what side and the order of the label on the linework. The same applies for Distance labels. Notice the preview display changing.

**Row:** Using numbers (1 or 2), or choosing None, you can determine the order and appearance of the descriptions. Note the change in the preview display.

**Side:** Choose inside or outside of the line.

**Order:** If you determine that the annotations are to be on the same row and same side of the line, then you must pick the order in which they will appear, from left to right.

**Orientation:** This offers this choice between parallel or perpendicular with regards to the labels' orientation to the line being labeled.

**Position Types:** Determined how each label is placed in relationship to the line and the other label.

**Angle Format:** Bearing, azimuths or gons are the choices.

**Always Use Line Tables:** Line tables are sometimes preferred as they keep the drawing linework clean and free of labeling.

**To Line Table Scaler:** The To Line Table Scaler applies when the Type of Line Label option is not set to Line Table. If the length of the line is less than this minimum, the line is labeled as a line table entry. The To Line Table Scaler is relative to the current horizontal scale and represents the length of the line in plotted inches.

**Starting Table Number:** User choice. You might change this because perhaps you have another group of line labels, in table form, in the drawing. Line table entries are numbered sequentially beginning at the line Starting Table Number. The location for the line table can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current line table. To set the location for the current line table, run the Table Header command in the Annotate > Line/Curve Table menu.

**Auto-annotate dialog box**, by selecting the **Ares tab**, displays the options for auto-annotating arcs. The columns are described, followed by the rest of the options.
Label: Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.

Row: Using numbers, or choosing None, you can determine the order of the descriptions, and determine whether or not some might be left off altogether.

Side: Choose inside or outside of the arc.

Order: If you determine that the annotations are to be on the same row and same side of the curve, then you must pick the order in which they will appear, from left to right.

Label Chord Angles in: Bearing, azimuths or gons are the choices.

Type of Curve: Choose between Road and Rail.

Flip Text on Arcs that Open to the North: Clicking here might make for a easier to read finished plan. User preference.

Use Symbol for Delta Angle Label: The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

Always Use Arc Tables: Curve tables are sometimes preferred as they keep the drawing linework clean and free of labeling.

To Curve Table Scaler: The To Curve Table Scaler applies when the Type of Arc label options is not set to Curve Table. If the length of the arc is less than this minimum, the arc is labeled as a curve table entry. The To Curve Table Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches.

Starting Table Number: The Starting Table Number is the starting number for the first line entered in the Curve Table. Curve Table entries are numbered sequentially from the curve Starting Table Number. The location for Curve Tables can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current Curve Table. To set the location for the current Curve Table, run the Table Header command in the Annotate > Line/Curve Table menu.

Auto-Annotate dialog commands, common to both Lines and Arcs.

Apply Label Settings By Layer: See the Label By Label Settings dialog and details below.

Avoid Label Overlap: See dialog and details below.
Settings: Brings you to the A ate Defaults dialog.
Layer Settings: Apply Label Settings By Layer option must be clicked in order to activate. You will then see the Label By Layer Settings dialog.
Overlap Settings: Avoid Label Overlap option must be clicked in order to activate. Brings up the Avoid Label Overlap dialog.
Defaults: This returns you to the default label values.
Load: You can load an existing .AAN file.

We will now say, for example, that with linework only to label in the drawing we run this routine. We first decide to go without the Avoid Label Overlap feature. This can be done by unclicking this option in the Auto-Annotate dialog. We will say that there is a fence line cutting through our property line, the property lines being the lines that we want to auto-annotate. In going without Auto Annotate's overlap protection, we perform Auto Annotate and we see that there is an overlap, with the labels running into the property lines and the fence line.

Panning and zooming the screen shows the problems we confront. Now, run Auto annotate again, but this time click ON the Avoid Label Overlap feature. Then click Overlap Settings button which brings up a dialog as shown below. This program and this specific dialog box has many different methods for fixing the overlaps. We will choose the different methods to apply.

First, we will choose Slide. This slides the labels along the linework. We can even choose a maximum amount of slide and other related parameters. We will also turn on the Stack method. The Avoid Linework Conflicts feature pertains to that fence line we have. Finally, click OK. Now can pick the linework. Note that you do not need to erase the existing auto annotate labels ahead of time. This command will remember that those labels were created with this command. It will simply replace the entire group of labels with the new auto annotate labels.

The result, with overlap detection on, is that this routine fixed 7 out of 7 of the conflicts. It slid some of the labels over and stacked others. You can also run Auto Annotate Overlap with manual mode. To do this, remove the automatic options (such as Stack, Slide, etc.) and click View Remaining Overlaps After Applying Rules ON. Say OK. It docks the Overlap Manager on the left side of the screen.

You can then fix the conflicts with this Overlap Manager by using the different methods presented in this new window. This manager will highlights the conflicts, it will, for example, slide to the next conflict and allow you to pick a new position. Hit the Next several times. Again, stack one, slide another over, and perform other changes. Then choose Close.

Also, remember that depending on the linework layer, you can even have different annotation styles. There is also an option to have different label settings "by layer". These decisions are made by using the Label By Layer Settings dialog options. To get to this dialog, click on the Layer Settings button at the bottom of the Auto-Annotate dialog.

Label By Layer Settings option and dialog.

Layer: Select a layer from the existing list of layers. If the linework you select and to be labeled is on this layer, the
parameters that you set in this dialog will be reflected in all labels.

**Auto-Annotation Settings:** Select an existing Annotation Settings file (AAN) by clicking the File button on the right. Or stick with the defaults.

**Auto-Defaults Settings:** Select an existing Default Settings File (ADF) by clicking the File button on the right. Or stick with the defaults.

**Load:** Select this option in order to load an existing layer file (LAY) to load.

**Avoid Label Overlap option and dialog.**

![Overlap Settings dialog]

**Available Methods:** Your choices. Pick from these.

**Used Methods:** Different ways in which this routine keeps the label from overlapping.

**Slide:** If this is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

**Offset:** will move your labels perpendicular to your linework as far as you set the Max Offset.

**Table:** Replaces your labels with a numbers and create a table of the numbers with the corresponding labels.

**Reorient:** If chosen, the labels will change orientation in the plain view to avoid overlapping.

**Flip:** It will flip your label onto the other side of the linework.

**Stack:** It will stack or unstack the text of your labels to avoid overlapping.

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the **Move Up** and **Move Down** buttons. If a solution is not found by using the first method then the next method is used in descending order.

**Add/Remove:** Some methods you might prefer not to use.

**Slide/Offset Parameter (multiples of text height):** These are variable that help you to slide or offset the label(s) in question.

**View Remaining Overlaps After Applying Rules:** This option will help you to see what still needs treatment.
View Last Overlap File: When it is checked, the Overlap Manager will return to the previous labels that were under review.

Skip Resolved Overlaps: When it is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

Restore Original Zoom: This will restore the zoom you were previously at before running the command.

Avoid Linework Conflicts: This is an extra precaution for when linework conflicts exist.

If there is a conflict, the following Overlap Manager dialog appears on the screen. It zooms to the conflict and provides you with the necessary tools to resolve the issues that need to be addressed. Many of the choices selected in the earlier dialog boxes can be modified yet again in the Overlap Manager, in your quest for a clean looking drawing. Within this special window you can zoom, pan, move to the next conflict, and perform many other tasks.

The Overlap Manager screen appears as a new window.

The Overlap Manager can be used to manually check and change label overlaps. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to flip through and fix or ignore the unresolved labels.

Prompts

Auto Annotate Dialog Choose settings and click OK.
Select Lines, Arcs, and/or Polylines to Annotate.
Select Objects: pick entities. Select the group of lines, arcs and/or polylines you want to annotate.

Pulldown Menu Location: Annotate
Keyboard Command: autoann
Prerequisite: Lines, arcs or polylines to annotate
File Name: \lsp\crdutil.arx

Custom Label Formatter AD

This command allows you to customize the labeling for lines and polylines. You are first prompted to select a line or polyline to label, given the existing defaults currently set. The linework is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. In this dialog, there are three columns at the top of the dialog, along with other features. On the command line, there is also a choice called Format (F), which allows you to enter quick-key style keywords for quickly changing the label format. See below for these

![Custom Label Formatter AD Dialog](image)

**Row:** This column allows you to stack the data in different ways. You can place more than one item in the same row. If *None* is selected, then that item will not be displayed.

**Side:** This column allows you to place each item either inside or outside of the line or polyline.

**Order:** This column determines the order of items when they are placed in the same row.

**General Settings:** This button brings you to the Annotate Defaults dialog, see ‘Annotate Defaults’ for more.

**Reset To Defaults:** This button restores the default settings shown above.

**Load/Save:** You may also Load and Save different label configurations with the corresponding buttons.

**Prompts**

Options/Format/Points/\Select line or polyline\>: select entity
Options/Format/Points/\Select line or polyline\>: O
Custom Line Label dialog choose your preferences and click OK
You can decide to go into the Option dialog at the start of the command, or after your initial labeling. If you use the Format command line option, you will be asked to enter the Format command. The choices are:

B = bearing
A = azimuth
G = gon
D = distance
R = next row
_ = switch side of line

**Pulldown Menu Location:** Annotate > Angle/Distance
**Keyboard Command:** annline
**Prerequisite:** An arc to label
**File Name:** \lsp\crdutil.arx

### Draw End Point Leaders

These three commands draw a pair of leaders (crow's feet) at the ends of the line or polyline segment. The segment can be selected from a line, polyline or pair of points. The leaders are drawn above or below the line or polyline, or you can pick a side, depending on which Endpoint Leader command is run. The Pick Side command gives you the ability to place the crow's feet on a selected side of the line or polyline. Controls to customize the look of the endpoint leaders are accessed through the *Annotate Defaults* command in the Annotate menu. The Leader Size Scaler determines the maximum length of the leader. If the line segment is too short, the leader is shortened to fit. The actual length of the leader in drawing units is calculated by multiplying the leader scaler by the drawing horizontal scale (i.e., \(0.5 \times 40 = 20\)). The Offset Scaler sets the distance that the leader head is off the line endpoint. There are four leader styles to choose from: Arc with Arrow, Arc Only, Dash-Dot-Dash and Dashed. Endpoint leaders can be drawn together with bearing/distance annotation by having the Draw Leaders to Endpoints option on under *Annotate Defaults*. This Draw End Point Leaders command allows you to add the leaders as another step.

### Prompts

**Define line by [Points/\(<\text{select line or polyline}>\)]:** *Select a line or polyline.*

If you wish to define by points, enter "P" at this prompt and pick points on the screen, or type in point numbers. If a coordinate (.CRD) file has not been previously loaded, a dialog will open to allow you to select a coordinate (.CRD) file to process. While using the Point selection method, the last point picked in the selection is stored in default brackets. So if you are working around a boundary, simply press enter to accept the defaults for the first point and move ahead to the next point.
Arc with Arrow Endpoint Leader

Dashed Endpoint Leader

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** `crowft`  
**Prerequisite:** None  
**File Name:** `\lsp\stackbd.lsp`

## Dynamic Annotation Note

Bearing and distance annotations can be linked to the linework, such that the annotations will automatically update if the linework is changed. For example, if a line is moved with the AutoCAD *Move* command, the bearing label will update. This link can be found, and toggled on and off, under Object Linking in Configure > General Settings. Configure is in the Settings menu. The link is established between the label and the line, or polyline, when the label is created by commands such as *Auto Annotate*, *Line Table* or *Bearing Distance*. There are no links for annotation created using the Points option. To update bearing annotation without using the dynamic annotation, use the *Global Reannotate* command in the Annotate menu. To remove the links between the annotation and the linework entities, use the *Remove Reactors* command, found under File > Drawing Utilities.
Switch Bearing/Azimuth Quadrant

This command switches the Bearing quadrant label or adds 180° to an Azimuth label. For example, N90°32'16"E would be replaced with S90°32'16"W or AZ 78°17'18" would be replaced with AZ 258°17'18". This routine changes bearing text to read as if the bearing were in the opposite direction.

Prompts

Pick Bearing or Azimuth Text: pick text
Pick Bearing or Azimuth Text: press Enter to end

Examples of switch bearing/azimuth quadrant

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: brgquad
Prerequisite: bearing or azimuth label
File Name: \lsp\scogo1.lsp

Mirror Selected Labels

This command rotates a group of text 180 degrees and maintains the same text position. Use this command to rotate any text. Ignores all entities in the selection set except text.

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: flipset
Prerequisite: Text to rotate
File Name: \lsp\flipset.lsp
Mirror and Flip Selected Labels

This command mirrors the label to the other side of the labeled segment. At the new location, it then flips the label back to its original orientation. Use this command to manipulate any text. It ignores all entities in the selection set except text.

Before Mirror & Flip Labels

After Mirror & Flip Labels

**Pulldown Menu Location:** Annotate > Flip Labels

**Keyboard Command:** MFLIP\_LABELS

**Prerequisite:** Text to rotate

Flip Last Label

This command flips the last text drawn 180 degrees. Use this command to rotate your last annotation.

**Pulldown Menu Location:** Annotate > Flip Labels

**Keyboard Command:** flip

**Prerequisite:** Text to flip

**File Name:** \lsp\flip.lsp
Flip Selected Labels

This command rotates a group of text 180 degrees. Use this command to rotate any text. The command ignores all entities in the selection set except text.

![Before and After Flip Labels]

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: flip_labels
Prerequisite: Text to rotate
File Name: \lsp\flip lbs.lsp

Flip On/Off

When activated, the bearing and distance text will be rotated 180 degrees when drawn.

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: flp
Prerequisite: None
File Name: \lsp\scogo1.lsp

Bearings with Leader

This command places the bearing of a line or polyline segment at a point, then plots a user specified leader line to point to the defining line or polyline. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity
Pick point to start leader: pick a point near the entity
Label Position: pick a pointSelect the point where to place the label.
Options/Points/<Select line or polyline>: O
When Options (O) is chosen

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: brglead
Prerequisite: None
File Name: \lsp\brglead.lsp

Distance with Leader

This command labels the distance of a line or polyline segment at a point then draws a user specified leader line to point to the defining line. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Define distance by, Points/<Select line or polyline>: select a line
Pick point to start leader: pick a point near the line
Label Position: pick a point
Define distance by, Points/<select line or polyline>: press Enter to end

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: distlead
Prerequisite: None
File Name: \lsp\distlead.lsp
Bearing-Distance with Leader

This command places the bearing and distance of a line or polyline at a point and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity
Pick point to start leader: pick a point near the entity
Label Position: pick a pointSelect the point where to place the label.
Options/Points/<Select line or polyline>: O

![Diagram of Bearing-Distance with Leader]

When Options (O) is chosen

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: bdlead
Prerequisite: None
File Name: \lsp\bdlead.lsp

Azimuth-Distance with Leader

This command places the azimuth and distance label of a line or polyline at a point, and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: pick entity
Pick point to start leader: pick point
Label Position: pick location
Options/Points/<Select line or polyline>: O
Label Leader Settings dialog make selection

When Options (O) is chosen

Pullown Menu Location: Annotate > Annotate with Leader
Keyboard Command: azilead
Prerequisite: None
File Name: \lsp\azilead.lsp

Fix Label Overlaps

This command allows you to fix label overlaps, where a conflict exists, for lines, arcs and polylines. You are immediately taken to the Avoid Label Overlap dialog. Here you can realign your labels by using a variety of optional methods. When the setting are to your liking, click OK. The command line then prompts you to select the entities for which to resolve annotation conflicts. Once you have selected your entities and hit Enter, this routine finds the conflicts and fixes the label overlaps.
If **Slide** is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

**Offset** will move your labels perpendicular to your linework as far as you set the Max Offset.

**Table** will replace your labels with a numbers and create a table of the numbers with the corresponding labels.

If **Reorient** is selected then the labels will change orientation in the plain view to avoid overlapping.

**Flip** will flip your label onto the other side of the linework.

**Stack** will stack or unstack the text of your labels to avoid overlapping.

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the **Move Up** and **Move Down** buttons. If a solution is not found by using the first method then the next method is used in descending order.

The **Overlap Manager** can be used to manually check and change label overlaps. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to flip through and fix or ignore the unresolved labels.

When **View Last Overlap File** is checked, the Overlap Manager will return to the previous labels that were under review.

When **Skip Resolved Overlaps** is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

**Restore Original Zoom** will restore the zoom you were previously at before running the command.
Prompts

Select Lines, Arcs, and/or Polylines for which to resolve annotation conflicts:

Select objects: select entities

Pulldown Menu Location: Annotate
Keyboard Command: annconf
Prerequisite: Annotation conflicts
File Name: \lsp\crdutil.arx

Global Reannotate

This command updates bearing and/or azimuth labels for when the lines and polylines associated with the labels have been rotated after the bearings and/or azimuths were labeled.

Prompts

Select One Bearing/Azimuth Text Before Rotation: pick a bearing or azimuth label
Pick line associated with old bearing/azimuth: pick the line or polyline for the selected label
Select All or specific objects to reannotate (<All/Objects)? press Enter to update all text

Pulldown Menu Location: Annotate
Keyboard Command: globalre
Prerequisite: Bearing or azimuth labels and lines or polylines
File Name: \lsp\globalre.lsp
Survey Text Defaults

This dialog box routine sets up the defaults for the Building Dimensions, Offset Dimensions and Adjoiner Text commands.

Building Dimensions allows you to set text specifications for building dimensions.
- **Layer**: Allows you to set the layer for the building text.
- **Text Style**: Allows you to set the text style for the building text.
- **Text Size Scaler**: This value multiplied by the horizontal scale determines the actual text size.
- **Decimal Places**: Allows you to set the display precision for the building dimensions.
- **Drop Trailing Zeros**: Allows you to truncate trailing zeros from dimensions.
- **Characters To Append**: Allows you to set characters to add to reported dimensions.
- **Offset From Line**: Allows you to set the offset distance from the line to the dimension text.
- **Auto Label Closed Pline**: Allows you to choose between automatically labeling the Interior or Exterior or closed polylines. You may also choose none.

Offset Dimension Text allows you to set text specifications for offset dimensions.
- **Layer**: This option allows you to set the layer for the offset text.
- **Text Style**: This option allows you to set the text style for the offset text.
- **Text Size Scaler**: This value multiplied by the horizontal scale determines the actual text size.
- **Arrow Size Scaler**: This option allows you to set the arrow scaler to determine arrowhead size.
- **Decimal Places**: This option allows you to set the precision for the offset dimensions.
- **Drop Trailing Zeros**: This option allows you to truncate trailing zeros from dimensions.
- **Label as Feet and Inches**: This option allows you to use feet and inches.
- **Characters To Append**: This options allows you to set characters to add to reported dimensions.
- **Offset From Line**: This option allows you to set the offset distance from the line to the dimension text.
**Text Alignment** allows you to align text either parallel to the line or horizontally in the drawing.

**Position** allows you to determine if you are to pick the location of the text, or if the text is automatically positioned in the drawing.

**Adjoiner Text** allows you to set text specifications for adjoiner text.

- **Layer**: Allows you to set the layer for the adjoiner text.
- **Text Style**: Allows you to set the text style for the adjoiner text.
- **Text Size Scaler**: Allows you to set the text scaler to determine text size.
- **Justification**: Allows you to set the text justification. See the AutoCAD Reference Manual for details on each justification choice.

**Dimension Line Type** allows you to determine the line style to use for dimensions.

- **Single Arrow Line**: Draws a line with an arrowhead from the dimension text to the figure.
- **Dual Arrows Line**: Draws dual arrowhead.
- **Standard Line**: Draws a line with no arrowhead from the dimension text to the figure.
- **Curved Leaders**: Draws a curved line with an arrowhead from the dimension text to the figure.
- **Dimension Only**: Draws the dimension text with no line.

**Pulldown Menu Location**: Annotate > Survey Text

**Keyboard Command**: svtextdf

**Prerequisite**: None

**File Names**: \lsp\svtextdf.lsp, \lsp\svtextdf.dcl

**Offset Dimensions**

This command labels the perpendicular distance between a point and a line or polyline. The point can be a building corner or other object. The endpoint snap is on by default for picking this point, although you may choose another snap mode manually. There is also an option for arrow only on end of line. The text layer, size, style and the dimensioning method are set in the *Survey Text Defaults* command, found in Settings > Configure > Survey Settings.

**Prompts**

- **[end on] Pick Bldg/Object Corner**: *pick a point*
- **Pick Line To Offset From**: *pick a line or polyline*
Offset Dimensions showing perpendicular distances from corners to property lines

**Pulldown Menu Location:** Annotate > Survey Text  
**Keyboard Command:** dimentxt  
**Prerequisite:** Line or polyline  
**File Name:** \lsp\dimentxt.lsp

## Building Dimensions

This command labels the length of line and polyline segments. The label is located in the middle of the line or polyline segment. The options for Building Dimensions are set in the *Survey Text Defaults* dialog. This dialog is found in Settings > Configure > Survey Settings. One option in *Survey Text Defaults* labels all the segments of a closed polyline with one pick of the polyline. Otherwise, the procedure is to pick a line or polyline segment and then choose an alignment. Depending where the alignment point is picked, the label is drawn either perpendicular or parallel, above or below the line.

**Prompts**

**Pick Line or Polyline:** *pick line or polyline segment to label*  
**Pick Alignment:** *pick point as shown*  

**Pulldown Menu Location:** Annotate > Survey Text
**Adjoiner Text**

This command draws text that is aligned with the selected line or polyline segment. The layer, style, size and justification for the text is set in the *Survey Text Defaults* command, found in Settings > Configure > Survey Settings. To align text that is already drawn, use the *Rotate Text* command found in the Edit menu.

**Prompts**

- **Pick Line or Polyline**: pick a line or polyline for alignment  
- **Starting point**: pick a point to start the text  
- **Text**: *MAIN STREET*

**Draw Grid**

This command will plot a plan view grid at a user specified distance and optionally label the northing and easting coordinates of the grid. This command takes in consideration the current screen twist angle in which case it prompts for three corner points. After selecting the corner points the dialog below will appear. The title block is assumed right justified to the lower right corner of the grid definition points. After changing any of the settings select the *OK* button to plot the grid.
Grid Interval: The distance between each grid line.

Horizontal Scale: Reports the scale of the current drawing. This can also be set using the Drawing Setup command in the Settings menu.

Grid Format: The Ticks Only option will draw tick marks instead of grid lines. Selecting the Ticks Only option activates the Tick Size option for sizing the tick marks. There is also a Full Grid and Perimeter option.

Layout of Ticks: This option places the ticks throughout the interior of the grid work or just on the perimeter of the grid boundary.

Use '-' for Negative Coordinates: This option labels the negative grid coordinates with a '-'.

Label Grid: Selecting this Grid Text Setting option labels the grid coordinates.

Use Split Coordinates Layout: Puts the thousands digits above the grid line and the hundreds digits below the grid line.

Text Size Scaler: This scaler, multiplied by the Horizontal Scale, determines text size.

Offset Scaler: This scaler, multiplied by the Horizontal Scale, determines the offset for text.

Avoid Title Block Area: This Title Block Exclusion option will allow you to not draw grid lines or tick marks in the title block area. It is for making sure that the grid does not overwrite the title block.

Pick Title Block Corner: This option prompts you to pick the corner of the title block to determine where the grid lines and ticks will be omitted.

X Dimension Scaler: This is the horizontal dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.

Y Dimension Scaler: This is the vertical dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.

Label Prefix North: This option is for assigning a prefix to the northing grid line and tick mark coordinates.

Label Prefix East: This option is for assigning a prefix to the easting grid line and tick mark coordinates.

Prompts

Pick or Type Lower Left Corner Point: endp of (pick point)

Pick or Type Upper Right Corner Point: endp of (pick point) Select the corners of your border in which you want the grid plotted.
Draw Plan View Grid Dialog

Pulldown Menu Location: Annotate
Keyboard Command: dgrid
Prerequisite: None
File Names: \lsp\grid.lsp, \lsp\scadarea.dcl

Draw Legend

This command draws a legend based on a legend definition file. After choosing the legend definition (.LGD) file to use, a dialog displays the current definitions. The legend definition file consists of descriptions assigned to symbols, linetypes and hatch patterns. The default legend that is included with Carlson is called legend.lgd.

**Legend Definitions**

<table>
<thead>
<tr>
<th>Symbol name</th>
<th>Description</th>
<th>Include</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPT63</td>
<td>PINE TREES</td>
<td>No</td>
</tr>
<tr>
<td>SPT65</td>
<td>WATER METER</td>
<td>No</td>
</tr>
<tr>
<td>SPT69</td>
<td>BUSH &amp; SHRUBS</td>
<td>No</td>
</tr>
<tr>
<td>SPT6</td>
<td>CONCRETE MONUMENT FOUND</td>
<td>No</td>
</tr>
<tr>
<td>SPT60</td>
<td>ORCHARD TREES</td>
<td>No</td>
</tr>
<tr>
<td>SPT61</td>
<td>TREES</td>
<td>Yes</td>
</tr>
<tr>
<td>SPT63</td>
<td>BAS METER</td>
<td>No</td>
</tr>
<tr>
<td>LTYPE(CURB)</td>
<td>CURB</td>
<td>No</td>
</tr>
<tr>
<td>LTYPE(CURB)</td>
<td>WOOD POST FENCE</td>
<td>No</td>
</tr>
</tbody>
</table>

**Edit** edits a definition, select it and then click on the Edit button. This brings up the Symbol Definition dialog box.
• **Symbol Name** designates the symbol to draw in the legend. You can either type in the symbol name or choose it from a slide library by picking the appropriate Select button.

• **Description** is the name of the symbol.

• The **Hatch Scale and Color** options are used if the symbol uses a hatch pattern.

• **Include in Legend**: This option corresponds to the Include column on the Legend Definitions dialog box. Not all the defined entries need to be drawn. An entry will be drawn (shown as Yes) if the Include in Legend box in the Symbol Definition dialog box is checked.

• **Select Point Symbol**: This option displays a slide library of point symbols to choose from.

• **Select Drawing Linetype**: This option displays a linetype name list to choose from.

• **Select Library Linetype**: This option displays a slide library of linetypes to choose from.

• **Select Hatch Pattern**: This option displays a slide library of hatch patterns to choose from.

**Add** inserts a new definition to the definitions. To insert a new definition, pick an existing definition and click on the Add button. The new definition is added immediately following the existing definition.

**Add from Drawing** adds entries to the legend table for each different symbol that is selected from the drawing.

**Remove** removes the selected definition.

**On** switches the Include field in the selected definition to Yes.

**Off** switches the Include field in the selected definition to No.

**On/Off by Drawing** prompts you to select symbols from the drawing. Symbols found will be turned on, all others will be turned off. This helps you create a legend that includes only symbols found in the drawing.

**Description by Field-to-Finish** uses the description from the Field-to-Finish code definition for symbols that match the code symbol.

**Sort** sorts the definitions alphabetically and numerically.

**Draw** draws the included definitions as a legend.

**Move Up**: This option moves the selected definition up one row. Legend entries are drawn in the order that they are defined.

**Move Down** moves the selected definition down one row. Use the Move Up and Move Down buttons to change the order that the symbols will be drawn.

**Save** saves the legend file as its original file name.

**Save As** saves the legend file to a new file name.
Quit exits the command back to the drawing window.

Draw opens the Draw Legend dialog.

- **Text Size** sizes the text in the legend. It defaults to the value from Drawing Setup in the Setting menu.
- **Symbol Size** defaults to the value from Drawing Setup in the Settings menu.
- **Hatch Size** sizes the hatch pattern scaler.
- **Line Size** sizes the lines in the legend.
- **Layer Name** defines the layer for the legend.
- **Draw Legend Title** draws the following text "Legend: These standard symbols will be found in the drawing."

**Prompts**

Specify Legend Definition File Dialog choose the file to process
Legend Definitions Dialog
Draw Legend Dialog
Enter or pick upper left point for legend: pick a point

Sample legend created by Draw Legend

Pulldown Menu Location: Annotate
Keyboard Command: legend
Prerequisite: None
**Draw North Arrow**

This command inserts a north arrow symbol. You can select from several styles of arrows, and you can add your own by using the *Edit Symbol Library* command on the Settings menu.

![Draw North Arrow Dialog](image)

**Prompts**

**Draw North Arrow Dialog** *choose an arrow symbol, layer and other variables*

**Specify insertion point:** *pick a point*

**X scale factor** `<1> / Corner / XYZ: press Enter`

**Y scale factor (default=X):** *press Enter*

**Rotation angle** `<0d0'0'": press Enter`
Pulldown Menu Location: Annotate
Keyboard Command: narrow
Prerequisite: None
File Name: \lsp\scadutil.arx

Draw Barscale
This command draws a barscale at the user-specified scale.

Prompts
Horizontal scale <50.0>: press Enter to accept default Specify horizontal scale if not 50.
Layer name <BARSSCALE>: press Enter to accept default Specify layer name if not default.
Decimal places <0>: press Enter to accept default Specify display precision.

Pulldown Menu Location: Annotate
Keyboard Command: barscale
Create Point Table

This command draws a table of the coordinate data of the points from the current coordinate (.CRD) file using different methods displayed at the top of the dialog. The command displays the dialog shown below for setting all of the point table options. At the top of the dialog enter the range of point numbers to label, do a Screen Pick or select a Point Group(s). You can also specify the order and format of the table columns. If you do not want to include a data type, set the Sequence number to blank.

Prompts

Point Table Generator Dialog
Building Data List ... Done.
Table Upper Left Corner: pick a point
Generating Table... Done.
### Typical Point Table

<table>
<thead>
<tr>
<th>POINT</th>
<th>NORTHING</th>
<th>EASTING</th>
<th>ELEVATION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>4837.185</td>
<td>4638.546</td>
<td>9.57</td>
<td>17</td>
</tr>
<tr>
<td>11</td>
<td>4814.573</td>
<td>4926.339</td>
<td>10.09</td>
<td>17</td>
</tr>
<tr>
<td>12</td>
<td>4768.075</td>
<td>4642.827</td>
<td>9.71</td>
<td>17</td>
</tr>
<tr>
<td>13</td>
<td>4770.531</td>
<td>4945.015</td>
<td>10.39</td>
<td>17</td>
</tr>
<tr>
<td>14</td>
<td>4872.472</td>
<td>4443.861</td>
<td>11.02</td>
<td>17</td>
</tr>
<tr>
<td>15</td>
<td>4640.627</td>
<td>4365.524</td>
<td>11.87</td>
<td>17</td>
</tr>
<tr>
<td>16</td>
<td>4808.982</td>
<td>4915.995</td>
<td>11.95</td>
<td>17</td>
</tr>
<tr>
<td>17</td>
<td>4377.455</td>
<td>4686.778</td>
<td>12.95</td>
<td>tp</td>
</tr>
<tr>
<td>18</td>
<td>4504.613</td>
<td>4821.334</td>
<td>13.78</td>
<td>17</td>
</tr>
<tr>
<td>19</td>
<td>4436.827</td>
<td>4755.157</td>
<td>15.09</td>
<td>17</td>
</tr>
<tr>
<td>20</td>
<td>4370.283</td>
<td>4853.938</td>
<td>16.34</td>
<td>17</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Annotate > Point Table  
**Keyboard Command:** pointtbl  
**Prerequisite:** A coordinate (.CRD) file  
**File Name:** `\lsp\pointsch.lsp`

### Update Point Table

This command prompts you to select an existing point table. The program then reads the settings from this table and displays these settings in the same dialog used in *Create Point Table*. You can change any of the table format options. The program will also update the table to reflect any changes to the coordinate (.CRD) file.

**Prompts**

- **Select existing point table:** *pick anywhere on the point table or select points from the screen*

**Point Table Generator Dialog**

- **Pulldown Menu Location:** Annotate > Point Table  
- **Keyboard Command:** pointtblupd  
- **Prerequisite:** An existing point table, .CRD file  
- **File Name:** `\lsp\pointsch.lsp`

### Table Defaults

This command sets the format for line and curve tables. Text Layer and Text Style determine the layer and style of the line/curve table text. The distance for line tables can be labeled in horizontal or slope distance. The Automatic Table Update option will automatically insert the entry into the line or curve table. The auto update will renumber the other table entries and the associated labels in the drawing. For example, if a line table had lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. Without the automatic update option, the entry location must be picked and the labels updated manually. The Label Alignment determines the orientation of the L# or C# that is labeled on the line or curve. Horizontal will make the label horizontal to the current twist screen and Parallel will draw the label parallel with the line or curve chord. The Line and Curve Label Prefix sets the text before the number that is drawn in the table and on the line or curve (i.e. "L3" or "Line3"). The Curve Options specifies which curve data to include in the table and the order. You specify the label and table attributes in the Line/Curve Table Defaults dialog.
**Label Text Layer**: This field determines the layer of the line/curve text.

**Label Text Style**: This field determines the style of the line/curve text.

**Label Text Size**: This field determines the size of the line/curve text.

**Line Label Prefix**: This field determines the prefix for each line.

**Table Text Layer**: This field determines the layer of the line/curve table text.

**Table Text Style**: This field determines the style of the line/curve table text.

**Table Text Size**: This field determines the size of the line/curve table text.

**Curve Label Prefix**: This field determines the prefix for each curve.

**Prompt for Label Location**: This option prompts you to pick the location to label each line or curve. If this is not selected, the location is chosen automatically.

Under **Line Table Distance**, the method for measuring distance is specified.

**Horizontal**: The distance measured is only horizontal, even if the line is a 3D polyline.

**Slope**: The distance measured is the slope distance, used mostly for 3D polylines to get their true length.

Under **Label Angles in**, the type of angle is selected.

**Azimuth**: The angles are reported as azimuth.

**Bearings**: The angles are reported as bearings.

**Gons**: The angles are reported as gons.

Under **Automatic Table Update**, the option automatically inserts the entry into the line or curve table. The auto update renumbers the other table entries and the associated labels in the drawing. For example, if a line table contained lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table, and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. If you set the **Automatic Table Update** to Off, you must manually pick the entry location and update the labels.

If **Automatic Table Update** is set to On, the table is updated automatically whenever the line is modified.
Label Alignment determines the orientation of the L# or C# that is labeled on the line or curve. Horizontal will make the label horizontal to the current screen alignment, Parallel will draw the label parallel to the line or curve chord. Under Curve Options, you specify which curve data to include in the table and the order.

Selecting "Set Line Table Labels" will lead you to the Line Table controls, as "Set Curve Table Labels" (see graphic at end of this command page) leads to the Curve Table controls. The options in "Set Line Table Labels" are shown below:

With the above settings, for example, the Line Table appears as shown below. For improved "aesthetics", you might prefer to change the Bearing justification to "Center", for example.

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18′48″ W</td>
<td>87.33′</td>
</tr>
<tr>
<td>L2</td>
<td>S 75°06′27″ E</td>
<td>148.57′</td>
</tr>
<tr>
<td>L3</td>
<td>N 88°27′07″ E</td>
<td>63.44′</td>
</tr>
<tr>
<td>L4</td>
<td>N 58°40′01″ W</td>
<td>63.44′</td>
</tr>
</tbody>
</table>

To save space, you can reduce the size of the "Distance" column from 11.5 to 10. Note that using the Line Label Prefix option, L1 and L2, for example, can read Line1 and Line2, and for that, you may want to expand the "Width" setting for the Line column. The prefix flexibility, and the fact that the text used for the column header can be changed, means that line tables and curve tables can be plotted in any language. In Puerto Rico, for example, surveys are typically conducted in bearings, in meters and in Spanish. For that location, the table could be reconfigured as shown here:
This would lead to the following line table:

<table>
<thead>
<tr>
<th>LINEA</th>
<th>RUMBO</th>
<th>DISTANCIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18’48” W</td>
<td>87.33m</td>
</tr>
<tr>
<td>L2</td>
<td>N 88°27’07” E</td>
<td>63.44m</td>
</tr>
<tr>
<td>L3</td>
<td>N 58°40’01” W</td>
<td>63.44m</td>
</tr>
</tbody>
</table>

Note that changing the distance suffix to "m" (or omitting any suffix by making it blank) is accomplished in the more general command Annotation Defaults.

Finally, below we see the dialog that appears when you choose Set Curve Table Labels.
Table Header

This command draws the column header labels for the Curve Table and Line Table commands. When prompted for the starting point, the user may enter a coordinate or pick a point on the screen. The starting point location that the curve or line table command defaults to is one row below the start of the header labels.

<table>
<thead>
<tr>
<th>Field</th>
<th>Label</th>
<th>Width</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curve Number</td>
<td>CURVE</td>
<td>8.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Radius</td>
<td>RADIUS</td>
<td>9.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Arc Length</td>
<td>ARC LENGTH</td>
<td>14.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Chord Length</td>
<td>CHORD LENGTH</td>
<td>14.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Chord Bearing</td>
<td>CHORD BEARING</td>
<td>16.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Chord Azimuth</td>
<td>CHORD AZIMUTH</td>
<td>15.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Chord GONS</td>
<td>CHORD GONS</td>
<td>15.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Delta Angle</td>
<td>DELTA ANGLE</td>
<td>13.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Tangent</td>
<td>TANGENT</td>
<td>10.000</td>
<td>LEFT</td>
</tr>
<tr>
<td>Degree Of Curve</td>
<td>DEGREE OF CURVE</td>
<td>17.000</td>
<td>LEFT</td>
</tr>
</tbody>
</table>

OK  Cancel  Help

Prompts

Type of table [Line/ <Curve>]? C
Starting point of Curve table text <(6585.0 -704.0 0.0)>: pick point

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: tabhead
Prerequisite: None
File Name: \lsp\tabhead.lsp
Set Table Position

This command sets the position for adding line table entries. The next line table rows will start from this point. To add to an existing table, pick a point at the lower left of the existing table.

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: set_tbl
Prerequisite: None
File Name: \lsp\set_tbl.lsp

Curve Table

This command will compute curve data and draw it in tabular form using the settings specified in Table Defaults. The program computes the curve data from an arc entity, an arc segment of a polyline or from specified points on an arc. The curve data includes radius, length of curve, chord length, chord bearing, tangent and delta or included angle. The current curve table numbers are remembered between drawings. The user is prompted for curve number (default is sequential starting with 1) and the starting point of the table. The curve is labeled with a C#, where # is the sequential curve number. After picking the starting point of the table, the placement point for the other table entries will default to the next position and you can just press Enter unless you want to relocate the table. The Auto Annotate command can also create curve tables. Use the Table Header command to draw the column header of the curve data names.

Prompts

Define arc by, Points/<Select arc or polyline>: pick an arc
Enter curve number <1>: press Enter
Starting point of curve table text <(5000,5000)>: pick a point in a clear area of the drawing
Define arc by, Points/<Select arc or polyline>: pick another arc
Enter curve number <2>: press Enter
Starting point of curve table text <(4030,4490)>: press Enter to use next position
Define arc by, Points/<Select arc or polyline>: press Enter to end

<table>
<thead>
<tr>
<th>CURVE</th>
<th>RADIUS</th>
<th>ARC LENGTH</th>
<th>CHORD LENGTH</th>
<th>CHORD BEARING</th>
<th>DELTA ANGLE</th>
<th>TANGENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>85.44</td>
<td>80.74</td>
<td>59.57</td>
<td>S 70°32'55&quot; W</td>
<td>38°24'14&quot;</td>
<td>31.59</td>
</tr>
<tr>
<td>C2</td>
<td>102.66</td>
<td>95.80</td>
<td>74.93</td>
<td>N 21°26'14&quot; E</td>
<td>79°41'57&quot;</td>
<td>39.95</td>
</tr>
<tr>
<td>C3</td>
<td>110.33</td>
<td>34.29</td>
<td>91.45</td>
<td>S 59°42'05&quot; L</td>
<td>49°58'55&quot;</td>
<td>50.24</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: arctabl
Prerequisite: None
File Name: \lsp\arctabl.lsp
**Line Table**

This command will compute line data and draw it in tabular form, using the settings specified in *Table Defaults*. The program computes the bearing and distance from a line, polyline segment or between points. The current line table numbers are remembered between drawings. The line is labeled with a L#, where # is the sequential number of the line picked. The bearing and distance will then be drawn in tabular form similar to the previous Curve Table command. The Auto Annotate command can also create line tables. Use the Table Header command to draw the column header of the line data names.

<table>
<thead>
<tr>
<th>LINE</th>
<th>BEARING</th>
<th>DISTANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>N 22°33'19&quot;E</td>
<td>31.9873'</td>
</tr>
<tr>
<td>L2</td>
<td>S 89°00'57&quot;W</td>
<td>353.8667'</td>
</tr>
<tr>
<td>L3</td>
<td>N 31°35'59&quot;E</td>
<td>37.0750'</td>
</tr>
</tbody>
</table>

**Railroad Curve Table**

This command is exactly like Curve Table, except the curve data is calculated for Railroad curves. See the Curve Table command for more details.

**Delete Table Elements**

This command erases rows from line or curve tables. The table entries following the removed rows are automatically repositioned and renumbered. The line or curve labels on the linework in the drawing are also updated.

**Label Arc**

This command labels the arc data along the arc between the endpoints of the arc. The curve information is also displayed. The format for the label is set in the dialog shown here. For each arc data value, you can specify the label, the row number, and the side of the arc it will appear on. If a row number is left blank, then that value is not
labeled. There is a choice of labeling inside or outside of the arc. Annotation is drawn as a block. The advantage of this is that the characters, rather than being individual entities, are plotted as a single entity that can be moved and edited as a unit. You would need to explode the "blocked" text in order to edit the text. A toggle button determines whether the user wants to flip the text on arcs that open to the top of the drawing.

Prompts

**Define arc by, Points/**<select arc or polyline>**: select arc
After selecting the arc or polyline arc segment the command displays the dialog below. Select the OK button and the arc is labeled with the current settings of the dialog.

![Label Arc Settings dialog](image)

Examples of Label Arc (above and below)
**Stack Label Arc**

This command draws a small table of curve data. Unlike the command *Label Arc*, instead of fitting the text on the arc, this command lines the data up in rows. After selecting the command, the dialog below appears. For each type of arc value, you can specify the label and the sequence number. Under Label Options, the Stack Label Arc data table will display the values in the order by sequence number. If the sequence number is left blank, then that data value is not labeled. The text and sequence is set. If a row number is left blank, then that value is not labeled. There are also settings to justify label left or right.

---

**Example of Stack Label Arc**

**Pulldown Menu Location:** Annotate > Annotate Arc

**Keyboard Command:** labarc

**Prerequisite:** Arc or polyline should be drawn before execution

**File Name:** \lsp\labarc.lsp
Under Label Options, the data table will display the values in order based upon sequence number.

**Arc Length**: Select a label prefix and a sequence number.

**Radius**: Select a label prefix and a sequence number.

**Delta Angle**: Select a label prefix and a sequence number.

**Chord Angle**: Select a label prefix and a sequence number.

**Chord Length**: Select a label prefix and a sequence number.

**Tangent**: Select a label prefix and a sequence number.

**Degree of Curve**: Select a label prefix and a sequence number.

**External**: Select a label prefix and a sequence number.

The **Use symbol for Delta Angle** option uses a delta triangle symbol for the prefix.

Label Chord Angles in allows you to set how the angle is labeled.

**Azimuth**: The angles are reported as azimuths.

**Bearings**: The angles are reported as bearings.

**Gons**: The angles are reported as gons.

The **Type of Curve** option determines the type of curve.

**Roadway**: The length is determined as the true length of the curve.

**Railroad**: The length is adjusted based on 100-foot chord segments.

**Prompts**

Define arc by, Points/<select arc or polyline>: P The P option causes the command to prompt for points on the arc. This can be useful for labeling sub-arcs such as lot corners of a cul-de-sac.

Pick Points in a Clockwise direction.

Pick Endpoint of arc: pick a point

[nea on] Pick point between endpoints on arc: pick a point
Pick Other Endpoint arc: *pick a point*
Starting point of label: *pick a point* The labels are then drawn left justified from the point picked.
Define arc by, Points/<select arc or polyline>: *press Enter* Pressing Enter causes the program to end.

L = 243.4246'
R = 161.4800'
\(\Delta=86^\circ 22'16''\)
CLEN = 221.0219'
BRG = S 85\(^\circ\) 37'04" W

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: slabarc
Prerequisite: an arc entity or arc points
File Name: \lsp\slabarc.lsp

**Custom Label Formatter**

This command allows you to customize the labeling for arcs. You are first prompted to select an arc to label, given the existing defaults currently set. The arc is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. There are four columns at the top of the dialog along by other features.
Label: This first column allows you to set the prefix that will go before your arc data.  
Row: This column allows you to stack the data in different ways. You can place more than one item in the same row. If *None* is selected then that item will not be displayed.  
Side: This column allows you to place each item either inside or outside of the arc.  
Order: This column determines the order of items when they are placed in the same row.  
Flip Text on Arcs that Open to the North: When this is checked text will be orientated according to the open side of your arcs instead of being orientated according to the plain view.  
Use Symbol for Delta Angle Label: Allows you to use the triangle symbol for delta as the label instead of plain alphabetic or numeric representation.  
General Settings: This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.  
Reset To Defaults: This button restores the default settings shown above.  
Load/Save: You may also Load and Save different label configurations with the corresponding buttons. 

Prompts

*Options/*<Select arc>*: select entity
*Options/*<Select arc>*: *O*
Custom Arc Label dialog *choose your preferences and click OK*

You can decide to go into the Option dialog at the start of the command and after your initial labeling.

Pulldown Menu Location: Annotate > Annotate Arc  
Keyboard Command: annarc  
Prerequisite: An arc to label  
File Name:

**Draw Text On Arc**

This command draws text that aligns with an arc or polyline arc segment. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc at that point. These text letters are automatically grouped together as an anonymous block. This command starts with the Create Text on Arc dialog. This command draws text that aligns with an arc, beginning at a picked point. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc. These text letters are automatically grouped together as a block. The text string, text height, and text style are set in the Create Text on Arc dialog box.
**Text String**: Specify the text to label on the arc.

**Text Height**: Specify the text height. The default value is obtained from the text height specified in Drawing Setup. The value set here is retained throughout the drawing session.

**Text Style**: Choose an existing text style from the list of defined styles.

**Select text offset on screen**: When checked, the program will prompt you for offset. You can set the text offset from the arc by graphically picking the offset point on the screen. When this option is not checked, the Text Offset field described below becomes available to specify a known offset distance.

**Text Offset**: If the above setting is not selected, specify the Text Offset here. A positive value denotes an offset distance inside the arc, while a negative value denotes an offset distance outside the arc.

**Is base of text towards radius point?**: This option determines whether the base of the text should face the radius point of the arc. It orients the text to the curve. Examples showing the results of different settings follow.

**Example 1** - Offset distance specified on screen and base of text away from radius point.

Select Arc or Polyline segment: **pick Arc or Polyline segment** to place text on.

Select Text Offset: **pick the desired offset distance from arc**

Select Text Placement: **pick a point**, select the desired position to draw the text. Note that the text remains visible on the screen and attached to the "rubber banding cursor" so that various positions can be inspected before specifying the placement point. The graphic below shows this aspect of the command.

Note that the ghosted text is located along the midpoint of the arc. If no offset distance is specified or picked from the screen, the text will be placed at this point. An offset of zero puts the text directly on the arc.
**Example 2** - Offset distance specified in dialog and base of text towards radius point.

Select Arc or Polyline Arc Segment: **pick Arc**
Select Text Placement: **pick point**

Note that the prompt for offset distance was skipped because the offset distance was input on the dialog box. Simply select the text placement point resulting in the graphic below.
Draw Text on Tangent

This command is identical to Draw Text on Arc, except that the text is not curved to fit the arc. You are presented with this dialog box. Fill in the text, decide on the other options, click OK, and then follow the prompts.

Edit Text on Arc or Tangent

This command allows you to edit text created by the Draw Text on Arc or Draw Text on Tangent command. You can change the text string, text height and text style. The program prompts you to select the Text on Arc entity, then displays the same dialog used in Draw Text on Arc.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: textarc
Prerequisite: An arc entity
File Name: \lsp\textarc.lsp

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: textarctan
Prerequisite: Arc or polyline arc segment
File Name: \lsp\c_text.lsp

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: editarctext
Prerequisite: text entity as described above
File Name: \lsp\c_text.lsp
Fit Text Inside Arc

This command fits text between two points picked along an arc. Text is curved to fit the arc using individual text entities, which can only be edited one at a time. The Draw Text on Arc command creates an text entity that can be edited using Edit Text on Arc or Tangent. It will optionally display information about the selected arc. If you choose to display the curve data, you will be prompted to pick the endpoints of the arc in a clockwise manner. When prompted, enter the text you want drawn inside the arc.

Prompts

Pick points in a clockwise direction.

[nea on] Start Point on arc for text: pick point on arc to start text Notice that the AutoCAD Near snap is turned on by default.
[nea on] End Point on arc for text: pick point on arc to end text Notice that the AutoCAD Near snap is turned on by default.

Enter text for inside of arc: MEADOWVIEW LANE

Fit Text Outside Arc

Same as the previous command except this command fits text on the outside of the arc.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: OARCT
Prerequisite: An arc entity
File Name: \lsp\oarct.lsp

Change Polyline Linetype

This command changes the linetype of polylines or lines to the linetype selected from the dialog. True AutoCAD linetypes are created and applied to the selected entities, compared to other commands, such as Polyline to Special Line and Special Line/Entity, which break the polyline into segments. The spacing between linetype symbols and the symbols size are controlled by the Line Type Spacing and Line Type Text Scaler settings in the Annotate Defaults command. To select a linetype from the dialog, pick on the linetype image. Use the Next button to see more linetypes. At the end of the list of linetypes, there are two special choices. The UserDef choice lets you enter your
own text string into a linetype, and the Wingdings choice lets you insert any Wingdings font character into a linetype. Consult Windows® documentation for a listing of Wingdings characters.

Prompts

Select Linetype dialog *select linetype and adjust other variables*
Select items to change.
Select objects: *pick the polylines*
Linetype styles available using Change Polyline Linetype

**Pulldown Menu Location:** Annotate > Line Types

**Keyboard Command:** pltype2

**Prerequisite:** Polylines

**File Name:** `\lsp\ltype.lsp`

### Polyline to Special Line

This command converts polylines into special lines by adding the appropriate symbol onto the polyline, such as railroad, hedge, stonewall or telephone lines. Carlson has defined several line types as shown below. You can create custom lines by selecting the ? or another line type, which then prompts you for the text symbol to use. The size and spacing are set by the *Annotate Defaults* routine. This routine breaks the polyline in order to fit in the symbol. Broken polylines cannot be used by the *Area* command, and are difficult to edit. Consider using this command towards the end of your project.

*Change Polyline Linetype* command creates actual AutoCAD linetypes that are applied to the selected entities.
Prompts

Select Carlson Linetype dialog
Select the polyline(s) to convert.
Select objects: pick the polylines

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: pltype
Prerequisite: Polylines
File Names: \lsp\linetype.lsp, \lsp\cogoutil.arx

Polyline to Tree Line

This command changes a polyline into a series of semicircles for representing a tree line.

Prompts

Side for arcs on polyline direction? (Left/Right) press Enter
Enter the segment distance <10.0>: press Enter
Select the polylines to convert.
Select objects: pick one or more polylines

Before and After Polyline to Tree Line
Add Zig to Polyline

This command draws a [not-to-scale] style zig to a polyline. First pick the polyline and then pick a position on the polyline to draw the zig.

Prompts

Zig size <4.0>: press Enter
Select polyline to add zig: pick a polyline
Pick or enter point to add zig: pick a point along the polyline
Select polyline to add zig: press Enter to end

A zig in a polyline

Add Culvert to Polyline

This command adds culvert style brackets to both ends of the selected polylines.

Prompts

Culvert symbol size <4.0>: 12
Select polylines to add culvert symbols.
Select objects: pick the polylines

Culvert symbols added to polyline
Prerequisite: Polyline
File Name: \lsp\poly3d.arx

Sketch Tree Line
This command draws a tree line as you move the cursor.

The resulting tree line after you pick point to end

Prompts

Pick First Point then sketch tree line (pick point to end): Pick a starting point and then slowly move the cursor and pick a second point to end the routine.

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: treeline
Prerequisite: None
File Name: \lsp\treeline.lsp

Special Line/Entity
This command breaks a line, arc or pline and inserts a string of text or a block in the breaks. It can be used to draw fence lines, utility lines, tree lines or any line which can be constructed by inserting a text or block entity.

The command prompts to select an entity near its endpoint then the distance between inserts. Next, the user selects whether to insert text or a block, and whether to enter the distance or length to be broken out of the entity. If the user enters a 0 distance for the break distance, then the entity is not broken. If a distance greater than 0 is entered, then this distance is divided in half and broken out of the entity on both sides of the point at which the insert distance measures the entity.

If the user elects to insert text, the command prompts for the text to be inserted. Next, choose whether you want the text Middle or Center aligned, and whether you want to have the text flipped so it does not appear upside down. See the AutoCAD Reference Manual for more information on justification options.

If the user elects to insert a block, the command prompts for the block name. The size of the block is controlled by the symbol size setting in Drawing Setup. Considering that almost anything can be made into a block, such as raster images, wipeout entities, etc., this is a very powerful command. Alternatives to this command are Polyline to Special Line and Change Polyline Linetype.

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: speent

Chapter 15. Annotate Menu
**Guard Rail**

This command adds box symbols along a polyline to generate a guard rail. See the command *Change Polyline Linetype* also.

**Prompts**

**Pick Polyline/Last:** pick a polyline  
**Left/Right:** L for Left  
**Pulldown Menu Location:** Annotate > Line Types  
**Keyboard Command:** grail  
**File Name:** \lsp\grail.lsp

**Label Angle**

This command will label and report the interior and exterior angles between two directions. The angles can be defined by three points, or by two line or polyline segments that have a common endpoint. An example of labeling interior and exterior angles is shown below. The Both option will label interior and exterior angles simultaneously.

**Prompts**

**Define angle by, Points/<select line or polyline>:** pick a polyline segment  
**Select adjoining line or polyline:** pick another polyline segment  
**Interior:** 72°39'46'' **Exterior:** 287°20'14''  
**Angle to label (<Interior>/Exterior/Both/None)?** press Enter  
Typing B for Both labels both the interior and exterior angles.  
**Define angle by, Points/<select line or polyline>:** press Enter to end
**Label Coordinates/Elevation**

This command will label a coordinate on the screen. You can choose to label the northing and easting, the Z elevation, or all three properties. The point can be picked on screen, or specified by point number from the current coordinate (.CRD) file. Options include drawing a box around the label, labeling both feet and meters, setting the layer name for the label, setting the display precision, deciding whether or not to use a leader and selecting a change in the symbol used to mark the point. You can also set the text prefix and suffix for the label. Additionally, you can locate a label on Real Z Axis.
There is also an option to label the Delta X, Y and/or Z between two points, which is called Label Delta Between Two Points. When this option is clicked On, and after the prompt, you will first click two points locations. The label, with the delta value(s), will then be placed precisely in between these two pick locations. If, for example, the North, East and Elevation button is chosen, the resulting label will show the N, E and Z delta values.

Prompts

Label Coordinates/Elevation dialog
Point to Label?
Pick point or point number: pick a point
Point to Label (ENTER to End)?
Pick point or point number: press Enter

Pulldown Menu Location: Annotate
Keyboard Command: labcoor
Prerequisite: None
File Name: \lsp\labcoor.lsp
Label Lat/Long

This command will label the latitude and longitude of a selected point. The input point should be a state plane coordinate (either 27 or 83) which the program will convert to latitude and longitude. First, the program displays a dialog box with options to set the label prefixes, to set the display precision, to draw a box around the label and to change the symbol used to mark the point. Next there is a second dialog for setting the state plane zone. Then the program prompts for the points to label.

Prompts

Label Latitude / Longitudedialog
State Plane Zone dialog
Pick point or point number: pick a point
Pick point or point number: press Enter to end

Pulldown Menu Location: Annotate
Keyboard Command: lablat

Chapter 15. Annotate Menu
Label Curb/Flow Elevations

This command will automatically label curb and flowlines. It will also label the prefix and suffix as desired. Set the precision up to seven decimal places. Leader bearing sets the leader 'relative' to the angle of the polyline, or 'absolute' which means set to the orientation of the screen. You can also set the Tolerance, Leader angle, Text size scaler, Text offset scaler (horizontally and vertically) and layer as you desire.

Prompts

Pick a polyline to annotate (Enter to End): *pick a polyline*
Pick side for flowline (Enter to End): *pick a side*

Pulldown Menu Location: Annotate
Keyboard Command: cfelev
Prerequisite: curb and flowline data
File Name: \lsp\cogoutil.arx

Replot Descriptions

This command will create user specified text entities at the location of selected point descriptions.

Prompts

This command will Search for a certain Point Description and plot
New text on the current layer with current style.
Attribute Text to Search for < >: *STK*
New Text to plot < >: *Stake Fnd*
Select objects: Select Carlson points
Select objects: press Enter
Number of Text Entities Plotted: 4

Points with description STK

Found four STK descriptions and created four text entities

Pulldown Menu Location: Annotate
Keyboard Command: plotdesc
Prerequisite: Points with descriptions must be plotted. Set the layer and text style that you require.
File Name: \lsp\speent.lsp

Leader With Text

This command will draw a straight leader between two points, with an arrow at one end and optional text at the other. The arrow size is determined by the Symbol Plot Size setting, found in the Drawing Setup command. On the command line, selecting O for Options will provide you with more customizing choices to make.

Prompts

Options/Pick Arrow Location: pick a point
Text location: pick a point
Text: Leader With Text
Text: press Enter
**Pulldown Menu Location:** Annotate  
**Keyboard Command:** LDR  
**Prerequisite:** None  
**File Name:** `\lsp\leader.lsp`

### Special Leader

This command draws a curved leader line like the one shown. With this routine you can also choose to enter in multiple lines of text, not just a single line. The arrow size is determined by the Symbol Plot Size setting, found in the *Drawing Setup* command. On the command line, selecting `O` for Options will provide you with more customizing choices to make.

### Prompts

**Options/Pick Arrow Location:** *pick a point* Pick point where leader arrow will start.  
**Text location:** *pick a point*  
**Text:** *Monument*  
**Text:** *press Enter*
Pulldown Menu Location: Annotate  
Keyboard Command: sleader  
Prerequisite: None  
File Name: \lsp\al.lsp

**Text Box**

This command allows you to draw a shaded, shadow text box around a selection of Text or Mtext. The size of the shading and the optional leader are determined by the height of the text that is selected.

![Text Box Example]

Pulldown Menu Location: Annotate  
Keyboard Command: textbox  
Prerequisite: Text or Mtext entities  
File Name: \lsp\textbox.lsp

**Label Offset Distances**

This command labels the distances of a point to one or two lines. The first distance is between the point and an east-west line. This distance is labeled as either north or south of the line. The second distance is between the point and a north-south line. This distance is labeled as either east or west of the line. The distances are labeled with a leader and a description of the point.

**Prompts**

Pick 'E-W', Left to Right Property Line (if any)  
Pick Line or Polyline (Enter for None): pick the polyline  
Pick 'N-S', Top to Bottom Property Line (if any)  
Pick Line or Polyline (Enter for None): pick the polyline  
Pick Offset Point, (N) for Number, <E> to Exit: pick a point
**Pick point to start leader at:** pick a point at or near the offset point

**To point:** pick an alignment point for the label

**To point:** press Enter

**Pick Offset Point, (N) for Number, <E> to Exit:** press Enter to End

---

**Pulldown Menu Location:** Annotate

**Keyboard Command:** offlab

**Prerequisite:** Polyline or Line

**File Name:** \lsp\offlab.lsp

---

**Label Elevations Along Polyline**

This command labels point elevations and aligns with a polyline. The point elevations are read from Carlson points drawn on the screen. The options for the labels are set in the first dialog. The Text Size Scale and Offset Distance Scaler are relative to the current horizontal scale, which is set in *Drawing Setup*. These scalers are multiplied by the horizontal scale to obtain the actual AutoCAD units. The Side for Labels is relative to the direction the polyline is drawn.

**Prompts**

**Label Elevations Along Polyline dialog**

Select alignment polyline: pick a polyline

Select points to label.

Select objects: pick the points
The alignment polyline with points to label is shown

**Pull down Menu Location:** Annotate  
**Keyboard Command:** elevlab  
**Prerequisite:** Polyline and points  
**File Name:** \lsp\elevlab.lsp
The Surface menu, shown below, has many commands for triangulation, contouring, volumes, profile design and much more.


**Triangulate & Contour**

This command provides a complete set of functionality for contouring, labeling, and creating tin surface models. Given data entities that represent the surface, this command creates a final contour map with labeled, smoothed, and highlighted contours and/or a surface model that can be saved to a file (to be used in other areas of the program) or drawn on the screen as triangles or faces. Eligible data entities include points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.

*Triangulate & Contour* has many options which are defined in the exhibits shown in the following pages. With this command, you can do any combination of drawing the triangulation network lines, drawing the contours, drawing triangulation network 3D Faces or lines, writing a triangulation file and storing a surface file.

In order to force *Triangulate & Contour* to correctly interpolate elevations between two points that define a grade break in the surface (such as points on a ridge, wall, or road), a breakline must exist between the points. A breakline line can be specified as a 3D polyline or line. In fact, all 3d polylines and lines with elevation are treated as breaklines.

If *Triangulate & Contour* reports zero points found and fails to do anything when you’re using Carlson points, then those points are probably located at zero elevation. To fix this problem, make sure that Carlson Point Inserts is toggled on in the Selection tab. This will enable *Triangulate & Contour* to read the elevation from the elevation attribute of the point.

**Triangulate Tab**

![Triangulate and Contour dialog box](image)

When **Draw Triangulation Lines** is turned on, the program will draw the triangulation as simple AutoCAD lines with elevation. Specify the layer for these lines in the box to the right.

When **Draw Triangulation Faces** is turned on, the program will draw each triangle in the triangulation network as a 3D Face. These 3D Faces can then be used in AutoCAD's modeling routines such as *HIDE* and *SHADE* or in Carlson routines such as *3D Viewer Window*, *3D Surface FlyOver and Slope Zone Analysis*. Specify the layer for
these 3DFaces in the box to the right.

**Write Triangulation File** stores the triangulation surface model as an .flt or a .tin file. The .flt file format is a text file depicting the edges in the triangulation network. The .tin file is a new binary file format depicting the triangulation network. The .tin file is much faster and more efficient than the previous .flt file format. The triangulation file(s) can be used by several commands such as **Volumes By Triangulation, Spot Elevations, and Profile from FLT File**. Either type in the file name to create or press the Browse button to select a file name.

When **Use Inclusion/Exclusion Areas** is activated, the program will prompt you for inclusion and exclusion polylines. These are used to define the area of activity for triangulation and contouring. The inclusion and exclusion polylines must be closed polylines and must be drawn before using **Triangulate & Contour**. The command line display must be set to show at least two lines to see the prompting for the selection of the Inclusion/Exclusion perimeters.

Only the parts of the contour lines and triangles that are within the inclusion polylines will be drawn. For example, an inclusion could be the perimeter of the site. The parts of contour lines that are inside the exclusion polylines are not drawn. Exclusion polylines can be used for areas where you don't want contours such as within buildings. When **Ignore Zero Elevations** is activated, this setting will filter out all data points at an elevation of zero from the data set.

If you would like to manually set the range over which to contour, select one of the **Specify Input/Output Elevation Range** options, one for source data and one for contour output. The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval.

When **Erase Previous Contour Entities** is activated, this setting will erase previously drawn contour entities.

The triangulation network is based on the x,y position of the points. **Pick Reference Plane** allows you to contour an overhang or cliff by changing the reference plane to a side view. The reference plane can be specified by first using the **Viewpoint 3D** command and then using the View option, or you can specify three data points on the cliff (two along the bottom and one at the top).

**Highlight Breaklines** highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

**Interpolate Ridges and Valleys** creates additional triangulation in a ridge or valley situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours, since it replaces the need to manually draw 3d polylines along ridges and valleys.

**Interpolate Summits and Pits** creates additional triangulation in a summit or pit situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours.

**Simplify Surface** is designed to reduce the digital size of a surface, without significantly compromising the integrity or accuracy of the surface. The most common application is for surfaces derived from very large datasets, such as smoothed contours. Its use is less applicable to design surfaces or surfaces based on surveyed points, but it can still be utilized. **Simplify Surface** reduces the size of the surface file by analyzing the difference in elevation between each vertex of the TIN and the vertices directly surrounding it, assigning a numerical weight or value to each vertex. If it is determined that the calculated weight for a particular vertex is less than the Tolerance factor, the vertex is a candidate for removal. The number of vertices removed is directly proportional to the Tolerance factor, so the higher the Tolerance factor, the more vertices are removed, the lower the Tolerance factor, the fewer vertices are removed.

If **Simplify Surface** is selected, the **Preserve Breaklines** option is activated. **Preserve Breaklines** further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular
difference between edges is greater than the specified Breakline Angle, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the Breakline Angle, it becomes a candidate for removal. In that case, the Weight factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the Tolerance, it is then removed. The number of vertices removed is inversely proportional to the Weight factor, so the greater the Weight factor, the fewer vertices that are removed, the lower the Weight factor, the more vertices that are removed.

A good rule of thumb that can be used when deciding whether or not to use these options is: if the surface contains no man-made features, use Simplify Surface only, if it contains man-made features, such as roads, use both Simplify Surface and Preserve Breaklines.

Before: Surface made from an existing contour map. Note the flat spots in the bottom of the valley (bottom center of the image) when Interpolate Ridges and Valleys is disabled.
After: The same surface with Interpolate Ridges and Valleys enabled. Note the smooth flowline at the bottom center of the image.

The Max Triangle Mesh Line Length value limits the length of the triangulation network lines. Any triangulation line that exceeds this limit will not be drawn or included in contouring. This allows you to avoid abnormally long triangulation lines where you have relatively too few data points and on the outskirts of your data points. The Exterior value applies to triangulation lines around the perimeter of the triangulation area and the Interior value applies all the other triangulation lines. Generally you would have the exterior value larger than the interior.

An Error Log is generated if the Triangulate and Contour routine finds a vertical conflict between breaklines or other surface entities, opening the following dialog box. Three types of conflicts are reported; Crossing Breaklines, Vertical Edges, and Breakline T-Intersections. Crossing Breaklines indicates that the intersection of two entities does not have a common elevation. Vertical Edges indicates that two entities or vertexes of differing elevations have the same x-y location, thus forming a vertical plane. Breakline T-Intersections indicates that a 3d entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection. Each type of conflict is listed in its own category.

Clicking to the "plus" sign beside a category will display the individual conflicts within that category. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.
**Zoom** pans the drawing to move the selected conflict to the center of the screen. The zoom functions are only active when a single line item is selected.

**Zoom In** zooms in on the highlighted area for closer inspection. Multiple picks on the zoom button will increase the magnification.

**Zoom Out** zooms out away from the highlighted area.

**Report All/One** toggles between One and All depending whether a single line item conflict or a category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.
Draw All/One toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict. The layer and size of the symbol is controlled in the fields below.

Continue closes the Error Log and proceeds with the contouring operation.

Layer Name specifies the layer name for the "X" entities drawn with Draw One/All. This also sets the layer name for the "Draw Lines" option.

Symbol Size specifies the size of the "X" symbol that is drawn to delineate the selected errors. This will determine the actual size of the symbol in the drawing. This value is not multiplied by the horizontal drawing scale.

In the case of crossing polylines, Draw Lines will trace over the polylines responsible for the conflict. The polylines will be created in the layer specified in the layer field.

Contour Tab
When the **Draw Contours** box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

**Contour by Interval** or **Contour an Elevation** determines whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100. The default mode is by interval.

Use **Contour Interval** to specify the interval to contour. **Note:** If the previous option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

Contour lines whose total length is less than the **Min Contour Length** value will not be drawn.

**Reduce Vertices** attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is ON.

When the Reduce Vertices option is enabled, the **Offset Distance** value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

When activated, the **Hatch Zones** option will create hatching between the contours based on elevation zones. The following dialog will open allowing the user to specify the hatch type and color for each elevation zone. The entire elevation range of selected data is displayed under Current Values.
Clear clears the all of the Elevation fields in the dialog.

Load loads previous settings from a saved .pat file.

Save saves the current setting configuration to a .pat file.

Auto opens the following dialog, allowing for automatic configuration of the range of elevations in each zone, assigning of colors and hatch patterns, and the scale.

Starting Zone sets the zone with which to begin the application of the setting defined in this dialog. For Instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.

Set Values enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.

Starting Value sets the elevation of the beginning zone to define.

Value Interval sets the elevation increment for subsequent zones.
Set Colors enables the Starting Color and Color Increment fields.

Starting Color sets the starting color number, based on the AutoCAD standard color chart.

Color Increment sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.

Set Pattern sets the hatch pattern for the defined zones.

Set Scale enables the Scale option.

Scale sets the scale for the selected hatch pattern.

Draw Index Contours creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

Use Contour Smoothing Method to select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

Bezier Smoothing Factor The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect. Note that too much smoothing applied in some situations can result in crossing contours.

Subdivisional Surfaces / Subdivisions Generation causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance’s sake, consider enabling Reduce Vertices.

Labels Tab
When **Label Contours** is activated, contours will be labeled based on the settings below.

**Label Layer** specifies layer name for intermediate contour labels.

**Index Label Layer** specifies layer name for index contour labels.

**Label Style** specifies the text style that will be used for the contour label text.

**Label Text Size Scaler** specifies the size of the contour labels based on a multiplier of the horizontal scale.

Contours whose length is less than the **Min Length to Label** value will not be labeled.

When **Break Contours at Label** is checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

When **Label Contour Ends** is checked, contour ends will be labeled.

When **Draw Box Around Text** is checked, a rectangle will be drawn around contour elevation labels.

When **Label Index Contours Only** is checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with
the best of both worlds; you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

When **Align Facing Uphill** is checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the top of the text label will always be toward the uphill side of the contours. So as the labels are read right side up, the contours will be progressing uphill.

Use **Internal Label Intervals** to choose between Label Intervals or Distance Interval. Label Intervals will label each contour with a set number of labels. Distance Interval lets you specify a distance between labels.

**Selection Tab**

![Triangulate and Contour dialog box](image)

When **Specify Selection Options** is checked, you can control what type of entities **Triangulate & Contour** uses. This is an excellent method of "filtering out" unwanted entity types.

Points, 3D Polylines, 2D Polylines, Lines, Inserts are standard AutoCAD entities types.

Carlson Point Inserts refer to Carlson points which include the block SRVPNO$ with the point number, elevation, and description attributes.

Spot/Bottom Elevation Inserts include text entities that start with 'X'.

From File allows you to triangulate from the points in a coordinate (.CRD) or ASCII file. This option also provides access to the use of Point Groups as a data source.
Chapter 16. Surface Menu

Label Contour Ends

Align Text With Contour ON

Align Text With Contour OFF

Draw Box Around Text

Original data points with one 3D polyline

Triangulation network without contouring
Contours without triangulation network

The contours are smoothed, reduced, drawn at an interval of 2, and highlighted at an interval of 10 with labeling on the index contours.

**Pulldown Menu Location:** Surface

**Keyboard Command:** tri

**Prerequisite:** Data entities in the drawing, including points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.

**File Names:** \lsp\tri4.lsp, \lsp\tri4.dcl, \lsp\tri4.arx

## Contour from TIN File

**Function**

This command creates contours directly from a TIN file (.flt or .tin) without the need to have the TIN drawn on the screen. The routine starts by opening the dialog for *Triangulate and Contour*, allowing the user to specify triangulation, contour and label settings. After pressing OK on the initial dialog, a second dialog opens, allowing for the selection of the TIN file from which to create the contours.

See the *Triangulate and Contour* section in the manual for a detailed description of each of the settings.
Prompts

Fill out the Triangulate and Contour Dialog information with the desired options.
Select the desired TIN file and choose Open.

Loading edges...
Loaded 1994 points and 5944 edges
Created 3936 triangles
Removed 9 disconnected edges.
Reading points... 0
Contouring elevation 497
Inserted 1926 contour vertices.

The user may be prompted for additional information depending on settings used in the Triangulate and Contour dialog box.

Pulldown Menu Location: Surface >> Contour from...
Keyboard Command: cntrTIN
Prerequisite: A TIN file (.flt or .tin)
File Name: \lsp\tri4.arx

Draw Triangular Mesh

This command draws a triangulation (.flt or .tin) file as either 3D LINES or 3DFACEs. Since 3DFACE entities can be shaded within the 3D Viewer Window or 3D Surface FlyOver, or with the AutoCAD 3D Orbit command, this is an excellent tool for visual surface inspection. 3D Lines cannot be shaded.
Triangulation (.flt or .tin) files can be created by *Triangulate & Contour*.

**Prompts**

**Select TMESH File to Draw**
Choose a triangulation (.flt or .tin) file from the file selection dialog. You are then prompted for options:

If using Inclusion/Exclusion Perimeters, you will be prompted to select them as the routine executes.

**Loading edges...**
Loaded 198 points and 234 edges

This Triangulation mesh was drawn as 3DFaces with the Draw Triangular Mesh command, and then colorized by elevation within 3D Viewer Window

**Pulldown Menu Location:** Surface >> Draw Surface
**Keyboard Command:** drawtri
Prerequisite: A triangulation (.flt or .tin) file
File Name: \lsp\contour4.arx

Contour Elevation Label

This command can be used to simultaneously create elevation labels on a group or groups of contour polylines at elevation. To place the labels, pick two points crossing the contour polylines at the desired label location. The program will find all the contour polylines that intersect the picked line (defined by the two picked points) and will place labels at the intersection point of each contour. A second crossing line can be initiated immediately, so multiple areas can be quickly labeled while remaining in the command. The actual "z" elevation of the contour line determines the label value.

Contour Label Options Dialog

![Contour Label Options Dialog](image)

**Label Layer** specifies layer name for the contour labels that will be created.

**Label Style**: specifies the text style to be used for labels.

**Horizontal Scale** is used in conjunction with the Text Size Scaler to determine unit height of the contour labels.

**Text Size Scaler** is a scaler that will be multiplied by the horizontal scale to set the actual text height of the labels in AutoCAD units.

**Decimals** sets the decimal precision for the labels to be created.
**Label Position** determines the label position in relation to the contour polyline.

- **On Contour** centers the label on the contour line.
- **Above Contour** places the label above the contour line. If this option is used, the options for Break Contours at Label and Draw Broken Segments become inactive.

**Ignore Zero Elevation Polylines** enables the routine to filter out all entities with an elevation of zero.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds: you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines.

When **Break Contours at Label** is checked, the contour lines will be broken and trimmed at the label location for label visibility.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

**Label By Distance** places the labels by distance along the contour. The user is not prompted for screen picks of contour crossing when this option is used.

- **Interval** sets the distance interval to be used between labels on each contour.

When **Draw Box Around Text** is checked, a rectangle will be drawn around the elevation labels.

**Label Index Only:** When checked, only Index contours are labeled.

**Prompts**

**Contour Label Options Dialog Opens** Select the desired options and press OK.

**Define a line which slices the contours at the desired label locations.**

**Pick 1st point:** *pick a point*

**Pick 2nd point:** *pick a point*
By selecting two points the contour lines that cross the line defined by the two points are labeled.

**Pulldown Menu Location:** Surface >> Contour Labels  
**Keyboard Command:** gclabel  
**Prerequisite:** polylines with elevation (contour polylines)  
**File Names:** \lsp\gclabel.lsp, \lsp\contour4.arx

**Move Label Along Contour**

This command slides an existing contour label along a contour, maintaining its alignment with the contour. The label must have originally been created with the *Break Contours at Label* option *Off*. If the option to *Hide Drawing Under Labels* was used when the label was created, the wipeout will move with the label when using this command.

**Prompts**

Select contour label to move: *Pick label*  
Pick new contour label position: *Move mouse to relocate label*

**Volumes By Triangulation**

Volumes By Triangulation is an alternative volume method that compares two triangulation networks. This method is different from the grid based volume routines (*Volumes By Layer, One Surface Volumes, Two Surface Volumes, Stockpile Volumes, etc.*) and the cross section volume routine (*Calculate Section Volume*). Volumes by Triangulation calculates faster in most cases than the other methods, and it is the most accurate because it uses true TIN to TIN prismoidal volumes. This added accuracy in general is very small. The grid resolution is usually sufficient to model...
the surface for the grid based volumes. The Volume By Triangulation accuracy applies well when there is a feature like a 5 foot wide ditch. Then the grid resolution would need to be less than 5 feet to model the ditch which might be difficult on a large site.

The disadvantage to this routine is that it lacks the output options that help the analysis of the volume such as Difference Contours. Also Volumes by Triangulation does no extrapolation and stops calculating volume at the perimeter of the smaller of the two triangulation networks. Volumes By Triangulation is better when used with point data instead of contour data because contour data requires triangulating all the contour polylines as breaklines which creates a large triangulation network and is slower.

The triangulation networks to compare are defined in .tin or .flt files that are created by Triangulate & Contour with the Write Triangulation File option. Note that while both file formats are supported, the newer binary triangulation file format (.tin) is twice as fast to load and save, and half the size, of the .flt triangulation file format. For this reason, the .tin file format is recommended. Before using this command, run Triangulate & Contour twice to create an triangulation (.TIN or .FLT) file for each surface. The volume calculation is limited by either the extent of the triangulation networks or by an inclusion/exclusion perimeter(s). These perimeters must be closed polylines.

Output data includes area, tons by density, average thickness, shrink and swell, ratio, and total volume.

Prompts

Select EXISTING surface Tmesh File
Choose an .flt or .tin file

Select final elevation or surface TIN [Elevation/]\TIN?> press Enter
Select FINAL surface Tmesh File Dialog
Choose another .flt or .tin file.

Choose Predefined Boundary Dialog Choose none.
Select Inclusion polylines select objects
Select Exclusion polylines select objects

Volume Report Choose viewing option

Comparing Triangulation files: C:\SCAD2006\DATA\TRI1.FLT
and C:\SCAD2006\DATA\TRI2.FLT
Cut volume: 66891.35 C.F., 2477.46 C.Y.
Fill volume: 43458.01 C.F., 1609.56 C.Y.

Keyboard Command: trivol
Prerequisite: Two .flt or .tin files

Triangulation File Utilities

This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3d viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN. Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10', thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual reconfiguration of the
TIN network. This is performed under Surface Tools, also in the Contour pulldown menu. This routine also includes conversions to and from TIN files, DXF files and 3D Face entities.

Begin with the dialog shown here. First select a TIN model. You may choose between an .flt or .tin file, a DXF file (that includes 3DFACE entities), or 3DFACE entities in the current drawing. Specify the subject area by choosing inclusion or exclusion perimeters, then press the next button.

**Load TIN File:** Allows you to specify a triangulation (.flt or .tin) file to load.

**Load DXF File:** Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.

**Select 3D Faces:** Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3d faces from a plotted grid.

**Pick Bounding Polylines:** Allows you to select any inclusion/exclusion perimeter(s). When this button is selected, the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.

**Fast TIN Intersect:** When checked, this command will perform a simple and fast check for overlapping triangles, so is the preferred choice in most cases. However, if problems with the TIN are suspected, this option should be unchecked, so that a complete and thorough check and repair of the TIN is performed.

**Fill-in-holes:** When checked, any missing triangulation or gap in the surface will be automatically filled in with additional triangles. This option has to be set before loading the TIN file to take effect.

**Region Mode:** This option deals with nested or overlapping boundaries. When checked, AutoCAD hatch pattern logic is applied, in which all nested boundaries are used in an alternating fashion, so that an Inclusion Boundary within an Exclusion Boundary is still recognized. If this option is not checked, everything within an Exclusion Boundary is ignored.

**Next:** Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you do not specify any perimeters, the desired operation/s will be performed on the entire TIN.
**Add Value:** Prompts for a value to Add to the subject area of the TIN.
**Subtract Value:** Prompts for a value to Subtract from the subject area of the TIN.

**Multiply Value:** Prompts for a value to Multiply to the subject area of the TIN.

**Divide Value:** Prompts for a value to Divide to the subject area of the TIN.

**Add TIN:** Raises the subject area of the current TIN by the elevation value from a second user selected TIN file. This function is most applicable to applying a strata thickness TIN.

**Subtract TIN:** Lowers the subject area of the current TIN by the elevation value from a second user selected TIN file.

**Min TIN:** This does a comparison between the current TIN and a second user selected TIN file, and applies the lower value of the two TINs to the subject area.

**Max TIN:** This does a comparison between the current TIN and a second user selected TIN file, and applies the higher value of the two TINs to the subject area.

**Merge TIN:** Merges the current subject TIN into a second user-specified TIN file. There are three methods:

- **Current TIN inside/Second TIN outside boundary:** This method is only available when Bounding Polylines are selected in the first Triangulation File Utilities dialog. The current TIN will be used inside the boundary polylines and the second TIN is used everywhere else. The current TIN file should be the smaller of the two surfaces since the subject file will be joined or merged into the second file. For example, to merge a pad design into existing ground with this method, choose the pad design as the current TIN, pick the pad perimeter as the bounding polyline and use existing ground as the second TIN.

- **Second TIN inside/Current TIN outside boundary:** This method uses the second TIN inside the boundary and the current TIN everywhere else. The outline of the second TIN is used as the boundary if no bounding polylines where selected in the initial dialog. For example, to merge a pad design into existing ground with this method, choose the existing ground as the current TIN and choose the pad design as the second TIN.

- **Wipe, combine and repair Current TIN where overlaps Second TIN:** This method removes triangles from the current TIN for areas that overlap the second TIN. Then the second TIN is added into the current TIN surface and the gap between the current and second TINs is triangulated to stitch them together. This method is useful when the two TINs don't have matching have elevations on their common boundary. Then this method will create a transition zone between the TINs.

**Enhance Flats:** This routine eliminates flat triangles by adding a data point inside the triangle at a different
elevation to subdivide the triangle. The elevation of this point is calculated based on the slopes of the neighboring triangles.

**Offset:** Performs a perpendicular offset (from the face/s) to the TIN surface by the specified amount.

**Simplify:** Causes edges within the Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

**Tolerance:** This setting is used by the Simplify command described below. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

**Hold Breaklines:** Further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified **Breakline Angle**, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the **Breakline Angle**, it becomes a candidate for removal. In that case, the **Breakline Weight** factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the **Tolerance**, it is then removed. The number of vertices removed is inversely proportional to the **Breakline Weight** factor, so the greater the **Breakline Weight** factor, the fewer vertices that are removed, the lower the **Breakline Weight** factor, the more vertices that are removed.

**TIN Statistics:** Generates a report of the TIN statistics, including number of points, edges, and triangles, and minimum and maximum Z value.

**Subdivide:** Subdivides triangles to make them more equalateral.

**Set New Elev:** Sets all TIN faces in the subject area to the elevation specified.

**Set NULLs to Elev:** Sets all NULL values in the subject area to the elevation specified.

**Set Elev to NULL:** Sets all of the elevation values in the subject area to NULL.

**Set Elev by Surface:** Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.
Output Options: The following three options determine what part or parts of the TIN modifications that will be saved to the new TIN file. If the entire TIN is to be saved, all three options should be toggled on.

- **Insides**: If this is the only option checked, only changes made to the TIN within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved to the named file.
- **Border**: When the routine re-works the TIN to fit around a perimeter, a small horizontal offset is automatically applied to prevent the formation of vertical faces. The Border function will save changes made to TIN in this offset area.
- **Outsides**: If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved to the named file. Everything outside of the perimeter will be saved.

**Save As TIN**: Saves the current TIN as an .flt or .tin file.

**Save As DXF**: Saves the current TIN as a .dxf file. This format can be used by many other CAD programs.

**Draw As 3DFaces**: Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.

Converts the left mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out.

Converts the left mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis.

Converts the left mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes.

Toggles shading on and off.

Restores the graphics to plan view.

Reverses the effects of all operations performed on the TIN and reverts it back to its original status.
This icon exits the routine. If the TIN has been modified, you will be prompted to save.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** TINUTIL  
**Prerequisite:** 3D Faces, a TIN file or a DXF file.  
**File Name:** \lsp\tri4.arx

## Surface Manager

The *Surface Manager* toolkit allows the user to modify pre-defined triangulated surfaces, making real-time modifications and updates to contours and associated TIN (Triangulated Irregular Network) definitions. Functionality includes swapping TIN lines, adding breaklines to the surface, adding or removing points, adjusting point elevations, removing TIN lines, drawing or removing contour lines and labels, re-contouring at a different interval or with different label settings, etc. Contour lines are automatically updated to reflect any changes made to the TIN. A surface must be named and saved by one of the surface modeling routines (in the Triangulate tab) as a prerequisite to using the *Surface Manager* tools.

![Surface Manager](image)

All of the tools available in the *Surface Manager* are also available in the *Surface Triangulation Surface Manager* fly-out menu, as shown in this figure. Their functions are identical but require a surface to be set current. Changes made apply only to the current surface.

![Surface Manager Fly-out Menu](image)
The Surface Manager dialog box contains the following options:

**Set Current** designates a surface as current for editing with various surface tool functions, such as modifying TIN lines, setting a new contour interval, labeling contours, etc.

**Add** allows you to add a surface by selecting a surface model file (.TIN or .FLT).

**Remove** allows you to remove a surface from the list of stored surfaces.

**Rename** allows you to rename a surface.

**Edit** allows you to perform various TIN-related modifications to the current surface. Using the *Edit* function will activate the command line, where the user will be prompted with the following options:

*Add Point (AP)* adds a triangulation point to the network by picking a point from the screen. The pick must be inside an existing triangle. The elevation for the selected point is interpolated from the surrounding TIN network. This is a good method for adding additional triangulation to the surface in a sparse area. Also, a new elevation can be specified for the picked point. This function does not create Carlson points, and the point will not be saved to the .CRD file.

*Remove Point (RP)* removes an existing triangulation intersection from the TIN network. The affected triangulation re-adjusts to compensate for the missing intersection. Contours update accordingly.

*Add Breakline (AB)* adds a breakline to the surface by picking beginning and ending points on the screen. The endpoint snap automatically turns on. Only one breakline can be created at a time. The TIN network will reconfigure to follow the new breakline and update the contours. This does not create 3d polylines in the drawing.

*Swap Edge (SW)* swaps common TIN edges to create two different triangles from the original triangle configuration. Contours automatically update to reflect changes made to the TIN. Some common edges may not be swapped because of the orientation of the two triangles.

*Set Elevation (SP)* sets a new elevation for a specified TIN intersection. The affected TIN is adjusted and the contours are updated.

*Remove Tri (RT)* removes a TIN line from the surface by picking a TIN line or selecting an interior point. Contours are removed from the affected area.

*Hide Tris (ST)* turns the TIN network on and off.

Point addition/removal and elevation-related changes made to the TIN are only reflected in the surface file and the contours resulting from that surface file. Point changes are not saved to the .CRD file and 3D linework is not updated in the drawing. Use traditional methods to update these entities if desired.

**Prompts**

The command line will prompt as follows:

*Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)*

*Remove Tri(RT), Show/Hide Tris(ST)*

**Adding points, Pick point or enter keyword:** Type in the two letters of the function to be performed and press enter.
Add Points
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)

Adding points, Pick point or enter keyword: Press Enter to accept the default mode of Adding Points. Pick a point inside the TIN model at the desired location. The default elevation will be interpolated from the TIN model.

Enter the elevation of new point [559.112171]: 560
The surface will be recalculated using the input data.

Remove Points
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)

Adding points, Pick point or enter keyword: RP Pick close to the area that you want an elevation point removed.

Add Breakline
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)

Adding points, Pick point or enter keyword: AB

Pick near the 1st point of breakline: Pick a point
Pick near the 2nd point of breakline: Pick a point When adding a breakline, OSNAP Endpoint will default on.
Swap Triangle Edge
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)
Adding points, Pick point or enter keyword: SW
Please select an internal edge to swap: Select desired edge.
Set Point Elevation
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)
Adding points, Pick point or enter keyword: SP
Pick near the point to have elevation set: Pick near point 34.
Enter new elevation of the point [597.200000]: 600

Remove TRI Line
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)
Adding points, Pick point or enter keyword: RT
To conclude the Surface Edit mode, *press Enter* at the end of the internal command sequence. This will return to the Surface Manager dialog.

**Properties** allows the user to alter the drawing display properties for TIN lines, contours and labels for the selected surface. Applicable dialogs from Triangulate and Contour are used to provide a full set of options. When accessed, settings for the current surface display configuration are set. To make a modification, simply specify the desired change and press ok. For instance, if Draw Triangulation Lines was checked on, unchecking the box and pressing ok will redraw the surface without the TIN lines. If the contours were drawn at 1 foot intervals, setting the interval value to 2 and pressing *OK* will redraw the contours at 2 foot intervals. Refer to the *Triangulate and Contour* section of the manual for a more detailed explanation of the options below.
Chapter 16. Surface Menu
Done exits the Surface Manager and saves any modifications performed to the surface/s updating the .flt or .tin file.

**Pulldown Menu Location:** Surface >> Triangulation Surface Manager  
**Keyboard Command:** surface mgr  
**Prerequisite:** A triangulated (non-grid) surface

### Make 3D Grid File

This command creates a grid (.GRD) file which serves as a surface model for use in many of the other Surface routines. The program internally makes a triangular network of the data points (if Triangulation is selected as the modeling method) and then interpolates the elevation values of a rectangular grid at the specified grid resolution. Data points can be either points, inserts, lines, or polylines. Lines and polylines are treated as breaklines in the triangulation.

Gridding as a means of modeling surface features is generally less favorable than triangulating as the surface is defined only at the intersection of the grid lines. This can lead to inaccuracies around local features such as ditches or curb lines, since the grid resolution must be small enough to adequately capture the changes in these local regions. Contrast this with Triangulated Networks which carry all this information at every point along the features. Gridding can, however, be useful for modeling large sites in general trends such as watershed analyses and large-scale volume computations.
Grid superimposed over triangulated features

The grid location is specified by first picking a lower left corner and then an upper right corner. The screen cannot be twisted when this is done because grids always run north-south and east-west.

The dialog box sets the range of elevations to process, modeling method and grid resolution. Each of these items is described below.

- **Range of Elevations/Values to Process:** Entities with elevations or values outside the range to process are ignored and will not be used for the gridding.
- **Modeling Method:** The modeling method almost always should be triangulation for surface topographic grid files. Polynomial, inverse distance, kriging and linear least squares apply to random data points for surfaces like underground features, usually sourced by such methods as drillholes, data tables, etc.
- **Triangulation Mode:** When using Triangulation and Polynomial methods, there are four triangulation methods available.
modes: AutoDetect, Triangulation Only, Intersection with Triangulation and Intersection Only.

- **Auto Detect** method automatically chooses between the Triangulation Only and Intersection with Triangulation methods. If the selected surface entities are primarily made of polylines, then the Intersection with Triangulation method is used. Otherwise, the Triangulation Only method is used.

- **Triangulation Only** method builds a triangulation surface out of all the selected points, lines, and polylines. All lines and polylines are treated as breaklines. Grid node elevations are calculated based on the triangulation.

- **Triangulation with Subdivision** method uses the subdivisional surfaces modeling method. This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation. This gives a much smoother surface model, where instead of one triangle, there are now three or more.

- **Intersection Only** method goes directly to the Steepest Intersection method using the selected lines and polylines. The Steepest Intersection method is used to assign the grid node elevations from the linework of the triangulation lines and the selected lines and polylines. The triangulation step is skipped, and any selected point data is not used. This method can be used for making grids out of polylines such as a contour map as long as the surface is defined just by contour polylines without needing spot elevation points. Skipping the triangulation step makes this method a lot faster especially for large files.

**Grid Resolution:** The grid resolution is specified by either the number of grid cells or by the size for each grid cell. It is usually best to set the Dimensions of a Cell to a known size, and the program will calculate the "number of cells in X and Y." While the program can handle really large grids with no limit, a general rule of thumb is to keep the total number of grid cells under 500,000 (about 700 by 700 cells) to limit the processing time. The grid location and resolution can also be specified by using the position/resolution from an existing grid file. In this case, the location and resolution of the new grid will match those of the selected grid file which is useful for routines that require two grid files with identical locations and resolutions.

No elevations are calculated on grid cells that extend beyond the extent of the data. The figure shows an example of how the grid is calculated to the limits of the data points. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. When there are grid cells with no elevation in a grid (.GRD) file, many routines will prompt *Extrapolate grid to full grid size?* Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data. *Grid File Utilities* can be used to apply and save extrapolation to a grid file. The *Plot 3D Grid* command can then draw the grid file so that you can see the extrapolation.

A Carlson grid (.GRD) file has the following format:

Line 1 is the lower left Y coordinate
Line 2 is the lower left X coordinate
Line 3 is the upper right Y coordinate
Line 4 is the upper right X coordinate
Line 5 is the X direction grid resolution
Line 6 is the Y direction grid resolution

The rest of the lines are the Z values of the grid intersects starting from the lower left moving in the left to right direction and ending at the upper right. If the intersect has no value, the letter 'N' is saved instead of the Z value for Null values. An example is shown in the Display-Edit Report dialog.
Griding from Contour Maps

A grid file can be created from contours represented as polylines with elevation. The program calculates the elevation of each grid corner by looking for contour intersections in eight directions (N, S, E, W, NE, SE, SW, NW) and then interpolating the elevation between the two steepest intersections.

To accurately model the surface, it might be necessary to add entities in addition to the contour polylines. For one, spot elevation points can be added for the high and low points. Otherwise the grid model might plateau at the last contour. Also 3D breaklines need to be added on long narrow ridge and valley contours because in these areas the program will find the same contour when it looks for intersections in the eight directions. When all eight intersections are the same contour, the interpolated grid elevation equals the contour elevation instead of rising up the ridge or dipping in the valley. The 3D breaklines force interpolation along the ridge or valley. To draw these polylines, set the OSNAP to Nearest and run the 3D Polyline command. Then draw the polyline by picking the contour polylines where the breakline crosses them. Another way to quickly create breaklines is to first draw 2D polylines. Then convert these polylines into 3D polylines with the Screen option in the 2D to 3D Polyline by Surface Model command found on the 3Dpoly menu. There is also an automatic way to draw these breaklines. Under 3D Data, use the command: Create Ridge polylines from Contours.

Prompts

Grid File to Create File Selection Dialog
Enter a name for the grid file.
Use position from another file or pick grid position [Pick]/File?
Pick Lower Left grid corner <8111.88,3985.08>: pick a point for the lower left limit of the grid
Pick Upper Right grid corner <8366.88,4195.08>: pick a point

Make Grid File dialog box
In this dialog, you specify the grid resolution and whether or not to include data points with zero elevations. You can specify the resolution by entering the number of grid cells in the X and Y directions. By the Dimensions option, you to set the X and Y size for each grid cell.

Reading points ...
Select points, lines, polylines and faces to grid from.
Select objects: Specify opposite corner: 1075 found
Select objects:
Reading points ... 980
Finding points on breaklines ...
Ignored 2729 duplicate points.
Inserting breaklines 3480 ...
Triangulating points ... 980
Assigning grid values > 1800
Writing grid file: C:\Carlson 2008\WORK\example1.grd
Pick the Lower Left grid corner: pick a point for the lower left limit of the grid
Pick the Upper Right grid corner: pick a point

Pulldown Menu Location: Surface
Keyboard Command: mkgrid
Prerequisite: Entities that define the surface
File Names: \lsp\dtmmkgrd.lsp, \lsp\makegrid.dcl, \lsp\makegrid.arx

Draw 3D Grid File
This command draws the 3D grid mesh of the chosen grid (.GRD) file. Each grid cell can be drawn as a 3D Face entity, Polyface mesh, Text or temporary lines. 3D Faces and Polyface Meshes can be viewed/used in the following commands: 3D Viewer Window, Viewpoint 3D, Hide, Shade, 3D Surface FlyOver, and Slope Zone Analysis.
If **Use Vertical Exaggeration** is checked, grid elevations are multiplied by the value specified.

**Exaggeration Method** specifies whether to use an *Absolute* exaggeration method or *Relative to Base*, which uses the specified base elevation.

Specify the type of entities to draw in **Draw Method**. 3D Faces are described above. The Preview Only option draws the grid using temporary vectors. This method provides a much faster way to view the grid. However these temporary vectors are erased when the viewport is modified. This means as soon as you execute zoom, redraw, regen or plot, this grid will disappear. You can quickly redraw the grid by typing in VG for View Grid at the command prompt. Polyface Mesh is similar to 3D Faces except it is a single entity. The Text option will label the grid elevation at the grid corner. The text is placed center justified over the grid corner. To reduce clutter, there is an option to skip rows and columns.

Specify the layer for the grid entities in **Layer Name**.

Specify the initial viewing direction in **View**.

When **Color by Elevation** is checked, the grid will be colored based on a table of user-defined elevation ranges and the assigned colors. There is also an option to subdivide the grid cells at the color zone transitions. This is similar to the Elevation Zone Analysis command. Use the Specify Elevation Zones command to define ranges and colors.

When **Draw Side Faces** is checked, the program will draw vertical faces around the perimeter of the grid. The side faces will be drawn vertically from the grid perimeter to the Sides Base Elevation. You may optionally specify the Sides Base Elevation, it defaults to 0.00.

When checked, **Reverse Face Order** changes the direction of the points for a grid cell from clockwise to counterclockwise. The order applies to shading the grid cell in 3D render viewers such as the 3D Viewer Window command. The grid cell will only appear shaded when viewing the grid cell from the clockwise side. Viewing from the other side will show a wire frame. The default is to show the shaded side from the top-down view. This option allows you to draw the grid so that the underside of the grid is shaded.
When checked, **Draw Corners Only** will draw the side lines only at the grid corners. Otherwise side lines are drawn down each perimeter grid cell.

When checked, **Extrapolate Grid to Full Size** draws the entire rectangular surface of the grid.

When **Use Inclusion/Exclusion Perimeters** is checked, it allows you to select inclusion and exclusion areas. Only grid cells inside the inclusion polylines will be drawn. Grid cells inside the exclusion polylines will not be drawn.

When checked, **Subdivide Grid Around Inclusion Perimeter** subdivides grid cells that are partially inside and outside the perimeter into smaller resolution grid cells.

When checked, **Subdivide Grid Around Inclusion Perimeter** subdivides grid cells that are partially inside and outside the perimeter into smaller resolution grid cells.

---

**Pulldown Menu Location:** Surface >> Draw Surface  
**Keyboard Command:** plotgrid  
**Prerequisite:** a grid (.GRD) File  
**File Names:** \lsp\plotgrid.lsp, \lsp\cntr_grd.arx

### Two Surface Volumes

*Two Grid Surface Volumes* calculates the cut and fill volumes between two surfaces modeled by grid (.GRD) files. These two grid files must have the same location and resolution. To create the grid files, use the *Make 3D Grid File* routine. When creating the second grid file, choose *Use position of another file* and select the first grid file. Using the position of the first grid file sets the location and resolution of second grid to match the first.

There are several other routines that calculate volumes based on grid files. Grid based volumes can be calculated by *One Grid Surface Volumes, Volumes by Layer, Stockpile Volumes, and Pond/Pit Volumes*. These routines have special prompting and calculate the grid surfaces and volume in one step.

Volumes by Two Surface Volumes has three steps:

1. Creating the first grid file with *Make 3D Grid File*
2. Creating the second grid file with *Make 3D Grid File*
3. Running *Two Grid Surface Volumes*

One advantage to this command is that you have more output options to help analyze volumes.

Besides grid based volumes, volumes can also be calculated between triangulation surfaces using the *Volumes by Triangulation* commands. Cross section end area is another volume method that is used by the *Calculate Sections Volume* command in the Civil Design module.
There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the volume within this inclusion area is calculated. **Important:** Whenever possible you should use a polyline that represents the limits of disturbed area as the inclusion perimeter. Volumes within an exclusion area are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine.

If the grid contains grid cells that have no elevations, you have the option to extrapolate elevations from the grid cells with elevations. When you choose not to extrapolate, no volume is calculated for the grid cells left without elevations. In general, extrapolation is not very accurate and should be avoided whenever possible. Sometimes you may get small amounts of cut in stockpiles that should only be fill, or small amounts of fill in pits that should only be cut. These extraneous quantities are due to extrapolation at the border and should be small enough to be ignored. When inclusion or exclusion polylines are used, the program will automatically extrapolate the grids. In addition to writing a volume report to the file, printer or screen, there are several volume report options.

**Write Difference Grid File** creates a grid (.GRD) file of the elevation difference of the two grid files.

**Draw Difference Contours** creates a contour map of the difference or depth between the two grid files.

**Draw Elevation Difference in Each Cell** plots the elevation difference at the grid corners which is the same as the Elevation Difference routine.

**Draw Volume in Each Cell** plots the calculated volume for each grid cell and is an excellent way to verify the volume calculation. If a cell contains both cut and fill, both values will be plotted.

**Calculate Elevation Zone Volumes** calculates the cut and fill between different elevation ranges.

**Draw Cut/Fill Color Map** fills each grid cell with different shades based on the average cut or fill in the cell. Red shades are used for cut and blue for fill. There is an option to draw a color legend. You can subdivide the grid cells at zone transitions. Also, there is an option to control the zone intervals and range.

**Use Report Formatter** allows you to customize the report by choosing the fields to report and their order. Also the report formatter can be used to output the report data to Microsoft® Excel or Microsoft® Access.

**Process Another Area with Current Grids** runs Two Surface Volumes again using the same grid files but different inclusion/exclusion polylines. This option saves the step of reloading the grid files to calculate volumes from the same grids for multiple areas.

The **Cut Swell Factor** value is multiplied by the cut volume in the report.

The **Fill Swell Factor** value is multiplied by the fill volume in the report.
**Report Tons** allows you to enter the material density and the program will report the cut and fill tons in addition to volume.

Given two accurate grid (.GRD) files, this routine will calculate accurate volumes. To verify the volume calculation, it is a good idea to check the grid (.GRD) files either by drawing them with *Draw Surface >> Draw 3D Grid File* and viewing them with *the 3D Viewer* or by contouring the grids with the *Contour Grid File* command.

**Existing surface**

**Final surface contours with a closed polyline**

**Contours from the Draw Depth/Difference Contours option**

Cut contours are red, fill contours are blue, daylight contours are green.

This is a good way to check that both surfaces are modeled correctly and to verify the volumes.

**Sample Two Surface Volumes report:**

<table>
<thead>
<tr>
<th>Volume Report</th>
</tr>
</thead>
</table>

Comparing Grid: C:\scad2006\data\simo.grd  
and Grid: C:\scad2006\data\final.grd  
Lower left grid corner: 186551.67,57624.98  
Upper right grid corner: 186828.81,57897.09  
X grid resolution: 75, Y grid resolution: 75
X grid cell size: 3.70, Y grid cell size: 3.63
Total inclusion area: 37016.71 sq ft, 0.850 acres
Cut to Fill ratio: 1.14
Cut (C.Y) / Area (acres): 3642.35
Fill (C.Y) / Area (acres): 3182.70
Cut vol: 83570.89 cubic ft, 3095.22 cubic yards
Fill vol: 73024.56 cubic ft, 2704.61 cubic yards

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter
Specify Base Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/No)? press Enter If you enter Yes to this prompt, surface elevations will be computed for any grid cells that have null elevations.

Sample report from the Calculate Elevation Zone Volumes option:
(Calculates the cut and fill in different elevation ranges at a user-specified interval and beginning at a user-specified starting elevation.)

Volumes by elevation zone
Zone 20.00 to 30.00
Cut volume : 0.30 cubic ft, 0.01 cubic yards
Fill volume: 107.90 cubic ft, 4.00 cubic yards
Zone 30.00 to 40.00
Cut volume : 4.88 cubic ft, 0.18 cubic yards
Fill volume: 73021.14 cubic ft, 2704.49 cubic yards
Running total:
Cut volume : 5.18 cubic ft, 0.19 cubic yards
Fill volume: 73129.05 cubic ft, 2708.48 cubic yards
Zone 40.00 to 50.00
Cut volume : 65044.26 cubic ft, 2409.05 cubic yards
Fill volume: 0.25 cubic ft, 0.01 cubic yards
Running total:
Cut volume : 65049.44 cubic ft, 2409.24 cubic yards
Fill volume: 73129.29 cubic ft, 2708.49 cubic yards
Zone 50.00 to 60.00
Cut volume : 17786.85 cubic ft, 658.77 cubic yards
Fill volume: 0.00 cubic ft, 0.00 cubic yards
Running total:
Cut volume : 82836.29 cubic ft, 3068.01 cubic yards

Specify Final Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/No)? press Enter
Volume Report Options dialog
This shows a grid drawn by *Plot 3D Grid File* and volume values drawn by the Draw Volume in Each Cell option of the Two Surface Volumes routine. Cut appears as negative and fill as positive. Notice that cells bordering cut and fill regions contain a little of both.

**Pulldown Menu Location:** Surface >> Volumes By Grid Surfaces  
**Keyboard Command:** volcalc2  
**Prerequisite:** Two grid files  
**File Names:** \lsp\volcalc.lsp, \lsp\volcalc.arx

### Volumes By Layer

This is the easiest yet still equally accurate method for calculating volumes. For this command, volumes are calculated in one step by a simple window of the area, selecting the items, and *calculate*.

First, you must specify the grid location and resolution. The grid location should enclose the area for volume calculations. Next the program asks for the layer names of the entities for the base and final surfaces. You designate the layers to use for each surface either by typing the layer names or by picking from the screen, then during the routine you select the entities to use. You may safely use the keyword *ALL* to select the entities, since you have pre-defined the layers to use, and all those entities not on the specified layers will be filtered out. These entities, for use in modeling the surfaces, can be points, lines (such as triangulation lines), 2D polylines (such as contours), and 3D polylines (such as breaklines).

Inclusion and exclusion perimeters may optionally be specified to limit the volume calculation area on the grid. An inclusion perimeter should be used if there is a closed polyline for the limit of the disturbed area. Then the program internally generates grids of the surfaces from the entities on the corresponding layers and then calculates and reports the volume. The main disadvantage to this routine is that it doesn't have the special output options of *Two Grid Surface Volumes* such as Depth Contours.
Prompts

Command: layervol
Pick Lower Left limit of surface area: pick lower left corner of grid
Pick Upper Right limit of surface area: pick upper right corner of grid

You are then prompted to designate layers:

Select entities on layers of Existing surface. select sample object(s)
Select objects: Specify opposite corner: 3 found
Select objects: press Enter to conclude selection.
Select entities on layers of Final surface. select sample object(s)
Select objects: Specify opposite corner: 10 found
Select objects: press Enter to conclude selection.
Reading points...
Select surface entities on corresponding layers.
Select objects: all filters out those objects not on designated layers
85 found
Select objects: press Enter to conclude selection.
Reading points... 9396
Assigning grid values > 5300
Pass > 28 Null Z values left > 0
Writing grid file: C:\Documents and Settings\...\USER\grid1.grd
Assigning grid values > 5300
Pass > 43 Null Z values left > 0
Writing grid file: C:\Documents and Settings\...\USER\grid2.grd
Select the Inclusion perimeter polylines or ENTER for none: select inclusion perimeter
Select objects: 1 found
Select objects: press Enter to conclude selection.
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter for none.
Reading cell > 5346
Pass > 28 Null Z values left > 0
Reading cell > 5346
Pass > 43 Null Z values left > 0
Pre-processing grid cells ....
Processing cells ...
Select point for color legend (Enter for None): press Enter

Pulldown Menu Location: Surface >> Volumes By Grid Surfaces
Keyboard Command: layervol
Prerequisite: Entities that define both the base and final surfaces.
File Names: \lsp\layervol.lsp, \lsp\makegrid.arx

Spot Elevations By Surface Model

This command will calculate the Z coordinate of any point that falls within the surface model. Use this command to calculate the elevations for points of a design for slope staking or for putting spot elevations on a topography map. The calculated points can be stored in the current coordinate (.CRD) file. A surface model is either selected from a grid (.GRD) or triangulation (.TIN or FLT) file or internally calculated from the existing entities on the drawing.

Spot elevations can be calculated at various user-specified points or at a specific interval. For random spot elevations, the user picks or enters the X,Y coordinates for each spot elevations. The elevation at the current position of the crosshairs is displayed in real-time in a small window. For interval spot elevations, the alignment for the intervals is defined by a polyline that must be created before starting this routine.

Prompts
Source of surface model (File/<Screen>)? press Enter Use the File option to select a grid (.GRD) or a triangulation (.TIN or .FLT) file.

Layer for points <POINTS>: press Enter

Add spot points to Coordinate File (Yes/<No>)? Yes This option stores any points created in this routine to a .crd file and draws Carlson point entities.

Draw nodes only (Yes/<No>)? press Enter This prompt only appears if Add points to Coordinate File is off. This option either draws only AutoCAD POINT entities or an X mark and elevation text.

If you specified the use of a file for the surface model, you are then prompted to select the surface model file.

If you specified the use of Screen entities, you are prompted for:

Pick Lower Left limit of Surface area:
Pick Upper Right limit of surface area:

then the following dialog box appears with the settings to make a 3D Grid file:

For picked point spot elevations:

Random spot elevations or interval along pline (<Random>/Interval)? press Enter

Enter or pick point (Enter to end): pick a point

Enter or pick point (Enter to end): press Enter

For spot elevations along a polyline:

Random spot elevations or interval along pline (<Random>/Interval)? Interval

Pick the centerline polyline: pick a polyline

Interval along polyline <50.0>: 25
Number of left offsets <0>: 1
Enter left offset interval <25.0>: 10
Number of right offsets <0>: 2
Enter right offset interval <10.0>: press Enter

Spot Elevations with Add to Coordinate File off and Draw Nodes Only off
**Interval spot elevations for points 1-32**

"Random" spot elevations for points 33-37

**Pulldown Menu Location:** 3D Data

**Keyboard Command:** spotelv

**Prerequisite:** Surface entities or a grid (.GRD) file

**File Names:** \lsp\flatpond.lsp, \lsp\pond.arx

---

**Tag Hard Breakline Polylines**

This command tags polylines with a description so that Triangulate & Contour can identify these polylines as hard breaklines. The tag is invisible and doesn't change the polyline. Triangulate & Contour will not smooth the contours as they cross these hard breaklines, even with contour smoothing turned on. For example you could tag 3D polylines that represent a wall or a curb so that the contours go straight across without smoothing curves. If contour smoothing is turned off, this tag had no effect.

**Prompts**

Select hard breakline polylines. (For no smoothing in Triangulate & Contour)

**Select objects:** Select breaklines to tag

**Select objects:** press Enter to conclude selection

Set 14 polylines as hard breaklines.

**Pulldown Menu Location:** 3D Data >> Hard Breaklines

**Keyboard Command:** hardbrk
Untag Hard Breakline Polylines

This command removes hard breakline description tags from polylines. These tags are used by Triangulate & Contour to identify polylines as hard breaklines. Contours are not smoothed as they cross these hard breaklines, even with contour smoothing turned on. This routine untags polylines so that contours are smoothed across them. If contour smoothing is turned off, hard breaklines have no effect.

Prompts

Select polylines to remove hard breakline tag from.
Select objects: select polylines

Design Pad Template

This command creates design slopes from a perimeter polyline at specified cut/fill slopes to reach existing ground. This routine can be used to design building pads, pits, roads, ditches, stockpiles, etc. The design is drawn as 3D polylines for the cut/fill slopes and for the daylight perimeter where the design meets existing ground.

Before beginning this routine, you must have drawn the polyline representing the outside edge of the feature to model. The edge is drawn as a polyline which can be either a 2D or 3D closed or open polyline. For a 2D polyline, the program will prompt for an elevation for the pad perimeter. With a 3D polyline, the pad perimeter is set to the elevations of the 3D polyline. For an open polyline, the program will prompt for the side for the design. With a closed polyline, the program designs the slopes either outward or inward depending on the settings in the dialog.
Under **Source of Slope Target Surface Model**, choose between a Surface File (.GRD, .FLT, .TIN), Screen Entities, or a specific Elevation. If using Screen Entities, the routine internally calculates a gridded model, the limits of which are specified by screen picks. Make sure that the grid area covers the entire area for the pad including room for the cut/fill slopes.

For closed pad perimeters, there is a **Slope Direction from Closed Plines** option to draw the slopes inward or outward from the perimeter. The outward method starts the slopes at the design elevation of the perimeter and projects out to intersect the existing surface. The inward method projects the slopes inside to reach the grid surface or a set elevation. Outward sloping would be used for such things as building pads, parking lots, etc. where the interior remains as a defined surface. Inward sloping would be used for such things as the top edge of an excavated pit or pond where the interior side slopes project downward at the specified slopes until reaching the original ground surface.

Under **Design Slope Format**, choose between **Ratio**, **Percent**, or **Template**. The use of a Template allows for complex slopes to be applied, and is also an alternative approach to road design. The template (.TPL) file is created in the **Design Template** routine in the Roads menu. When using a template, the pad perimeter represents the centerline. One way to create the pad perimeter for the template is to use the **Profile to 3D Polyline** command which converts a 2D centerline to a 3D polyline using a design profile. With a template, the program uses not only the cut and fill slopes from the template file but also draws all the template grade points such as edge of road, curb and ditch. The subgrade, superelevation and template transition options of the template file are not used in this command. These options are only applied in the **Process Road Design** command. The grade points are drawn as 3D polylines parallel with the centerline. Cross section 3D polylines that include the grade points are also drawn at the specified interval.

**Use Another Surface for Pad Interior** will bring up a prompt for another Surface file (.GRD, .FLT, .TIN) to use for the design surface within the starting pad perimeter. Otherwise the program will model the pad interior by straight interpolation from the starting pad perimeter elevations. For example, if a building pad has a starting pad perimeter at a set elevation and the pad is supposed to be flat, then this option is not needed. This option is needed in a case where you are designing a pit and the starting pad perimeter is a 3D polyline that follows an undulating pit bottom.

---

**Chapter 16. Surface Menu** 878
surface. The pad design will model the pit side slopes. In order to model the undulating bottom of the pit, you need the Use Another Surface for Pad Interior option to select a surface that models the pit bottom.

**Use Different Slopes for Separate Sides** allows you to specify different slopes for different sides of your pad polyline. If this is toggled ON, the Assign Pad Cut/Fill Slopes dialog is invoked, where you can create multiple Slope Groups along the Pad Template polyline and set the Cut and Fill design ratios for each.

![Assign Pad Cut/Fill Slopes](image)

**Use Slope Pad Design** allows you to set a cross slope amount for the top of the pad. You will be prompted to screen pick two points that designate the slope direction. For automatic balancing of cut/fill quantities, you will be prompted to find the optimal slope and slope direction.

**Draw Slope Direction Arrows** draws an arrow on the outslopes that points in the downhill direction. Arrows on fill slopes are drawn as solid filled.

**Solid Cut Arrows** allows you to choose between drawing the cut arrows as solid filled or as wire frame.

**Round Exterior Corners** holds the outslopes around the corners. Otherwise the side outslopes stay straight until they meet at the corners as shown in the figure.

**Erase Previous Pad Entities** erases drawing geometry created with this command previously.

When **Draw Side Slope Polylines** is ON, Design Pad Template will draw 3D polylines perpendicular to the pad perimeter from the pad to the catch point.

**Color Side Polylines** assigns different colors to Cut and Fill Side Polylines to make them easier to distinguish.
Example of pit design for option of Use Another Grid for Pad Interior

Pad corner without round corners option

Pad corner with round corners option

**Side Polyline Spacing** specifies the interval at which to draw the Side Slope Polylines. Besides at the interval, side slope polylines are also drawn at grid corners.
Cut volume is multiplied by the **Cut Swell Factor** in the final volume report.

Fill volume is multiplied by the **Fill Shrink Factor** in the final volume report.

You must specify the **Pad Layer Name** that the pad 3D polylines will be drawn on.

There is an option to calculate volumes for the pad design. The volumes are calculated by comparing the existing surface with the pad design. The inclusion perimeter for the volume calculation is the daylight perimeter polyline which represents the limits of disturbed area. The existing surface model is defined by the existing surface file (.GRD, .FLT, .TIN) or screen entities selected at the beginning of the command. The pad design surface is calculated by making a surface from the pad 3D polylines including the starting pad perimeter, the side polylines and the daylight perimeter.

Besides calculating the volumes in the **Design Pad Template** routine, you can also calculate the volumes with the **Two Surface Volumes** command, or the **Volumes by Triangulation** command. Two Surface Volumes works with two grid files, Volumes by Triangulation works with two TIN files. The design surface for Two Surface Volumes can be the final output surface from Design Pad or you can create a design surface with **Make 3D Grid File** using the 3D polylines created in Design Pad. You could also create a TIN surface of the design surface using **Triangulate and Contour**. Some of the reasons to use either the Two Surface Volumes command or the Volumes by Triangulation command are that these volume routines have more output options (cut/fill color maps, etc.) and you can check the volumes by plotting or contouring the surface files. Also, you can combine several pads and other final surfaces by running **Make 3D Grid File or Triangulate and Contour** and then use these volume commands to calculate the overall site volumes.

The design is drawn as 3D polylines and the earthwork volumes are calculated. Before ending, the program allows you to adjust the design by changing the pad elevation, slopes and offset. The program can find the cut/fill balance by automatically adjusting the pad elevation. If adjustments are specified, the pad polylines are redrawn and the volumes recalculated. At the end, there is an option to trim existing contours inside the disturbed limits of the pad. Then there is an option to draw contours on the pad. If contouring is selected, a dialog lets you set the contouring options. Usually you should specify a new contour layer and turn off smoothing.

**A few Key things to note:**

1. **If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a grid file, then the surface produced from the designed pad will be a grid surface and a grid file (.GRD).**
2. **If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a TIN file, then the surface produced from the designed pad will be a triangulated surface and a TIN file (.TIN).**
3. **If the Surface used as a Target Surface is listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to Update the Surface, which is the Target Surface, so if you say "Yes," your Existing Ground Surface will now essentially contain the designed pad. So if you want to maintain an unedited version of Existing Ground, you may want to start with a copy of the Existing Ground Surface.**
4. **If the Surface used as a Target Surface is not listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to create a new surface of the combined surfaces.**
5. **If you respond "Yes" to the prompt about whether to contour the designed pad, the contouring dialog box has an option of whether to write the designed pad as a new surface, which will be only the area within the limits of the new design, not the entire Target Surface and design pad surface combined.**

**Prompts**

**First you are presented with the Design Pad Template dialog box.**
If the Source of Slope Target Surface Model is set to a Surface File, you will first be asked to:

**Pick the top of pad polyline: select perimeter polyline**

Then the Select Slope Target Surface dialog box is presented. Choose the Slope Target Surface file, pick Open. You then proceed to enter the slope parameters of the pad...

If the Source of Slope Target Surface Model is set to a Screen Entities, you will first be asked to:

**Pick Lower Left limit of pad disturbed area: pick lower left** These prompts appear for the Screen Entities surface model method.

**Pick Upper Right limit of pad disturbed area: pick upper right** Be sure to pick these limits well beyond the area of the top of pad polyline in order to make room for the outslopes.

**Make Grid File Dialog** After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.

Then,

**Pick the top of pad polyline: select perimeter polyline**

Then proceed to enter the slope parameters of the pad...

**Enter the fill outslope ratio <2.0>: 2.5**

**Enter the cut outslope ratio <2.0>: 2.5** After entering outslopes slope ratios, a range of elevations along the pad top will be noted.

**Enter the pad elevation <29.54>: 39**

**Calculate earthwork volumes (<Yes>/No)? press Enter**


**Adjust parameters and redesign pond (Yes/<No>)? press Enter**

**Write final surface to grid file (Yes/<No>)? press Enter** This option will output a grid file using the elevations of the pad within the disturbed area polyline and using the original ground surface everywhere else.

**Trim existing contours inside pad perimeter (Yes/<No>)? press Enter**

**Contour the pad (<Yes>/No)? press Enter**
Pad template with contours

3D view of pad with DTM of surface and triangulation faces of pad

Template to apply in Design Pad Template
Existing surface with 3D polyline centerline

Result of Design Pad Template showing template grade polylines, cross section polylines, cut/fill slopes, and final contours

Viewpoint 3D view of Design Pad Template
Design Pad Template can also handle self-intersecting side slopes

Pulldown Menu Location: Surface
Keyboard Command: pad
Prerequisite: A pad perimeter polyline and surface entities or a surface file for an intercept target.
File Names: \lsp\flatpond.lsp, \lsp\pond.arx
Slope Zone Analysis

This command calculates the surface area of a site in different slope zone ranges. This command can use either a surface model file, (.TIN, .GRD, or .FLT), or 3D Face drawing entities, which can be generated by the Plot 3D Grid File command, the Draw Triangular Mesh command, or the Draw Triangulation Faces option of Triangulate & Contour. For each slope zone, the 3D Faces can be hatched with any AutoCAD hatch pattern, including the SOLID pattern, or left empty with the NONE pattern.

This command can also generate contours of the slope zones based on the calculated slope at each point of the 3D Faces. The slopes can vary greatly between neighboring points. When contoured directly, these slope data points produce incoherent contours. Instead this routine applies a filtering algorithm that reduces the noise. There is another option to output a grid file of the slope values.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the slope area within the inclusion polyline is calculated. Slope area within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the slope area of each selected 3D Face is used.

Prompts

Source of surface model: [File/<Screen>]? F for File
Slope Zone Options dialog box. Choose whether to Draw Slope Zone Contours, whether to Output Grid File of Slope, and Slope Format. Pick OK
Select surface model file.
Define Ranges dialog. Specify the slope zones, colors and patterns from lowest to highest. Pick OK.
Select the Inclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter
Select the Exclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter
Report is generated.
If you choose to draw Slope Zone Contours, the Contour Options dialog box is presented.

![Contour Options dialog box]

Note: If you choose to use Screen entities instead of a surface model file, you are prompted whether to:

- Apply hatch patterns to grid cells [Yes/<No>]
- Freeze grid layer after processing [Yes/<No>]

Chapter 16. Surface Menu
Surface contours

3D Faces from a grid surface model

3D Faces created by *Triangulate & Contour* with the Draw Triangulation Faces option
Slope zone contours

Slope zones that follow the surface contours using the triangulation 3D Faces
Hatched slope zone contours created from the grid 3D Faces

Pulldown Menu Location: Surface >> Slope Analysis
Keyboard Command: szone
Prerequisite: Surface model file (.TIN, .GRD, or .FLT), or 3D Faces entities
File Names: \lsp\elanl.lsp, \lsp\contour4.arx

**Profile Defaults**

This command allows you to specify the default parameters for working with profiles.
**Profile Defaults**

- **Horizontal Scale**: Specify the horizontal scale.
- **Vertical Scale**: Specify the vertical scale.
- **Text Size Scaler**: Specify the text size scaler. This value is multiplied by the horizontal scale to obtain the final text height.
- **Symbols Size Scaler**: Specify the symbol size scaler. This value is multiplied by the horizontal scale to obtain the final symbol size.
- **Profile Annotations Layer**: Specify the layer that the profile text will be plotted on.
- **Object Height for Sight Distance Calcs**: Specify the object height value used when a sight distance is calculated.
- **Eye Height for Sight Distance Calcs**: Specify the eye height value used when a sight distance is calculated. The sight distance defaults are set to the AASHTO standards but can be changed as conditions dictate such as for an accident study or for metric values.
- **Vertical Curve Drawing Resolution**: Specify the length for line segments that are generated to represent vertical curves. Default value is 10.0
- **Vertical Curve PC & PT Points Layer**: Specify the layer that the endpoint nodes of the vertical curve will be plotted on.
- **Station Type**: Specify the format for the station labels: 1+00 is the default, 1+000 is for metric, NO.0 is the Korean format.

**Keyboard Command**: PRD
**Prerequisite**: None
**File Name**: \lsp\scadprof.dcl, \lsp\prd.lsp

### Quick Profile

This command allows you to create a profile in one step. The alignment for the profile can be defined using picked points, a centerline file or a polyline. The surface for the profile can be defined by 3D screen entities or surface files (grid or triangulation). Since picked points are the default for the horizontal alignment, the command is as
quick as select surface type (screen or file), then *Pick, Pick, Enter* and view. The resulting profile is displayed in a graphic dialog box with real time data reporting. As the crosshairs are moved across the profile in the window, the station, elevation and slope data corresponding to the current crosshair location appear in the lower right of the window. A second crosshair on the plan view corresponds to crosshair movement along the profile so the user knows exactly where the current profile point is on the plan view. Also the Adjust Alignment function allows you to drag a horizontal alignment point and update the profile in real-time.

**Vertical Exaggeration:** Determines the amount of vertical exaggeration for the profile in the window.

**Drag Action:** Determines whether the right mouse button functions as "Zoom" or "Pan" in the profile window.

**Grid Ticks Only:** Instead of the full graph as shown above, Grid Ticks only plots only ticks along the horizontal and vertical axis near the station and elevation text.

**Adjust Alignment:** Allows you to pick a horizontal alignment point and while moving it, the profiles are updated in real-time. You can also select a horizontal alignment segment and move the whole alignment position. The Adjust Alignment function is only available when surface files are used as the source of the surface model.

**Save:** Writes the current profile data to a .PRO file.

**Draw:** This draws the profile with grid in the drawing. The user has options for horizontal and vertical scales and the layer of the profile. The Draw Profile command includes more options for drawing the profile. In order to use this command, you must first create a .PRO file using the Save command described above.

**Exit:** Exits this command.

**Help:** Opens on-line help.
Note that the Draw option will exit the Quick Profile command after the drawing is complete. A typical completed drawing, in this case with two surfaces, is shown below. Note also that the horizontal stationing text offset follows the setting in the Draw Profile command itself.

![Completed Drawing](image)

**Prompts**

- **Pick starting point (CL-Centerline, P-Polyline):** *screen pick alignment points for profile*
- **Pick second point:** *pick next point*
- **Pick next point (Enter to end):** *press enter to end*
- **Tested 58 of 58 Entities Intersects found > 33**

**Dialog Box**

**Opening file:** `c:\Carlson2008\DATA\quickpro.pro for write`. Note that the 2nd surface profile, if used, is named `QUICKPRO2.PRO`.

**Keyboard Command:** `quickpro`

**Prerequisite:** 3D screen entities and a grid (.GRD) or triangulation (.FLT) file

**File Name:** `\lsp\quickpro.lsp`

**Profile from Surface Entities**

Profile from Surface Entities creates a profile from contours, triangular mesh, and other 3D drawing entities. The method is to draw a polyline as the profile centerline. Then the profile is derived from the intersections of this polyline with the 3D entities. For added accuracy in pulling the profile, include the triangular mesh as well as the contours.
File: Displays the name of profile to be created.
Beginning Station: Specify the beginning station for the profile.
Interpolate Endpoint Elevations from Beyond Profile Extents: When checked, the program will look past the ends of the centerline for additional intersections with 3D entities. These additional intersections will then be used to interpolate the elevation at the starting and ending station of the centerline.
Extrapolate Endpoint Elevations to Extents of Profile: This option uses the slope of the last two elevation points of the profile and calculates the elevation of the endpoint from this slope.
Station by another reference centerline: When checked, the program will prompt you to pick another centerline polyline. The intersection points along the first centerline are then projected onto the second centerline. The profile then stores the elevation of the intersection with the station along the second centerline.
Breakpoint Descriptions from Layers: When checked, breakpoint descriptions are assigned based on layer name of surface entities. These descriptions are used in routines such as Input-Edit Profile and Profile Report.
Ignore Zero Elevation Lines in Surface Model: When checked, any zero elevations selected in the surface model are ignored.
Profile Offsets: Specify optional offset profiles. Enter offsets separated by a space. Example: 30 -30 (to create 30’ left and 30’ right offset profiles). After entering the offset values, press TAB to select file options described below.
Offset Profiles to: Specify whether offsets profiles should be created as separate profile (.PRO) files, or included in a single profile (.PRO) file. Only available if you specify Profile Offsets above. Offset profiles are automatically named by combining the profile name and the offset. For example, if the profile is named NATGRD.PRO and you create a 30’ right offset profile, it will be named NATGRD30.PRO.

Prompts
Profile File to Write dialog Specify a new profile file (.PRO) name to create.
Profile from Surface Model dialog Make choices, click OK.
Polyline should be drawn in direction of increasing stations.
CL File/<select polyline which represents the profile centerline>: pick the centerline (Do not press Enter.)
Select Lines, PLines, and/or 3DFaces that define the surface for profiling.
Select objects: C (for crossing and window everything the centerline crosses) or All (to select all objects on the drawing)
Keyboard Command: prosm
Prerequisite: A polyline centerline and surface lines and polylines.
File Names: \lsp\scadprof.dcl, \lsp\proflap.lsp, \lsp\plinsct.arx

Export Topcon Grid or TIN File

This command writes a Topcon TIN file (.TN3) from 3d Faces, TIN lines, or triangulation files (.TIN, .FLT). If you choose to export from an existing surface file (.TIN or .FLT), you are only prompted to specify the file to read and the name and location for the Topcon file (.TN3) to create. If you specify the use of Screen entities for the source data, the following prompts are presented.

Choose Type of Export

- **Triangle Faces**: Triangulation networks that consist of edge matched 3D Faces defined by three points.
- **Triangle Edges**: Triangulation Networks that consist of edges drawn with Lines defined by two points.
- **Triangulation File**: A Carlson triangulation file (.FLT only).

Source Units: Select the appropriate unit type of the entities to be exported, then press NEXT.

If the Triangulation File option is chosen, a standard windows file selection dialog will open to allow for the selection of the .flt file.

If Triangulation Edges or Faces are used for the export, you must select the entities to be exported from the screen. The following dialog opens:
Manually Select allows on-screen selection with any of the various methods (Window, Crossing, Crossing Polygon, etc.)

All on a Selected Layer allows selection of a single entity. The command then selects all Lines or 3DFaces on the layer of the selected entity for export, filtering entities not on selected layer.

Generally, you can select any entities drawn on the screen without special care. The command filters out all types except Lines or 3DFaces depending on the type selected.

When Processing Lines: Crossings, crossing polygon, and fence selection sets can often result in "spikes" around the edges. The command generally discards these spikes, or reconnects them. In any case, better results are developed with clean selections of drawing entities.

Pressing NEXT will open the following dialog:

Other Features to Export: Often, landmark lines, or other features will assist in orientation to the user when using the TN3 file in the field. For example, property lines, project centerlines, or other well established reference lines. These features may be added and displayed on the TN3 by choosing them at this prompting. The Other Features dialog opens with all three Source Formats.

Selections are made as described above.
Once the selections are made and the dialog reappears, press NEXT.

**Naming the TN3 File:** After all the triangulation and feature items are selected from the graphics screen, the command requests a name for the output file. Once a name is given, the following dialog reviews all the selections made. A description for the job can be added at this time. Press Finish when ready to proceed.

The program will process the selected entities and/or files and report as shown here:

To view the final output, press the Run Simulation button, or press Exit to return to the Carlson program.
Run Simulation Dialog

**Pulldown Menu Location:** Surface >> Import/Export

**Keyboard Command:** topcon_tin

**Prerequisite:** 3D Face entities plotted usually created by the Make 3D Grid File command, or a surface file (.TIN or .FLT)

**File Names:**

---

**Profile from Points on Centerline**

This command creates a .PRO file from points and a centerline that is represented by a polyline or centerline file. The elevations of the profile are derived from the elevation of the points and the stationing for these profile points is calculated from the distance along the centerline. The points must be within the offset distance from the polyline in order to be included in the profile. The profile is created by projecting the points perpendicular onto the alignment to determine the station and the elevation comes from the point elevation. The polyline or centerline should be drawn (or defined) in the direction of increasing stations. The points can be selected from point entities in the drawing (Screen), by point numbers from the current coordinate file (Numbers), or by point group as defined by the Point Group Manager (Group).
Prompts

**PROfile file to Write dialog box:** Enter a new profile file name to write.

**CL File/<Select polyline that represents centerline>:** *pick a polyline or choose C for Centerline*

Select Centerline file if Centerline option is used. If the desired points are further from the centerline, enter a larger maximum offset tolerance.

Note: for all selected points, the points should be located on the real Z axis.

**Select the Carlson points along the centerline.**

**Select objects:** Select the point entities.

**Keyboard Command:** `profpts`

**Prerequisite:** A polyline centerline and points

**File Names:** `\lsp\profpts.lsp, \lsp\regrade.arx`

### Input-Edit Profile File

This command is a spreadsheet type editor for profile (.PRO) files. Besides editing a profile, this routine can be used to just view the contents of a profile. Also, a new profile can be entered by editing a previously empty or non-existing file.

The command starts by prompting for the profile file to edit. Alternately, you can run Input-Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the profile and vary its appearance by using zoom and pan. You can change the look of the profile more by using the vertical exaggeration multipliers. The station, elevation and slopes are also shown at the lower left of the dialog, fluctuating with the movement of the cursor. Then there are between five and nine columns for the possible fields in a profile. Which columns are active depends on the type of profile: generic, road, sewer, pipe, crossing or circular. Six rows are visible at a time. To view different rows, use the scroll bar on the right. When a greater amount of columns are in use, use the scroll bar at the bottom. The Profile Name edit box is an optional identification name used by multiple profiles in Draw Profile. The Add Row and Remove Row buttons, when used, will dynamically...
and immediately make changes to the profile image at the top.

On the right is a column for Check Stations which report the elevation at the specified stations. The Check Stations are not stored in the profile. This is a design tool for viewing the elevations at certain stations while adjusting the profile data. The last line has eight action buttons.

![Profile Editor](image)

**Add Row:** Adds a new row into the profile after the current row.  
**Remove Row:** Removes the current row.  
**Type of Profile:** Choose. Column titles and the amount of columns will change accordingly.  
**Hold Next Slopes:** A toggle that may applied or left blank.  
**Use K-Value:** Toggles between displaying K-Value and Sight Distance in the fifth column for road profiles.  
**Select Reference profile:** An option to show a second profile as reference. When a reference profile is active, the Check Stations and graphic window report the cut/fill with the current profile and the elevation of the reference profile. Also with a reference profile active, the spreadsheet adds a column for depth.  
**Vertical Speed Tables:** This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.  
**Next:** Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.  
**Previous:** Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.  
**Transform:** Allows you to either Translate or Scale the profile. Translate globally adds or subtracts value to stations and/or elevations within the specified range of stations, while Scale will apply the specified scale factor to stations and/or elevations within the specified range of stations.  
**Load:** Used for loading another, existing .PRO file for editing.  
**Save:** Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.  
**SaveAs:** Allows you to save the profile under a different profile file name.
Keyboard Command: profedit
Prerequisite: None
File Names: \lsp\profile.dcl, \lsp\profedit.arx

**Draw Profile**

*Draw Profile* is a flexible routine for drawing a profile anywhere in the drawing. The profile may be drawn with or without a grid or with just tick marks. The vertical curve annotations, for a road profile, and manhole annotations, for a sewer profile, may also be drawn. Draw Profile uses the profile information that is stored in .PRO files. Once the profile is drawn using Draw Profile, the design and labeling routines of the Profiles dropdown are applicable to the profile. The first step in Draw Profile is to choose the profile (.PRO) file(s) you want to draw.
The Draw Profile dialog box appears, and contains all of the settings for creating the profile.

**Draw Grid:** This option will draw a grid and axis elevations for the profile. Pick Setup to access Grid Setup dialog.
**Grid Direction:** Profiles can be drawn Left to Right (the default) or Right to Left. Although most profiles are drawn left to right, if you have a road that runs east to west and you wish to draw the profile stationing beneath the actual road stationing, then choosing a Right to Left profile may be appropriate. Unavailable when Draw Sheet is checked.

**Vertical Grid Adder to Top:** This adds the specified amount of grid to the top of the profile.

**Vertical Grid Adder to Bottom:** This adds the specified amount of grid to the bottom of the profile.

**Draw Elevation Bar:** Click on this option if you desire to have a vertical barscale displayed. It will run up and along the left-most vertical grid line of the profile.

**Label Scale:** Click on this option and you obtain a scale drawn at the lower left corner of the profile.

**Draw Elevation Labels Only On Left Side:** This option eliminates elevation labels on the right side of the profile.

**Offset Elevation Text:** This option offsets the left-side vertical axis text using the specified Offset Scale.

**Offset Station Text:** This option offsets the horizontal axis Station text by the specified Offset Scale, allowing the insertion of elevation or other information above the stationing. It is often used in conjunction with the Label Horizontal Axis options.

**Grid Type:** This selects the type of Grid to generate. The choices are Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks.

**Station Text Orientation:** This option allows you to specify the orientation of the station text shown along the bottom of the profile. The example below shows both options:
**Draw Sheet:** When checked, the profiles will be drawn in paper space. Plan Only, Profile Only, or Plan and Profile sheets can be created. Each plan and profile sheet is created in its own layout tab. When the plan and profile is drawn, you are placed in tilemode=0 and paper space. Click the "model" space tab (shown below) to return to model space to edit the plan view features, for example. The options within Sheet Setup become available when this toggle is checked on. Pick Setup to access the Sheet Setup dialog:

![Sheet Setup dialog](image)

**Layout Name:** Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the plan view and the profile view into sheet layouts, and if the length of the profile extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1. If you enter "ms" to go to model space within a layout tab, you can pan to alter the plan view position. Its best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

![Layout tabs](image)

**Block Name:** This is the drawing name for the plan and profile sheet to be inserted. Carlson provides a standard plan and profile drawing in the form of Profile.dwg located in the Support subdirectory. You may wish to revise Profile.dwg, add your company logo, and re-save it as Profile1.dwg or you could add your own complete version of a Plan and Profile sheet. If you choose the latter, you should examine the scale, dimensions and the lower left
corner of Profile.dwg, and try to duplicate those dimensions and corner coordinates in your own drawing. It is also important to store all your standard profile sheets in the Support subdirectory. You cannot draw Right to Left in Sheet mode. Note that the Sheet mode will re-orient the centerline left to right, which may cause text (such as the stationing) to plot upside down, until you use the Flip Text command under the Edit menu.

**Sheet Width:** This is the profile width, in inches, on the sheet. Even though the sheet is a fixed size, you can limit the length of the plot to 32 inches or less with this entry. If we used an entry of 16 for the example profile above, two plan and profile sheets would be created, because the first sheet would go from station 0+00 to 3+20 (16 inches at a 20 scale) and the second sheet would finish from 3+20 to 4+51.91. In English units, a typical entry here would be 30 for 30 inches.

**Overlap Station:** In multiple plan and profile sheet plotting, after the first sheet, all subsequent sheets will have the first 2 stations in common with the last 2 stations on the previous sheet, if the Overlap Station option is turned on. For example, if the last 2 stations are 3+10 and 3+20 on sheet 1, then sheet 2 will start with 3+10, then 3+20, with this option turned on. With this option turned off, if the first sheet ends with 3+20, then the second sheet would begin with 3+20.

**Sheet Contains:** This drop list allows the selection of which type of sheet to generate. The choices are Plan and Profile, Plan Only or Profile Only.

**Plan View Lower Y:** This sets the lower position of the paper space window for the plan view. With Lower Y set to 9 (inches above the base of the sheet) and Top Y set to 21, there is a 12 inch vertical window, running the full Sheet Width (typically 30 to 32). This window for the plan view can be expanded or reduced with these settings.

**Top Y:** This sets the top vertical limit for the plan view window, measured in inches from the bottom of the plan and profile sheet.

**Draw North Arrow in Plan View:** This draws a North Arrow in plan view.

**Draw Layout Plan View Borders in Model Space:** This draws the borders in Model Space.

**Plot at 1:1:** With this clicked on, the sheet will be paper size, designed to be plotted at 1:1. A 30-inch profile sheet will measure 30 units, even though the centerline and profile may be 1500 feet in length. If the Scale 1:1 option is turned on, then you cannot check the distances of features using commands such as Bearing and Distance on the Inquiry menu, because the distances will be scaled down by a factor equal to the drawing scale (for example, at 1"=50', the reduction in scale factor is 1/50 or 0.02). You can set the absolute starting coordinate for the 1:1 scaled plot by setting the Sheet Lower X and Sheet Lower Y. With this clicked off, the profile will drawn full size, with a 1500-foot profile measuring 1500 feet.

**Fit Each Vertical:** With this option turned on, the command will recognize the lower and upper vertical elevations of the profile and set the vertical axis elevation range to enclose the actual elevation limits of the profile. With this option turned off, you can enter the lower vertical elevation range, dropping it down further to increase the lower margin. Whether or not the Fit Each Vertical option is turned on or off, you are always prompted for the top elevation range.

**Tile Sheets:** If clicked on, only one Layout is created in paper space, and all sheets appear in this single Layout as tiles of individual sheets, much like the tiles mode of viewing files within Windows Explorer.

**Label Match Line:** When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.
Prompts (Draw Sheet option)

You are first asked to select the polyline that represents the centerline, and the program best fits the centerline in the plan view portion of the plan and profile sheet, then captures all of the associated drawing that will fit in that paper space window. If the length of the polyline divided by the scale exceeds the Sheet Width entry (for example, 5000 feet of road divided by 50 Horiz. Scale is 100, which exceeds the sheet width), then multiple plan and profile sheets will be automatically created. A 5000 foot road at 50 scale with a 30-inch sheet width, would lead to 3 full sheets of 1500 feet each and a "leftover" fourth sheet showing the last 500 feet.

Bottom Vertical Spacing <0.0>? press Enter

The program places the profile plot flush against the bottom of the vertical grid, by default. This prompt allows for an offset, moving the profile plot up off the bottom of the grid. If the lowest elevation of the profile is 940 by default, entering 10 would start vertical axis labeling at 930, and if the vertical scale was 5 units, this would push the vertical plot up 10 units or 2 standard grid intervals.

Top Elevation of Profile Grid <945.0>: press Enter
Cl File/Select polyline that represents centerline: Select the centerline polyline (if Draw Plan has been clicked on).
Beginning Station <0.0>: press Enter

The items below refer again to the profile options that are independent of the Draw Sheet option:

Draw Horiz Axis Elev: This option creates elevation labels along the horizontal axis. Pick Setup to access the Horizontal Axis Elevations settings dialog.
Draw Horiz Label Box: This option draws a boxed area underneath the profile. It is best used in standard Draw Grid mode, with Draw Sheets clicked off. Pick Setup to access the Horizontal Label Box Setup dialog. An example of the resulting plot is shown here:
**Draw Break Point Sta:** Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Station Setup dialog.

![Break Point Station Setup dialog]

**Draw Break Point Elev:** Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Elevation Setup dialog.
**Draw Break Point Desc:** Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Description Setup dialog.

**Starting Station:** This field defaults to the starting station in the selected profile(s). If changed, the starting station can move forward, clipping out the first part of the profile. When you are not plotting sheets, you must set the starting station to the end of the previous sheet's ending station to force a multiple sheet layout.

**Ending Station:** This field defaults to the ending station in the selected profile(s). A profile that is 3000 feet in length could be plotted in 2 parts, first station 0 to 1500, then station 1500 to 3000, using the Starting Station and Ending Station options.

**Label Text Scaler:** This sets the size of text used for vertical curve annotation to the horizontal scale times the scaler, when you are working in English units. In metric units the text height would be $0.01 \times \text{horizontal scale} \times \text{scaler}$.

**Link To Files:** This setting controls the linkage of the plotted profile(s) to the actual profile file(s) (.PRO), determining how changes to the file affect the plotted profile(s). If set to Off, there is no linkage, Prompt will
ask whether to update the plotted profile(s) when the file changes, and Auto will automatically update the plotted profile(s) when the file changes.

**Match Line Elevations:** For high relief profiles that might otherwise extend up and into the plan view portion of the drawing, the Match Line Elevations option can be used to break the profile and redraw the remaining portion with its own vertical scale, as seen above.

**Elevation Range:** This is the range of elevations that is used in conjunction with the Match Line Elevation option. If the range is exceeded (that is, if the range above is 20), the program will break the profile and draw the remainder with a separate vertical axis range.

**Grid Scale and Interval Settings**

**Horizontal Scale:** This scale applies primarily to text size. If the text scaler is 0.1 and the horizontal scale is 50, then text size will be $0.1 \times 50 = 5$.

**Horizontal Grid Interval:** This sets the spacing of the grids that run vertically from the horizontal scale.

**Horizontal Text Interval:** This sets the spacing of the stationing text that appears along the horizontal axis. When using a large "Axis Text Scaler", the horizontal axis text can become too large, and it often necessary to space the horizontal text interval at twice the horizontal scale.

**Vertical Scale:** This scale sets the vertical exaggeration of the profile. If the horizontal scale and vertical scale are the same, then the vertical is not exaggerated. Profiles are often plotted with a 5 or 10 vertical exaggeration. For example, the horizontal scale may be 50, but the vertical scale may be 5.

**Vertical Grid Interval:** This sets the spacing of the grids that run horizontally between the vertical axes on the left and right side of the profile.

**Vertical Text Interval:** This sets the spacing of the elevation text that appears along the vertical axes.

**Label Settings:** These 4 buttons are where you gain access to control over specific label settings for different profile types.

Layers, Colors, Text Styles and Linetypes buttons provide access to settings for each of these features of the profiles.
Load Settings: Loads a saved collection of Draw Profile settings, saved in a (.PFS) file.

Save Settings: Saves all Draw Profile settings in a (.PFS) file.

When OK is clicked at the base of the dialog box, the prompting at the command line continues. In this example, assume that a road profile has been selected, since more prompts will occur with road profiles than with generic profiles.

Prompts (Road profile example)

Erase existing profile from drawing [<Yes>/No]? N This prompt appears only if you have previously drawn the profile.
Next a dialog appears to set the Profile Grid Elevation Range by specifying the Top and Bottom Elevations. Adjust as desired, pick OK.

Pick Starting Point for Grid <8779.55, 5716.36>: pick a point for the lower left corner of the grid

Assuming a road profile has been selected, the following dialog box appears:

Include K-value: This option is a function of the change in slopes on either side of the point of vertical intersection.
Include Sight Distance: This option is computed by the delta slope and is a function of whether the vertical curve is a sag or a crest.
Include Grade: This option draws slopes along the tangent portion of the vertical curves, with slope direction arrows.
Draw Vertical PVC and PVT Lines: This option draws vertical lines emanating from the PVC and PVT of all vertical curves.
Position Text Below Line: This option draws the PVC, PVI, and PVT information under the picked location for the vertical curve labeling.
**Pick Each Label Position:** If there were more than one vertical curve in the profile, this option allows you to pick a vertical position for each of the vertical curve’s annotation.

**Draw Slope Direction Arrow:** Draws an arrow to indicate slope direction.

**Number of Decimal Places:** Choose the decimal precision used in the elevation and stationing annotation for vertical curves.

Next, select a point vertically that corresponds to the position of the left-right lines under which is written percent grade and above which is written the vertical curve length, sight distance, and K-factor, if requested. The PVC, PVI, and PVT stations and elevations are written above or below this picked point depending on dialog box settings.

Sewer Options:
Additional Prompting for Multiple Profiles

Detected multiple profiles within C:\CARLSON PROJECTS\2006-0124\DATA\PRO\EXAMPLE.PRO

Note that the Profile from Surface Entities command can store additional profiles into the same profile file.

**Draw profiles on same or different grids** (Same / Different)? press Enter This determines whether the multiple profiles will be drawn together on the same grid or drawn on separate grids.

**Uniform or variable grid size** (Uniform / Variable)? press Enter This selects between one-size-fits all grids or
individually sized grids for each profile.

**Keyboard Command:** drawprof

**Prerequisite:** A .PRO file

**File Names:** \%lsp\%drawprof.lsp, \%lsp\%profile.dcl, \%lsp\%vcplot.lsp, \%lsp\%endsewer.lsp

### Profile to 3D Polyline

This command converts a 2D polyline centerline into a 3D polyline that follows the elevations of the profile. Horizontal and vertical curves are represented as a series of polyline segments since 3D polylines cannot contain arcs. Profile to 3D Polyline can be combined with other commands for plan-view road design as follows:

1. Draw 2D polyline centerline.
2. Profile from Surface Model - to create existing surface profile.
3. Design Road Profile - to design the final profile with vertical curves.
4. Profile to 3D Polyline - create a 3D polyline of the road centerline.
5. Offset 3D Polyline - offset the 3D polyline centerline left and right by the horizontal and vertical distances.
6. Design Pad Template - run twice for left and right polylines of road to tie into surface at specified cut and fill slopes. This creates the limits of the disturbed area. Or use Join Nearest, Direct Connect Endpoints, to create a closed loop pad with one run of Design Pad Template for simple ramps, driveways and access roads.
7. Triangulate & Contour - draw final contours using road 3D polylines.
8. Volumes - use any of the volumes commands to calculate cut and fill volumes.

### Prompts

**Layer Name for 3D Polyline <3DPROF>:** press Enter

**Select profile centerline polyline:** pick a polyline

**Station by another reference centerline [Yes/<No>]?** N for no. This option will prompt for a second centerline to use for stationing.

**Enter the starting station <0.0>:** press Enter

**Select Profile File**

**Starting station of centerline <0.0>:** press Enter

**Erase centerline (Yes/<No)?** Y This option will erase the original 2D polyline centerline.

Example of road design in plan-view with Profile to 3D Polyline
Keyword Command: proto3dp
Prerequisite: A .PRO file and a centerline polyline
File Name: \lsp\profedit.arx

Profile To Points

This command creates Carlson points along a horizontal alignment polyline using a profile file to compute the point elevations. The created points are stored in a coordinate (.CRD) file and can also be drawn on screen in the layer specified by the user. Station text, profile name, and special points (vertical and horizontal PC's and PT's) can be stored in the point description depending on user settings.

Create points at Profile special points: Includes vertical PC and PT points.
Create points at Centerline special points: Includes horizontal PC and PT points.
Create points at Station Intervals: Allows you to specify intervals for point creation.
Interval On Line Segments: Specify station interval for line segments.
Interval On Curve Segments: Specify station interval for curve segments.
Station To Begin Intervals: Specify station to start intervals.
Prompt For Additional Odd Stations: Any station can be entered to create additional points with elevations derived from the profile.
Create Points on Centerline: When checked, points will be created on the centerline.
Create Left Offset Points: When checked, left offset points will be created. Specify the offset in the edit box.
Create Right Offset Points: When checked, right offset points will be created. Specify the offset in the edit box.
Vertical Offset of Profile: Specify the vertical offset. Enter zero for no vertical offset.
Plot Points: When checked, points will be plotted in the drawing, otherwise points are only added to the current coordinate (.CRD) file.
Include profile name in point descriptions: When checked, the profile name will be used as the prefix on the the point description. For example, if the profile name is DESIGN.PRO, then the point description might be
DESIGN 0+63.37

Decimal Places: Specify the display precision for points that are plotted in the drawing. This setting does not affect the coordinates stored in the CRD file.

Centerline by: Click either Polyline or CL File.

Type of Centerline: Click either Roadway or Railroad.

OK: Specify files.

Prompts

Select Coordinate File to Process
If the current coordinate is set, it is used automatically without this prompt.

Select profile centerline polyline: pick a polyline

Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing.

Starting station of centerline <0.0>: press Enter

Choose Profile to Process dialog Specify a profile name.

Starting point number <1>: press Enter This defaults to the point number after the highest one currently in the CRD file.

Station for additional point (ENTER to end): press Enter This option will create a point at the specified station. Prompt occurs only if option is specified in dialog.

Keyboard Command: pro2pts

Prerequisite: A .PRO file and a centerline polyline

File Name: \lsp\profedit.arx

Convert LDD Contours

This command allows you to convert Autodesk Land Desktop contours (known as AECC_CONTOUR objects) into polylines. You must have the AEC Object Enabler installed before using this command. If you do not have the

**Note:** If no object enabler is installed, opening a Land Desktop drawing with contours will display large boxes for each contour, essentially outlining the extents of each one. In this case you will need to download the object enabler. If the object enabler is installed, contours will appear normally, and you can use this command to convert them to standard Iwpolylnes or you can use the AutoCAD *Explode* command. The Carlson *Convert LDD Contours* command is preferable only in the fact that it will search the drawing for AECC_CONTOUR objects and convert only those, while an AutoCAD *Explode* command could inadvertently explode other entities that you do not wish to be exploded.

You can use the *List* command to determine if contours are polylines or AECC_Contour objects. Here is an example listing:

```
AECC_CONTOUR Layer: "CONT-MJR"
Space: Model space
Handle = 429
Major Contour Interval
Elevation: 1005.00
Smoothing: None
Number of Vertices: 48
Open
Length: 560.25
Constant width: 0.00
Style Name: Standard
```

**Prompts**

Select AEC Contours to convert
Select objects: *pick the AEC contour entities*

Pulldown Menu Location: Surface >> Import/Export
Keyboard Command: aec_cntr
Prerequisite: AEC Contours to convert
File Name: \lsp\dtm1.fas

**Profile Conversions**

There are eleven Profile Conversion commands, all of which are listed below. The first nine in the list are Import Profile commands. These commands allow you to convert a single profile file from their respective program to the Carlson profile (.PRO) format. For each, you are prompted to select the file to be imported, then provide a Carlson profile file name. Underneath each of the nine brief descriptions shown are, in bold, the prompts that you see in dialog box form and/or on the command line.

The last two commands listed below are Export Profile commands. They allow you to convert a single Carlson profile (.PRO) file to Softdesk (.TXT) format, or a single Carlson profile (.PRO) file to Leica (.GSI) format. You are prompted to select the Carlson profile file, then provide a name for the Softdesk or Leica file.

**Import Columnar Text**

*Chapter 16. Surface Menu*
Allows you to Import a comma or space delimited text file to create a profile (.PRO) file.

**Import CAiCE Profile**

Allows you to convert a single CAiCE (.KCP) profile file to the Carlson profile (.PRO) format. You are prompted to select the CAiCE file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** caice2pro  
**File Name:** \lsp\profedit.arx

**Import Leica Profile**

Allows you to convert a single Leica profile (.GSI) file to the Carlson profile (.PRO) format. You are prompted to select the Leica file then provide a Carlson profile file name.

**Choose Leica/Wild File to Readdialog** Select existing file.  
**Choose Profile to Writedialog** Select file name.  
**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** wildpro2  
**File Name:** \lsp\profedit.arx

**Import MOSS Profile**

Allows you to convert a single MOSS profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the MOSS file then provide a Carlson profile file name.

**Choose MOSS Profile File to Readdialog** Select existing file.  
**Choose Profile to Writedialog** Select file name.  
**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** moss2pro  
**File Name:** \lsp\profedit.arx
Import Softdesk Profile

Allows you to convert a single Softdesk profile (.TXT) file to the Carlson profile (.PRO) format. You are prompted to select the Softdesk file then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** dcapro2  
**File Name:** \lsp\profedit.arx

Import Sokkia/SDR Profile

Allows you to convert a single Sokkia/SDR (.SDR or .RAW) profile file to the Carlson profile (.PRO) format. You are prompted to select the Sokkia/SDR file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** sdr2pro  
**File Name:** \lsp\gisutil.arx

Import Spanish ALZ Profile

Allows you to convert a single Spanish ALZ profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish ALZ file and then provide a Carlson profile file name.

Choose CLIP File to Read  
Choose Profile to Write  
**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** alz_to_pro  
**File Name:** \lsp\eworks.arx

Import Spanish RAS Profile

Allows you to convert a single Spanish RAS profile (.RAS) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish RAS file and then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** ras_to_pro  
**File Name:** \lsp\eworks.arx

Import Terramodel Profile

Allows you to convert a single Terramodel (.RLN) profile file to the Carlson profile (.PRO) format. You are prompted to select the Terramodel file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** tm2pro  
**File Name:** \lsp\gisutil.arx

Export Softdesk Profile
Choose Profile File to Read dialog Select existing .PRO file.
Choose Softdesk File to Write dialog Enter new Softdesk file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro1
File Name: \lsp\profedit.arx

Export Leica Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Wild File to Write dialog Enter new .GSI file name.
GSI file format [<8>/<16]? press Enter

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Commands: wildpro1
File Names: \lsp\cogoutil.arx
The GIS menu shown below has commands for managing and reporting data attached to drawing entities.
GIS Database Settings

This command sets the current Template and Output MDB files. The Template MDB file defines the GIS codes and the field names for each code. The Output MDB file is the database file where any new data will be stored. The MDB files for the Template and Output MDB files can be set up as either new MicroSoft® Access '97 or new Microsoft® Access 2000 database format files, or part of an existing MDB file. Either existing or new MDB files may be chosen or created for this GIS Database Setting routine.

Prompts

GIS Setting dialog Click both file buttons and select new or existing files.

Pulldown Menu Location: GIS Data
Keyboard Command: gis_config
Prerequisite: None
File Name: \lsp\gisprt.lsp

Define Template Database

This command prepares the fields for prompting to attach data to objects. The prompts are stored in the form of an .MDB file. A feature, such as a manhole, can have several prompts, such as Number of rungs, Type of material, Number of inlets, etc. Features can be organized into Categories: Utilities, Roads, Properties. The Category designation is an arbitrary way of organizing the features. Features and the prompts can be imported from Object Data found within the drawing in AutoCAD Map, or from tables within standard MDB database files, or from the Carlson .GIS files that are used by SurvStar, Carlson Field and other Carlson products to generate prompts. A Carlson GIS file works by triggering prompts when a description such as "mh", for manhole, finds a corresponding MH.GIS file.
with pre-defined prompts and default responses. But the most common way to develop features, and the associated prompting, is to enter them directly here in Define Template Database, rather than using the three import options. From a database standpoint, features are the same as tables.

To create GIS prompting for ASCII and MDB GIS features, you need to input the following fields in the dialog box:

1) The first field to set is the Template Database, or MDB file. All MDB GIS prompting is stored in one template Microsoft® Access MDB file named here. To create a new MDB, choose the Template Database pulldown from the top of the Define Template Database dialog, then New, and then select which type of new MDB file you would like to create. Your choices are New Access '97 format or New Access 2000 format. You can also load an existing MDB Template file by choosing Open under the same pulldown.

2) The next field is the Category Name, found within a pulldown called Category. GIS feature codes can be categorized (e.g. STRUCTURES, UTILITIES, ROAD FEATURES, etc.). At least one category must be created. This is because in order to Export a GIS File to the Template MDB file, this routine requires a category to export the GIS code under. After selecting New and inputting a category name, click OK to create this category in the template MDB file.

3) The next field is Feature, which has a pulldown as well. A category such as UTILITIES might have features such as manholes, light poles, fire hydrants, water valves, etc. The GIS feature name needs to be input by selecting New. This GIS feature name is very important because it identifies the group of data fields.

4) You can upload features to SurvCE, GISCE or FAST Survey using a GIS File pulldown option. Using this option you will be able to choose a .FLD file.

5) The GIS prompting is input under ATTRIBUTE (abbr), ATTRIBUTE (full name), LIST VALUES, REQUIRED and TYPE. Once values are specified, only these values can be used. Values are entered by typing them under the List column and hitting Enter, then typing another, hitting Enter and continuing until complete. The default value is the one displayed when the GIS Code is stored to the MDB template file using Save As in the Feature pulldown. Fields, when created, can be designated Char, Int or Real. Fields with pre-set responses will default to Char type. To add a new attribute, click on the first available blank cell in the first Attribute row of the list, shown in the Define Template Database dialog, and click Insert.

6) To store the new prompts and field names, click Save As under Feature.

7) To use this dialog to "back-door" create a GIS File for the ASCII method of prompting (the .GIS file method), click Export under the GIS File pulldown at the top of dialog. This ASCII .GIS file will then be available to SurvStar for field prompting.

8) To import the attributes and jump start the completion of attribute full names, attribute prompts and other table elements, you can use Import under the GIS File pulldown. This will read a Carlson .GIS file.
Automatic versus Prompted Values

It is possible to assign data to objects automatically, without any prompting. The automatic items are pre-set responses the program knows, such as date, time, currently configured instrument, etc. When the cursor is located in the List Values column, press the down arrow on the right side of one of the cells. You will see the available known data fields. Here you can select variable. The list may expand with new builds of Carlson.

Template Database pulldown option
Input-Edit GIS Data

This routine creates, reviews and appends GIS data linked to entities stored in the AutoCAD drawing.

The GIS Smart Prompting dialog has a spreadsheet format for editing the data fields. The GIS table to process is selected in the pull-down list in the upper right of the dialog. The GIS tables that are available depend on the tables that are defined in the current template database. Use the GIS Database Settings and Define Template Database commands to setup the tables. Once you select a table to process, the fields for that table are displayed in a spreadsheet format. If a field is related to a field in another table in the database, a "+" character is shown next to the field name. Picking the "+" will open another dialog box with the related data in the other table. The data in this related table is not editable, only the data in the initial linked table.

The bottom portion of the dialog has features for attaching images to the entity. Existing image files (BMP, JPG or GIF) can be linked by choosing the New option. The Update option will replace the current image with a newly selected image. The Delete option will remove the current, attached image. The Capture button will take a shot in the field using a configured camera and then attach the image to the entity. Different digital cameras can be used by picking Pick or Set Camera.

The Input-Edit GIS Data command is an excellent way to simply review the data associated with an entity. If the entity has GIS data, the banner line at the top of the dialog will display "Entity has GIS Data". If not, the banner line will display "Entity has no GIS Data". Even when the entity has no data, the default values for the prompts will appear. Pressing OK will assign this data to the entity. To avoid assigning data to the entity (if it has none), press Cancel. Alternately, you can use the commands GIS Inspector Settings, followed by GIS Data Inspector, to review the data with no possibility of editing or inputting data in the process.

There are three methods for selecting the drawing entities to process: S for Select, P for Pick and N for Number:

Select Object method: With this method, you pick the drawing entity to process the data attached to that entity.
When selecting a Carlson point, the point number is used to link to the database.

**Pick method:** For this method, you pick inside a closed polyline to process the data attached to that polyline.

**Number method:** Here you simply input the point number from the current CRD file to process.

**Prompts**

Select object (Number/Pick/<Select>):  \textit{P}

Pick a point inside polygon (Select/Number/<Pick>):  \textit{pick a point}

GIS Smart Prompting dialog \textit{make selections}

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** gisdata

**Prerequisite:** MDB GIS prompting must be created in \textit{Define Template Database} and points or entities must exist to link GIS information to.

**File Name:** \textbackslash lsp\gisprt.arx

### GIS Inspector

This command displays all or portions of the data attached to drawing entities in real-time. How much of the attached data is displayed is set by the command GIS Inspector Settings. When you move the cursor over an entity with GIS data, selected fields are displayed in a tooltip box next to the cursor. For data attached to closed polylines, you can move the cursor anywhere inside the polyline to show the data. Polylines that are closed will highlight with a solid fill as you inspect each one. Open polylines, such as road centerlines, will highlight with a solid fill generated along the length of the polyline. The solid fill color for all highlighting is set in GIS Inspector Settings.

The routine starts by prompting you to select entities. The entities that you select will be used by GIS Inspector. In the case of a large drawing, this selection allows you to limit the entities for inspector to a local area instead of having to process the whole drawing. Then after reading the entities, you can move the cursor around the drawing to inspect the GIS data. You can also use the arrow, page up and page down keys to pan and zoom the display. Pressing enter ends the routine.

**Prompts**

Select objects: \textit{select entities with attached data}

Arrow keys=Pan; PageUp/Down=ZoomOut/In;
Pulldown Menu Location: GIS Data
Keyboard Command: gis_inspector
Prerequisite: MDB GIS Prompting must be created in Define Template Database and entities must have linked GIS information.
File Name: \lsp\gisview.arx

GIS Inspector Settings

This command sets up the fields to be displayed when using GIS Data Inspector. Each GIS table code can have different display options stored in the GIS Inspector Settings command.

GIS Inspector Settings reads all the points and entities with GIS information currently linked in the drawing and displays a list of the linked data tables under the Available GIS Table column. When a GIS Table code is highlighted (i.e. 0001 or Road), the fields for this GIS table are displayed to the right in the Select Fields column. Up to 6 fields or lines of GIS data can be defined for display for each GIS code table, including one picture. To add a field to the display list, double-click on the field name. To remove a field from the display list, highlight the GIS table to remove from and then use the Clear Settings buttons. The Last Option button will remove the last field to display from the current GIS table. The Picture Name will remove the image from the display list. The Entire Line button removes all the fields from display for the current GIS table.
GIS Query/Report

This command applies a user-defined query on a data table or related tables with the database. Records in the table that pass the query can be reported or the associated entities can be highlighted in the drawing. The Query Using option in the main dialog box sets the source of the data table to process as either GIS data attached to selected drawing entities or from the current Output MDB file.

The query is defined in the dialog shown here. To add a query, enter a new query name in the in the space underneath Current Query. If there is already a name there, just highlight and type over it with a new name, then hit Clear to clear out existing query lines and get full access to all Table Names. Set the Current Output MDB. Under Table Name, a list of all tables in the Current Output MDB with GIS links is available. Choose the table for the initial query. Once a table is selected, add a parameter is created and added, the Table Names list becomes unavailable because any additional query parameters must come from that table, or relate through that primary table.

The top portion of the dialog contains a list of the query parameters. To add a parameter, select a table name from the Table pop-up list. The available tables will either be all the tables found in the GIS links of the drawing or all the tables from the Output MDB file depending on the Query Using option. Once the table is specified, the Field Name pop-up list contains all the available fields in the table. Choose a field from this list. Next choose the operator (=, >, etc.) from the operator list. The Value pop-up list contains all the different values for that field that are found in the current data set. You can either select one of these values or type in another value into this field. If a Field Name relates to another Table, when you select that Field, an additional button will appear allowing you to add a
query parameter from the related table.

When all the parameter values are set, pick the Add Parameter button.

When all the parameters are defined for the query, you can save these settings by filling out a name Current Query field and then picking the Save Query button. This query can be recalled later by highlighting the query name and clicking the Load Query button.

Pick the Execute button to process the query. With the Generate Report option, the program will bring up the Report Formatter which allows you to choose the fields to include in the report and the report format. If the Highlight Screen Entities option is on, then the program will highlight the entities with GIS data that pass the query. Point entities are highlighted by drawing a box around the point and polylines are highlighted by solid fill. Shown here is the report for all manholes with a Condition of Good.
**Pulldown Menu Location:** GIS Data

**Keyboard Command:** gis_query

**Prerequisite:** MDB file with data or entities with linked GIS information

**File Name:** \lsp\gisview.arx

---

**Label GIS Polyline: Closed Polyline Image**

This command draws images inside the selected closed polylines with attached GIS image files. Images can be assigned to polylines by the Input-Edit GIS Data command.

The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the image to draw. This dialog displays a list of all the GIS table names found in the selected polylines. First choose a table to process. Then the image fields defined for this table are displayed in the lower list. Only one image can be draw inside the polyline. The Erase Images button will erase any existing images inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.gsf) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to draw the images. The images are drawn in the centroid of the polylines.

---

*Chapter 17. GIS Menu*
Example of images drawn inside closed polylines

**Pull down Menu Location:** GIS > Label GIS Polyline  
**Keyboard Command:** display_polygon_image  
**Prerequisite:** Closed polylines with linked GIS images  
**File Name:** \lsp\gislab.arx
Label GIS Polyline: Closed Polyline Data

This command draws text labels for the specified fields inside the selected closed polylines with attached GIS data. The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn center justified in the centroid of the polylines.
Label Closed Polyline Data result of country name and population fields

Pull down Menu Location: GIS > Label GIS Polyline
Keyboard Command: display_polygon_image
Prerequisite: Closed polylines with linked GIS information
File Name: \lsp\gislab.arx

Label GIS Polyline: Open Polyline Data

This command draws text labels for the specified fields along the selected polylines with attached GIS data. The program starts by selecting polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels for the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn along the polylines.
Example of text labels along polylines with GIS data

**Pulldown Menu Location:** GIS > Label GIS Polyline  
**Keyboard Command:** label_arc_text  
**Prerequisite:** Polylines with linked GIS information  
**File Name:** \sp\gislab.arx
Create Links

This command makes GIS links between blocks in the drawing and a database table using a key field that is in both the block attributes and the database table. Both the block entities and database records must exist before running this routine.

The routine starts by prompting you to select the block entities to process. Then a dialog appears for choosing the block attribute and table to link. The current template and output database file names are shown at the top of the dialog. Use the GIS Database Settings command to set these file names before running Create GIS Links. The dialog lists all the block names that were found in the entity selection. Choose a block name to process. Then in the lower left of the dialog, there is a list of the attributes for the selected block. Highlight the attribute name that contains the point ID key field for the blocks and then pick the Select First Key Value button. For each block entity, the program will use the value of this attribute to link to the record in database table. This value is matched to the database record using the PT_ID database table field. For example, a block with an attribute value of 402 for the specified attribute name will be linked to the database record with a value of 402 in the PT_ID field.

Next, the database table needs to be specified to either one fixed table name or to table names defined by a block attribute. A list of the available tables in the current output database is displayed. To link all the blocks to one table, highlight the table name from the list and pick the Select Second Key button. Or to link the blocks to various table names based on a block attribute, highlight the attribute name and pick the Select Second Key button. This attribute value for the blocks will then need to contain the database table name. For example, consider a block for electric utility data with two attributes: ID and TABLE. The ID is a number to use as the first key and the TABLE is the table name (i.e. POLE, BOX). Once the key fields are set, pick the OK button to create the links.

Pulldown Menu Location: GIS Data
Keyboard Command: create_links
Prerequisite: Block entities with attribute IDs and a database table with matching IDs.
File Name: \lsp\gisprt.arx
**Erase Links**

This command removes all the GIS links from the selected entities (polylines, blocks, etc.).

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** erase_links  
**Prerequisite:** Entities with GIS links  
**File Name:** \lsp\gisprt.lsp

**Audit Links**

This command checks the GIS links for the selected entities in the drawing to make sure that the template database, output database and table exist. Any invalid links can be erased from the entities or be fixed by selecting another database or table. For example if a database file (.mdb) has moved to another directory, then you can use this command to specify the new location.

The routine starts by prompting you to select the entities to check. If no errors are found, then the routine is done. When there are errors, a dialog box appears. Each GIS link is defined by a template database, output database and table. For each combination of these three settings that have an error, this dialog displays the template database, output database and table name from the entities. The number of GIS link combinations with errors is shown in Table Used for Links field (i.e. 1 of 2). The template database is shown at the top. If the template database link is broken, then use the Select New Template MDB button to assign another template database file. The output database also has a Select New Output MDB to set the output database file. In the lower left of the dialog is a list of the table names from the output database. You can choose the table to use for the link from this list. The Fix Links for Current Table button will assign the template database, output database and table name from the dialog to all the selected entities. The Erase Links from Table button will remove these broken links from the entities. The Go to Other Table button will process the next GIS link combination with errors.

![Audit GIS Links from Current Drawing](image)

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** audit_links
Prerequisite: Entities with GIS links
File Name: \lsp\gisprt.arx

Import SHP File

The Import/Export SHP file routines convert ESRI SHP files into Carlson GIS links and back. The Import SHP command reads database information from ESRI ArcView SHP files, and loads these SHP files into Carlson with the database information intact. You can read SHP files into Carlson and after completing all mapping convert these GIS features back into ESRI SHP files. The SHP Export command converts drawing entities and GIS links in Carlson into SHP files for input into ESRI's ArcView product.

These routines are useful GIS data collection tools since the majority of surveying and civil engineering maps are created in the AutoCAD drawing (.DWG) format and the majority of GIS produced maps are made in the ESRI shape (SHP) format. Carlson combines these two formats effortlessly and seamlessly. The GIS professional can stay with ESRI's ArcView SHP format while all field and GIS mapping can still be done in the AutoCAD drawing environment.

The Import SHP File dialog displays the Output MDB file to add data to and the source SHP file to be imported. SHP files are similar to entities in one layer in AutoCAD. You must specify the table name to store the data in the MDB database and the layer name for the entities to be created. Typically these names are the same or near equivalent as the SHP file name. Once these names are entered, the Import Polylines from SHP button becomes available. Pick this button to import the SHP files entities and database. You can also assign elevations by a specified data attribute.

ESRI ArcView creates primarily three types of SHP files: Points, Arcs and Polygons. Both Arc and Polygon SHP files are brought into Carlson as polylines in the drawing and data stored in a table in an MDB database file. Point SHP files are imported in a three step process. The first step uses the Import SHP File command to create a coordinate file (.crd) for the points in the SHP file and a corresponding table in the output MDB file for the points database. The second is to use Draw Locate Points to draw the points from the CRD file into the drawing. The third step uses Create Links to select the points in the drawing and link the database to these plotted points. Once the SHP file is selected, Carlson detects the data contents of the file and sets the dialog options for importing either polygons, arcs or points.

Pulldown Menu Location: GIS Data
Keyboard Command: import_shp
File Name: \lsp\gisprt.arx

Chapter 17. GIS Menu
Export SHP File

This command creates a SHP file from the selected entities in the drawing. After selecting entities to be converted, a dialog shows the number of Points, Polylines (Arens) and Closed Polylines (Polygons) found in the drawing selection set. Those Points, Arcs and Polygons with database information linked are displayed with their database table names. Any Points, Arcs and Polygons without linked database information display as unknown.

Highlight the Point, Arc and Polygon tables to output or selects Export All to select all entities including the UNKNOWN entities to export into SHP files. The Export SHP File commands outputs all entities selected into SHP files with the same name as their table name into a subdirectory selected. Also Points can be stored in the ESRI Arcview database as 3D X, Y and Z coordinates when Include Z Coordinates is toggled on. SHP files do not have arc entities. So the export routine will convert arcs and polyline arcs into a series of small chords segments. The Offset Cutoff field sets the maximum horizontal shift allowed between the original arc and the chord segments.

These SHP files can be imported into ESRI's Arcview product. Database GIS links in Carlson are converted to SHP files by storing the GIS database information into DBF files for ESRI's Arcview product to read and link to.

Prompts

Specify Name for SHP File dialog select .SHP file name
Select objects select entities
Export Carlson Entities to SHP File dialog choose settings, click OK

Pulldown Menu Location: GIS Data
Keyboard Command: export_shp
Prerequisite: None
File Name: \sp\gisprt.arx

Image Inspector

This command views images attached to entities. At the start, the program highlights all entities that have attached images. When you move the cursor over these entities, the attached image is displayed in a window. If you click within the image window, the program will start the image application editor that is setup for your system.
This application, such as Microsoft Internet Explorer, depends on your Windows system setup. Also while moving the cursor over drawing entities, you can use the arrow, page up and page down keys to pan and zoom the display.

Prompts

Arrow keys=Pan; PageUp/Down=ZoomOut/In; Pick Image Box = Open Image!
Move pointer over entity with image (Enter to End): press Enter

Keyboard Command: view_image
Prerequisite: drawing entity with attached image
File Name: /lsp/gisutil.arx

Place Camera Symbol/Image

Prompts

Image File To Process: choose .TIF file

Pulldown Menu Location: GIS Tools
Keyboard Command: maketfw
Prerequisite: TIF image file
File Name: lsp	ifutil.arx
**Attach Image to Entity**

This command attaches an image file to a drawing entity. The possible image file formats are .bmp, .jpg and .gif. Any type of drawing entity can be used such as polyline, points or symbols. To run the command, first pick an entity on the screen. Then a dialog appears for selecting the image. First set the image directory and then highlight the image file name. A graphic of the image should appear in the preview window. Then click OK.

The Capture Image button can be used to trigger an attached digital camera to take an image. The Pick Camera and Set Camera buttons can be used to configure the camera to use.

The View Image button will display in the preview window any image already attached to the entity. Also any image already attached to the selected entity is displayed in the Current Image field at the top of the dialog.

**Prompts**

**Select object to attach symbol to:** *pick an entity*

**Attach Image to Object Dialog**

**Done.**

**Select object to attach symbol to:** *press Enter*

**Keyboard Command:** set_image

**Prerequisite:** A drawing entity and an image file

**File Name:** \lsp\gisutil.arx

**Define Note File Prompts**

This command allows the user to create a .GIS file for use in several other routines in Carlson GIS and other Carlson Software products, such as SurvCE or SurvStar.
The program starts with the main Define Note File Prompts dialog, as shown below. The Load button allows the user to load an existing GIS file for editing or review. The list box shows the various data capture items in the GIS file, showing the field name, the prompt, the default value and the various options for that field. The Edit button allows the user to edit the highlighted field. The Add button allows the user to add new fields after the highlighted field. The Move Up and Move Down allow the user to change the order in which fields appear in the GIS file, while the Remove button completely removes the highlighted field. The Save button saves the GIS file that is currently being edited, while SaveAs allows the user to save the current GIS file under a different name. The Quit button checks to see if the current GIS file is saved and quits the routine.

When the Edit or Add button is clicked, the dialog box shown here appears, allowing the user to enter and edit data with respect to a particular field in the GIS file. The Field Name is a unique identifier of the field in the GIS file and hence a GIS file cannot have repeated field names. The Prompt is what appears at the command prompt while waits for user input. The Default Value is the value that would be used among various options, if the user presses Enter at the command prompt without typing anything in response to the prompt. The list box, Options for value, contains a list of options that can be selected for the particular field. A new option can be added to the list or removed from the list by clicking the appropriate button. The Add Option button brings up a small dialog and accepts the option to be included in the list. Press OK to accept the values set here. At the minimum, the Field Name and Prompt must be specified.

![Define Note File Prompts dialog](image)

**Define Note File Prompts dialog** Load a file, or change variables as required.
Pulldown Menu Location: GIS Data
Keyboard Command: defnote
Prerequisite: None
File Name: \lsp\cogoutil.arx

Database File Utilities

This command is designed to import GIS data from SurvCE, GISCE and FAST Survey files, as well as from user-defined text/ASCII file fields. It also exports data from Carlson Note files (.NOT or .VTT) to Microsoft® Access (.MDB) database tables. The .NOT extension is used when data transfers from desktop. The .VTT extension files are data transfers from data collector.

Note files are associated with Coordinate files (.CRD) and contain additional data for point numbers. For example, the Coordinate file for a manhole point could contain the point number, northing, easting, elevation and 32 character description, while the corresponding note file for that point contains additional data on the manhole such as diameter, depth, condition, etc. A Carlson Note file for a Coordinate file will have the same name as the Coordinate file, except with a .NOT or .VTT extension instead of the .CRD extension (e.g. PARK.NOT goes with PARK.CRD). The Carlson Note file is a text file which consists of a point number (PT_ID) followed by field names with values. This group of point number and fields can also have a GIS_FILE name, which is used to identify this group of fields. This GIS_FILE name comes from the Note file prompting definition file (.GIS), which defines the field names for the group and is created in the Define Note File Prompts command.

You can select the Note file to process by using the Import Note File button. The program will then list all the GIS_FILE names that were found in the Note file. If a set of data for point number does not have a GIS_FILE name, then this group will appear in the list as UNKNOWN.

The name of the Microsoft® Access database to add the data to is the output database file, listed at the top-left of the Database File Utilities dialog. You can change the output database by using the Open Database button and selecting an existing database, or by clicking New Database to create a new database. The database tables will automatically have the same name as the GIS_FILE. This dialog also allows you to preview and edit a spreadsheet editor, which in turn allows you to modify values in the table. Each set of note file data for a point is displayed on one row with the corresponding record from the database shown on the next row. You can export the Note file data and create a new Access database .MDB file, in Access ‘97 format or in Access 2000 format, by doing a SAVEAS into .MDB format. You can rename and delete a table as well.

Database File Utilities can be combined with the Create Links command to make GIS links between the point entities in the drawing and the Microsoft® Access database records. The point entities can be drawn with the Draw/Locate Points or Field to Finish commands.
Initial dialog at start of command with primary functions

**Available Table from Output Database:** Selection list. Pick a table from the Output Database.

**Import Note File:** Imports a Carlson Note File (.NOT).

**Import SurvCE/GISCE/FastSurvey GIS File:** Imports a SurvCE/GISCE/FastSurvey Note File.

**Import ASCII File:** Imports ASCII file.

**Open Database:** Opens Access database .MDB file.

**New Database:** Creates a new Access database .MDB file in Access ’97 format or in Access 2000 format.

**Preview/Edit Table:** Displays a spreadsheet editor, allowing you to preview/edit values from table.

**Rename Table:** For renaming a table as needed.

**Delete Table:** For deleting a table as needed.

**Current Table:** Displays the selected table from above list.
Dialog seen after choosing Import ASCII File and selecting file name

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** noteutil

**Prerequisite:** A note file (.NOT from desktop or .VTT from data collector)

**File Names:** \lsp\gisprt.arx
Index

plus-0.5in
2 Point - 2 Point Intersect, 673
2 Tangents, Arc Length, 270
2 Tangents, Chord Length, 270
2 Tangents, Degree of Curve, 272
2 Tangents, External, 271
2 Tangents, Mid-Ordinate, 271
2 Tangents, Radius, 269
2 Tangents, Tangent Length, 272
2D Align, 217
2D Polyline, 29, 52, 55–60, 112, 128, 135, 137, 138, 140, 264, 716, 719, 742, 743
2D Scale, 211
3 Point, 268, 276, 277, 683
3-Radius Curve Series, 275
3D Entity to 2D, 239
3D Polyline, 19, 29, 120, 121, 197, 198, 236, 237, 266, 295, 609, 646, 716, 719, 723, 865, 878, 916
3D Polyline by Slope on Surface, 237
3D Polylines, 121, 237
3D Viewer Window, 249, 252, 831, 844, 845, 867
4 Sided Building, 56, 653
AASHTO, 701, 891
Add Culvert to Polyline, 818
Add Intersection Points, 225
Add Points At Elevation, 236
Add Polyline Vertex, 226
Add Zig to Polyline, 818
Adjoiner Text, 67, 789, 791
Align by Two Pairs of Points, 378
Align Points, 383, 403
Alphanumeric, 44, 334, 360, 373, 525
Angle/Distance, 68, 399, 778
Angle Balance, 456, 480, 482, 638
Angle Mode, 311, 334, 663
Annotate Menu, 768
Annotation, 3, 18, 26, 619, 769, 775, 787, 806, 891
Annotation Defaults, 769, 771, 802
Aperture Object Snap, 354
Arc Length, 270, 272, 701, 708, 769, 808
Arcview, 940
Area/Layout Menu, 727, 751
Area by Closed Polylines, 733
Area by Interior Point, 732
Area by Lines & Arcs, 731, 732
Area Defaults, 728, 729, 731, 735, 748
Area Label Defaults, 656, 730, 732, 734
Area Radial from Curve, 738
Arrowhead, 292, 412, 416
ASCII File, 46, 106, 107, 317, 369, 945, 946
ASE, 193
Attach Image to Entity, 942
Attribute Definitions, 763
Attribute Layers, 613
Attribute Layout ID, 362, 363, 409, 614
Audit, 188
Audit Links, 938
Authorizing Carlson Software, 10
Auto Annotate, 115, 225, 771–774, 776, 779, 804
AutoCAD Overview, 164
Automatic Point Numbers, 362
Auto Tablet On, 334
Azimuth-Distance with Leader, 784
Backsight, 87, 456, 472, 475, 489, 492, 493, 511, 657, 659, 663, 667, 688, 689
Bearing-Bearing Intersect, 670, 671, 673
Bearing-Distance Intersect, 671
Bearing-Distance with Leader, 784
Bearing & 3D Distance, 307
Bearing Annotation, 769
Bearing Area Cutoff, 740
Bearing with Leader, 782
Benchmark, 448, 678, 679
Best Fit Circle, 696, 697
Best Fit Curve, 276
Best Fit Line by Average, 697, 698
Best Fit Line by Least Squares, 698
Blips, 224, 305, 306
Block Explode, 199
Boundaries, 286
Boundary, 29, 286, 293, 732, 751, 849, 850
Boundary Polyline, 3, 135, 293, 631
Break, 112, 133, 135, 138, 158, 159, 201, 204, 205, 215, 229, 230, 682, 908, 909
Break, At Selected Point, 205
Break, Select Object, 2nd Point, 205
Break, Select Object, Two Points, 205

947
Break at Intersection, 205
Break by Crossing Polyline, 203
Breakline, 614, 833, 853, 856–859
Breaklines, 832, 833, 853, 876, 877
Breakpoint Descriptions, 894
Break Polyline at Specified Distances, 204
Brg-Dist w/Leader, 68
Building Dimensions, 65, 115, 788, 790
Building Offset Extensions, 686, 687
Calculate Offsets, 277, 724
Carlson File Types, 26
Carlson Points, 210, 398, 426
Carlson Registration, 12
Centerline, 19, 26, 125, 181, 277, 279, 700, 701, 703,
  704, 706, 710–712, 714, 716, 718, 720, 721,
  723–725, 743, 893, 899, 917, 918
Centerline Conversion, 726
Centerline Conversions, 726
Centerline File, 712, 767
Centerline ID, 712
Centerline Menu, 700
Centerline Report, 19, 711
Change Attribute Style, 207
Change Block/Inserts Resize, 210
Change Block/Inserts Rotate, 208
Change Block/Inserts Substitute, 209
Change Elevations, 160, 206, 373, 382
Change Layer, 60, 160, 260
Change Point LayerColor, 418
Change Polyline Elevation, 233
Change Polyline Linetype, 53, 59, 60, 814, 816, 819,
  820
Change Polyline Width, 232
Change Properties, 206
Change Style, 208
Change Text Font, 213
Change Text Oblique Angle, 215
Change Text Size, 214
Change Text Width, 214
Channel Sample, 26
Check Elevation Range, 233
Chord Bearing, 308, 620
Chord Length, 269, 270, 274, 808
Circle, 268, 389, 390, 492, 493, 696
CLAYER, 16, 258
CL File, 222, 711, 716, 894, 899, 918
Clipboard, 184, 185, 196
Close, 172, 201, 229, 232, 242, 264, 266, 448, 598,
  661, 718, 733, 774, 788, 878, 933, 935, 940
Closed Polylines, 134
Closure, 2, 36, 474, 478, 497, 510, 533, 571, 572, 574,
  575, 581, 584, 585, 591, 592, 620, 637, 638,
  640
Closure by Point Numbers, 637
Closure Error, 731
Coal Sections, 341
Code Definitions, 597, 606, 614
COGO Menu, 655
Color by Elevation, 867
Command Entry, 16
Compare Points, 384, 385, 645
Compass, 496–498, 500
Composite Bed Qualities by Density, 341
Compound Curve, 701–703
Compound or Reverse, 274
Configuration, 26, 28, 342, 351
Configure, 332, 335, 350, 351, 360, 361, 363, 372,
  386, 400, 426, 454, 631, 729, 729, 769, 779, 789–
  791
Contour Elevation Label, 846
Contour from TIN File, 843
Contours, 151, 159, 232, 349, 837, 839, 840, 843,
  847, 848, 856, 865, 869, 870, 877, 887, 919
Convert C&G to Carlson Points, 424
Convert Carlson Points to Ashtech GIS, 426
Convert Carlson Points to C&G, 423
Convert Carlson Points to Eagle Point, 427
Convert Carlson Points to Land Desktop, 423
Convert Carlson Points to Simplicity, 424
Convert Carlson Points to Softdesk, 426
Convert Civil 3D to Carlson Points, 422
Convert CRD to Land Desktop MDB, 421
Convert CRD to TDS CR5/Convert TDS CR5 to
  CRD, 421
Convert Eagle Point to Carlson Points, 427
Convert Geodimeter to Carlson Points, 426
Convert Land Desktop MDB to Carlson Points, 421
Convert LDD Contours, 918, 919
Convert Leica to Carlson Points, 426
Convert PacSoft CRD to Carlson CRD, 426
Convert Simplicity to Carlson Points, 425
Convert Softdesk to Carlson Points, 423
Convert Surveyor1 to CRD, 421
Coordinate File, 26, 317, 368, 372, 375, 394, 400,
  436, 438, 473, 474, 489, 505, 540, 597, 615,
  649, 679, 690, 699, 722, 875, 918
CooRDinate File Utilities, 373
Coordinate File Utilities, 18, 207, 312, 360, 361, 366,
  374, 387, 400, 423, 426, 428, 658
Coordinate Transformation, 27, 377
Copy Polyline Section, 197
Copy To Layer, 196
Crandall, 2
CRD File, 218, 303, 333, 334, 361, 373, 374, 376, 382, 400, 407, 423, 426, 428, 441, 444, 449, 450, 458, 615, 701, 725, 731
Create Links, 937, 939, 944
Create Points from Entities, 674, 676, 683, 685
Create Point Table, 798, 799
Create Polyline ID Labels, 231
Crosshairs, 349
CSTYLE, 16
Cul-de-Sacs, 743
Curve - Arrow, 292, 293
Curve Calc, 276, 277
Curve Edit Mode, 706
Curve Info, 308, 333
Curve Table, 18, 773, 802–805
Custom, 6, 7, 26, 177, 178, 284, 329, 612, 810
Custom Label Formatter, 809
Custom Label Formatter AD, 777
Cut Sheet, 18, 643, 646, 647, 649, 650, 688
Database File Utilities, 944
Data Collectors, 430, 431, 459
Deed Correlation, 626, 627
Deed Description, 18, 27, 33, 127
Deed Linework ID, 626
Deed Reader, 621–623, 641
Define Lot Attributes, 763
Define Note File Prompts, 942–944
Define Strata, 341
Define Template Database, 924, 925, 927–930
Delete Layer, 159
Delete Points, 383
Delete Table Elements, 805
Delta Angle, 274, 773, 808, 810
Densify Polyline Vertices, 223
Depth Contours, 872
Description for Points, 383
Design Centerline, 701, 703, 711
Design Lot, 758
Design Pad Template, 3, 19, 28, 877, 879, 881, 883–885, 916
Design Road Profile, 916
Design Template, 878
Digitize Areas, 734
Direct-Reverse Report, 490
Direct-Reverse Settings, 488
Discussion Groups, 30
Display-Edit File, 309
Display Last Report, 309
Display Order, 257, 329
Display Precision, 539
Distance-Distance Intersect, 672
Distance with Leader, 783
Divide Along Entity, 681
Divide Between Points, 680
Dozer, 28, 183
Dozer Push, 26
Dragline, 26, 28
Draw-Locate Points, 364, 383, 398, 593, 620, 656, 658–660
Draw 3D Grid File, 866, 870
Draw Barscale, 119, 797
Draw By Example, 290
Draw Centerline File, 710
Draw End Point Leaders, 778
Draw Field to Finish, 593–597, 599, 600, 606–608, 615
Draw Grid, 19, 791, 902, 907
Drawing Block, 296
Drawing Cleanup, 185, 188
Drawing Explorer, 13, 316–321
Drawing Inspector, 17, 305, 306, 361
Drawing Template, 173
Draw Legend, 793, 795
Draw Menu, 263
Draw North Arrow, 796, 905
Draw Polyline Blips, 224
Draw Polyline File, 184
Draw Profile, 19, 28, 892, 893, 899, 901, 902, 912
Draw Text On Arc, 810
Draw Text on Tangent, 813
Draw Triangular Mesh, 844, 845, 886
Duplicate Points, 384
Dynamic Annotation, 334
Dynamic Annotation Note, 779
Eagle Point, 167, 427, 428, 598, 599
Eagle Point Coding, 598
Earth Curvature, 477, 494, 496
Edit-Process Level Data, 502
Edit-Process Raw Data File, 430, 454, 507, 620, 637–639

Index
Index

Edit Menu, 192, 462
Edit Multiple Pt Attributes, 408
Edit Point, 146, 368, 392
Edit Point Attributes, 361, 407
Edit Points, 397, 615, 627
Edit Polyline Section, 228
Edit Polyline Vertex, 226, 227
Edit Symbol Library, 344, 796
Edit Table, 945
Edit Text, 212
Edit Text on Arc or Tangent, 813, 814
Elevate 2D Polylines, 744
Elevation Difference, 664, 869
Elevation Zones, 867
End Areas, 26
Enter-Assign Point, 660, 662
Enter and Assign, 126, 366
Enter Deed Description, 618, 624
Entities to Polylines, 222
Entity Insertion Point Rotate, 211
Erase by Closed Polyline, 194
Erase by Layer, 193
Erase Links, 938
Erase Outside, 195
Erase Point Attributes, 113, 413
Erase Points, 398
Erase Select, 193
Explode Carlson Points, 420
Export Lot File to MDB Database, 765
Export Lot File To Old SurvCADD, 766
Export SHP File, 940
Export Text, 376
Export Text/ASCII File, 370, 376, 395
Export Topcon Grid or TIN File, 895
Extend Arc, 201
Extend by Distance, 201, 202
Extended Point Information, 361
Extend To Edge, 200
Extend to Intersection, 200
Extract Project Archive, 322
Extrapolate, 237, 864, 871, 894
Extrapolate Grid, 868
Extrapolation, 864
Fence Diagram, 27
Ferm Codes, 27
Field to Finish Inspector, 616, 617
File Editor, 504, 507
File Menu, 170, 457
Fillet, 29, 131, 219, 236, 239, 742
Fillet 3D Polyline, 236
Find Bad Angle, 490
Find Point, 307
Fit Text Inside Arc, 814
Fit Text Outside Arc, 814
Fix Label Overlaps, 785
Fix Point Attribute Overlaps, 414, 417
Flip Last Label, 781
Flip On/Off, 782
Flip Selected Labels, 782
Flip Text, 115, 215, 715, 721, 773, 810, 905
Flood Note, 348
Four Way Control, 693, 694
Freeze Layer, 63, 118, 142, 159, 261, 398
Freeze Points, 398, 399
General Commands, 166, 656, 658–660
Geodimeter, 426, 430, 449–451, 459, 501
Geologic Column, 27
GIS Database Settings, 924, 927, 937
GIS File, 363, 925
GIS Inspector, 928
GIS Inspector Settings, 927, 929
GIS Links, 25
GIS Menu, 923
GIS Query/Report, 20, 930
Global Reannotate, 787
GLO Corner Proportioning, 690, 693, 694
Grid File, 19, 229, 232, 237, 333, 365, 477, 865, 866, 869, 871, 882, 886
Grid File Utilities, 27, 183, 864
Guard Rail, 820
Hatch, 283–286, 331, 794, 795, 837, 890
HEC-2, 27
Highlight Crossing Plines, 234
Hinged Area, 135, 136, 736
Horizontal Axis Elevations, 906
Hydrograph, 27
Identify Area Descriptions, 736
Image Adjust, 243
Image Clip, 242
Image Frame, 242
Image Inspector, 940
Import/Export LandXML Files, 181
Lot File, 19, 142, 147, 150, 756, 757, 759–761, 765–767
Lot File by Interior Text, 142, 761
Lot File by Pick Interior, 760
Lot File to Centerline, 766
Lot Inspector, 762
Lot Layout, 133, 134, 138, 740, 741
Lot Manager, 761
LotNet Road Network, 750
Lot Network Boundary, 749
Lot Network Hinged Area, 755
Lot Network Inspector, 756
Lot Network Labels, 756
Lot Network Linework, 754
Lot Network Output To Lot File, 757
Lot Network Renumber Lots, 757
Lot Network Report, 756
Lot Network Settings, 747, 751, 755
Lot Network Sliding Side Area, 755
Lot Network Subdivide Area, 755
Make 3D Grid File, 862, 868, 881, 898
Manhole, 72, 111
Map Check by Pnts, 639
Map Check by Screen Entities, 641
Map Points from, 376
Maps, 865
Maptech, 460
Max Samples, 338, 340
Measured, 448, 563
MicroStation, 183, 184
Mirror, 30, 219, 780, 781
Mirror and Flip Selected Labels, 781
Mirror Selected Labels, 780
Mortgage Block, 348
Mouse Click Settings, 343
Move, 195, 202, 250, 264, 361, 373, 381, 382, 412, 416, 417, 704, 737, 747, 763, 775, 779, 786, 794, 848, 929, 941, 943
Move Label Along Contour, 848
Move Point Attributes, 114, 117
Move Point Attributes Single, 411
Move Point Attributes with Leader, 412, 417
Move Points, 406
Multi-Point Symbols, 281, 283
NADCON, 377
Nearest Found, 594
Nikon, 430, 448, 449, 460, 501
Nodes, 365, 875
North Arrow, 38, 70, 119, 905
Note File, 646, 944, 945
Numeric, 44, 334, 655
Numeric Pad COGO, 679
Object Data, 924
Object Linking, 189, 333
Obtaining Technical Support, 30
Occupy Point, 657, 663
Offset 3D Polyline, 235
Offset Cutoff, 187, 940
Offset Dimensions, 66, 67, 119, 788–790
Offset Point Entry, 277, 722
Offset Profiles, 894
Offsets & Intersections, 742, 743
OLE objects, 174, 327, 328
One Way Control, 690, 691
Ownership, 27
Page Setup, 174, 175, 326
Pan, 248, 250, 333, 417, 468, 568, 617, 666, 704, 774, 892, 928, 941
Parking, 746
PC, PT, Center, 268
PC, Radius, Arc Length, 269
PC, Radius, Chord, 269
PCMCIA card, 448
PC Point, 270
PDSIZE, 333, 361
Pick Intersection Points, 668
Pipe Size, 28
PI Points, 706, 714, 719
Pivot Point Rotate by Bearing, 210
Place Camera Symbol/Image, 941
Place Image by World File, 289
Plot, 174–178, 220, 236, 259, 277, 311, 326, 327, 381, 620, 711, 825, 826, 864, 872, 886, 905, 917
Plot Preview, 174
Point Defaults, 33, 34, 49, 362, 363, 409, 418, 593, 658, 660, 672, 682, 690–693

Index
Index
Save/Load Tablet Calibration, 351
Save As, 173, 504, 537, 606, 607, 625, 627, 794, 854, 892, 900, 912, 931, 932, 934, 935, 943
SB-Slope, 28
Scale Point Attributes, 50, 412, 414
Scale Points, 404
Screen Pick Point, 383
SDPS, 340
Seam Stacking, 340
Search Radius, 340
Section File, 646
Section Subdivision, 689
SEDCAD, 26, 339
Select by Area, 241
Select by Elevation, 241
Select by Filter, 240
Selection of Items, 167
Sequential Numbers, 141, 290, 742
Set/Reset X-Hairs, 349
Set Back Measure-Move, 746
Set Coordinate File, 316, 360, 372, 454, 701
Set CRD File for Lot Files, 766
Set Data Directory, 15
Set Layer, 260
Set Lot File, 757
Set Point Elevations by 3D Polylines, 651
Set Point Elevations by Surface Model, 651
Set Polyline Origin, 232
Set Project/Data Folders, 313
Set Table Position, 804
Settings Menu, 310
Setting Up a Project, 13
Set UCS to World, 352
Sewer, 28, 59, 914
Sewer Structure, 28
Shade, 251, 604
SHP File, 940
Shrink-Wrap Entities, 294
Side Shots, 659, 663, 664
Sight Distance, 483, 891, 900, 913
Sketch Tree Line, 819
Sliding Side Area, 3, 138, 139, 737
Slope Distance, 451, 493, 494, 588, 664, 677, 688
Slope Zone Analysis, 19, 886
Smart Promting, 927, 928
SMI, 26, 430, 443, 444, 460, 501, 701
Smoothing, 839, 919
Smooth Polyline, 55, 224, 614
Softdesk, 423, 426, 459, 919, 921, 922
Sokkia/SDR, 440, 441, 501, 921
Sokkia G, 430, 442
Solar Observations, 694
Special Leader, 3, 69, 826
Special Line/Entity, 819
Spiral, 278, 702, 706–708
Spiral Curve, 277
Spiral In, 706
Spirals, 701
Spline, 129, 187
Split Bed by Parameters, 341
Split Text into Two Lines, 215
Spot Elevations, 875
Spot Elevations By Surface Model, 874
SRVPNO, 302, 362, 419, 614
Stack Label Arc, 69, 807
Standard Align, 218
Standard Copy, 196
Standard Explode, 198
Standard Offset, 197
Standard Report Viewer, 20, 41, 47, 145, 308, 309, 368, 478, 480, 631, 652
Start Point Number, 362, 363
Startup Wizard, 13, 15, 33, 43, 44, 105, 106, 125, 147, 333
State Plane, 377, 405, 484–486, 527, 554, 583, 587, 592, 823
Station-Offset, 648, 723
Station Polyline/Centerline, 18, 712, 714
Stockpile, 160, 163
Store Project Archive, 321, 322
StrataCalc, 26
Strat Isopach Maps, 26
Strata Quantities, 29
Superelevation, 28, 647
Surface 3D FlyOver, 252
Surface 3D Viewer, 252
Surface Entities, 19
Surface Inspector, 28
Surface Manager, 855, 856, 860, 862, 881
Surface Menu, 830

Surface Model, 222, 254, 267, 878, 881, 882, 894, 916
SurvCE, 27, 28, 430–432, 434, 436, 438, 442, 457, 460, 486, 512, 531, 547, 599, 646, 925, 944, 945
SurvCOGO, 460, 502
Survey Menu, 429
Surveyors Assistant, 430
Survey Text Defaults, 63, 64, 66, 67, 115, 119, 788–791
SurvNET, 506
SurvStar, 430, 431, 924, 925, 942
Switch Bearing/Azimuth Quadrant, 780
Symbol Library, 28, 278, 361
Symbol Size, 62, 63, 119, 333, 795, 836
System Requirements, 4
System Variable Editor, 357
Table Defaults, 799, 804, 805
Table Header, 772, 773, 803–805
Tablet Calibrate, 349
Tablet Calibration, 350, 351
Tag Area Descriptions, 735
Tag Hard Breakline Polylines, 876
Tang, PC, Radius, Chord Length, 273
Tang, PC, Radius, Delta Angle, 274
Tangent, PC, Radius, Arc Length, 272
Tangent, PC, Radius, Tangent Length, 273
Tangent Line from Circles, 686
Tangent Out Bearing, 618
TDS, 2, 430, 442, 443, 454, 460, 461, 599
TDS CR, 421
Technical Support, 31
Template Database, 925, 926
Template Point Profile, 647
Terramodel, 921
Text Box, 827
Text Enlarge/Reduce, 39, 121, 212, 214
Text Explode To Polylines, 183, 216
Text Plot Size, 41, 122
Text Size, 41, 64, 66, 67, 212, 291, 468, 769, 795, 800
Text Style, 75, 715, 769, 788, 789, 799, 800, 811
Thaw Layer, 63, 160, 261, 399
Thaw Points, 399
Three Way Control, 692, 693
TIF file, 290, 941
Title Block, 3, 36, 37, 45, 70, 118, 345, 792
Toolbars, 344, 546
Transit, 481, 488, 639
Translate Points, 255, 383, 399
Traversal, 658–661, 663
Triangular Mesh, 19
Triangulate & Contour, 831, 832, 845, 849, 876, 877, 886, 888, 916
Triangulation, 19, 27, 29, 181, 338, 340, 646, 831, 832, 842, 844, 849, 862–864, 868, 886, 888, 895
Triangulation File Utilities, 849, 852
Trim, 18, 30, 199, 219, 369, 430, 440, 460, 510, 532, 545, 882
Trimble, 18
Trim by Point Symbol, 40, 418
Tutorials, 32
Twist, 113–115, 208, 211, 213, 333, 413, 414, 721
Twist Point Attributes, 114, 413
Twist Screen: Line Pline or Text, 256
Twist Screen: Standard, 255
Twist Screen: Surveyor, 256
Two Surface Volumes, 868–870, 872, 881
Two Way Control, 691, 692
Undo, 193, 199–202, 228, 243, 264, 267, 293, 381, 387, 400, 402, 403, 462, 618, 620, 665, 701, 702, 730, 731, 758
Units Control, 352, 770
Universal Transverse Mercator, 377, 695
Untag Area Descriptions, 736
Untag Hard Breakline Polylines, 877
Update Drawing from CRD File, 382
Update Point Table, 799
Using the Carlson Software Manual, 2
Variable Offset, 197
Ventilation, 28
Vertical Angle Mode, 363
Vertical Curve, 891
View Menu, 245
Viewpoint 3D, 254, 832, 866, 868, 885
Visual COGO, 662, 663, 665, 666
Volume, 3, 19, 161–163, 832, 848, 849, 868–872, 874, 881, 916
Volumes By Layer, 872
Volumes By Triangulation, 848, 849

Web Site, 31
What is New, 17
Wild, 62, 124, 151, 366, 369, 448, 501, 920, 922
Wildsoft, 383, 446–448, 459
Write Block, 298
Write Polyline File, 183, 216

Xref Manager, 179, 180

Zeiss, 369, 370, 460
Zone Polylines, 183
Zoom - Center, 247
Zoom - Dynamic, 246
Zoom - Extents, 247
Zoom - Previous, 246
Zoom - Window, 246
Zoom IN, 247
Zoom OUT, 247
Zoom Points, 248
Zoom Selection, 248